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Welcome!

 

Congratulations on your choice of WaveLab! Ever since its early versions 
WaveLab has enjoyed a high reputation among professional and semi-
professional users. WaveLab is the audio editor of choice, not only in top-
of-the-line mastering and restoration facilities, but also for any serious en-
gineer or musician. 

This new version of WaveLab continues in the tradition of introducing 
new powerful and exciting features while maintaining the ease of use and 
workflow that makes working with WaveLab so effective. We are quite 
confident that version 6.0 will define a new standard in applying psycho-
acoustic tools to professional audio editing and mastering. WaveLab 6.0 
will integrate seamlessly into your existing studio environment, and with 
your outboard gear.

Steinberg has always shown a strong commitment to protect the invest-
ment of loyal customers. WaveLab 6.0 follows this route by introducing 
the Steinberg key to preserve your competitive advantage.

Your Steinberg Team.

 

What’s new in WaveLab 6.0?

 

This section lists the main new functions and features added to the 6.0 
version of WaveLab:

 

• The main wave window and the overview can independently be set to display one 
of three display modes: Standard waveform display (Wave), the loudness enve-
lope of the sound (Loudness envelope), or as a spectrogram (Spectrum).

• New Spectrum editor offers powerful audio restoration and processing functions. 
High quality linear-phase filters allow you to remove unwanted artefacts in the au-
dio with surgical precision. You can also process a selected frequency/time re-
gion separately via the Master Section.

• New Rename function that can automatically update all file references in other 
documents such as Audio Montages. Files, clips and markers can also be batch 
renamed.

• Marker regions can be rendered as separate audio files.
• Improved file read/write performance.
• No limitation on audio file size.
• DIRAC engine - perhaps the highest quality algorithm for Time stretch/Pitch shift 

processing available today.
• Crystal Resampler plug-in, a professional sample rate converter providing excep-

tional transparency and preservation of the frequency content.
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• External gear plug-in allows you to process audio via external equipment.
• New Audio input plug-in replaces the Live input feature, with the option to record 

the incoming signal.
• Option to save an audio selection as an Audio Montage clip.
• Redesigned graphic user interface in all menus and dialogs.
• Auto Split enhancements includes Split to specific file length and Split according 

to a text file (XML support).
• Clip files can be created when using Auto Split.
• The Loudness Normalizer allows you specify the desired loudness of a file to a 

given value. A high quality limiter coupled with multi-pass analysis ensures very 
accurate results.

• The Pan Normalizer allows you to process the left/right audio channels in a stereo 
file to the same loudness.

• The Level envelope processor can control the level of an audio file or selection 
using an envelope curve.

• The Pitch Quantize processor can automatically detect and correct the pitch of 
an audio file.

• Effect morphing - gradually blend two processed audio ranges with a custom en-
velope for sample accurate effect transitions.

• Global Bypass tool compensates for the loudness difference between pro-
cessed/unprocessed audio.

• New Edit folders dialog manages all default file folders used by WaveLab.
• Define up to 3 temporary file folders to further improve file performance.
• View settings files (extension “.mem”) can store/recall information relating to a spe-

cific audio file such as window/zoom/scroll positions, Master Section preset etc.
• Audio peak files (extension “.gpk”) can now be stored in a separate folder.
• Improved graphic speed for displaying large files. Peak files can also be created 

in the background with graphical progress monitoring.
• Updated preference dialogs.
• Advanced “Insert silence” function allows you to insert user specified ambient 

background noise instead of silence, with optional cross-faded insertion.
• K-System support for loudness metering.
• New Audio Montage tab can manage all plug-ins used in a Montage in a variety of 

ways. Copy and paste plug-ins between clips or tracks, or load and save whole 
plug-in chains.

• Batch processing of Audio Montages.
• WaveLab can now be slaved to the ASIO Positioning Protocol, for sample accu-

rate synchronization.
• You can now assign MIDI commands for WaveLab functions.

 

Best of all, WaveLab is continuously developed and refined, in collabora-
tion with our users – from professional audio engineers to hobbyists. Your 
input has helped make this version of WaveLab the most complete, flexi-
ble and user-friendly ever!
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How you can reach us

 

After having installed and launched the program, you will find a number of 
useful Steinberg Web links on the Help menu (“Steinberg on the internet” 
submenu). These allow you to get online support, check for updates, get 
answers to frequently asked questions, etc.

 

These features require that you have a working Internet connection.
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This is what you need…

 

To use WaveLab you need the following:

 

• A PC with Windows XP or 2000 installed and ready.

 

A free USB port is also required. For more details about the computer requirements, see 
below.

 

• A Multimedia PC compatible, 16-bit (or better) audio card.

 

By audio card we mean a card capable of recording and playing back audio, using the com-
puter’s hard disk as storage media. See “About audio cards” on page 18.

 

To take advantage of WaveLab’s more advanced features, you need the 
following:

 

• To utilize WaveLab’s CD burning capabilities, you will need a CD recorder.

 

Your CD recorder must support the disc-at-once write mode.

 

• To utilize WaveLab’s DVD-A burning capabilities, you will need a DVD 
recorder.

• To utilize WaveLab’s surround and multichannel capabilities, you will need 
an audio card with multiple inputs and outputs.

 

Furthermore, the audio card must have an ASIO driver.

 

• DirectX 9 or later must be installed.

 

Computer requirements

 

Below, the minimum computer requirements are listed, with recommen-
dations where applicable. The following sections describe each system 
component (processor, RAM, etc.) in more detail.

 

Minimum requirements

 

• Intel Pentium III/AMD Athlon 800 MHz (Intel Pentium IV/AMD Athlon or AMD 
Opteron 2,4GHz). 

• Newer dual core CPUs are recommended.
• 256 MB RAM (1GB recommended).
• A monitor and video card with a resolution of 24 bit (32bit recommended).
• 50MB of free hard disk space (10GB recommended).
• Windows XP or 2000 (Windows XP recommended).
• Windows MME compatible audio hardware (ASIO compatible audio hardware 

recommended).
• CD or DVD ROM drive for installation (CD/DVD writer recommended).
• USB port.
• DirectX version 9 or later is required for using video and some export functions.
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RAM

 

Since WaveLab is disk based, the amount of RAM does not limit the size 
of audio files you can work with. Even with moderate amounts of RAM, 
you can have many files open at the same time. However, when more 
RAM is available, some processes can be accelerated by WaveLab.

 

Processing power

 

The difference between running WaveLab on a faster computer and a 
slower one is noticeable in many cases:

 

• More real-time processing

 

The faster the computer, the more real-time plug-ins you will be able to use.

 

• Faster “off-line” processing and analysis tasks

 

Certain types of processing which make heavy demands on the computer will be com-
pleted more quickly on a faster machine. 

 

• Screen updates

 

Scrolling, editing and manipulating objects is “snappier” on a faster machine.

 

Hard disk

 

Audio files are relatively big. Approximately 10.6 MB of hard disk space is 
used up for every minute of 16 bit stereo/44.1 kHz audio recorded. For 24 
bit/48 kHz audio or higher, the audio files are of course a lot bigger. There-
fore we recommend that you get the largest hard disk you can afford. The 
speed of the hard disk will affect some of the processing operations. This 
is mainly noticeable when you work with very long files.

In addition, a fast hard disk is absolutely crucial for CD-R and DVD-R 
burning. If the hard disk is slow, your recorder might not be able to write at 
its maximum possible speed.

 

Do not use file compression on hard disks where audio files are stored!
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Sampler requirements

 

To communicate with samplers, you need the following:

 

• A MIDI interface, or…
• A SCSI card, or…
• Both a MIDI interface and a SCSI card.

 

Exactly which of the three is most appropriate depends on the capabilities 
of your sampler and how you intend to communicate with it. See “About 
the various communication methods” on page 658.

 

SCSI card considerations

 

WaveLab works with SCSI cards that are 100% Windows compatible.

 

If you are buying a SCSI card specifically to communicate with the sampler, 
we recommend that you get an original Adaptec card. Small deviations in 

 

SCSI implementations can cause transfer problems.

 

About audio cards

 

WaveLab works with any Multimedia PC compatible audio card. How-
ever, the audio quality varies dramatically between cards.

For serious work with WaveLab, we recommend that you get a card with 
the highest possible specifications.

However, if you use WaveLab to edit files for use with other hardware 
(such as a hard disk based recording system using its own audio convert-
ers) any loss in audio quality that you experience when listening to the 
files in WaveLab (due to deficiencies in the audio card) will not affect the 
final audio files in any way. 

For professional use (mastering, etc.) we recommend that you get a card 
capable of playing back files in 24 bit resolution.

 

Surround

 

To use the surround capabilities of WaveLab’s Audio Montage, you need 
an ASIO compatible audio card with multiple inputs and outputs. In a sur-
round configuration, each WaveLab channel can be routed to separate 
outputs and inputs on the audio card.
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About the System Information feature

 

After having installed and launched WaveLab, you can get a very detailed 
report describing your computer system by selecting “System Informa-
tion” on the Help menu. This function analyses your system and lists oper-
ating system specifics; processor(s), memory, hard drives, and much 
more. This is especially useful if you need to contact Technical Support, 
since this allows you to describe your computer configuration accurately.
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Setting up the computer

 

Before proceeding, your computer should be set up and the following 
items should be installed:

 

• Windows (see “This is what you need…” on page 16 for details on which version 
to use).

• The audio card and its driver.

 

Checking the audio card

 

To make sure the audio card will work as expected, you can perform the 
following two tests:

 

•

 

Use the software included with the audio card to make sure you can 
record and play back without problems.

 

•

 

Use the Media Player application (included with Windows and described 
in the Windows documentation) to record and play back audio.

 

Colors

 

At this point you might want to check and for example change the number

 

 
of colors you use on your computer screen. See your Windows docu-
mentation for instructions on how to do this. The recommended setting 
for WaveLab is 24 or 32 bit mode (“True Color”).
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Installation procedure

 

The Steinberg Key

 

Please read the following section before installing the WaveLab software.

 

Included with the WaveLab package, you will find the Steinberg Key 
(sometimes referred to as a “dongle”), a hardware copy protection device 
that is part of the WaveLab copy protection scheme. WaveLab will not 
run if there is no Steinberg Key.

 

The Steinberg Key

 

The Steinberg Key is, in fact, a little computer on which your Steinberg 
software licenses are stored. All hardware-protected Steinberg products 
use the same type of key, and you can store more than one license on one 
key. Also, licenses can (within certain limits) be transferred between keys 
– which is helpful, e.g. if you want to sell a piece of software. 

 

•

 

If you already own copy-protected Steinberg software, you must remove 
any existing Steinberg Keys from the computer’s USB port before starting 
the WaveLab installation routine.

 

•

 

If you are using other copy-protected Steinberg products, you may want 
to transfer all licenses for your applications to only one Steinberg Key, 
thus using only one USB port of your computer. More information on the 
transfer of licenses between keys can be found in the help for the Syn-
crosoft License Control Center (which can be found in the Start/Pro-
grams menu of your computer).

 

The Steinberg Key must not be plugged in before the installation of Wave-
Lab. Otherwise the operating system of your computer will register it as 
new USB hardware and try to find drivers that won’t be present before 

 

WaveLab installation.
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Installing the software 

 

The installation procedure unpacks all the files and automatically puts 
them in the right places.

 

1. Insert the CD-ROM disk in the drive.
The installation program should start automatically after a few seconds. If, for some reason 
it doesn’t – for instance if you have “Auto Insert Notification” deactivated for your CD drive 
– perform steps 2-4 below. Otherwise, proceed to step 5.

2. Launch the Explorer, open the “My Computer” window or select “Run” 
from the Start menu.

3. Locate and double click on the drive symbol for the CD-ROM drive.

4. Double click on the “setup” symbol (setup.exe).

5. Follow the instructions on screen.

• If you are updating from WaveLab 4, WaveLab 5 or WaveLab Essential 
you will need to enter both the serial number and the original CD that 
came with the previous version.

6. At one point of the installation a dialog appears requesting you to connect 
your Steinberg Key – do so.
The first time the copy protection device is plugged in, it will be registered as a new hard-
ware device, and a dialog will appear asking you whether you would like to find drivers for 
the device manually or automatically. You should select to find drivers automatically, and 
click OK to proceed and close the dialog.

7. Finally, a dialog informs you that the installation was successful.
A restart may be requested – but if no dialog requests a restart it is not necessary to do so.

When the installation is finished, the program is found among your other 
programs on the Start menu and/or the desktop.

This completes the installation of your WaveLab program! But, you’re not 
really done yet…

Register your software!
Registering your software will make sure you are entitled to technical sup-
port and kept aware of updates and news regarding WaveLab.
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Launching WaveLab
1. Make sure the Steinberg Key is plugged into the USB port.

2. Launch WaveLab.
WaveLab starts.

• The Steinberg Key has to be plugged in at all times when running WaveLab. 

Program settings
Before you start working, you should make some settings:

Audio card settings

You need to specify which audio card and driver you intend to use. Wave-
Lab can communicate with the audio card via any of the standard proto-
cols; ASIO, MME or WDM. Note:

• For multichannel operation and other WaveLab features like the External 
gear plug-in you must use an ASIO driver.

Selecting an ASIO driver

1. Open the Preferences–Audio device tab.

2. Select the ASIO driver from the “Playback device” pop-up menu.
Note that the “Playback device” menu heading has now changed to “Playback/Record de-
vice” and the Recording device section has been greyed out. This is because with ASIO, 
the same driver is always used both for output and input.

3. If you click the “Control Panel” button the audio card settings application 
(usually installed with the audio card) for the ASIO driver opens.
In the Control Panel you may find settings for buffer size, digital formats, additional I/O con-
nections, etc. depending on the audio card and the driver.

4. Click on the “Connections” button.
The ASIO Audio connections dialog will appear, listing all available channel inputs and out-
puts in WaveLab.

Internally there are 8 fixed WaveLab channels that can be freely mapped 
to ASIO outputs and inputs on your audio interface. “Surround channels” 
are the available surround speaker channels. See “The ASIO Audio Con-
nections dialog” on page 507 for more information about the ASIO Au-
dio connections dialog.

5. Close the dialog.
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• When using ASIO, the playback resolution is set from the ASIO driver 
(you may find a setting for this in the ASIO Control Panel, depending on 
the hardware and driver).
Therefore, the Playback Resolution settings will be greyed out.

Selecting an MME/WDM driver

1. Select “Preferences…” from the Options menu.

2. Click on the Audio device tab.

3. Select the audio card you want to use for recording and playback from 
the pop-ups.
If you only have one audio card you can also select the “Microsoft Sound Mapper” options 
(the sound mapper is a “virtual audio card” which “maps” all audio to your real card). How-
ever this does not let you take full advantage of the card’s driver when recording audio and 
is therefore not recommended.

4. Choose your “Playback Resolution”.

Additional audio settings

There are other settings in the Preferences that affect audio playback and 
recording. We recommend that you try the default settings before you 
change anything, since these work well in most cases.

On the “Audio Card” tab, you will find the following settings:

• Playback Buffer Number and Size.
These determine how much RAM memory is used for buffering when playing back. If you 
get playback problems such as dropouts or glitches, you should try to increase these val-
ues. Click the question mark icon in the dialog for details.

With ASIO drivers, you may find these settings in the ASIO Control Panel.

• Recording Buffer Number and Size (not available when using ASIO).
These determine how much RAM is used for buffering when recording. If you get dropouts 
in the recorded audio, you should try increasing these values. Click the question mark icon 
in the dialog for details.

On the Preferences–File tab, you will find the following settings:

• Disk block buffer size.
Governs the buffer size used when WaveLab is reading data from the hard disk. If you ex-
perience problems in a read intensive scenario (such as playing back an Audio Montage 
with a lot of simultaneous clips), you should try changing this value. 
If you change this setting, playback will stop when you leave the dialog.
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• Use system cache.
When this is deactivated (default), WaveLab reads files directly from the hard disk, bypass-
ing Windows’ file cache.

We recommend that you leave this option deactivated!

The option is available since it may remedy problems on certain systems with slow disk 
drives. Note:

• If you activate this, avoid using large disk block buffer size values!
• After activating this option, you need to close and reopen all open files, for the 

setting to take effect!

About latency

In the Playback section of the Audio device tab, you will find an indication 
of the current latency (at 16bit/44.1kHz stereo). Latency is the delay be-
tween when audio is “sent” from the program and when you actually hear 
it. The latency in an audio system depends on the audio hardware, its driv-
ers and their settings. It’s usually possible to reduce latency by lowering 
the number and size of the playback/recording buffers. However, please 
note:

While a very low latency can be crucial in a real-time DAW application such 
as Steinberg Nuendo or Cubase, this is not strictly the case with WaveLab. 
Here the important issues are optimum and stable playback and editing 
precision. Therefore, you should not try to reach the lowest possible latency 
figures when working with WaveLab. And again, should you get dropouts, 
crackles or glitches during playback, raise the Buffer Number setting on the 
Preferences–Audio device tab.
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Temporary files

You also need to specify where WaveLab should store its temporary files. 
Temporary files are used for certain operations, such as WaveLab’s ex-
tensive Undo function (see “Undo and Redo” on page 47).

WaveLab allows you to specify up to three different folders for storing 
temporary files. If you have access to more than one drive, saving your 
temp files on separate drives (not partitions) can considerably speed up 
performance. 

For example, if your source files are located on the C: drive, you could 
specify D:\temp and E:\temp as temporary folders.

This will not only improve performance, but also reduce disk fragmentation.

1. In Windows, create a separate folder in which to store your “temp” files.

The folder(s) should be on your fastest hard disk and you should make sure 
you have plenty of room available on that hard disk (or partition). Putting the 
“temp” files on a separate drive (that is, not the same drive as your regular 
files) will speed up file operations considerably.

2. Select “Folders…” from the Options menu.
This opens the Folders dialog, where you can edit how various WaveLab folders are han-
dled (see “Folder editing” on page 731). 

3. Click on the plus sign beside the “Temporary folders” item (this is located 
in the “Work folders” category).
Three possible folders can be specified for temp files.

4. Selecting one of the Temporary Folder items will show the current loca-
tion where the temp files will be created in the Folder field to the right.

5. Either type in the path to the directory or you can browse the drives to 
locate and select the folder via a standard Windows file dialog.
Click OK to select a folder and exit the file dialog.
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Peak and view memories

A peak file is a small file with the extension “.gpk” automatically created by 
WaveLab each time a file is modified or opened in WaveLab (if it hasn’t 
been previously). The peak file contains information about the waveform, 
and determines how it is drawn in the wave window.

View memory files (extension “.mem”) store view information relating to a 
specific audio file such as window and scroll positions, etc., and option-
ally any Master Section effects used – see “Saving view settings” on 
page 124.

By default, peak files and view memory files are stored in the same folder 
as the related audio file. Setting this to another folder on a different drive 
will also improve performance to a certain degree. Regardless of whether 
this folder is on a different drive or not you also get the advantage of not 
having the audio file folder cluttered with non-audio files if a separate 
folder is used.

This folder can be specified from the Folders dialog, either directly or via 
the Preferences–Wave edit tab.

Select Preferences from the Options menu and select the Wave edit tab.

• If the “Save view settings in companion file” option is activated, view 
memory files will be saved in the same folder as the related audio file.

• If you select “Save in independent folder” you can click the “Edit” button, 
which will open the Folder dialog with the “Peak and view memories” 
work folder selected.
From here you can navigate to a new folder location to store the peak and view memory 
temp files.
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Installing a CD/DVD recorder

Hardware installation/connection

For general instructions on installing internal or connecting external re-
corders via USB or Firewire, please refer to the instructions that came 
with the computer, or the recorder itself.

For WaveLab, please just check the following points:

• Make sure to have the latest firmware version installed in your recorder unit. For 
CD recorders, the firmware you have must support Disk-at-Once mode! In addi-
tion, running a unit with older firmware might for example prevent you from writing 
sub-index markers into the tracks.

Checking the installation of the CD/DVD recorder

You might want to check that the recorder unit was actually found by the 
program. Proceed as follows:

1. Select “CD/DVD Information…” from the Tools menu.
The CD/DVD Info dialog appears.

2. Check that your recorder unit appears in the list to the left.
The list will also contain any regular DVD-ROM drives, etc. If your CD/DVD recorder isn’t 
listed, there’s either something wrong with the installation or the unit is not supported by 
WaveLab. 
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Installing samplers

Installing MIDI and SCSI interfaces

If your sampler communicates with WaveLab via MIDI, you need to install 
a MIDI interface. If it communicates via SCSI you need a SCSI card. For 
some samplers you will need both.

For all general instructions on installing MIDI interfaces and SCSI cards, 
please refer to the instructions that came with the units.

Do not connect anything to the SCSI card until you have finished installation 
of the card and its drivers and have read the instructions below!

Connecting the sampler

MIDI connections

1. Connect a MIDI cable from the MIDI Out on the sampler to a MIDI In on 
your computer.

2. Connect a MIDI cable from a MIDI Out on your computer to the MIDI In on 
the sampler.

SCSI connections

Before you connect your sampler via SCSI, read the following!

SCSI is a high speed electrical interface, primarily designed to connect 
hard disks and other peripherals to personal computers. SCSI is not a 
regular computer network so there are severe restrictions on how many 
devices you can have connected, cable lengths, etc.
Improper SCSI handling may cause permanent damage to your equip-
ment. Please, always follow the few but important golden rules of SCSI to 
insure yourself against damaged equipment:

• Always make all connections with all units turned off!
• Set all devices to different IDs before connecting and turning on power! 

PC SCSI cards normally occupy the SCSI ID 7.
• The ID of your sampler can normally be changed from its front panel.
• Use high quality SCSI cables! The shorter they are, the better.
• The total length of all SCSI cables should never exceed 6 meters (20 feet).
• The devices at the ends of your SCSI chain must be terminated! 
• Follow the recommendations in your sampler manual about how to terminate your 

devices.
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• If you set up with too many terminators, or a terminator missing, data transmission 
most probably won’t work properly. In the worst case, one of your SCSI devices 
may be physically damaged.

• The computer should always be at one end of the SCSI chain of devices.
• Always turn on the computer last, after all other devices have been started up.
• Always switch on all devices. If some device is not turned on, you may lose data.

Booting up

1. Make sure you have the latest operating system for your sampler. Wave-
Lab may not be able to communicate with the sampler if you don’t have a 
current version. If in doubt, contact your dealer.

2. Turn on the sampler and any connected external SCSI devices. Let the 
sampler finish booting.

3. Turn on your computer.

4. If the computer refuses to boot (the computer “hangs” during startup) 
there’s something wrong with the termination, cables or SCSI IDs.
Go back and check everything again. Try with less equipment connected (but don’t forget – 
always terminate both ends of the SCSI chain!).

Verifying SCSI communication with the sampler

To make sure your sampler has really been installed properly on the SCSI 
bus, proceed as follows:

1. Launch WaveLab.

2. Select “Sampler configurations…” from the Sampling menu.

3. Click on the Settings tab.

4. Pull down the Unit pop-up in the SCSI section.
The sampler should be listed here. If it isn’t, there’s either something wrong with your instal-
lation, or the sampler model cannot communicate via SCSI from a Windows computer.

Verifying MIDI communication with the sampler

This is done when you start using it for audio transfers, and involves a 
number of steps (creating presets, making SysEx ID settings, etc.). See 
“Using samplers and creating loops” on page 657 for details.
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Installation done! Where do I go next?
There are three things we suggest you do:

• Read through the rest of this book and try out the different possibilities as 
you go along.

• Examine your WaveLab directory and other disks included in this package 
for files that might be useful to you.

• If you run into problems, check the Troubleshooting chapter in the online 
documentation.

About the Tracer application
In the WaveLab directory created on your hard disk during installation, 
you will find a folder called “Tools”. Among other things, this folder con-
tains a small application called Tracer. This is a diagnostic tool that tracks 
and logs various procedures that WaveLab executes when it is launched, 
e.g. the loading of plug-ins.

Should you run into problems with WaveLab and need to contact techni-
cal support, you can use the Tracer application and pass on the informa-
tion it displays to the technical support staff. This could be of great 
assistance since it might be possible to see exactly which operation 
caused a problem.

• To use the Tracer, locate the file Tracer.exe in the Windows Explorer and double 
click on it – or use the Run command on the Start menu to browse for the file.

• After you have activated the Tracer application, launch WaveLab.
• All loading procedures are displayed as plain text, and you can copy this informa-

tion and then paste it into, for example, an e-mail.
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Get to know WaveLab
Welcome to WaveLab! 

This chapter is intended to get you acquainted with the program. We will 
here briefly describe its fundamental functions and main features, so as to 
point you in the right direction on your road to mastering all of the possi-
bilities that WaveLab offers.

The windows and what you can do with them
Working with WaveLab, you will encounter a number of different windows 
that let you do different things. Editing audio files, compiling files for burn-
ing CDs or DVDs, applying effects and much, much more. This is an over-
view of the main windows in the program.

The Wave window

This is a Wave window, a graphical representation of an audio file. It con-
sists of two parts – the lower is the Main view, and this is where you can 
perform various audio editing operations such as copying, cutting, pasting, 
moving, deleting, etc. 

The upper part is the Overview and serves to let you easily navigate 
through long files.

You can read more about the Wave window and the operations you can 
perform in it in the chapter “Editing in the Wave window” on page 69.
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The Audio Montage window

This is an Audio Montage window. An Audio Montage lets you compile 
and edit multiple clips (references to audio files on disk) on one or several 
tracks.

As you can see, the window consists of two panes. The lower one is 
called the Track View, and this is where you assemble the clips. The ap-
pearance of the upper pane depends on which of the 12 tabs at the very 
top of the window is selected. These tabs give you access to various 
functions.

After you have imported audio files as clips into an Audio Montage, you 
can arrange, edit and play back the clips. You can also apply effects, 
fades and crossfades, surround panning and much more, and last but not 
least, you can directly create CDs or DVD-As. All in all, the Audio Mon-
tage is an excellent tool for advanced music CD or DVD-A creation.

Read more about the Audio Montage and its features in the chapter “The 
Audio Montage” on page 371.
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The Basic Audio CD window

If you just want to create an audio CD, with each CD track corresponding 
to a single, whole audio file on disk, you may not need all the editing fea-
tures in the Audio Montage. Instead, you can use the Basic Audio CD 
window. This is an environment that quickly and easily lets you compile 
audio files in a track list and burn them onto a music CD.

You can freely change the order of the tracks, the length of the pauses 
between them and more.

More on the Basic Audio CD window can be found in the chapter “Pre-
paring a Basic Audio CD” on page 347.

The DVD-Audio project window

This is where you make various settings for a DVD-Audio project before 
rendering it and burning it onto a DVD.

A DVD-Audio project can be based on one or more Audio Montages. Af-
ter you have specified a Montage as basis for a DVD-Audio project, you 
can, among other things, create a visual menu for the DVD-A, add DVD 
text, create a bonus group and specify picture transition effects. See 
“DVD-Audio projects” on page 551.

You then render the DVD-Audio project, after which the Data CD/DVD 
window automatically opens where you can optionally add data and other 
contents before burning the DVD (see below). For a general description 
of the DVD-Audio format, see “Background information” on page 366.
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The Data CD/DVD Project window

The Data CD/DVD window can be used for compiling and creating data 
CDs/DVDs (discs that exclusively contain computer data) and Mixed 
Mode CDs (discs that contain both data and audio), as well as DVD-Au-
dio discs that contain audio, data and video.

The window is divided into two panes; the upper is called the source win-
dow, and the lower is the destination window. You drag files from the 
source window to the destination window, in which you can rename, re-
move and move files before burning a CD or DVD.

For a detailed description of the Data CD/DVD window and what you can 
do with it, see “Data CD/DVD Projects” on page 583.
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The CD/DVD Label Editor

This window is the Label Editor. Here you can design and print custom la-
bels for the CDs or DVDs you create. You can create labels for both the 
front and back of a jewel case, as well as for the discs.

Read more about this in the chapter “Creating labels” on page 603.

The Backup Plan window

WaveLab lets you back up all kinds of files and folders onto CD or stan-
dard media. This window lets you decide which files and folders should 
be backed up, and also allows you to make various settings for the 
backup procedure.

For a complete description of this window and how to perform backups, 
see the chapter “Using WaveLab for backup” on page 713.
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The Audio Database window

An Audio Database is a convenient way of storing and organizing audio 
files in libraries and categories, making it easy to locate and access spe-
cific files.

What is stored is not the audio files themselves, but instructions on where 
the files are located. Thus, the files can be located on any storage media 
connected to your computer.

You can read more about this in the chapter “Audio Databases” on page 
683.

The Workspace window

A Workspace lets you collect a number of files that you for one reason or 
another want to “keep together”. This could be all of the audio files used 
in a single song for instance.

How to create and manage Workspaces is fully described in the chapter 
“Workspaces” on page 707.
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The Master Section

This is a very important part of WaveLab, called the Master Section. It has 
a number of uses including:

• Adding real-time effect plug-in processors such as Chorus, Reverb, etc.
• Applying effects to files so that they are permanently made a part of the files (as 

opposed to using them in real-time).
• Monitoring and controlling the output level from every WaveLab channel.
• Adding dithering.

For details, see “Master Section” on page 217.
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Find your way around in WaveLab

Editing and processing

Where do I go if I want to…

• Edit an existing audio file?
When you open an audio file, it appears in a Wave window, in which you can edit it in vari-
ous ways. See “Editing in the Wave window” on page 69.

• Compile and edit several audio files on multiple tracks?
Create an Audio Montage. See “The Audio Montage” on page 371.

• Apply processing to a wave file?
The Process menu contains a number of options for manipulating wave files, including fade-
in/out, normalize, time stretch and much more – see “Off-line processing” on page 175. 
You can also use the Render function in the Master Section to apply effects to a file. See 
“Rendering” on page 239.

• Apply processing and effects to multiple files in one go?
You do this with a function called batch processing. See “Introduction” on page 274.

• Convert an audio file into another audio format?
There are several ways: You can use either the “Save as” command or the “Save Special” 
command on the File menu (see “Saving in another format (Save as…)” on page 117), or 
the “Render” function in the Master Section (see “Rendering” on page 239). Finally, batch 
file encoding lets you convert multiple files to another format – see “Batch file encoding” on 
page 303.

Playback and recording

Where do I go if I want to…

• Play back with real-time effects?
Effects are added in the Master Section, see “Master Section” on page 217. In Audio Mon-
tages you can also add individual track and clip effects, see “Adding effects to tracks and 
clips” on page 474.

• Record new audio files?
Use the Record button on the Transport bar. The new file will appear in a Wave window, 
and can also be added as a new clip in a Montage. See “Recording” on page 146.

• Record songs from an audio CD or DVD into WaveLab?
You don’t – you import them directly from the disc. On the Tools menu there is an option 
called “Import Audio CD tracks” (see “Importing audio CD tracks into WaveLab” on page 
594), and one called “Import DVD-Audio tracks” (see “Importing DVD-Audio tracks into 
WaveLab” on page 599).
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CD/DVD creation

Where do I go if I want to…

• Create an audio CD that can be played back in a regular CD player?
You can either create a Basic Audio CD (see “Preparing a Basic Audio CD” on page 347) 
or an Audio Montage (see “The Audio Montage” on page 371). As the name implies, the 
Basic Audio CD allows for quick and easy CD creation, while the Audio Montage lets you 
perform advanced, clip-based editing.

• Create a DVD that can be played back in a DVD-A player?
A DVD-Audio compatible disc can contain one or several (up to 9) groups. A group corre-
sponds to a Montage in WaveLab. You add the Audio Montage(s) to a DVD-Audio project 
where you also can make various settings, and finally render the project before burning the 
DVD (see “DVD-Audio projects” on page 551).

• Create a data CD/DVD or a Mixed Mode CD/DVD containing audio, data and 
video?
You do this in a Data CD/DVD window. See “Data CD/DVD Projects” on page 583. 

• Create labels for the CDs/DVDs I make?
This is done in the Label Editor. See “Creating labels” on page 603.

Miscellaneous

Where do I go if I want to…

• Use WaveLab for data backup purposes?
Create a backup plan, as described in the chapter “Using WaveLab for backup” on page 
713.

• Use hardware samplers with WaveLab?
WaveLab can communicate directly with a number of different sampler models. This is 
done from the Sampling menu. Read more in the chapter “Using samplers and creating 
loops” on page 657.

The above are just a few pointers to some of the fundamental functions in 
WaveLab. While using them, you will discover a multitude of other fea-
tures and functions that let you make full use of the possibilities of this 
amazing program.

Have fun exploring WaveLab!
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Why you should read this chapter
This chapter describes general methods that you will use when working 
with WaveLab. Getting accustomed with these procedures will allow you 
to work more effectively with the program.

Getting help
WaveLab comes with a detailed help system, making it easy to look up 
procedures and descriptions from within the program. There are several 
ways to access the help system:

• By selecting “Operation Manual” from the Help menu.
This takes you to the help in Adobe Acrobat format (extension “.pdf”). This PDF file contains 
all chapters of the printed manual plus additional sections describing plug-ins, sampler de-
tails, key commands, and troubleshooting procedures.

• By pressing [F1].
If a window is active, you will get help on that window. If a dialog box is open, this dialog is 
described. 

• By clicking on the question mark icon in a dialog.
This will display information about the available items in that dialog.

• By selecting the Help item at the bottom of a menu.
This will give you help about the items on that particular menu.
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Undo and Redo
WaveLab has an extremely extensive Undo function, applicable when work-
ing in Wave windows, Audio Montages or the CD Label Editor. You can:

• Undo as many steps back as you like, by using the Undo item on the Edit menu.
The only limitation is the available hard disk space. You can also use the shortcuts [Ctrl]-[Z] 
or [F3] to undo. [F3] has the added advantage in that you can undo even if a modal dialog 
is currently open.

• Redo as many steps as you like, by using the Redo item on the Edit menu (or by 
pressing [Ctrl]-[Y] or [F4]).

Furthermore, each window has its own undo “history”, so you can click on 
any window and undo the last changes made there, even if you afterwards 
worked in another window.

About Undo and disk space

Many undo operations require no memory or disk space. However, oper-
ations that modify actual wave data (like time stretch, EQ, etc.) require 
that a file copy of the selected part of the wave is stored, so that it can be 
brought back when you need to redo.

For this reason, WaveLab will need to store files on your hard disk, in the 
folder you have specified for the temporary files (see “Temporary files” on 
page 28). These files are automatically deleted each time you close or 
save the related document.

Limiting the Undo function

If you run out of hard disk space or if you are applying processing to ex-
tremely long sections of waves, you might want to put a limit on the Undo 
function (applicable to Wave windows only):

1. Select “Preferences” from the Options menu and click the Wave edit tab.

2. Uncheck the “Unlimited” option in the Undo/Redo section.

3. Change the Limit number to the desired value.
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Clearing the undo

There might be situations where you have “collected” a large number of 
undo possibilities that you know you don’t need. You might then clear the 
whole undo “buffer” for one file at a time. This will free up some primary 
memory (RAM) but more importantly it will also delete all the “undo files” 
from your hard disk, to free up space.

1. Select “Clear undo” from the Edit menu.
A window appears informing you of how much RAM and hard disk space you will gain by 
this operation.

2. Click OK.

Please note that this function works on one document at a time. It is only 
the undo buffer for the file in the active window that will be cleared. Also 
note that it only applies to Wave windows.
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Working with windows

Basic window handling

WaveLab follows the basic guidelines for the Windows interface, which 
means standard “Windows procedures” apply.

Closing Wave windows

You can close a document window by clicking its close button, by select-
ing Close from the File menu or by pressing [Ctrl]-[W]. If document win-
dow(s) contain unsaved changes, you will be asked whether you want to 
save those changes before closing.

• If you hold down [Ctrl]+[Shift] when clicking the close button, the window 
closes immediately. Any changes you have made will not be saved.

• You can also close all windows in one go (either all Wave windows, or all 
windows regardless of type), by selecting the corresponding option from 
the Windows menu.

Minimizing Wave windows

WaveLab windows are minimized like any other, but there are also op-
tions for minimizing all Wave windows or all windows (regardless of type, 
as with closing, see above), from the Window menu.

Quitting

When you quit the program, and have files with unsaved changes, the 
“Exiting with modified documents” dialog, see “Save All” on page 120, 
appears. Selecting all files in the list and clicking Save Selected, ensures 
that all changes made to any and all files, are saved.

Quick window switching

• To “cycle” between all open windows, press [Ctrl]-[Tab] or [Ctrl]-[F6]. 

• If you release the [Ctrl] key, and use any of these commands again, you will 
switch to the previous window, rather than the next window in the stack.
This allows you to quickly move back and forth between two windows.
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The document switch bar

A quick way to switch between the open document windows is to use the 
document switch bar.

In this example, clicking on the tab will bring the “MoonProject” window to front.

• You can position the document switch bar at the top, bottom, left or right 
side of the screen by using the document switch bar submenu on the View 
menu.
This submenu also lets you hide the document switch bar, if you like.

List of open files dialog

This dialog, opened from the View menu (or by pressing [F5]), is useful 
when you are working with many open documents. It shows all currently 
open WaveLab files and documents in a list. The dialog is non-modal and 
will automatically be updated if any window is closed or opened.

• Files with unsaved changes have a red dot before the name. 
• You can navigate the list using the arrow keys, or by using a-z on your keyboard. 



WAVELAB
Basic methods 5 – 51

The dialog contains the following items:

Panes

Several of WaveLab’s windows are divided into panes. Panes are sepa-
rated by dividers. For example, a Wave window can have two panes, the 
Overview and the Main view. A Database window has three panes.

The panes and dividers in a Database window

Item Description

Filter pop-up This pop-up (in the top right corner) allows you to only show files of a 
certain type by selecting an item from the menu.

Visible/Hidden files 
checkboxes

You can select to show visible files and/or hidden files (i.e. files that 
are open internally in WaveLab but not open in a separate window, 
e.g. an audio file referenced by an open Montage). Hidden files are 
shown with grey text.

Edit button This will bring up the selected file as the top window. You can also 
double click on a file in the list or use the [Return] key to do this. If 
Auto-close is checked, the dialog will close.

Play/Stop This will play a selected audio file. If you click Play the button 
changes to Stop.

Save If a file has unsaved changes, this button can be used to save it, in its 
current location (no dialog appears).

Rename This opens the Rename dialog where you can rename a selected file, 
and optionally change its path. See “Renaming files and documents 
(Rename)” on page 121.

Close This closes all selected files.

Exit Closes the dialog.

Dividers

Panes
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Adjusting the size of a pane

1. Position the mouse over the divider between the two panes.
The pointer turns into a two-way arrow.

2. Drag the divider to adjust the pane size.

Hiding and revealing a pane

In some windows, a pane can be hidden altogether. 

To hide a pane, drag the border between the two panes all the way up or 
double click it. To reveal the pane again, drag the miniature divider symbol 
down or double click it.

You can also hide/show the Overview pane in the Wave window by 
pressing [O] on the computer keyboard.

“Folding” windows

If you find a window takes up too much screen space, but you still don’t 
want to close it, you can “fold it in” by clicking on the fold-in icon on the 
title bar. For dialogs, you can also double click on the title bar.

The miniature divider symbol

The fold-in icon
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To return to normal size, just click again.

The Document icon

WaveLab adds another symbol to some document windows, the Docu-
ment icon. This is used to drag the whole document to various other win-
dows, such as Databases, Audio Montages and Basic Audio CDs.

Unsaved changes indicator

When you have made changes to a document window, an asterisk will be 
displayed after the document name in the title bar until you save the doc-
ument.

The normal Time Stretch dialog…
…and when “folded in”.

The Document icon
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Working with multiple windows

You can edit the same data in more than one Wave window. Among other 
things this allows you to work on different sections of a wave file (for ex-
ample the start and end), without scrolling back and forth.

• The two windows are views of exactly the same data. 
Any change you make in one Wave window is immediately apparent in the other.

Creating a second window using menus

1. Make sure the desired window is the active one.
If it isn’t, click once in its title bar.

2. Select Duplicate View from the View menu.
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Creating a second window by dragging

1. Make sure “Create windows using mouse” is activated on the Prefer-
ences–Wave edit tab.

2. Click and drag a rectangle in an empty area of the WaveLab window.
This must be of a certain minimum size or bigger. If you don’t get a new window, try again 
with a bigger rectangle.

Dragging a box like this will create a new window for this audio file.
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Windows sets, snapshots and Wave view settings

In addition to the above, there are other ways to manage windows:

• Snapshots store individual settings for one Wave window at a time, which allows 
you to quickly move between various views of a file. See “Snapshots” on page 87.

• Screen layouts store document window and dialog box positions and sizes. See 
“Working with window layouts” on page 744.

• View settings can be automatically stored (Preference setting) when saving wave 
audio files. This will store all view settings for an individual Wave window; i.e. win-
dow size & placement, time ruler style, scroll positions, selection ranges, snap-
shots and a master section preset. See “Saving view settings” on page 124.

Dockable control bars
Various tools, shortcuts and commands are gathered on “control bars” 
(strips with symbols). These can be used either as “palettes” (separate 
windows) or you can “dock” them to the window edges. 
The following control bars are available:

• The Standard Commands
• The Transport bar
• The Meters
• The Window Controller
• The Wave toolbox
• The Wave Snapshots control bar
• The Marker toolbar

Docking a control bar

There are two ways to dock a control bar:

• Drag the control bar window (by its title bar) to any of the sides of the application 
window and release the mouse button.
The outline shows you the shape of the control bar at the docked position.

• Double click the title bar of a control bar to return it to its last docked position.

Please note that you can stack control bars and put them side by side, to 
create any type of layout you desire.

In this example, the Standard Commands, Toolbox and Transport control bars have all 
been docked to the upper part of the application window.
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Turning a docked control bar into a separate window

To “un-dock” a control bar, drag it out from the docked position, or dou-
ble click somewhere on its handle.

• Control bar windows are moved by dragging the title bar, just as with any 
other window.
To drag a control bar on side of the application window, without docking it, hold down [Ctrl] 
when dragging.

Showing/hiding a control bar

There are various ways to show/hide a control bar:

• Pull down the View menu, select Control Bars, and from the submenu that ap-
pears, select the desired control bar, or…

• Click on a button on the Window controller (a control bar used for showing/hid-
ing other control bars, see below), or…

• Hide a control bar by clicking its Close box.

Changing the appearance of a control bar

To change the shape of a control bar to either horizontal, square or verti-
cal, drag the right or bottom edge as when resizing any other window. 

To change the size of the buttons in the control bar, open the Prefer-
ences–Environment tab and adjust the “Button size” setting.

Finding out what a button on a control bar does

1. Select Preferences from the Options menu and click on the Environment 
tab.

2. Make sure “Show Tips” is activated.

3. Close the Preferences dialog.

4. Move the pointer over an item on the control bar and wait a moment.
A text showing the name of the button appears.

An example of a “Tip” pop-up for the control bar.
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The various control bars

The Window Controller

The Window Controller acts as “master selector” for the main windows 
and control bars, providing quick access even to those that have no key-
board shortcut. If a Window Controller button is “pressed”, the corre-
sponding window/bar is active and visible. If not, the window/bar is 
hidden.

The Standard Commands

The Standard Commands bar supplies shortcuts for the most commonly 
used menu items, as well as some unique functions.

The Toolbox

The tools are used to perform various operations on the data in the win-
dow, like selecting, playing, etc.

The Snapshots control bar

This is used to store and recall window “layouts”, see “Snapshots” on 
page 87.
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The Transport bar

The Transport bar is used for various playback commands, see “Using the 
Transport bar” on page 135.

The Marker toolbar

This is used for various commands related to markers, see “Introduction” 
on page 328.

The Meters

This provides shortcuts to the various level meters in WaveLab, see “Me-
tering” on page 155.

The status bar

This is normally displayed at the bottom of the screen, but it can be hid-
den on the Preferences–Environment tab. 

The status bar shows information related to the active window. Exactly what 
information appears depends on the window type – for Wave windows it 
shows various information about the file. See “The status bar” on page 79.

• For some of the fields you can also click to perform operations related to that field.
• The status bar also indicates the progress of operations that take some time to 

finish.
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Speed menus
Most displays have speed menus associated with them.

• To bring up a speed menu, right-click in the desired area.
In the Wave windows for example, there is one speed menu for the level ruler, one for each 
of the time rulers and one for each of the waveform displays.

The Wave window main view “speed menu”

The Speed menus contain the same items that can be found on the main 
menus, but some speed menus also contain unique items.

When searching for a function, don’t forget to check the speed menus in the 
window in which you are working!
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Units of time and level

For rulers

You can specify the time and level (amplitude) formats for each ruler in 
each window, by right-clicking on the ruler and selecting a format from 
the pop-up menu that appears.

Time formats

Level formats

• To make a ruler format the default (to be used in new Wave windows), you 
need to save it as part of the default window style.
See “Styling WaveLab – Wave windows” on page 734.

Menu name Description

Time Positions are shown as hours, minutes, seconds and milliseconds. At large 
magnification factors, hundredths of milliseconds are shown.

Samples Positions are shown as number of samples. How many samples there are to 
a second depends on the sample rate of the wave. For 44.1 kHz for exam-
ple, there are 44100 samples for each second.

Time code Also called SMPTE. Positions are shown in the following format:
hours:minutes:seconds:frames.
The number of frames per second is set on the Preferences–Sync tab.

Meter Positions are shown as bars, beats and ticks, as specified on the Prefer-
ences–Sync tab.

File size Positions are shown in file size units, MegaBytes, where the decimals repre-
sent kiloBytes.

Menu name Description

% Amplitude (level) is shown as a percentage of full level.

dB Amplitude is shown in decibels, a logarithmic scale used in audio engineer-
ing.

Decimal This is the actual value of the amplitude as stored in computer memory (al-
ways displayed as 16 bits). Please note that the range is from negative to 
positive with “0” representing “no signal”.
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Setting values
In dialog boxes, you will find yourself adjusting values. The following tech-
niques apply:

Typing values

As in most other Windows programs you can “tab to” or click directly on 
a value and type in a new one.

Using the spin controls/value fields

Values can be set using either the regular Windows spin controls, or any 
of the other methods described below.

• Clicking either arrow raises/lowers the value.
• Keeping the mouse button pressed over an arrow will “scroll” the value.
• Holding down [Ctrl] makes the value change in larger steps.
• Holding down [Ctrl]+[Shift] changes the value to its minimum/maximum.
• The last adjusted control can be changed using the [↑] and [↓] keys, also in com-

bination with [Ctrl] or [Ctrl]+[Shift] as described above.
• You can also click and hold in the value field and move the pointer up or down to 

change values.
• Pointing in a value field will display the available parameter range.
• The down arrow to the right of the spin controls brings up a history pop-up where 

the last applied value change(s) in the current dialog are shown and can be se-
lected.

Using sliders and pop-ups

Many times, the most convenient way of changing a value is using Wave-
Lab’s proprietary sliders and pop-ups:

1. Click with the right mouse button on the spin control (in some windows 
you can also double-click with the left mouse button).

2. If a pop-up menu appears, select one of the options on it.

The spin controls

The history pop-up
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3. If one or more sliders appear, drag the handle(s) or click the arrows to set 
the value.
The setting is shown in the value box “behind” the slider window.

4. When you have finished, click outside the slider window.
• If the value is “segmented” (for example divided into minutes and seconds, etc.), 

more than one slider will appear, each used for adjusting one of the “segments”.
• The slider window can be dragged to any position on the screen, using the “ title 

bar” at the top.
• The last-used slider can also be adjusted using the computer keyboard: .

In effect processor panels

In the Master Section you will find either generic or custom effect panels 
for each effect processor. In custom panels, values are adjusted using 
special methods, see “The Effects pane” on page 225.

Using a wheel mouse

If you are using a mouse with a scroll wheel or similar, you can take ad-
vantage of the wheel for various operations in WaveLab:

Scrolling

If you point at a waveform, the wheel scrolls the view horizontally.

These keys Move the slider handle

[↑] and [↓] One step up/down.

[Page Up] and [Page Down] A few steps up/down.

[Home] and [End] To the top/bottom.

In this case, four faders appear, one 
for the integer and three for the dec-
imals.

The value gets updated when you 
move the sliders.
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Zooming

If you hold down [Ctrl] and point at a waveform, the wheel zooms the view 
horizontally.

If you hold down [Ctrl] and [Shift] and point at a waveform, the wheel 
zooms the view vertically.

Changing values

If you point at an edit field in a dialog, the wheel can be used to adjust the 
value.

• If you hold down [Ctrl], the value changes in bigger increments.
• If you hold down [Ctrl]+[Shift] the value jumps to the minimum or maximum.

Master Section

• When working in the Master Section window, the wheel can be used to 
adjust the master volume. 
You have to point in the Master Section for this to work.

• This functionality can be turned off in the Preferences–Environment tab.
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Presets
Many dialogs in WaveLab have either a Presets tab or a Presets pop-up 
menu. If you think of the dialogs as forms, presets allow those forms to be 
filled out automatically. WaveLab comes with a selection of presets for 
most dialogs that use them, but the real power of presets becomes evi-
dent when you start creating your own!

• For some WaveLab effect panels there is a Preset button instead of a Pre-
sets tab or pop-up menu. Clicking the button opens the Presets dialog 
which has the same items as described below.

Depending on how presets are displayed in a certain dialog (tab or menu) 
they are handled slightly differently, but both cases are described below.

A number of presets in the Harmonization dialog

Loading presets

1. Open the dialog you wish to use and click on its Presets tab or pull down 
its Presets menu.

2. Select the preset you want to use. 

3. Where applicable, click the Load button.

• A quick way to load a preset is to right-click on the Preset tab and select a 
preset from the menu that appears.
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Creating a preset

1. Open the dialog you wish to use and set up the dialog as desired.

2. Click on the Presets tab or pull down the Preset menu.

3. Click on the name line and type in a name for the preset or click the Save 
As… menu item and type in a name in the dialog that appears.

4. Where applicable, click the Add button.

Modifying a preset

1. Load the preset you want to modify, as described above.

2. Make the desired settings in the dialog.

3. Click the Update button or click the Save item.

Deleting a preset

1. In the Presets tab, click on the preset you want to delete.

2. Click the Delete button.

Or…

1. From the Presets menu, select the option Explore presets.

2. In the Explorer window that appears, select the preset file you want to de-
lete and press [Delete].

Store temporarily and Restore

Some dialogs also allow you to quickly save and load up to 5 presets with 
the Store temporarily and Restore menu items. This is useful if you want to 
quickly test and compare different settings.

1. Select the option “Store temporarily” and from the submenu select the 
number under which you want to save (#1 – #5).

2. To quickly load the saved settings again, select the corresponding num-
ber from the Restore submenu.

How presets are saved

The presets are automatically saved when you quit the program. The next 
time you load the program, the presets are ready and waiting, just as you 
left them. Furthermore the presets are “global” to all files. No matter which 
file you are working on, you still have access to all your presets.
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About non-modal dialogs
Many of the dialog boxes in WaveLab are “non-modal”. This means that 
the window behind the dialog can be operated even though the dialog 
box is still up on the screen.

For example, when you have a Processing dialog up on screen, you can 
still work with the Wave window and the main menus. For example, this 
allows you to perform the following operations without closing the dialog.

• Play back the wave to hear the effect of any applied processing.
• Adjust the selection before re-processing.
• Use the menu to undo the last processing.

Keyboard commands

Windows normally does not allow you to select from menus and use key-
board accelerators when a dialog box is the active window. However, we 
have provided a few special key shortcuts for the most crucial commands:

Key Command

[F3] Undo

[F4] Redo

[F6] Play selection

[Shift]+[F6] Activate loop and play selection

[F7] Stop

[F8] Play
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Using the computer keyboard
When you are working with WaveLab, the computer keyboard has several 
different uses:

Transport controls

The Transport functions (such as Play, Stop, Record and so on) can all be 
managed from the computer keyboard. The keyboard commands for these 
functions are located on the numeric keypad, to the right on the computer 
keyboard. See “Using the Transport bar” on page 135 in this book.

Keyboard shortcuts

Shortcuts for menus

Many of the items in WaveLab’s menus have a computer keyboard equiva-
lent – an “accelerator”, listed on the menu. Some abbreviations might need 
an explanation:

Due to the large number of functions in WaveLab, some key commands 
consist of double or triple key strokes (known as “key sequences”). These 
are displayed with the different keys separated by comma signs. 
For example, “Alt+F12, T” means “hold down [Alt] and press [F12], re-
lease, then press [T]”.

Customizable shortcuts

You can define you own key shortcuts for a number of functions in the 
program, see “Customizable key/MIDI commands” on page 746.

Additional shortcuts

In addition to the above, there are key commands that are not listed on the 
menus or in this manual. Check the Key Commands chapter in the online 
documentation for a full list.

Abbreviation Description

KP The numeric keypad. “KP 2” for example means the “2” key on the 
numeric keypad.

BkSp The Backspace key.

F1 to F12 The Function keys.
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About this chapter
The Wave window is the heart of WaveLab’s audio editing capabilities. 
This is where you view, play back and edit individual audio files. This chap-
ter describes how to open and save audio files, how to perform wave edit-
ing and how to handle the Wave window itself.

Creating new empty documents
If you want to start with an empty file, for assembling material from other 
files for example, proceed as follows:

Using menus

1. Select New from the File menu, and Wave from the submenu that ap-
pears.
Or, right-click the New icon on the Standard Commands control bar.

2. Fill out the dialog that appears.
See “Supported file formats” on page 113 for details about the various options.

By dragging

This is only possible if the currently active window is a Wave window (or 
if no document windows are open).

1. Make sure “Create window using mouse” is activated in the Preferences–
Wave edit tab.

2. Drag to make up a box in an empty free area of the WaveLab application 
window.
This must be of a certain minimum size. If you don’t get a new window, try again with a big-
ger box. The new window “inherits” its attributes from the last active window. If no window 
is open, the dialog box settings for units are used instead.

About display options

There are a number of options that govern how a window will look when it 
is first created. These are all found on the Preferences–Wave edit tab. 
Click the question mark icon in the dialog for details.
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Opening Waves

For a list of supported file formats, see “Supported file formats” on page 113.

Using the Open dialog

1. Select Open Wave from the File menu, press [Ctrl]-[O] or click the Open 
icon on the Standard commands control bar and select “Wave…” from 
the pop-up menu that appears.

2. Use the standard controls to locate and select the desired file.
The file format pop-up allows you to only view files in a certain format and the buttons in the 
upper left half provide various views of the files on the disk.

3. Click Open.
The Wave appears in a new window.

Below follow descriptions of the items/procedures which are not stan-
dard for all Windows Open dialog boxes:

The Recent Folders pop-up menu

At the top of the dialog, you will find a pop-up menu which lists the most 
recently accessed folders. Select one to open it.

The playback functions

Once you have selected a file in the list you can audition it by clicking 
Play. Click again to Stop.

You can also have files play back automatically as soon as they are se-
lected. To do this, activate the Auto button.

Opening multiple files

As in many other Windows programs, you can select and open as many 
files as you wish. The [Shift] key is used for making continuous selections 
and [Ctrl] is used for selecting any combination of files.

When you click Open the selected files will be opened, each in an individ-
ual window.

The Open in Audio Montage window option

If you check this option at the bottom of the dialog, the file(s) you open will 
be placed in an automatically created new Audio Montage. 
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Opening dual mono files

If you have two mono files which are actually the left and right channels of 
a stereo recording (some systems handle stereo this way), you can open 
these as if they were a stereo file. Proceed as follows:

1. Open the Preferences from the Options menu, and click the File tab.

2. Make sure the option “Allow opening of dual mono files” is activated, and 
close the dialog.

3. Select Open Wave from the File menu.

4. Select the first file, hold down [Ctrl] and select the other.

5. Click Open.
The two files are opened as one stereo file, with the file with the first name (alphabetically) 
becoming the left channel. If this is not as desired, you can swap the channels, see “Swap-
ping channels in a stereo file” on page 111.

You can now work on the two files as if they were one. You can later save 
them as a stereo file or as two mono files. See “File handling in Wave win-
dows” on page 113.

• You may want to deactivate the “Allow opening of dual mono files” option 
when you’re done, to avoid accidentally opening two separate mono files as 
a dual mono file.

Inserting a file into the current document

You may have a file that you want to insert into an existing file. The two 
must have the same attributes (e.g. sample rate), or a warning will appear.

1. Locate the document into which you want to add material, and make it ac-
tive.

2. If you want to add the file at some arbitrary position in the document 
(rather than at the beginning or end), click to move the wave cursor to that 
position.

3. Pull down the Edit menu and select Insert Audio File and then one of the 
options from the submenu that appears.

4. Select a file and click Open.
The file is added. If you used the “at cursor position” option, a temporary marker is added at 
the insertion point.
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Using drag and drop

To open files from the Windows desktop, use one of the following possi-
bilities:

• Drag and drop the file(s) on the WaveLab application window.
• Drag and drop the file(s) on the WaveLab program icon or a shortcut for it.

If the program isn’t already running, it will be launched. This works even if the application is 
running but minimized.

To Nuendo

• It is also possible to drag and drop files from WaveLab to Steinberg’s Nuendo!
This should be done using the Document button or from a Database window.

Opening files from the desktop

To open a file in WaveLab by double-clicking on it, you must have created 
an association between the file format and the WaveLab application. 
Such an association can be set up in two ways:

• There is an option to automatically associate certain file formats with 
WaveLab during the installation process.

• You can also do this from within WaveLab at any time by selecting “Asso-
ciate all files of this type with WaveLab” on the File menu–Special sub-
menu.
This association is made according to the currently selected file’s format, and will ensure 
that all files of this format always opens with WaveLab.

Using the Recent Files lists

On the bottom of the File menu you will find one or several hierarchical 
menu items that allow you to open recently used document files. There 
are different submenus for different file types, as indicated by the menu 
items (“Recent Audio Files”, “Recent Audio Montages”, etc.). Each sec-
tion holds up to forty files (this number can be set in the Preferences–En-
vironment tab). Selecting an item on one of the submenus opens the 
corresponding file.
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At the bottom of these submenus there is an item named “Open file se-
lection box”. If you select it, a dialog opens. This is a handy file manager 
dialog which lists all recently used files of the corresponding type. Up to 
200 files can be shown (this is set in the Preferences–Environment tab) in 
the dialog. 

• Files in this list are by default sorted according to when the files were last 
used, but you can click on a column header to sort the list by Name or Path.
You can also navigate in the list using the keyboard (a-z keys or the arrow keys) as usual.

• This dialog allows you to select multiple files (using standard [Shift] or 
[Ctrl] commands) for opening.
Clicking OK opens all selected files and closes the dialog. You can also double-click a file 
in the list to open it and close the dialog.

• By clicking the “Remove selected files” button you can remove selected 
files from the Recent list.
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Using Favorites

Just above the “Recent…” items is the Favorites menu. This lets you cre-
ate a “library” of files that you want to be able to open quickly.

• The “Add current document” option, adds the currently active document to the 
menu.
The list is sorted alphabetically.

• “Validate list” checks whether each document on the menu is still residing in the 
specified location on your hard disk(s).
If a document can’t be found, it is removed from the list.

• “Clear list” removes all files from the menu.

Opening Wave files from within other windows

You can also open files from the Workspace and Database windows as 
well as from Basic Audio CD windows, Audio Montage windows and the 
Batch dialog. See the respective chapters for details.

Importing tracks from an audio CD

This is described in the section “Importing audio CD tracks into Wave-
Lab” on page 594.

Importing tracks from a DVD-A disc

This is described in the section “Importing DVD-Audio tracks into Wave-
Lab” on page 599.
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Window overview and adjustments

About the window sections

Main view

The lower waveform area is where the main action is going on. It is here 
that you select, apply tools, drag and drop, etc. 

• There are both time and level rulers. These can be hidden and displayed (see the 
ruler and wave display speed menus). You can also set which units of time and 
level they show (see “Units of time and level” on page 61).

Overview

The overview is mainly used for navigating through long files. Since you 
can have different zoom factors in the two areas, the Overview can dis-
play the entire wave while the Main view only shows you a short portion. 
You can also synchronize these views – see “Synchronizing the views” on 
page 78.

Overview

Zoom controlsMain view Display mode pop-up

Display mode pop-up

Left audio 
channel

Right audio 
channel
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About the Display modes

Both the main view and the overview can independently be set to show 
the audio in one of three display modes:

• Wave display.
This is the standard waveform display, as shown in the main picture.

• The Spectrum display. 
This displays the audio as a “spectrogram” which allows you to view the level intensity of 
each area in the frequency spectrum across the time line. This mode allows for very precise 
and specialized editing operations in the time/frequency domain using the Spectrum selec-
tion tool – see “Spectrum Editor” on page 255.

• The Loudness Envelope display.
This displays the average loudness of an audio file, which can be useful in many circum-
stances. See “About the Loudness envelope display mode” on page 129.

You select which view is shown in each section from the pop-up to the 
left of the respective horizontal Zoom control.
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Synchronizing the views

You may find it useful to work with separate display modes for the main 
view and the overview, as this gives you the option of viewing the audio in 
two different ways. In such cases you might want the two views to display 
the same part of the audio file simultaneously, so that the cursor position 
is synchronized in both views.

• This is done by selecting “Synchronize top and bottom views” from the 
Display mode pop-up menu (either for the main view or the overview).
When this is selected, the horizontal Zoom control (see “About zooming” on page 80) is 
only available in the main view.

• In the rest of this chapter the Wave editing are described for the standard 
Wave display mode.
The Loudness Envelope display mode and the various options available are described sep-
arately at the end of this chapter – see “About the Loudness envelope display mode” on 
page 129. Spectrum editing is described in a separate chapter – see “Spectrum Editor” on 
page 255.
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The status bar

The status bar can be hidden. This is done on the Preferences–Environ-
ment tab. The status bar provides the following information:

• The Wave and Mouse cursor time positions are shown using the same unit of 
time as in the rulers and dialog boxes.

• Level positions are always shown in dB.
• The “Selection length” field shows the length of the entire wave if nothing is se-

lected, and the length of the selection (in brackets) if there is one. If you click this 
value the window zooms in on the selected range.

• If Spectrum display mode is selected, the Level is substituted for Frequency. 

Sizing, moving and minimizing

WaveLab uses standard Windows techniques for resizing, moving, maxi-
mizing and minimizing windows. See your Windows documentation for 
details.

Maximizing width

Selecting the Maximize Width item on the View menu makes the window 
as big as the screen (or any other factor) permits.

The divider

The divider between the Main view and the Overview can be dragged to 
change the view sizes. See “Panes” on page 51 for details.

Mouse cursor position/Level 

Zoom factorWave cursor position/Selection length

File format details (see “Supported 
file formats” on page 113)
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Setting the zoom factor

About zooming

Horizontal zoom

• When you zoom out all the way the entire file fits the window.
• When you zoom in as far as possible, each sample will occupy several pixels on 

the screen. This allows for single sample-accurate editing of waveforms.

Vertical zoom

• When you zoom out all the way, the complete height of the wave fits into the win-
dow. You can note this by checking the ruler on the left side.

• As you progressively zoom in, the display will only show you a smaller part of the 
total height. Exactly which section you see can be adjusted with the vertical scroll 
bars. Again, check the ruler to see which part of the waveform is currently shown 
in the display.

Zoom out all the way to 
see the entire wave.

Zoom in until you can see 
each individual sample 
point, for very detailed 
editing.
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For example, to check the peaks of the waveform in great detail, zoom in 
and scroll all the way up and down.

Using the zoom controls

Both the Main view and the Overview have horizontal and vertical zoom 
controls. These behave just like scroll bars:

• You can drag the handle to any position.
• You can click anywhere on the scale to move the handle there.
• You can click on the arrows at either end to change the zoom factor in smaller 

steps.
Either way, the zoom factor on the status bar is updated continuously.

Using the Magnifying Glass tool

The Magnifying Glass tool is used to specify any section of the waveform 
and have it occupy the entire window.

The Magnifying Glass tool selected.

Detailed view of 
waveform peaks

Vertical and horizontal zoom 
controls
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Selecting the tool

The Magnifying Glass tool can of course be selected from the tool box, 
but there are two other options:

• When you hold down [Ctrl] and move the pointer over the Main view, the Magni-
fying Glass is automatically selected.
This is just a momentary selection. As soon as you release [Ctrl] you get the previous tool 
back.

• When you move the pointer over the overview, it turns into the Magnifying Glass 
automatically.

Using the tool in the Main view

1. Press the mouse button with the pointer somewhere in the waveform.

2. Drag left or right to make up a box, and then release the button.
The area encompassed in the box now fills up the entire window.

Making a box like this…

…zooms in so that the 
“boxed” area will span the 
entire display.
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Using the tool in the Overview

The Magnifying Glass can be used in the Overview, just as in the Main 
view. However, even though you use the tool in the Overview, it is the 
Main view that gets zoomed.

You can for example use this as follows: keep the Overview zoomed out 
all the way and use the Magnifying Glass tool to display any section in the 
Main view.

Mouse zooming

Using the mouse, you can continuously change the zoom factor by drag-
ging:

1. Position the mouse pointer over the ruler in the Main view.

2. Press the mouse button and drag up or down.
The zoom factor changes continuously.

Dragging to change the zoom factor.

• To zoom with the cursor in a fixed center position, hold down [Shift].

• To make vertical zoom adjust automatically to the peaks in the waveform, 
hold down [Ctrl].

• To switch to scrolling, hold down [Alt].

This technique works very well in combination with the fact that you can 
move the song position by dragging horizontally in the ruler. By dragging 
in both directions, you can quickly find a certain position in the file and 
display it at the desired magnification factor.

Using mouse zooming to its full effect requires some practice – but it is 
worth the effort!

Setting sensitivity for mouse zooming

On the Preferences–Environment tab, there’s a Sensitivity setting for 
mouse zooming. The higher the value, the less sensitive the function. You 
might want to raise this value when you first try out the function.
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Using a wheel mouse

• If you hold down [Ctrl] and point at a waveform, the wheel zooms the view hori-
zontally.

• If you hold down [Ctrl] and [Shift] and point at a waveform, the wheel zooms the 
view vertically.

Using the Zoom menu

The Zoom submenu can be invoked from two places:

• From the main view menu.
• By clicking on the Zoom factor on the status bar.

It provides the following options:

Using the keyboard

A quick way to zoom the active Wave window is to use the arrow keys on 
the computer keyboard: Press [arrow up] or [arrow down] to zoom in or 
out (respectively) horizontally. Hold down [Shift] and use the arrow keys 
to zoom in or out vertically.

There are also additional key commands for zooming – check the Key 
Commands chapter in the online documentation for a full list.

Option Description

Restore last zoom Brings back the last zoom factor set using this menu or the Magnifying 
Glass tool.

Overview Zooms the view out as far as possible.

Zoom in 1:1 Zooms in so that one pixel (dot) on the screen represents one sample.

Microscope Zooms in as far as possible, so that one sample occupies several pixels.

Zoom selection Zooms the window so that the current selection (see “Selecting” on 
page 91) fills the entire display. You can also click the selection range 
(in brackets) on the Status bar.

Custom… This brings up a dialog that allows you to enter any zoom factor. Click 
the question mark icon in the dialog for details.

Optimize vertical 
zoom

This changes the vertical zoom factor so that the peaks are clearly visi-
ble. This adjustment is done according to the section of the wave cur-
rently visible in the window, not the whole file.
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Using auto zoom for Overview

This setting, found on the Preferences–Wave edit tab, allows you to have 
the zoom factor automatically adjusted, so that it always shows the entire 
wave. 

1. Activate “Auto zoom for overview” in the Preferences dialog.

2. Zoom out on the overview so that you see the entire wave.
Now, when you resize the window, the overview zoom factor is automatically adjusted so 
that the entire wave is always shown. If you then zoom in on the overview, the automatic 
zooming is deactivated until you zoom out all the way again.

Which part of the file do I see?

In the overview, a striped line called the “range indicator” tells you which 
section of the file is currently displayed in the Main view. Note that the 
range indicator is only shown, if the option “Synchronize top and bottom 
views” is deactivated.

Furthermore, the range indicator moves while you drag the scroll bar han-
dle. This means that by observing the overview you can easily find posi-
tions in the Main view when scrolling, even though the Main view might be 
zoomed in very closely.

The range indicator can be displayed at the top or bottom of the overview, 
see “Range Indicator at top/bottom” on page 737.

When you drag the scroll bar, the range indicator continuously shows you 
which part of the wave is shown in the Main view.
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Navigating through the file
There are several ways to move the view to a certain position in the file:

Scroll bars

This is the most evident option. These work exactly as in any other Win-
dows program. Please note that the waveform scrolls while you drag the 
scroll bar handle.

Furthermore, WaveLab uses proportional scroll bars, that is, the size of 
the handle shows you how much of the entire document you see. To get a 
feeling for how this works, drag the horizontal zoom control while observ-
ing the size of the scroll bar “handle”.

Centering the view vertically

If you have zoomed in vertically, you might want to center the waveform 
view. To do so, double click in the level ruler.

Clicking in the Overview

If you click once in the Overview, the Main view is scrolled so that the po-
sition where you clicked is shown on the left side of the window.

Using the Scroll to menu

To bring up the Scroll to menu, either select “Scroll to” from the Main view 
menu, or right-click in the Overview or the Main view. 
The difference between the methods is that the main menu always affects 
the Main view, whereas the speed menus affect either view depending on 
where you clicked.

The following options are available on the menu:

Option Scrolls the view to

Start/End The beginning or end of the wave.

Selection start/end The beginning or end of the current selection, if any.

Cursor The wave cursor.
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Clicking on the status bar

If you click on the cursor position on the status bar, the view is scrolled so 
that the wave cursor becomes visible.

If you right-click instead, a dialog appears to let you specify a certain time 
position to scroll the view to.

Using a wheel mouse

If you move the wheel down the scroll bar will move forward and vice 
versa. You can also hold down the wheel and drag the view in either 
horizontal direction.

Snapshots
Snapshots store the Main view’s “layout” – essentially two things:

• How a window is scrolled (which part of the wave you see).
• The window’s zoom factor.

If you move back and forth between various positions in a file, or if you 
zoom in and out for detailed or overview editing, using snapshots will save 
you a lot of time. Snapshots are created and managed on the Wave 
Snapshots control bar, opened from the View menu.

To create a snapshot, you first set up the view as desired (by scrolling 
and/or zooming). Then click the camera icon on the Wave Snapshots 
control bar, followed by one of the numbers. The snapshot is now stored 
under that button. The fact that the snapshot is used is indicated by a red 
circle around the number.

You use the same procedure to “reprogram” existing snapshots.

To recall a stored snapshot, simply click on its number on the Wave 
Snapshots control bar.

• Snapshots will be automatically saved with the individual file if “Save view 
settings in companion file” is activated in the Preferences–Wave edit tab, 
see “Saving view settings” on page 124. 

This snapshot is “programmed”.
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Setting the ruler start position
Normally, the ruler is set so that the beginning of the file represents posi-
tion “0”. However, for editing purposes you may want to set the “0” posi-
tion at some other point in the file. The picture sequence below shows 
you how to do this:

1. Set the wave cursor where you want the “0” position.

2. Right-click the ruler to 
bring up this pop-up menu.

The ruler start position 
is moved.

3. Select “Set 
origin at cursor”.
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Working with a meter based display
If the material on which you are working is tempo based, and you know 
the tempo, you can make the ruler show positions in meter format (bars, 
beats and ticks), to make it easier to find musically related cutting points:

1. Select Meter for the ruler time format, see “Units of time and level” on 
page 61.

2. Open the Preferences–Wave edit tab.

3. Set the Time Signature and Tempo to match the file.

4. Set the “Ticks per quarter note” setting to a number you feel comfortable 
with.
This might for example be the same value as that used by your MIDI sequencer.

In this example, a meter ruler with 96 ticks per quarter note is used.

Setting the wave cursor position
Many operations, such as playback and selection depend on the current 
cursor position – for example, playback often starts at the cursor. The cur-
rent cursor position is indicated by a vertical flashing line, both in the Main 
view and in the Overview. There are various ways to move the wave cursor:

• By clicking once somewhere in the Main view or on the time ruler.
If you have a selection, click on the ruler, since clicking in the waveform deselects all.

• By clicking and dragging in the time ruler.

• By using the Transport controls (see “Setting the start point for playback” on 
page 136).

• By using the “Move cursor to” menu on the View menu.
The options on this are similar to the “Scroll to” menu, see above. There’s also a “Position” 
option which allows you to specify any position in the format selected for dialogs and a 
“Snap Cursor” option described in the section “Using “Snap Cursor”” on page 90.
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• By using the Cursor keys:

• By using markers
Markers allow you to pre-define positions and move the cursor there, see “What are mark-
ers for?” on page 328.

Using magnetization

If you have “Magnetize bounds” on the Options menu activated and drag 
the cursor on the time ruler, it will “snap” to the following positions:

• The start and end of the entire wave.
• The start and end of the selection.
• Markers (see “What are markers for?” on page 328).

Using “Snap Cursor”

This function – which can be reached from the “Move cursor to” item on 
the View menu and from the main wave display speed menu – moves the 
cursor position automatically for you. There are two options:

• Move to the closest zero crossing (see “Snapping to zero crossings” on page 95) 
to the left of the cursor position.
To get this effect, make sure “Snap to time unit” is turned off on the Options menu.

• Move to the zero crossing closest to a major time unit.
For example, this can be to the zero crossing closest to a whole second on the time ruler. 
To get this effect, make sure “Snap to time unit” is activated on the Options menu.

In the last case, the “time unit” mentioned depends on which type of scale 
is selected for the ruler:

These keys Move the wave cursor

[←] and [→] One “pixel” (screen dot) in either direction.

[Ctrl] + [←] and [→] Twenty “pixels” in either direction.

[Home] and [End] To the beginning and end of the wave.

Option Cursor moves to

Time Closest whole second

Samples Function not available

Time code Closest frame

Meter Closest whole beat
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Selecting
Almost all types of editing and processing you perform in WaveLab oper-
ate on the selection. There are numerous ways to make a selection:

By dragging or [Shift]-clicking

The standard way to select a range in a Wave window is to click and 
drag. If you drag all the way to the left or right side of the window, it scrolls 
automatically, allowing you to select larger sections than what can be 
shown in the window. The speed of the scrolling depends on how far from 
the window edge you are.

You can also press [Shift] and click in the Wave window to make a selec-
tion between the position of the wave cursor and the click position.

By using the Audio Range dialog

Another way of selecting a range in a Wave window is to use the Audio 
Range dialog. This dialog, accessed by selecting the “Edit…” item from 
the Select submenu on the Edit menu, allows you to define a selection 
range in great detail. See “Using the Audio Range dialog” on page 141.

Selecting in stereo files

If you are working on stereo material you can select either channel or both 
so that you can apply an operation to one channel only or to the entire 
stereo material. Which channel will be selected when you drag or [Shift]-
click depends on where you position the mouse pointer, as indicated by 
the pointer shape:

• To select a single channel by [Shift]-clicking, you need to set the wave cur-
sor in only one channel (by clicking in the upper or lower part of the wave) 
and then [Shift]-click in the same channel.

Position Pointer Shape Description

Upper half of left channel Only the left channel will be selected.

Middle area Both channels will be selected.

Lower half of right channel Only the right channel will be selected.
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Switching the selection between channels

If you have made a selection, you can move this to the other channel or 
extend it to both channels by selecting the corresponding items from the 
Select submenu (on the Edit menu). Or, you can press [Tab] to move the 
selection between channels (if there is no selection, [Tab] moves the cur-
sor between channels).

Selection shortcuts

There are a number of ways to quickly make certain selections (for many 
options there is more than one method):

To select… You can…

The area between two con-
secutive markers

• Double click between them.
• Depending on the type of marker, use one of the last three options 
on the Select menu (on the Edit menu).

The area between any two 
markers

• Double click between two markers, keep the mouse button 
pressed and drag left or right.

The entire waveform • If there are no markers, double click.
• Triple click.
• Press [Ctrl]-[A].
• Select “All” from the Select menu on the Edit menu.

From the cursor to the fol-
lowing or previous marker

• Select “From cursor to previous/next edge” from the Select menu 
(on the Edit menu).
• Hold down [Shift] and double click between the cursor and the 
marker.

From the cursor to the be-
ginning or end of the file

• Select “From cursor to start/end of file” from the Select submenu 
(on the Edit menu).
• Hold down [Shift] and double click to the left/right of the cursor 
position.
• Press [Shift]+[Home] or [Shift]+[End].

All data between two start/
end CD, loop, 
region or mute markers

• Hold down [Shift] and double click on either marker head.

Half or double the current 
selection length

• Select “Halve the selection length” or “Double selection length” 
from the Select menu on the Edit menu. These options are useful if 
you are working with measures.

All audio data that makes up 
a CD Track

• Click between the markers for the track and select “CD Track” 
from the Select menu on the Edit menu.
• Hold down [Ctrl] and double click between the markers.

What was previously 
selected

• Select “Toggle” from the Select menu on the Edit menu.
• Press [Esc].
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Selecting in the Overview

You can select in the Overview, just as in the Main view. To get the selec-
tion tool in the overview, hold down [Ctrl] and move the pointer into the 
overview.

Extending and shrinking the selection

Very often you will have made a selection only to find it isn’t completely per-
fect. In this case you can extend or shrink the selection. In fact you can very 
well use this as a method: make a coarse selection with a lower zoom fac-
tor, then zoom in and adjust the start and end in more detail.

By dragging

1. Move the mouse pointer to the beginning or end of the selection.
It turns into a double arrow.

2. Press the mouse button and drag left/right.

Dragging the end of the selection.

Using [Shift]

• Hold down [Shift] and click outside (extend) or inside (shrink) the current 
selection.
If you click inside the first half of the selection, this will change the start point, if you click in-
side the latter half, this will change the end point.
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Using the cursor keys

• If you hold down [Shift] and press the [←] or [→] keys, the start or end of the se-
lection is moved one pixel (screen dot) to the left/right. If you also hold down [Ctrl] 
it is moved twenty pixels instead.

• If you hold down [Shift] and press [Page Up]/[Page Down], it will also move 20 
pixels.

• If you hold down [Shift] and press the [Home]/[End] keys, the selection will extend 
from the current cursor position to the start/end of the file respectively.

Which end of the selection you change depends on which end of the se-
lection the cursor is closest to.

Exactly how much one pixel represents depends on the zoom factor. If for 
example the zoom factor is “x1:64”, the cursor keys alone move 64 sam-
ples, and together with [Ctrl] they move 1280 samples.

Using the Select menu

The Select submenu (on the Edit menu) has a number of options for ex-
tending the selection to various points in the waveform. For details, use 
the help item on the Edit menu.

Moving the selection

If the selection is the right length, but at the wrong position, you can move 
it:

1. Hold down [Ctrl] and [Shift].

2. Point at the selection and drag left/right.
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Snapping to zero crossings

About zero crossings

If you cut out a portion of a wave and paste it in somewhere else, chances 
are there will be a discontinuity where the two waves are joined. See the 
example below. This discontinuity will result in a transient in the wave when 
it is played back, which is perceived as a “click” or “bump” in the sound.

To avoid this you need to make the splice at a zero crossing.

A zero crossing is – a point where the wave crosses the zero level axis, 
the point where the wave is considered to have “zero level”.

Furthermore we recommend that joins are made with the splice points of 
the two waves heading from opposite directions to the zero crossing. 
That is, one should be on its way up (below the zero level axis), and the 
other should be on its way down (above the zero level axis).

WaveLab can help!

If you wish, WaveLab can automatically search for zero crossings, and ex-
tend the selection “outwards” (make it bigger at both ends) so that it begins 
and ends at a zero crossing. Normally this will not be noted in the editing 
precision (since there are usually hundreds or thousands of zero crossings 
per second), but it will help avoid “clicks” and “pops” and “bumps”.

But just making the selection start and end at zero crossings is not enough. 
When you actually perform the editing operation (cut and paste or drag-
ging, for example) you need to make sure the material is inserted at a zero 
crossing. See “By dragging” on page 99.

At this point, there will be a 
click in the sound, due to the 
discontinuity in the splice.
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Setting up zero crossing detection

1. Pull down the Options menu and activate “Snap to zero crossing”.

2. Select Preferences from the Options menu.

3. Click on the Wave edit tab.

4. Fill out the “Snap to Zero crossing” options.
Click the question mark icon in the respective dialog for details.

Checking the effect of Snap to Zero crossing

1. Make sure that “Off at high zoom factor” is not activated and zoom in until 
the zoom factor is 1:1.

2. Make a selection and observe how it is extended left and right.

If you make a selection like this…

…it is automatically extended at both 
ends, to the closest zero crossings.
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Snapping to time units

When “Snap to time units” is activated on the Options menu, selections 
will automatically be extended to the left and right so that they start and 
end at whole time units (and also at the closest zero crossing, if that op-
tion is activated, see above). This allows you to easily make selections 
spanning a certain number of seconds for example.

Note that this means that you must drag across a certain “time area” (for 
example more than half a second) to get any selection at all.

The “time unit” mentioned depends on which type of scale is selected for 
the ruler:

Using Magnetization

If you have “Magnetize bounds” on the Options menu activated and cre-
ate or adjust a selection, it will “snap” to the following positions (or to the 
zero crossing closest to the position, see above):

• The wave cursor.
• The start and end of the entire wave.
• Markers (see “What are markers for?” on page 328).

Option Cursor moves to

Time Closest whole second

Samples Function not available

Time code Closest frame

Meter Closest whole beat

File size Function not available
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Level selections

For some of WaveLab’s level processing functions, it is useful to make a 
selection not only in time, but in level.

By dragging

1. Make a regular “time” selection.

2. Hold down [Shift].

3. Move the mouse to the top or bottom of the selection box.
The pointer changes into a vertical double arrow.

4. Press the mouse button and drag up/down.

If you then extend the selection time-wise, the level selection still remains 
the same.

Extend to peaks

To automatically set the level selection to the highest peak in the current 
selection, make a time selection as desired and select “Extend to peaks” 
from the Select submenu on the Edit menu.

Make a regular selection, move the pointer to 
its top or bottom and hold down [Shift]…

…drag up/down, and re-
lease the mouse button.
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Basic editing commands

Mono/stereo

WaveLab is totally flexible in its handling of stereo. All editing operations 
can be performed on either channel or both.

Copying audio

The following operations allow you to make copies of sections of audio 
within the same file or from one file to another.

Please note that any existing markers (see “What are markers for?” on page 
328) in the source audio section also will be copied.

By dragging

1. Decide whether you want to use “Snap to Zero crossing” (activated from 
the Options menu) for this operation.
When this is activated, both the selection start and end as well as the drop position will al-
ways occur at zero crossings. See “Snapping to zero crossings” on page 95 for details.

2. Make a selection.

3. Point at the selection, press the mouse button and hold it down.

4. Drag to a position outside the selection (in the same file) or to another 
Wave window.
When you have the cursor over a valid area, the pointer will turn into a single or double 
waveform (see below). The status bar will show the exact position at which the selection 
will be inserted.

Make sure you don’t drop on a selection in the destination window, or you 
will perform a crossfade, see “Crossfade” on page 192.
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5. Release the mouse button.
The selection is inserted at the indicated point. The audio that previously began at that point 
is moved forward so that it is now played after the inserted section.

Using “Magnetize Bounds”

If you have “Magnetize bounds” on the Options menu activated when you 
drag, the cursor will “snap” to the following positions:

• The wave cursor.
• The start and end of the entire wave.
• Markers (see “What are markers for?” on page 328).

Make a selection, position the mouse pointer over it…

…drag and drop…

…the dragged section is inserted at the drop point.
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Stereo/mono “conflicts”

Stereo/mono is handled as follows when you drag between files:

Sample rate conflicts

If you copy or move audio from one window to another, and the sample 
rates of the two files are not the same, the copied/moved sound will play 
back at the wrong pitch (speed). The program will warn you if this is about 
to happen.

While mixing sample rates can sometimes be used as an effect, it is most 
often not desired. There are two ways to get around this:

• Sample rate convert the source file to the same rate as the destination file before 
doing the editing.
You might go back later and undo this conversion if necessary.

• Sample rate convert the destination file to the same rate as the source file before 
adding the audio to it.
Please note that you are then partly “stuck” with this new sample rate, since rate converting 
back and forth too many times is not recommended, see “Convert sample rate” on page 210.

By using Copy and Paste

1. Make a selection.

2. Select Copy from the Edit menu, press [Ctrl]-[C] or drag the selection 
onto the Copy icon on the Standard Commands control bar.

3. If you want to insert the audio, click once at some position in the same file 
or in another file.
The wave cursor appears at that point.

4. If you would rather replace a section of audio, select it.
In this case, the position of the cursor is of no relevance.

Dragged section “Drop” wave Action

Stereo Stereo The dragged audio is always inserted into both 
channels.

Stereo Mono Only the left channel is inserted.

Mono Stereo What happens depends on the vertical position in 
the destination window at which the drop is made. 
This is indicated by the cursor shape (see “Select-
ing in stereo files” on page 91). The selection can 
be inserted into only one of the channels, or the 
same material can be inserted into both channels.
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5. Select Paste from the Edit menu or press [Ctrl]-[V].
The material you copied is either inserted at the indicated point (no selection) or it replaces 
the current selection (if you have a selection).

Make a selection, and select Copy…

…click for an insertion point…

…and select Paste. The copied section is inserted at the cursor position.
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Stereo/mono “conflicts”

Stereo/mono is handled as follows when you paste:

Moving audio

The following commands allow you to rearrange the “order” of the audio 
in a file.

By dragging

This is just like drag copying (see above). The only difference is that you 
hold down [Alt] and [Ctrl] while dragging to move audio. The material you 
dragged is removed from its original position and inserted where you drop 
it.

By using Cut and Paste

This is just like using Copy and Paste (you can for example drag the se-
lection to the Cut symbol on the Standard Commands control bar – see 
above). The only difference is that when you select Cut, the audio is re-
moved from the window. The material after the cut section will be moved 
to fill out the gap.

Please note that to completely undo a move between two files you must 
first undo the paste in the destination window and then undo the cut in the 
source window.

Copied section Paste wave Action

Stereo Stereo If the wave cursor extends across both channels of 
the destination file, the material will be inserted into 
both channels.

Stereo Stereo If the wave cursor is only in one channel, the Paste will 
only happen in that channel. Material from the left 
channel will be pasted in the left channel and vice 
versa.

Stereo Mono Only the left channel is pasted.

Mono Stereo What happens depends on whether the wave cursor 
is in one channel or both. The Paste can either happen 
in one of the channels, or the same material can be in-
serted into both channels.
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By nudging

The Nudge left/right tools in the Toolbox (also known as “Kicker tools”) 
can be used to move the audio in small steps within a file.

1. Make a selection.

2. Click on the selection with one of the Nudge tools (depending on the di-
rection in which you want to move it).
The audio is moved one pixel (screen dot). Exactly how much this is depends on how far 
you are zoomed in. If for example the status bar says x1:256, the selection will be moved 
256 samples.

• The moved section “overwrites” the audio originally at that position. 
For example, when you nudge a selection to the right, silence will appear before the nudged 
section while audio to the right will be replaced by the nudged section. This is different from 
moving by dragging.

• If you nudge many times in a row and then undo, all the moves are undone 
in one go.

Repeating an audio selection

To repeat a section of audio, proceed as follows:

1. Make a selection, select Cut or Copy and place a new insertion point, just 
as when performing a normal Cut or Copy (see above).

2. Select “Multiple copies…” from the Paste Special submenu on the Edit 
menu.

3. In the dialog that appears, enter the number of copies you desire (up to 
1000), and click OK.

The Nudge tools



WAVELAB
Editing in the Wave window 6 – 105

Other Paste operations

On the Paste Special menu you will find some additional options:

Overwrite

This will overwrite data in the destination file, rather than moving data to 
make room for the inserted audio. The actual amount that will be overwrit-
ten depends on the selection in the destination file:

• If there is no selection in the destination file, a section with the same length as the 
pasted data will be overwritten.
If there is a selection, the pasted data will replace that selection, just as when making a reg-
ular paste.

Append

This will add the pasted audio after the end of the file, just as if you had 
placed the wave cursor there and selected Paste.

Prepend

This will add the pasted audio before the beginning of the file.

Mix

This will blend the two files into each other, starting at the selection (if you 
have one) or at the cursor position (if there is no selection).

• When you select the Paste Special – Mix option, a dialog appears, allow-
ing you to specify the desired gain for the audio on the clipboard and at 
the destination, respectively.
A setting of 0 dB means the level will be unaffected.

• All the data on the clipboard is always mixed in, regardless of the length of 
the selection.
It doesn’t matter whether or not you have a selection in the destination file when you paste.

Deleting selections

Delete

You can use the following methods to delete a selection of audio:

• Select Delete from the Edit menu.
• Click the Delete icon on the Standard Commands control bar.
• Press [Backspace] or [Delete].
• Drag the selection to the Delete icon on the Standard Commands control bar.
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Trim

To remove all the audio except the current selection, select Trim from the 
Edit menu (or press [Ctrl]-[Backspace]).

Smooth Delete

This function is available from the Edit menu. It is similar to the standard 
“Delete” function, but in addition, a short crossfade is performed at the 
edges of the section to be deleted, allowing for a smoother audio transi-
tion. 

• The default length and shape of the crossfade is set in the Preferences–Wave 
edit tab. 

• If the range to cut out is smaller than the defined fade length, then standard “De-
lete” is performed. 

• Note that the crossfade is performed at the edges of the selection to delete. Thus 
if the region to remove is 1000 milliseconds and the defined crossfade is 20 mil-
liseconds, only 980 milliseconds of audio will be removed.

• If the region is the start of the file, only a fade-in is performed. If the region is the 
end of the file, only a fade-out is performed.

Silence

The Silence function offers several different methods for inserting silence, 
but there are two basic operational modes:

• You can “insert” silence into a section, i.e. to space two sections further apart.
• Or, you can select to “replace” a selection or time range with silence. 
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Replace selection

If you intend to replace a specific range with silence, proceed as follows:

1. Make a selection that encompasses the range you wish to replace with si-
lence.

2. Select Silence from the Edit menu or press [Ctrl]+[Shift]-[Space].
This will open the Silence dialog – see below for descriptions of the options in the dialog.

3. In the dialog, set the Length to “As selection”, and the Mode to “Replace 
selection”.

• From here, you can select whether to apply “True silence” or “Back-
ground noise”.
The “Background noise” option allows you to select an audio file containing ambient noise, 
and use this as the source for the silence operation. See “About the Ambience – Back-
ground noise option” on page 108.

Insert silence

If you intend to insert silence, proceed as follows:

1. Either make a selection that encompasses the range where you wish to 
insert the silence, or set the cursor where you want the inserted silence to 
begin.

2. Select Silence from the Edit menu or press [Ctrl]+[Shift]-[Space].
This will open the Silence dialog – see below for descriptions of the options in the dialog.

• In the dialog, set the Length to “As selection” if you have specified a se-
lection and want the silence to be inserted inside the range.

• Alternatively, uncheck “As selection” and set the desired silence Length 
in seconds.

3. Set the Mode to “Insert at cursor”.

4. From here, you can select whether to apply “True silence” or “Back-
ground noise”.
The “Background noise” option allows you to select an audio file containing ambient noise, 
and use this as the source for the silence operation. See “About the Ambience – Back-
ground noise option” on page 108.
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Silence dialog options

The Silence dialog contains the following options:

About the Ambience – Background noise option

In certain situations, completely muting the sound (True silence) will pro-
duce an undesirable result. This particularly applies to spoken word and 
field recordings, where a natural background ambience is often present. 

Inserting “True” silence can introduce a marked difference to the pas-
sages with voice dialog as opposed to the silenced passages, thus limit-
ing the use of the Silence function (unless this is what you want). Using 
the Background noise feature you can insert ambience instead of silence 
which in such circumstances will produce a far more natural result. Here’s 
how its done:

1. Select “Background noise” in the Ambience section.

2. Click the folder icon to open a standard file dialog where you can navigate 
to the source file for the Background noise. 

The file you specify must have the same properties (stereo/mono, sample 
rate, etc.) as the file to be silenced. The file can be any length – if the si-
lence region is longer than the file it will be looped.

Item Description

Length If set to “As selection”, the silence range will be the same as the se-
lection. If this is unchecked, you can specify a silence length in the 
field below the checkbox.

Fade in/out If this is checked, a crossfade will be performed at the start and end 
of the silence region for a smoother transition. You can specify the 
crossfade time.

Ambience – 
True silence

If this is selected, the result will be “digital silence”, i.e. completely 
muted sound.

Ambience – 
Background noise

This option allows you to select an audio file containing ambient 
noise, and use this as the source for the silence operation. See be-
low.

Gain This allows you to lower or raise the gain of the Background noise 
source file.

Mode The sets whether to Replace the selection or to Insert the silence at 
the cursor position.

Apply Applies the operation.
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Replacing a section with silence – Fast mute

This is similar to Silence, but always replaces the selection and always 
applies “True” silence. There are four ways to replace a section of audio 
with silence:

• Select it and select Fast mute from the Edit menu.
• Select it and click the Fast mute icon on the Standard Commands control bar.
• Select it and press [Ctrl]-[Space].
• Select it and drag the selection to the Fast mute icon on the Standard Com-

mands control bar.

Turning selections into new documents

If you want to turn a section of wave into a new document, proceed as fol-
lows.

By dragging

1. Make a selection.

2. Drag the selection out of the window and onto an empty section of the 
WaveLab application window.
The cursor turns into a “new document” icon.

3. Release the mouse button.
The selection appears in a new window. You can also use this function to create stereo 
waves out of mono waves, see below.

By using “Copy to new window”

1. Make a selection.

2. Select “As is” from the “Copy to new window” submenu on the Edit 
menu.
The selection appears in a new window.

Converting from mono to stereo

You may convert a mono file into a stereo file that contains the same mate-
rial in both channels, for example for further processing into “real” stereo.

This can be done in two ways, by using menus or by dragging to a new 
file, as described below.
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By dragging

1. Make a selection.

2. Drag the selection out to the WaveLab “desktop”.

3. When the pointer is outside the window, hold down [Ctrl] and release the 
mouse button.

By using menus

1. Make a mono selection.

2. Select “Convert to Stereo” from the “Copy to new window” menu on the 
Edit menu.
The selection appears in a new stereo window.

Converting from stereo to mono

You may mix the two channels in a stereo file into a mono document.

This can be done in three ways. Which method to use mainly depends on 
whether you want to convert the entire file or just a selection:

By dragging

1. Make a stereo selection.

2. Drag the selection out to the WaveLab “desktop”.

3. When the pointer is outside the window, hold down [Ctrl] and release the 
mouse button.

By using menus (converting a selection)

1. Make a stereo selection.

2. Select “Convert to Mono (Mix)” from the “Copy to new window” menu on 
the Edit menu.
The selection appears in a new window, mixed down to mono.

• The option “Convert to Mono (subtract right channel from left channel)” will 
also convert stereo audio to mono – but in this case one channel is sub-
tracted from the other.
The resulting mono wave will contain the difference between the channels. For example, 
this allows you to verify that a wave file really is a true stereo file (rather than a mono file 
converted to stereo format).
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By saving (converting an entire file)

1. Open the stereo file.

2. Select “Save as” from the File menu and click the Properties button at the 
bottom of the dialog to open the “Audio File Format” dialog.

3. Change the Channels setting to the “Mono (Mix)” option, but leave the 
other settings as they are.
You can of course change the other settings too, but this will have other effects, see “Sav-
ing in another format (Save as…)” on page 117.

• The other two “Mono (Mix)” options will also convert a stereo file to mono, 
but the amplitude of the resulting file will be attenuated by 3 or 6 dB re-
spectively.
Since the mixing of the two channels when converting a stereo file to mono might often re-
sult in the amplitude increasing to a point where clipping occurs, these two options can be 
useful to remedy such a situation.

4. Click OK and save the file.

5. Open the file you just saved.

Swapping channels in a stereo file

You may move the material in the left channel to the right channel, and 
vice versa:

1. Make a selection across both channels.
Only the material in the selected section will be swapped.

2. Select “Swap channels” from the Edit menu.
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Waveform restoration with the Pencil tool 

The Pencil tool allows you to redraw the waveform directly in the Wave 
window. This can be used to quickly repair waveform errors.

This error in the right channel (red waveform) can be corrected quickly by using the 
Pencil tool.

• The Pencil tool can be used if the Zoom resolution is set to at least 1:8 
(one pixel on the screen equals 8 samples) or a higher resolution.
Resolution values can be set in the Zoom pop-up menu. You can open it by clicking on the 
Zoom factor field in the Status bar, located at WaveLab’s bottom window rim.

• Select the Pencil tool from the Toolbox and redraw the waveform.
If you wish to redraw the waveform of both channels at once, press [Shift] on your computer 
keyboard during the drawing process.

• You can also use “Audio error detection and correction” to automatically re-
pair corrupted audio files – see “Audio error detection and correction” on 
page 631.

Click here 
to open the Zoom 
pop-up menu.
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File handling in Wave windows

This section describes file handling in the Wave window (i.e. handling audio 
files). File handling of other document types (e.g. Audio Montages) is de-
scribed in the respective chapter.

Supported file formats

WaveLab can open and save audio files in a number of file formats. The 
table below gives you some basic information about the various formats 
available (note that additional file formats may have been added after this 
document was written).

• The Format column also lists the typical file name extensions for each format.
• All sample rates are supported, for all file formats.
• All file types can handle mono and stereo.

Format Description

Wave (.wav) The most common file format on the PC platform. If you plan to load the 
files into any other PC program, Wave files are a safe bet. 8, 16, 20, 24 
bit and 32 bit (float) resolutions are supported.

Wave 64 (.w64) This file format, developed by Sony, is very similar to the Wave format 
but with one important difference; it allows you to record and/or edit files 
of virtually any length (actually the limit is 512 GB but this ought to cover 
most situations). Standard Wave files are limited to 2 GB (stereo files) in 
WaveLab. 

RF64 You have an option (set in the Preferences - Files tab) to support the 
RF64 file format. If this is activated, the standard Wave file format 
switches automatically to the RF64 file format as soon as the file size ex-
ceeds 2 GB, without any performance loss or interruption. This is espe-
cially useful when recording very long sessions as there is no need to 
worry about file size limit (apart from available disk space). A RF64 file 
will still have the “.wav” extension but can only be opened with an appli-
cation that supports the RF64 standard. 

AIFF (.aif, .aiff, .snd) Audio Interchange File Format, a standard defined by Apple Computers 
Inc. 8, 16, 20, or 24 bit resolutions are supported.
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MPEG-1 Layer 3 
(.mp3)

The most common audio compression format. The major advantage of 
MPEG compression is that the file size is significantly reduced, while 
there is little degradation of sound quality. WaveLab can both open and 
save files in this format.
- Note that when you open an MPEG compressed file in WaveLab, the 
file is converted to a temporary wave file that is much larger than the 
original compressed file. Therefore, make sure that you have enough free 
space on your hard disk when opening MPEG compressed files. 
- When you save, the temporary wave file will be converted back to 
MP3, so from a user perspective the file handling is transparent apart 
from the size difference mentioned above.

MPEG-1 Layer 2 
(.mp2/.mpa/.mpg/
.mus))

MP2 (sometimes referred to as “Musicam files”) is a common file format 
in the broadcast industry. With regard to file sizes the same applies as 
with MP3 files.

Original Sound 
Quality (.osq)

This is WaveLab’s proprietary lossless compressed audio format. By 
saving files in this format, you can save considerable disk space without 
compromising audio quality. See “About saving OSQ files” on page 
119.

Sound 
Designer II (.sd2)

This audio file format is used by Digidesign applications (such as Pro 
Tools). 8, 16 or 24 bit resolutions supported.

U-LAW
(.ulaw, .vox)

This is an audio encoding and compression technique supported by 
Windows and Web phones, using 8 bit resolution. The U.S. telephone 
system uses U-law encoding for digitization.

A-LAW 
(.alaw, .vox)

This is an audio encoding and compression technique for telephony, us-
ing 8 bit resolution. The EU telephone system uses A-law encoding for 
digitization.

Sun/Java
(.snd, .au)

This is an audio file format used on Sun and NeXT computers. Files in 
this format can often be found on the Internet. 8, 16 or 24 bit resolutions 
are supported.

ADPCM – 
Microsoft/
Dialogic (.vox)

This is a format commonly used for games and telephony applications 
that offers a lower bit rate than linear PCM and thus requires less stor-
age space/bandwidth.

Ogg Vorbis 
(.ogg)

Ogg Vorbis is a relatively new compressed file format that is open and 
patent-free and offers very small audio files maintaining comparatively 
high audio quality. 

Format Description
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The “$$$” file type is WaveLab’s own temporary file format. In case you ex-
perience a computer crash you may restore some of your work by opening 
any stray “$$$” files on your hard disk(s).

About 20-, 24- and 32-bit float files

You do not need a 20- or 24-bit audio card to take advantage of the fact 
that WaveLab can handle 20- and 24-bit audio files. Any processing or 
editing performed on the files is always done at full resolution, even if your 
card doesn’t support the full resolution. For playback, WaveLab automat-
ically adapts to whatever card you have installed.

About temporary files

As you work in WaveLab, temporary files used for Undo, etc. are created 
on your hard disk, see “Temporary files” on page 28.

You can decide whether these files should be in 16-, 24- or 32 bit format. 
This is done on the Preferences–File tab.

The higher this value, the better the quality of the temporary file. However, 
32-bit files are also twice as big as 16-bit files and take longer to process.

Text/Excel (.txt) This is a text representation of a waveform. By saving an audio file as a 
text file and then opening it in a spreadsheet application such as Excel, 
you can view it in textual, decimal form and edit the sample values. When 
you open a text file representing a waveform in WaveLab, it will be de-
coded and opened as an audio file. Note that these files are not com-
pressed in any way, so they can get very large! Therefore, avoid creating 
and opening extremely large .txt files. Also note that when using 32 bit 
float files, the .txt format is not 100% lossless – i.e. information may be 
lost! This is because it is not possible to express a binary floating point 
value in textual decimal form without some precision loss.

Windows Media 
Audio (.wma, .asf))

Microsoft’s own compressed format. WaveLab lets you import/export 
audio in this format. Note that it is also possible to import/export audio in 
WMA surround format, provided that you have Windows Media Player 9 
(or later) installed on your system.

Ensoniq Paris (.paf) Used by the Ensoniq Paris™ system (16 bit resolution).

Raw PCM files
(.raw, .bin, .pcm, 
.$$$)

In this format, no information about bit resolution or sample rate is in-
cluded. If you open a file in this format, WaveLab will ask you to specify 
the bit resolution and sample rate. If you don’t do this correctly, the file 
will not play back as intended.

Format Description
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• If you ever plan to export your files, or create high resolution DVD-A discs, in 24-
bit or 32-bit format, use this format or a better one (higher number) for your tem-
porary files as well.

• Use 32-bit if you want to create files with levels exceeding 0dB.
• Even if you only work with 16-bit files, selecting 24-bit for your temporary files can 

improve audio quality slightly.
• For less critical applications where speed and disk space are crucial factors, use 

16-bit temporary files.

About the “Erase Peak files…” option

This item allows you to erase all peak files from a selected folder. 

A peak file is a small file with the extension “.gpk” automatically created by 
WaveLab each time a file is modified or opened in WaveLab (if it hasn’t 
been previously). The peak file contains information about the waveform, 
and determines how it is drawn in the wave window.

For example, if you have stored your peak files (this is set in the Prefer-
ences dialog) in the same folder as your audio files, you may wish to erase 
the peak files so that the folder only contains audio files. Erasing peak files 
is safe, they will be recreated when needed.

Proceed as follows:

1. Select Erase peak files from the Tools menu.
A dialog opens.

2. In the upper field specify the folder with peak files to erase.
Check the “Also scan sub-folders” option if this is applicable.

• If you check the “Also erase files with these extensions” option, you can 
specify other file types to erase in the set folder by typing in extensions 
separated by a comma. 
This option lets you erase peak or other temp files created by other applications for example.

Please note that the files will be permanently erased (not moved to the Recy-
cle bin)! It is possible to erase important files if you specify wrong extensions 
or if you aren’t 100% sure of what you are doing. Therefore use this option 
with caution!
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Opening files

The various methods for opening an audio file in a Wave window are de-
scribed in the section “Opening Waves” on page 71. Importing CD tracks 
from an audio CD is described in the section “Importing tracks from an 
audio CD” on page 75. Importing tracks from a DVD-Audio disc is de-
scribed in the section “Importing DVD-Audio tracks into WaveLab” on 
page 599.

Save and Save as – General information

• When you save a new document for the first time, it doesn’t matter whether 
you select Save or Save as. 
The “Save as” dialog will appear, since you need to specify a file format, folder, and file name.

• Once a file has been saved, you can continue to edit it and then select Save 
from the File menu, or press [Ctrl]-[S], to update the file and make the 
changes permanent.

• If you want to specify a new name, location and/or file format, you should 
select Save As from the File menu.
See “Saving in another format (Save as…)” on page 117.

• All save operations except “Save Copy” clear the Undo buffers, which 
means that after saving you cannot undo or redo.

Automatic backups

For all save operations except a regular “Save”, backups are created au-
tomatically if a file with the same name already exists.

If for example you select Save As and specify a file name already used in 
that folder, the program will ask you if you want to back up the existing file 
first. If you click Yes, the first letter in the file’s extension will be changed 
to “~”. “AIF” for example, will become “~IF”.

Saving in another format (Save as…)

If you want to change the format (file format, sampling frequency, bit res-
olution and stereo/mono status) when saving, proceed as follows:

1. Select Save as… on the File menu.

2. A regular file dialog appears where you can specify a file name, folder and 
a file format (see “Supported file formats” on page 113).
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3. If you wish to change other attributes of the file (e.g. mono/stereo status, 
bit resolution or sample rate), click the button at the bottom of the dialog.
This opens the Audio File Format dialog where you can specify the desired properties of the 
converted file.

The Audio File Format dialog

4. After making the desired settings, close the Audio File Format dialog and 
click Save.
A new file is created. The original file is not affected by the operation. For detailed descriptions 
of the settings in the Audio File Format dialog, click the question mark icon in the dialog.

If you change the sample rate, bit resolution and number of channels, the 
following operations are performed:

• If you only wish to change the bit resolution you can do this directly in the 
“Audio Properties” dialog (see “Editing audio properties” on page 127) 
instead and perform a standard save.

Property Action

Sample Rate If a new sample rate is specified, a sample rate conversion will be performed 
(see “Convert sample rate” on page 210).

Bit Resolution If a different bit resolution is specified, the file is either “truncated” down to 
8 bits, or “padded” up to 16 bits. If you convert to 8 bits, the audio is auto-
matically normalized.
If you are converting to a lower bit resolution, you should consider adding 
dithering – see “The Dithering pane” on page 231.

Mono/Stereo If the file is converted from mono to stereo, the same material will appear in 
both channels. If the conversion is from stereo to mono, a mix of the two 
channels will be created (clipping is prevented in the mixing process).



WAVELAB
Editing in the Wave window 6 – 119

• For high quality mastering purposes, it is not recommended to change the 
sample rate and number of channels this way, but instead use plug-ins and 
functions of the Master Section (see “The Effects pane” on page 225).

• For the available compressed file formats (MP3, MP2, WMA and Ogg 
Vorbis), you can select “Edit…” from both the Encoding and Attributes 
pop-up menus in the Audio File Format dialog.
This opens additional settings dialogs, where you can specify various options such as bit 
rate and compression method, and also enter text tags for the file. Click the question mark 
icon in the dialog for details.

• It is also possible to convert several files to another format in one go (batch 
encoding). 
See “Batch file encoding” on page 303.

• Note that you can also save as WMA files, MP3 files and MP2 files via the 
“Encode to…” options on the Save Special submenu.

About saving OSQ files

OSQ (Original Sound Quality) is a lossless audio compression format, 
which can significantly reduce the audio file size without affecting the audio 
quality at all.

• You can save any audio file as an OSQ file by using the Save As function.
The audio will play back exactly the same as in the original, uncompressed file.

• Similarly, if you open an OSQ file in WaveLab and save it as an uncompressed au-
dio file in its original format (e.g. WAV), the audio will play back exactly the same.

• You can also convert several files to OSQ format in a batch. See “Batch file en-
coding” on page 303.

Save selection as

This is a menu item on the Save Special submenu. It works exactly as 
Save As, except that only the current selection is saved as a new file.

Save selection as clip (for Audio Montages)

This item is available from the Wave window speed menu when a selec-
tion is active. It allows you to save the current selection as a clip file which 
can be used in Audio Montages. Clip files can be used just like audio files 
in Montages but are not self-contained audio files. Instead they contain a 
reference to the source audio file.
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Save a Copy

This item, also on the Save Special submenu, allows you to save a copy of 
the file, in its current state, without affecting the original. A regular file dia-
log is used as with Save As.

Save left/right channel as

These two menu items are also located on the Save Special submenu. 
They allow you to save each channel individually, into a separate file. A 
regular file dialog is used as with Save As.

This menu command is used when you have been editing “dual mono” 
files for example, and wish to save the channels into separate files.

Save All

The Save All dialog

This menu item brings up a dialog that allows you to save some or all of 
the open documents, in one go.

The list displays all open documents that currently contain unsaved 
changes. The “Show paths” check box allows you to display/hide the 
complete file paths.

1. Select /deselect files by clicking on them or by using the Select/Deselect 
button.
Only the selected files will be saved.

2. Click “Save selected”.
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Revert to saved

This menu option, on the File menu, allows you to revert the file back to its 
last saved state (actually, the last saved version of the file is loaded from 
disk). This can be used as a kind of “super undo” which undoes all the 
changes made to the file since it was last saved.

1. Select “Revert to saved” from the File menu.

2. Click “Yes” in the warning dialog that appears.
The file is restored to its previously saved state.

Renaming files and documents (Rename)

The Rename function is available from most WaveLab documents, not 
just Wave windows. The function is however of particular importance 
when renaming audio files. If you rename an audio file outside WaveLab, 
and this file is referenced to an Audio Montage or a Basic Audio CD (or 
any type of WaveLab document/project that uses file references), the ref-
erence will be lost the next time you open the document that references 
this file.

But WaveLab allows you to handle file renaming in an intelligent way so 
that all the documents that reference this renamed file are automatically 
updated! This works as follows:

• All open documents that reference the file or document to be renamed will 
be automatically updated to reference the new name.
E.g. if you rename an audio file named “India” to “Sitar”, all currently open documents that 
reference the file “India” will be updated to reference the file as “Sitar”!

For audio files, peak and marker files will also be renamed accordingly. 

• Documents that use audio file references are Audio Montages, Basic Au-
dio CDs, Data CD/DVD projects, DVD-Audio Projects, Backup plans, 
Audio Databases, and Workspaces. 

• WaveLab documents can also refer to the names of other documents, 
e.g. a DVD-Audio project will contain references to Audio Montages. 
This will work in the same way – if the document/project that references the document to 
be renamed is open, the references will be updated.
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To rename a file or document proceed as follows:

1. Select the audio file/document to be renamed. 
Make sure all documents that reference this particular file are open. This is not mandatory, 
but if they aren’t, the file references will not be updated.

2. Select “Rename…” from the File menu, or press [F2].
The Rename dialog opens.

The dialog contains the following items:

You can also Batch rename files – see “Batch renaming” on page 307.

Item Description

Name text field This is where you type in the new name.

Change folder It is also possible to change the folder location of the file when re-
naming. If Change folder is ticked, you can navigate to a new loca-
tion. Note that this is only possible within the same drive partition.

Keep as default path If you check this option, the same path will be selected the next time 
you open the dialog. This is useful if you need to move several files 
successively.

Extension pop-up The file extension can be changed, but only if corresponds to the 
original file format (certain file formats can have different possible file 
extensions, e.g. “aif” or “snd”).
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Deleting files and documents

It is possible to delete whole files or documents from within WaveLab. 
This function is available from the File menu and will delete the currently 
selected file or document from disk. 

1. Make sure the file or document you wish to delete is in focus.

2. Select “Delete…” from the File menu.
A dialog appears as a warning, allowing you to cancel or proceed with the operation.

3. Select whether to permanently delete the file or to move it to the Recycle 
bin by clicking the appropriate button in the Method section of the dialog.
Only select to permanently delete if you are absolutely certain – you won’t be able to re-
trieve the file!

• Any open documents in WaveLab that has a reference to this file will be 
updated accordingly. 
This update will apply to Data CD/DVD projects, Backup plans, Audio Databases and 
DVD-Audio projects, and the file name will be removed from these. 

• However, if a file is being referenced by a currently open Audio Montage 
or Basic Audio CD, you will not be able to delete the file and a warning 
will appear. 

In addition, you will not be able to delete the file in the following circum-
stances:

• If it is currently copied to the clipboard.
• If a part of it is has been pasted into another file that is open. 
• If the file is open in another application.

• Deleting an audio file will also automatically delete its peak and marker file 
names.
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Saving view settings

WaveLab can automatically save all settings associated with a Wave file. 
This includes:

• Window size and position.
• Zooming.
• Scroll position.
• Display mode (Wave/Spectrum/Loudness Envelope).
• Snapshots.
• Master Section preset associated with the file.

The view setting information is stored in a companion file (extension 
“.mem”) either together with your audio files or in a separate folder.

• This feature is activated/deactivated (on by default) in the Preferences–
Wave edit tab (“Save view settings in companion file”).

If the feature is activated and you save a file, the settings will be recreated 
exactly as you had them when later reloading the same file!

Saving a Master Section preset with an audio file

You can also store all Master Section settings used as part of the saved 
file. When you reload the file, you can choose to recreate the Master Sec-
tion effects exactly as they were when saved. 

To store Master Section effects as part of an audio file, proceed as follows:

1. Make sure the effects and their settings are configured the way you wish 
to store them.
“Save view settings in companion file” must be activated in the Preferences.

2. Select the file you wish to save a Master Section preset for, and [Ctrl]-
click on the “M” button on the title bar.
The button will now be lit up in green, to indicate that the Master Section effects settings 
have been saved.

3. Anytime you reload the file, you can recreate the Master Section effects 
by clicking on the “M” button.
The effects will be loaded exactly as saved.
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Compression encoded export formats

Apart from the formats available in the Save As dialog and the Save spe-
cial encode MP3/MP2/WMA options, WaveLab allows you to export files 
in a number of compression encoded audio formats, suitable for multime-
dia, web publishing, etc. (see “Supported file formats” on page 113). The 
basic functionality for this is part of a software technology called Mi-
crosoft ACM (Audio Compression Manager) which is included with Mi-
crosoft Media Tools.

The number of formats you can export, depend on which ACM drivers you 
have installed on your computer.

For more information, see www.microsoft.com/windows/windowsmedia.

About “lossy” and “non-lossy” compression

There are two types of compression methods. When you use a “non-
lossy” method (like saving as an OSQ file – see above), all information 
about the file is preserved, which means that when you decompress the 
file, you get it back exactly as it was.

However, most audio compression techniques are “lossy”. This means 
that once the file has been compressed, some information has been lost. 
This type of compression always results in some kind of audio degrada-
tion, albeit in many cases a very small one.

WaveLab can also import any file supported by ACM, provided that the 
correct ACM drivers are installed.

If you need audio file compression with uncompromised audio quality, you 
should use the OSQ (Original Sound Quality) lossless audio compression 
format instead (see “About saving OSQ files” on page 119).
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Exporting to encoded formats

The menu item “Encode (ACM)” uses the Microsoft MediaTools technol-
ogy to convert the file to one of a number of compressed formats.

1. Select “Encode (ACM)…” from the Save Special submenu.
The dialog that appears is a MediaTools dialog, not a WaveLab dialog.

2. Select one of the formats from the pop-up in the middle and chose a set-
ting for it from the pop-up below.
The dialog also provides possibilities for creating “presets” of formats and settings, using 
the upper row of controls.

The options which are available depend on the original format of the file, its 
sample rate, the number of channels, etc. However, we have noted prob-
lems with some ACM drivers. Even though a certain format can be selected, 
an error message appears when you try to save the file. If this happens, 
please use another encoding method.

3. Click OK.
A regular file dialog appears.

4. Specify a name and location for the file, as with any Save operation.

Note: When you export to compressed files using the “Encode (ACM)” 
option, the file that is created will technically be a Wave file, regardless of 
the compression format (the files will have the extension “wav”). But in-
stead of the regular “linear” audio data that usually makes up a wave file, 
a special audio data “chunk” is included that contains the compressed 
audio.

This is normally not a problem, but something to be aware of when plan-
ning for usage of files in other programs and on other computer platforms.
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Editing attributes and getting information

Editing audio properties

Each audio file has a certain set of properties, that is, information about 
the sample rate at which it was recorded, what the bit resolution is, etc. 
The “Audio Properties” dialog allows you to change that information.

There are two ways to bring up this dialog:

• Select “Audio Properties” from the Edit menu.

• Click on the properties information field, on the status bar.

The Audio Properties dialog

About changing the values

Changing the values in this dialog does not process the file in any way, 
unlike Convert File (see “Saving in another format (Save as…)” on page 
117). However, the following rules apply:

• If you change the sample rate, the file will play back at the wrong pitch.
• If you change the bit resolution the file will be converted to the new resolution the 

next time you save it.

There is no Undo for this item. If you save with a lower bit resolution, the file 
is permanently converted.
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File attributes

If you select this option on the Edit menu, a dialog opens in which you can 
specify various information about the wave file.

The Wave Attributes dialog 

You can enter information on either the Standard tab or the Broadcast 
Audio Extension tab. The information you enter here is added to the 
header of the file, and thereby labels it as either a Standard wave file or a 
Broadcast wave file. A Broadcast wave file is essentially the same thing 
as a Standard wave file, the difference is what information the file headers 
can contain.

• On the Standard tab in the dialog, you can enter information that will be 
displayed for instance when viewing the file’s properties in the Windows 
explorer.

• Note that you can instruct WaveLab to automatically fill out the text fields for 
“Originator software” (WaveLab) and “Creation Date” (the current), by click-
ing the small buttons to the right of the fields.

• On the Broadcast Audio Extension tab you can also enter information to 
be embedded in the file, such as title, author, etc. A Timecode position is 
included in the file as well. This makes it possible to insert audio at pre-
cise positions in other applications. By default, the Timecode position is 
set to the start position of the audio.

Information

This item, on the File menu – Special submenu, brings up a dialog that 
displays basic information about a file.
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About the Loudness envelope display mode

As described earlier in this chapter, there are three display modes for 
Wave windows (see “About the Display modes” on page 77).

The Loudness envelope wave display is selected from the pop-up menu 
at the bottom right of the wave window, to the left of the horizontal zoom 
control (the overview also has a separate Display mode pop-up).

The curves represent the loudness over time in an audio file (see “About 
the curves” on page 130). The loudness is an average level of the individ-
ual levels of the samples (RMS). As isolated peaks do not alter the per-
ceived loudness of audio material very much, this display will represent 
the loudness of an audio file more accurately than the standard waveform 
display.

Apart from a more accurate visualization of the loudness, this display 
mode will also give you an overview of a song’s compression (or dynamic 
range). For instance, the more dips in the curve, the more dynamics in the 
audio material. An even curve with few dips indicates that the material is 
compressed with a limited dynamic range (which is common for modern 
pop/dance music).
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• When the Loudness envelope display mode is selected, the “Y” axis is 
logarithmic, not linear like in the waveform display. 
The vertical zoom slider will change the scale rather than a zoom factor. By displaying a 
larger scale, very small volume changes can be viewed.

• All standard editing operations, i.e. selecting, cut/copy/paste, etc., are 
available, except drawing with the Pencil tool.

About the curves

Up to four different curves can be shown simultaneously in the Loudness 
envelope display. These curves have different colors and represent the 
average loudness of the signal in different areas of the frequency spec-
trum. This can be useful to visualize where in the frequency domain the 
loudness is “spread” at a given time, or to display the loudness of a spe-
cific part of the spectrum. The curves can be shown individually or in any 
combination.

• Which curves are displayed, and what frequency area they represent is 
set in the Loudness envelope options dialog (see below). 
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Loudness envelope options

This dialog contains various options for the Loudness envelope display 
mode. Select “Loudness envelope options…” from the Display mode 
pop-up (only available when Loudness envelope is selected).
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The dialog contains the following items:

Option Description

Time resolution This sets how many samples are used to compute the average loud-
ness (“RMS”). The longer the time set here, the more the loudness 
variations are evened out in the envelope. With shorter times, the en-
velope will be more sensitive to individual peaks.

Slow/Fast tracking “Slow tracking” takes into account more samples than the “Time res-
olution” setting, but the “older” the samples, the less they contribute 
to the average loudness calculation. This will produce a more evened 
out envelope curve. “Fast tracking” takes into account the exact num-
ber of samples as defined by the Time resolution setting, and all are 
taken into account equally to calculate the average. This last method 
produces a curve with less “inertia”, hence the name.

Envelope types This allows you to specify which envelope curves to display, and to 
set a frequency range for the filtered envelope curves. 

Main If checked, this curve is shown in black and displays the overall aver-
age loudness of the audio. If unchecked this will not be shown.

Low pass filter If checked, this curve is shown in red and displays the overall average 
loudness of the audio in the lower frequency area. You can specify 
the frequency in the value field below the checkbox.

Band pass filter If checked, this curve is shown in green and displays the overall aver-
age loudness of the audio in the mid frequency area. You can specify 
the center frequency in the value field below the checkbox. The “Q” 
parameter determines the bandwidth of the Band pass filter.

High pass filter If checked, this curve is shown in blue and displays the overall aver-
age loudness of the audio in the higher frequency area. You can 
specify the frequency in the value field below the checkbox.

Apply Any changes made in the dialog will be applied when this is clicked.
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Playing back

Background information

About sample rates

If the wave file is recorded at a sample rate not supported by your audio 
card you will not be able to play it back. You might then opt to use sample 
rate conversion, see “Convert sample rate” on page 210. Also see “Sup-
ported file formats” on page 113 for more on file formats.

About sync

It is possible to synchronize WaveLab to other devices either via MIDI 
Time Code or via the ASIO Positioning Protocol which allows for sample 
accurate sync. This is described in the chapter “Synchronizing WaveLab 
to external devices” on page 649.

About the playback cursor position and appearance

Great care has been taken to achieve synchronization between what you 
hear and what you see (the wave cursor position in the wave during play-
back). However, by nature, this precision depends to a large extent on the 
audio card and its driver. In case you run into problems you may want to 
adjust the settings on Preferences–Audio device tab. Click the question 
mark icon in the dialog for details.

About audio cards and playing in the background

When you activate playback or recording in WaveLab, it will “grab” the 
audio card so that other applications cannot access it. The opposite is 
also true: if another application has grabbed the card, WaveLab will be 
unable to play.

• If you want to run WaveLab together with another audio program, and make 
sure whichever application is active gets access to the audio card, activate 
the “Release audio hardware…” option in the Preferences–Audio device tab. 
When you do, WaveLab will “let go” of the audio card when another application is made 
active (provided that this doesn’t happen during playback or recording in WaveLab).
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Using the Transport bar

Displaying the Transport bar

If the Transport is hidden, select Transport from the Control bars submenu 
on the View menu.

The Transport controls

The Stop button

The result of clicking on the stop button depends on the current situation: 

• If the program is stopped and you click the Stop button, the wave cursor 
is moved to the beginning of the last start position. A second click will 
move the cursor to the start of current selection (if any and if this is lo-
cated before the last start position).

• If there is no selection, or if the wave cursor is already to the left of the 
selection, it is moved to the beginning of the file instead.

• If there is no selection, and you activate playback from a point and then 
stop so the wave cursor is to the right of the original point, the cursor will 
move to the place you last started when you click Stop again.

• If you click on the Stop Point/Loop button and activate the “On stop, 
move cursor back to start” option on the menu, the cursor will be auto-
matically moved back to the beginning of the selection when you click 
Stop (from playback).
If there is no selection, it will automatically move back to the place you started from.

Loop On/Off

Goto beginning
Rewind

Fast Forward
Goto End

Stop
Play

RecordStart Point

Skip

Stop Point/Loop

Jog & Shuttle

Playback Speed
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Transport control settings for separate windows

By default, open windows in WaveLab (wave windows and montage win-
dows) all use the same Transport control settings (loop settings, playback 
speed, etc.). You can however choose to use separate settings for sepa-
rate windows if you want: open the Preferences–Audio device tab and 
make sure the option “Transport settings are global to all windows” is not 
activated.

When this option is deactivated, the following transport controls can be 
set differently for each open wave or montage window:

• Start point (see “Setting the start point for playback” on page 136).
• Skip (see “Skipping sections during playback” on page 137).
• Playback speed (see “Setting the playback speed” on page 138).
• Stop point/loop (see “Setting the Stop point/loop” on page 136).
• Loop On/Off (see “Looping” on page 137).

Setting the start point for playback

The Start point button on the transport brings up a menu that allows you 
to specify where playback will start.

For example, if you select “Play from start of file”, as soon as you hit Play, 
the wave cursor will jump back to the beginning of the file and playback 
starts from there.

For detailed information about the options on this menu, use the help item 
at the bottom of the menu.

• For a description of the option “Synchronize from MIDI Time Code” on this 
pop-up menu, see “Synchronizing WaveLab to external devices” on page 649.

Setting the Stop point/loop

The Stop point/loop button on the Transport bar allows you to select 
where playback should stop and whether it should loop indefinitely.

Automatic Stop

For example, if you select “Stop at next marker”, playback will stop as 
soon as the program reaches a marker or the end of the file, whichever 
comes first.
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Looping

Let’s say you have chosen “Loop selection” mode. Now, if some piece of 
the wave is selected, this will be repeated indefinitely (as long as you 
don’t start playback from a position later than the selection).

If no selection is made, the entire wave is looped.

• For details about the Stop point/loop menu items, use the help item at the 
bottom of the menu.

About loop updating and short loops

The loop points are updated continuously during playback, which means 
that if you change the loop start or end during playback, the loop changes. 
This is a great feature for auditioning selection points for rhythmic material!

Please note that it takes some time for positions to be updated (0.3 to 1 
second, depending on the file’s bit resolution and sample rate). If you don’t 
want to wait, activate “Restart loop on change” on the Options menu. 
When this is activated, the loop starts over as soon as you adjust the se-
lection or move a loop start marker.

Also please note that WaveLab handles playback of extremely short loops 
without problems. However, the cursor position might not be updated 
correctly.

Skipping sections during playback

You can also have playback automatically jump past certain positions dur-
ing playback. This way, you will be able to audition what the material would 
sound like with certain sections cut out, before the actual edits are made.

This selection is done from the menu invoked by clicking the Skip button 
on the Transport bar.

• If you have added mute markers to your file (see “The various marker 
types” on page 329), you can select “Skip Muted regions” to skip areas 
between mute markers.

• If you have made a selection range, you can select “Skip selection” to skip 
the selected area.
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Setting the playback speed

You can change the playback speed for open documents with or without 
affecting the pitch of the audio. Playback speed can be set for:

• Wave windows.
• Audio Montages (all clips in a montage are affected).

Each separate open wave or montage can have its own playback speed 
setting if you wish, i.e. if you have several wave windows open and 
change the playback speed for one of them, the set speed does not affect 
the other windows when you switch to them. This requires that you deac-
tivate the option “Transport settings are global to all windows” in the Pref-
erences–Audio device tab. See “Transport control settings for separate 
windows” on page 136 for details.

This function can be put to good use in a number of ways. For example, 
lowering the playback speed could be used for locating certain positions 
in the audio, to discern the nuances of a tricky section, for practicing an 
elaborate recording or as a special effect.

• Note that the playback speed does not affect the original audio file in any 
way, but merely how it is played back.

To set the playback speed, proceed as follows:

1. Click the red Playback Speed button on the Transport bar.

The Playback Speed button
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2. From the pop-up menu that appears, select “Edit”.
The Playback Speed dialog appears.

The Playback Speed dialog

3. Select a preset number by clicking one of the radio buttons to the right, 
and type in the desired name in the name field above the buttons.

Note that WaveLab comes with a number of ready-made playback speed pre-
sets, so unless you want to overwrite one of these with your own settings, 
make sure to select a preset number that isn’t already used (the name should 
read “Untitled”).

4. Make the desired settings in the dialog and save them as the selected 
preset by clicking “OK”.
For a detailed description of the options in the dialog, click the question mark icon in the 
dialog.

5. You can now select the saved preset from the pop-up menu on the Trans-
port bar.
You’ll notice that the Playback Speed button on the Transport bar changes shape to re-
semble a stopwatch when you select any of the presets.
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Play tool – Playing one or both channels in stereo files

Selecting the Play tool momentarily

The Play tool can of course be selected by clicking in the Toolbox, but 
there are situations when you are working with another tool and just mo-
mentarily want to use the Play tool.

• To momentarily select the Play tool, hold down [Alt]. When you have fin-
ished playing, release [Alt].

Using the Play tool

The Play tool allows you to play back from any position:

1. Point at the position where you want playback to start.

2. If the wave is in stereo, move the pointer up or down to decide whether 
only one channel should be played back.
Watch the cursor shape, it indicates what will be played back (L, R or both).

3. Press the mouse button.
Playback continues for as long as you keep the mouse button pressed, or until the wave 
ends. After playback has stopped, the cursor will be moved to the playback start position, 
making this a quick way to locate to certain positions in the audio.

Using the Playback Browser

The Playback Browser feature helps you find a certain position in an audio 
file, by restarting playback repeatedly when you click or drag to move the 
wave cursor.

1. Activate playback using the regular Play function, or select the Play tool.
Note that depending on your Preferences settings, Playback Browsing may only be avail-
able for the Play tool.

2. Click or drag in the ruler.
If you click, playback jumps immediately to the position at which you clicked. If you drag 
continuously, a short snippet of audio from each new position is played (looped).

Playback Browser preferences

On the Preferences–Wave edit tab you will find two preferences for Play-
back Browsing:

• The Sensitivity setting is used to determine the size of the “snippets of audio” 
played back when you drag.

• When the “Restrict to Play tool” option is activated, Playback Browsing is not avail-
able when you activate Playback using the transport bar or computer keyboard.
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On the Options menu you will also find an option called “Stop after play-
back browsing”, which determines what happens when you release the 
mouse button: playback continues (deactivated) or stops (activated). 
Note that when this option is activated, the cursor will automatically be 
moved back to the playback start position on stop, allowing you to use 
this function for locate positions in the audio.

Playing the selection only

There are several ways to play the selected part of the wave only:

• Press the right mouse button in the Overview or the Main view and select Play 
Selection from the menu that appears.

• Hold down [Ctrl] and click on the Play button.
• Press [F6].

If you hold down [Shift] and press [F6], the selection will be played back repeatedly (looped).

• Drag and drop the selection on the Play button on the Transport.
• Use the Audio Range dialog (see below).

Using the Audio Range dialog

The Audio Range dialog

This dialog is opened by selecting “Edit” from the Select submenu on the 
Edit menu, and allows you to define an audio range to play back in great 
detail.
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Select the desired options in the FROM and TO sections of the dialog to 
define an audio range.

You can specify audio ranges to play back From/To:

• Start/End of the file, respectively.
• The Cursor position.
• Start/End of selection.
• Named Markers.
• User specified time positions (Custom).

In addition you can specify an offset for any range position.

The playback buttons work like this:

• In the Options section of the dialog, the audio range to be processed can 
be set more precisely. You must first set a FROM position, then set a spe-
cific length in seconds in the Options section. For this to work, the “Spec-
ify length” option must be activated.

• Using the “Snap to zero-crossing” function, you can make sure that the 
start and end of the selected range snap to a zero-crossing of the wave-
form.
This prevents click noise that could otherwise occur when start and end are played back. 

• The “Channels” pop-up menu lets you select which channel(s) should be 
played back.

• The “Play duration” option is used to set the desired playback length.
Note that this overrides the set “From” or “To” selection range. If the audio range is set to 
play to “End of selection”, the selection is 4 seconds long and the Play duration is set to 2 
seconds, only the last 2 seconds before the end will play back.

Play to The range before the set position is played back.

Play from The range after the set position is played back.

Play once The set range is played back once.

Play looped The set range is played back as a loop until you click on the Stop 
button that becomes visible during playback.
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Using the Jog/Shuttle function

The Jog/Shuttle function allows you to play back audio forwards or back-
wards, at any speed. This is useful for finding exact spots in the audio file, 
etc.

The Jog and Shuttle functions are CPU intensive because of the real-time 
scrolling that occurs. If you experience stuttering playback, try reducing the 
window size (this will reduce CPU usage proportionally).

Jog

This can be viewed as dragging the audio past a “playback point”, much 
like dragging a reel-to-reel tape past the playback head:

1. Zoom in so that you can get a good visual feedback.

2. Click the Jog/Shuttle button on the Transport bar or press [F10].
A vertical line appears in the middle of the Wave window. This is the “playback point”.

3. Move the pointer to the upper half of the Wave window.
The pointer takes on the shape of a hand.

4. Click and drag to the left or right to drag the audio past the playback 
point.
The audio is played back, forwards (if you drag the audio to the left) or backwards (if you 
drag to the right), at the speed with which you drag.

The playback point
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Shuttle

This can be viewed as playing back with a continuous control for tape 
speed and direction:

1. Zoom in so that you can get a good visual feedback.

2. Activate the Jog/Shuttle button on the Transport bar or press [F10].

3. Move the pointer to the lower part of the Wave window.
The pointer takes on the shape of a speaker.

4. Click and hold the mouse button to the left or right of the vertical line.
Clicking to the left of the line will play the audio backwards and clicking to the right will play 
the audio forwards. The playback speed is determined by the distance from the line to the 
pointer, so that the further away from the line you move the pointer, the faster the playback.

5. Release the mouse button to stop playback.

6. Deactivate the Jog/Shuttle button on the Transport bar by executing any 
stop command when finished.

Using a MIDI pitch bend wheel to control Shuttle

You can use MIDI pitch bend controller to control audio scrubbing (Shut-
tle). A MIDI interface has to be installed and working and a MIDI keyboard 
connected for this to function.

You set it up as follows:

1. Open the Key Commands dialog from the Options menu.

2. Make sure that the connected MIDI interface is selected on the “Input for 
MIDI commands” pop-up.

3. Activate the Shuttle/Pitch bend function by checking the box.

4. Set the Shuttle/Pitch bend channel to the MIDI channel you are transmit-
ting over.

5. Click OK to exit the dialog.

6. Activate “Enable MIDI commands” on the Options menu.

7. Press [F10] to activate Shuttle.

8. Now if you move the wheel you can control the playback speed and direc-
tion using the Pitch Bend wheel!
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Using ShuttlePro

WaveLab features support for Contour Design’s ShuttlePro Multimedia 
Controller. You can use the buttons on the ShuttlePro to perform the 
above described Jog and Shuttle functions, as well as several other func-
tions such as zoom in/out, undo/redo, start/stop playback, play selection, 
toggle loop mode, toggle jog & shuttle mode, open file and save as. The 
WaveLab functions that can be performed with a ShuttlePro are defined 
in a ShuttlePro preferences file called “WaveLab Shuttle Pro.pref”, lo-
cated in the WaveLab/Tools folder.

If you want to use a ShuttlePro with WaveLab, proceed as follows:

1. Copy the preferences file from the WaveLab/Tools folder to the ShuttlePro 
Settings folder.
By default, this is C:\Program Files\Contour ShuttlePro\Settings.

2. Open the ShuttlePro control panel in your ShuttlePro folder.

3. In the control panel, select “File – Import Settings” and select the “Wave-
Lab Shuttle Pro.pref” file.

4. Exit the ShuttlePro control panel.
You can now use the ShuttlePro with WaveLab.

Scrolling during playback

The “Scrolling during playback” submenu on the Options menu contains 
several options for how the view should be scrolled in Play mode:

• Note: the two last options require a fast computer and graphics card.
If you get dropouts during playback, please select another Scrolling mode.

These options do not apply to playback using the Play tool.

Option Description

Immobile view This disables scrolling completely.

View follows cursor In this mode, the waveform view will automatically change when the 
Wave cursor reaches the right side of the window during playback. 

Scroll wave (partial) In this mode, the waveform view is scrolled continuously, attempting 
to keep the Wave cursor in the middle of the view. However, if loop 
mode is activated and the loop range fits on the screen, no unneces-
sary scrolling takes place, allowing for a more stable view of the loop. 
The program will also “sense” the end of a file and stop scrolling 
when it is “in view”, rather than when the end is reached.

Scroll wave (always) In this mode, the waveform view is scrolled continuously, attempting 
to keep the Wave cursor in the middle of the screen. 
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Recording

For details on connections, recording levels, etc. please refer to the docu-
mentation that came with your audio card.

See “Multichannel recording” on page 521 for information on multichannel 
recording in the Montage.

About automatic gain controls

Some audio cards may have a feature which automatically sets the re-
cording level for the microphone input. This feature is often called AGC 
(Automatic Gain Control). For “professional” results we recommend that 
you deactivate this feature using the software that came with the card.

Please note that if you leave this feature activated, the Microphone input 
gain control in the Mixer (see later in this text) will have less effect on the 
recording level.



WAVELAB
Playback and recording 7 – 147

Preparations

To record a new file, proceed as follows:

1. Click the Record button, or press [*] on the numeric key pad.
The Record dialog appears.

The Record dialog

2. Decide whether you want to record to a “named” or a “temporary” file, by 
selecting from the pop-up at the top of the dialog.
Temporary files are practical to use, since you don’t need to name the file beforehand, you 
just “hit record and go”. On the other hand, you will need to save the file at a later stage. 
Temporary files are always wave files, while named files allow you to choose to record files 
in a number of different formats. Also note that if you plan to make a recording over several 
minutes we recommend that you record a named file.

• If you plan to record continuously for a long time, especially if it is a multi-
channel recording, you should consider using Wave 64 as the format.
Other formats can record files up to 2 GB, whereas the Wave 64 format allows you to 
record files of any size.
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• Alternatively, if you have the “Support RF64 file format”option activated, 
the standard Wave file format switches automatically to the RF64 file for-
mat as soon as the file size exceeds 2 GB, without any performance loss 
or interruption. This is especially useful when recording very long ses-
sions as there is no need to worry about file size limit (apart from available 
disk space). A RF64 file will still have the “.wav” extension but can only be 
opened with an application that supports the RF64 standard. 

3. If you have selected one of the “Named File” options in the step above, 
type in the path to the desired destination for the file on the line below the 
pop-up or click the folder button and specify a file location.
If you activate the Auto number checkbox, a three-digit number will be added to the file 
name. Starting at the number you specify in the value field to the left of the checkbox, the 
Auto number will be increased in increments with each new recording, to prevent existing 
files from being overwritten.

4. Click the file format button at the top of the Record dialog, and decide on 
a recording format. WaveLab lets you record directly into a number of dif-
ferent formats (see “Supported file formats” on page 113 for details). 
In the Audio File Format dialog that appears, you can among other things choose the desired 
format, sample rate, number of channels to record (see “Multichannel recording” on page 
521) and bit resolution. Click the question mark icon in the respective dialog for details.

The Audio File Format dialog

If you choose a bit resolution not supported by your audio card, you will not 
be able to record.

5. Click OK to close the Audio File Format dialog.

6. Select an appropriate Input mode, depending on whether you want to 
record the audio card input or the Playback output:
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• In “Audio input (hardware)” mode, WaveLab will record the signals from the 
activated inputs on your audio hardware.
This is the standard mode. Use this for recording any external audio signal sources con-
nected to the inputs on your audio card.

• If you are using an ASIO driver and this mode is selected, you can click 
the button to the far right in this section of the dialog to access the “Re-
cording channels” dialog.
In this dialog you can select which input channels you want to record from. If you have an 
audio card with multiple inputs, you can record up to 8 channels simultaneously. See “Mul-
tichannel recording” on page 521 for information about multichannel recording.

• If you are using a MME/WDM driver and this mode is selected, you can 
click the button to the far right in this section of the dialog to access the 
audio card preferences (see “Audio card settings” on page 25).

• In “Playback output” mode, the program will record only what is being 
played back in WaveLab itself. 
This mode does not utilize your audio card or any Windows audio protocols. Instead, the 
audio from WaveLab is sent straight back into WaveLab and this input is then recorded. 
The typical use for this is:
Record what you are playing back, capturing any real-time volume or parameter changes 
you make during playback.

7. If needed, activate the desired recording options in the dialog.
There are also additional settings in a separate dialog, opened by clicking the Settings but-
ton. For details, click the question mark icon in the dialog.

At this point, you can start recording (see “Start recording!” on page 152) 
if you like. For details on the available recording options, click the ques-
tion mark icon in the respective dialog.

Recording settings presets

You can create and save different recording options and settings as pre-
sets for quick access by using the Preset menu in the Record dialog.

This way, you can set up options and settings for different specific record-
ing purposes and then quickly load the settings when the need arises.

See “Presets” on page 65 for information about creating, saving and 
loading presets in WaveLab.
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Setting up the mixer (MME/WDM drivers)

At this point you may want to click the Mixer button to adjust the relative 
volume of your card’s inputs.

• For the mixer to appear, you must have specifically selected the card on the 
Preferences–Audio device tab. 
If the Input and Output are set to “Microsoft Sound Mapper” a mixer cannot be created.

Exactly what controls will appear in the mixer depends on the card, but 
here are some possibilities:

• Master Gain (output-fader)
• Synth In (input-fader plus on/off check box)
• CD (input-fader plus on/off check box)
• Line (input-fader plus on/off check box)
• Mic (input-fader plus on/off check box)

In addition to the above, the card might have custom controls for monitor-
ing, etc., which cannot be accessed from the WaveLab mixer. Again, please 
use the application(s) included with the card.

Not all audio cards have a mixer application and can therefore not access 
the WaveLab mixer. This is especially true with digital I/O cards.
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Using the meters

In the lower part of the Record dialog, you will find a meter display. This is 
useful for checking the input level, as well as the frequency spectrum of 
the input signal.

• The meters in the Record dialog are “miniature” versions of the Level, Spec-
trum and Phase Meters in the Meter windows. 
For detailed descriptions of the functionality and features, see “Level/pan meter” on page 159.

For the meters to register the signal, you need to activate the Monitor 
checkbox. This can be done automatically, if the option “Activate meters 
when opening record window” is activated in the Record Settings dialog. 
The pop-up menu in the lower left corner allows you to select between 
Level or Spectrum metering.

• When the Level Meter is selected, horizontal bars show the peak level (outer 
bars) and average loudness (VU, inner bars) of each channel.
Values are also shown numerically. If the Phase Scope option is activated on the pop-up 
menu next to the Reset button, a Phase Meter is displayed to the right of the Level Meter 
(see “Phase Scope” on page 165).

• When the Spectrum Meter is selected, a “bar diagram” will be shown, providing a 
continuous graphical representation of the frequency spectrum.
See “Spectrum meter (60 bands)” on page 166.

You can reset the meters by clicking the Reset button – this instantly re-
sets all meters and numerical indicators, including the Maximum Peak and 
RMS values to the right in the Level Meter.

You can also select one of five presets for the Level Meter on the pop-up 
menu next to the Reset button. These presets (containing settings for 
meter ranges, colors, etc.) can be edited by selecting “Settings…” from 
the pop-up menu. The options are described in the chapter “Making set-
tings for the level and pan meters” on page 161.

Use the Level Meter to check the audio input level. Adjust this (with the 
mixer controls or the audio card’s applications), so that the Peak Level 
Meters go as high as possible without ever reaching 0dB!

• You can also use the meters to monitor the signal being written to disk dur-
ing rendering or recording. See “Monitor file rendering” on page 157.
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Checking disk capacity

The Disk Capacity indicator above the meters helps you make sure you 
have enough disk space for the recording. This indicator shows the amount 
of available disk space on the hard disk specified in the Create Final File 
path, or the hard disk you have selected for your temporary files (see “Tem-
porary files” on page 28). Please note that this value is approximate.

When there is less than ten seconds of available hard disk space, the disk 
capacity indication is displayed in red.

Start recording!

When all the preparations are done, click Record to start the actual re-
cording.

• If you have selected one of the Auto-start options (click the question mark 
icon in the Record dialog), the recording will go into Pause mode (the 
Record button will blink), until the specified Auto-start criteria are met.
When recording starts, the Record button will be “lit” and the Recorded Time value will in-
dicate how much you have recorded. 

• If you have selected the “Auto-stop after given duration” option, the “Re-
maining Time” value will indicate how much recording time you have left.

• If you like, you can pause the recording by clicking the Pause button at 
any time.
The Record button will blink to indicate Pause mode. To resume recording, click the Pause 
or Record button again. As described above, a short section of audio just before you re-
sume recording (according to the Pause memory value in the Record Settings dialog) will 
be captured.

• You can drop markers in the file during recording by clicking the Drop 
Marker buttons.
See below.

• If you want to abort the recording, click the Discard button.
This terminates recording and discards the recorded file. 

• Note that if you have activated the option “Confirm when discarding record-
ing” in the Record settings dialog, a dialog will appear asking you to confirm 
whether you really want to terminate recording and discard the recorded file.
If you change your mind and select “Cancel”, recording will continue.

• When you have finished, click Stop. You can also have recording stop au-
tomatically by using one of the Auto-stop options. Either way, the record-
ing by default appears in a new window behind the dialog.
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• You can deactivate the option “Open audio file in WaveLab after recording” 
in the Record settings dialog if you don’t want the recording to appear in a 
new window.
In this case, the recorded file is saved to disk but does not automatically appear in Wave-
Lab after recording.

If you want to perform more recordings after the first, click the Record 
button and record again. If you have selected the Named File option, and 
the Auto number option is deactivated, you have to specify another file 
name to avoid overwriting the previously recorded file.

When you have finished recording completely, click the Close button (in 
the lower right corner) to close the dialog.

• If you have created temporary files, and want to save the file(s) permanently, 
click on each document you have created and use Save As on the File menu 
to save each one.
See “Saving in another format (Save as…)” on page 117 for details.

About dropping markers during recording

When you are recording, you can click the marker buttons at any time, to 
add a marker to the recorded file. The yellow button will generate a num-
bered, generic marker (see “The various marker types” on page 329), 
while the white buttons will generate numbered, generic region start and 
end markers.

If you want to name the markers you drop rather than using generic, num-
bered markers, you can do this in one of the following ways, or use a com-
bination of both:

• Type in the desired name in the box below the buttons. 
You can type in a new name for each marker before you drop. This works well if you know 
beforehand where you want to drop the markers and what their names should be. If you 
want to be able to drop markers not planned beforehand though, the method described be-
low is probably better suited.
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• Activate the option “Confirm name of markers to drop” in the record set-
tings dialog.
In this case, a dialog will appear each time you click a button to drop a marker. In this dialog, 
you can either type in a name for the marker, or you can confirm that you want to use an al-
ready entered name. The benefit of using this method is that the marker will be dropped at 
the time position when you clicked the marker button, regardless of how long you take to 
type in a name for the marker.

Furthermore, this dialog also allows you to specify a delay value for the marker. The marker 
will then be dropped at the position when you clicked the marker button, minus the delay 
value you specify. So if you clicked the marker button after 10 seconds of recording and 
specify a delay value of 2 seconds, the marker will be dropped 8 seconds into the recording.

• Note: if you insert two or more region start markers in a row (with no region 
end markers in between), only the last of these start markers will be kept 
(the first marker(s) will be removed).
In other words, the last region start marker doesn’t become “permanent” until you insert a 
region end marker.
The same goes for region end markers – if you insert several end markers in a row, only the 
last one will be kept.

This is a very useful function, because it allows you to “change your mind” 
when inserting markers during recording. For example, let’s say you are 
recording a continuous performance and want to mark all takes worth 
keeping. At the start of a take you insert a region start marker. However, 
this turns out to be a false start or a flawed take. When the next take starts 
you insert a new region start marker again and the previous, unwanted 
start marker is removed.



8
Metering
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Introduction
WaveLab offers very detailed and versatile metering, allowing you to moni-
tor level, pan, phase, spectrum and more during playback, on audio input 
and even during file rendering. This chapter describes how to display, set 
up and use the various meters.

Selecting what to monitor
On the lower part of the Analysis menu, you will find different monitor 
modes for the meters. You select a monitor mode either from the menu, or 
by clicking the corresponding button on the Meters control bar.

The six modes work as follows:

Monitor playback

This is the normal metering mode, in which the meters reflect the audio 
being played back. Note that metering occurs after the Master Section in 
this mode, which means the results of effects, dithering and Master faders 
are taken into account.

In this mode, the meters can be used for monitoring all kinds of audio 
playback: Wave windows, Audio Montage, audio CD track lists, audition 
in file dialogs, etc.

Monitor audio input

In this mode, the meters will reflect the audio input to the program. Typi-
cally, this is the mode to use when recording. The Master Section settings 
are not taken into account in this mode.

Freeze all meters

Selecting this “mode” will freeze all open meters, causing them to keep 
the values and readings displayed the moment you selected the mode. 
The meters will remain frozen until you select another monitor mode.
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Monitor edit-cursor position

This mode is only available for Wave windows. When this is selected, the 
meters will be static, showing the levels and other values for the audio at 
the position of the Wave Cursor, in stop mode. This allows you to analyse 
a certain position in an audio file, in real time. The Master Section settings 
are not taken into account in this mode.

Analyse selection

Again, this mode is only available for Wave windows. It allows you to 
make a selection and have the meters display the average values over the 
selected range, statically. The Master Section settings are not taken into 
account in this mode.

When you change the selection, you need to update the meter displays by 
selecting “Refresh selection analysis” from the Analysis menu (or by click-
ing the Refresh button on the Meters control bar).

Monitor file rendering

When this mode is activated, you can monitor what is being written to 
disk during file rendering or when recording. Master Section settings are 
taken into account. Like Analyse selection, average and min/max peak val-
ues are computed.

After rendering, the meter(s) will freeze, and remain so until you refresh or 
change monitor mode.
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Multi-channel metering
As previously mentioned, WaveLab features 8 audio channels internally 
that can be routed to inputs and outputs on a multi i/o audio card. The Au-
dio Montage supports various surround channel configurations using up 
to 6 channels (see “Multichannel operation in the Montage” on page 506 
for more information).

WaveLab can display multiple meters so when working with multiple 
channels in the Audio Montage, each channel can be metered. This ap-
plies to all meters (up to 8 real time FFTs, 8 level meters, 4 pan meters, 4 
phase scopes, etc.). If a surround configuration is selected, each meter 
indicates the corresponding surround channel (Lf, Rf, LFE, etc.).

The Bit Meter in a 6 channel (5.1) surround configuration.
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The meters
There are seven different meters in WaveLab, each with its separate win-
dow. The meters are opened and closed from the Analysis menu (or by 
clicking the buttons on the Meters control bar).

• To close all open meter windows, click the Close Meters button on the 
Meters control bar.

As with any standard window, you can resize the meter windows by drag-
ging the window borders, and fold the windows by clicking the fold icons 
(or by double clicking the title bars).

On the following pages, the available meters are described.

Level/pan meter

Level meters

The upper part of the level/pan meter window shows the peak level and 
average loudness, in the following way:

• The Peak Level meters display the peak levels of each channel, graphically and 
numerically.
By default, the meter segments and numerical peak values are displayed in green for low 
levels, yellow for levels between –6dB and –2dB, and red for levels above –2dB. You can 
change both the colors and the range boundaries if you wish, as described on “Making set-
tings for the level and pan meters” on page 161.

VU meters

Peak level 
meters

Meter presets (see “Selecting meter presets” on page 165) Reset button
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• The VU (Volume Unit) meters measure the average loudness (RMS) of each 
channel.
These meters have a built-in inertia, evening out loudness variations over a user-defined 
time span. 
If you are monitoring playback or audio input, you will also note two vertical lines following 
each VU meter bar, seemingly “trying to reach” the current RMS value. These lines indicate 
the average of the most recent minimum RMS values (left line) and the average of the most 
recent maximum RMS values (right line). To the left, the difference between the minimum 
and maximum average values is displayed (the level value in brackets) – this gives you an 
overview of the dynamic range of the audio material.

• If you are monitoring real-time audio (playback or input), the maximum peak and 
loudness values are displayed numerically to the right of the meter bars.
Numbers in brackets to the right of the Maximum Peak values indicate the number of suc-
cessive clips (0dB signal peaks). 1 or 2 clips can be acceptable, but if you get a larger 
number, you should lower the master level to avoid digital distortion.

Pan meters

The lower part of the window shows the pan (the difference in level be-
tween the left and right channel, only applicable when monitoring stereo 
audio):

• The upper pan meters show the peak level difference between the channels, 
graphically and numerically.
Note that the pan meters are “two-sided”; the level bars can go to the left or right, indicating 
which channel is the loudest. The two sides are shown in different colors (which can be 
edited – see “Making settings for the level and pan meters” on page 161).

• The lower pan meters show the average difference in loudness between the 
channels, in a similar way.
This gives you a visual indication of whether a stereo recording is properly centered, etc.

Recent minimum Recent maximumDifference value
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• If you are monitoring real-time audio (playback or input), the maximum balance dif-
ference values (peak and loudness) for each channel are displayed numerically to 
the left and right of the meter bars.

Resetting the meters

You can reset the level and pan meters by clicking the Reset icon, or by 
selecting Reset from the Options pop-up menu. This instantly resets all 
meters and numerical indicators, including the Maximum Peak and RMS 
values and the number of signal clips.

The Reset icon

Making settings for the level and pan meters

You can adjust the behavior, scale and color of the meters as desired. It is 
also possible to save five sets of meter settings as presets, for instant ac-
cess. Proceed as follows:

1. Pull down the Options pop-up menu and select “Settings” (or click the 
“tool” icon).
The Level/Pan Meter Settings dialog appears.
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2. Adjust the settings as desired.
By using the Apply button, you can check the results of your changes without closing the 
dialog. The following settings are available:

Setting Description

Global colors Click these buttons to select colors for the meter background, marks 
(scale units) and grid lines.

Global range This is where you specify the low and high end of the displayed level range. 
Typically, you may want to create a preset showing the full level range, and 
other presets for detailed view of a smaller range.

Peak meter – 
Ballistics

These settings determine how fast the peak level meter falls after a peak 
(Release rate) and for how long the numerical peak indication remains dis-
played after a peak (Peak hold time).

Peak meter –
Zones

The color buttons allow you to select colors for the peak level meters’ low, 
middle and top zones. You can also define what should be considered 
“middle” and “top” zones, by changing the “Middle zone from” and “Top 
zone from” values. 

Peak meter – 
Cursor mode

These settings are only relevant when using the meters in Cursor mode 
(“Monitor Edit-cursor position” selected). Here, you can choose by which 
units the peak levels should be displayed.
There is also a choice of whether to display the value of the single sample 
at the cursor position (checkbox ticked) or the peak value of the range 
around the cursor position (this range is set with the Samples to scan pa-
rameter in the VU meter section). Generally, the option is best activated 
when you have zoomed in on the waveform to see the details, and best 
turned off when you’re working at normal zoom.

VU meter –
Show

Allows you to activate or deactivate the VU meters.

VU meter –
Mode

On the pop-up you can select between Standard and three special K-Sys-
tem modes. The K System metering modes are described below this table.

VU meter – 
Ballistics

These settings determine how the VU meter responds:
Resolution is the sample width of the “average window” for the VU meter 
(the number of samples continuously evaluated to calculate the average). 
The smaller this is, the more the VU meter behaves like the peak meter.
Range inertia determines the “average windows” for the recent minimum 
and maximum value lines, and will therefore affect how quickly these re-
spond to changes in loudness.

VU meter –
Zones

The color buttons allow you to select colors for the VU level meters’ low, 
middle and top zones. You can also define what should be considered 
“middle” and “top” zones, by changing the “Middle zone from” and “Top 
zone from” values (only available in Standard VU mode). 

VU meter – 
Cursor mode

This setting determines how many samples to scan when calculating the 
VU meter value in “Monitor edit-cursor position” mode.
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3. If you want to store your settings for later use (or assign them to a preset), 
select “Save as…” from the pop-up menu at the bottom of the dialog, and 
specify a name for the preset in the file dialog that appears.

4. To make the settings instantly available for selection in the Meter window, 
use the “Assign to preset button” submenu on the pop-up menu.

5. When you are finished, click OK to close the dialog.
Clicking Cancel closes the dialog and discards any changes you have made (even if you 
have used the Apply button to apply them to the meters).

About the K-System VU meter modes

Mastering engineer Bob Katz has proposed the “K-System” which inte-
grates standardized metering, monitor calibration and level practices. 

• The technical concept behind this proposed standardization is described in 
detail on “www.digido.com”.
Go to the “Articles” section and select the “Level practices” page. Here, in an illuminating 
two part article, Bob Katz explains the theory behind the K-System. Anybody genuinely in-
terested in sound mastering practices should read this!

In WaveLab, the K-System’s loudness metering standard is available as 
an option. There are three metering modes which all set the 0 dB VU 
point below the standard VU meter. This allows much more headroom for 
transients and peaks to be accommodated at their normal level. The 
meter is still just a scale of course, and the basic audio material will be the 
same regardless how you meter it. But by adapting to the K-System way 
of metering average loudness and peak levels (and understanding the ba-
sic principles behind it), you may find that your mastered audio material 
will sound better.

• To fully utilize the K-System you need to calibrate your monitor level so 
that 0VU equals 83dB.
You should use a pink noise reference signal and a SPL level meter. Use C weighting (slow 
response), and adjust your playback level so that your noise meter indicates 83dB SPL per 
channel or 86dB SPL when played on the two channels simultaneously. 

During mixing or mastering digital audio, many strive to keep the level as 
close to maximum as possible, without introducing clipping. This is done 
to “maximize” the loudness of the recording. This practice has been an 
ongoing and escalating trend over the last couple of decades, so that it 
has now virtually become standard practice (the overuse of Loudness 

Panning Meter In this section, you can turn the pan meter on or off, change the colors 
used for the pan meter bars and adjust the dB range of the pan meter.

Setting Description
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Maximizers being one of the main reasons). The trouble with this practice 
is that it renders average loudness levels that are very close to the maxi-
mum peak levels which drastically reduces the available “headroom” or 
dynamic range.

The difference between the average loudness and the peak level is often 
around 11 to 15dB in a dynamic high quality recording. This means that if 
you strive to squeeze the maximum “loudness” out of such a recording 
when mixing or mastering, the peaks or transients will obviously have to 
be limited quite heavily, thus negatively affecting the natural openness, 
clarity and dynamic range of the audio material. 

It “quashes” natural transients, lowers the dynamic range, introduces dis-
tortion and degrades the quality of the audio, all for the sake of making the 
audio as loud as possible. For pristine audiophile recordings this is defi-
nitely not good practice!

The K-System has three meter operating modes (selectable from the VU-
Meter pop-up in the Level/Pan Meter Settings dialog). These are intended 
for different applications, as follows:

• K-System 20:
This places 0 VU 20dB lower than standard VU mode, and is intended for music with very 
wide dynamic range, e.g. classical music.

• K-System 14:
This places 0 VU 14dB lower than standard VU mode, and is intended for music with 
slightly more compressed dynamic range. Use this for typical pop, R&B and rock music.

• K-System 12:
This places 0 VU 12dB lower than standard VU mode, and is primarily intended for broad-
cast applications.
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Selecting meter presets

If you have assigned your settings to the Preset buttons in the Settings di-
alog, you can quickly switch between different level scales and display 
modes, by clicking one of the Preset icons [1]-[5], or selecting the desired 
preset from the Options pop-up menu.

Phase Scope

The Phase Scope is only relevant when monitoring stereo audio material.

The Phase Scope indicates the phase and amplitude relationship be-
tween the two channels, in the following way:

• A vertical line indicates a perfect mono signal (the left and right channels are the 
same).

• A horizontal line indicates that the left channel is the same as the right, but with an 
inverse phase.

• A random but fairly round shape indicates a well balanced stereo signal. If the 
shape “leans” to the left, there is more energy in the left channel and vice versa 
(the extreme case of this is if one side is muted, in which case the Phase Scope 
will show a straight line, angled 45° to the other side).

• A perfect circle indicates a sine wave on one channel, and the same sine wave 
shifted by 45° on the other.

• Generally, the more you can see a “thread”, the more bass in the signal, and the 
more “spray-like” the display, the more high frequencies in the signal.

At the bottom of the display, you will find a Phase Correlation meter, 
which shows the same information but in a different way:

• The green line shows the current phase correlation, while the two red lines show 
the recent peak minimum and maximum values, respectively (these are the default 
colors, which can be adjusted).
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• With a mono signal, the meter would show +1, indicating that both channels are 
perfectly in phase.

• Similarly, –1 indicates that the two channels are the same, but one is inverted.
• Generally, for a “good” mix, the meter should show a value between 0 and +1.

Unlike the main Phase “coil” meter, the Phase Correlation meter is also 
available in “Analyse Selection” mode, showing an average value for the 
selected range.

Making settings

To make settings for the Phase Scope, select “Settings” from the Options 
pop-up menu, or click the “tool” icon. The dialog that appears contains 
the following settings:

Spectrum meter (60 bands)

The Spectrum meter shows a continuous graphical representation of the 
frequency spectrum, in the shape of a “bar diagram” with 60 frequency 
bands (much like a simplified form of the FFT meter below).

Setting Description

Background Click this to change the background color.

Coil display Allows you to adjust the color for the grid and phase coil display.

Auto-size When Auto-size is activated, the display will be optimized so that the 
size of the “shape” matches the window size.

Correlation display This is where you select colors for the elements in the Phase Correla-
tion meter display, and adjust the Peak hold time for the maximum and 
minimum indicators.

Number of samples
to display

This setting affects the length of the phase coil, and hence the den-
sity of the display. For audio with high sample rates, you might want 
to raise this value.
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Spectrum analyser (FFT)

The Spectrum Analyser uses FFT (Fast Fourier Transform) to display a 
continuous frequency graph, allowing for very precise and detailed real-
time frequency analysis.

• The current frequency spectrum will be shown as a red graph (by default).
• Spectrum “peaks” (recent maximum values) will be shown as a purple graph. All 

colors can be adjusted in the Settings dialog as described below.
• By clicking the camera icon, you can take a snapshot of the current spectrum. 

This will be superimposed on the current peak spectrum graphs, in a color you 
can customize (by default, a white graph), until you click the camera icon again (to 
take a new snapshot). One use for this is to check the effects of adding EQ, etc.

Zooming

You can adjust the frequency scale and range in the Settings dialog as de-
scribed below, but it’s also possible to temporarily zoom in on a frequency 
area of interest. This is done by clicking and dragging a rectangle in the 
Spectrum display – when you release the mouse button, the display is 
zoomed in so that the enclosed frequency range fills the window. To return 
to full-scale display, select “Zoom-out fully” from the Options pop-up menu.
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Making settings

You can adjust the behavior and display of the meters as desired, and as-
sign up to five sets of Spectrum Analysis settings to the Preset buttons, 
for instant access. Open the Settings dialog by selecting “Settings” from 
the Options pop-up menu or clicking the “tool” icon.

The dialog has two tabs (see below).

• The Process tab contains parameters for the actual analysis:

Setting Description

Analysis
block size

The higher this value, the higher the accuracy in the frequency domain (the 
spectrum is divided into more bands). However, raising the block size value 
will also require more CPU power and introduce more latency. Therefore:
High values may only be usable for off-line monitoring.

Analysis 
overlapping

To get more accurate results, the program can analyse overlapping blocks 
(i.e. samples will be analysed more than once). This setting determines the 
amount of overlap between each block – the higher the value, the more ac-
curate the results.
A word of caution: raising this value is very CPU intensive. Compared to no 
overlap at all, a setting of 50% requires twice the amount of CPU power, a 
setting of 75% requires four times the CPU power, etc.

Smoothing 
window

Allows you to choose which method should be used for pre-processing the 
samples in order to optimize the display of the desired information in the 
spectrum. The smoothing window sets a compromise between the accu-
racy at which a frequency can be detected, and the noise-floor.
This parameter is best left at its default setting, if you’re not an expert in the 
field. 
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• The Display tab contains settings for how the spectrum graph should be 
shown:

Note that you can apply your settings without closing the dialog, by click-
ing the Apply button.

If you want to store your settings for later use (or assign them to a Preset 
button), select “Save as…” from the pop-up menu in the lower part of the 
dialog, and specify a name for the preset in the file dialog that appears. 
Now, you can choose to make the settings instantly available for selection 
in the FFT Meter window, by using the “Assign to preset button” submenu 
on the pop-up menu.

• When you are finished, click OK to close the dialog.
Clicking Cancel closes the dialog and discards any changes you have made (even if you 
have used the Apply button to apply them to the meters).

Setting Description

Frequency ruler 
range

Determines the frequency range to be shown, at full-scale display. 
Note that the lowest frequency actually to be shown depends on the 
Analysis block size setting and the highest actual frequency depends 
on the sample rate (only frequencies up to about half the sample rate 
will be shown).

Logarithmic scale When this is activated, each octave will occupy the same horizontal 
space in the display. If you need more resolution in the high frequency 
range, you may want to turn this off.

Level ruler range Determines the range of the vertical level ruler, in dB or as a percent-
age.

Normalize display 
to 0dB

This is only relevant in non-real time mode. If this is activated, the level 
display is offset, so that the highest point on the curve is displayed as 
0 dB (reaches the top of the display).

Optimize scale This option will optimize the level scale so that the only the relevant 
level range is shown. Again, this is only available in non-real time 
mode. 

Display type Allows you to choose whether the spectrum should be shown as a 
curve or as a bar graph.

Peak Hold time Determines for how long the peak level graph remains displayed when 
the levels drop.

Colors This is where you select colors for the curves, grid, background, etc.
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Selecting Spectrum Analyser presets

If you have assigned your settings to the Preset buttons in the Settings di-
alog, you can quickly switch between different level scales and display 
modes, by clicking one of the Preset icons [1]-[5], or selecting the desired 
preset from the Options pop-up menu.

Exporting FFT data as ASCII text

When using the Spectrum Analyser in off-line mode (“Monitor Edit-cursor 
Position” or “Analyse Selection” mode) you can export the displayed FFT 
data as a text file, by selecting “Export FFT data as ASCII” from the Op-
tions pop-up menu. The resulting text file can then be imported into e.g. 
Microsoft Excel, or other applications that allow graph plotting from text 
files, etc.

Bit Meter

The Bit Meter shows how many bits are used, i.e. the resolution of the au-
dio being monitored. While you may expect the maximum number of bits 
to be the same as the resolution of the audio file (e.g. a 16 bit audio file 
would show up to 16 bits being used), this is not necessarily the case!
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As soon as you perform any kind of real-time processing on an audio file, 
the audio data will be treated at a much higher resolution (32 bit floating 
point), to allow for pristine audio quality. Examples of such processing in-
clude level adjustments, effects, mixing of two or more files, etc. In fact, 
the only time when a 16 bit file will be played back at 16 bit resolution is if 
you play it without any fades or effects, and with the Master Faders set to 
0.00 (no level adjustment). You can try this out for yourself by playing 
back a 16 bit audio file and viewing the Bit Meter – as soon as you adjust 
the Master Faders, you will note that 24 bits are used and the “inter” indi-
cator is lit (more on this below).

How to “read” the Bit Meter

• The innermost meters (closest to the bit scale) show the number of bits in use. 
You can adjust this display in the Settings dialog, as described below.

• The outer meters are “history” meters, showing how many bits were recently in 
use. You can adjust the hold time in the Settings dialog.

• The “over” segment indicates clipping, similar to a clip indicator.
• If the “below” segment is lit, there are more than 24 bits. The bit meter will show 

the 24 higher bits, and the “below” segment indicates the existence of extra, 
lower bits. Note that audio is processed with more than 24 bits internally.

• If the “inter” segment is lit, this indicates that the audio data cannot really be ex-
pressed on a regular 24 bit scale (there are floating point values “in between” bits 
– thus the label “inter”). This is typically the case if you apply effects, etc.
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When to use the Bit Meter

• To check whether dithering is necessary or not.
As a rule, if you’re playing back or mixing down to 16 bits, and the Bit Meter shows that 
more than 16 bits are used, you should apply dithering.

• To see the “actual” resolution of an audio file.
For example, even though a file is in 24 bit format, only 16 bits may be used. Or, a 32 bit file 
may only use 24 bits (in this case, the “below” segment would not be lit). For this purpose, 
the Bit Meter is best used in “Analyse selection” mode.

• To see whether a “zeroed” plug-in still affects your signal, or whether a plug-in 
uses 16 bit internal processing.

Making settings for the Bit Meter

To adjust the Bit Meter settings, select “Settings…” from the Options 
pop-up menu or click the “tool” icon.

The dialog that appears contains the following settings:

Setting Description

Colors You can adjust the colors of the meter segments, grids, background, etc. 
by clicking the corresponding color buttons.

Bit hold time Determines for how long peak values are held (by the outer meters, by de-
fault shown in dark green).

Bit display Determines how the bits are displayed:
In “Intuitive mode”, the absolute value of the signal is displayed. The bar 
graphs will go higher with higher signal levels, similar to a common level 
meter (although the range will not work the same way).
In “True mode”, the meter shows the direct mapping of the bits, but since the 
actual values may be negative, there is no intuitive relationship with the level 
(a negative value may use a lot of bits, even though its absolute value is very 
small). This mode is useful if you instantly want to check the full range, since 
all bits will quickly be displayed, regardless of the audio signal level.
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Oscilloscope

The Oscilloscope is a “microscope” version of the level meter, showing 
the area around the cursor position at large magnification.

The Oscilloscope cannot be used in “Analyse Selection” mode.

If you are analysing stereo audio, the Oscilloscope will normally show the 
separate levels of the two channels. However, if you activate the option 
“Show Mix and Subtraction” on the Options pop-up menu (or click the +/– 
icon) the upper half of the Oscilloscope will show the mix of the two chan-
nels and the lower half will show the subtraction.

Making settings

Selecting “Settings” from the Options pop-up menu (or clicking the “tool” 
icon) will open the Oscilloscope settings dialog. Here you can adjust the 
display colors, and choose whether Auto-zoom should be active or not. 
When Auto-zoom is activated, the display will be optimized so that the 
highest level reaches the top of the display at all times.
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Waveform Scope

This meter displays a real time waveform drawing of the audio signal being 
monitored. It can be useful when recording or rendering a file (if “Monitor 
File rendering” mode is active – see “Monitor file rendering” on page 157).

Making settings

Selecting “Settings” from the Options pop-up menu (or clicking the “tool” 
icon) will open the Waveform Scope settings dialog. Here you can set 
various color options for the background, grid and waveform display, as 
well as setting the waveform rendering speed and vertical zoom.

If “Clear waveform when reaching right of pane” is checked the waveform 
display is cleared each time the cursor reaches the right end of the dis-
play. If unchecked, the previous waveform is overwritten.



9
Off-line processing
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Introduction
When we refer to off-line processing, we mean functions that “perma-
nently” alter the file, to make it sound more or less different. This is in 
opposition to “real-time processing”, which makes the file play back dif-
ferently, without making any permanent changes to it. Real-time pro-
cessing is described in the next chapter.

Applying processing
Processing can be applied to a selection or to a whole file. For certain 
processing operations processing the entire file is necessary. This will be 
indicated in the respective section.

• If “Process whole file if no selection exists” is activated in the Preferences–
Wave edit tab, the whole file will automatically be processed if no selection 
exists.

To apply processing to a selection, proceed as follows:

1. Make a selection.
Note that you will “Select All” to process the entire file. If the file is in stereo, you can apply 
processing to either channel or both, by selecting one channel or both, see “Selecting in 
stereo files” on page 91.

2. Select the desired type of processing from the menus.

3. If a dialog appears, fill it out.
If the dialog uses presets, you can load one of them to fill out the settings automatically, see 
“Presets” on page 65.

4. When you have finished with the settings in the dialog, click the Apply/
Paste/Process button.
The status bar shows the progress of the operation. If you need to interrupt a long process, 
click the “Stop” button on the status bar or press [Esc].

Undo/Redo

No matter how long the selection is or how elaborate the processing may 
be, you have access to unlimited Undo/Redo for all processing. The only 
limitation to this is the available hard disk space, as described in the sec-
tion “Undo and Redo” on page 47.
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Getting the most out of the non-modal dialogs

The processing dialogs are non-modal, which means they stay on screen 
even after the processing has been applied. This, together with the Undo 
allows you to try different types of processing without ever leaving the di-
alog (or even stopping playback!):

• When the dialog is still the active window you can use the computer key-
board for the following operations:

• While the dialog is still open (but inactive) you can select from menus and 
use other dialogs and palettes (for example the Transport bar).

• You can “fold in” and “fold out” non-modal dialogs, as described in the 
section ““Folding” windows” on page 52.

Presets

As described in the section “Loading presets” on page 65, you can use 
presets for most processing dialogs, to save and recall settings. In addi-
tion, the program comes with a number of useful presets for each pro-
cessing option.

Key Command

[F3] Undo

[F4] Redo

[F6] Play selection

[Shift]+[F6] Loop selection

[F7] Stop

[F8] Play
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Level Normalizer

This allows you to change the amplitude (volume) of the selection. The 
value is always related to the maximum level that can be obtained.

The controls

To find out exactly what each control in the dialog does, click the question 
mark icon in the dialog.

Gain Change

This also allows you to change the amplitude (volume) of the selection, just 
like the Level Normalizer. The difference here is that the gain change is set 
in absolute numbers, plus/minus the current level (which is indicated as 
0dB).
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Clipping

This processor lets you do something that most other functions in Wave-
Lab never do: introduce clipping.

Clipping is when the gain is raised to a point where distortion is added. 
While this is normally not wanted, mild clipping in for example the attack 
of a drum sound can add some “punch”.

If you try to raise the level of a 
wave above 0dB (100%)…

…it will get distorted (the 
peaks are “clipped”).
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Loudness Normalizer

This processing tool allows you to specify the loudness of a file. Because 
it relates to loudness as opposed to maximum peak level, this tool works 
quite differently than the Level Normalizer. A typical application is to spec-
ify a level, e.g. -12dB, and the Loudness Normalizer will process the loud-
ness to match this level.

Like Gain Change, increasing the loudness to a certain value might intro-
duce clipping, which is to be avoided. To remedy this, a peak limiter (the 
Peak Master plug-in) can be part of the process. The Loudness Normal-
izer will smartly raise the loudness and limit peaks in the signal at the 
same time (if needed), to achieve the desired loudness.

In case of stereo files, both channels are processed independently.

• This process happens over two stages; first an analysis and then the final 
rendering. 
The results of this analysis can be seen in the Statistics. If all seems well, you can apply the 
processing using the Render button. 

• The Loudness Normalizer is also available in the Batch processor, which 
is logical as one of the primary applications is to process different files to 
equal loudness.
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The dialog contains the following options:

Item Description

Desired Loudness The loudness you desire to achieve. Positive and negative values can 
be set.
Be aware that specifying high positive values might not be good prac-
tice, as this could require a gain which is beyond what the limiter can 
properly handle so distortion could occur. A good tip is to use “Statis-
tics” (see below) after specifying a loudness, which will tell you how 
much the gain needs to be raised and if peak limiting needs to be ap-
plied. Light peak limiting is acceptable, but if heavy limiting is necessary 
this will probably render a result that will not accurately match the de-
sired loudness and precision and might degrade the audio quality. In 
such cases a warning will be shown after applying the process, allow-
ing you to undo it.

Sliding interval 
(keep maximum) 

If this option is not checked, the global average loudness of the selec-
tion (or the whole file) is used as a loudness reference (RMS). If 
checked, a “sliding interval” is used, meaning that the maximum loud-
ness value found in the audio selection is retained, and used as a refer-
ence. If you have a file where the overall loudness is more or less even, 
leave this option unchecked. If you have a file with a high dynamic 
range, Sliding interval is preferable.

Compensate for 
ear’s frequency 
sensitivity

The human ear is less sensitive to low and high frequencies than to mid-
range frequencies (as shown in the famous “Fletcher-Munson” curve). 
Moreover, the degree of this phenomenon depends on the overall loud-
ness (the lower the loudness, the more sensitive the ear is to the fre-
quency difference).
WaveLab takes into account the frequency contents of the file. E.g. if it 
contains much bass, you’ll get a lower RMS value if you use the com-
pensation option (since low frequencies contribute less to the per-
ceived loudness), and a higher value if mid-range frequencies are 
prominent. If you want to normalize two files so that they sound equally 
loud, you should specify both equal “Desired loudness” values and 
equal “Compensation” values. 

Catch loudness from 
audio selection 

This will set the “Desired loudness” value to the average loudness 
found in the current audio file (or selection). 

Peak Limiter – 
Max peak level

This specifies the maximum peak level of the resulting audio. The lower 
this is set, the less loudness you can achieve.

Peak Limiter – 
Softness

This parameter affects the way the Peak Master operates. A high set-
ting will maximize the perceived loudness effect but can in some cases 
result in a slight harshness of the sound. Adjust this parameter to opti-
mize the balance between sound quality and the desired effect.

Remove DC offset If any DC offset exists in the file, this will affect the loudness computa-
tion. Therefore it is recommended that you keep this option activated. 
See “Eliminate DC Offset” on page 195 for a description of DC offset.
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Attempts/Analysis – 
Desired precision

If the Desired loudness requires peak limiting, this will also reduce the 
loudness to some degree. This can’t be computed in advance and be 
automatically applied to the gain change, because the limiting is a com-
plex process. Instead, several simulation passes are performed to find 
the best possible gain. This option lets you define the desired precision 
of the result. 

Attempts/Analysis – 
Maximum number of 
passes

WaveLab will perform as many analysis passes as are needed to match 
the desired precision. Use this option to specify the maximum number 
of passes to be performed.

Attempts/Analysis – 
Authorized peak 
compression

As too much compression will degrade the audio quality, you can here 
specify a limit to the applied compression. The value can be set be-
tween -1 and -20 dB. If you actually need maximum allowed compres-
sion (-20 dB) to achieve the desired loudness, it might be better to 
reconsider, and instead lower the Desired loudness value, as this will 
almost certainly render better results.

Warn if 
unmatched

If checked, this will warn you if the normalizing process does not meet 
the desired loudness/precision. This option is not available in the Batch 
processor.

Statistics This opens a window which shows you information about the file to be 
processed. It will show any DC offset, the current loudness, the current 
peak level, the required gain to achieve the desired loudness, and an in-
dication about whether or not limiting is required.

Loudness 
distribution

This opens the Loudness distribution dialog where you can see how 
frequently a given loudness occurs in an audio file. For instance if the 
peak in the display is at -12 dB, this would be the most frequent loud-
ness found in the file (this is different from average loudness). Use the 
“?” button in the dialog for more information.

Item Description
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Pan Normalizer

The Pan Normalizer can ensure that both channels of a stereo file have 
the same level or loudness. You need to have a stereo selection in a ste-
reo file to apply this process. 

• This process requires two passes (analysis and rendering). 

• The Pan Normalizer is also available in the Batch processor.

The dialog contains the following options:

Item Description

Peak level The channel with the lowest peak level will be raised to match the peak 
level of the other channel.

Loudness (RMS) This is the most useful mode. The loudness of both channels is first an-
alyzed, then the gain of each channel is adjusted to get matching loud-
ness levels on both channels. The resulting loudness will be the 
maximum loudness found during the analysis (in either of the channels). 
No clipping can be introduced using the Pan Normalizer.

Remove DC offset If any DC offset exists in the file, this will affect the loudness computa-
tion. Therefore it is recommended that you keep this activated. See 
“Eliminate DC Offset” on page 195 for a description of DC offset.

Analyse channel
difference…

This will show you the current Loudness ratio between the left/right 
channels. The result will differ according to the selected “Peak/Loud-
ness” mode.

Apply Applies the processing.
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Dynamics

This dialog allows you to tailor the dynamics of the audio, to create effects 
like compression, expansion, limiting and noise gating. Since dynamic 
processing of audio is a big subject, we will not be able to describe all the 
possibilities in this short text. Please study the included presets which im-
plement examples of the above-mentioned functions and experiment with 
the controls to get a feeling for what they do.

The Time Response controls

The settings in this section apply regardless of whether you use the 
graphic editing possibilities or not. These controls govern how a variation 
in sound level in the material affects the amount of processing.

The Attack parameter, for example, is related to the beginning of new 
sounds in the material (for example each new “hit” in a drum recording). 
Raising the Attack time means that more of the beginning of each sound 
(the attack) will pass through unprocessed.

We recommend that you try the Auto feature first, and if that doesn’t give 
the desired result, use the individual controls instead.

To find out exactly what each control in the dialog does, click the question 
mark icon in the dialog.
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The Normalize controls

These are used to normalize the sound before and/or after processing. 
Please note the following:

• The effect of all dynamic processing depends on the amplitude (level) of the mate-
rial to be processed. Therefore, if you process a number of files with slightly different 
levels (for example using presets or batch processing) the effect of the processing 
will be different from file to file. To avoid this, activate “Normalize before”.

• On the other hand if you are experimenting with different settings, this means that 
after activating “Normalize before” you may have to re-adjust the Threshold level. 
See “Level Normalizer” on page 178 for more information on normalizing.

• One reason for setting the “Normalize before” value to less than 0 dB (full level) is 
if you are expanding, which might introduce clipping if the signal is too strong to 
start with.

Again, click the question mark icon in the dialog for details.

The Dynamics controls

When the Graphic Editing switch is deactivated, the dynamics processor 
works very much like a simple compressor. Use the Threshold and Ratio 
settings to set the amount of compression (click the question mark icon in 
the dialog for details).

About graphic editing

When the Graphic Editing check box is activated, you can specify any in-
put to output function. This allows you to “draw” limiters, noise gates, ex-
panders, etc. and combinations of all these. See the presets for examples.

• The curve shows input level along the horizontal axis and output level along the 
vertical axis. With a straight line diagonally, each input level is represented by the 
same output level (the signal is not processed at all).

No processing
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• If the curve starts at 45° and then tilts downwards from any point, signals above 
this point will have a lower output level than input level. In other words, a gain 
(compression) reduction is performed.

Compression

• If the curve is tilted upwards instead, the output level will be higher than the input 
level, which is referred to as expanding.

Expansion

• If the curve is horizontally flat from some point, the output level will be the same 
regardless of input level. This is referred to as limiting.

Limiting
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• If the curve starts out horizontally flat and then rises upwards, signals in the flat 
area will be eliminated completely. This is called (noise) gating.

Gating

Setting up the curve

• You can drag any breakpoint in the curve to any position, using the left 
mouse button.

• When you move breakpoints closer to the left side or the bottom of the 
graph, you will note that the number of positions is more limited. This is 
due to the nature of digital audio, where, for lower levels, a smaller num-
ber of “bits” is used to represent the data.

• You can add a new breakpoint by clicking anywhere on the curve with the 
left mouse button.

• You can delete a breakpoint by clicking on it with the right mouse button.

• The Reset button restores the curve to a straight line with only one break-
point.

• The “Add point at level selection” button adds a breakpoint at the level in-
dicated by the current level selection (see “Level selections” on page 98 
and the example below).
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An example of using “Add point at level selection”

The “Add point at level selection” function can be used to create a noise 
gate with a threshold at a certain level. Let’s say you have a recording of 
narration, with noise between the phrases that you’d like to remove:

1. Make a regular selection in a section that only contains background noise.
The longer this selection, the more accurate the result will be.

2. Select “Extend to peaks” from the Select submenu on the Edit menu.
The selection height now represents the level of the background noise.

3. Open the Dynamics dialog and set it up for graphic editing.

4. Remove all breakpoints from the graph.

5. Click on the “Add point at level selection” button.

6. Add a second breakpoint, “manually”, to the left of the one that just ap-
peared.

7. Drag this second breakpoint so that it appears directly below the other 
one, at the bottom of the graph.
See the noise gate example above.

8. Adjust the Attack, Hold and Release settings as desired.

9. Go back to the Wave window and select the section to be gated.

10. Open the Dynamics window and click the Process button.

11. Listen to the result, and if necessary, Undo, adjust the settings and Pro-
cess again.

Expert settings

The Dynamics dialog has a special tab devoted to “expert” settings. Click 
the question mark icon in the respective dialog for details.
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Level envelope

This dialog allows you to create a volume envelope which can be applied 
to a selected range or a whole file.

The dialog consists of a waveform view in the middle, with an envelope 
curve (initially a straight line) running through it. A vertical ruler displays 
the level change in dB, and the horizontal ruler displays the time line. You 
can boost the level up to 6 dB and decrease it down to silence.

Basic operation procedure

By adding points to the envelope curve you can create an envelope curve 
that will change the volume of the material over time.

1. Double click on the envelope curve to add a point.
A point will be added where you click. 

2. If you click on the point it will be selected (red color) and by click-drag-
ging you can move it in any direction.
The curve changes accordingly in the waveform display.

• When you point the mouse in the display (or move a point), the current 
position and level change is shown continuously in the field above the dis-
play.

3. You can keep adding as many points as you like to the curve.
You cannot move a point past a another point in the horizontal direction.

4. You can select several points using [Shift] and move them together.
By clicking on the envelope curve itself (not on a point) you can move the whole curve up or 
down.
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Envelope functions in the dialog

The functions are selectable in three ways (the same options in all cases): 

• From the Functions menu. 
• By clicking the icons above the display.
• By right-clicking in the display.

The following options are available in the dialog:

Option Description

Deselect all points This will deselect all selected points.

Delete selected points Deletes all selected points.

Reset selected points Resets all selected points to 0dB.

Reset whole envelope This removes all added points.

Flip Vertical This will flip the current envelope vertically (in the level axis).

Flip Horizontal This will flip the current envelope horizontally (in the time axis).

Smooth envelope This allows you to create spline curves, for smoother level changes.
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Fade-in and fade-out
A fade-in is a gradual increase in level and a fade-out is of course the op-
posite. There are two ways of applying fades in WaveLab: by using the 
Easy Fade function or by using the Fade dialog.

Easy Fades

The Easy Fade function allows you to very quickly apply a fade-in or fade-
out to an audio file, without having to make any settings:

1. To create a fade-in, make a selection from the start of the audio file to 
where you want the fade-in to end.
Similarly, to create a fade-out, you should make a selection from the position where you 
want the fade to start, to the end of the audio file.

2. Select “Easy Fade” from the Process menu, or press [Ctrl]-[D].
A fade is applied to the selection. The shape of the fade is governed by the Default fade/
crossfade setting in the Preferences–Wave edit tab.

Using the Fade dialog

The Fade dialog allows you to specify the desired shape of the fade, and 
to create fade-ins or fade-outs anywhere in a file:

1. Make a selection that spans from where you want the fade to start to 
where you want it to end.

2. Select fade-in/out from the Process menu to open the Fade dialog.

3. Use the Type options to select a fade-in or a fade-out.

4. Set the Offset and Damping parameters.
A graph in the waveform indicates the resulting shape. The Damping value indicates how 
much the wave will be attenuated at the Offset point. A 6dB Damping with a 50% Offset 
normally gives the most natural results. See “Crossfade” below for more details.
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Crossfade
A crossfade is a gradual fade between two sounds, where one is faded in 
and the other faded out. This function allows you to do just that. It also lets 
you create plain mixes of two sounds.

Performing a regular crossfade

The material you want to crossfade can either be in two different sections 
of the same file, or it can be in two different files.

Since the crossfade is a type of paste operation, you must start by getting 
the section into which you want to fade (the later part of the fade) onto the 
clipboard.

1. Select the section into which you want to fade.

2. Select Copy, from the Edit menu.

Now it’s time to move over to the section from which you want to fade, 
which might very well be in another Wave window:

3. Select the section from which you want to fade-out.

This selection cannot be longer than the selection you just copied, or the 
program will not be able to perform the crossfade!

The length of this selection will determine the length of the actual cross-
fade (check the length on the status bar). In a typical case, this selection 
will be at the end of the wave. See below for details.

4. Select Crossfade from the Process menu.
The dialog appears and crossfade slope indicators are shown in the current selection.

5. Make sure that “Mix without fading” is not activated in either section.
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6. Adjust the Offset and Damping parameters as desired.
The shape of the two curves is indicated in the selection. See below for details.

7. Click the Paste button.

Please note that if both waves already have full level sections in the cross-
fade area (for example if you have normalized both waves), clipping (and 
hence distortion) might occur! If this happens, reduce the amplitude of both 
waves by 3 to 6 dB and try again.
Also note however, that if one of the “Inverse of Fade In/Out” boxes is 
checked, clipping can never occur.

How the fade is done

• As described above, the length of the fade is determined by the size of the selec-
tion in the file into which you paste.

• The pasted material has to be longer than the selection you paste “into” (or there 
won’t be enough material to finish the fade).

• Any “excess” material in the copied selection will appear after the fade (at “full 
level”). The wave is lengthened as needed.

• Any material that originally appeared after the selection in the file into which you 
paste, will be moved so that it now appears after the newly pasted material.

About the curves

The design of the fade and crossfade curves is based on psycho-acous-
tic research material, in order to give as pleasant and harmonic a result as 
possible.

For each of the two sections – the fade-out and the fade-in – you can se-
lect an Offset and a Damping value. When you adjust these values, the 
curves in the wave are adjusted accordingly so that you can see what kind 
of crossfade you will get.

The Offset factor determines where in the fade section the file will play at 
its “mid level” (normally half the level, see below).
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The Damping parameters adjust the “steepness” of the fade. For example, 
a -6dB setting for the fade-in will result in a normal fade, where the level is 
half the original when it reaches the Offset point. Values closer to 0dB will 
emphasize the beginning of the fade-in wave. Values closer to -18dB will 
make the fade-in sound drop drastically at the beginning of the fade.

Here, the default -6dB Damping curves with 50% Offsets are selected. This gives you a 
normal crossfade with the focus on the middle of the fade.

In this example, the Offsets have been moved so that the focus of the fade is more to the 
left. This means the fade-out is faster than the fade-in. However, both Damping factors 
are still set to the standard -6dB.

Mix without fading

If you activate “Mix without fading” for either section, it will play at full level 
throughout the entire fade.

An example

Let’s say you have two environmental sound effects you want to fade be-
tween, “city” and “restaurant”. You want to fade from “city” to “restau-
rant”. The two sounds are in different windows.

1. Select the entire “restaurant” wave and copy it.

2. Make a selection in the “city” wave, from a point close to the end.
The length of this selection is equal to the length of the fade.

3. Open the crossfade dialog, set both Offsets to 50%, both Damping set-
tings to -6dB, deactivate both “Mix without fading” options and click the 
Paste button.
The “city” wave is now lengthened, so that it starts as it originally did, then fades over to the 
beginning of the “restaurant” wave and ends like the “restaurant” wave.
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Invert Phase
This turns the signal “upside down”, which is the same as inverting the 
phase by 180°. No settings are needed for the operation.

There is no audible change when you invert the phase of a mono signal. 
However, if one channel in a stereo pair is out of phase with the other, this 
will lead to artifacts such as a drop in the bass register and a “blurred” 
stereo image.

The most common use for this function is therefore to fix a stereo record-
ing where one of the channels has accidentally been recorded out of 
phase with the other.

Reverse
This function reverses the selection, as if playing a tape backwards. No 
settings are needed.

Eliminate DC Offset
This function removes a problem that most often appears due to mis-
matches between various types of recording equipment.

This function should be applied to whole files, since the problem is normally 
present throughout the entire recording.

A DC offset is when there is too large a DC (direct current) component in 
the signal. If the DC offset is really bad, it can be visible as the signal not 
being visually centered around the “zero level axis”. However, the DC off-
set can be significant without actually being seen.

A wave with a serious DC offset

A DC offset is problematic for two reasons:
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• It affects where the zero crossings appear, which in turn affects the smoothness 
of splices between audio files.

• Certain processing options do not give optimal results when performed on files 
with a DC offset.

Checking for and eliminating DC Offset

1. Select the wave you want to check and fix.

2. Select “Eliminate DC Offset” from the Process menu.
A dialog appears stating the amount of DC offset.

3. Click OK or Cancel.

Waveform Restorer
This lets you remove intermittent clicks and pops in an audio file. First 
make a selection encompassing the artefact you want to remove, then ap-
ply one of the available methods. Usually, you will have to use a high zoom 
factor to be able to locate and select the undesired element.

The Waveform Restorer lets you select one of several available restora-
tion methods. The selected method is described in the dialog.

• Note that if you want a more direct control of the process, you can instead 
use the Audio error detection and correction dialog for a more “hands on” 
way of restoring audio files. See “Audio error detection and correction” on 
page 631.

Time Stretch
Time stretch is an operation that allows you to change the length of a re-
cording without affecting its pitch. Actually the standard term “time stretch” 
is a bit misleading since you can of course also make the material shorter.

This function is most often used to make a section of audio fit in with some 
other material. Therefore this dialog is set up exactly for that. You select the 
material to be stretched and use the options in the dialog to find a stretch 
factor (the “Percentage”). This is done by specifying the desired length, or 
the desired tempo, all according to what the situation requires.
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Opening the dialog

When you open the dialog, the following information about the selection 
is displayed:

Specifying a percentage directly 

If you know by how many percent you want to change the length, you can 
enter this value in the “Percentage” field.

Calculating the percentage by specifying a new length

• If you know the desired length in samples, adjust the Samples value in the 
“Desired result” section.

• If you know the desired length in minutes, seconds and milliseconds, ad-
just the corresponding value in the “Desired result” section.
Regardless of which you choose, the other values and the Ratio are updated accordingly.

The original length in 
seconds.

The original length 
in samples.

The calculated original 
tempo according to the set 
length and time signature.
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Calculating the ratio by specifying a time code range

If you want to fit the selection to a certain range, for example in a video or 
film sequence, you can specify the start and end of this range as time 
code values:

The other values and the Percentage are updated accordingly.

Calculating the Percentage by specifying a new tempo

If you know you want the selection to play back in a certain tempo, after 
the stretch, proceed as follows:

1. If you know the current tempo of the selection, type it in the Tempo field in 
the Source part of the dialog.

2. If you don’t know the exact current tempo, but the length of the selection 
and the time signature, you can specify these instead, in the Bars and sig-
nature fields, and the Source tempo will be calculated for you.

Please note for these operations to work properly, the exact specified 
source tempo or length must be selected. Any deviation from the real 
values will be transferred to the stretched audio.

3. Type in the desired tempo in the Tempo field in the “Desired result” section.

Reset

The Reset button resets the Percentage to “100%”.

Enter the desired 
end position here.

Enter the start 
position here.
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Additional settings

Limitations

Time stretch is a very complicated Digital Signal Processing (DSP) oper-
ation. It requires complicated mathematical operations and always affects 
the sound quality to some extent:

• For speech, stretch factors within a ±30% limit will normally provide very good re-
sults.

• For composite music, try to limit the range to ±10%.
• For sensitive material, like solo piano, try not to exceed ±3%.

• Note that if the DIRAC algorithm is used (see below), the above range rec-
ommendations can be extended and still produce very good results.

Setting Description

Quality There are three Quality settings, “Quick Process”, “Standard” and “High 
Quality”. The High Quality mode provides very high quality pitch correc-
tion, but the process will take longer. For most uses, the Standard mode 
is probably sufficient.

Use DIRAC 
processor

This is described separately below.

Preserve pitch When this option is activated, the pitch of the audio material will not be 
affected when you apply Time stretch. This is the normal mode of oper-
ation. If you turn this off, the pitch will change proportionally with the 
Time stretch ratio, much like when speeding up or slowing down a tape 
recorder.

Audio quantize When this option is activated, the length of the resulting file will be exactly 
the one displayed in the “Desired result” section of the dialog. When it is 
deactivated, the actual file length may differ by a few milliseconds.
If you don’t need this accuracy, you should leave the option deactivated, 
for a slightly better audio quality.

Rhythm accuracy This is only available if “Standard” or “High Quality” mode is selected. 
Set this parameter according to whether the rhythmic feel of the audio 
material has a high priority or not. If you set this to a high value, the tim-
ing and rhythmic feel will be preserved as far as possible, which is im-
portant for drum tracks, etc. If you set it to a low value, the audio quality 
can be slightly better, but sections of audio might be moved slightly (in 
the milliseconds region) in the process. 
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About the DIRAC processor

The DIRAC (DIRAC Time Stretch/Pitch Shift technology, ©2005 
Stephan M. Bernsee) engine is a very high quality time stretcher, perhaps 
the best available on the market today. It will produce the best quality re-
sults possible, but the trade-off is longer processing times. In WaveLab, 
you can use the DIRAC algorithm to process mono or stereo files with up 
to 96kHz sample rates.

• If you check the “Use DIRAC processor” box there will be an extra quality mode 
available (“Best (very slow)”) and 6 processing options available on the pop-up 
menu. 

• The selected quality mode affects the processing speed to large extent. Be pre-
pared for very long processing times if the “Best (very slow)” option is used.

About the DIRAC processing options:

Option Description

Auto / Preview This automatically selects the best time/frequency trade-off for real-
time/preview performance. This is the fastest setting but might not 
provide optimal results in all cases.

Time localization ++ 
(instruments, voices)

Selects full time localization. This is a good setting for single instru-
ments and solo voices.

Time localization + Time/frequency localization with the emphasis on time localization. If 
the previous mode produces echo artefacts, try this option.

Average Time/
Frequency localization

This sets the time/frequency localization halfway between the time 
and frequency domains. It is the best setting for all general purpose 
signals.

Frequency
localization +

Time/frequency localization with the emphasis on frequency localiza-
tion. Good setting for classical music.

Frequency localization 
++ (complex mixes)

Highest possible frequency localization. This setting might not work 
well on material with many sharp attack transients, but it can produce 
good results with less transient/percussive material.
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Pitch Correction
Pitch Correction is a function which allows you to detect, and to change, 
the pitch of a sound, with or without affecting its length.

Amount of shift

This allows you to specify the amount of pitch change in semitones and/or 
cents.

Pitch detection

WaveLab can analyze an audio selection and detect the pitch of the audio. 
Click the “Find current pitch of audio selection” button to perform the de-
tection. The found pitch is displayed below the button.

You also have the option to automatically compute the required pitch 
shift, based on the currently detected pitch and the pitch specified in the 
value field below the “According to the current pitch, etc.” button. When 
the button is clicked the “Amount of Shift” parameters are automatically 
adjusted to the computed pitch shift.



WAVELAB
9 – 202 Off-line processing

Length compensation

This allows you to set how the length of the selection should be affected 
by the operation.

• A setting of 100 means that the length will be the same after the operation.
• A setting of 0 means that the program will behave like a tape recorder does when 

the speed of its tape is varied. For example, if you raise the pitch by one octave, 
the sound will become half as long.

• Intermediate values will give results in between these two extremes. 
• For large transposition values, the lower this setting is, the better the quality of the 

effect will be.

Additional settings

Setting Description

Quality There are three Quality settings, “Quick Process”, “Standard” and 
“High Quality”. The High Quality mode provides very high quality 
pitch correction, but the process will take longer. For most uses, the 
Standard mode is probably sufficient. If the DIRAC processor is used 
you will get an additional setting; “Best”.

Audio Quantize When this option is activated, the processed file will have the exact 
same sample length as the original. When it is deactivated, the result-
ing file length may differ by a few milliseconds.
If you don’t need this length accuracy, you should leave the option 
deactivated, for a slightly better audio quality.

Preserve Formants When this option is activated, changing the pitch of vocal material 
will give a more realistic result. When you are processing non-vocal 
material, you should leave this option deactivated, since it uses a 
slightly slower processing algorithm.
Warning: this algorithm might increase the signal level. If your audio 
material has a high level, you may need to lower its level before pitch 
shifting.
In fact, the best solution is to use this effect from the Batch Proces-
sor, followed by a normalizer.

Rhythm Accuracy This is only available if “Standard” or “High Quality” mode is selected. 
Set this parameter according to whether the rhythmic feel of the au-
dio material has a high priority or not. If you set this to a high value, 
the timing and rhythmic feel will be preserved as far as possible, 
which is important for drum tracks, etc. If you set it to a low value, the 
audio quality can be slightly better, but sections of audio might be 
moved slightly (in the milliseconds region) in the process.

Use DIRAC processor This is described below.
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About the DIRAC processor

The DIRAC engine (DIRAC Time Stretch/Pitch Shift technology, ©2005 
Stephan M. Bernsee) is a very high quality pitch shifter, perhaps the best 
available on the market today. It will produce the best quality results pos-
sible, but the trade off is longer processing times. In WaveLab, you can 
use the DIRAC algorithm to process files with up to 96kHz sample rates, 
but not over.

• If you check the “Use DIRAC processor” box there will be an extra quality mode 
available (“Best (very slow)”) and 6 processing options available on the pop-up 
menu. 

• The selected quality mode affects the processing speed to large extent. Be pre-
pared for very long processing times if the “Best (very slow)” option is used.

About the DIRAC processing options:

Option Description

Auto / Preview This automatically selects the best time/frequency trade off for real-
time/preview performance. This is the fastest setting but might not 
provide optimal results in all cases.

Time localization ++ 
(instruments, voices)

Selects full time localization. This is a good setting for single instru-
ments and solo voices.

Time localization + Time/frequency localization with the emphasis on time localization. If 
the previous mode produces echo artefacts, try this option.

Average Time/
Frequency localization

This sets the time/frequency localization halfway between the time 
and frequency domains. It is the best setting for all general purpose 
signals.

Frequency 
localization +

Time/frequency localization with the emphasis on frequency localiza-
tion. Good setting for classical music.

Frequency localization 
++ (complex mixes)

Highest possible frequency localization. This setting might not work 
well on material with many sharp attack transients, but it can produce 
good results with less transient/percussive material.
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Pitch Quantize

The purpose of this process is to automatically detect and correct the 
pitch (intonation) of an audio file. The input signal is quantized to discrete 
notes. 

Pitch quantize works best on recordings that have a single fundamental 
frequency, such as voice or single instruments. The dialog has the follow-
ing parameters:

• Reference frequency: defines the reference tuning (in Hz) for the pitch 
correction. Default is 440 Hz.

• Tolerance: defines the tolerance for the pitch correction (in cents). 
If the pitch of the input signal deviates more than the specified amount from the nearest 
semitone, it is shifted toward that frequency by the specified amount. For example, if a 
singer sings 25 cent flat and this value is set to 10, the correction will shift the note so it will 
be 15 cent flat after the correction.

• Slur time: defines the time it takes for the correction to reach the full cor-
rection amount. 
Typically, sung notes are slightly unstable at the beginning, because the attack phase of a 
sound has a higher amount of noise, and because singers gradually adjust their tuning after 
the onset of the note. The slur time makes the pitch correction sound more natural because 
it mimics this effect. Higher values will yield a slower adaptation time and will delay the cor-
rection to the corrected pitch. Longer slur times will also preserve vibrato better.



WAVELAB
Off-line processing 9 – 205

Pitch Bend

This function utilizes a high quality pitch shifting engine that lets you cre-
ate stunning effects, by gradually changing the pitch of a sound accord-
ing to a set envelope curve.

Range

Specify the maximum range in semitones for the pitch change. When you 
change this value, the vertical ruler reflects the changes. You can right-
click or double-click in the dialog box to bring up a slider.

Envelope

In this window, you draw the curve that the pitch should follow.

• Create and erase points by double clicking.
• Select points by clicking on them.

By pressing [Ctrl] when clicking, you can select more than one point and 
later move them together. Selected points don’t have to be contiguous. 
You can also click anywhere in the window and drag the mouse over the 
envelope points to select them.

• You can drag any segment to move the whole envelope curve up and down.
• You can drag a single segment vertically by pressing [Ctrl] and moving the seg-

ment up and down.
• You can drag a single segment horizontally by pressing [Ctrl] + [Shift] and moving 

the segment left and right.
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Functions

You can access these functions either from the Functions menu, or by 
clicking the corresponding icon:

Option Description

Deselect all points Select this option to deselect points (selected points are red, un-
selected points are yellow).

Delete selected points All selected points will be deleted.

Reset selected points All selected points will be set to position “0” (no pitch change).

Reset whole envelope The envelope curve will be reset to its default shape (2 points and 
no pitch change).

Flip Vertical All envelope points will be moved to the opposite side of the hor-
izontal axis.

Flip Horizontal The envelope curve will be reversed (the start becomes the end, 
and vice versa).

Smooth envelope Activate this option if you wish to make the envelope curve 
smoother (no straight lines between points).

Undo Select this option if you want to undo the last envelope change.

Redo Select this option if you want to redo the last undone change.

Apply Click this button when you have set up the envelope curve and 
want to apply the effect on the audio selection.
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Harmonization

This is a variation of the Pitch Correction, which allows you to create not 
only one shifted voice, but up to sixteen! 

Setting up the voices

1. Set the scroll bar to the voice for which you want to make settings.
Which voice is currently shown is indicated just above the scroll bar.

2. Activate the voice by clicking the check box.

3. Set up the amount of pitch shift for this voice, by adjusting the Semitones 
and Cents values.
The maximum range is ±36 semitones (±3 octaves). The cents value adjusts the pitch 
within one semitone, that is, 50 means a quarter tone.

4. If you want one of the voices to play back the original wave (at the re-
corded pitch), activate one voice for this and set both its Semitones and 
Cents settings to 0.

5. If you are processing a stereo selection or if you have activated “Create 
stereo wave” (see below), you can adjust the stereo position of the voice 
by using the Pan control.
If you pull the slider all the way left or right, this voice will be played in that channel only.

6. Use the scroll bar to select the next voice and set this up like the first.
The text to the right of the Pan control tells you how many voices are activated.
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Additional controls

Please note that by specifying very small pitch shift amounts (a few cents 
only) and panning the detuned voices hard left and right, you can create 
stereo material out of mono recordings without a noticeable change in 
pitch. Please try to keep a balance in the detuning. If for example you set 
one voice to +5 cents, set another to -5 cents.

Hi-fi Chorus

This chorus works slightly differently from many others. Often chorusing is 
achieved by delaying a copy of the signal, continuously varying the 
amount of delay and mixing the delayed signal back in with the original.

While this is adequate for many purposes, WaveLab takes a more natural 
approach to creating chorus. Since a chorus effect is about making a re-
cording sound as if it was performed by many “identical musicians”, 
WaveLab takes just that approach. It multiplies the recording up to 100 
times and detunes and delays each “voice” slightly and – if so desired – 
pans the voices across the stereo image.

To find out exactly what each control does, click the question mark icon in 
the dialog.

Control Description

Preserve level When this is activated, the resulting audio will have the same level as the 
original, even though a number of voices have been added.

Create stereo 
wave

If you are operating from a mono selection you can still create a stereo wave 
by activating this option. The processed wave will then open in a new window. 
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EQ

This is a three-band equalizer with high and low shelving filters and a full 
parametric mid-frequency band. The following parameters are available 
on the Settings tab:

Parameter Description

High Shelf Gain Determines the boost or cut (in dB) of the high shelving filter.

High Shelf
Frequency

Sets the frequency of the high shelving filter. Frequencies above this 
value will gradually be increased or reduced in level, according to the 
High Gain setting.

Mid Shelf Gain Determines the boost or cut (in dB) of the Mid range EQ.

Mid Shelf 
Frequency

Sets the center frequency of the Mid range EQ. Frequencies around 
this value will be affected by the Mid Gain.

Mid Q Use this parameter to set the width of the Mid range, i.e. how wide a fre-
quency range around the Mid Frequency should be affected by the Mid 
range EQ. The higher this value, the “narrower” the Mid range.

Low Shelf Gain Determines the boost or cut (in dB) of the low shelving filter.

Low Shelf 
Frequency

Sets the frequency of the low shelving filter. Frequencies below this 
value will gradually be increased or reduced in level, according to the 
Low Gain setting.
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Presets tab

The Presets tab features a list of EQ presets, with self-explanatory names.

• To load a preset, select it in the list and click the “Load” button.

• If you have modified a preset which you wish to save, use the “Update” 
button.

• You can also save your own presets by typing in a name and clicking the 
“Add” button.

Convert sample rate
This function allows you to change the sample rate of a recording. This is 
very convenient if you have a file that you wish to use in a certain audio 
system and find that the file was recorded at a sample rate this system 
doesn’t support. Please note that Sample rate conversion can also be 
done as part of the Saving process (see “Saving in another format (Save 
as…)” on page 117).

Please note the following:

• Sample rate conversion from a low frequency upwards does not improve sound 
quality. The high frequencies that were lost due to a low recording frequency can-
not be restored by a conversion.

• When you sample rate convert down to a lower frequency, high frequency mate-
rial will be lost (this is part of the mathematics behind digital audio). Therefore, do 
not convert down and then up again, since this will lead to a degradation in sound 
quality (unless that’s exactly what you’re after). Instead, use the Undo and Redo 
functions.

Performing the sample rate conversion

1. Select Convert sample rate from the Process menu.
This opens the Sample Rate dialog.

2. Select the desired sample rate from the pop-up menu and click OK.
If you want to change any other audio properties (e.g. the bit resolution or stereo/mono sta-
tus), you can do this in one of two ways:
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• Open the Audio Properties dialog from the Edit menu and make the desired set-
tings (see “Editing audio properties” on page 127).

• Open the Audio File Format dialog by selecting “Save as” on the File menu and 
clicking the Properties button in the lower section of the dialog (see “Saving in 
another format (Save as…)” on page 117).

Sample rate conversion is always applied to the entire file. Any selection 
you have made is not used in any way for this operation.

Effect Morphing
Effect Morphing can gradually mix two audio ranges that have different ef-
fects/processing applied to them. This allows you to smoothly “morph” 
from one effect to another, or from an unprocessed audio segment to a 
processed audio segment. 

Basic operation

Effect Morphing always involves two audio ranges. Normally, this is in fact 
two versions of the same audio range, of which one is processed and the 
other unprocessed.

You set it up as follows:

1. Start by making a selection range over the time you wish the effect mor-
phing to take place.

2. Now process this range using any Master Section effect(s) (see “Render-
ing” on page 239), or use some other off-line processing.
You cannot use processing/effects that alter the length of the selection, e.g. time stretching.
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3. Open the Effect Morphing dialog from the Edit menu.
The dialog consists of a waveform display (that shows the current selection) with an envelope 
curve (currently a straight line) in the middle. By adding points to the envelope, you can create 
a curve that is used for the morphing process, see “Setting the Envelope” on page 214.

4. Make sure that “Unprocessed selection” is selected in the dialog.

The current processed selection can now be mixed with an unprocessed 
version of the same selection. This is done by utilizing WaveLab’s Undo 
memory.

• The last Undo memory is read by WaveLab and this is used as the “sec-
ond” audio range involved in the morphing process.

• The vertical ruler to the left shows as a percentage ratio between the two 
audio segments (processed/unprocessed), ranging from 0:100 (100% 
processed) to 100:0 (100% unprocessed). 

As an example, let’s say you would like to start with the selection 100% 
processed, and then gradually fade in the unprocessed range so that 
when the selection ends the audio will be 100% unprocessed.
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This can be done by positioning the two envelope points like in the picture 
below.

• If you now click “Apply”, the processing will create a perfectly linear tran-
sition between the processed and unprocessed audio.
It will start out 100% processed, gradually fading in the unprocessed audio (simultaneously 
fading out the processed audio at the same time) so that at the middle of the selection the 
ratio between the processed/unprocessed audio will be 50:50, and at the end it will be 
100% unprocessed!

This transition is determined by the curve, which in this case was a simple 
linear curve from maximum to minimum values. You can create more com-
plex curves by adding points which is described below. 

In fact, you can use Effect Morphing as “effect automation” across the 
range of a whole file if you like. By deciding where you wish the effect to 
be applied, you can draw a corresponding curve where you also have full 
control over the effect/dry balance and the fade-in and fade-out length!

Mix current selection with clipboard

Morphing can also take place between two differently processed audio 
segments. In this case you would proceed as follows: 

1. Process the selection. 

2. Use [Ctrl]+[C] to copy the result onto the clipboard. 

3. Undo the processing. 

4. Process the selection again, this time with a different effect. 

5. Open the Effect Morphing dialog and make sure that “Clipboard” is se-
lected in the “Mix current selection with” section.

6. Apply the desired morphing curve. 
Now the curve will enable you to morph between two different processing methods!
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• The clipboard could also be a copy from another wave file, but the clipboard 
size and the selection size must match.

Setting the Envelope

By adding points to the envelope curve you can create an envelope curve 
that governs how the two audio ranges are mixed over the time line.

1. Double click on the envelope curve to add a point.
A point will be added where you click. 

2. If you click on the point it will be selected (red color) and by click-drag-
ging you can move it in any direction.
The curve changes accordingly in the waveform display.

• When you point the mouse in the display (or move a point), the current 
position and level change is shown continuously in the field above the dis-
play.

3. You can keep adding as many points as you like to the curve.
You cannot move a point past a another point in the horizontal direction.

4. You can select several points using [Shift] and move them together.
By clicking on the envelope curve itself (not on a point) you can move the whole curve up or 
down.

Envelope functions in the dialog

The functions are selectable in three ways (the same options in all cases): 

• From the Functions menu. 
• By clicking the icons above the display.
• By right-clicking in the display.

The following options are available in the dialog:

Option Description

Deselect all points This will deselect all selected points.

Delete selected points Deletes all selected points.

Reset selected points Resets all selected points.

Reset whole envelope This removes all added points.

Flip vertical This will flip the current envelope vertically (in the level axis).

Flip horizontal This will flip the current envelope horizontally (in the time axis).

Smooth envelope This allows you to create spline curves, for smoother transitions.
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Support for reNOVAtor™
If this audio restoration plugin is installed on your system, you can select it 
from the Tools menu.

This menu option is enabled if a wave window is open and an audio selec-
tion is active (it can be both channels or a single channel). 

Selecting “reNOVAtor…” from the menu opens this plug-in and the active 
audio range is edited. The plug-in window is non-modal, hence you can 
work in WaveLab without closing the plug-in.

Go to http://www.algorithmix.com/en/renovator.htm for more info.
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Master Section
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Introduction
The Master Section is the heart of WaveLab’s “Real-time Engine” and the 
final block in the signal path, before the audio is sent to the audio hard-
ware (or to an audio file on disk). This is where you adjust master levels, 
add effect processors and dither. 

The settings and processors in the Master Section are taken into account 
in the following cases:

• When playing back an audio file in a Wave window.

• When playing back an Audio Montage.
Note that the Master Section effects are global for all clips and tracks in a Montage, as op-
posed to the individual clip or track effects.

• When using the Render function with any of the above.
The Render function writes the outputs of the Master Section to a file on disk, allowing you 
to apply Master Section processing to a Wave or mix down a Montage to an audio file. In 
case of a multichannel Montage, several files can be created, one for each channel in the 
selected configuration. See “Rendering” on page 239.

• When using the Audio Input plug-in.
See “Audio Input” on page 251.

About the Master Section in multichannel mode

If you are working in a Montage in multichannel mode, the Master Section 
looks and works slightly differently. See “Multichannel configurations in 
the Master Section” on page 524. However, the basic procedures are the 
same as described on the following pages.

About the “Use Master Section” option

If you don’t need the Master Section at all, you can turn it off completely 
by deactivating the Use Master Section setting on the Options menu. This 
will save processor power, but makes the following sections of the pro-
gram unavailable:

• The Master Section window, including processors and dithering.
• The Audio input and External Gear plug-ins.
• Several functions of the Monitor window.
• The Batch Processor.
• Audio CD Burning from the Audio Montage.
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The Master Section window
To open the Master Section window, you can either select it from the 
Specialized Windows submenu on the View menu, click the Master Sec-
tion button on the Window controller bar or press [Ctrl]-[F9].

• When you open the Master Section, active effect processor panels will also 
appear (if they haven’t been hidden).

To close the Master Section, select it from the menu again (or click the 
Master Section button again).

The Effects pane allows you 
to add and manage effect 
processors. See “The Effects 
pane” on page 225.

The Master Level pane. This 
is where you adjust the final 
output level. See “The Master 
level pane” on page 222.

The Dithering pane lets you 
add dithering when mixing 
down to a lower bit resolu-
tion. See “The Dithering 
pane” on page 231.

Indicates that the level 
faders are active (any set-
ting other than 0.00), or 
that the Mono button is 
activated.

There are eight slots for in-
serting effect processors. 
Effects can be turned on or 
off with the On buttons, and 
reordered by dragging the 
slots.

Options for the internal dith-
ering algorithm.

Level faders.

Indicates that an effect is 
activated.

Here you can insert a post-
master fader effect, such as 
Apogee UV22HR or other 
dithering plug-ins, replacing 
the internal dithering.

Click this to render the 
output to a file.

Activate this for mono output.

Indicates that dithering is on.
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Showing and hiding panes

You can independently hide the three Master Section panes in any com-
bination:

• Clicking on the Hide button for a pane will “fold” it, leaving only the pane title bar 
visible.
This is useful for saving screen space, if you e.g. don’t need to see the Dithering settings. 
Note that the red indicator for the pane will still be visible when the pane is hidden, allowing 
you to see at a glance whether effects, master volume or dithering are used or not.

• To show a hidden pane, click its Hide button again.
• Right-clicking (or [Ctrl]-clicking) a Hide button will hide the other two panes and 

bring the clicked pane to view (if hidden).
• Double clicking a Hide button will hide or show that pane and the pane(s) below it.
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About the signal path
The three panes in the Master Section window correspond to the Master 
Section’s three “processing blocks”: Effects, Master Level and Dithering. 
The signal passes through these blocks from top to bottom, as shown in 
this figure:

Audio from WaveLab

Slot 1
Slot 2
Slot 3

Slot 8

Master Level

Dithering 
(or post-master effect)

Effects

Audio Hardware 
(or file on disk)

Note that the signal passes through the effects in 
series (from top to bottom) – reordering the effect 
slots affects the signal path.

Master Section meters monitor the signal here.

Meters in the Meter windows monitor the signal here 
(in “Monitor Playback” mode, see “Selecting what to 
monitor” on page 156).
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The Master level pane

The Faders

The faders in the Master level pane govern the final output level. Use 
these in conjunction with the level meters (those next to the fader, or even 
better, the meters in the Level/Pan Meter window) and the clip indicators 
to optimize the level of the signal sent to the audio hardware.

It’s particularly important to avoid clipping (signal levels exceeding the 
available headroom), especially when mastering. Clipping is indicated by 
the Master Section’s clip indicators (see below) and by the number of clip 
indicators in the Level/Pan meter.

To adjust the level, use the following methods:

• To make coarse adjustments, click a fader handle and drag it.
You can also click directly anywhere along the fader scale to move the fader handle there 
immediately.

• For fine adjustments, click on the upper or lower half of the fader handle.
This raises or lowers the level by a small amount.

• To reset a fader to 0.00 dB, press [Ctrl] and click anywhere on the fader.
When both faders are set to 0.00 (and the Mono button isn’t activated), the Master level 
section will not affect the signal at all. This is indicated by the red indicator for the Master 
pane going dark.

• You can control the faders using a wheel mouse.
This has to be activated in the Preferences–Environment tab.

The fader settings are shown numerically below each fader.
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About the Unlink mode

The Unlink button determines whether the faders should be individually 
adjustable (indicated by a lit Unlink button) or “ganged”. Normally, you will 
probably want Unlink deactivated, so that moving one fader also moves 
the other by the same amount. Turning on Unlink allows you to correct im-
proper stereo balancing by adjusting the channels’ levels individually. 
Note:

• If you offset the faders (with Unlink turned on) and then deactivate Unlink 
again, you can adjust the overall level without changing the level offset be-
tween the channels.
In other words, moving one fader will move the other one by the same amount, relative to its 
current setting. Note that the faders use an exponential scale – this means that when you 
move one fader, the other does not follow in a linear fashion on the screen. However, the 
audio result is what you expect.

• Fader offsets are not preserved at the end of the range of movement.

The Meters

The Master Section meters show the signal level of the signal before dith-
ering (or any other plug-in you have applied post-master fader – see 
“Adding other plug-ins to the Dithering pane” on page 235). Use these to 
get an overview of the signal levels.

• The numeric fields above the faders show the peak levels (the highest signal levels 
reached) for each channel.
They will hold these values until you click on them to reset them.

• The red “LEDs” above the meters are clip indicators, which will light up whenever 
the signal clips (exceeds the maximum available headroom). 
If this happens, you should lower the faders, reset the clip indicators by clicking on one of 
them, and play back the section again until no clipping occurs.

For critical level metering, we recommend using the level/pan meter (see 
“The meters” on page 159). Not only is this more detailed, it’s also applied 
after the whole Master Section (after dithering) and will thus show the ac-
tual signal level sent to the audio hardware.
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The Mono button

If you activate the Mono button, the two channels will be summed to 
mono. Furthermore, the output level is automatically reduced by -6dB, to 
avoid clipping. The Mono button is useful for checking mono compatibility 
of stereo mixes, etc.

• If the Mono button is activated, the red indicator for the Master level pane 
will be lit, even if the master level isn’t adjusted.
This helps you avoid accidentally leaving the Mono button activated.

The Dropout indicator

This indicator lights up whenever WaveLab fails to properly play back as 
little as a single sample of the currently selected wave. A dropout is most 
likely to occur when your computer does not have the processing power 
to adequately handle all effect processors you have inserted.

To avoid dropouts, try the following:

• Use fewer effects.
You might be running out of processing power.

• Consider “Rendering” the processing rather than running it in real time. 
Then master from the processed file without any processors plugged in. 
See “Rendering” on page 239.
Dropouts never occur when “Rendering” to a file.

• Do not process any files in the background while mastering digitally to a 
DAT for example. See “Working with multiple files” on page 243.

• If neither of the above helps, please check the audio card preference set-
tings, you might need to adjust the audio buffer settings.

If a dropout occurs during a real-time mastering process (and if your mas-
ter needs to be flawless) we recommend that you re-master. Stop play-
back, click on the dropout indicator to reset it, and try again.

• As mentioned above, this indicator lights up as soon as even a single sam-
ple is not played back correctly. This type of precision is not often required, 
but it’s there if you need it.
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The Effects pane

WaveLab allows you to insert up to eight effect plug-ins in series (plus an 
additional, post-master fader plug-in, normally used for dithering, see 
“The Dithering pane” on page 231). Three plug-in formats are supported 
in the Master Section:

• WaveLab-specific plug-ins, included with the program. This also includes a sub-
menu; “ASIO”, which by default contains the Audio Input (see “Audio Input” on 
page 251) and External Gear (see “Using External effects” on page 252) plug-
ins. These are only available if you are using an ASIO driver.

• VST plug-ins.
Steinberg’s VST plug-in format is supported by a lot of programs and plug-in manufacturers. 
You will find a number of VST plug-ins included with WaveLab; other plug-ins can be pur-
chased separately from Steinberg or other manufacturers or in some cases downloaded 
from the Internet. 
Note also that if you have Cubase installed on your computer, the effects that were included 
with Cubase can optionally also be available in WaveLab (provided that they are installed in 
the “Shared VST Plug-ins” folder, see the Cubase documentation for details). Whether the 
effects in the “Shared VST Plug-ins” folder should be available in WaveLab or not is set in 
the Preferences–VST tab. You can also specify an extra VST plug-ins folder in the Prefer-
ences if you wish, meaning that you can have access to both the effects in the “Shared VST 
Plug-ins” folder and the effects in some other folder containing VST plug-ins.

• Plug-ins that adhere to the Microsoft DirectX standard.
These are known as DirectX or DX plug-ins and are also widely available.
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Selecting effects and managing slots

To select an effect plug-in for a slot, click on the slot (or the numbered 
button to the right of the slot) and select an effect from the pop-up menu 
that appears. Note that effects can be organized in groups (see “Organiz-
ing plug-in processors” on page 753), in which case they will appear in 
hierarchical submenus.

Selecting an effect from the VST group.

The number of effects available on the menu depends on which plug-ins 
you have installed. It’s also possible to globally deactivate or exclude ef-
fects you don’t need, as described in the section “Activating and deactivat-
ing plug-ins and groups” on page 754.

When you have selected an effect, it is automatically activated (the On 
button lights up), and its control panel appears as a separate window 
(see “Making settings – The Effect control panels” on page 227 for more 
on effect control panels).

• You can turn off an effect (without removing it) by clicking its On button.
To activate the effect again, click the On button so that it lights up.

• To hide the control panel for an effect, right-click its On button (or right-click the 
effect slot and select Hide from the pop-up menu that appears).
A hidden control panel can be shown by right-clicking the On button again (or by selecting 
Show from the same pop-up). You can also have one effect panel shown and automatically 
hide all the other panels, by right-clicking the Solo button for the slot.

• Clicking the Solo button for an effect will bypass all other effect slots, allowing 
you to check the sound of that effect only.
You can also bypass effects manually in their control panels – see below.
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• You can change the order of the slots (and thus the order in which the signal 
passes through the effects) by clicking a slot and dragging it to a new position.
When you drag, a dotted outline shows the position of the slot.

• To remove an effect from a slot, right-click the slot and select Remove from the 
pop-up menu that appears.
This is the same as selecting “None” from the effect selection pop-up menu.

Making settings – The Effect control panels

The control panel window is where you make settings for an effect. Plug-
ins can either have specialized control panels (with any combination of 
knobs, sliders, buttons and displays) or use standard panels.
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Bypass, Mute and Preset

As you can see in the figure above, the three buttons above the actual 
panel are common to both kinds of control panel windows. They have the 
following functionality:

• Clicking the Bypass button will temporarily bypass the effect.
Unlike turning off the On button for the slot, the bypass function does not free up any pro-
cessing power. Note that you can bypass all effects except one by using the Solo button for 
a slot. It’s also possible to bypass all effects by using the global bypass button in the Effects 
pane. Also note that bypassing effects is for playback only, and does not affect rendering. 
To deactivate an effect when rendering, use the On/Off buttons in the Master Section ef-
fect pane.

• The Mute button turns off the signal output from the effect.
This means that you will no longer hear your signal because it won’t even reach the next 
stage (either another slot or the master faders).

• The Preset button allows you to select and edit presets for the effect.
This is described in the section “Working with effect processor presets” on page 229.

Standard panels

A standard panel shows parameter names and values in the display to the 
left. To make settings, use the slider beside the corresponding parameter.

Custom panels

An effect plug-in can actually have any control panel that the plug-in de-
signer desires. There are several examples of custom panel plug-ins in-
cluded with WaveLab.

For information about the panels for additional plug-ins, see the docu-
mentation for each plug-in.
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Working with effect processor presets

With WaveLab comes a number of “factory presets” for the included pro-
cessors, which you can either select and use as is, or use as a starting 
point for your own settings. Additional plug-in processors may provide 
their own “factory presets”.

• To access the presets for an effect, click the Preset button in its control 
panel window.
The result and available functions depend on the type of plug-in:

WaveLab specific plug-ins

Applying and saving presets for WaveLab specific processors works ex-
actly as with any other preset, apart from the fact that there are no preset 
“tabs” or menu items as in dialogs. Instead, clicking the Preset button will 
open a separate Preset dialog. The options in this dialog are exactly the 
same as for dialogs with Preset tabs. See “Presets” on page 65 for more 
details.

VST-compatible plug-ins

VST plug-ins have their own preset handling. When you click the Preset 
button for this type of effect, a pop-up menu with the following options 
appears:

DirectX plug-ins

Here, the same functionality is provided as for WaveLab plug-ins. In addi-
tion, you can import “native” presets created for the plug-in.

Item Description

Load/Save Bank… This allows you to load and save complete sets of presets. The file format 
is compatible with Cubase.

Load/Save Default 
Bank

This allows you to load the default set of presets (as will appear when 
first loading the plug-in) or save the current set of presets as the default 
bank.

Load/Save Effect Lets you load or save one preset at a time. Also compatible with Cubase.

Edit name of current 
program…

This allows you to define a name for the preset, which might be displayed 
in the panel (depending on the plug-in).

Preset List This allows you to select one of the currently loaded presets.
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About the effect plug-ins supplied with WaveLab

Included with WaveLab is a large number of plug-ins for all kinds of pur-
poses, audio compression, chorus, stereo enhancement, reverb, etc. The 
parameters for each plug-in are described in the “Plug-in Processor Refer-
ence” in the online documentation.

Installing additional effect plug-ins

If you have purchased or downloaded additional plug-ins (VST or Di-
rectX), you need to install these to be able to use them in WaveLab. Nor-
mally, plug-ins come with an installer application of some kind, along with 
a manual or installation notes – make sure to follow the instructions in 
these when installing the plug-in.

About installing DirectX plug-ins

Normally if the DirectX plug-in has been installed properly, it will automat-
ically be “visible” in WaveLab. If it isn’t, you need to “update the Windows 
registry” so that it is. Proceed as follows:

1. In Windows, locate the actual plug-in file on your hard disk.
These are “dll” (dynamic link library) files, which means they normally have the extension 
“.dll”. Sometimes other extensions are used as well.

2. Drag and drop the file icon, either onto the WaveLab program icon, or 
somewhere in the WaveLab application window.
A dialog box will ask you whether you want to register the plug-in or not.

Organizing plug-ins

You can specify which plug-ins should be available in the program and 
how these should be organized on the menus. See “Organizing plug-in 
processors” on page 753.
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The Dithering pane

The Dithering pane allows you to add dithering to the signal before it’s sent 
to the audio hardware or to a file on disk. You can choose between Wave-
Lab’s internal dithering algorithm, Apogee’s renowned UV22HR algorithm 
or any external dithering plug-in of your choice. First, some theory:

What is dithering?

Dithering is a method for reducing quantization errors in digital record-
ings. In the case of WaveLab, dithering is applied when reducing the 
number of bits in a recording, for example when moving from 24 to 16 
bits, and when applying processing.

The theory behind this is that during low level passages, only a few bits 
are used to represent the signal, which leads to quantization errors and 
hence distortion. To the ear, this is perceived as “graininess” during low 
level passages in a recording.

When “truncating bits”, as a result of moving from for example 24- to 16-
bit resolution, such quantization noise is added to an otherwise immacu-
late recording.

By adding a special kind of noise at an extremely low level, the quantization 
errors are minimized. Indeed, the added noise can be perceived as a very 
low-level quiescent hiss added to the recording. However, this is hardly 
noticeable and much preferred to the distortion that otherwise occurs.

• The reason for the dithering block to be last in the Master Section is that 
the output level must not be changed after dithering a signal.
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When should I apply dithering?
The basic rule-of-thumb is that you should dither when moving to a lower 
bit resolution. One obvious instance of this is when converting an audio 
file to a lower resolution (e.g. preparing a 24-bit file for mastering to CD, 
which uses 16-bit format).

However, even if you’re playing back or rendering a 16-bit file to the same 
resolution, you need to dither if you’re using any real-time processing 
whatsoever in WaveLab! The reason for this is that WaveLab works with 
an internal resolution of 32-bit (floating point), for supreme audio quality. 
This means that as soon as you perform any kind of real-time processing, 
the audio data will be treated at this high resolution instead of the original 
16 bits, thus making dithering necessary.

Examples of real-time processing include level adjustments, any effects, 
mixing of two or more clips in a Montage, etc. In fact, the only time when 
a 16-bit file will be played back at 16-bit resolution is if you play it without 
any fades or effects, and with the Master Faders set to 0.00 (no level ad-
justment – Master level indicator turned off).

• To make sure whether you need to dither or not, use the Bit Meter to check 
the actual resolution of your audio signals.
The Bit Meter is described in the section “Bit Meter” on page 170.

Selecting a dithering algorithm
To select and activate a dithering algorithm, click on the arrow button next 
to the plug-in slot in the Dithering pane, and select one of the options from 
the pop-up menu that appears. The default options are “Intern” (Wave-
Lab’s internal dithering algorithm), “UV22” and “UV22HR” (dithering algo-
rithms developed by Apogee). However, you can also add other plug-ins 
to this list, see “Adding other plug-ins to the Dithering pane” on page 235

• When you select any of the “UV22” options, a special control panel appears. 
This is where you make the UV22 dithering settings (see “UV22HR Dither-
ing” on page 234).
This is handled in the same way as regular effect control panels – you can hide or show it by 
right-clicking on the slot, bypass it in the control panel, etc. The same is true if you select any 
plug-in other than the “Intern” option. For the internal dithering, the controls in the Dithering 
pane are used, as described below.

Once you have selected a dithering algorithm, dithering is active (as indi-
cated by the red indicator for the Dithering pane). It will apply to all play-
back (through the Master Section) or rendering.

• To turn off dithering completely, right click in the slot and select “Remove” 
from the pop-up menu that appears.
This is the same as selecting “None” from the effect selection pop-up menu.
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Making settings

When dithering, there are no hard and fast rules for how to set up the pa-
rameters – this largely depends on the type of material. We recommend 
that you experiment and let your ears be the final judge.

The available parameters are different for the internal algorithm and the 
UV22 algorithms:

Internal dithering

Internal dithering must be used when rendering multichannel Montages, 
see “Dithering and multichannel Montages” on page 526.

Parameter Description

Noise Type Determines the dithering method used:
In “Off” mode, no dithering is applied – use this as a Bypass function. 
The “Type 1” mode is the most “all-round” type of method.
The “Type 2” mode emphasizes higher frequencies more than Type 1.

Noise Shaping This parameter alters the character of the noise added when dithering. 
Again, there are no hard and fast rules, but you may notice that the higher 
the number you select here, the more the noise is moved out of the ear’s 
most sensitive range, the mid-range.

Output Bit 
Resolution

This is where you specify the intended bit resolution for the final audio, after 
dithering, regardless of whether you will “Render” the settings or play back 
in real-time.
It is very important to set this to the correct resolution!
Dithering will change the sample resolution, but not the sample size. E.g. 
when dithering 24-bit to 16-bit, the file will be still be 32-bit in size, al-
though only 16 bits of information will have significance. 
Hence, when rendering to a 16-bit file, specify the desired file resolution to 
avoid wasting space!
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UV22 Dithering

The UV22 is a dithering plug-in based on an algorithm developed by Apo-
gee. 

The UV22 is mainly included for backwards compatability, so that Wave-
Lab Master Section presets saved in earlier WaveLab versions can be 
loaded successsfully.

UV22HR Dithering

The UV22HR is an advanced version of Apogee's renowned UV22 dither-
ing algorithm, capable of dithering to 8, 16, 20 or 24 bits.

Option Description

Normal Try this first, it is the most “all-round” type.

Low This applies a lower level of dither noise.

Autoblack When this is activated, the dither noise is gated (muted) during silent pas-
sages in the material.

Option Description

Normal Try this first, it is the most “all-round” type.
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Adding other plug-ins to the Dithering pane

If you have purchased another dithering plug-in that you prefer, you can 
use this instead of the internal or UV22/UV22HR dithering. It’s also pos-
sible to insert some other type of plug-in in the Dithering pane – it will be 
applied after the Master level faders (possible useful plug-ins would be 
maximizers, limiters, etc.).

Please remember that the meters in the Master Section monitor the signal 
before the Dithering pane! To avoid clipping, check the Level/Pan Meter and 
adjust the output level setting of the plug-in, if available.

To make a plug-in available on the plug-in slot pop-up menu in the Dither-
ing pane, proceed as follows:

1. Pull down the Options menu and select “Organize Master Section plug-
ins…”.
A dialog appears, listing all plug-ins installed in your system. See “Organizing plug-in pro-
cessors” on page 753.

2. Locate the plug-in in the list.
Note that plug-ins can be placed in groups (folders) in the list – click the plus sign next to a 
folder to view the contents of a group if needed.

3. Activate the checkbox in the PM column for the plug-in.
PM stands for “Post Master fader”.

4. Click OK to close the dialog.

Now, the plug-in will appear on the pop-up menu in the Dithering pane, and 
can be inserted after the Master Level faders (as with the regular dithering 
types). You make settings for the plug-in like you would for effects in the Ef-
fects pane. Note also that the plug-in will still be available for selection as a 
regular, pre-master effect.

Low This applies a lower level of dither noise.

Autoblack When this is activated, the dither noise is gated (muted) during silent pas-
sages in the material.

Bit resolution You use the buttons 8, 16, 20 or 24 to select the intended bit resolution for 
the final audio. As when using the internal dithering, it is very
important to set this to the correct resolution!

Option Description
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Master Section presets

You can turn all settings currently made in the Master Section into a pre-
set. This includes which processors were used, what settings were made 
for each one of them, and dithering options.

Creating presets

To create a new preset, proceed as follows:

1. Set up the Master Section as you want it.
This includes selecting Processors, making settings, and setting dithering options.

2. Click the Presets button in the Effects pane.

3. Type in a name for the preset in the upper right corner.

4. If you want the dithering options and Master level settings to be part of 
the preset, make sure “Save Dither/Level settings” is activated.
This is the default.

5. Click Add.

• The presets are saved automatically when you quit the program. The next 
time you load the program, the presets are ready and waiting, just as you 
left them.
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Loading a preset

To load a preset, select it in the list to the left, and click on one of the Load 
buttons, depending on the desired load method:

• The Replace method replaces all settings in the Master Section with the setting in 
the preset.

• The Mask method replaces only those slots in the Master Section that are actually 
used in the preset.

• The Append method fills the unused slots in the Master Section with the settings 
in the preset.
If there are not enough free slots available to load the entire preset, a warning message will 
appear.

Modifying a preset

1. Set up the Master Section as desired.
If you only want to adjust a few settings in an existing preset, you may want to load this first, 
as described above.

2. Go back to the “Master Section Presets” window.

3. Select the preset you want to overwrite with the new settings.

4. Click the Update button.

• To update settings for the last loaded preset you can [Ctrl]-click the Pre-
sets button.
This will save any changes without having to open the dialog.

Deleting a preset

To delete a preset, select it in the list to the left and click the Delete button.

Using key sequences for presets

If you want to invoke a preset via a key command sequence, you can do 
this by defining key sequences.

A key sequence contains between one and three keys that must be 
pressed in a certain order to recall the preset.

Defining key sequences

1. Select the preset for which you want to create a key sequence, and click 
the key sequence button.

2. If you want to clear the current key sequence, click Clear.
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3. Make sure Catch mode is active.

4. Press the first combination of keys that you want to use.
You can include modifiers ([Shift], [Ctrl], [Alt], etc.) if you like. There is also a setting that 
makes the program distinguish between two modifiers with the same label, on each side of 
the space bar.

5. Proceed with the following key(s).

6. Disable Catch mode.
This is just a safety measure so that you don’t accidentally erase or add to your current key 
sequence, when pressing more keys.

7. Close the dialog.

8. Use the Default Key Action buttons to decide whether your key se-
quences will invoke the “Replace”, “Mask” or “Append” load method.
This setting is global to all Key sequences.

Using key sequences

Key sequences can only be invoked when the Master Section Presets di-
alog is closed. Press the keys in the order they were entered in the dialog, 
and the preset is loaded.

Saving and loading preset groups

You can save one or more created presets as a preset group for easy ac-
cess. If you have added presets to the Preset window and want to save 
them as a group, use the drop-down menu at the bottom of the dialog to 
enter a name for the group and save it.

When you have saved a set of presets as a group, you can delete the pre-
sets themselves, since they are saved in the group and can be recalled by 
selecting that group from the drop-down menu.

This function is useful if you are working on several projects, since it 
makes for a convenient way to keep specific Master Section presets for 
specific projects well organized and easily accessible.
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Rendering
While the Master Section can perform all processing in real time during 
playback, it’s also possible to save the audio output to a file on disk. This 
is done with the Render function.

There are several uses for Rendering:

• Mix down a complete Audio Montage to an audio file.
This can be a goal in itself, but can also be necessary if your Montage uses e.g. more ef-
fects than the system can handle in real time. By Rendering it to a file first, and creating a 
CD from this file instead, you can avoid dropouts and CD burning failure.

• Mix down a file in a Wave window to a new audio file, complete with Master Sec-
tion effects, dithering and other settings.
You can freely choose the format of the new audio file, allowing you to create an mp3 file 
and add effects at the same time, for example.

• “Apply” all settings in the Master Section to a file in a Wave window.
This is the same as the previous option, but the Master Section processing will transpar-
ently and permanently be “applied” to the current file instead.

Rendering Audio Montages is described in the Audio Montage chapter (see 
“Mixing down – The Render function” on page 527). This section describes 
Rendering waves.

What is rendered?

When you use Render, all Master Section settings (effects, master levels, 
dithering, etc.) are included in the resulting audio file. In other words, what 
you hear is what you get.

• One thing to note: the Bypass switch affects playback only, while the effect 
On switches affect both playback and Rendering.
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Calling up the Render dialog and filling out the options

Click the Render button to call up the following dialog:

The Render dialog for Wave windows (for information on Rendering Audio Montages, see 
“Mixing down – The Render function” on page 527).

Here is what the options mean:

Range

This is where you specify what part of the wave to render.

Option Description

Selection Process only the portion that is currently selected in the Main view.

Whole file Process the entire file.

Skip Mute 
Regions

When this is activated, regions between Mute markers (see “The vari-
ous marker types” on page 329) will not be included in the resulting file.

Regions In this mode, all regions of a certain type (either Track, Loop, or Generic 
– selectable from the pop-up), can be rendered separately. This is a 
powerful option allowing you to instantly create/process multiple files/
selections as defined by region markers. You could for example add a 
fade-in and fade-out to each region.
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Result

Here, you can choose whether the original wave file should be changed 
(“applying” the Master Section settings) or whether a new audio file 
should be generated.

Create named file

If this is activated, the resulting new file will be saved (not temporary). The 
field below the checkbox allows you to specify a name and location for the 
file, and you can click the audio properties button to set the desired audio 
format. Clicking the “Rename as source” button will set the file name to 
the same as the file being processed (but retaining any path you have 
specified above).

If “Regions” is selected as the Render Range, the field normally used for 
the file name is instead used to define the destination folder. Each region 
must have a unique name.

Option Description

Process in place Modifies the original file. If you wish to keep the changes, you need to save 
the file again. Note: if you use this for adding effects to a file, you may want 
to activate the “Activate Global Bypass” option on the Schedule tab (see 
below).

No tail If this is activated, the resulting file will end where the original did, even if 
the processing adds material (like for example echoes or reverb tails).

Copy markers If this is ticked, the resulting new file will contain all markers present in the 
original file.

Do crossfade at 
boundaries/Do 
fade-in/out at 
boundaries

“Do crossfade at boundaries” is useful when processing in place (selec-
tion or regions), because it allows smooth transitions between the pro-
cessed/non-processed parts. 
“Do fade-in/out at boundaries” is selectable when “Process in place” is 
not activated. In this case, the generated files get a short fade-in at the 
start, and a short fade-out at the end.
The crossfade time and shape is set in the “Default fade/crossfade” sec-
tion in the Preferences–Wave edit tab.
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You can of course create unique names for the Region markers manually, 
but it is much quicker to do it automatically. You can do this in two ways:

• Use the Batch Renaming tool. 
This allows you to define numerous options for renaming markers. See “Markers” on page 
311.

• Use Auto Split to generate regions with markers (although this would 
have to be done when the Marker regions are created).
Auto Split gives you the option of adding numbers to each created marker region name. 
See “The Auto Split dialog” on page 342. 

• If you click the audio properties button at the bottom of the dialog, you 
open the Audio File Format dialog in which you can choose the desired for-
mat of the file and make settings for the conversion and encoding. Click the 
question mark icon for details about the Audio File Format dialog.

Batch…

This button opens up the Batch Processor (see “Opening the Batch Pro-
cessor” on page 276).

This is only available if “Whole file” is selected and “No tail” is disabled.

Options on the Schedule tab

• The On Start options determine what WaveLab should do before rendering:

• The On Completion options determine what should happen after rendering:

Stop playback Stops playback to free up some processing power. This option is not 
available if playback is already stopped.

Open Monitor window Opens the Monitor window, see “The Monitor window” on page 247.

Minimize window The file window is minimized to free up screen space.

Beep WaveLab will beep to signal that the operation is completed.

Show 
message box

WaveLab will display a message to confirm the operation. Click OK to con-
tinue.

Restore 
audio window

Upon completion, WaveLab will restore a minimized window (see above) to 
its original size.

Activate 
Global Bypass

WaveLab will automatically activate the Bypass switch in the Master Section’s 
Effects pane (see “Bypass, Mute and Preset” on page 228) upon completion. 
This allows you to play the processed file back after rendering, without hearing 
the effects “twice” (applied to the file and activated in the Master Section).
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• The Priority setting lets you specify how fast the file should be processed.

Any dropouts that occur as a result of too little processing power left will 
only affect the played file. Files processed in the background will always be 
free of dropouts!

Processing the file

Once everything is set up correctly, click OK to initiate the processing. 
Or, if you change your mind, click Cancel.

• Tip: If you just need to process the current audio selection in place, you can 
press [Ctrl] while clicking on the Render button. This will process the audio 
selection in place without opening the dialog. 
Settings like Crossfade on/off are kept from the last time you accessed the dialog.

Working with multiple files

Once you have applied settings to one wave, as described below, you 
can continue with processing the next. The processing of the first wave 
will continue in the background. This way you can apply processing to as 
many waves as desired. Please also note that each wave can have its own 
priority setting, as described below.

If you are rendering to MP3 format, you should only render one file at a time.

Relax 
Background

The file is processed in the background, but priority is given to audio playback 
and to your continued work on other files. This makes WaveLab as responsive 
as possible, but slows down processing.

Background The file is processed in the background but with a lower priority given to your 
continued work on other files. This makes processing faster but the program 
less responsive. Try this mode when several files should be processed in the 
background.

Fast Processing is given a high priority. A fairly high-performance computer may be 
required to avoid dropouts in playback.
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Smart bypass

This function is available from the Tools menu. The main reason for Smart 
bypass that processing audio often changes the level or loudness of the 
signal. When comparing the processed signal with the original signal, 
your ears will be sensitive to this loudness change, which may in turn af-
fect your judgement. If you need to compare the sound of the effect inde-
pendently from the loudness change, a level correction is required.

Smart bypass allows you to compare the original (unprocessed) signal to 
the processed signal with a level correction applied to it. This function is 
particularly useful when you are making final level adjustments to a re-
cording, i.e. during mastering.

Smart bypass compares the signal at the input of the Master Section to the 
signal at the output of the Master Section, and adjusts the level accordingly.
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Basic operation

Smart bypass works as follows:

1. Open the “Smart bypass” dialog from the Tools menu.
When the dialog opens, it monitors the processed audio (the output of the Master Section) 
by default.

2. The three Play options allow you select what to monitor; the original (un-
processed) audio, the processed audio plus level correction or the pro-
cessed audio.

3. You can select between three modes of level correction: Match Peaks, 
Match loudness (RMS) or Custom correction.
These are explained in the table below.

4. Specify a time range to be analysed in the Time field.

5. Play back the audio and wait for the analysis to complete (i.e. the time 
specified in the previous step).

6. Click the “Update gains” button.
Depending on the selected correction method, the level correction that will be applied is 
shown below the corresponding button. 

7. Now you can switch between the three Play mode options to compare 
between the processed audio with level correction, the processed audio 
without level correction and the unprocessed signal.

8. If you should change the analysis time or start playback from another po-
sition you have to wait for the set time and then click the “Update gains” 
button again to update the analysis (i.e. repeat steps 5 and 6).
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Dialog items

The Smart Bypass dialog contains the following items:

Item Description

Play – Original audio This monitors the unprocessed signal at the Master Section input.

Play – Processed 
audio + level correction

This monitors the signal at the Master Section output plus the ap-
plied level correction. To listen to the corrected level requires that 
you have clicked the “Update gains” button first.

Play – 
Processed audio

This monitors the signal at the Master Section output without level 
correction.

Level correction – 
Match peaks

If this is selected, the output signal will be level-corrected so that 
the peak levels of the processed signal and the original signal 
match. 

Level correction – 
Match loudness

If this is selected the output signal will be level-corrected so that 
the loudness of the processed signal and the original signal match. 
This is the overall most useful mode, as it works similarly to how 
the ear perceives loudness.

Level correction – Time This determines the length of the level analysis.

Level correction – 
Update gains

This will update the current analysis. You have to play back the au-
dio for at least as long as the set “Time” before clicking this but-
ton. If you change the level correction parameters, you have to 
click “Update gains” again to refresh the analysis.

Level correction – 
Custom correction

This allows you to set a custom level compensation (no analysis).
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The Monitor window
This window allows you to monitor the ongoing processes, check how 
hard your computer’s CPU is working with various tasks, and more.

To open this window, select “Monitor” from the Specialized Windows 
submenu on the View menu or click the Monitor button on the Window 
controller bar.

The Monitor button

The window has three displays, selected by clicking the corresponding 
tab at the bottom of the window.

The Progress display

The Progress display shows a list with the following columns:

Column Description

Name The name of each wave or montage being processed.

Progress How much of the wave has been processed so far.

Remaining time This indicates how much time is required to finish the processing.

Priority Boost The priority assigned to this particular processing (see “The Priority set-
ting lets you specify how fast the file should be processed.” on page 
243 and below).
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Process menu

Even while a wave is being processed, you can change its settings. Posi-
tion the pointer in the monitor window and press the right mouse button.

The following options are available:

Option Description

Suspend/Resume Suspends processing of the wave. The menu option changes to Re-
sume so that you can activate processing again. When a process is 
suspended, more CPU power will be available to the other processes.

Suspend/Resume All Halts/starts processing of all waves.

Relax Background, 
Background, Fast

Changes the priority status for the wave, see “Relax Background” on 
page 243.

Cancel Cancels the processing operation for the selected wave, in which 
case the message in the Priority Boost column reads Cancelled until 
WaveLab has performed all the necessary clean up operations.
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The Performance display

The Performance display provides an overview of the processing power 
currently being used.

• The yellow lines refer to the power used for providing input to the Master Section, 
either reading waves from disk or Audio Input. Please note that the values are an 
approximation.

• The purple lines indicate the processing power that is required for all processors 
currently running in the Master Section. The shorter the line, the less the load on 
the CPU. This is a very precise measurement.

• The blue lines reflect the processing power required by the output device.
• There is also a number indicating processor usage in percent.

Customizing the Performance display

You can customize the way the processing information is displayed. If you 
want to see more of what is going on, resize the window. 
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Other options are available if you position the cursor anywhere in the 
black part of the window and press the right mouse button. The following 
options are available:

• You can activate/deactivate the Input, Process, and Output information 
(see above)

• To get an exact (but not as smooth) picture of the processor usage, deactivate 
Average.

• You can select a Zoom factor for the display (50%~400%).
• You can change the direction of the status information flow (horizontal or vertical).

The Timecode display

This has two uses (selected on the Options pop-up menu in the window): 

• To display incoming timecode when synchronizing WaveLab to external equipment. 
See “Synchronizing WaveLab to external devices” on page 649.

• To show the current position of the playback cursor in the active Wave or Montage 
window.
You can resize the window as desired, changing the size of the numerals.
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Audio Input
The Audio Input is a special Master Section plug-in that allows you to ren-
der a signal coming in to a sound card’s input(s) together with any Master 
Section effects. This signal can be anything your sound card accepts, for 
example a feed from a mixer, a tape recorder or a microphone. An ASIO 
driver is required to use Audio Input.

You set it up as follows:

The first step is to designate which ASIO inputs should be used. This is 
done in the Preferences–Audio device tab:

1. Click the “Connections…” button to open the ASIO Audio Connections 
dialog.

2. Select which inputs to record from in the “External gear connections” 
section and close the Preferences dialog.
Note that you only have to set the ASIO inputs – the External ASIO outputs are not relevant 
for Audio Input. 

3. Click in the top Master Section effect slot, and select “Audio Input” from 
the ASIO sub-menu.

• You can only use one instance of this plug-in, and it has be loaded into the 
top effect slot. Also, as long as the Audio Input plug-in is loaded, wave play-
back is not possible.

4. The Audio input control panel appears, allowing you to set the desired 
number of inputs and the sample rate. 

5. To monitor the Audio input, press Play on the transport.
Normal wave playback will not happen (the cursor will not move), but the Play button will be 
lit, and you can now monitor the input source. Pressing Stop will stop input monitoring.

• If you change the settings in the control panel, press Stop and restart 
playback to apply them.
Note that if you are using any non-multichannel plug-ins in the Master Section effect chain, 
these are limited to two channels! You will also have to activate the required number of inputs 
in the ASIO Connections dialog to match the number of inputs selected here. A warning mes-
sage will appear if any of the above criteria don’t match the selected number of inputs.
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6. Click the Render button.
A dialog appears allowing you to select a name, an audio format and a location for the file to 
be rendered.

7. When you click OK, recording (or rendering) starts, recording the external 
input from the output of the Master Section, including all real-time pro-
cessing.
You can monitor the recording as it happens.

8. Click Stop on the transport to stop the recording/rendering.

Using External effects

The External Gear Master Section plug-in allows you to process audio files 
using external hardware processors. One or more ASIO outputs are used 
to send the audio signal to your processor, and corresponding ASIO inputs 
are used to return the signal coming from the external processor.

• By default, this plug-in is located in the ASIO sub-menu of the Master 
Section effects.
An ASIO driver must be used.

• Only one instance of this plug-in is allowed in the Master Section plug-in 
chain. 
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To use the External gear plug-in, proceed as follows:

The first step is to designate which ASIO channels should be used. 

1. Open the Preferences–Audio device tab:

2. Click the “Connections…” button to open the ASIO Audio Connections 
dialog.

3. In the “External gear connections” section you can activate the output 
channels you wish to send to the external gear inputs in the “ASIO out-
puts (to gear)” section, and which input channels the effect processor 
outputs should be connected to in the “ASIO inputs (from gear)” section.
This should normally not be the same I/O channels as you use for playback/recording. The 
number of available outputs in this plug-in equals the number of inputs (up to 8). 

Close the Preferences dialog when you are done.

4. Click in a Master Section effect slot, and select “External Gear” from the 
ASIO sub-menu.
The External Gear control panel opens.

In the control panel you can set the following options:

• “Num.Outputs”
Here you can set the number of outputs to use. Normally this is the same as the number of 
inputs (the “As Inputs” option). You can however use a mono out/stereo in configuration in 
which case you set this parameter to “2” with the slider.

• “Latency”
External gear may introduce latency. WaveLab can automatically compensate for this if you 
select “Auto” (only active during rendering), or you can set this latency compensation your-
self (in milliseconds). The latency introduced by the ASIO driver is automatically taken into 
account by WaveLab.

• “Send level”
This allows you to adjust the send level. This should normally be set to 0 dB. If necessary, 
adjust the input level on the external effect.

5. Now you can process a signal through the external processor, just like if it 
was a standard plug-in effect!

6. If you render a file using the External plug-in, playback will not be available 
during the rendering.
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Introduction
The Spectrum editor is powerful audio restoration and processing tool 
set, using high quality linear-phase filters to process a spectrum selection 
both in the time and in the frequency domain.

There are two main operational modes:

• Surgical processing (offline processing).
This is intended for audio restoration purposes applied to short time ranges. See “Surgical 
processing” on page 262.

• Master Section processing.
This allows you to process a specific frequency range via the Master Section. See “Master 
Section processing” on page 269.

Both modes operate according to a spectrum region, which is set using 
the Spectrum selection tool. The region selection defines a time and a 
specific frequency range.

This allows you to edit and process audio both in the time domain and in 
a specific frequency domain, as opposed to standard wave editing which 
always operates in the full frequency domain. This introduces a whole 
new approach to wave editing! 

Spectrum editing can perform many different types of processing, mainly 
aimed at audio restoration, but could certainly also be used for artistic or 
special effects – the filters are very powerful.

Basics

Selecting Spectrum display mode

Spectrum editing can only be performed when Spectrum display mode is 
selected. 

• It should be noted that the Spectrum display isn’t really designed to be an 
alternative to the Wave display when it comes to standard editing proce-
dures in WaveLab. 
It is specifically meant for audio restoration purposes using the various processing methods 
in the Spectrum editor, which are usually applied to very short time segments in an audio file.
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There are two ways to select Spectrum display mode:

• By clicking the arrow button in the lower right corner of the main view, and 
selecting “Spectrum” from the pop-up menu that appears.

• By selecting the Spectrum selection tool in the Tools control bar.
This automatically switches the display mode to Spectrum in the main view and also opens 
the Spectrum editor dialog.
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The Spectrum display is a “spectrogram”, where each vertical line repre-
sents the frequency spectrum at the corresponding time location. The 
bottom of the display corresponds to the lower frequencies while the up-
per part of the display represents the higher frequencies. 

The intensity or level of the frequencies are either represented as a color 
spectrum, from red (maximum intensity) to purple/black (minimum inten-
sity), or as a monochrome intensity (depending on the setting in the 
Spectrum options dialog – see below).

It may take a while to get accustomed to “reading” the spectrogram, but 
you will find the effort worthwhile. 

• The vertical ruler on the left shows the frequency area (in Hz) for the spec-
trum. 

• The status bar will show exact time/frequency positions for the mouse 
pointer.

• You can perform standard selection and edit operations, just like in the 
Wave display.
Note that the Pencil tool is not available.
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About the Spectrum options

The Spectrum options dialog allows you to define how the frequency 
spectrum should be displayed. 

• You open the dialog by clicking the arrow button in the lower right corner of 
the main view, and selecting “Spectrum options…” from the pop-up menu.

The dialog contains the following items:

Option Description

Style Use this to specify whether the Spectrum should be displayed in color or in 
one of two grayscale modes.

Logarithmic 
frequency 
scale

If this is activated, each octave in the frequency spectrum will be equally 
spaced vertically. However, linear mode (i.e. this option is not activated) is 
sometimes better suited for spectrograms. The reason for this is that for 
sound restoration purposes the “interesting” frequencies are often located in 
the upper end of the spectrum, and in linear mode the higher frequencies are 
displayed over a larger region.

Range Any frequency below this level will not be displayed in the spectrogram. This 
option allows you to focus the display on the more audible part of the spec-
trum.

Audio gain 
for analysis

This allows you to apply gain to the analysis (audio is unchanged). This helps 
you find artefacts with low levels.

Resolution This selects the size of the frequency analysis (FFT). This analysis calculates 
the spectrum from a block of audio samples. The selectable values represent 
the number of samples per analysis. The higher the value, the more frequen-
cies can be analyzed, but the analysis will be less accurately localized in the 
time domain, and vice versa. Together with the FFT size, the time and fre-
quency resolution is displayed on the menu. 
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Defining a region
All Spectrum editing functions are applied to (or from, if Master Section 
processing is used) a selected region. A region set in the Spectrum editor 
contains a time range (horizontal axis) and a frequency range (vertical axis). 

Before you start, it is a good idea to decide where in the file’s time range 
you would like to apply Spectrum editing. Then set it up so that the view is 
zoomed in on this range, and maybe also define this range with markers. 
This to enable you to view the area you wish to process in more detail, but 
also because screen redrawing (e.g. when changing horizontal zooming) 
takes time to compute in Spectrum display mode, especially when long 
audio segments are in view. 

You define a region in the following way:

1. Select the Spectrum selection tool.
This will change the Wave window to Spectrum display mode (if not already selected) and 
will also open the Spectrum editor dialog.

• The Spectrum editor dialog is non-modal and always open when the Spec-
trum selection tool is selected. 
The current settings in the dialog do not matter when defining regions, so you can fold the 
dialog window or move it out of view if it is in the way.

2. You define a region by drawing a rectangle with the mouse in the Spec-
trum view.
The height and the vertical position of the rectangle defines the frequency range, and the 
horizontal axis defines the time range. 

• When defining a region in a stereo file, a “mirrored” region is automatically 
created in the other channel.
To define a region in one channel only, press [Shift] while drawing the region.
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• If you point the mouse cursor inside a set region, a pop-up appears show-
ing the currently set frequency range in Hz and the time range in seconds/
milliseconds for the current region.
To apply Surgical processing, the region length must not exceed 10 seconds.

• To deselect a region, right-click in the window and select “Deselect” from 
the speed menu.

• A selected region can be moved in any direction by click-dragging the re-
gion manually.
If you press [Shift], you can only move the region horizontally thus retaining the selected fre-
quency range. If you press [Ctrl] + [Shift] you can only move the region vertically thus re-
taining the selected time range. 

• You can resize the region by pointing the mouse cursor on the region 
edges (so that a double-arrow appears) and then click-dragging.
There are many more options for setting regions available on the speed menu (right-click in 
the Spectrum view) – for descriptions of these options, please see “Speed menu options” 
on page 271).

Once a region has been defined, you can process it separately using either 
Surgical processing (see below), or Master Section processing (see “Mas-
ter Section processing” on page 269).
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Surgical processing
Surgical processing can be used to process short regions (up to 10 sec-
onds) offline. This type of processing is mainly used to reduce, remove or 
replace unwanted sound artefacts in the audio material, which can be 
done with great precision. 

As with all Spectrum editor operations, you first have to define a time/fre-
quency region. Once a region has been set, you can select one of the two 
Surgical processing modes. These are as follows:

• Filtering operations.
These are described below.

• Copy operations.
This allows you to copy a spectrum region and apply it to another region – see “Copy op-
erations” on page 265.

Filtering operations

The Filtering operations allow you to filter a selected region in various 
ways. This works as follows:

1. Select the Spectrum selection tool so that the Spectrum editor dialog 
opens.

2. Define a region in the Spectrum view.
Make sure that the region does not exceed 10 seconds. 

3. In the Spectrum editor dialog, select “Surgical processing (offline)”.

4. Clicking “Process” will apply the filtering according to the set parameters.
See below for a description of these.
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Common filtering parameters

There are two pop-up menus in the “Filtering operations” section; the up-
per selects the type of filter processing to be performed, and the lower 
selects a filter type (only available for some of the filter operations). Addi-
tionally, you can specify the Gain of the filtering (i.e. the attenuation level) 
as well as the Filter steepness.

Filter steepness determines how sharply or quickly frequencies above or 
below a certain point are attenuated. Steepness is stated in dB per oc-
tave, with higher numbers indicating a steeper filter. WaveLab uses high 
quality linear-phase digital filters capable of “infinite” steepness 
(>1000dB/octave). 

The Steepness parameter crossfades the processed part with the un-
processed part. It could be described as a crossfade in the frequency do-
main. If the steepness value is small, the selected region will contain much 
of the unprocessed signal near the frequency edges. 

The “Crossfade time” parameter sets the length of the crossfade (when 
the processed signal is merged with the unprocessed signal). 

For filtering operations the following processing options are available in 
the Spectrum editor:

Gain
dB

Frequencies

Filter Steepness
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Damp

This is used to attenuate the level of a region. The Gain parameter speci-
fies the level of the attenuation (although less commonly used it is also 
possible to set positive gain values, i.e. to boost the frequencies in the re-
gion). Three filter types are available to perform the damping:

• Pass-band filter
All frequencies in the region are equally attenuated.

• Low-pass filter
Higher frequencies in the region will be attenuated more.

• High-pass filter
Lower frequencies in the region will be attenuated more. 

For the Low- and High-pass filters, a low Filter steepness setting is nor-
mally used (around 6 to 18dB).

Blur peaks

This filter operation analyzes the region to find the frequencies with the 
highest level. The level of these frequencies will be attenuated (or boosted) 
according to the set Gain value. If the gain is negative, these frequencies 
will be “blurred” and disappear in the mix as a whole. The purpose of the 
filter is to mask the loudest frequencies (e.g. it could be used to eliminate a 
sudden burst of pitched but unwanted sound in the audio material, like 
acoustic feedback).

This mode works best with the Infinite steepness setting, which is auto-
matically selected when “Blur peaks” is used. You can, however, freely 
set any Filter steepness setting. The filter type options are not available 
when this mode is selected.

Dispersion

This is a special filter that “smears” the dynamics and pitch of the region, 
without changing the actual frequency content. This works best on lower 
frequencies, to mask the identity of a signal without changing the average 
frequency spectrum.

This mode works best with the Infinite steepness setting, which is auto-
matically selected when Dispersion is used. You can, however, freely set 
any Filter steepness setting. The filter type options are not available when 
this mode is selected.

Dispersion can also be used to create special effects as it warps the 
sound in a unique way.
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Fade out

This can be used with any of the three filter types (Pass-band/Low-pass/
High-pass). It gradually filters the frequencies in the region along the time 
axis (from nothing at the left edge of the region, to maximum allowed by 
the gain parameter at the right edge), useful for gradually removing fre-
quencies from a region.

Fade in

This works like Fade out but inversed.

Fade out then in

This is a mix of the two previous options; the filtering effect gradually 
fades out until the middle of the region, then fades back in. The “Fade in 
then out” option is the inverse.

Playback pre-roll/post-roll

This allows you to set a pre-roll and post-roll time for playing back a se-
lected region. If the values are set to zero, the transport parameters will 
work normally.

Copy operations

This feature is also mainly intended for audio restoration purposes. First, a 
Source region and a Destination region are defined. You can then copy 
the audio from the source region to the destination region. 

The following applies:

• The two regions must have equal duration and frequency range. 
In other words, the regions must be equally sized. 

• The two regions must also belong to the same audio file.

• The Filter steepness should be set to a high or Infinite value.

This feature can be used to remove an unwanted sound in the audio ma-
terial. There are two general recommended methods you can use:

• You can set a Source region just before or just after the sound to remove. 
The Source region will most probably contain a very similar frequency spectrum as the Des-
tination region containing the artefact you wish to remove, but without the artefact. This can 
produce very accurate results, e.g. perfectly removing a sudden noise like a cough or a 
chair falling over.
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• You can also do the same in the frequency domain; have the Source and 
Destination regions in the same time line position, but in different frequency 
ranges. 
This could be used to mask a spurious sound artefact with few harmonics, by copying the 
audio placed a bit “lower” or “higher” in the frequency range. Note that when copying be-
tween different frequency regions pitch shifting takes place. Tip: Copying a source region 
to the destination region using the “Move region upwards (or downwards) 1 octave” op-
tions on the speed menu will often produce better results.

• This mode is useful to replace narrow frequency ranges, e.g. feedback.

• Having an octave shift from the source to the destination region can help 
achieving better results (there is a function for this in the speed menu).

For audio restoration work you should generally avoid copying regions in 
the low to low mid frequency range. This is where most of the “energy” in 
the sound is usually found, which makes the masking/removal of any un-
wanted artefact difficult to achieve without audible interruptions. Therefore, 
to remove or reduce artefacts, it is important to find a limited frequency 
area, so as not to interrupt the flow of the audio.

You perform a Copy operation in the following way:

1. Select the region that you wish to use as Source region.
As stated before, this could be right before or after the sound artefact to be removed, or it 
could be in the same time line but in a frequency range just above or below the range con-
taining the sound you wish to mask. Note that these are guidelines, not absolute rules. 

2. To use the selected region as the Source region, click the “Mark” button 
in the Source section of the dialog.
You can also right-click to bring up the speed menu and select ““Define as Source region”.

As the Destination and Source regions have to have equal length and fre-
quency ranges, the simplest method is to use the Source region as the 
basis for the Destination region, or the Destination region as the basis for 
the Source region. The following describes the former method, but the 
general procedure is the same:
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3. Click the “Show” button in the Source section if the Source region isn’t 
currently shown.
If the region is active but outside of the current view you can right-click to bring up the 
speed menu and select “Jump to selected region”.

4. Click the “Mark” button in the Destination section of the dialog.
Now an exact copy of the source region has been selected as the Destination region. 

5. Now you can move the Destination region to where you wish to copy the 
Source region to.

• If you wish to preserve the original frequency range press [Shift] when 
moving the region.
This restricts movement to moving left/right (the horizontal), thus preserving the frequency 
range.

• If you wish to preserve the original time range press [Shift] + [Ctrl] moving 
the region.
This restricts movement to moving up/down (the vertical), thus preserving the time range.

• You can also use the various items on the speed menu to move regions.
See “Speed menu options” on page 271.

6. When you have set the “new” Destination region, click the Destination 
“Mark” button again.
Now, both a Source and a Destination region have been set. If you click the Source and 
Destination Show buttons, the view will jump between the two selected regions, given that 
they are both visible inside the current window view. If they aren’t, use the same method but 
select “Jump to selected region” from the speed menu after clicking the corresponding 
Show button. If you play back, the Pre-roll/Post-roll settings will apply to the currently 
shown region.

7. Set the Filter steepness parameter to the desired value.
A high value or the Infinite setting is recommended.
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From here, you can select one of two Copy methods, using the pop-up 
menu above the Copy button.

• “Copy exactly” will, as the name implies, copy the Source region exactly 
as it is.

• “Copy ambience” copies an average of the source frequencies, and pro-
duces a blurring of the original dynamics and pitch variation information. 
This mode can be useful as the copied region will appear more “transparent”, whereas the 
“Exact copy” might cause a “repetition” effect. There is no general rule as to when to 
choose either method, it depends on the audio material.

8. When you have set the copy options as you want them, click “Copy” in 
the Spectrum editor dialog to perform the operation.

Using Copy/Paste

You can also use standard copy/paste commands for regions:

1. With a region selected, press [Ctrl] + [C].

2. Place the cursor where you wish to place the copied region.

3. Press [Ctrl] + [V] to paste the audio at the cursor position.
The original length and frequency range will be the same as in the original region, but note 
that the copied audio is pasted – it does not create a new region.

Storing regions

If you have defined a region, and then draw a new region, you will not be 
able to return the to previous region unless you have marked it as a 
Source or Destination region. If you wish to switch between two regions, 
e.g. to compare how a certain filter operation will turn out, you can use the 
two Mark buttons in the Copy operations section to store two indepen-
dent regions as usual, but you don’t have to perform a Copy operation be-
tween the two.

Instead, you can use the Show buttons for the Source/Destination as a 
way of switching between two independent region definitions.
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Master Section processing
Another application of the Spectrum editor is Master Section processing. 
This allows for frequency selective processing. A selected region’s fre-
quency spectrum can be routed to the Master Section where you can 
choose to process it separately from the non-selected frequency spectrum.

The signal is split so that one part (region spectrum or non-selected 
spectrum) is sent to the plug-ins, while the other part can be mixed with 
this processed signal, after the Master Section output.

The arrows show the three possible routing options for the spectrum re-
gion selection. The non-selected spectrum has the same options, al-
though it cannot use the same routing destination (i.e. Bypass/Master 
Section input/Master Section output) as set for the region selection.

Thus, a selected spectrum region can either be: 

• Processed separately by the Master Section plug-ins. 
In this case, the non-selected spectrum can either be bypassed or sent to the Master Sec-
tion.

• Bypassed.
This removes the selected spectrum region from the audio file. In this case, the non-se-
lected spectrum can either be routed to the Master Section input or the Master Section 
output.

• Sent to Master Section output. 
In this case, the non-selected spectrum can either be bypassed or sent to the Master Sec-
tion input. If the latter is selected, it will be mixed with the selected spectrum region at the 
Master Section output.

Spectrum region 
selection

Bypass

Master Section 
plug-ins 1-8

Master level

Master Section 
output (Mix)

Master Section 
Dither/Post 
Master plug-in
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To apply Master Section processing, proceed as follows:

1. Select the Spectrum selection tool and define a region using the normal 
methods.
The selected region should preferably be longer than one second. The frequency spectrum 
of the region will be used to filter the sound. Note that if you intend to use the Render func-
tion, the selected region time range is what will be rendered – see “Rendering the Master 
Section processing” on page 271.

2. Select “Master Section processing” in the Spectrum editor dialog.
This grays out all parameters in the dialog that are not applicable for this processing 
method. 

3. Select a Filter type (Pass-band/Low-pass/High-pass) from the pop-up in 
the Filtering operations section in the dialog.

4. Specify a Filter steepness and Crossfade time (crossfading only applies 
when Rendering).

Next step is to select how to route the selected (region) spectrum. The 
options in the “Routing of selected spectrum” section in the dialog are as 
follows:

• “Bypass” – this will mute the selected region spectrum.
• “Send to Master Section input” – this sends the selected region spectrum to the 

Master Section input, allowing you to process the region separately using any 
plug-ins.

• “Send to Master Section output (pre-master)” – this sends the selected region 
spectrum to the Master Section output (no plug-in processing).

The same routing options are available for the non-selected spectrum (i.e. 
for all frequencies outside the selected spectrum), but you can’t route 
both the selected and non-selected spectrum to the same destination (as 
that would be pointless).

• If you select to route the selected spectrum to the Master Section input 
and bypass the non-selected spectrum, you can listen to the selected re-
gion spectrum separately (including plug-ins). 
If you start playback, you will notice that the whole audio file is filtered according to the re-
gions spectrum – not just the region itself. You can move and resize the region during play-
back, and the filtering will change accordingly in real-time. This gives you a direct feedback 
over how the region spectrum affects the sound. 

• You should not use any plug-ins that change the number of samples, e.g. 
Resampler in this mode.
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Rendering the Master Section processing

The selected region’s time range determines the range that will be ren-
dered. 

If you wish to apply the filtering to the whole file, you should use the “Se-
lect whole file length” option from the speed menu.

• If you click Render in the Master Section with the Spectrum selection tool 
selected, the rendering will take place without the Rendering preferences 
dialog opening.
It will “process in place” the selection according to the settings in the Spectrum editor dialog.

Speed menu options

When the Spectrum selection tool is selected, right-clicking in the Spec-
trum display will bring up the following items on the speed menu:

Item Description

Filter Applies the processing (Surgical processing only).

Copy selection 
to cursor

The selected region is copied at the position of the cursor (the fre-
quency range remains the same).

Copy source 
to selection

The region defined as “source” (see “Copy operations” on page 
265), is copied at the position of the selected region.

Copy source 
to destination 

If a source region has been defined (see “Copy operations” on page 
265), this function copies the source region to the destination region.

Deselect Deselects the region in all channels.

Deselect this
channel only

Deselects the region in the selected channel.

Swap channels Shifts the selection to the other channel. This can be useful if you 
want to restore samples in one channel by using samples from the 
other channel.

Jump to selected 
region

Scrolls the display to the current selection.

Zoom selected
region

Zooms the time axis so that the current region occupies half of the 
window width.

Move region 
forwards

Moves the region selection forward so that it starts after its current 
end position on the time axis.

Move region 
backwards

Moves the region selection backwards so that it ends before its cur-
rent start position on the time axis.
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Move region
upwards

Moves the selection up to start after its current end on the frequency 
axis.

Move region 
downwards

Moves the selection down to end before its current start on the fre-
quency axis.

Move region 
upwards 1 octave

Moves the selection up by 1 octave on the frequency axis.

Move region down-
wards 1 octave

Moves the selection down by 1 octave on the frequency axis.

Select until start of file Extends the region selection to the start of the file.

Select until end of file Extends the region selection to the end of the file.

Set whole file length Extends the region selection to the whole file.

Select until highest
frequency

Extends the selection to the top of the frequency axis.

Select until lowest 
frequency

Extends the selection to the bottom of the frequency axis.

Define as source 
region

Stores the current selection as the “source” region.

Define source region 
from cursor 

Moves the current selection to the cursor position, and stores the re-
sult as the “source” region.

Show source region Displays the source region.

Define as destination
region

Stores the current selection as the “destination” region.

Define destination 
region from cursor 

Moves the current selection to the cursor position, and stores the re-
sult as the “destination” region.

Show destination
region

Displays the destination region.

Item Description
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Introduction
Batch processing is an extension of the Master Section Render function 
(see “Rendering” on page 239). The big difference is that the Batch Pro-
cessor can work on any number of files, and process different files with 
different settings. However, it also allows you to do a few other things that 
are not available with the Render function:

• Have any number of processors applied.
• Use plug-ins not available in the Master Section, see “About the off-line proces-

sors” on page 287.
• Batch process Montages and wave files simultaneously.
• Work on files that aren’t open, and save the processed files directly to disk.
• Change the file format and name of files.

Furthermore, the Batch Processor is much more effective than rendering 
multiple files simultaneously, especially when a large number of files are 
processed. This is because it is more efficient for the computer to pro-
cess the files one after the other, rather than sharing the processing 
power between a number of files, all processed “simultaneously”. The 
truth is that the Batch Processor in WaveLab is really fast.

However, there are a few things that you can achieve with Render in the 
Master Section that aren’t available from the Batch Processor. The “Ren-
der Region” feature (and the “No tail” and “Skip Mute sections” options) 
are only available in the Render dialog. The “Render Region” feature is of 
course an ideal way to render multiple files which in turn can be pro-
cessed in the Batch processor.

• Note that WaveLab also has a specific batch file encoding function, for 
batch converting files from one format to another.
See “Basic procedure” on page 304.

• WaveLab also features powerful Batch renaming functions. 
This is described in the chapter “Batch renaming” on page 307.

An example of the advantages of the WaveLab Batch Processor

Great care has been taken to make the WaveLab Batch Processor as ef-
fective as possible. We would like to give you an example to prove this. If 
you are not yet familiar with the Batch Processor, you might not under-
stand all the details. Still, this text should give you an insight to the inner 
workings of this extremely useful and effective part of the program.

Let’s say you set things up so that a three minute file should be processed 
through the following chain of effects:
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DC Remover –> Denoiser –> Normalizer (first instance) –> Compressor 
–> Normalizer (second instance) –> MPEG Compression

Of these effects, the DC Remover and the Normalizer(s) are Multi Pass 
effects. This means that the signal needs to pass each of these effects 
more than once – in this case twice, first for the effect to analyse the sig-
nal (gathering data for the processing) and then again for the actual pro-
cessing.

This is how WaveLab would handle the processing chain in this example:

During the first “pass”, the audio is read from the file and passed through 
the analysis part of the DC Remover. The other processors don’t need to 
read the signal at this stage and are skipped. Nothing is written to disk, 
the only result of this pass is the amount of DC removal required. After 
only a few seconds of analysis (the DC remover does not need to read 
the whole file), the process starts over.

During pass two, the DC remover processes the signal, but it is not saved 
to disk (which makes the process fast). It also passes through the first 
Normalizer for analysis so that the program is aware of how much Normal-
ization will be required. The other processors are skipped.

Pass 1: = disk domain = RAM

Transfer Analysis

DC RemoverRead file

Pass 2: = disk domain = RAM

Transfer Process Analysis

Read file DC Remover Normalizer

Pass 3:

Transfer Process AnalysisProcess Process Process

= disk domain = RAM

Read file DC Remover Normalizer Denoiser Com-
pressor

Normalizer
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During pass three, the signal is processed by the DC Remover, the first 
Normalizer, the Denoiser and Compressor and is analysed by the second 
Normalizer. Again, nothing is saved to disk, the only purpose of this pass 
is to gather information about how much normalization will be required.

Time for pass four. Now all information has been gathered so that all the 
real processing and disk writing can take place during one single pass.

Thanks to the unique WaveLab technology, the process finishes much 
faster than if the file had been read and written to disk by each processor. 
Furthermore, rounding errors are reduced to a minimum since the audio 
never leaves the “32 bit domain” (no temporary file is created). This in-
creases the overall sound quality even further!

Opening the Batch Processor

“Use Master Section” (on the Options menu) must be active for batch pro-
cessing to be available!

There are three basic ways of opening the Batch Processor:

• From the Tools menu.
This gives you a “clean slate” to start with. You can open as many Batch Processor windows 
as you like.

• From the Render dialog (see “Rendering” on page 239).
This takes the current settings in the Master window and converts them into a process list 
(a sequence).

• By using the Auto Split function - see “The Auto Split dialog” on page 342.

For the Batch Processor button to be available in the Render dialog, “Whole 
file” must be selected and “No tail” must be disabled!

Pass 4:

Transfer Process Process Process Process Process

Process Transfer

= disk domain = RAM

Read file DC Remover Normalizer Denoiser Com-
pressor

Normalizer

MPEG 
Encod- Write file
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Overview of the Window

The Batch Processor window

The window is divided into four tabs:

The Input tab

This is used to set up the files to process. Here you use various tools and 
functions to assemble lists of files and documents.

From the Input tab you can also open the process list, which allows you to 
specify exactly what type of processing should be performed on the files.

The Output tab

This is used to specify where the resulting files should be stored, how 
they should be named and in what format they should be.

The Schedule tab

This is used to set up priorities and post-processing options.

The Presets tab

You can create presets of batch settings made on the Input, Output and 
Schedule tabs. See “Presets” on page 65 for details.
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The Input tab – Assembling a list of files

The functions described in this section are also available on a speed menu 
(accessed by right-clicking in the file list).

Creating batches

You are not only able to process one batch of files, but many. Each batch 
contains a number of files, and all the files in a batch will be processed iden-
tically. However, each batch can use a totally different set of processors.

• To create a batch, click the button “Create batch folder” at the top of the 
list.
In addition, if there is no batch at all, one will be created automatically when you add the first 
file, see below.

• To remove a batch, select it and click the Remove button (the red cross).
All the files in the batch will be removed from the list as well.

The “Create batch folder” button.

In this example, there 
are three batches.
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Renaming and setting attributes for a batch

To rename a batch, proceed as follows:

1. Select the batch in the list and click on the name icon (the “A”).
Alternatively you can hold down [Alt] and double click directly on the batch.

2. Enter the desired name in the dialog.
Entering a number instead of a name has a special meaning. This will change the name of 
the batch to the default name “Batch X”, where X is the number you typed. All the other 
batches with default names will be renumbered accordingly.

3. If desired, specify an output path for the batch.
This is an advanced option that in many cases will not be necessary. You will only need to 
specify a path here if you want to process a number of batches at the same time and want 
some of the batches to store their output files in a different directory. See “Setting up file lo-
cations and names” on page 292 for details.

Setting the order of batches

Batches will be processed in the order they appear in the list. If you want 
a certain batch to be processed first, put it at the top of the list. There are 
several ways to set the order of batches:

• You can move a batch up and down by using the arrow buttons.

• You can drag and drop a batch to change the order.

Adding and removing files from a batch

• Regardless of which method you choose from below, you should first select 
the batch to which you want to add the files, by clicking on it.
This will ensure that the files are added to the right batch. If you forget this, you can always 
drag files to the right batch later, see “Moving files between batches” on page 282.

Adding open documents

To add a document that is already open to the list, select it from the doc-
ument pop-up menu.
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Note that this also works with documents in open Basic Audio CDs and Au-
dio Montages. This way you can add and batch process all files that “belong” 
to a Basic Audio CD or an Audio Montage.

Open documents are represented by blue and white miniature window 
icons.

You cannot process files that have never been saved (“Untitled” files). How-
ever, you can process files that have previously been saved, but are now 
open for editing.

Adding one or more files via a dialog

1. Click the Add file button.

2. In the file dialog that appears, locate and select the desired files and click 
Open.
Files are represented by yellow icons. Please remember that you can use [Shift] and [Ctrl] in 
the file dialogs to select as many files as you wish, from the same folder.

…brings up the docu-
ment pop-up menu.

The document button…

A file on disk

An open document

The Add File button.
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Adding files via Drag and Drop

• You can add files from the Windows Explorer or My Computer windows. 
Drag the file icon and drop it on the batch.

• You can add an open Wave document, by using the drag icon on the title 
bar and dropping it on a batch.

Adding all files in a folder

To add all files in a folder (and in all its subfolders), proceed as follows:

1. Click the Add folder button.

2. In the list that appears, select the desired folder and click Open.

3. In the next dialog, decide what file types should be included, via specify-
ing an extension (you can use “*” to add all file types).
You can also specify whether or not you want to include files in folders located inside the 
selected folder (subfolders).

Adding Audio Montage files

When you add Audio Montages, the whole Montage will be processed as 
“one”, producing a mixdown of the Montage (a single file for a stereo 
Montage). Multichannel Montages can also be batch processed if multi-
channel plug-ins are used, and if “Multi Stereo/Mono” is selected as the 
output format, separate files will be processed/rendered.

1. Click the Add Montage file button.

2. In the file dialog that appears, select the desired Audio Montage file(s).

The Add folder button.

The Add Montage file button.
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About “Allow duplicate file names”

When this option on the Extra pop-up menu is activated, the same file can 
be added to several batches, and hence be processed several times.

The only restriction is that each “instance” of the file must be set to create a 
file with a name and/or location that is different from the other “instances” of 
the same file. This is done by using path variables, as described in the sec-
tion “Using path variables” on page 293.

Removing files

If you want to remove a file from the list, select it and click the Remove 
button (the red cross).

You can also clear the list completely and start “from scratch”, by pulling 
down the Extra menu and selecting “Clear list”.

Various file considerations

If you are processing a file that is already open, please note the following 
things:

• If the new file will have the same name and is saved in the same location, the file 
will not be saved (since it is already open). This is the same as using the Render 
function with the “Process in place” option activated. In this case, Undo is avail-
able for the processing.

• If the new file will have the same name and is saved in the same location, and the 
number of channels changes in the file (mono becomes stereo or vice versa) then 
a new document is created, which is opened in an untitled window.

• If the new file is saved under a new name or in a new location, a new file on disk 
is created, there’s no need for saving. The Batch Processor can be used for sav-
ing very large files to disk in the background, so that you can keep working on 
other files “in the foreground”.

Setting the order of files in the list

Moving files between batches

It is very important which batch a file is part of, since all files in a batch are 
processed with the same set of effects. If one ore more files for some rea-
son have wound up in the wrong batch, you can move it:

1. Select the file(s) that are in the wrong batch.

2. Drag and drop it/them onto the correct batch.
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Changing file order within a batch

The order of files within a batch is usually of no particular importance 
(they will all get processed in the same way), but when you set up a batch 
with many files, it might make things easier if you can organize things the 
way you want it:

• You can move a file up and down within the batch by using the arrow buttons.
• You can drag and drop files within a batch to change the order.
• You can re-sort the order of the files on the Input tab by selecting one of the sort 

options on the “Extra” menu.
You can also re-sort the list by clicking on the file headings. 

About the file icons – File status

To the left of the file you will find an icon providing information about the 
status of the file:

Option Description

Green circle The file is ready to be processed. You cannot start processing unless at 
least one file has this status.

Purple dot The file is currently being processed. The Batch window can’t be closed if 
any files have this status, the only way to stop a batch is then from the Mon-
itor window, see “The Monitor window” on page 247.

Half filled 
green circle

The file has been analysed by an “Ultra-pass” processor but has not been 
processed and written to disk yet, see “Ultra-pass processors” on page 288.

Green dot The batch has been processed without problems. In order to process the file 
again, you need to reset its status, see below.

Red cross An error occurred. You will most likely have been warned via an alert box. If 
an error occurs, processing is cancelled by default. On the Extra menu there 
is however an option called “Stop batch processing at first error”. If you de-
activate this, processing will not stop upon error, but instead skip to the next 
file in the batch.

The file status 
icons
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Resetting file status

To reset the status of a file to the “green circle” status described above, 
click on the symbol to the left of the file.

To reset the status of all files, select “Reset status of all files” from the Ex-
tra pop-up menu.

Opening files

There are three ways to open a source file in a Wave window:

• Double click on it in the list.
• Select it and click the “Open window” button (to the right of the Play button).
• Drag it and drop it on an empty section of the WaveLab program window.

To instead open the processed file (after running a batch), proceed as fol-
lows:

• Double click on the file in the Output column in the list, or…
• Select the original file in the list, hold down [Ctrl] and click the “Open window” 

button, or…
• Hold down [Ctrl], drag the file from the list and drop it on an empty section of the 

WaveLab program window.

Other file functions and options

• The “Show full path” and “Show name only” options on the Extra menu allow you 
to determine what file information you want to see in the list.

• To play a file, select it and click the Play button (speaker icon).
Stopping is done using any of the usual methods or by clicking the button again.

• If the file list contains files in raw format, or files that contain an unsup-
ported header, you can specify the format for them, by selecting “Define 
default special file format” from the Extra pop-up menu. If this is done, you 
don’t have to specify the format manually each time a file in “raw” format is 
about to be processed.
For this to make sense, all “raw” files must be in the same format.

Saving and opening file lists

To save the file list as a simple text file, containing the absolute paths (lo-
cations) of all files in the list, select “Save file list…” from the Extra menu. 
When you open a file list that you have saved (or one created in some 
other way), the files in the list are added to the currently selected batch.
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Validating the list

There might be occasions where it is not certain the file list really matches 
the contents of the hard disk. For example, a file might have been deleted 
from the disk since you last updated the list.

Also, you might add files in formats that WaveLab can’t handle.

• When you select “Validate list” from the Extra menu, the program will scan 
the list and check that all files really exist in the specified locations and that 
their formats are valid.
Entries for non-existent or invalid files will be removed from the list.

Setting up the processing tasks to be performed
The next step is to set up how the effect processors should be applied to 
the batch.

Opening the Processor List

There are three ways to open the Processor List:

• Select a batch in the list and click the Processor List button.
• Select a batch in the list and press [Return].
• Double click on a batch.

Please note that it might take some time to open this window, depending 
on the number of presets and additional plug-ins you might have installed. 
If this is a problem, delete the presets you don’t need.

The Processor List button
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About the Processor List

The Processor List has two tabs, one is the main tab and the second is for 
managing presets (see “Presets” on page 65).

The Processors tab

This tab is divided into two columns:

• The left column (Sequence) displays a list of processing that will be applied to the 
batch. When you first open the dialog, this list is probably empty, because you ha-
ven’t assigned any processors to it yet. Later, when you process, the processing 
will be performed in the order it appears in this list.

• The right column (Plug-ins/Presets) contains the list of available processors and 
combinations of processors. This is described in the following paragraph.

The Plug-ins/Presets list

This list contains three folders on the top level, with items that represent 
various processing options:

• The “Master Section Presets” folder contains a list of all presets created in the 
Master Section Presets dialog, see “Master Section presets” on page 236. Such 
a preset can contain a number of combined processors, all with their own individ-
ual settings.
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• The Process List Presets folder contains a list of presets created in this dialog. As 
with the Master Section Presets, this can represent a combination of a number of 
processors. This allows you to easily re-use combinations of processors.

• The Plug-ins folder contains folders and lists of the processors in the program, to 
some extent the same list as in the Master Section.

The plug-in icons and presets

• In the Plug-ins folder, each icon represents an installed plug-in.
• Unfolding a processor icon reveals its current presets. If an icon has no plus sym-

bol, it has no “WaveLab Presets”, that is, to access presets, you then need to 
open the panel for the processor itself, see later in this chapter.

A processor plug-in (Chorus) and its presets.

• ASIO, DirectX and VST plug-ins are in their own folders.
• Off-line processors (see below) are categorized by different colors.

About the off-line processors

There are some important things to note about the off-line processors:

The three categories

• Regular (yellow). These require only one processing pass (see “An example of the 
advantages of the WaveLab Batch Processor” on page 274). Example: “Time 
Stretch”.

• Multi pass (turquoise). These require two or more passes (analyse and process). 
Example: “Normalizer”.

• Ultra pass (green). See “Ultra-pass processors” on page 288. Example: “Meta 
Normalizer”.

The three Plug-ins/
Presets folders
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Other considerations

• Off-line processors might not have presets.
• Off-line processors that require extra processing “passes”, slightly increase the 

overall processing time.

The included off-line processors

• DC Remover. This removes any DC Offset in the file (see “Eliminate DC Offset” 
on page 195). This would normally be inserted at the beginning of the processing 
list, preparing the file for processing, so to speak.

• Normalizer. This is normally included at the end of the list to get the resulting file 
back up into “full level”. Alternatively, it can be inserted in between other proces-
sors when required (for example before the input of a compressor). You can add 
as many Normalizers as you need, in between other processors, if required.

• Time Stretch and Pitch Correction. See “Time Stretch” on page 196 and “Pitch 
Correction” on page 201.

• Loudness Restorer. This is used to “capture” the loudness at a certain point in the 
audio chain and restore that loudness at some other point. For this reason, these 
must be inserted in pairs into the signal chain (one plug-in “capturing” and one 
“restoring”). Click the question mark icon in the dialog for details.

• Meta Normalizer. This allows you to give all the processed files the same level af-
ter processing. Click the question mark icon in the dialog for details.

• Meta Leveler. This lets you raise the level of all processed files by a certain 
amount while maintaining the original level differences between the files. Click the 
question mark icon in the dialog for details.

• Resizer. This allows you to set the sample length of a file to a given value.
• Stereo -> Mono. Lets you convert stereo files to mono files and limit the level of 

these to avoid clipping.
• Fade-In and Fade-Out. These allow you to apply identical fade-ins and fade-outs 

to all the processed files. You can specify the fade curve shape, the length of the 
fades and the desired start (fade-in) and end (fade-out) amplitudes.

• External Gear. This is located in the “ASIO” subfolder. This allows you to Batch 
process using an external processor – see “Using External effects” on page 252.

Ultra-pass processors

An ultra-pass processor analyses all files in the batch, collects the result, 
and applies it to the files by various amounts, if desired. This means that 
the result of the analysis of one file, can affect how other files are pro-
cessed. A typical example is the (included) Meta Normalizer, which can 
process a number of files so that they all get the same loudness as the 
loudest file in the batch. It does this by analyzing all files to find out which 
is the loudest (and how loud it is) and then process them all by various 
amounts so that they get the same level.
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Ultra-pass processors can be freely combined with other types of proces-
sors. For example you can use both the Meta Normalizer and a regular Nor-
malizer in the same batch. You may also combine ultra-pass plug-ins with 
multi-pass plug-ins.

An ultra-pass plug-in requires two processing passes. During the first 
pass all the files in the batch are analysed, during the second pass, they 
are all processed:

This is different from other multi-pass plug-ins, where each file is analy-
sed/processed twice (or even more times if required).

Levels – About the Normalize “Only if clipping” option

Processors often increase signal level. If you are not careful, your file may 
be distorted when it exits the batch. To prevent this, you can use the “Only 
if clipping” option in the Normalizer. The theory behind this is as follows:

It is perfectly OK if the signal is amplified above “0 dB” (full level) within 
the “audio stream”, since WaveLab uses 32 bit internal processing. 
There’s lot’s of extra “headroom” and the signal will not be clipped.

However, when a signal that exceeds “0 dB” is converted to a 16 bit file 
at the output of the Batch Processor, clipping – and hence distortion – 
will occur.

Global Pass 1:

Global Pass 2:

= disk domain = RAM

File 1 Process Analysis

Transfer Process Analysis

Transfer Process Analysis

Transfer Process TransferProcess

Transfer Process TransferProcess

Transfer Process TransferProcess

Read file Any plug-ins Meta Normalizer

Read file Any plug-ins Meta Normalizer Write file

TransferFile 2

File 3

Transfer

File 1

File 2

File 3
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To remedy this, you can insert the Normalizer at the end of the signal 
chain. The Normalizer will not only raise levels, but also lower them as re-
quired so that the signal peaks exactly at the specified value just before it 
is converted to a file. This is useful to do even when “Only if Clipping” is 
not activated.

However, if you only want the Normalizer to be applied when clipping 
should otherwise occur, activate “Only if Clipping”. When this is acti-
vated, the signal output may be low, but you can rest assured it isn’t 
clipped due to amplification within any of the processors.

Effectively, this allows you to use the Normalizer as a completely distor-
tion-free limiter.

Adding a processor to the list

1. If the processing option has presets that you want to use, click on its 
folder “+” symbol to open it.

2. Select either the desired preset or the plug-in icon.
Selecting the plug-in icon itself, adds the processor with default settings.

VST plug-ins do not have presets in this list, you have to make settings in 
the actual panel. See “VST-compatible plug-ins” on page 229 for further in-
formation.

3. Either click on the “+” button or drag the selected symbol in the left pane 
of the window and drop it.

To add processors, drag them 
from the Plug-ins/Presets 
pane into the Sequence pane.
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• If you use the “+” button or drop below the existing list, the processor will be 
added at the end of the list.
You can also do this by double clicking the processor in the list to the right.

• If you drag and drop on another symbol, it will be added just before that proces-
sor in the list.

If you create an “impossible” combination of effects, for example feed a 
mono output into a processor that only accepts stereo input, you will get an 
error message when you try to process.

Removing processors from the list

To remove a processor, select it in the left list and click the Remove but-
ton or press [Backspace].

Changing the order of the processing

If you have added the correct processors, but realize they are in the 
wrong order, you may change this:

1. Select a processor in the list.

2. To move it one step up/down, click the up/down arrow buttons.

Activating and deactivating processors

You can activate or deactivate a processor in the sequence list by clicking 
in the checkbox to the left.

Making settings for a processor

If you want to adjust the settings for a certain processor, proceed as fol-
lows:

1. Double click on the processor in the sequence list, or select the proces-
sor in the list and click the Edit button (the fader).
The panel for the processor appears.

2. Adjust the settings (or select another preset) and click OK.
See “Making settings – The Effect control panels” on page 227 for more information on 
processor panels and presets.

Some off-line processors (shown with “blue”, “yellow” or “green” icons) may 
not have presets. In this case, you have to adjust the settings on the panel. 
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Closing the Processor List window

Once you have finished with all the settings, click OK to confirm the set-
tings and close the dialog or Cancel to close it without saving any 
changes.

The Output tab – Settings for created files

This tab allows you to specify where the created files are to be located, in 
what format they should be, and other related options.

In fact, you can perform useful batch processing with the options on this 
tab, without using any processors at all! You might for example convert 
files from one format to another and/or just change the names of a num-
ber of files.

Setting up file locations and names
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Setting up a simple destination folder

There are two ways to specify a folder for all created files:

• Type in a path (file location) on the Destination folder line.
• Click the folder icon just beside the destination folder line, browse your way to a 

folder and select it.

Using path variables

If you need more advanced options, for example if you need to store dif-
ferent batches in different folders, you need to use the path variables, 
available on the pop-up to the right of the folder icon.

Variables are text strings enclosed in brackets (for example “<Group 
Path>”) that appear on the Destination folder line. You can type these 
variables yourself, but usually it makes much more sense to select them 
from the pop-up.

When you run the batch, the variables are replaced by folder names. Exact 
details follow later in this text.

The specified folders are created automatically if they don’t exist.

You can use more than one variable on the line, to create very advanced 
automatic file paths. Then the order of the variables on the line is very im-
portant since each added item will represent a subfolder inside the previ-
ous folder.

When you add variables to the Destination path, they will appear just after 
the insertion point, just as when you type text. Hence, adding a variable is 
done as follows:

1. Click at the position on the Destination folder line where you want the 
variable added.
A blinking insertion point cursor appears.

2. Select the desired variable from the pop-up menu invoked by clicking the 
arrow button to the right of the Destination folder line.
Please note that to completely replace the existing text with a variable, you can just select 
all text and then select the variable from the pop-up menu.
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The available variables have the following functions:

There is one exception to the statements above, and this is drive names. If 
you explicitly specify a drive name, this will always be used, regardless of 
where the source is located and what type of variables are used.

For example, if you have a source file in “c:\MyFolder\” and specify 
“e:\<SourcePath>\”, the new file will be stored in “e:\MyFolder\”.

We will also give two more examples of variables, to show you what 
advanced specifications you can make:

Let’s say you have a file with the following path: 
“c:\Folder1\Folder2\Folder3\Sound.wav”. It is part of a batch titled 
“Orange” with a “Banana” path specified for it.

Variable Function Example

Batch Name Creates a folder with the 
name of the batch, as 
specified on the Input tab 
(see “Setting up file locations 
and names” on page 292).

If you have a group called MyAudioFiles, 
and the Destination file reads “c:\<Batch-
Name>\” the files will be stored in a folder 
called “MyAudioFiles”, located in the root of 
the C drive.

Batch Path Same as above, but instead 
uses the path that can 
optionally be specified for 
each batch, see “Renaming 
and setting attributes for a 
batch” on page 279.

If the path “c:\MyFolder\” has been speci-
fied for a batch, the files in that batch will be 
stored in a folder called “MyFolder” on the 
root of the C drive.

Source file path This specifies the same path 
as that in which the source 
file(s) are stored. 

Using this without any additional tags, will 
put the outputs files in the same folder as 
the source file. If you combine this with no 
pre/suffix for file names (see below), the 
output files will overwrite the original files.

Source file 
path – down 1

Same as above, but specifies 
a folder one level down in the 
hierarchy.

If the source file is located in 
“c:\Folder1\Folder2\Folder3\”, this speci-
fies the file location “c:\Folder2\Folder3\”.

Source file 
path – down 2

Same as above, but specifies 
a folder two levels down in 
the hierarchy.

If the source file is located in 
“c:\Folder1\Folder2\Folder3\”, this speci-
fies the file location “c:\Folder3\”.

No file output No output file is created at 
all.

This is not a “variable” but a “constant”. If 
you use this, nothing else should be entered 
on the line. It is only useful for processors 
that analyse the file (not producing any out-
put audio file at all) rather than process it.
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• If you enter “d:\NewFolder\<SourcePath2>, the file will be stored as: “d:\New-
Folder\Folder3\Sound.wav”.

• If instead you enter “<BatchPath><BatchName>”, the new file will be: “c:\Ba-
nana\Orange\Sound.wav”.

Using file name prefixes and suffixes

For the file names created, you can use the fields “File name prefix” and 
“File name suffix” to add text to the beginning and/or the end of the origi-
nal name.

• You can type in any text, which will then be added at the beginning/end of 
the file name.
If for example you leave the prefix field empty and type “(processed)” in the suffix field, 
“MyFile” will become “MyFile (processed)”.

• You can add the “variable” “Batch name” (see above) anywhere in the text 
by selecting it from the small pop-up to the right of the pre/suffix lines.
This will add the name of the batch into the file name, at that location.

• You can add the variable “File number from…”, in the same way.
This will add a number to the file name. All the files will be numbered consecutively, and a 
dialog will allow you to specify the first number in the series.

Checking the output paths and names

Once you have set up the path and file name, you can switch to the Input 
tab and check the Output column. It will tell you where each processed 
file will be located and under what name.

If a line is empty, there is something wrong with the settings on the Out-
put tab – the settings aren’t valid for this file. Please go back and adjust.
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Creating zip archives

You can automatically create a zip archive of the created files. A zip ar-
chive is a file which contains other files, in a compressed format. The 
compression is non-lossy, which means that when you “un-zip” the files, 
you get exactly what you had when you created the archive – the informa-
tion is not changed in any way.

Zip files are often used for archiving purposes and when sending files to 
other people, for example via the Internet.

The zip archive is created after all processing has finished.

Proceed as follows:

1. Activate “Archive Output Files”.

2. Decide on a Path and file name for the zip file.
This is done either by typing the complete path or by clicking the folder button.

3. If you want the zip archive to contain information about how the files are 
stored in subfolders, activate “Save path information”.

4. If you want to delete the output files after the files have been added to the 
zip archive, activate “Move (erase) output files”.
If this is deactivated, you will get the output files in their regular format plus a zip archive 
containing the same files.
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Creating backups and automatically deleting source files

If you want the program to create backups of any files that would other-
wise be overwritten as a result of the procedure, activate the “Create 
backups” options. When this is activated, the program will make a copy of 
the file before processing. It will also change the first letter in the exten-
sion of the copy to “~”. For example “myfile.wav” will be backed up as 
“myfile.~av”.

This only applies if you have used the variable “Source Path”, as described 
above, to specify that the file should be overwritten with the same name.

If you are not absolutely sure of what you are doing, we strongly rec-
ommend that you leave this option activated, to avoid accidentally overwrit-
ing files.

If you want the program to delete the original (unprocessed) files after 
processing activate “Delete files after process”.

Be careful with this option! If the processing didn’t turn out as expected, 
you can’t redo it, because you won’t have any files left to re-process!
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Selecting an Output Format

• Click the large button to open the Audio File Format dialog in which you 
can select the desired output format and make settings for it.
For details about various file formats, see “Supported file formats” on page 113. For detailed 
information about the Audio File Format dialog, please click the question mark icon in the dia-
log.

The Audio File Format dialog.

• If you want the output files to be of the same format as the source files, se-
lect “No change” from the Type pop-up menu.

• The Audio File Format dialog offers not only the possibility of changing the 
file format, but also lets you change the number of channels and the sam-
ple rate and resolution – however, this is not recommended for high quality 
mastering purposes.
For these purposes, you should insert plug-ins to facilitate the conversions (such as 
Resampler) into the audio chain instead.
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Scheduling

The Schedule tab is used for various options related to the performance 
of the batch processing:

On start of batch process

This is where you instruct WaveLab what to do just before starting the 
batch operation:

On batch process completion

This is where you select how WaveLab should behave after processing all 
files.

Option Description

Stop playback Stops playback to free up some processing power.

Open Monitor window Opens the Monitor window (see “The Monitor window” on page 
247).

Option Description

Beep WaveLab will beep to signal that the settings have been applied.

Show message box WaveLab will display a message to confirm the operation. Click OK to 
go on working.
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On start of file process

This is where you select how WaveLab should behave when processing 
each file. There is only one option here: “Minimize wave window”. If this is 
activated and the document is currently open in a window, WaveLab will 
minimize this before the processing starts.

On file process completion

These settings determine what should happen after each individual file 
has been processed:

Priority

These buttons specify how fast the wave file should be processed.

Any dropouts that occur as a result of too little processing power will only 
affect the playback of the file. Files processed by the Batch Processor will 
always be free of dropouts!

Option Description

Restore wave window If the window was minimized when processing started, it will be 
restored to its previous size.

Open in window If this option is activated, the file will be opened after processing, 
regardless of whether it was open before or not.

Option Description

Relax Background The file is processed in the background, but priority is given to audio 
playback and to your continued work on other files. This makes Wave-
Lab as responsive as possible, but slows down processing.

Background The file is processed in the background but with a lower priority given 
to your continued work on other files. This makes processing faster but 
the program less responsive (unless your computer is fast enough for 
this not to make any discernible difference). Try this mode when sev-
eral files should be processed in the background.

Fast Processing is given high priority. If you have playback activated during 
processing, a fairly high-performance computer will be required to 
avoid dropouts in playback.
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Running and stopping the batch(es)
Once all settings are made, all you have to do to start the batch is to click 
Run. The files get processed, much like when you click Render in the 
Master Section, see “Rendering” on page 239.

You can stop processing in two ways:

• By clicking the Stop button in the Batch Processing dialog.
• By right clicking in the Monitor window, see “Process menu” on page 248.

Zip archiving won’t stop until the current file has been processed.

Using presets for batch processing
Please note that there are two different types of presets involved in this 
dialog:

Batch processing presets

Use these for storing and recalling settings that apply to all batches. They 
include:

• All settings made on the Input tab, except the actual file list.
• All settings made on the Output tab.
• All settings made on the Schedule tab.

They do not include:

• The list of files to be processed.
• The list of processors assembled in the Processor List dialog.

Processor List presets

These include the currently assembled list of processors in the Processor 
List dialog. Use these to save useful combinations of processors with 
their settings.

File lists

While strictly not a type of preset, the Open and Save file list features de-
scribed in the section “Saving and opening file lists” on page 284 can be 
used to save and recall the list of files processed in a batch. Note that this 
is a simple text file that can be edited by any text editor.
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Basic procedure
WaveLab can open and play both uncompressed and compressed files in a 
number of different formats, including WAV, AIFF, MP3, WMA (Windows 
Media Audio) and OSQ (Original Sound Quality), which is WaveLab’s pro-
prietary lossless audio format.

It’s also possible to convert WAV or AIFF files to another format. While 
this can be done by opening a file and selecting “Save As” or “Save Spe-
cial/Encode” on the File menu, you can also convert several files in one go 
(batch conversion). This is much like a simplified version of the Batch Pro-
cessor, for when only batch file conversion is needed (no processing).

Proceed as follows:

1. Select “Batch file encoding…” from the Tools menu.
The “Encode audio files” dialog opens.

2. Click on the green “plus” symbol.
A file selector opens, where you can select the desired audio files (WAV or AIFF). Files 
must have the same sample rate and number of channels (e.g. stereo/mono).

Click here to add files.

3. In the file type pop-up select one of the available formats (WAV or AIFF) 
and then – in the file list – select the desired files. If necessary, use the 
[Ctrl] and/or [Shift] keys to select several files. Confirm your selection by 
clicking “Open”.
This brings you back to the “Encode audio files” dialog.

Note that it is possible to simultaneously batch encode audio files of differ-
ent formats, given that all the files have the same sample rate and number 
of channels.

4. Select the destination folder for the converted files from the correspond-
ing pop-up menu.
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5. Select the desired destination format by clicking the audio properties but-
ton at the bottom of the dialog.
This opens the Audio File Format dialog in which you can select the desired format and 
make settings for it.

6. For some compressed file formats, clicking on the arrow button to the 
right of the Encoding and Attributes menus calls up dialogs where you 
can set the encoding parameters and enter text strings.
Click the question mark icon in the Audio File Format dialog for a description of the various 
options.
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Introduction
WaveLab features a powerful set of procedures to convert, remove, for-
mat, import, and insert text. This allows you to batch rename file names 
according to user specified rules.

When dealing with large projects, it can be most useful to have the option 
of applying specific names to all referenced files, markers and clips that 
belong to the same project.

Batch renaming can be used for the following operations:

• To rename files.

• To rename clips in Audio Montages.

• To rename markers in audio files and Audio Montages.

These functions share most of the same features, with some differences. 
The Batch Renaming dialog has 2 pages. The first page defines which 
files/clips/markers should be renamed, and the second dialog page de-
fines how the renaming should be executed. The second page is identical 
in all cases.

Setting up which files/clips/markers to rename

Files

As described in “Renaming files and documents (Rename)” on page 121, 
you can rename individual files and/or documents, and any open Wave-
Lab documents (Audio Montage, Basic Audio CD, Data CD/DVD, 
Backup Plan, Audio Database) that reference this file or document will be 
automatically updated. In addition, peak, mem and marker files are also re-
named accordingly for audio files.

The same applies when batch renaming files.
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To open the Rename dialog, select “Batch file renaming…” from the Tools 
menu. 

This is the first page of the dialog, where you define which files to rename.

• The first step is to define the folder in which the files to rename are located. 
This is the top item in the dialog where you can type in a location or navigate to the desired 
folder.

The rest of this dialog page contains the following items:

Option Description

Scan subfolders If this item is checked, the scan will include any subfolders in the se-
lected folder.

Rename all files This will apply the renaming to all files in the folder.

Only rename files 
with this extension

This allows you to limit the renaming to files with a specific extension, 
which is entered in the text field.

Only rename 
files with 
specific names

This allows you to set up specific text rules for which files to rename. If 
you check this you can type in a text string in the lower text field. 
Above the text field you can open a pop-up menu containing four options 
which will govern how files are selected/excluded according to the text 
string you entered:
• File name must contain this text…
• File name must NOT contain this text…
• File name must contain this regular expression…
• File name must NOT contain this regular expression… (See “About reg-
ular expressions” on page 321.)

Skip read-only files This will skip any read-only text files in the selected folder.

Set new
extension

As certain file formats have several possible file extensions (e.g. .aif or 
.snd) you can choose to change it so that all files use the same extension.
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Clips

When you rename clips, the Montage that you invoke Batch renaming 
from will be updated with the new clip names.

Select “Batch clip renaming…” from the Clips tab – Functions menu to 
open the Rename dialog. 

This is the first page of the dialog, where you define which clips to re-
name. The dialog page contains the following items:

Option Description

All clips This will apply the renaming to all clips in the Montage.

All clips in selected 
track

This will apply the renaming to all clips on the selected track.

All selected clips This will apply the renaming to all selected clips.

Only clips with 
specific names

This allows you to set up specific text rules for which clips to rename. 
If you check this, you can type in a text string in the lower text field. 
Above the text field you can open a pop-up menu containing four op-
tions which will govern how clips are selected/excluded according to 
the text string you entered:
• Clip name must contain this text…
• Clip name must NOT contain this text…
• Clip name must contain this regular expression…
• Clip name must NOT contain this regular expression…
See “About regular expressions” on page 321.

Skip locked clips This will skip any locked clips.
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Markers

You can rename markers of any type both for audio files and for Montages.

• For Montages, select “Batch marker renaming” from the Marker tab – 
Functions menu. 

• For audio files, “Batch marker renaming” is available from the Marker 
speed menu (right-click the time ruler).

The options are the same in both cases:

Option Description

All Markers This will apply the renaming to all markers in the Montage.

All Markers in se-
lected audio range

This will apply the renaming to all markers in a selected range.

Types to rename The upper pop-up allows you to select a marker type to rename. You 
can either select “All Marker types” or a specific marker type. If a spe-
cific marker type is selected you can select a second marker type from 
the lower pop-up (e.g. so that you can rename both start and end 
markers of a certain type).

Only Markers with 
specific names

This allows you to set up specific text rules for which markers to re-
name. If you check this, you can type in a text string in the lower text 
field. 
Above the text field you can open a pop-up menu containing four op-
tions which will govern how markers are selected/excluded according 
to the text string you entered:
• Marker name must contain this text…
• Marker name must NOT contain this text…
• Marker name must contain this regular expression…
• Marker name must NOT contain this regular expression…
See “About regular expressions” on page 321 for a description of reg-
ular expressions.

Skip locked Markers This will skip any locked markers.
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Renaming operations

Basics

When you have set up what files/clips/markers to rename, click “Next” in 
the Rename dialog to open the second page. Here you can define an un-
limited number of operations to perform on a name. This allows you to 
transform an existing name or create a new one from scratch. 

In the “Operations” section of the dialog, you set up and add operations 
to perform. 

1. To add a new operation, click the “+” button. 
This creates a “Insert nothing” operation, as a place to start.

2. Next, select a type of operation from the two pop-ups at the top left of the 
dialog. 

• The first pop-up selects the operation category. 
You can choose between Remove, Convert, Insert, Find and replace from table and Import 
and insert. These are all described later in this chapter.

• The next pop-up selects the operation type.
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Each operation is associated with specific parameters. When you select 
a new operation of a certain category, the available options on the Type 
pop-up change. Depending on the selected operation new parameters 
may appear below the pop-ups. Each operation is explained later in this 
chapter.

3. You can continue to add as many operations as you like which will be 
added to the list in the top right corner of the dialog.

• Operations are executed in the order they appear in the list. 
An operation can be disabled by deselecting it in the list. You can also delete selected op-
erations by using the Delete button, and use the up/down arrows to reorder the list.

• Each operation can also be associated with a comment (at the bottom of 
the dialog).

The Rename dialog allows you to perform any type of text-based opera-
tion. Although there is virtually no limit to what you can do, many of the op-
erations are easy to understand and use. 

The complex options are there for those who need them, but for many us-
ers the pre-defined operations will most probably suffice.

About the Preview section

This allows you to preview the effect of the renaming operations. Simply 
type in a name in the “Preview” field, and the change is automatically re-
flected in the Result field. This preview is continuously updated. 

• You can also click the Preview button at the bottom of the dialog to open 
the Preview Renaming dialog.
Here you can see how all the selected file/clip/marker names will be changed before you 
perform the operation. The right column shows the original name, and the right column the 
new name.
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Range parameters

A common concept to all the operations, is “where in the name” the oper-
ation is executed. The range relates to the name that will be processed by 
the current operation. If the first operation adds a counter, the range of 
the second operation (if any), can be different.

For example, if you want to remove certain characters, you have to define 
“where” in the name this should take place. This is set using the “Range” 
parameters. There are 2 types of operations: 

• Operations that act on a range (“from this position to this position”), e.g. “Remove 
operations”.

• Operations that happen at a specific place (“at this position”), e.g. “Insert opera-
tions”.

The following parameters can be set in the Range section of the dialog:

Range: All/Other/Regular expression

• All – The whole text is the range.

• Regular expression – The use of regular expressions allows for powerful 
editing of the current text, and is intended for advanced users already fa-
miliar with this concept. See “About regular expressions” on page 321.

• Other – This allows you to independently define the start and end position 
of the range, using the parameters in the From/To sections.
See below.
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Range: From/To

When “Other” is selected, the parameters in the From/To sections be-
come available. 

The following parameters are available in the “From” section:

• Start – The start of the text.

• Character position – This allows you to set a number starting from 0 and 
upwards to perform an operation on a fixed position in the text.

• Start of regular expression – You define a regular expression in the text 
field below, and the range will start at the beginning of the first match of 
this regular expression.

• After regular expression – You define a regular expression in the text field 
below, and the range will start right after the end of the first match of this 
regular expression.

• End of previous operation – If the last operation has removed, replaced or 
inserted a text range, selecting this option represents the character posi-
tion right after the last processed or inserted text.

• End – The end of the text.

The following parameters are available in the “To” section:

• End – end of the text

• Position from end – A number starting from 0 to specify a fixed position, 
counting from the end.

• Number of characters – The end position plus the number of characters 
you specify will be the start position of the operation.

• Before start of regular expression – You define a regular expression in the 
text field below, and the range will end right before the first match of this 
regular expression.

• End of regular expression – You define a regular expression in the text 
field below, and the range will end at the end of the first match of this reg-
ular expression.
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Operations

The following operations are available from the two pop-ups in the Oper-
ations section of the dialog. The upper pop-up selects the category, the 
lower the type. Below, all the operation types available for each category 
are listed.

Remove category

• All – This operation removes all characters in the selected range. 
This can be useful as a start operation if you want to create a new name from scratch.

• Spaces – All space characters are removed in the selected range.

• Spaces at start/end – Space characters at the start and end of the range 
are removed. 
Any space characters enclosed by other characters are kept.

• Doubloons – Any doubloon of a specified character is removed. 
For instance, if you specify “space” as the character, any sequence of more than one space 
will be replaced by a single space.

• Specific characters – You can remove any character(s) from the selected 
text.
You specify the character(s) to remove in the text field below the type pop-up.

• Surrounded text – You can remove any text from the selected range that 
starts with a specific character and ends with another specific character.
This is useful for removing an expression enclosed in parenthesis or brackets. In the “Left 
character” text field you specify the character from which removing starts, and the “Right 
character” text field sets the character where the removing operation stops. The “Case” 
pop-up allows you to specify whether the position of the occurrence, 1st, 2nd, etc., or all 
occurrences of this match should be taken into account.

Convert category

• To lower case – All characters in the selected range are set to lower case.

• To upper case – All characters in the selected range are set to upper case.

• Capitalize – The first character is set to upper case, and the rest to lower 
case.
There are two options for this operation: 
Only once: only the first word in the selected range is capitalized, and other words are set 
to lower case. 
All words: all words in the selected range are capitalized.

• Initials to upper case – Only single letters are set to upper case. 
E.g. “The u.s.a” will be converted to “The U.S.A”.
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• Specific character to text – The selected range is searched for a given 
character, and all occurrences of this character are replaced by a speci-
fied text.
Specify the character to replace in the left text field. In the “Replacement” text field you 
specify what the removed character will be replaced with; this can be a single character or 
a text string.

• Normalize number with zeros – The selected range has to contain a num-
ber. This number is then padded with zeros at the left side. 
E.g. a number such as 12 could become 0012. This is useful if you have a series of files 
with non-normalized counters, and you want to change this. You set the desired number of 
digits for the number from the pop-up below the type pop-up.

• Inverse character order – The order of the characters in the selected 
range is inverted. 
For instance abc would become cba.

• Replace with new text – The selected range is replaced with a text you 
specify.

Insert category

• Counter – A number is generated and increased or decreased for each 
renamed item.
The following parameters can be set:

• The Start value sets the number given to the first renamed item. 
• Step: This value is added each time an item is renamed.
• Prefix: This text is inserted before the number. Typically a parenthesis.
• Suffix: This text is inserted after the number. Typically a parenthesis.
• Format: The desired number of digits for the number, zeros are added to the left 

(but for the first choice in the combo box).
• Reset counter if folder change: When renaming files in folders and sub-folders, 

you might like to reset the counter to the start value each time a new folder is 
reached.

• Decrease counter: Typically the number is increased after each renaming opera-
tion, but you can also decrease it.

• Specific text – Specify any text that should be inserted.

• Part of original name – This operation inserts a part of the original name at 
the specified position. 
This is useful for example to reorder the parts of the original name (first operation could re-
move all characters, then you could insert parts of the original name in the desired order). 
The parameter uses regular expressions, see “About regular expressions” on page 321.
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• Pair of characters around text – The selected range will be preceded by a 
specific character, and followed by another character. 
Useful e.g. to put parentheses around a part.

• Space around text – Inserts a space character before and after the se-
lected range.

• Space after specific characters – You specify a list of characters, then 
WaveLab will search for these characters in the selected range and insert 
a space after each one it finds. 

• Space before each capitalized word – This can be useful to transform a 
name such as “MyNicePiano” to “My Nice Piano”. 
If the option “Lower case for each word but first one” is activated, the result would be “My 
nice piano”.

Find and replace from table category

This category allows you to define a table of words (any size), and to as-
sociate each word with a replacement. This feature is useful to reformat a 
text according to a new style. For example, it could be used to map a se-
ries of numbers to a series of tags, e.g. to change a numerical sequence 
like “000 - 127” to “C-2 - G8” (MIDI notes).

It is set up as follows:

1. Click the Menu button and select “New” from the pop-up menu.
A dialog appears allowing you to type in a name for the table.

2. The Renaming table opens.
This contains two columns; a Find column and a Replacement column.

3. Click the “+” in the top left corner.
A text field opens in the Find column, allowing you to type in a text string to replace in the 
selected range.

4. Double-clicking in the Replacement column will open a text field where 
you can type in a text string to replace the text specified in the Find col-
umn.

5. You can continue adding text matches and replacements in the respec-
tive columns using the same methods.
You can reopen the table at any time to add new words by selecting “Edit” from the “Menu” 
pop-up. 

There are two options on the Type pop-up:

• Find anywhere in text – The selected range searches each word in the ta-
ble, and each match is replaced.
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• Find exact text – Replacing only happens if the selected range exactly 
matches a word in the table.

As an example, let’s say you have a series of drum samples where the 
term “Darksnare” is the common part of the name, and you would like to 
change all these to “Ambientsnare”.

If you have specified “Dark” as a match and “Ambient” as the replace-
ment, it would work fine if “Find anywhere in text” was selected, but not if 
“Find exact text” was specified.

Lastly, two options are available:

• Case sensitive search – if this is checked the search will be case sensi-
tive.

• Keep letter case – if this option is checked the letter case will be trans-
ferred to the replacement. 
E.g. if the selected range is “Pno” and the replacement “piano”, then the selected range will 
become “Piano”. If the range was “pno”, it would become “piano”. If it was “PNO”, it would 
become “PIANO”.

Import and insert category

This will insert information taken from a file or current context. This is 
mostly audio-oriented as some features analyze the audio file headers.

If information is imported from the file, clip or marker itself, the following 
applies:

• If an audio file is needed, the file in the active window is used. 
• If a marker is needed, the first marker in the active window is used. 
• If a clip is needed, the first clip in the active window (Audio Montage) is used. 

The following options are available on the Type pop-up:

• Sample rate – This will insert the sample rate in the name(s) according to 
the selected range.
You can select various ways to express the current sample rate from the Format pop-up, 
e.g. 44100, 44.1kHz, etc. You can also insert a prefix and suffix in the corresponding fields.

• Number of channels – This will insert the number of channels in the 
name(s) according to the selected range.
You can select various ways to express the current number of channels from the Format pop-
up, e.g. 2ch, Stereo, etc. You can also insert a prefix and suffix in the corresponding fields.

• Sample bit resolution – This will insert the bit resolution in the name(s) ac-
cording to the selected range.
You can select various ways to express the current bit rate from the Format pop-up, e.g. 16, 
16 bit, etc. You can also insert a prefix and suffix in the corresponding fields.
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• Bit rate – This will insert the bit rate in the name(s) according to the se-
lected Range.
You can select various ways to express the current bit rate from the Format pop-up. You 
can also insert a prefix and suffix in the corresponding fields.

• VBR – If the audio file is compressed using a variable bit rate method the 
text “VBR” is inserted in the name.
You can also insert a prefix and suffix in the corresponding fields.

• File length – A time value is inserted in case of an audio file. 
For other file types a file size is inserted.

• File extension – The file extension is inserted, and you can insert a prefix 
and suffix.

• Date/Time – This will insert the date and time (of the last modification 
date) in the name. 

• Folder name – The name of the folder in which the file is located is in-
serted, and you can add a prefix and suffix.

• Name of folder’s folder – The name of the folder that contains the folder in 
which the file is located is inserted, and you can add a prefix and suffix.

• Sample: Midi note – If an audio file is associated with a MIDI root note, 
then this is inserted. 
You can select various ways to express the MIDI note from the Format pop-up, e.g. C2 - 
G8, 0 - 127, etc. You can also insert a prefix and suffix in the corresponding fields.

• Sample: detune – If an audio file contains detune information, this is in-
serted. 

• Sample: Key range – If the audio file is associated with a MIDI key range, 
this is inserted. 
You can select various ways to express the MIDI note from the Format pop-up, e.g. C2 - 
G8, 0 - 127, etc. You can also insert a separator type (e.g. “/” or “_”), prefix and suffix in the 
corresponding fields.

• Sample: velocity range – If the audio file is associated with a MIDI velocity 
range, this is inserted. 
You can select various ways to express the velocity range from the Format pop-up. You can 
also insert a prefix and suffix, and a separator.

• File header: Title – If the audio file is associated with Title information 
(meta-data, such as ID3), this is inserted. 
You can also insert a prefix and suffix.

• File header: Artist – If the audio file is associated with Artist information 
(meta-data, such as ID3), it is inserted. 
You can also insert a prefix and suffix.
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• File header: Genre –If the audio file is associated with Genre information 
(meta-data, such as ID3), it is inserted. 
You can also insert a prefix and suffix.

• Time line position (for clips and markers only) – This allows you to insert 
the time line position. The time format is the same as the one defined for 
the time ruler of the window where the clips/markers are located. 
You can also insert a prefix and suffix.

• Line X from text file – You can specify a text file consisting of a name list 
(one name per line). WaveLab inserts the name #1 for the first renaming 
operation, then name #2, etc. 
This option is mainly useful for markers, because markers are renamed one after the other 
according to their time position, hence the text file can be written with this knowledge (as 
opposed to files and clips which are renamed in no specific order).

About regular expressions 
The inclusion of regular expressions as a way to specify ranges and oper-
ations is intended for the advanced user. A regular expression is a set of 
text symbols that describe a method to find a specific text string within a 
larger text, and then apply a specific operation to this text string. Regular 
expressions are commonly used in many different areas to perform vari-
ous text-based operations. 

In WaveLab, the use of regular expressions should be seen as an added 
functionality for those who are familiar with the subject. 

As illustrated in the previous sections, the Operating Categories/Types 
together with the Start/From Range settings allow for almost any type of 
conceivable renaming operation, without ever having to specify regular 
expressions.

But if you are familiar with regular expressions, you can use this powerful 
feature to further customize text searches and perform any desired re-
naming operation!

It is beyond the scope of this manual to fully describe this subject (there 
are many internet links available), but please read on if you wish to famil-
iarize yourself with the basic building blocks used in regular expressions.
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Common expressions

A regular expression is a formula composed of characters that have spe-
cial meanings (called “operators”). Other characters are just plain letters 
and numbers that are searched for. The search engine browses the target 
text one character at a time and stops as soon as it finds a sequence of 
characters that matches the regular expression. Searches are not case-
sensitive.

Note that there are various versions of regular expressions. WaveLab 
uses a version that represents a good compromise between power and 
ease of use.

When “Regular expression” is selected for the Range, you can add regu-
lar expressions in the text field, either by typing them in manually, or by se-
lecting expressions from the corresponding pop-up menu.

The term “expression” refers to a single character, a character class, or a 
sub-expression enclosed with () or {} (see table below).

The following items are available on the Regular Expression pop-up menu:

Menu item Operator Description

Any character . Symbolizes any character.

Character in range [ ] A bracketed text is treated as a single character, i.e. any 
character from this text. Example: [AEW13] means A or 
E or W or 1 or 3.
A hyphen within the brackets specifies a range of char-
acters. Examples: 
• [F-I] means F or G or H or I.
• [A-Z0-9] matches all letters and all digits.
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Character not in range [^] A circumflex located at the first position in a bracket is a 
complement operator. In other words, all characters 
match but those included in the bracket. Example: [^E] 
means any character but E.

/ A slash before a character means that this character is 
treated literally, not as an operator anymore.

0 or 1 match 
(1 if possible)

? Matches 0 or 1 time the preceding expression. 1 repeat 
if possible is grabbed, then the rest of the regular ex-
pression continues to be evaluated.

0 or 1 match
(0 if possible)

?? Matches 0 or 1 time the preceding expression. 0 repeat 
if possible (the NEXT step in the regular expression is 
also evaluated and has priority).

0 or more matches
(as many as possible)

* Matches 0 or more times the preceding expression. As 
many repeats as possible are grabbed, then the rest of 
the regular expression continues to be evaluated.

0 or more matches
(as few as possible)

*? Matches 0 or more times the preceding expression. As 
few repeats as possible are grabbed (the NEXT step in 
the regular expression is also evaluated and has prior-
ity).

1 or more matches
(as many as possible)

+ Matches 1 or more times the preceding expression. As 
many repeats as possible are grabbed, then the rest of 
the regular expression continues to be evaluated.

1 or more matches 
(as few as possible)

+? Matches 1 or more times the preceding expression. As 
few repeats as possible are grabbed (the next step in 
the regular expression is also evaluated and has priority).

Or | OR operator. Use this to separate 2 expressions and to 
match expression #1 or expression #2. E.g. Piano|Drum 
matches all texts that contain Piano or Drum.

Not ! Negation (NOT) operator: the expression following ! 
must not match the browsed text. E.g.: a!b matches any 
“a” not followed by “b”.

Generic Group () Grouping operator. Useful to form a sub-expression. 
This sub-expression can be followed by one of the 
repeat operators.

Capture {} Capture operator. By default, the found text corre-
sponds to the entire regular expression. But it is possi-
ble to limit a part of the regular expression with { }, and if 
a part is matched, this will be the retained part. For in-
stance the regular expression “ab{cd}ef” that is applied 
on “abcdef” will return “cd”. 

Beginning of text ^ Put this sign to specify that the sought-after text MUST 
be located at the start of the browsed text. Any match 
not located at the start of the browsed text is ignored.

Menu item Operator Description
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The Shortcuts submenu on the Regular Expression pop-up menu con-
tains the following options:

All special characters used for regular expressions are available from the 
“Special characters” submenu. 

There is also a Presets sub-menu with pre-defined operations. The items 
on this sub-menu are as follows:

End of text $ Put this sign to specify that the sought-after text MUST 
be located at the end of the text. Any match not located 
at the end of the text is ignored.

Menu item Operator Description

Any digit /d Special code to symbolize any digit, as [0-9].

Any non-digit /D Special code to symbolize any non-digit, as [^0-9].

Any letter /l Special code to symbolize any letter, as [a-z].

Any non-letter /L Special code to symbolize any non-letter, as [^a-z].

Any alphabetic /w Special code to symbolize any alphabetic character, as 
[0-9a-z].

Any non-alphabetic /W Special code to symbolize any non-alphabetic charac-
ter, as [^0-9a-z].

Any number /u Special code to symbolize a number (without a sign).

Number with possible 
+- before 

/i Special code to symbolize a number which can be pre-
ceded by a + or - sign.

Quoted string /q Special code to symbolize quoted text.

Simple word /z Special code to symbolize a simple word (a sequence of 
letters surrounded by non-letters, e.g. spaces).

Menu item  Description

1st/2nd/3rd word This searches for the first, second or third word, respectively 
(separated by a space).

Last word This searches for the last word (separated by a space).

1st/2nd/3rd expression
in parentheses

This searches for the first, second or third string enclosed in 
parentheses, respectively.

Menu item Operator Description
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Last expression
in parentheses

This searches for the last string enclosed in parentheses.

1st/2nd/3rd expression
in brackets.

This searches for the first, second or third string enclosed in 
brackets, respectively.

Last expression in brackets This searches for the last string enclosed in brackets.

Menu item  Description
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Introduction

What are markers for?

Markers allow you to save and name certain positions in a file. You can 
use these positions later on in various ways:

• Set the wave cursor to a marker.
• Select all audio between two markers.
• Define CD tracks according to markers.
• Loop the section between two markers, etc.

There is no limit to the amount of markers you can have in a file.

This chapter describes how to use markers in Wave windows. 
Audio Montages have their own markers, see “Using markers in the Mon-
tage” on page 492. Please note however, that if you define CD tracks with 
markers and import the file containing the markers into an Audio Montage 
intended for a DVD-A, the existing CD Track markers will automatically be 
used in the montage as DVD Track markers.
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The various marker types

The following marker types are available:

About marker pairs

Four of the marker types come in pairs: CD, Loop, Mute and Region.

Since you can’t have a CD track that starts but never ends, a loop end 
point without a start, etc., special rules exist for creating, deleting and 
moving these types of markers.

• CD track markers must always be “balanced”.
For example, if you delete a track start, the corresponding end marker will also be deleted, 
or other markers will get changed.

• Loop, Mute and region markers only have a functionality when balanced.
You can enter just a start marker, but its purpose will be defeated by the lack of a corre-
sponding end marker.

Marker type Description

Generic This is mainly used for locating certain important positions and for editing 
(for example selecting all audio between two positions). Generic markers 
can be created directly during recording if needed (see “About dropping 
markers during recording” on page 153).

Temporary As Generic, but not saved with the file.

CD Track Start, 
End and Splice

These denote where CD tracks start and end. A CD track splice is used 
when a CD track starts just where another ends. As previously mentioned, 
these will automatically serve as DVD track markers if the wave file is im-
ported into an Audio Montage that will be used to create a DVD-A.

CD Track Index These are used to create “index” points in CD tracks.

Loop start and 
end

These are used for defining loop points. This is useful for editing pur-
poses as well as when creating loops before transferring a sound to a 
sampler.

Mute start and 
end

These let you temporarily silence a certain section. Muted sections can 
also be skipped on playback (see “Skipping sections during playback” 
on page 137).

Region start and
end

Use these to define start and end points for generic regions. This is use-
ful for editing purposes and can be created directly during recording if 
needed (see “About dropping markers during recording” on page 153).

Playback Starter This is used to program a playback start point. See “Setting the start 
point for playback” on page 136.
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About importing and saving loop markers

There are a few points to be aware of when importing files with loops into 
WaveLab. This is because the loops can be defined in two places: Wave 
and AIFF file formats have the ability to contain loop points, and WaveLab 
stores loop points as markers separately for each file, in “.MRK” files. So, 
there’s a potential risk for conflict:

• When you import a file that has never been used in WaveLab before, and which 
contains loops, the loops are “imported” and displayed as loop markers (in addi-
tion, the sample note and detune information described in the section “Editing 
sample attributes” on page 667 is imported, if present).

• When you then save the file in AIFF or Wave format, the loop points are stored, 
both as part of the actual file (so that other applications can read them) and in the 
“.MRK” file (for WaveLab).

• When you open a file that has been used in WaveLab before, loop indications 
that were originally in the file, before you used it in WaveLab, are ignored. Only 
the loop information in the “.MRK” file is used.

The Marker toolbar

This is a special control bar for markers. It can be brought up from the 
Control Bars submenu on the View menu.

Add CD markers

Add new 
marker

Drop Generic marker Add loop 
markers Open marker list

Go to previous marker

Go to next marker

Add Mute markers Add region markers
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Creating markers

Dropping markers on the fly

To add a marker on the fly, proceed as follows:

1. Play back the file.

2. When the cursor reaches the position where you want a marker, do one 
of the following:

• Press [Insert].

• Click the Drop marker button on the Marker toolbar.

• Select Drop Marker from the time ruler speed menu.
You can give the marker a proper name later.

• The markers dropped this way are generic.

Creating a marker from “stop mode”

1. Set the wave cursor to where you want the marker to appear.

2. Do one of the following:

• Click on the New Marker button on the Marker toolbar.

• Click with the right mouse button on the time ruler and select New Marker 
from the menu that appears.

• Press [Ctrl]+[Insert] as a shortcut for the “New Marker” operation 
described above.

3. Select a marker type.

4. Fill out the other options in the dialog and click OK.
Click the question mark icon in the dialog for details.

The new marker appears at the wave cursor position.

• If you add a CD start marker like this, a corresponding end marker will be 
added automatically, and vice versa. 
See “About marker pairs” on page 329 for details.
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Dropping markers while recording

You can drop markers during a recording. For example, if you are audition-
ing some material while transferring it from DAT tape to WaveLab, you can 
add markers at important positions, as they are coming up. The marker 
types you can add are: Generic, Region start and Region end. See “About 
dropping markers during recording” on page 153.

Creating marker pairs from the Marker toolbar

To create a loop, a mute region or a region (see later in this chapter for 
descriptions of these terms) or a complete CD track, you can use the 
Marker toolbar:

1. Make a selection that spans the area you want to enclose by a marker pair.

2. Click on the corresponding marker pair symbol on the Marker toolbar.
Markers are added at the start and end of the selection.

About the marker list
There is a marker list window that displays all markers in a wave. This can 
be used for various purposes, for editing, deleting and locating to mark-
ers, as described in the following sections.

Opening the list

To open the marker list, either select “Specialized Windows”/”Wave 
Marker List” from the View menu, or click the corresponding button on the 
Marker toolbar.

The marker list

• To sort the list alphabetically, click on the “Name” heading.

• To sort the list according to position, click the “Position” heading.
This is the default when you first open the window.
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Marker appearance and visibility
Hiding marker heads

To hide/display the marker triangles from the ruler, click with the right 
mouse button in the ruler and select Hide/Show Marker Heads.

Changing the appearance of marker lines

To hide the marker lines in the waveform, click with the right mouse button 
in the waveform and select Elements. From the menu that appears, set 
things up so that neither Solid markers, nor Dotted markers are activated.

Hiding all markers of a certain type

There’s a special dialog for hiding markers of certain types. To open it:

• Click with the right mouse button on the time ruler and select Visibility, 
or…

• Open the marker list, click with the right mouse button on a marker and 
select Visibility.

In this dialog you can show/hide markers of any type.
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Editing, converting and naming markers
The New Marker window can also be used to change existing marker’s 
properties. There are several ways to open this window with settings for a 
certain marker:

• Right click on the marker in the time ruler and choose “Edit Marker” from the menu 
that appears. 

• Hold down [Alt] and double click on the marker.
• Open the marker list, select a marker and click with the right mouse button on a 

marker and select Edit or press [Return].

To transform a marker into any other type, select that type in the list to the 
left.

To rename a marker, uncheck “Automatic naming” and type in a name of 
your own choice. The name of the marker will then be visible beside it. The 
name of the marker will also be shown as a “tip” if you move the mouse 
pointer over the marker head and wait for a moment.

The name of the marker is shown as a “tip”.

• To make sure that a CD track end or splice marker appears on an exact 
CD frame position, activate the corresponding option.
See “About frames, positions, small frames and bits” on page 578 for more details about 
CD frames.
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• To lock the position of a marker so that it can’t be moved, activate the 
Lock Position option.

• If the marker is a loop end marker you can change the number of loop rep-
etitions by unchecking Infinite and specifying your own number of loops.

• You can also use the Batch Renaming function to rename markers – see 
“Batch renaming” on page 307.

There are also two ways to convert several markers to another type in one 
go:

• By using the “Convert marker type” dialog – see below.

• You can also use the Auto Split function to convert all markers in a file from 
one type to another, as described in the section “Example 2 – Converting 
marker type” on page 345.

The Convert marker type dialog

In this dialog you can convert markers from one type to another. Up to 
three From/To marker type conversions can be performed in one go!
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• For wave files, the dialog is opened by right-clicking the time ruler and se-
lecting “Convert marker type…” from the menu.

• For Montages, the dialog is opened from the Marker tab : Functions menu.

The dialog contains the following items:

Moving and duplicating markers
To move a marker, press the mouse button over the triangle “Head” and 
drag to the new position.

• If “Magnetize bounds” is activated (see “Dropping on markers (Magnetize 
bounds)” on page 339) the marker “snaps” to the edges of the selection, the 
cursor’s position and the beginning and end of the wave.

• If you hold down [Shift] while dragging a marker in the ruler, you will be 
duplicating it instead of moving it.

Marker type Description

From Selects which marker type to convert. 

To Selects which marker type to convert to.

Conditions pop-up Here you can optionally specify text conditions for each of the three 
marker conversions. If you select any of these options you can enter a 
text string to match in the lower text field. The conditions are as follows:
• Marker name must contain this text.
• Marker name must NOT contain this text.
• Marker name must contain this regular expression…
• Marker name must NOT contain this regular expression… (See “About 
regular expressions” on page 321.)

Markers to change Here you can select whether to convert all markers (“All”) or only mark-
ers in the selected audio range. You can also select to skip locked 
markers.
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Deleting markers

When you delete one marker in a marker pair, the other marker will also be 
deleted.

Deleting one marker from the Wave window

1. To delete a marker in the Wave window, click with the right mouse button 
on the head of marker you want to delete/rename.

2. Select Delete.
Alternatively you can drag the marker out of the window.

Deleting in the marker list

1. Hold down [Ctrl] and double click in the ruler.
The wave markers window appears.

2. Click with the right mouse button on the marker you want to delete.

3. Select Delete.

Deleting all markers of a certain type

1. Click with the right mouse button on the time ruler.

2. Select “Delete Multiple Markers…”.

3. Check the marker types that you want to delete.

4. Click OK.
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Operations involving markers

Setting the wave cursor to a marker position

To move the wave cursor to a certain marker, do one of the following:

• Double click on the marker triangle.
This is probably the most convenient option if the marker is currently visible in the window. 
This even works during playback!

• Open the marker list and select one of the markers on it.
This is probably the most convenient option if the marker is outside the current view.

• Activate “Magnetize bounds” on the Options menu. Click on the ruler 
close to the marker, or drag the cursor to a position close to the marker.

Browsing markers

You can move the wave cursor from marker to marker by clicking the ar-
row buttons on the Marker toolbar, or by using the keys [4] and [5] on the 
numeric key pad.

Starting playback from a marker

There are several ways to make playback start from a certain marker:

• Locate to a marker, as described above, and activate playback from there.

• Double click on a marker in the marker list.

• Select one of the marker related options on the Transport bar (see “Set-
ting the start point for playback” on page 136 for details).

Selecting between markers

To select all audio between two adjacent markers, double click between 
them.

Double clicking here… …selects the audio between the markers.
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You can extend the selection to consecutive markers, by continuing to 
drag to the left/right.

To select all audio between any two markers, double click just to the right 
of the leftmost one, hold down [Shift] and double click just to the left of 
the rightmost one. 

Dropping on markers (Magnetize bounds)

For any operation involving drag and drop of audio material you can use a 
marker position as start point for the section you drop. This is useful when 
it is very important that the dropped material is inserted at a very specific 
position.

1. Make sure Magnetize bounds (on the Options menu) is activated.

2. Drag the selection, and position the mouse pointer close to a marker line.
The “drag line” snaps to the marker line.

Make this selection by dou-
ble clicking as above…

…then press [Shift] and double click to 
the left of the rightmost marker…

…to select all audio between the leftmost and rightmost markers.
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3. Make sure the marker line and the drag line appear on top of each other, 
then release the mouse button.

Creating CD tracks

All operations related to CD markers are described in the section “Pre-
paring a Basic Audio CD” on page 347.

Looping

Loop markers are primarily intended for transfer to samplers as described 
in the section “Using samplers and creating loops” on page 657, but you 
can use loop markers in various additional ways:

• Set up a loop and repeat it indefinitely during playback, while editing ma-
terial inside the loop.
For more information on playback and loops, see “Looping” on page 137.

• Set up a loop with a specified number of repetitions, to check out how a 
repetition effect will sound.

• Note that you can nest loops, that is you can have loops inside loops.

Skipping regions

You can use start and end Mute markers to have sections skipped during 
playback (or when rendering, see “Rendering” on page 239):

• To skip a mute region on playback, click the Playback skip mode icon on 
the Transport bar and select “Skip Muted regions” from the pop-up menu 
that appears.
This can be very useful in conjunction with looping. Loop a section and adjust the Mute 
markers during playback until the desired section is skipped.

If you point at a marker when us-
ing drag and drop, the audio will 
be inserted there.
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Introduction
Auto Split is a powerful function that allows you to automatically split au-
dio files according to certain specified rules. You can use it to split files in 
the following ways:

• …at marker points
• …at regions containing silences
• …at beat points using beat detection
• …at specific time intervals
• …according to a description of regions stored in a text file

In addition, you can use the Auto Split function to remove silence at the 
start and end of a file, or to split stereo files into two mono files.

The Auto Split function can either create new files or Montage clips refer-
encing the original file(s). The new files or clips can be automatically named 
and/or numbered.

The Auto Split dialog
To open the Auto Split dialog, select “Auto Split” from the Tools menu, or 
press [Ctrl]-[T]. 

What appears is actually a series of dialogs or pages, with different pa-
rameters and options according to what Auto Split method you select. 
When you have set up the first page as desired, click “Next” to proceed to 
the next page, and so on. If you change your mind, you can click “Back” to 
go back to the previous page.

• On the first page you specify what file(s) to process with Auto Split.
You can select between:

• The Wave in the currently active window (or a selection of the same Wave).
• All wav or aif files in a specified folder (optionally including subfolders).
• File List (a text file containing the names and paths to audio files on your disks, 

with one file name per line).
For the last two items you have to click the Browse button and navigate to the desired 
folder or text file, respectively.
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• On the second page you select the type of splitting you wish to perform:

• The third page of the dialog varies according to the chosen split method. 
The following pages of the dialog are common to all types of Auto Split, except that certain 
options are greyed out in the dialogs if not applicable.

• The fourth page is where you specify what to do with the regions created 
by Auto Split.
You can choose to save the regions as separate files or to create clips and add these to a 
new or existing Montage. You can also select to not split the file(s) but to create markers at 
the split points instead. Click the question mark icon in the dialog for details.

• On the fifth page you can set various options.
Here you can insert silence at the start and/or end of the files, or automatically assign root 
key note numbers to the files. Click the question mark icon in the dialog for details.

• On the last page you specify how the files, clips or markers created by 
Auto Split should be named before finally performing the splitting.
Options include a source file name plus a key name or number, or the file name as specified 
in a text file. Click the question mark icon in the dialog for details. 

Option Description

Split according to 
markers

This will split the file(s) at specific marker positions. If you select this, the 
next page allows you to select which marker type should govern where 
splitting will occur. 

Split at specific 
intervals

This will split the file(s) at specific time intervals. If you select this, the 
next page allows you to specify this time interval (and thus the duration 
of each region).

Split between 
silences

This will split the file(s) so that each non-silent section becomes a sepa-
rate region. If you select this, the next page lets you specify the minimum 
region duration, minimum duration of a silent section, and the signal level 
that should be considered as “silence”.

Learn regions from 
text file

This mode allows you to split an audio file according to a description of 
regions stored in a text file. See “About the “Learn regions from text file” 
option” on page 346.

Split at beats This option will detect “beats” in the audio material and split the file(s) at 
each beat. If you select this, the next page allows you to specify the sen-
sitivity of the beat detection, the minimum beat level to create a split 
point, and the minimum region duration (i.e. no regions shorter than the 
specified duration will be created).

Cut head and tail This will remove sections from the start and/or end of the file(s), either 
silent sections or sections specified by you on the next page.

Convert stereo files 
to two mono files

This will split stereo files into two mono files. Since there are no addi-
tional settings for this, the next page will be the “fourth page” below, on 
which you specify where to save the files.
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Example 1 – Splitting samples

Here’s one application of Auto Split: Let’s say you are working with a 
sampler (hardware based or software, e.g. Steinberg’s HALion). You have 
made a long recording of separate notes of an instrument that you wish to 
cut up into separate samples and transmit to the sampler:

1. Open the audio file in a Wave window and select Auto Split from the 
Tools menu.

2. On the first page, specify that the “Wave in active window” should be 
processed, and click Next.
The next page asks you what type of splitting to perform.

3. Select “Split between silences” and click Next.
This assumes that there are sections of silence between the recorded notes. If the notes 
have reasonably clear attacks, you could also try the “Split at beats” method.

4. Set up the next page according to the audio file, and click Next.
You should adjust the first setting according to the length of the shortest recorded note, the 
second setting according to the shortest period of silence between two notes, and the third 
setting according to the level of the “silence” between the notes (this can require some ex-
perimenting if the recording contains room ambience or long decaying notes).

5. Now you are asked what to do with the regions to be created. Select 
“Save as separate files”, specify the desired format (wav or aiff) and loca-
tion for the new files and click Next.

6. On the Options page, activate the “Assign Key” option and select the 
“Detect pitch” method. Click Next.
This will analyze each note and assign the correct “Key” setting (also known as “root key”) 
to each sample. If you activate “Quantize to nearest semitone”, WaveLab will set the Key 
according to the closest semitone; if not, the “Detune” setting in the sample may also be 
adjusted, according to any pitch deviations. See “Editing sample attributes” on page 667.

7. On the final page, select the naming option “As audio file name + key” 
and click Process.
WaveLab splits the file according to your settings, and creates new files in the specified lo-
cation. If you are working with HALion, it’s now very easy to import the samples into the 
sampler: open all the created files and use the [Ctrl]-[Shift]-[C] function described in the 
section “Using WaveLab with Steinberg HALion” on page 666.
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Example 2 – Converting marker type 

Another example of Auto Split does not involve any actual splitting of the 
file. Instead we illustrate how you can use Auto Split to convert all markers 
of one type to another. Proceed as follows:

1. Open the audio file containing the markers you wish to convert in a Wave 
window and select Auto Split from the Tools menu.

2. On the first page, specify that the “Wave in active window” should be 
processed, and click Next.
The next page asks you what type of splitting to perform.

3. Select “Split according to markers” and click Next.

4. Next you specify what type of markers should be used to “split” the file 
and click Next.
Here you select the existing marker type that you are about to convert.

5. On the next page, select “Do not split, only create markers at splitting 
points”.

6. Then on the same page, set the marker type you want to convert the exist-
ing markers to.

7. Continue through the next pages and set options as required.

8. Finish by clicking Process on the last page.
The markers are changed to the specified type.
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About the “Learn regions from text file” option

You can split an audio file according to a description of regions stored in 
a text file. 

This works as follows:

• The text file must be placed in the same folder as the audio file, with the 
same name, and with an extension that you specify in the WaveLab dialog 
(e.g. “txt” or “xml”).
Each region is described by a name, a start position and end position (or a region length). 
The text file is a series of such descriptions. WaveLab lets you specify a few parameters so 
as to adapt to different text formats. Let’s start by an example:

Name=My region

Start=10000

End=20000

Name=My other region

Start=50000

Length=15000

The parameters are each identified by a tag. There are 4 possible tags: 

• Region name
• Region start
• Region end
• Region length 

These tags can be customized in the dialog. The text file must specify 
either the “End” or the “Length” parameter. The “End” parameter is the 
sample position right after the last sample of the region so that “End to 
Start” equals “Length”.

• Each parameter (name, positions), must be located on a separate text 
line.
This does include the XML style, which is normally allowed to do otherwise.

• The time values must be in samples or in time code format.
Hours:minutes:seconds:samples.

There are 3 possible text formats:

• “Tag” = “Value”: The tag comes first, then the sign “=”, then the value.
• “Tag” Tabulation “Value”: The tag comes first, then a tabulation sign, then the value.
• XML style: The tag comes first, surrounded by < and >, then the value, lastly the 

tag surrounded by </ and >. 
When you select this text format, the characters are expected to be in the UTF-8 format.
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Creating, opening and saving Basic Audio CDs

Basic Audio CD was the first implementation of CD burning in WaveLab. The 
Audio Montage has since added many new features for CD creation, but 
this original concept (Basic Audio CD) still represents a simple and effec-
tive way to create a CD. 

The Basic Audio CD allows you to burn real “red book compatible” CDs. 
It is in this window that you assemble the files you want to appear on the 
CD, and make settings for them.

• To create a Basic Audio CD, pull down the File menu, select New, and 
from the submenu that appears, select Basic Audio CD.
You will get a blank window that you can fill with entries, see “Adding files to a Basic Audio 
CD” on page 350.

• To open an already existing Basic Audio CD, select Open from the File 
menu, and Basic Audio CD from the submenu that appears. Alternatively, 
use the list of recently opened files at the bottom of the File menu.
When you open a Basic Audio CD, all the files to which it refers are also opened. However, 
they do not appear in windows. If some files that are part of the Basic Audio CD can't be 
found, a warning message appears.

• Once you have created your list, you can save it to disk like any other file, 
using the Save and Save as commands.

Please note that the Basic Audio CD can very well be used as a generic 
“play list”. It allows you to easily assemble lists of files or sections of files 
with adjustable pauses in between. These lists can be used for auditioning 
or for creating complete program material.
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About the Basic Audio CD window
When a Basic Audio CD is active, a new menu called “CD” appears. You 
can also open this menu from the top left corner of the Basic Audio CD 
window.

The CD menu, here invoked from the main menu bar.

• You can have several Basic Audio CD windows open at the same time.
• The Basic Audio CD is merely a list of the files (or file segments), it does not con-

tain the actual files themselves.
This means that changes you make to the files will be reflected in the list as well. In other 
words, it is very important to keep track of changes made to files that are used in several 
Basic Audio CDs, because these changes will appear in all these lists.
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Adding files to a Basic Audio CD

What audio file formats can be used?

You can add any type of file to a Basic Audio CD. However, when it is 
time to burn the CD, the files in the list must meet the following specifica-
tions:

• 44100 Hz (44.1kHz).
• Mono, dual-mono or stereo.
• 8, 16, 20 or 24 bit resolution.

The files will be converted to 16-bit stereo on the fly, while the CD gets burned.

A track can only appear once in each Basic Audio CD!

Using Add Track(s)

This item on the CD menu is used to add tracks directly from disk.

1. Select Add Track(s) from the CD menu.

2. In the File dialog that appears, select as many files as you wish.

3. Click OK.
The files are now added to the list:

• If a file contains CD start and sub-index markers, these are used to define the 
track in the list.

• If there are several sets of markers, there will be several track entries in the list, all 
“pointing” to this file.

• If a file does not contain any markers, a dialog box will ask you if you want to use 
the file start and end as boundaries for the track. Click “OK” (or “OK for all, if you 
have selected several files): you can always move the markers later to redefine the 
positions.

For more information about markers, see “Working with CD markers” on 
page 358.

By dragging a document

You can drag an entire Wave document into the Basic Audio CD, by us-
ing the drag icon on the title bar. When you do this, all CD tracks defined 
in the document are added to the list.
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By dragging a waveform selection

If you already have a Wave window open, you can drag and drop selec-
tions from it to the track list.

1. Make a selection.
There are numerous ways of making selections. Let us just mention here the possibility to 
double click between two markers to select all audio between them.

2. Position the mouse pointer over the waveform, inside the selection area, 
and drag and drop in the track List.
The selection appears as a track. If there are sub-index markers inside the selection, they 
will be part of the track.

Dragging a waveform selection into the Basic Audio CD to add it as a track.
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By dragging or copying and pasting between Basic Audio CDs

If you have several Basic Audio CDs open, you can drag and drop between 
them.

1. Point at a track item in a list.

2. Press the mouse button and drag and drop the track item into another 
list.

You can also use Cut, Copy and Paste to achieve the same thing:

1. Select an item in one track list.

2. Select Cut or Copy from the Edit menu.

3. Select another Basic Audio CD.

4. Select Paste from the Edit menu.

By dragging from a Database

You can drag files from the Database File List onto the Basic Audio CD 
window.

1. Point at a file in a Database.

2. Press the mouse button and drag and drop the track item into a CD track 
list.
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Setting the order of the tracks on the CD
Once you have all the files you need in the Basic Audio CD you might 
want to set the order in which they will appear on the CD.

Determining the current order

1. Pull down the CD menu and select “Sort by Track Order”.

2. Check the numbering on the side of the list, it is now consecutive and the 
list reflects the order of the tracks on the CD.

Changing the order using drag and drop

1. Position the mouse pointer over the name of the track you want to move 
to another position.

2. Drag and drop it somewhere else in the list.
The items get resorted to reflect the new order.

Changing the order using the keyboard

1. Select the track you want to move up/down.

2. Hold down [Ctrl] and press the up/down cursor keys.
The file is moved up/down, accordingly.

Deleting files from Basic Audio CDs
To remove a file from the track list, select it and select Delete from the 
Edit menu or press [Backspace]. The file disappears from the list, but is of 
course not deleted from the hard disk.

The track order
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Managing list columns
There are a couple of changes you can make to your track columns:

• You can change the width of each column, by dragging the dividing lines between 
the headings left/right.

• You can hide/show each column by clicking with the right mouse button on a 
heading, and selecting from the menu that appears.

• You can click on the Title header to switch between three modes that show vari-
ous amounts of details about the files to which the tracks belong. 
This also switches the sort modes between “Sort by Track Order” and “Sort by audio file”.

The three levels of file detail

You can also use the CD menu (that only appears when the Basic Audio 
CD is the active window), to switch between “Sort by Track Order” and 
“Sort by audio file”.
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“Unfolding” a track
Just as in the Explorer and other Windows programs, you can unfold a 
track, to reveal additional settings. This can be done either by clicking the 
“+” and “-” symbols or by selecting the track and using the [+] and [-] 
keys on the numeric key pad.

An “unfolded” track

What information is available about a track?

The track length value is calculated from 
the position of the track end marker.

This is the pause that 
will precede the track. 

This is a representation of the marker that indicates the start of the track. The columns show the 
start (always 00:00:00) and Length (calculated from the position of the previous track end marker).

These indicate any track sub-index markers that have been de-
fined for the track. The columns show the start (the position of 
the marker) and length (the time from this marker to the next sub-
index marker or the end of the track, whichever occurs first).

These columns are described in the 
section “Other settings” on page 360.

This is a representation of the 
marker that indicates the end of the 
track. The columns only show the 
start (the position of the marker).

The track start value shows you how far in on 
the CD this track will start (in minutes:sec-
onds:frames). The start time is calculated 
from the length of the preceding tracks.
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Opening CD tracks for wave editing
There are several ways to open a Basic Audio CD item for editing in a 
Wave window:

• Double click on the Start time field.
This opens the Wave window and selects the entire track. If you double clicked on a sub-in-
dex marker or on a track end marker, the Wave cursor is moved there. Otherwise the cursor 
is moved to the track start marker.

• Drag and drop a track item, a track start marker or a Pause item onto the 
WaveLab background (outside all document windows).
This opens the corresponding Wave window and selects the area inside the track bound-
aries.

• Drag and drop a sub-index or track end marker onto the WaveLab back-
ground (outside all document windows).
This opens the Wave window and moves the Wave cursor to the corresponding position.

• Drag and drop a CD track onto an already open audio file window.
This inserts the track into the file, as when you drag and drop between Wave windows. 
Please note that this must of course be a window for another file.
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About the relation between the track list and CD 
markers

CD markers appear in the audio files. They define the start, end points 
and sub-index points for tracks in the track list.

To learn about the various marker types, open the Edit marker dialog (se-
lect “New Marker” from the time ruler menu) and click the question mark 
icon in the dialog for details.

The following illustration shows which items correspond to which in the 
track List vs. the Wave window.

Note the track splice marker that indicates the end of one 
track and the beginning of the next.
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Working with CD markers
You edit and add CD markers using any of the following methods:

• By adjusting positions of existing CD markers.
This is done by dragging, as with any marker.

• By converting existing “Generic” or “Temporary” markers into CD type 
markers.
This is done by right-clicking on a marker and selecting “Edit marker”.

The “Edit Marker” dialog

• By adding markers on the fly, and then converting them into CD 
markers.

• You can also use the “Convert marker type” dialog to convert markers – see 
“The Convert marker type dialog” on page 335.

• By adding markers using the New Marker function.
For details on the two options above, see “Dropping markers on the fly” on page 331.

• By dragging waveform selections into the Basic Audio CD.
See “Adding files to a Basic Audio CD” on page 350.

• By making a waveform selection and then selecting the speed menu op-
tion “Create CD Track from Selection”.

• By using Add Tracks on files that have not previously been marked for Ba-
sic Audio CDs.

Remember that if you make a mistake, you can always undo your actions.
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About relations between markers in a file

To understand how CD markers relate to the items in the Basic Audio 
CD, please read the following:

• A track in the Basic Audio CD is defined by a track start or track splice marker in 
the actual audio file! Delete the track start/splice marker, and the track item van-
ishes from the list! Also, edit the track start or end position, and the change is re-
flected in all Basic Audio CDs that include this track.

• Just because you create the markers for it, this does not mean the track will be 
added to a Basic Audio CD window. You have to do this “manually”, using drag 
and drop to the desired Basic Audio CD(s). As a matter of fact, you can have sev-
eral tracks defined in a single audio file, but still decide to only use one or a few of 
them in a Basic Audio CD.

• Whenever you create a track start marker, WaveLab will automatically create a 
track end marker at the start of the next track or at the end of the file, whichever 
occurs first. It’s then up to you to adjust the position of that end marker if you like.

• WaveLab does not allow tracks that start but have no end. Neither will it allow 
overlapping or nested tracks (tracks inside tracks). If you try to move track mark-
ers to invalid places (beyond the end of the file, to a position inside another track, 
etc.), WaveLab will automatically reorganize the markers to a valid configuration.

• The track splice marker indicates the end of one track and the start of another. In 
other words, it's a combined start and end marker. If you drop a start marker after 
another start marker, it will automatically convert into a splice marker since you 
can't have two starts after each other without an end between them.

• If you use one file in multiple Basic Audio CDs, beware that any changes you 
make to the audio file will be reflected in all Basic Audio CDs!

• Sub-index markers can be added between starts and ends as required. The only 
limitation is that there can only be 98 sub-index markers per track. You can’t in-
sert a sub-index outside a CD track. If you move a sub-index out of a CD track, it 
is deleted.

• Whenever you insert a sub-index, its position is quantized to a CD frame (1/75th 
of a second, or 588 audio frames) relative to the track start. If you move the CD 
track start marker, all sub-index markers will need to be re-quantized. You will be 
warned about this via an alert box. This is usually not a problem, since you will nor-
mally only start defining sub-indexes once your start and end points have been 
established.



WAVELAB
17 – 360 Preparing a Basic Audio CD

Adjusting pauses
Each track has a pause setting. This pause will be played before the be-
ginning of the track.

• To change the length of the pause, double click on the value (the dark red 
digits). As usual, you can right click on the numbers (after double clicking) 
to set the value using sliders.
If you press [Ctrl] while setting the length of a pause, all tracks will get the same pause length.

• Don’t confuse seconds with frames; 00:00.02 is 2 frames (almost noth-
ing) while 00:02.00 is 2 seconds

Naming tracks
• If you hold down [Alt] and double click on a track name, you can edit it (to 

be precise, what you are editing is the name of the CD track markers in 
the audio file). Please note that this name is not stored on the CD (CD 
tracks don't have names). This naming is only for your convenience.

Other settings

• The ISRC field (see “ISRC codes” on page 579) can be edited by double clicking.
• The comment field is also edited by double clicking. This text is not stored on the 

CD, it is only here for your convenience.
• The key symbol indicates a track copy protection “flag” (on/off setting). Click here 

to activate/deactivate this flag. Please note that this setting is hardly ever used now-
adays, and not all CD-R units can even handle it. Normally you will leave this off.

• The little rainbow colored symbol indicates the Emphasis “flag”. This setting is 
used to indicate if the track was recorded with emphasis or not. Please note that 
this does not apply/remove emphasis from the audio, it is just an indicator for how 
the file was created. Normally you will leave this off.

There is a shortcut for the last two settings: To invert the settings for all 
tracks, click on the column heading instead of the actual track item.

Copy Protection Emphasis ISRC Comment
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Checking the total length of the CD
The total length of the CD is displayed at the bottom of the Basic Audio 
CD window.

Playing files in the track list
There are several ways to play back a file in a Basic Audio CD.

• Click with the right mouse button in the track column for an item (any type 
of marker will work), and select from the menu items.
The items should be self explanatory. Please note that clicking on a track end marker allows 
you to play a transition between two tracks with a short pre-roll time.

• Double click on a track name, or select it and press [Enter] or [F8].
This plays the entire list, from that point and on, including pauses. Hit [F7] or [0] on the 
numeric key pad to stop.

• Double click on a Length field.
This plays the section between this and the next marker.

• You can drag and drop a track title onto the Play button on the Transport 
bar.
This is just the same as double clicking on the track name.

Please note:

• What you hear during playback is identical to the way the audio will be played 
back from the actual CD, that is, all pauses and other adjustments are taken into 
account (this includes the Advanced Settings unless otherwise stated).

• During playback, a progress bar appears at the bottom of the window. There will 
be no play cursor in the actual Wave window.

• During playback, you can toggle between track-local time and CD global time by 
clicking on the time counters in the bottom right corner of the window.

• Changes to markers are not taken into account during playback (you need to stop 
playback and start again).

• If you have material in the list that does not have the correct sample rate 
(44.1kHz), this can still be played back. However, when you activate playback, all 
files will play back at the same rate. The inherent rate of the selected file (the one 
that plays first) will be used for all files.

Playing back via the Master Section

To make the audio play back through the Master Section, activate the cor-
responding option in the Preferences–CD Burning tab, and open the 
Master window. The default setting for this is off.
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Creating a disc image
There might be situations where you want to “freeze” an entire Basic Au-
dio CD, without actually burning a CD. This is done with the “Save as CD 
image” command.

1. Set up the track list so that it is exactly as you want it.

2. Select “Save as CD image” from the CD menu.

3. Find a directory for the files (we recommend that you create a new direc-
tory, since the “image” is made up of three different files), and type in a 
name.

4. Click OK.

Now, the following is created in that folder:

• A Basic Audio CD file, with the specified name. This is the file you will want to 
open the next time you want to access this “CD image”.

• A single wave file, containing all the tracks, with markers inserted at all the correct 
positions.

• A marker file with the same name (it is this file that actually contains the markers).
• A peak file for the wave file.
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Exporting audio files from a track list
There are situations where you might want to save the items in a Basic 
Audio CD as audio files on your hard disk (e.g. for archiving or when you 
use the Basic Audio CD as a general play list for preparations of files for 
other purposes). You can either save the tracks as separate files or as 
one single audio file.

As separate files

To save the files in a Basic Audio CD as separate files, proceed as follows:

1. Set up the track list so that it is exactly as you want it.

2. Select “Save each track as a separate audio file” from the CD menu.

The “Save each track as a separate audio file” dialog.

3. Find a destination folder for the files.

4. Click the large audio properties button to decide the output format for the 
files.
This opens the Audio File Format dialog, in which you can select the desired format and 
make settings for it. Click the question mark icon in the dialog for details.

5. Fill out the other options in the dialog.
Click the question mark icon in the dialog for details.

6. Click OK.

Now, the tracks in the list are saved as separate files, in the specified 
folder.
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As one file

To turn the entire Basic Audio CD into one long file, proceed as follows:

1. Set up the track list so that it is exactly as you want it.

2. Select “Join all tracks into one virtual file” from the CD menu.

3. Fill out the other options in the dialog.
Click the question mark icon in the dialog for details.

4. Click OK.
The new file appears in a Wave window.

5. Save the file, like any other wave file.

Preparations done!
If you have set up a Basic Audio CD to your liking, the next step is of 
course the actual CD burning process. This is described in the chapter 
“Burning an audio CD” on page 571.
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Background information
With its unique ability to create and burn DVD-Audio compatible discs, 
WaveLab is a major step forward in bringing this versatile audio format to 
a wider consumer market.

DVD-Audio offers high resolution and multi-channel audio plus extra con-
tent such as still images and text. DVD-Audio is likely to become the stan-
dard media for audio in the future.

The structure of a DVD-Audio project

About albums, groups and tracks

To understand DVD-Audio projects, let’s start with a look at the structure 
hierarchy:

• A single sided DVD-Audio disc can contain one album.

• An album can contain up to 9 groups.
In WaveLab, a group corresponds to a Montage, but it can also be looked upon as a playlist 
for tracks – see below for further details.

• Each group can contain up to 99 tracks.
Tracks are defined by DVD track start and end markers in the Montage.

A given track may be referenced by more than one group. One group can 
consist of a complete list of songs played in a certain order. Another 
group can be a separate playlist of the slow, acoustic numbers from the 
song list, while a third group might be a playlist of the up tempo tracks, all 
taken from the same collection of material.

A group can of course also contain alternative mixes of the “original” 
tracks or just different tracks altogether.
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What can a DVD-Audio project contain?

The DVD-A specification allows for three main content groups:

• Audio content
DVD-Audio allows for audio files in a variety of channel configurations and resolutions, e.g. 
high resolution stereo and multichannel (surround) formats with up to 6 channels. Each 
group (i.e. Montage) can have different channel configurations and audio resolution set-
tings. See “Audio format considerations” on page 369 for details regarding audio formats.

• Value-added content (optional)
Real time text and still pictures can be added to the DVD-A project. A compatible DVD-
player connected to a video display can for example display real time text as a song is play-
ing, as well as displaying a slideshow of pictures. There are special tracks in the Montage 
where you can add pictures and text directly on the time line – see “Using DVD-A picture 
and text tracks” on page 546.

• DVD-V content (optional)
This can be video and audio material authored to the DVD-V format. You can add such con-
tent to a DVD-A project in WaveLab, but it has to be authored in another application. DVD-
A discs that contain video content are referred to as “hybrid” discs. To view movie contents 
you need to play back the DVD-A either in a universal DVD player, or a standard DVD-V 
player (see “Types of DVD players” on page 370).

In addition to the above, a DVD-ROM sector can be added to the disc, 
containing any type of data files. See “Creating a DVD-Audio compatible 
disc” on page 589.

An example DVD-Audio project could contain the following:

• A group with 5.1 surround mixes of various songs, including real time text 
and still pictures.

• A group with high resolution (up to 24-bit/192 kHz) stereo mixes of the 
same songs.

• A group with a different playlist of some of the same songs, perhaps de-
fined by style and/or tempo.

• Video clips (interviews, promo videos, etc.).
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Data structure of a DVD-Audio disc

The contents of a DVD-Audio project are stored in a folder named 
AUDIO_TS (Audio Title Set), which includes all audio, still picture, text 
and visual menu data. The AUDIO_TS contents are created when you 
render a DVD-Audio project, and are data files in various special formats 
readable by the DVD-A player. These cannot be opened or edited in 
WaveLab.

It is also possible to add a VIDEO_TS folder (authored in another applica-
tion) containing video content which can be viewed in standard video 
DVD players and in universal DVD players (see “Types of DVD players” on 
page 370).

Audio formats

For Montages that are to be included in a DVD-Audio project you must 
use a PCM (uncompressed) audio format.

Apart from this, a DVD-Audio project can contain audio in a wide varie ty of 
resolutions. Supported sample rates and bit-depths are:

You can use other bit resolutions for audio files in a Montage, but they will 
be stored on the DVD-A disc as either 16 or 24 bit audio samples, re-
gardless of the original resolution. The bit resolution of the DVD is speci-
fied in the DVD-Audio options dialog – see “Using DVD-A picture and 
text tracks” on page 546.

Sample Rates Bit-depths

48 / 96 / 192 kHz
44.1/ 88.2 / 176.4 kHz

16 / 24 
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Audio format considerations

There are two main considerations when planning a DVD-Audio project:

• The total size of the album.
A single album cannot contain more data than 4.7 GB (using a standard single layer 
DVD). In the table below you can see the maximum recording time on a single sided, 
single layer DVD for various formats.

• The maximum allowable data rate for a group.
The data rate is the data “bandwidth” necessary to reproduce a given number of channels 
at a certain bit resolution and sample frequency. The DVD-Audio specification allows for a 
maximum data rate of 9.6 Mbps (Mega bits per second) when using an uncompressed 
PCM audio format. For example, a group containing a 24-bit / 96 kHz 5.1 surround Mon-
tage would exceed this 9.6 Mbps limit, thus it would not be possible to use this group in a 
DVD-Audio project. 

To keep a DVD-Audio project within the allowable data rate limit, use the 
table below as a guide:

• If a group’s number of channels and sample rate exceed the 9.6 Mbps data 
rate a warning will appear when using the Check function (see “Using the 
Check function” on page 568).

Number of
channels

 Bit resolution/sample rate Max recording time

6 16-bit / 96 kHz or 24-bit / 48 kHz 64 minutes

2 24-bit / 192 kHz 64 minutes

2 24-bit / 96 kHz 129 minutes

2 16-bit / 44.1 kHz 421 minutes

Number of channels Maximum bit resolution/sample rate

6 Up to 16-bit / 96 kHz or 24-bit / 48 kHz

4 Up to 24-bit / 96 kHz

2 Up to 24-bit / 192 kHz
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Types of DVD players

There are three basic types of DVD players:

• DVD-Audio player.
This could either be an audio-only player (AOP), or a player capable of displaying visual 
menus, text and still images.

• DVD-Video player.
This is referred to as a “V-Player” (Video Player), and is capable only of playing back video 
contents contained in the VIDEO_TS folder.

• Universal DVD-Audio/Video player.
This is capable of playing back DVD-Audio data, displaying menus, text and still images. It 
can also play “hybrid” DVDs with both DVD-A and video content (contained in a VIDEO_TS 
folder), as well as standard video DVDs.

About DVD disc formats

Virtually all common types of recordable DVD formats can be used for 
burning DVD-Audio compatible discs. Supported formats are as follows:

Format Description

DVD+R Non-rewritable with a recording capacity of 4.7GB.

DVD-R Non-rewritable with a recording capacity of 4.7GB and 9.4GB.

DVD+RW Rewritable with a recording capacity of 4.7GB.

DVD-RW Rewritable with a recording capacity of 4.7GB.

DVD-RAM Is rewritable and available in capacities up to 9.4 GB.
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Introduction
The Audio Montage is a multichannel and multi-track non-destructive 
editing environment, which allows you to arrange, edit, play back and 
record audio clips on multiple tracks and channels. Features include both 
track- and clip-based effects, volume and pan automation, wide-ranging 
fade and crossfade functions and synchronization to MIDI Time Code. 
Multichannel support makes it possible to create surround mixes that can 
be burned to DVD-Audio compatible discs. 
The Audio Montage is a great tool for music CD or DVD-Audio creation, 
mastering, multimedia work, radio spot production, etc.

Basic terminology

The Audio Montage can contain an unlimited number of stereo or mono 
audio tracks. These provide a way for the user to structure the work graph-
ically, but should not be viewed as “virtual tape tracks”. Depending on the 
channel configuration of the Montage, you can route each track to different 
surround channels (up to 6) or non-surround audio channels (up to 8).

On an audio track, you can place any number of clips. These are “contain-
ers” for the audio, and include a number of settings and functions such as 
volume and pan curves, fades, etc.

A clip contains a reference to a source audio file on your hard disk, as well 
as start and end positions in the file (allowing clips to play back smaller 
sections of their source audio files). Any number of clips can reference 
the same source file.

In addition to audio tracks you can create DVD-A picture and text tracks 
(as part of a DVD-Audio project, see “Using DVD-A picture and text 
tracks” on page 546), and video tracks (see “Using video tracks” on page 
504) in the Audio Montage. 
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The Audio Montage window

About the two panes and the views

The Audio Montage window is divided into two “panes”. The lower pane 
always shows the tracks and the clips, while the upper pane shows one of 
12 views, as listed below.

• You can resize the upper and lower panes by dragging the divider between 
the panes up or down.

• You can choose to view the upper pane or the Track View only, by selecting 
“Show tabs only” or “Show Tracks only” from the main View menu.
To revert to the standard view (showing both panes), pull down the View menu again and 
deselect the selected option.

• You select views for the upper pane by clicking the tabs at the top of the 
Montage window, or by using key commands (see below). 
Apart from the actual displays, the different views may have different menus and icon bars.

The Edit view selected in the upper pane

The Track ViewClipsTracks
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The following views are available:

View Key Description

Edit E This is where you configure how many audio channels you wish to use in 
the Montage (see “Multichannel operation in the Montage” on page 
506), and where you select one of two basic operational modes; CD or 
DVD-A (from the Mode menu). This is also where you find various op-
tions for zooming, editing, fading, selecting, etc.

Zoom Z Displays a very detailed view of the focused clip’s fade-in area, for fine 
editing and phase matching of adjacent clips. See “The Zoom view” on 
page 433.

Clips C This view contains a list of all clips in the Montage, allowing numerical 
editing and adjustment. See “Editing in the Clips view” on page 436.

Groups O Use this view for grouping clips that you want to select as one entity. See 
“Groups” on page 489.

Files L Contains various tools for audio file management, including direct import 
of clips and audio files into the Montage. See “The Files view” on page 
441.

Plug-ins R This allows you to overview and manage all plug-in effects (track and 
clip) used in a Montage. See “Managing effects in the Plug-ins view” on 
page 483.

Markers M This view allows you to add and manage markers in the Montage. This in-
cludes CD and DVD-A markers, for writing CDs directly from the Audio 
Montage or preparing a DVD-Audio project, see “Using markers in the 
Montage” on page 492.

Video V Displays the contents of the video track in the upper pane of the Audio 
Montage. See “Using video tracks” on page 504.

CD/
DVD-A

D This is where you prepare for writing a CD directly from the Audio Mon-
tage (see “Preparing the Audio Montage for CD/DVD-Audio burning” on 
page 531), or alternatively for making preparations for a DVD-Audio 
project (see “Creating and opening a DVD-Audio project” on page 552). 
Which tab is shown (CD or DVD-A) depends on the selected Montage 
mode (Edit view : Mode menu).

History Y This is a list representation of the Undo history, allowing you to undo/
redo several operations in one go. See “Undo/Redo and History” on 
page 496.

Snapshots P Allows you to capture magnification and view settings as snapshots, to 
be able to quickly select different views. See “Using snapshots” on page 
396.

Notes A standard notepad.
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• If the Montage window is too narrow to show all tabs, two arrow buttons 
are displayed in the upper right corner of the window.
Use these to “move” the row of tabs so that you can see and click the one you want.

About naming

Most of the views contain one or several menus. To make it clear which 
menu is meant in each case, we use the following syntax:

• X view : Y menu

For example, “Edit view : Options menu” means the Options menu in the 
Edit view.

The info line

The info line is the grey area below the Track View. It indicates what will 
happen when you click the mouse buttons (with or without modifier keys), 
depending on where you currently aim the pointer (much like tool tips for 
buttons). This is especially useful since editing in the Audio Montage is 
based on mouse zones – you click in different areas of the clips to per-
form different actions (see “About the mouse zones (audio tracks only)” 
on page 408).

The info line will also display positions and lengths when you are moving, 
copying or resizing clips.

Showing and hiding the info line

1. Select the Edit view by clicking on the Edit tab.

2. Pull down the Edit view : Options menu and activate or deactivate the op-
tion “Show Info Line”.
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Info line symbols
The following symbols are used in the info line (the symbols for [Shift], [Ctrl] 
and [Alt] may differ depending on the language selected for WaveLab):

In this example, the info line indicates that you can open the envelope speed menu by 
right-clicking, you can click and drag up or down to change the envelope level or double 
click to add a point. Holding down [Alt], [Ctrl] or [Shift], will enable additional functions.

Symbol Description

Indicates that you can right-click to display a speed menu. The name of the 
speed menu is displayed after the M symbol.

Indicates what happens if you single click.

Indicates what happens if you double click.

This means that you can [Ctrl]-click for an additional function. Press [Ctrl] for 
more information.

This means that you can [Shift]-click for an additional function. Press [Shift] for 
more information.

This means that you can [Alt]-click for an additional function. Press [Alt] for 
more information.

C/S/A 
combinations

Indicates that you can use combined modifier keys. 
For example, “CS” means that you can [Ctrl]-[Shift]-click for an additional 
function. Press the indicated modifier keys for more information.

Indicates what happens if you click and drag up or down.

Indicates what happens if you click and drag left or right.

Indicates what happens if you click and drag the item (in any direction) within 
the Montage.

Indicates what happens if you click and drag the item out of the Montage.

This is shown as an alert indicator, when you are moving or resizing clips or 
changing envelope values, etc.
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The ruler

At the top of the Track View in the Audio Montage window, there is a ruler, 
similar to that in the Wave window. To change the ruler format, right-click in 
the ruler and make a selection from the pop-up menu that appears.

Selecting Meter format on the ruler pop-up menu

• Depending on the selected format, you can make detailed display settings by se-
lecting “Time format…” from this pop-up menu.

• It is also possible to offset the ruler, so that “zero” is somewhere other than at the 
actual start of the Montage (this is done by selecting “Time offset…”).

• When you move and edit clips, you can choose to snap to the ruler positions.
See “Magnetic bounds” on page 409.

The time grid

If you like, a “grid” can be displayed in the Track View, consisting of verti-
cal lines at every labeled position in the ruler. To show or hide the grid, 
right-click in the ruler and activate or deactivate the “Show Grid” option 
on the pop-up menu.

Time grid activated
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Assembling the Montage

Creating a new Montage

1. Pull down the File menu and open the New submenu.

2. Select the “Audio Montage…” item.
The Sample rate dialog appears.

3. Specify the preferred sample rate.
The audio files that you want to use in the Montage must have this sample rate. 

If you plan to burn a CD from the Audio Montage, you have to select the 
44.1 kHz sample rate.

4. Click OK.
A new Audio Montage window appears, containing one stereo track.

If you have saved a template (see “Saving a Montage template” on page 
499), the Sample rate dialog will not automatically be displayed (since the 
new Montage will use the sample rate saved in the template). To change the 
sample rate, you will need to select “Audio Properties…” from the Edit menu.

Alternative ways to create a Montage

There are several ways to generate a new Montage “automatically”:

• Import cue-sheet/CD image as Audio Montage.
This function on the File menu (Open submenu) allows you to open a cue sheet – a text file 
containing information about how CD tracks correspond to the audio in an associated CD 
image file. The result will be a Montage with clips corresponding to the tracks in the cue 
sheet, all referencing the same CD image audio file.
Cue sheets and CD images can be created in many programs, including WaveLab (see 
“Rendering a CD image and cue sheet” on page 540).

• By importing Audio CD tracks directly to a Montage.
When using the Import Audio CD tracks function on the Tools menu, you can automatically 
create an Audio Montage playing the imported tracks. See “Convert to Basic Audio CD” on 
page 598.

• You can convert a Basic Audio CD into an Audio Montage.
This is done from the CD menu (available for Basic Audio CD windows).

• By importing DVD-Audio tracks.
You can import selected tracks, a group or all groups from a (non-copy protected) DVD-
Audio disc and convert these into Montages – see “Importing DVD-Audio tracks into 
WaveLab” on page 599.
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• You can create a Montage from a Wave file with the Auto Split function.
See “The Auto Split dialog” on page 342.

• By opening a Wave file and selecting “Create Audio Montage from Wave” on the 
Edit menu.
This option is also available in the Open – Wave dialog (File menu).

• By importing an AES-31 project file.
You can for example export a complete Nuendo project as an AES-31 file, and import this 
into WaveLab, where a Montage containing all the tracks and files of the original Nuendo 
project is created – see “Exporting and importing AES-31 files” on page 547.

• By importing a XML text file.
See “XML Export/Import of Audio Montages” on page 549.

About the channel configuration modes

In addition to the default stereo mode, WaveLab supports up to 8 channel 
operation and up to 6 channel surround operation. To enable a multichannel 
operation mode, an ASIO driver must first have been selected in the Prefer-
ences–Audio device tab (see “Selecting an ASIO driver” on page 25). 

• To select a channel mode, open the Edit view : Mode menu.

The menu contains all the available channel configurations. See “Select-
ing a channel configuration” on page 508 for descriptions of multichannel 
and surround modes.
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Handling tracks

Creating and managing tracks is done in the area to the left of the tracks 
in the Track View (from now on called the Track Control area). In the mid-
dle of this area is a button with the number of the track. Clicking this but-
ton brings up the track pop-up menu, which contains most of the track 
functions.

Adding tracks

There are four different track types available in the Montage: audio, video 
(see “Using video tracks” on page 504), DVD-A picture (see “Using 
DVD-A picture and text tracks” on page 546) and DVD-A text (see “Using 
DVD-A picture and text tracks” on page 546).

1. Click on the track number button for a track next to where you want to 
add a new track.
The track pop-up menu appears.

2. Select one of the Add items at the top of the menu.
You can choose what type of track to insert and, if an audio track is to be inserted, whether 
the new audio track should be mono or stereo. By default, the new track is added below the 
focused track. If you wish to place it above the focused track rather than below, press [Ctrl] 
when adding the new track.
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Selecting an output for an audio track

This relates to multichannel operation – see “Assigning tracks to output 
channels” on page 510.

Moving tracks

To move a track up or down in the Track View, proceed as follows:

1. Click on the track number button for the track that you want to move.
The track pop-up menu appears.

2. Select “Move track up” or “Move track down”.

Deleting tracks

To remove unwanted tracks, proceed as follows:

1. Click on the track number button for the track that you want to delete.
The track pop-up menu appears.

2. Select Delete track.
If there are clips on the selected track, you will be asked whether you really want to delete 
the track. Click OK to proceed.

Deleting a track with clips will also delete the clips! However, the audio files 
to which the clips refer will not be affected. Also remember that you can re-
cover accidentally deleted clips by using the Undo function.

Splitting audio tracks

You can split a stereo audio track into two mono tracks:

1. Click on the track number button for the track that you want to split.
The track pop-up menu appears.

2. Select “Virtual-split as two mono tracks”.
The track is split. If the track is empty, this will be the same as deleting the track and insert-
ing two new mono tracks. However, if there are clips on the track, the two stereo sides will 
now be separate clips, allowing you to move, edit or process them independently.

Note that this is a “virtual” split – no audio files are affected or created.
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Folding tracks

To save screen space, you can fold tracks that you don’t need to have vis-
ible. This is done by clicking the arrow button at the top left corner of the 
Track Control area.

Click on the arrow…

…to fold the track.

To unfold a folded track, just click on the button again, or double click 
anywhere in the folded track.

Half height tracks

Another way to save screen space is to bring up the track pop-up menu 
for a track and selecting “Half height”. The height of the track will then be 
reduced by half relative to other tracks.

Cloning audio tracks

The Clone track function on the track pop-up menu creates a duplicate of 
an audio track and all its clips, and inserts it below the original track.

Adding audio clips to the Montage

You can create clips by copying audio selections from Wave windows 
into the Audio Montage. There are several ways to do this:

You cannot add a mono clip to a stereo track or vice versa. Also, the clip’s 
audio file has to have the same sample rate as the Audio Montage.

By using drag and drop from Wave windows

Select the audio section that you want the clip to refer to, and drag the 
selection into the Montage window and drop it on a track. A pop-up menu 
appears, listing a number of Insert options, see “The Insert options” on 
page 388.
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A clip is created, named after the original audio file. You can change the 
name of clips in the Audio Montage, as described in the section “The col-
umns” on page 439.

• This method can also be used for dragging selection ranges (see “Selection 
ranges” on page 413) from another (or the same) Montage.
The dragged range will become a separate clip.

• If you want to drag the whole audio file from the Wave window to the Audio Mon-
tage, you don’t need to make a selection first.
Instead you can click on the purple document button at the upper right corner of the Wave 
window and drag it to the Montage.

• You can also drag files into the Clips view.

By inserting from open Wave windows

If one or several Wave windows are open, you can right-click an empty 
area on a Montage track and select any open Wave from the pop-up 
menu that appears. A number of Insert options for the file are presented 
before inserting, see “The Insert options” on page 388.

If several Wave windows are open you can also select “Insert all open 
waves” from the pop-up to insert them all. This will open the Insert audio 
files dialog, allowing you to specify how the files should be ordered and 
whether they all should be placed on one single track or separate tracks – 
see “Multiple clips” on page 390. 

By using Copy and Paste

1. In the Wave window, select the audio section that you want the clip to re-
fer to.

2. Select Copy from the Edit menu, or press [Ctrl]-[C].

3. Make the Audio Montage window active, and click in the track on which 
you want to put the clip, at the desired position.
This sets the Montage cursor position (as indicated by the vertical line) and selects the 
track (as indicated by the highlighted Track Control area to the left). 

4. Select Paste from the Edit menu, or press [Ctrl]-[V].

5. A pop-up menu appears, listing a number of Insert options. Select one of 
these.
The options are described in the section “The Insert options” on page 388.
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Once you have added the desired clips from an audio file, you don’t need to 
have the original Wave window open. Should you need to edit the original 
(source) audio file, you can access it from the clip speed menu, as described 
in the section “Editing source files” on page 442 (any editing done to the 
source audio file is immediately reflected in all clips referring to the file).

By dragging from the Files view

This way, you can add clips without having Wave windows open:

1. Select the Files view by clicking the Files tab.

2. Click the System tab to the left of the display.
The view now shows a file navigation environment, similar to the Windows Explorer.

3. Pull down the Files view : Browser menu and make sure that “Show audio 
files” is selected.

4. Use the left pane to locate and open the folder containing the audio files 
you want to import.
The contents of the folder are shown in the right pane.

5. Locate the desired audio file(s) and drag them to a Montage track.
If you are dragging a single file, a pop-up menu appears, allowing you to select one of the 
Insert options. If several audio files are dragged, the Insert audio files dialog appears, allow-
ing you to specify how the files should be ordered and whether they all should be placed on 
one single track or separate tracks – see “The Insert options” on page 388. 

By dragging regions from the Files view

If you have defined marker regions in a wave file (not regions in a Mon-
tage), you can drag these regions directly from the Files view onto a Mon-
tage track:

1. Open the Files view and select the System tab.

2. Select the folder containing the source file in the left pane.
The content of the folder is shown in the middle pane.
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3. Select the audio file containing the regions in the middle pane.
Now any defined CD/DVD Track, Loop, Mute or Region Start/End markers in the audio file 
are shown in the right pane.

4. Now you can drag any region into the Montage.
When you drop the region, a pop-up menu appears, allowing you to select one of the Insert 
options – see “The Insert options” on page 388. You can only drag one region at a time us-
ing this method.

By importing files

1. In the Track View, click in the track on which you want to put the clip, at 
the desired position.
This sets the Montage cursor position (as indicated by the vertical line) and selects the 
track (as indicated by the highlighted Track Control area to the left). 

2. Right-click in an empty area on the track and select “Insert file(s)…” from 
the pop-up menu that appears.
A regular file dialog appears. You can also open this from the Files view : File menu.

• On this menu you also have the option to import a surround audio file, see 
“About the “Import Surround audio file” option” on page 520.

3. Locate and select the file(s) you want to import, and click Open.
Depending on whether you have selected one or several files, the Insert options pop-up or 
the Insert audio files dialog will appear (see “The Insert options” on page 388). The new 
clips are then added, ordered according to your settings.

The two clips shown in the picture above have been imported. The first clip has been 
positioned at the Montage cursor. Note the default pre-gap time inserted between the 
first and the second clip.
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By copying clips from another Montage

If you have more than one Montage open, you can copy clips from one 
Montage to another. This can be done either by using drag and drop 
(from the clip list or the Track View) or by using Copy and Paste. You can 
also use this method to copy clips within the same Montage.

When dragging or selecting clips in the Track View, you need to click at the 
appropriate mouse zone, as explained in the section “About the mouse 
zones (audio tracks only)” on page 408.

By dragging clips from the Clips view

You can add clips (that are already used in the Montage) by using drag 
and drop from the clip list in the Clips view.

By importing saved clips

You can save clips individually and load them into a Montage – see “Sav-
ing and loading clips” on page 386.

By dragging clips from a Database window

As described in the section “What is an Audio Database and why do I 
need it?” on page 684, a WaveLab Database is a collection of files, which 
you can organize and manage in different ways. You can add saved clip 
files listed in a Database window to a Montage, using drag and drop.

Saving and loading clips

Saving clips

It is possible to save clips to disk as separate files. This is useful if you 
have e.g. created a perfect fade, envelope or clip effect configuration, but 
want to continue experimenting with the clip in the Montage. By saving 
the clip, you can always revert to the “perfect” version later on, by loading 
it again. Note, however, that saved clips are still a reference to the original 
source file and do not contain audio data.

You can save clips in the following ways:

• By right-clicking a clip and selecting “Save clip…” from the clip speed 
menu.
In the file dialog that appears, select a location and name for the clip. Clip files have the ex-
tension “.clip”.

• By selecting “Save focused clip as…” from the Clips view : File menu.
A focused clip is indicated by a highlighted name label in the Track View.
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Loading saved clips

As usual, you need to select a stereo track for stereo clips and a mono 
track for mono clips.

1. In the Montage, place the cursor where you would like to insert the clip(s).

2. Right-click the target track and select “Insert clip file(s)…” from the clip 
speed menu.
You can also select this from the Clips view : File menu.

3. In the file dialog, locate and select the clip(s) you want to load.

4. Click Open.
The clip(s) are inserted on the selected track. If you selected more than one clip, the first one 
will be positioned at the Montage cursor, and any following clips will be spaced according to 
the default pre-gap time (set on the Edit view : Options menu). When you import several 
clips, they will be ordered alphabetically after the file names.

• If any of the auto-grouping options are activated in the Edit view, clips to the right 
of the insertion point will be moved to the right to “make room” for the inserted 
clips.
If “Track auto-grouping” is activated, only clips on the same track are moved. If “Global 
auto-grouping” is activated, clips on all tracks are moved. See “About the auto-grouping 
options” on page 391.

• It is also possible to load saved clips via drag and drop from the Files 
view.
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The Insert options

Single clip

When you add a single clip to the Montage (by pasting, importing from 
disk or using drag and drop), a pop-up menu appears. By selecting one of 
the menu items, you specify how the clip should be inserted, whether ex-
isting clips should be affected or not, etc.

Option Description

Add/Mix The clip is inserted without affecting any clips that already exist on 
the destination track. The exception is if an inserted audio clip par-
tially overlaps another audio clip, in which case a crossfade is cre-
ated in the overlapping zone (see “Using crossfades” on page 462).

Add/Mix & bind
right Clips (track)

When the clip is inserted, all clips to the right of it (on the same 
track) are moved to the right, to “make room” for the inserted clip.

Add/Mix & bind
right Clips (global)

When the clip is inserted, all clips to the right of it (on all tracks) are 
moved to the right, to “make room” for the inserted clip.

Split/Insert This option is only available if the insertion point is within an existing 
clip (audio tracks only). When the clip is inserted, the existing clip is 
split and the right section is moved to the right to make room for the 
inserted clip. Other clips are not affected.

Split/Insert & bind
right Clips (track) 

As Split/Insert, but other clips to the right on the same track are also 
moved accordingly (audio tracks only).

Split/Insert & bind
right Clips (global)

As Split/Insert, but other clips to the right on all tracks are also 
moved accordingly (audio tracks only).
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Replace selected range Only available if there is a selection range on the destination track. 
The clip with the selection range will be split at the selection range 
edges, the inserted clip will replace the range and the section to the 
right of the range is moved to the left or right (depending on the 
length of the inserted clip vs. the length of the selection range), so 
that there is no gap after the inserted clip.

Replace selected range 
(trim source accordingly)

This is only possible if there is a selection range on the destination 
track, and if that selection range is shorter than the range of the clip 
to be inserted. The inserted clip will overwrite the selected range 
only, that is, the range to be inserted will be trimmed according to 
the current selection. 

Replace selected range 
& bind right Clips (track)

As Replace selected range, but other clips to the right on the same 
track are also moved accordingly.

Replace selected range 
& bind right Clips
(global)

As Replace selected range, but other clips to the right on all tracks 
are also moved accordingly.

Overwrite from
cursor

If the inserted clip overlaps any other clips, the overlapped regions 
are removed from the existing clips.

Cancel No clip is added (you can also cancel the insertion by clicking out-
side the pop-up menu).

Option Description
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Multiple clips

When you add several audio clips to the Montage (by importing from disk 
or using drag and drop), the Insert audio files dialog appears. 

In this dialog you can:

• Select files in the list by clicking on them.
• Change the order of the files by clicking the green arrow buttons or by using drag 

and drop in the list.
• Add files to the list by clicking the green plus sign.
• Remove files from the list by clicking the red cross sign.
• Specify how the clips should be inserted.

The dialog contains the following options:

Option Description

Line up on the 
current track

The clips will be added to the Montage, lined up contiguously 
on a single track and spaced according to the default pre-gap 
time (set on the Edit view : Options menu).

Place each file on 
a different track

The clips will be added to the Montage, each on a separate 
track, according to the settings below.

Start inserting 
below current track

If this is activated, the new tracks for the files you add will be 
inserted below the currently selected track. 

Always create 
new tracks

You will probably want to have this activated for most purposes. 
Anytime you add more files to a Montage by using this method, 
this will ensure that they end up on separate tracks.

Shift existing 
clips to the right

If this is activated, any already existing clips in the Montage will 
be moved to the right by an amount equalling the length of the 
first new added file.
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When you insert audio clips, regardless of whether it is a single clip or 
multiple clips, the following options are taken into account:

• Create default fades in new clips (see “Create default fades in new clips” on 
page 459).

• Snap to waveform when crossfading (see “Additional crossfade options” on page 
468).

• Create optimized crossfade when snapping to other clip (see “Moving and snap-
ping to another clip” on page 417).

• Snap to fade-in/out when snapping to other clip (see “Additional crossfade op-
tions” on page 468).

About the auto-grouping options

The Track and Global auto-grouping icons.

There are two auto-grouping options that can be used when inserting 
clips. If any of these auto-grouping options are activated in the Edit view, 
clips to the right of the insertion point will be moved to the right to “make 
room” for the inserted clips.

If you are adding several clips at the same time, these options affect the 
result in the following way:

• If “Track auto-grouping” is activated, clips on the same track, to the right of the in-
sertion point, will be moved to the right to “make room” for the added clips.

• If “Global auto-grouping” is activated, clips on all tracks, to the right of the inser-
tion point, will be moved in the same way.

The auto-grouping options are not taken into account when you add a sin-
gle clip. Instead, you can use one of the “bind right clips” options on the In-
sert options pop-up menu to achieve the same result.
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Zooming and navigating

Horizontal and vertical zoom controls

The zoom “levers” in the upper and lower right corners of the Montage 
window work just like in the Wave windows. 

Note that changing the vertical zoom does not affect the height of the 
tracks. Rather, it affects the vertical magnification of the waveforms within 
each (audio) clip.

Zooming in the ruler

As in the Wave windows, you can adjust the horizontal zoom by clicking in 
the ruler and dragging the pointer up or down with the mouse button 
pressed. Drag up to zoom out and drag down to zoom in.

• If you hold down [Shift] while zooming this way, the Montage cursor posi-
tion isn’t affected.

Changing the height of tracks

The height of the tracks (and thereby the number of tracks displayed in 
the Montage window) is governed by the track magnification controls in 
the lower right corner of the Montage window.

• Click on the large Magnifying Glass icon to “zoom in” – increase the 
height of the tracks.
This is the same as displaying one track less. When only one track is displayed, this icon 
will be greyed out.
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• Click on the small Magnifying Glass icon to “zoom out” – decrease the 
height of the tracks.
This is the same as displaying one track more. When all tracks are visible, this icon will be 
greyed out. Consequentially, if the Montage only contains one track, both Magnifying Glass 
icons will be greyed out.

• You can zoom in on a single track, making it fill the window.
This is done by clicking the numbered button to the left of the track to bring up the track 
pop-up menu, and selecting “Zoom”.

Zooming with the Rubber Band tool

1. Click the magnifying glass icon in the top left corner of the Track View.
The pointer takes on the shape of a “four-way arrow” with a magnifying glass.

2. Click and drag a rectangle in the Track View, to indicate the section you 
want to zoom in on.
When you release the mouse button, the Track View is magnified, so that the section in the 
rectangle fills out the display. Note that the magnified view will include any tracks fully or 
partially enclosed by the rectangle.

Drag a rectangle and release the mouse button…

… and the selection is magnified to fill out the display of the Track View.

3. Deactivate the Rubber Band tool by clicking the icon again, or by right-
clicking anywhere in the Track View.

• It is also possible to temporarily select the Rubber Band tool, by holding 
down [Ctrl] and aiming in an empty area of the Track View (or in a mouse 
zone used for range selection).
See “About the mouse zones (audio tracks only)” on page 408.
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Zooming in on a single audio clip

If you want to study an audio clip in detail, you can zoom in on it so that it 
fills up the track display:

1. Point at the audio clip.
Make sure you don’t aim at an envelope curve.

2. Click with the right mouse button.
The clip speed menu appears, containing various clip-based functions and settings.

3. Select “Zoom”, and from the submenu that appears, “Whole Clip”.
The Track View zooms in on the clip.

Zooming and navigating in the Edit Overview

When the Edit view is selected (by clicking the Edit tab), the upper pane 
shows an Overview of the Montage, with clips displayed as boxes. You 
can use this Overview to zoom in or out, and for navigating to other sec-
tions of the Montage. This is done by moving and resizing the Track View 
rectangle in the Overview:

• The Track View rectangle indicates the section of the Montage currently displayed 
in the Track View.

• You can zoom in or out, vertically or horizontally, by resizing the Track View rectan-
gle.

You can also resize the rectangle horizontally by holding down [Shift] and clicking. This will 
instantly move the closest edge of the rectangle to the clicked position.

The Track View rectangle
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• You can drag the Track View rectangle to view other sections of the Audio Mon-
tage.

• Clicking on one of the clip boxes outside the Track View rectangle will make the 
Track View zoom in horizontally on that clip.
The number of tracks shown will not change.

• Double clicking on one of the clip boxes in the Overview will make the Track View 
zoom in horizontally and vertically on that clip.

• Right-clicking anywhere in the Overview will make the Track View zoom out, so 
that the whole Audio Montage is visible.
The Key Command for this is [J].

• To identify a clip in the Overview, position the pointer over its box.
The name of the clip is displayed.

Moving the Montage cursor

To move the Montage cursor, you can either click at the desired position, 
use the Transport bar or use the computer keyboard.

• You can click in the ruler, in an empty section of the Montage or within a clip (any-
where except in the mouse zone used for copying clips by dragging, and on the 
volume envelope line).
The mouse zone concept is described in the section “About the mouse zones (audio tracks 
only)” on page 408.

• The buttons on the Transport bar work as in the Wave windows.
The Fast Forward and Rewind buttons scroll the playback position forwards or backwards, 
while the start and end buttons move the playback position to the start or end of the Montage.

• The left and right arrow buttons on the computer keyboard can be used to move 
the Montage cursor in finer steps.
If you hold down [Ctrl] and press the left or right arrow button, the Montage cursor will jump 
to the nearest clip edge (start or end position of a clip). It is also possible to move the Cur-
sor by using the Page Up, Page Down, Home and End keys.
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Using snapshots

To make it easy to quickly move between different views and zoom levels, 
you can capture view settings as snapshots, and apply these at any time. 
This is done in the Snapshots view:

The Snapshots view

A snapshot contains the following settings:

• The horizontal and vertical magnification.
• The section (horizontal and vertical) of the Montage currently shown in the Track 

View.
• The Montage cursor position.
• The current selection range (if any).

Capturing the current view

Set up the view as desired, and click the black camera icon, or select 
“Capture current settings” from the Snapshots view : Functions menu. A 
new snapshot is added to the list.

Updating snapshots

You can update an existing snapshot to contain the current settings by 
selecting the snapshot you want to update, and clicking the blue camera 
icon (or by selecting “Update selected snapshot with current settings” 
from the Snapshots view : Functions menu).
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Editing snapshots in the list

You manage the snapshot list and edit the settings using the standard 
WaveLab list editing techniques:

• Hide and show columns using the columns pop-up menu (accessed by clicking 
the arrow button to the left of the list columns).

• Reorder or resize columns by dragging in the headings.
• Sort the snapshots by clicking in a column heading.
• Rename a snapshot by double clicking on its name and typing.
• Edit other values by using regular value editing techniques.

The columns have the following functionality:

Applying a snapshot

1. Make sure the desired checkboxes are activated for the snapshot.
As described in the table above, these govern whether the view, Montage cursor position 
and/or selection range are to be affected when you apply the snapshot.

2. Click the numbered button to the left of the snapshot in the list, or select 
the snapshot and select “Apply selected snapshot” from the Snapshots 
view : Functions menu.

Deleting snapshots

To delete a snapshot, select it and click the trash icon, or select “Delete 
selected snapshot” from the Snapshots view : Functions menu.

Column Description

Name The name of the snapshot.

View When this checkbox is activated, the stored view (zoom factor and visible area) 
is included when you apply the snapshot.

Cursor When this checkbox is activated, the stored Montage cursor position is included 
when you apply the snapshot.

Position The stored position of the Montage cursor.

Selection When this checkbox is activated, the stored selection range is included when 
you apply the snapshot.

From The start position of the selection range.

To The end position of the selection range.

Length The length of the selection range.
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Undoing view and position changes

There is a separate “Undo history” for zoom, view and position changes in 
the Audio Montage. This allows you to undo one or several changes, in 
the following way:

• To undo the latest change to the view, click the green left arrow to the left 
of the Track View ruler (or press [7] on the numeric keypad).
You can repeat this as long as there is any change to undo (as long as the green left arrow 
is lit). This Undo history includes changes to zoom, view and cursor position.

• To redo an undone view change, click the yellow right arrow to the left of 
the Track View ruler (or press [8] on the numeric keypad).

Maximizing the width of the Audio Montage

If you click the double arrow icon at the top left corner of the Track View, 
the Montage window is enlarged horizontally to fill the screen.
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Playing back
Playback in the Audio Montage works in much the same way as in the 
Wave windows. However, there are some extra things to note:

• Audio tracks are normally routed through the Master Section.
This allows you to add global effects to the Audio Montage or use the Render function to 
create a mixdown audio file, separate audio files in case of a multichannel Montage or an in-
termediary Basic Audio CD (see “Mixing down – The Render function” on page 527).
You can also choose to route the audio from a track to the nearest track above (see “About 
the “Upper Track” output option” on page 482), for use with clip effects that allow modulat-
ing audio inputs (such as side-chain compressors, duckers, etc.). 
The routing is done using the “Route to” options on the track pop-up menu.

• The loop settings on the Transport bar apply as in the Wave windows.
If the “Loop Selection” mode is selected, playback will loop within the boundaries of the 
current selection range (see “Selection ranges” on page 413). This selection range may be 
on any track – you can even make a “selection” on an empty track. This vertical position of 
the selection range is of no relevance for loop playback, only the left and right selection 
boundaries matter. 
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Mute and solo

You can mute or solo tracks in the Montage by using the corresponding 
buttons in the Track Control area:

• Note that a track is muted when the green button is dark.
• Note that a track is soloed when the Solo button is blue (lit).
• The Solo buttons are exclusive, that is, solo can only be activated for one track at 

a time.
However, you can manually unmute other tracks when Solo is activated, if you want to listen 
to a combination of tracks.

Muting individual clips

It is also possible to mute a clip:

1. Right-click anywhere on the clip you want to mute (except on the enve-
lope curve).
The clip speed menu appears.

2. Select “Mute” from the menu.
The clip is muted. This is indicated in three ways:

• The clip is shown with another color (by default “greyed out”) when not selected.
• The “M” checkbox in the Clips view is ticked (see “The columns” on page 439).
• The “Mute” item on the clip speed menu is ticked.

• To unmute the clip, bring up the clip speed menu again and uncheck the 
“Mute” item.

• To mute or unmute all selected clips, pull down the Edit view : Select 
menu and select “Mute/Unmute all selected clips”.

It is also possible to mute a selection range within a clip, using the volume 
envelope. This is described in the section “Muting a selected range of a 
clip” on page 451.

Solo Mute
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The track activity indicator

The track activity indicator is located on the right side of the Track Control 
area. This shows the volume level for audio tracks. It is not intended to 
give exact level readings but rather to provide an overview of which tracks 
are currently playing back audio, and at what approximate level.

About the track gain faders

The track gain faders are located to the left of the track activity indicator in 
the Track Control area. They provide a simple way of adjusting the level 
for all clips on an audio track. 

• The track gain is independent from both the volume envelope and the clip 
gain. 

• The track gain can be lowered down to -48 dB, and increased up to 6 dB.
If you change the level by dragging the faders, the fader handles change from grey to red/
blue to indicate that the level is offset from the default 0 dB setting. If you point at the fad-
ers, the current gain setting is shown.

• In the audio chain, the track gain affects the level post any track effects 
and before the Master Section.

• The track activity meter does not reflect the track gain setting, nor is track 
gain reflected in the waveform.

• Press [Shift] and drag a fader handle to change the level for the left or 
right side of a stereo track separately. 
Press [Ctrl] and click on the fader to reset the level to 0 dB.

The track activity indicator
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Playing back individual clips and selections

When editing and rearranging the Audio Montage, it can be useful to au-
dition the individual clips and selections. This is done using the clip speed 
menu:

1. Right-click on the clip you want to play back (make sure you don’t click on 
the envelope curve, as this will open another speed menu – see “Hiding/
Showing volume envelope curves” on page 447).
The clip speed menu appears.

The clip speed menu
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2. Select one of the “Play” items.
“Play clip” plays back the clip you clicked on. 
“Play clip selection” plays back the current selection range only (this is only available if you 
have made a selection in the clip – see “Selection ranges” on page 413). 
“Play (with Pre-roll)” plays back the clip you clicked on, starting slightly before the clip. The 
Pre-roll time is set with the “Playback pre-roll time” parameter in the Preferences–CD Burn-
ing tab.

Playing all tracks within the current selection range

If you have made a selection range (see “Selection ranges” on page 413), 
you have the possibility to play back this range only. This is a quick way to 
listen to a short section of an Audio Montage:

1. Drag with the mouse to create the selection range, either in a clip or in an 
empty section of a track.

2. Right-click in the ruler.
The ruler pop-up menu appears.

3. Select “Play selection” from the pop-up menu, or press [F6].
All unmuted audio within the selection range is played back.

When you use this playback method, the loop settings on the Transport bar 
are disregarded. To play back the selection in a loop, press [Shift]-[F6].
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Using the Shuttle function

As described in the section “Using the Jog/Shuttle function” on page 143, 
the Shuttle function can be viewed as playing back with a continuous con-
trol for tape speed and direction. This works in the same way in the Audio 
Montage as in the Wave windows:

1. Activate the Jog/Shuttle button on the Transport bar (or press [F10]).
A vertical line is displayed in the middle of the Audio Montage window and the pointer takes 
on the shape of a speaker.

2. Click and hold the mouse button to the left or right of the vertical line.
Clicking to the left of the line will play back the audio backwards and clicking to the right will 
play the audio forwards. The playback speed is determined by the distance from the line to the 
pointer, so that the further away from the line you move the pointer, the faster the playback.

• The playback speed is indicated in the info line.
“1.00” is normal playback speed. Negative values indicate reverse playback.

3. Release the mouse button to stop playback.

Remember to deactivate the Jog/Shuttle button on the Transport bar when 
finished (by clicking the button, pressing [F10] or using Stop).

• You can also control Shuttle via a MIDI pitch bend wheel.
See “Using a MIDI pitch bend wheel to control Shuttle” on page 144.

Using the Jog function

As described in the section “Using the Jog/Shuttle function” on page 143, 
the Jog function can be viewed as dragging the audio past a “playback 
point”, much like dragging a reel-to-reel tape past the playback head. This 
is done in a different way than in the Wave window:

1. Click the Jog/Shuttle button on the Transport bar or press [F10].
A vertical line appears in the middle of the Audio Montage window. This is the “playback 
point”. Furthermore, the area above the ruler turns purple.

2. Point in the purple area above the ruler.
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3. Click and drag to the left or right to drag the audio past the playback point.
The audio is played back, forwards (if you drag the audio to the left) or backwards (if you 
drag to the right), at the speed with which you drag.

Remember to deactivate the Jog/Shuttle button on the Transport bar when 
finished (by clicking the button, pressing [F10] or using Stop).

Playing back from the ruler

You can use the ruler to quickly locate to a position and start playback 
from there:

• Double clicking in the ruler starts playback from that position.
Playback continues until you press Stop (or until the end of the Montage).

• If you double click in the ruler and keep the mouse button pressed, play-
back will start from that position and stop when you release the mouse 
button.
After stopping, the Montage cursor will return to the position where you clicked. This is a 
handy way to quickly locate and audition positions in the Montage.

• If you single click in the ruler during playback, playback will immediately 
jump to that position.
This even allows you to “jump” between different document windows.
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Recording

If you have an audio card with multiple inputs and an ASIO driver you can 
record up to 8 channels simultaneously. For a description on how to set up 
and record multiple channels, see “Multichannel recording” on page 521.

It is possible to record audio and have it appear directly as a clip in the 
Audio Montage. There are several ways to do this:

By using the track pop-up menu

1. Move the Montage cursor to the position where you want the recorded 
clip to appear. 

2. Select Record at cursor from the track pop-up menu for the desired track.
The Record dialog appears. The option “Add to selected track of Montage” is automatically 
activated, and stereo or mono is automatically selected depending on the selected track.

3. Proceed as when recording into a Wave window.
When you finish recording, a clip is created at the cursor position.

By using the track pop-up menu during playback

1. Start playback.

2. Select Record at cursor from the track pop-up menu for the desired track.
The Record dialog appears as in the previous example.

3. Make settings as when recording into a Wave window.

4. Activate recording.
The clip will be inserted at the position where the Montage cursor was the moment you ac-
tivated recording. If you first go into Pause mode and then activate recording, you will get a 
“pre-roll” time according to the Pause buffer, allowing you to capture the audio just before 
you start recording.



WAVELAB
The Audio Montage 19 – 407

By using the Record button

1. Select a track by clicking in its Track Control area.

2. If you like, activate playback.

3. Click the Record button on the Transport bar or press [*] on the numeric 
keypad.
The Record dialog appears.

4. Make sure the checkbox “Add to selected track of Montage” is activated.

5. Proceed as when recording into a Wave window.
When you finish recording, a clip is created at the cursor position, or if playback was acti-
vated, at the position where the Montage cursor was the moment you activated recording.

Things to note

• Make sure you select a stereo track if you want to do a stereo recording and 
vice versa.

• If “Temporary File” is selected when you record, the clip will refer to an un-
titled, unsaved “invisible” file. 
If you try to save a Montage with references to temporary files, WaveLab will ask you to 
save these files (since the program needs to know the file names, for proper reference).

About playing back during recording

When you record in a multi-track environment, it is often desirable to have 
the existing tracks play back during recording, performing an “overdub”. 
For this to be possible in the Montage, the following requirements must 
be met:

• Your audio card must support Full Duplex operation (MME/WMA drivers only).
This means that the card must allow simultaneous recording and playback. Consult the 
documentation for the audio card if you are uncertain. ASIO drivers always allow simulta-
neous recording and playback.

• The option “Stop playback when metering or recording” must be deactivated in 
the Record Settings dialog.
If it is activated, you will be asked whether you want WaveLab to turn it off for you before 
starting recording.
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About monitoring the recorded signal

WaveLab in itself does not handle monitoring (routing the input signal 
back to the output) during recording. If you want to hear the signal you are 
recording, there are two ways to achieve this:

• Use an external mixer.
Normally, you connect your audio input sources (and the audio card’s outputs) to the 
mixer’s inputs, connect the mixer’s main outs to the monitoring equipment and use a send 
or bus to send the desired channels to the audio card’s inputs for recording. This is neces-
sary to avoid including background tracks in the recorded signal.

• Use the audio card’s mixer application.
Many audio cards allow you to route the input signal back to the outputs. Consult the doc-
umentation of the audio card for details.

Rearranging clips

About the mouse zones (audio tracks only)

Basic rearranging of clips in the Audio Montage is done by clicking and 
dragging with the mouse. However, the results of dragging with the mouse 
depend on where in the clip you click. The different areas in a clip are called 
mouse zones.

By default, the mouse zones have the following basic functionalities: 

Mouse zone Description

Top clip area Copy clip by dragging (see “Duplicating clips” on page 419).

Upper clip area Make a selection range (see “Selection ranges” on page 413).

Lower clip area and
Bottom clip area

Select clips and move clips by dragging (see “Selecting clips” on 
page 411 and “Moving clips” on page 415).

Upper and lower 
clip edges

Resize clips by dragging the edges (keeping the audio source “static” 
– see “Resizing clips” on page 422).

Top clip area Upper clip area

Lower clip areaBottom clip area

Upper clip edge

Lower clip edge

Upper clip edge

Lower clip edge
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As you see, some mouse zones have the same default functionality. You 
can change this if you like, using the Mouse zones submenu on the Edit 
view : Options menu.

• When you move the pointer over a mouse zone, the info line indicates the 
corresponding action(s).
As described in the section “Info line symbols” on page 376, this also indicates whether 
you can perform additional functions by holding down modifier keys.

Magnetic bounds

When you move and edit clips, it is often useful to have them snap to other 
clips as well as to significant positions in the Montage. To facilitate this, you 
can specify that certain positions should be “magnetic”. 

This is done using the Magnetic bounds submenu on the Edit view : Op-
tions menu.
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Activating Snap

Having set up the desired Magnetic bounds options, you activate the 
Snap function by clicking the “Enable snapping” icon in the Edit view (or 
by pressing [N] on the computer keyboard).

Now, when you move or resize a clip and its edges (or its cue point) get 
close to one of the Magnetic positions, two things happen:

• The clip snaps to the magnetic position.

Option Description

Start of Audio Montage The start of the Audio Montage.

Clip’s cue-point A position within a clip that you set using the clip speed menu 
(see “Using cue points” on page 428).

Clip’s head The start of a clip.

Clip’s tail The end of a clip.

Time units The time units displayed in the ruler (the same as the positions of 
the grid lines when the time grid is activated). The coarseness of 
these units is determined by horizontal magnification. For details 
about the ruler and the grid, see “The ruler” on page 377.

Audio Montage markers Markers in the Audio Montage window (see “Using markers in 
the Montage” on page 492).

Markers in audio source Markers in the clips’ original audio files (see “Using markers in 
the Montage” on page 492).

Selection Edges The start and end of a selected range in the Audio Montage.

Cursor The Montage cursor position.



WAVELAB
The Audio Montage 19 – 411

• A label is displayed, indicating what the clip snaps to.

To deactivate Snap, click the icon again or press [N].

Selecting clips

To select a clip (for copying, deletion, etc.), click in the mouse zone to 
which “Select/Move clip” is assigned (by default the bottom clip area).

Selected clips are normally displayed in a different color. You can edit this color, as 
described in the section “Defining custom colors” on page 740.

• You can select multiple clips by [Ctrl]-clicking.
This works in the same way as selecting multiple objects in other Windows programs.

• Holding down [Shift] and clicking allows you to select a range of consec-
utive clips (on the same track).
Again, this is similar to how you select ranges of objects in other Windows programs. Don’t 
confuse this with making a “selection range”, see “Selection ranges” on page 413.
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• If you hold down [Ctrl] and [Shift], you can click and drag a selection rect-
angle to select several clips on several tracks.
All clips touched or enclosed by the rectangle are selected.

When you hold down [Ctrl] and [Shift], the cursor takes on the shape of a “selection 
arrow”.

Using the Select menu

The Edit view : Select menu holds several items for selecting clips:

Option Description

Select all clips Selects all clips in the Montage.

Select clips of
selected track

Selects all clips on the selected track (the track with the high-
lighted Track Control area).

Select all clips included in 
the selection (on all tracks)

Selects all clips fully encompassed by a selection range, on all 
tracks.

Select all clips at left of 
cursor (selected track)

Selects all clips with the endpoint to the left of the Montage 
cursor, on the selected track.

Select all clips at left of 
cursor (all tracks)

Selects all clips with the endpoint to the left of the Montage 
cursor, on all tracks.
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About selected and focused clips

The program makes a distinction between selected and focused clips:

• A selected clip is a clip you have selected using the any of the procedures 
described above.
Several clips can be selected at the same time.

• The focused clip is the clip you selected (or clicked, or edited) last.
Only one clip can be focused at a time. By default, the focused clip is distinguished by a 
highlighted name label:

Clicking on the selected clip to the right makes it the focused clip.

Selection ranges

A selection range is a selected area on a track. The selection range may 
be entirely or partially within a clip, or in an empty section of the track. 
There are several uses for selection ranges:

• You can edit clips using selection ranges. This involves cutting or erasing the se-
lection, or trimming the clip to contain only the selection (see “Resizing by trim-
ming” on page 424).

• You can create a new clip by dragging the selection range to another track.

Select all clips at right of 
cursor (selected track)

Selects all clips that start to the right of the Montage cursor, on 
the selected track.

Select all clips at right of 
cursor (all tracks)

Selects all clips that start to the right of the Montage cursor, on 
all tracks.

Inverse Selection Deselects all currently selected clips and selects all other clips 
in the Montage.

Deselect clips Deselects the currently selected clips.

Lock/Unlock all selected 
clips

Locks all selected clips (or unlocks them, if they are locked). 
See “Unlocking a locked clip” on page 428.

Mute/Unmute all selected 
clips

Mutes all selected clips (or unmutes them, if they are muted). 
See “Muting individual clips” on page 400.

Option Description
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• You can open a Wave window with the range selected in the source audio file, by 
dragging the selection range to the WaveLab desktop.

• You can play back the selection range only, either the whole Montage or just the 
clip with the selection range (see “Playing back individual clips and selections” on 
page 402).

• You can have the playback loop within the selection, by activating the loop and 
selecting the “Loop Selection” mode on the Transport bar.

To create a selection range, proceed as follows:

• Creating a selection range in an empty area on a track is done by clicking 
and dragging with the mouse as when selecting audio in the Wave win-
dows.

• Creating a selection range within a clip is done in the same way, but the 
pointer must be in the mouse zone to which you have assigned the “Se-
lect range” function (by default the upper clip area).

When the pointer is in the “select range” mouse zone, it takes on the “Selection tool” 
shape.

• When you drag the mouse to create the selection range, the start and end 
position and the length of the range are displayed in the info line.

• If you double click in the selection range mouse zone, a selection range is 
automatically created, spanning the entire clip or the area between the 
closest markers (if there are any).
In the latter case, triple clicking will expand the selection range to the entire clip. Further-
more, if you double click and keep the mouse button pressed, you can drag the mouse to 
expand the selection range in “blocks” (clips or marker areas).

• You can resize a selection range by [Shift]-clicking or dragging its edges, 
as in the Wave windows.

• As in the Wave windows, you can toggle the selection range on and off 
by pressing [Esc].

• To remove (deactivate) a selection range, click elsewhere in the Montage.
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Moving clips

To move a clip, proceed as follows:

1. If you want to move more than one clip, you need to select these clips first.

2. Position the pointer over the clip, in the mouse zone to which you have as-
signed the “Select/Move clip” function (by default the lower clip area).
The pointer takes on the shape of a “four-way arrow”.

3. Click and drag the clip(s) in any direction.
When you are moving the clip(s), the info line displays the current start position of the clip 
you are dragging.

• The clip(s) will snap to any activated magnetic bounds, see “Magnetic 
bounds” on page 409.

• If you move clips sideways, the auto-grouping settings are taken into ac-
count, as described below.
If you move the clip over another track, auto-grouping is temporarily disabled until you re-
lease the mouse button.

• If you click on a clip, keep the mouse button pressed and then press 
[Shift], movement is restricted to vertical.
This is useful if you want to move a clip to another track without accidentally changing its 
horizontal position.

• You cannot move mono clips to stereo tracks or vice versa.
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Moving with auto-grouping

There are four options on the Edit view : Options menu that affect the re-
sult when you move clips horizontally: Track auto-grouping, Global auto-
grouping, Clip auto-grouping (same track) and Clip auto-grouping (all 
tracks). There are also separate icons for these options on the toolbar in 
Edit view mode:

• If Track auto-grouping is activated when you move a clip sideways, all clips to the 
right of it on the destination track will be moved by the same amount.

• If Global auto-grouping is activated when you move a clip sideways, all clips to 
the right of it in the whole Audio Montage will be moved accordingly.

• If Clip auto-grouping (same track) is activated when you move a clip sideways, all 
overlapping clips or clips where the clip edges are connected side by side on that 
track will also be moved.

• If Clip auto-grouping (all tracks) is activated when you move a clip sideways, all 
vertically or horizontally connected clips in the Montage will be moved.

Here, Clip auto-grouping (all tracks) is activated. If you move the selected clip sideways…

Track auto-grouping Global auto-grouping

Clip auto-group-
ing (same track)

Clip auto-grouping 
(all tracks)
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…all clips that are “connected” vertically or horizontally will also be moved.

Moving and snapping to another clip

If you line up clips so that one clip ends exactly where the next one starts 
(for example by using Magnetic bounds), the waveforms at the intersection 
point will probably not “match”. Instead, there could be an abrupt “jump” in 
level, which can give rise to audio artefacts such as pops and clicks.

To remedy this, activate the option “Create optimized crossfade when 
snapping to other Clip” on the Edit view : Fade menu (or click the corre-
sponding icon).

The “Create optimized crossfade when snapping to other clip” icon

When this is activated and you move a clip so that its start snaps to the 
end of another clip, the following happens:

1. WaveLab scans the waveforms of the clips within a short range, and at-
tempts to find the position where the waveforms of the two clips best 
match.
This is the same automatic phase matching as in the Zoom view (see “The Zoom view” on 
page 433). You can specify how far into the clips the program should scan, by selecting a 
Search range on the Zoom view : Options menu.

2. The position of the clip you moved is adjusted slightly, to achieve the best 
possible match between the waveforms.
This creates a short crossfade. For details about crossfades, see “Using crossfades” on 
page 462.

Note that this function only applies when moving “from right to left”, i.e. 
snapping the start of the moved clip to the end of the clip to the left.
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About overlapping clips

You can move clips so that they overlap each other on the same track. 
Please note:

• The tracks in the Audio Montage are polyphonic, which means that each track 
can play back several overlapping clips at the same time. 
Overlapping clips will be transparent, allowing you to see the underlying clips and their 
waveforms.

• To select an overlapped (underlying) clip, double click in the mouse zone to which 
“Select/Move clip” is assigned (by default the bottom clip area).

• There are automatic crossfading options that automatically adjust the volume en-
velope curves when you overlap clips.
This is described in the section “Using crossfades” on page 462.

Move selected clips to their related BWF time stamp

If a clip is referenced to a Broadcast wave file containing time code infor-
mation, you can select to move the clip to the position contained in the 
source file. This can be useful if you have imported Broadcast Wave files 
from another application that contain time stamp information embedded 
in the files.

• Select all clips that you wish to move in this way, and then select “Move 
selected clips to their related BWF time stamp” on the Clips view : Func-
tions menu. 
All clips will be moved according to the time positions embedded in the source file.

Update BWF time stamps (selected clips)

This is related to the preceding item, and can be used to update the time 
stamp information in the source file if you have moved the clips.

• If you select this option you need to resave the source file to store the 
changes.
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Duplicating clips

To make a copy of a clip, proceed as follows:

1. If you want to copy more than one clip, you need to select these clips first.

2. Position the pointer over the clip, in the mouse zone to which you have as-
signed the “Drag/Copy clip” function (by default the top clip area).

3. Click and drag the clip(s) in any direction.
While you are dragging the clip(s), a dotted line indicates where the first of the copied clips 
will end up. The position is also indicated on the info line (see “The info line” on page 375).

4. Release the mouse button.
If you dragged a single clip, the Insert options pop-up menu appears (see “The Insert options” 
on page 388). Select one of the options to insert the duplicate of the clip. If you dragged more 
than one clip, the duplicates are inserted, taking the auto-grouping settings into account, as 
described below.

• The clip(s) will snap to any activated magnetic bounds, see “Magnetic 
bounds” on page 409.

• You cannot copy mono clips to stereo tracks or vice versa.

• You can also duplicate a whole track, including all its clips, by selecting 
Clone track from the track pop-up menu.

Duplicating with auto-grouping

If you are copying more than one clip at the same time, two of the auto-
grouping settings in the Edit view affect the result (see “Moving with auto-
grouping” on page 416):

• If Track auto-grouping is activated when you duplicate clips, all clips on 
the destination track, to the right of the new copy, will be moved to the 
right, to “make room” for the new clips.

• If Global auto-grouping is activated when you duplicate clips, all clips to 
the right of the new copy in the whole Audio Montage will be moved to 
the right in the same way.
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Repeating clips

1. If you don’t know the exact number of copies (clones) needed, but know 
roughly where you want the last clip in the row to be positioned, move the 
Montage cursor there.

2. Right-click on the clip to bring up the clip speed menu.

3. Select “Repeat clip…”.
The Repeat clip dialog appears.

4. Either select the “Count” option and specify an exact number of clones, or 
select the “Repeat until cursor” option.

5. Select one of the Placement options:

6. Click OK.
The copies are created. If you chose the “Repeat until cursor” option, the last clip will start 
to the left of the Montage cursor.

Option Description

Place clips one after 
the other

Lines up the copies after the clip, spaced according to the “Gap 
between clips” setting.

Place every… Allows you to position the copies according to a time interval. You 
cannot specify times shorter than the length of the clip (i.e. it is not 
possible to have the clips overlap each other).

Align with clips of 
focused track

When this option is selected, the copies will be positioned accord-
ing to the clips on the focused track (the track with the highlighted 
Track Control area). 
If you specify an Offset value, the copied clips will be positioned at 
the starting position of the clips on the focused track + the Offset.
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Dragging selections to create new clips

If you have made a selection range in a clip, you can copy this to a new 
clip, in the following way:

1. Create the selection range, see “Selection ranges” on page 413.

If the selection range covers more than one clip, only the section belonging 
to the focused clip will be copied!

2. Position the pointer over the selection, in the mouse zone to which you 
have assigned the “Select range” function (by default the upper clip area).

3. Drag the selection to the desired position.
When you are dragging, the position of the pointer is displayed on the info line. Magnetic 
bounds apply, as when duplicating clips.

4. Release the mouse button.
The Insert options pop-up menu appears (see “The Insert options” on page 388). Select 
one of the options to insert the new clip.

Envelopes and effects will not be included when you copy selection ranges.
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Resizing clips

In this context, “resizing” usually means moving the start and end points of 
a clip, so that more or less of the original audio file is “revealed”. However, 
in the Audio Montage there are two ways of doing this: with the audio 
source “static” or “tied”. These two methods are explained below. 

As with other clip operations, the mouse zones determine which function 
is used, and the pointer changes shape to indicate the current function.

The “Resize clips” pointers for static and tied audio sources, respectively.

Resize clips (static audio source)

This is the traditional way of resizing clips, you move the start or end point 
to the left or to the right:

1. Point at the left or right edge of the clip.
By default, it doesn’t matter whether you click in the upper or lower half of the edge, but it 
is possible to select either half for the alternate resize method, as described below.

2. Click and drag to the right or left.
The start and end positions and length of the clip are displayed on the info line while you are 
dragging.

• You cannot drag the edge of a clip past the start or end point of the audio file it 
refers to.

• The clip edges will snap to any activated magnetic bounds, as described in the 
section “Magnetic bounds” on page 409.

• When you drag the right edge of a clip this way, the auto-grouping settings on the 
Edit view : Options menu are taken into account.
As when copying clips, this means that if Track auto-grouping is activated, all the following 
clips on the track will be moved when you resize the clip (so that the distance between the 
clip’s right edge and the next clip on the track remains the same).
If Global auto-grouping is activated, the same is true, but for clips on all tracks in the Audio 
Montage.
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Resize clips (tied audio source)

When you resize a clip using this method, the audio source is “tied” to the 
edge you are moving. This means that the audio is “scrolled” at the other 
edge of the clip, as in the picture below.

1. Point at the left or right edge of the clip, and press [Ctrl].

2. Click and drag to the right or left.
The start and end positions and length of the clip are displayed on the info line while you are 
dragging.

In this example, the right edge of the clip is moved to the right. As a result, the start point 
of the clip will refer to an earlier position in the audio file.

• Magnetic bounds and the auto-grouping options apply as when resizing 
with static audio source.

• It is also possible to assign either the upper of lower half of the clip edge 
to this alternate resize method. 
This is done on the Edit view : Options menu, by selecting “Resize clip (tied audio source)” 
for the upper or lower clip edges on the Mouse zones submenu. In this case, you don’t need 
to press [Ctrl] in step one above, but you must take care to aim at the desired mouse zone 
(upper or lower) when you resize the clip.

Resize clips (tied audio source) selected for the lower half of the clip edges.

Resizing all selected clips

• If you press [Alt] when resizing, all selected clips will be resized by the 
same amount.
To resize multiple selected clips using tied audio sources press [Alt] + [Ctrl] (unless you 
have assigned a mouse zone for this).
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Resizing by trimming

If you need to remove unnecessary material at the beginning and end of a 
clip, this can be quickly done by trimming:

1. Make a selection range within the clip (see “Selection ranges” on page 
413), encompassing the audio material you want to keep in the clip.

2. Right-click to open the clip speed menu.

3. Select Trim to selection.
The clip is resized to contain only the selected audio.

Sliding the audio in a clip

If you want to adjust the position in the audio file to which the clip refers, 
you can do this by “sliding” the audio within the clip, without resizing it:

1. Position the pointer over the clip, in the mouse zone to which you have as-
signed the “Select/Move clip” function (by default the lower or bottom 
clip area).

2. Press [Ctrl] and [Alt].
The pointer takes on the shape of a double arrow.

3. Drag left or right to slide the audio source.

• It is also possible to assign a separate mouse zone to this function. 
This is done on the Edit view : Options menu, by selecting “Slide audio source” for the de-
sired zone on the Mouse zones submenu. In this case, you don’t need to press [Ctrl]-[Alt] in 
step two above. Be careful not to slide the audio by accident, though.
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Moving a clip with the audio source fixed

This is the opposite of sliding the audio: this function moves the clip in the 
Montage, but the audio source remains fixed in position:

1. Position the pointer over the clip, in the mouse zone to which you have as-
signed the “Select/Move clip” function (by default the lower or bottom 
clip area).

2. Press [Shift] and [Alt].
The pointer takes on the shape of a box with arrows.

3. Drag left or right to move the clip, “revealing” other sections of the “un-
derlying” audio source.

• It is also possible to assign a separate mouse zone to this function. 
This is done on the Edit view : Options menu, by selecting “Move clip – source remains 
fixed” for the desired zone on the Mouse zones submenu. In this case, you don’t need to 
press [Shift]-[Alt] in step two above.

Splitting a clip

You can split a clip in two, using the following method:

1. Set the Montage cursor to the position at which you want to split the clip.

2. Position the pointer over the clip, in a mouse zone for which you have ac-
tivated the “Split at cursor with a double click” function (by default the top 
clip area).
The cursor takes on the shape of a pair of scissors.

3. Double click.
The clip is split in two. The two clips will have the same name and settings. Envelopes and 
fades (see “The volume envelope” on page 445) are converted, so that the two clips play 
back as before.
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• If the options “Create default fades in new clips” is activated on the Edit 
view : Fade menu, a crossfade is automatically created between the re-
sulting left and right clip.

• You can also split a clip by setting the Montage cursor and selecting 
“Split at Cursor” from the clip speed menu, or by pressing [S] on the com-
puter keyboard (in which case the focused clip is split).

Cutting and erasing sections of a clip

You can cut or erase a selection range within a clip, by using the func-
tions “Cut selection” or “Erase selection” on the clip speed menu, or by 
selecting Delete or Erase selected range from the main Edit menu.

Cutting

If you select “Cut selection” (or Delete on the main Edit menu), the se-
lected range is removed, and the right section of the clip is moved to the 
left, to fill out the gap.

• If any of the automatic crossfading modes or the option “Create default 
fades in new clips” are activated on the Edit view : Fade menu, a default 
crossfade is created between the resulting two clips, ensuring a click-
free, clean transition.
Furthermore, if “Snap to waveform when crossfading” or “Create optimized crossfade when 
snapping to other clip” are activated on the Edit view : Fade menu, the position of the right 
clip will be adjusted for the best possible phase match between the clips (see “Moving and 
snapping to another clip” on page 417).

• The auto-grouping settings in the Edit mode are taken into account.
This means that the following clips (on the same track or on all tracks) may be moved to the 
left, depending on the auto-grouping settings.
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Erasing

Selecting “Erase selection” removes the selected range, resulting in two 
clips with a gap between them.

• If “Create default fades in new clips” is activated on the Edit view : Fade 
menu, a default fade-in is created for the right clip, and a default fade-out 
for the left clip.

Deleting clips

There are two principal ways to delete a clip:

• Right-click on the clip to bring up the clip speed menu, and select “Delete 
clip”.

• Select it, and press [Backspace].
Instead of using [Backspace], you can press the [Delete] key or select “Delete” from the 
main Edit menu.

Make sure there is no selection range before deleting – otherwise the range 
will be deleted instead of the clip. To ensure there is no selection range, 
press [Esc].

Locking clips

Sometimes it’s useful to lock a clip (or several selected clips), to prevent 
you from accidentally moving, editing or deleting it. This is done by select-
ing “Lock” from the clip speed menu.

This clip is locked. This is indicated by the mouse pointer taking on the shape of a lock 
symbol, whenever you move it over the clip. The default color for locked clips is green, 
but you can change this if you like (see “The color elements” on page 742).
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Unlocking a locked clip

There are three ways to unlock a locked clip:

• Click on the clip, and click “Yes” when asked whether you want to remove the lock.
• Uncheck the checkbox in the Lock column in the Clips view (see “The columns” 

on page 439).
• Deactivate the Lock item on the clip speed menu.

• To lock or unlock several clips in one go, select the clips and select 
“Lock/Unlock all selected clips” from the Edit view : Select menu.
To be able to select locked clips, you need to use a selection rectangle (by pressing [Ctrl] 
and [Shift] and dragging with the mouse).

Using cue points

A cue point is a defined position marker that belongs to a clip. It may be 
positioned within or outside the clip. Cue points are displayed as dotted 
vertical lines.

A cue point

When you move a clip, its cue point will be magnetic to any edges, mark-
ers or positions activated on the Magnetic bounds menu (see “Magnetic 
bounds” on page 409). There are several uses for this:

• Set the cue point at a “relevant” position in the audio and use it to align the clip 
with other clips, etc.

• Set the cue point before the start of a clip, allowing you to position clips in a row 
with pre-defined spaces (by magnetizing the cue point to the end of the previous 
clip).

• Set the cue point at the fade-in or fade-out point of a clip, making it easy to maintain 
defined fade lengths when crossfading (see “Using crossfades” on page 462).
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To set the cue point for a clip, proceed as follows:

1. If you want to set the cue point at an arbitrary position, move the Montage 
cursor to that position.
This may be within the clip or outside it.

2. Right-click on the clip to bring up the clip speed menu.

3. Open the Cue point submenu.

4. Select one of the functions on the submenu:

Each clip can only have one cue point. This means that if you repeat the 
procedure above and select another option on the submenu, the cue point 
will be moved to a new position.

Option Description

Set at cursor Sets the cue point at the current Montage cursor position.

Follows fade-in 
end point

Sets the cue point at the clip’s fade-in junction point (the left purple han-
dle in the volume envelope). The cue point will follow the handle if you 
move it. See “Editing fades” on page 457.

Follows fade-out 
start point

As the previous option, but for the fade-out start point.

Set at default 
pregap position

Sets the cue point before the start of the clip, at a distance governed by 
the default pre-gap position (set on the Edit view : Options menu).
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Nudging

The Audio Montage window has a special function for making fine adjust-
ments, or “nudging”. The Nudge function is not restricted to the position 
of clips; it can be applied to a number of objects and properties in the 
Track View.

Basic procedure

1. If necessary, select the object(s) you want to nudge.
For example, if you want to adjust the position of a clip, or any property such as left/right 
edge, fade-in/fade-out length, etc., you need to select the clip.

2. Pull down the Edit view : Options menu and bring up the Nudge submenu.

3. Select the element or property you want to nudge, from the lower part of 
the submenu.
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4. Click the Nudge icons to nudge the selected element, or use the com-
puter keys [F11] (Nudge –) or [F12] (Nudge +).
Each time you click the icon or press the corresponding key, the element will be nudged by 
a defined amount (see below).

The Nudge icons. The tool tips for the icons indicate which element is currently selected 
for nudging.

• By holding down modifier keys when you click the icon or press the key, 
you can nudge the element by smaller or larger amounts.
The modifier keys have the following functionality:

• Generally, the magnetic bounds are not used when nudging.
That is, the nudged elements will not snap to other positions, but can be moved freely. The 
exception is “Snap to waveform when crossfading” for nudged clips, see below.

Setting the default nudge impulse

To define the default nudge impulse (the amount with which elements are 
adjusted when you nudge them), proceed as follows:

1. Bring up the Nudge submenu from the Edit view : Options menu.

2. Select “Define impulse…”.
The Impulse Value dialog appears.

3. Specify the default impulse time in the Time field.
This is used for nudging the position of objects or edges.

4. Specify the default impulse level in the Level field.
This is used for nudging volume.

5. Click OK to close the dialog.

• The Large, Small and Micro impulses are relative to the default value.

The default impulse settings are not used when nudging Syncro offset 
(SMPTE). See “Nudging sync offset” on page 654.

[Shift] Large impulse (10 x the default amount)

[Ctrl] Small impulse (1/10 of the default amount)

[Ctrl]+[Shift] Micro impulse (1/100 of the default amount)
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The nudgable elements

The following elements and properties can be nudged:

• Clip position.
This moves all selected clips. 

If the option “Snap to waveform when crossfading” is activated on the Edit 
view : Fade menu, and the focused clip (if any, see “About selected and fo-
cused clips” on page 413) is moved to the left so that it overlaps another 
clip, the nudged clip will be time-adjusted slightly to match the waveform in 
the left clip. This option is described in the section “Snap to waveform when 
crossfading” on page 468.

• Clip’s left or right edge.
This is the same as resizing the clip, in “static audio source” mode (see “Resize clips (static 
audio source)” on page 422).

• Clip’s fade-in or fade-out.
Moves the fade-in/fade-out junction point (see “Creating fades” on page 457). If the enve-
lope is a stereo envelope, both sides will be adjusted.

• Clip’s crossfade.
For this to work, you have to select the second clip (the one to the right) in a crossfade pair. 
Nudging will make the crossfade zone narrower or wider, by moving the junction points of 
both clips in the crossfade. For details about crossfades, see “Using crossfades” on page 
462.

• Cursor.
Moves the Montage cursor.

• Selected range left/right.
Moves the left or right edge of a selection range.

• Current marker.
Moves the currently selected Montage marker. To select a marker, click on it in the area 
above the ruler.

• Pan of focused clip.
Adjusts the Pan of the focused clip. Nudge+ pans to the left and Nudge– to the right. 

• Pan of all selected clips.
As above, but affects all selected clips.

• Surround Pan of focused clip
Adjusts the Pan of the focused clip. Nudge+ pans to the left and Nudge– to the right (alter-
natively front to back – depending on the selected surround pan envelope). 

• Surround Pan of all selected clips
As above, but affects all selected clips.
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• Volume of focused clip.
Adjusts the volume of the focused clip, in steps according to the Level setting in the Im-
pulse value dialog.

• Volume of all selected clips.
As above, but affects all selected clips.

• Synchro offset (SMPTE).
This is used when synchronizing WaveLab to external equipment. See “Nudging sync off-
set” on page 654.

Using Auto-Select

If the Auto-Select option on the Nudge submenu is activated, WaveLab 
attempts to automatically select what should be Nudged, depending on 
your last action in the Track View. If your last action was to select or move 
a clip, the “Clip position” option is automatically selected on the Nudge 
submenu, if you adjusted the volume, the “Volume of focused Clip” option 
will be selected, etc. In most cases, this allows you to use the Nudge fea-
ture without having to manually select Nudge elements on the submenu.

The Zoom view
When the Zoom view is selected (by clicking the Zoom tab), the upper 
pane displays a close-up view of the beginning of the selected clip. The 
main purpose of this is to help you splice two consecutive clips together 
(in which case the Zoom view will display the end of the left clip and the 
start of the right clip, as in the picture below). This splicing is done by ap-
plying short crossfades. 

To make things clear, there are two main “types” of crossfades:

• The “artistic” crossfades, for example when you want to crossfade two songs to 
make a nice transition.
Usually, these types of crossfades are quite long, and can easily be created from the Track 
View.
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• The “patch” crossfades, for example when you want to replace a section of audio, 
and want this to be done as transparently as possible, without any audible discon-
tinuity in the resulting audio.
In these cases, it is necessary to make the crossfades as short as possible. These types of 
crossfades are best created in the Zoom view.

The Zoom view helps you create very short crossfades, automatically 
matching the phase of the two clips, hence minimizing harmonic cancella-
tions. This method, though more CPU demanding, is far superior to the 
common method of just finding zero crossing points.

To splice two clips together in the Zoom view, proceed as follows:

1. In the Track View, move the two clips together end-to-start.

2. Make sure the clip to the right is focused.

3. Click the Zoom tab to display the Zoom view.
This shows a close-up of the two clips. 

Note that the Zoom view is centered around the start point of the right clip! 
This means that if you move the right clip in the Track View, the left clip will 
appear to be moving in the Zoom view.

4. Set the zoom factor using the icons above the display, or the correspond-
ing options on the Zoom view : Options menu.
In the finest mode (1:1), each pixel on screen corresponds to one sample. In the 1:8 mode, 
there are eight samples per pixel.

• If you activate Automatic level zooming on the Zoom view : Options menu, 
the waveforms are automatically zoomed vertically to fill out the Overview.
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5. If necessary, you can move or resize the right clip in the Zoom view.
Resizing is done exactly as in the Track View, with the audio source “static” or “tied” (see 
“Resizing clips” on page 422). Moving is done by clicking and dragging anywhere within 
the clip (the mouse zones within the clip are not used in the Zoom view).

6. Select a search range from the Zoom view : Options menu.
This determines how far into the clips the program will scan when searching for the best 
possible phase match. Higher values result in greater accuracy, but also longer processing 
times, since this is a very CPU intensive process.

If the sounds contain a lot of bass, you should avoid the shortest search 
range setting (5-10 ms).

7. Select “Move to left (match waveform)” from the Zoom view : Options 
menu (or click the icon with the left arrow, next to the menu).
WaveLab will now scan the audio to the left of the splice point and move the right clip to the 
position which provides the best possible phase match, to avoid harmonic cancellation. 
When the right clip is moved over the left clip, a short crossfade is automatically created.

For more information about crossfades, see “Using crossfades” on page 462.

• Selecting the function “Move to right (match waveform)” from the Zoom 
view : Options menu (or clicking the icon with the right arrow) does the 
same thing, but moves the right clip to the right instead.
This is useful if the two clips are already overlapping.

The crossfade in the Zoom view

The crossfade in the Track View
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Editing in the Clips view

When the Clips view is selected, all currently used clips (including pic-
tures, text or video clips if used) are displayed in a list in the upper pane. 
Each clip in the Track View has a corresponding entry in the clip list. Clips 
can also be dragged from the clip list into the Montage.

The list also allows you to edit the clips in various ways. In fact, virtually all 
clip editing functions available in the Track View are also available in the 
clip list. As usual, you can either type in the values or use sliders, allowing 
for exact and precise editing.

Customizing the view

Hiding/Showing columns

The Clips view can be divided in up to ten columns, with each column dis-
playing different data relating to the clips in the list. 

To hide/show columns, proceed as follows:

1. Click on the Clips tab to select the Clips view.
Make sure the divider between the upper and lower panes is pulled down, so you can see 
the clip list properly.

2. Click on the arrow above the clip numbers to open the Columns pop-up 
menu.
This pop-up menu displays all available column types. Currently visible column types are in-
dicated with a tick mark.

3. To hide a Column deselect the respective column type in the list.
The column disappears from the clip list, and the pop-up closes.

4. To show a hidden column type, open the columns pop-up menu again 
and select the desired column type.
The pop-up closes, and the column is now shown in the clip list.
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Moving columns

It is possible to rearrange the order of the columns by click-dragging a 
column heading. A vertical line is shown in the clip list to indicate where 
the column will be inserted when you release the mouse button.

Resizing columns

You can freely adjust the width of columns by positioning the mouse 
pointer on the edge of the column, and click-dragging the divider.

Optimize column width

This columns menu option can be used to optimize the size of all columns 
with regard to their contents, in other words all columns will be resized so 
that the column contents will be shown in full. Normally, you don’t have to 
do this, since WaveLab automatically optimizes the column widths each 
time the view is opened or resized.

Only show selected clips

When this item is activated on the Clips view : Functions menu, only 
those clips that are selected in the Track View are listed. Deselecting a 
clip in the Track View will automatically hide it in the clip list.

Sorting the clips in the list

The clips in the list can be sorted in a number of ways; alphabetically, by 
length, by start position, etc. This is done in the standard Windows fash-
ion, by clicking on the desired column heading. Clicking again on the 
same heading will reverse the sort order.

Navigating in the Clips view

If there are a lot of clips in the list, you can either use the scrollbar to the 
right to manually scroll the list up or down, or you can type in the first letter 
of a clip’s name – the selection will then immediately jump to the first clip 
in the list starting with this letter.
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Re-ordering clips in the Montage by drag and drop

This feature allows you to reorder clips in the Montage, in a way that is 
only possible from the clip list. As an example, let’s assume that we have 
edited the “Welcome” wave file (included with WaveLab) so that the 
words “Welcome” “to Steinberg’s” and “WaveLab” are instead contained 
in three separate clips. In this example the clips are all on the same track, 
but they do not have to be. Proceed as follows:

1. Place the clips so that the original welcome message is played back in 
the right order.

2. Open the Clips view : Functions menu, and make sure that the top menu 
item “Allow reordering by drag and drop” is ticked.

3. Now click the “Welcome” Clip number (1) to the left of the speaker icon 
in the clip list, and drag and drop it below the “WaveLab” clip in the list.
While dragging, the pointer changes to a Waveform icon. 

4. The clip order is still 1-2-3 but the message now says “to Steinberg’s” – 
“WaveLab” – “Welcome”.

The order of the clips is changed.
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The columns

Editing in the clip list allows for very precise adjustments. There are three 
ways you can edit values in the clip list columns (and in other Montage 
lists):

• By typing in the value.
• By using sliders or pop-ups.
• By using the spin controls.

For details, see “Setting values” on page 62.

In the clip list, you can edit the following parameters:

Column Description

Row header 
(number)

Clicking on the numbered button to the left of a clip in the list automatically 
selects the clip in the Track View and scrolls the Track View to display the 
clip.

Speaker 
icon

Click on the Speaker icon to audition a clip (including muted clips). This col-
umn cannot be removed, resized or edited.

Name Double click on a name to type in a new name.

Track Clicking on a track number opens a pop-up menu where you can select a 
new track for the clip (stereo clips cannot be moved to mono tracks and vice 
versa).

Pregap Length of silence before clip, or the overlap time between clips (see further 
description below). 

Start The clip start time (in the format selected on the ruler).

End The clip end time.

Length The length of the clip.

Clip-lock
status

If a box is ticked in this column, the related clip is time-locked in the Track 
View, and no editing can be performed on the clip.

Gain This allows you to boost or cut the clip gain by +/- 24 dB. Note that this “ex-
tra” gain adjustment is done at the end of the clip chain, after the envelope, 
effects and pan. This is the setting adjusted by the Meta Normalizer (see 
“The Meta Normalizer” on page 486).

Mute status If a box is ticked in this column, the related clip is muted (see “Muting individ-
ual clips” on page 400).

Comment In this column you can type in comments for the clip.
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About the Pregap column options

There are three options on the Clips view : Functions menu that deter-
mine what is displayed in the Pregap column:

• Show global pre-gaps.
If this is activated, the Pregap Column displays the length of the gap (if any) between the 
start of a clip and the end of the previous clip, on any track. In other words, it shows the gap 
between the two clips, regardless of whether they are on the same or on different tracks.

• Show pre-gaps by track.
As above, but shows the gap between clips on the same track only.

• Show overlap times (in red).
If this is activated, and a clip overlaps the previous clip, the Pregap column will display the 
length of the overlapping section, in red. Note that the “global” and “by track” options above 
apply to overlap times as well.

Export clip list as text…

This item on the Clips view : Functions menu allows you to save the clip 
list as a text file. The resulting text file will contain all the column items 
found in the clip list except the clip-lock and mute status. Additionally, it 
will contain information about the clips’ source wave files. You can select 
to format the text in one of three ways: Pure text, Excel (tabs) or XML.
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Managing clips and source files
There are several functions to help you check and manage the relationship 
between the clips and their source audio files:

The Files view

The Files view has two “subviews”, Audio Montage and System (selectable 
by clicking the vertical tabs to the left of the view). The System subview 
shows the files and folders on your hard disk, and can be used for importing 
audio files or regions via drag and drop into the Audio Montage (see “By 
dragging from the Files view” on page 384 and “By dragging regions from 
the Files view” on page 384, respectively). The Montage subview resem-
bles the Clips view, but lists all source audio files and their respective clips. 
This is useful for keeping track of which audio files are used.

• To display the clips that reference to a certain audio file, select the audio 
file in the left list.
Its clips are displayed in the right list, which has the same columns and functions as the list 
in the Clips view (see “Editing in the Clips view” on page 436). By default, not all columns 
are displayed in this list, but you can customize this as in the Clips view.

• To navigate in the Files view, you can either use the scrollbar to manually 
scroll the list up or down, or type in the first letter of a file’s name – the se-
lection will then immediately jump to the first file in the list starting with 
this letter.
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Editing source files

Editing the Montage may require that you process or edit the actual audio 
files referenced by the clips. This is done in the following way:

1. Right-click on the clip to bring up the clip speed menu.

2. Select Edit from the Source submenu.

A Wave window opens, showing the referenced source audio file with a selection corre-
sponding to the clip.

3. Edit the file as desired, save it and return to the Audio Montage.

You can also use the following methods to edit the source file:

• Drag the clip onto the WaveLab desktop.
• Double click in the mouse zone used for dragging/copying clips (by default the 

Top Clip area).
• Drag a selection range onto the WaveLab desktop. 

In this case, the selection in the Wave window will correspond to the selection range, rather 
than the clip.

Please note the following:

• Any editing you perform this way will affect all clips that use the audio file 
(including clips in other Audio Montages). 
If this is not what you want, you should consider using the “Clone and Substitute” function 
before editing (see below).

• You can undo/redo all changes in Wave windows, and these changes will 
be reflected immediately in all open Montages.

• If you reduce the length of the source audio file, so that it ends before the 
clip end point, the end of the corresponding clip(s) will be displayed in an-
other color (inverse video), to alert you.

• If you use “Save as” to save the source audio file under another name, the 
Montage will now refer to that new file instead.
This is true for all open Montages that refer to the file.
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Cloning and substituting source files

If you want to edit the source file of a clip, without the risk of affecting any 
other clips, you should use the function “Clone and substitute” on the 
Source submenu on the clip speed menu. This creates a copy of the audio 
source file, and makes the clip reference to this new file. As a result you can 
edit the source file without affecting other clips or the original audio file.

• The cloned audio file will have the same name as the original, but with the 
suffix “_#X”, where X is a number.
For example, if the original file is called “Piano.wav”, the first clone you make will be called 
“Piano_#1.wav”. If you repeat the procedure with another clip referencing to “Piano.wav”, 
that clone will be called “Piano_#2.wav”, and so on.

• The cloned audio file will be stored in the folder specified in the “Implicit 
folder” dialog on the Edit view : Options menu.

The “Implicit folder” is used when WaveLab needs to save files to disk. It 
is similar to the “Temporary folders” setting in the Edit folder dialog (see 
“Folder editing” on page 731), but with one important difference: Files 
stored in the “Implicit folder” are not “temporary”, that is, they are not de-
leted when you close WaveLab. This is necessary since the Montage 
contains references to the files.
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If the option “Use existing folders when possible” is activated, the cloned 
audio file will be stored in the same folder as the original file (provided that 
the original file has ever been saved). 
Note that this is not always desirable; if you are working with large audio 
files and have two or more hard disks, you should consider having the “im-
plicit” folder on a different hard disk from that of your regular audio folder. 
This will make cloning files twice as fast. However, most often it is best to 
have all source files in the same folder, to make backups easier.

Substituting the source audio file

There are two ways to substitute the source audio file:

Substitute for existing wave…

If you select the function “Substitute for existing wave…” from the Source 
submenu on the clip speed menu, a file dialog appears, allowing you to 
make the clip reference to another audio file. This is a good method to use 
if you wish to compare different takes.

• All clip settings will be retained.

• The substituting audio file must be long enough for the clip to “fit”.
This means that the audio file must at least cover the range between the clip’s start and end 
points.

• You cannot substitute a stereo file with a mono file or vice versa.

• You can also use “Substitute for existing wave…” for video and picture 
tracks.

Change file…

This is available from the File view : File menu. It opens a dialog which al-
lows you to substitute an existing file with a new one. 

• Unlike “Substitute for existing wave” (which is applied to the current clip 
only), “Change file” will reference all clips referring to the original file to the 
new file.
You can also double-click in the file list while pressing [Ctrl] to open this 
dialog.
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Renaming files and clips

You can rename source files and have all open Montages that reference the 
audio files automatically be updated. You can also freely rename clips from 
within a Montage and the current Montage will be updated accordingly.

You can either use the Rename dialog (see “Renaming files and docu-
ments (Rename)” on page 121) or the Batch Rename function (see 
“Batch renaming” on page 307).

The volume envelope
It is possible to create independent volume envelope curves for the clips 
in the Audio Montage. These envelope curves are used to automate vol-
ume, to create fades and crossfades, and for muting sections of clips.

How the envelope is displayed 

By default all clips display a volume envelope curve. Actually, you should 
view the volume envelope as three separate envelopes: the fade-in part, 
the “sustain part” and the fade-out part. The purple points to the left and 
right on the curve are the fade-in and fade-out junction points that sepa-
rate the fade parts from the sustain part.

The default volume envelope, with zero fade-in and fade-out times. 

The fade-in and fade-out parts of the envelope are described in the section 
“Using fades and crossfades in the Montage” on page 457. The following 
pages describe the “sustain part” of the envelope, that is, the section be-
tween the two fade junction points.
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Graphic display of envelope curves

The envelope curve indicates at a glance if points, fade-ins or fade-outs 
have been defined. In addition to the curve, changes in the volume enve-
lope are by default also reflected in the waveform itself. If you do not want 
this feature you can deselect the “Map waveforms to volume” item on the 
Edit view : Options menu.

A defined volume envelope curve with “Map waveforms to volume” activated.

The volume envelope mouse zone

The default envelope curve contains no volume envelope points. In this 
condition you can still use the curve to change the overall volume for a 
clip. Proceed as follows:

1. Place the mouse pointer on the curve.
The mouse pointer takes on the shape of a circle with two arrows pointing up and down, in-
dicating the envelope mouse zone. A label also appears displaying the current clip volume 
in dB, and the info line indicates the possible courses of action. 

The volume envelope mouse zone

The envelope mouse zone is always linked to an envelope curve, hence it is 
not user-definable like other mouse zones.

2. Click and drag the curve up or down to change the clip volume and release 
the mouse button.
The new volume level for the clip is displayed in the info line.
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Hiding/Showing volume envelope curves

All clips display volume envelopes by default. There are two ways you can 
hide the envelope curve for a clip. 

Method 1:

• Bring up the clip speed menu and deactivate the option “Fade/Level” on 
the “Show Envelope” submenu.
The volume envelope is hidden, but still active. To show the volume envelope, activate the 
option again.

Method 2:

• Bring up the envelope speed menu and select “Hide”. 
The volume envelope is hidden, but still active. To show the envelope curve again, bring up 
the clip speed menu and activate “Fade/Level” on the “Show Envelope” submenu.

Only show one envelope at a time

As pan settings (see “The pan envelope” on page 469) and effect send 
levels (see “Using effect envelopes (clip effects only)” on page 481) also 
can be automated using envelope curves, it is possible to have quite a 
few different envelope curves in a clip. This might make it difficult to 
quickly find the curve you wish to view or edit. To remedy this, you can ac-
tivate the option “Only show one envelope at a time” on the clip speed 
menu “Show envelope” submenu, and have only one selected envelope 
type shown:

If “Only show one envelope at a time” is selected when several curves are 
currently shown in a clip, nothing will happen. This is logical, since WaveLab 
cannot “know” what curves you want to show or hide.

1. On the clip speed menu, open the “Show envelope” submenu and acti-
vate the option “Only show one envelope at a time”.

2. To hide envelope curves, open the clip speed menu and deactivate the 
item(s) you wish to hide on the “Show envelope” submenu.

3. Repeat this procedure until only the relevant curve is shown.

4. If you now select another envelope type from the submenu, the new enve-
lope will replace the previous, only allowing one envelope at a time to be 
shown.
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Mono/stereo envelopes

It is possible to display two volume envelope curves for stereo clips, allow-
ing you to control the volume separately for the left and right channels. 
Proceed as follows:

1. Right-click on an envelope curve to open the envelope speed menu.

2. Select “Convert to stereo envelope” from the menu.
The clip now displays two volume envelope curves.

3. To convert back to a mono envelope, repeat step 1 and select “Convert 
to mono envelope” from the menu.

By definition, pan envelopes cannot be converted to stereo.

Editing envelopes

About using key commands

On the envelope speed menu, you will find that most functions have key 
commands. These will affect the envelope curve with the focus.

• The focused envelope curve is displayed with yellow handles for the enve-
lope points.

To set the focus to an envelope curve, click on it.

Adding volume envelope points

The volume envelope points allow you to “draw” volume curves in the clip. 
To add a point, double click on the envelope curve (or select “New point” 
from the envelope speed menu). You may add as many points as you like.

The focused 
envelope curve.
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Selecting envelope points

The following sections apply to both volume and fade envelope points. In 
other words, you can select, deselect and move both sustain and fade enve-
lope points.

Clicking on an envelope point selects it (it becomes red). You can also 
select several envelope points. The following rules apply:

• [Shift]-click (on a point) to select all points between a previously selected point 
and the current point.

• [Ctrl]-click (on a point) to select non-contiguous points in the envelope curve.
• [Alt]-click (anywhere in the clip) and draw a selection rectangle.

All points inside the rectangle become selected.

Deselecting points

You can deselect all selected points by clicking on a selected point or by 
selecting “Deselect all points” from the envelope speed menu. To dese-
lect a single point (amongst other selected points), [Ctrl]-click the point 
you want to deselect.

Dragging volume envelope points

• To move a point, click on it and drag it in any direction.
The junction points (the points separating the Fade parts and the sustain part) will only 
move horizontally this way. To move a junction part vertically, press [Ctrl] and drag.

• To move several selected points, click any selected point and drag in any direc-
tion.
All selected points will be moved.

• Clicking on a curve segment (i.e. the part of an envelope curve between two se-
lected points) allows all currently selected points to be moved vertically. 
You are constrained to vertical movement using this method.

• Clicking on a curve segment (i.e. the part of an envelope curve between two se-
lected points) and then pressing [Shift] allows all selected points to be moved 
horizontally. 
You are constrained to horizontal movement using this method.

• [Ctrl]-clicking on the envelope curve and dragging it up or down will select (and 
move) the two nearest points to the right and left respectively.
You are constrained to vertical movement using this method. This method is useful as a 
shortcut for quickly adjusting the level of a curve segment.
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• [Shift]-clicking on the envelope curve and dragging it left or right will select (and 
move) the two nearest points to the right and left respectively.
You are constrained to horizontal movement using this method. This method is useful when 
working with “Duck according to other track” (see “Duck according to other track” on page 
453) since it allows you to quickly adjust the position of duck regions.

• Clicking and dragging the envelope curve up or down selects (and moves) all 
points.
You are constrained to vertical movement using this method. Note that points set to the 
minimum value are not affected (see “Muting a selected range of a clip” on page 451).

• Holding down [Alt] and dragging the envelope curve up or down adjusts the cor-
responding envelopes in all selected clips.
This is a quick way to adjust the level or pan of several clips at the same time (and also to 
adjust both sides of a stereo envelope simultaneously).

Deleting volume envelope points

The junction points between the sustain and fade parts of the envelope 
cannot be deleted.

There are three ways you can delete points:

• By double-clicking on a point.
• By right-clicking on the point and selecting “Delete point” from the envelope 

speed menu.
• By selecting points and selecting “Delete selected point(s)” from the envelope 

speed menu.

Resetting points and envelopes

There are various ways to reset the envelope:

• To reset a point to 0dB, right-click on the point and select “Reset point” from the 
envelope speed menu.

• To reset the whole envelope curve to default, right-click the envelope curve and 
select “Reset all” from the speed menu.

• To reset the sustain part of the volume envelope only, select “Reset sustain to 
0dB” on the envelope speed menu.
All volume envelope points will be removed, but any defined fades will be left untouched. 
This applies to volume envelopes only.
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Copying envelopes

It is possible to copy an envelope curve and paste it onto another clip. 
Proceed as follows:

1. Open the envelope speed menu for the curve you wish to copy, and se-
lect “Clipboard” on the menu.
A submenu appears.

2. Select “Copy envelope” on the submenu.
The curve is copied to the clipboard and the speed menu closes.

3. Open the envelope speed menu for the clip to which you want to apply 
the curve and select “Paste envelope” from the Clipboard submenu.
The envelope curve is applied to the clip.

Muting a selected range of a clip

It is possible to mute parts of a clip using the volume envelope. Proceed 
as follows:

1. Use the “Select range” mouse zone to define the part of the clip you want 
to mute.

2. Right-click the clip to open the clip speed menu, and select “Mute selec-
tion (envelope)”.
The program adds points and draws a curve to mute the selected range (by lowering the 
volume to -144dB, with 20ms fall and rise times).

• By design, points set to the minimum value (-144 dB) are not affected 
when you drag the whole envelope curve up or down.
This allows you to adjust the overall level of the envelope without affecting muted regions.

Muting whole clips and tracks is described in the section “Mute and solo” 
on page 400.
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Envelope smoothing

If this item is ticked on the envelope speed menu, the resulting envelope 
curve angles will be rounded instead of angular. This produces smoother, 
more natural envelope curves. It can be used while drawing the envelope 
curve, or applied to an existing curve. 

Creating envelope presets

It is possible to create envelope presets which you can later recall and 
apply to other clips. Proceed as follows:

1. Open the envelope speed menu for the clip containing the envelope 
curve you wish to save as a preset.

2. Select “Envelope presets” from the menu.
A submenu opens.

3. Select “Edit…” from the submenu.
The Envelope presets dialog opens.

4. Type in a name for the envelope preset and click “Add” in the dialog.
The curve is now stored as a preset.

• Note that there are separate presets for the sustain part (envelope pre-
sets) and the fade parts.

Applying envelope presets

To apply an envelope preset, proceed as follows:

1. Open the envelope speed menu for the clip to which you want to apply an 
envelope preset.

2. Select “Envelope presets” from the menu.
A submenu opens.

3. Select the preset from the list on the submenu.
The envelope curve is applied.

Envelope smoothing off Envelope smoothing on
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Volume envelope presets can only be applied to volume envelopes. Non-
volume envelope presets (such as pan and effect presets) can be applied to 
any other non-volume envelope, but not to volume envelopes.

Envelope edit-lock

If this item is ticked on the envelope speed menu, the volume envelope 
curve points are hidden and cannot be edited with the mouse. You can 
however drag the whole curve up or down.

Global envelope lock

The Global envelope lock icon

If the Global envelope lock icon (in the Edit view) is activated, all enve-
lopes are locked and cannot be edited with the mouse. The envelopes 
and their points will still be displayed, but cannot be selected or edited 
(the mouse pointer doesn’t change shape when moved over the curve).

• You can toggle global envelope lock on/off by pressing [Shift]+[V] on the 
computer keyboard.

Duck according to other track

This feature allows you to create ducking effects between clips on two 
adjacent tracks. Normally, ducking is when the signal level on one track or 
channel is automatically lowered by the presence of another signal on an-
other track or channel (if this is what you want, you should use the Ducker 
plug-in, described in the section “About the “Upper Track” output option” 
on page 482). With “Duck according to other track” it is not the presence 
of another signal that causes ducking to take place, but the presence of 
another clip on an adjacent track.

The most obvious application of this feature is when mixing background 
music with a voice-over. When the voice-over starts, the level of the mu-
sic is automatically lowered and when the voice-over stops, the level of 
the music is restored to the original level. This is done by automatically 
creating volume envelope curves. In the following example we have cho-
sen to use “music” on the track to which ducking will be applied and a 
“voice-over” on an adjacent track that will cause ducking to take place.
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The clips that cause ducking must be located completely inside the time 
range of the clip to which ducking is applied.

If the clip(s) that cause ducking contain silent passages, ducking will not 
work properly. These clips have to be edited so that each phrase is a sepa-
rate clip without any silence. This is because it is not the signal level that 
activates the ducking, but the clip itself.

When “Duck according to other track” is performed it is applied to one clip 
at a time. If the music (in our example) consists of several clips that have 
been spliced together, only one of the clips will be ducked by the voice-
over. One solution is to repeat the function for each clip, another is to use 
the “Render” function (see “Mixing down – The Render function” on page 
527) in the Master Section to create a specific (single) file from the separate 
clips, and re-import this as a new clip in the Montage.

Proceed as follows:

1. Place the clips containing the music and the voice-over on separate adja-
cent tracks.
Make sure the voice-over clips are located inside the time range of the music clip.

The three voice-over clips on the upper track are placed inside the time range of the 
music bed on the track below.
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2. Open the envelope speed menu for the clip containing the music, and se-
lect “Duck according to other track…”.
The Ducking options dialog opens.

The Ducking options dialog

3. Click the appropriate “Previous track” or “Next track” radio button in the 
“Clips to follow” section (according to whether the voice-over track is 
above or below the music track in the Montage).
For now, we will use the default settings for the other dialog options.

4. Click “OK”.
The level of the music is automatically lowered by the voice-over clips, as shown in the illus-
tration below.

After applying “Duck according to other track”
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The following parameters can be set in the Ducking options dialog:

Parameter Description

Fall Duration The time it takes for the level to fall when ducking starts.

Rise Duration The time it takes for the level to rise to the original level after ducking 
ends.

Gap before Clip
(Fall)

The time between the end of the Fall region and the start of the voice 
clip.

Gap before Clip 
(Rise)

The time between the end of the voice clip and the start of the Rise 
region.

Balance clip 
fade-in

If this is ticked, any Duration or Gap settings in the Fall region will be 
ignored. Instead the ducking envelope will lower the volume according 
to the time of the voice clip’s fade-in curve.

Balance clip 
fade-out

If this is ticked, any Duration or Gap settings in the Rise region will be 
ignored. Instead the ducking envelope will raise the volume according 
to the time of the voice clip’s fade-out curve.

Damp factor This sets the amount of ducking, i.e. the level of attenuation applied to 
the affected clip.

Clips to follow This determines whether the track that will cause ducking to take place 
is positioned before or after the track that will be ducked. If “Only se-
lected clips” is ticked only the selected clips on the specified track will 
cause ducking.
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Using fades and crossfades in the Montage
There are a number of different options to choose from when creating and 
editing fades and crossfades in the Montage. These are described in the 
following sections.

Creating fades
As mentioned earlier, by default all clips display a fade-in and a fade-out 
junction point. These can be dragged horizontally to create a fade-in or 
fade-out for a clip. You can add envelope points to a fade just as with vol-
ume envelopes. To create a fade, proceed as follows:

1. Click on the fade-in point at the beginning of a clip and drag it to the right.
The resulting linear (by default) fade-in curve is displayed in the clip, and the fade is also re-
flected in the waveform. If you position the mouse over the fade-in point, a label appears, 
showing the fade-in time in seconds and milliseconds, and the volume in dB.

A linear fade-in

2. To create a fade-out, use the same basic procedure but instead click and 
drag the fade-out point at the end of the clip to the left.

• By default you can only move the fade junction points horizontally. To 
move them up or down, you need to hold down [Ctrl] and drag.

Editing fades

The operating procedure when creating and editing fades is identical to 
volume envelopes, except that the fade-in and fade-out speed menus only 
contain items related to the fade parts (whereas the envelope speed 
menu contains settings for all parts of the envelope). Please refer to the 
volume envelope section for details.

• To make editing of fades easier, there are special Zoom options on the clip speed 
menu, for zooming in on the fade-in or fade-out area.

Note that the fade junction points (the points separating the fade parts from 
the sustain part) have a special property: If you move a junction point, all 
other points in the corresponding fade are moved proportionally, to main-
tain the shape of the fade!
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Fade Options

Using fade-in/out smoothing

If either or both of these items are ticked on the envelope speed menu, 
the resulting corresponding fade curve angles will be rounded instead of 
angular. This produces smoother, more natural fade curves. It can be 
used while drawing the fade curve, or applied to an existing curve.

Fade-in/out presets

It is possible to create fade presets which you can recall and apply at will. 
This is done in the same way as with volume envelopes (see “Creating 
envelope presets” on page 452).

Fade-in/out edit-lock

If either or both of these items are ticked on the envelope speed menu, 
the corresponding fade points are hidden and cannot be edited. 

Editing the fades of all selected clips

If you press [Alt] and change a fade-in or fade-out point, this will affect all 
selected clips simultaneously.

Default fade-in/out

The factory default fade-in/out curve shape is linear. You can change this 
setting and define a default shape and/or length separately for both fade-
ins and fade-outs. To define a new default fade-in, follow the steps below. 
To define a new default fade-out use the same method described below 
but select “Default Fade-out” on the envelope speed menu:

Note that the default fades are saved for each Montage. If you want to use 
the same default fade for several Montages, you should update the Mon-
tage template file (see “Saving a Montage template” on page 499).

1. Open the envelope speed menu for the clip that contains the fade-in 
shape and/or length you want to use as default.

2. Select “Default Fade-in” on the menu.
A submenu opens.

3. Select “Define current shape as default” on the submenu.
Now every new fade-in will have the defined default shape. 

4. If you also want to define a default length, use the same procedure but 
select “Define current fade-in time as default” from the submenu.
You have now defined both a new default shape and length.
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To apply the default fade-in time use the following method:

1. Open the envelope speed menu for the clip to which you want to apply 
the default fade-in length, and select “Default Fade-in”.

2. Select “Apply default fade time” from the submenu.
The fade-in time is now set to the defined default value.

To apply the default fade-in shape to an existing non-default fade shape, 
use the following method:

1. Open the envelope speed menu for the clip you want to apply the default 
fade-in shape to, and select “Default Fade-in”.

2. Select “Apply default shape” from the submenu.

When you create a new fade-in in a clip that previously had no fade-in, the 
default shape is automatically applied.

To apply both default fade-in shape and length use the following method:

1. Open the envelope speed menu for the clip to which you want to apply 
the fade-in shape and time, and select “Default Fade-in”.

2. Select “Apply default shape and time” from the submenu.
The fade-in time and shape and is now set to the defined default value.

Create default fades in new clips

If this option is ticked on the Edit view : Fade menu, all new clips that are 
imported or recorded in the Montage will get the default fade-in and fade-
out shape and length. This is also true for clips that are created by split-
ting a clip.

Lock fade times when adjusting clip edges

If this option on the Edit view : Fade menu is ticked, the defined fade-in/
out length will be locked to the clip start or end, even if you adjust the clip 
edges.
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Copying fades

It is possible to copy a fade-in (or fade-out) and paste it onto another clip. 
Proceed as follows:

1. Open the envelope speed menu by right-clicking on the fade you wish to 
copy, then select “Clipboard” on the menu.
A submenu appears.

2. Select “Copy fade-in” (or fade-out) on the submenu.
The curve is copied to the clipboard and the speed menu closes.

3. Open the envelope speed menu for the clip to which you want to apply 
the fade, and select “Paste fade-in” (or fade-out) from the Clipboard sub-
menu.
The fade is applied to the clip.

Set fade/level envelope after effects

You have the option of placing the fade/level envelope after instead of be-
fore the clip effect section (default setting). This is useful for dynamic pro-
cessors that alter the level of the clip.

To do this right-click the level envelope to open the envelope speed menu 
and select “Set fade/level envelope after effects”

About fade-in/out presets

These are created and applied in the same way as volume envelope pre-
sets, see “Creating envelope presets” on page 452.

Using the fade- in/out ROM presets

If you select “Fade-in/out ROM Presets” on the envelope speed menu, a 
submenu opens where you can select various preset curves and other 
fade-related options.

The fade-in/out ROM presets are only selectable on the envelope speed 
menu if the respective fade-in/out length in the clip is defined, i.e. not set to 
zero.
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The following curve types can be selected (in these examples fade-in 
curves are used – the corresponding fade-out curves would of course 
display the mirror image):

Fade-in curve type Description

Linear This is the factory default fade curve. A straight line be-
tween two points.

Sinus This produces a fade-in curve that starts out moderately 
fast but planes out towards the end. This curve type will 
provide a constant power crossfade (see “Power 
compensation” on page 464).

Square-root This creates a curve that fades in quickly then planes out. 
This curve type will provide a constant power crossfade 
(see “Power compensation” on page 464).

Sinusoid This creates an s-shaped fade, with a medium slow start 
and end fade.

Logarithmic This creates a curve that fades in fast in the beginning, 
reaching full level early in the fade.

Exponential This creates a curve that fades in slowly in the beginning.

Exponential + This creates an even more pronounced exponential curve.
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Using crossfades

A crossfade is a gradual fade between two clips, where one is faded in 
and the other faded out. Crossfades in the Montage are created automat-
ically when clip edges overlap. To create an automatic crossfade, pro-
ceed as follows:

For automatic crossfading to work, the items “Enable automatic fade-in 
changes” and “Enable automatic fade-out changes” must be ticked (default 
setting) on the envelope speed menu for the clip to which you want to apply 
the crossfade. For a description of these menu items, see “Enable/Disable 
automatic fade changes” on page 463.

1. Click on the Edit tab and open the Edit view : Fade menu.

2. Select the menu item “Automatic crossfading – free overlaps”.
This can also be selected by clicking the leftmost crossfade icon.

The crossfade icons

3. Move a clip so that it overlaps the edge of another clip.
The crossfade is automatically created in the overlap; by default two equal length linear 
fade curves, one fading out and the other fading in. This will also happen if you paste a clip 
so that it overlaps another clip.
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Crossfade options

The following crossfade options on the Edit view : Fade menu determine 
how automatic crossfades will be created in the Montage: 

• No Automatic crossfading.
If this is activated, no automatic crossfading will be performed.

• Automatic crossfading – free overlaps.
If this is activated, automatic crossfades are created when a clip overlaps the edge of an-
other clip on the same track, and the length of the overlap determines the length of the 
crossfade.

• Automatic crossfading – fade-in constrained overlaps.
When this option is activated, the defined fade-in length of a clip will constrain the maxi-
mum possible overlap, and hence the crossfade time, to this set length. If you move the clip 
with the fade-in in the overlap past the set overlap time, the other clip will be progressively 
resized. Moving the other clip into the clip that contains the fade-in in the overlap produces 
the same result.

• Automatic crossfading – fade-out constrained overlaps.
This works in the same way, but instead it is the defined fade-out length that constrains the 
overlap. See “Crossfading with fade constrained overlaps” on page 467 for a detailed de-
scription of these items.

• Allow Automatic crossfading with selected track.
When this option is activated, automatic crossfades will also be created when moving a clip 
on any track so that it overlaps the edge of a clip on the currently selected (focused) track.

• Allow multiple automatic crossfades. 
When this option is activated, automatic multiple crossfades will be created on any track, if 
several selected or grouped clips will overlap other clips’ edges when moved.
If the option is turned off, crossfades will only be created for the clip you drag.

Enable/Disable automatic fade changes

You can also disable automatic fade changes for individual clips, as op-
posed to the “No automatic crossfading” Fade menu item, which is glo-
bal. This can be used if you have set a fade that you do not want to be 
altered in any way, even though you may want to overlap the clip with an-
other clip. Proceed as follows:

1. Open the envelope speed menu for the clip for which you want to disable 
automatic fade changes.

2. Deactivate “Enable automatic fade-in changes” if the fade you want left 
unaltered is a fade-in (or “Enable automatic fade-out changes” if it is a 
fade-out).
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About the crossfade compensation attributes

On the fade-in and fade-out ROM presets submenus, you can find an 
item called “Pure shape” along with three “compensation” items:

Note that selecting a compensation attribute for a single fade (not in a 
crossfade) will change the shape of the curve, but the actual “compensa-
tion” will only take place when the fade becomes part of a crossfade. 

Editing crossfades

The factory default automatic crossfade is linear, using the same shape 
and fade lengths for both the fade-in and fade-out. Most of the time, an 
unaltered linear or sinus crossfade will produce the desired result. You 
can, however, create crossfades with totally independent shapes and 
lengths for the fade-in and fade-out curves. The following rules apply:

• You can edit the fade-in and fade-out curves in crossfades in exactly the 
same way as fades.

• To change the crossfade time (the width of the crossfade zone) “symmet-
rically”, press [Shift] and move left and right.

Menu item Description

Pure shape The pure mathematical curve shape is used. This is the default setting 
when any fade-in/out ROM preset is selected. 

Amplitude 
compensation

If this is selected for a fade-in (or fade-out) curve in a crossfade, the 
summed fade-in and fade-out amplitudes will be the same all along the 
crossfade region. 
This option is recommended for short crossfades.

Power 
compensation

If this is selected for a fade-in (or fade-out) curve in a crossfade, the energy 
(power) of the crossfade will be constant all along the crossfade region. 
Crossfading between completely different types of audio material can 
sometimes cause harmonics to “cancel each other out” at the crossfade 
splice point, causing the volume to drop. Constant power crossfades com-
pensate for this problem. Using either the “Sinus” or “Square-root” fade 
ROM presets for a fade-in (or fade-out) will give a constant power cross-
fade without selecting this item.

Medium 
compensation

This option provides an intermediary between Amplitude and Power com-
pensation. This is recommended if the other two compensation attributes 
won’t provide the desired result.
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• Press [Ctrl] and move left and right to “slide” the cross-fade region while 
keeping its length.

Changing the crossfade time (left), and sliding the crossfade region (right).

• Please note that for these tow functions to work, the mouse pointer must 
not be positioned on an envelope curve point inside the crossfade region.
If the mouse pointer is positioned on an envelope point, this point was the priority and you 
cannot change the crossfade time nor slide the crossfade region.

• When you move a clip so that it overlaps another clip to create a cross-
fade, and neither clip has a defined fade in the overlap, a default cross-
fade is created.

• When moving a clip with a defined fade curve so that it overlaps another 
clip’s adjacent edge (without a defined fade), the unmoved clip automati-
cally gets the same fade shape as the moved clip (but as a corresponding 
opposite fade), with amplitude compensation.

Dragging the right clip so that it overlaps the left clip…

…will use the right clip’s fade shape (as a corresponding fade-out), to create a crossfade.
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Note that the above only applies if the unmoved clip’s fade-out length is set 
to zero.

• If both clips have different defined fade curves at their adjacent edges 
when creating a crossfade, this will create an asymmetrical crossfade, 
based on the defined fade curves.

Other predefined rules when creating crossfades

Apart from the different combinations described above, there are other 
factors that govern the result when creating crossfades. In this example 
we will use a pre-defined fade-out and an undefined fade-in. The fade-in 
will be created when the crossfade is performed. What will happen de-
pends on what type of defined fade-out curve is used:

• If the fade-out is a ROM preset (except “Sinus” or “Square-root”) that uses “Pure 
shape”, the corresponding fade-in will get the same ROM preset, with amplitude 
compensation.

• If the fade-out is a ROM preset that uses a compensation attribute (i.e. not “Pure 
shape”), the fade-in will get the same ROM preset, but with “Pure shape” activated, 
for the compensation to take effect.

• If the fade-out uses either the “Sinus” or “Square-root” ROM presets with the 
“Pure shape” setting, the fade-in will get the same ROM preset also with the “Pure 
shape” setting, and the compensation attributes will be greyed out on the menu.
In fact power compensation is used. This is because the “Sinus” and “Square-root” curves 
provide constant power crossfades by themselves, for mathematical reasons.

Dragging the right clip so that it overlaps 
the left clip…

…creates a crossfade based on the 
already defined fades.
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Crossfading with fade constrained overlaps

On the Edit view : Fade menu and amongst the crossfade icons, you can 
find two items; “Automatic crossfading – fade-in constrained overlaps” and 
“Automatic crossfading – fade-out constrained overlaps”. These items al-
low you to create crossfades and resize clips simultaneously. The length of 
a defined fade-in or fade-out will constrain the maximum length of the over-
lap (and hence the crossfade) to the set fade length. If you continue drag-
ging a clip past this point, the clip that does not have the chosen fade type 
in the overlap will be resized. 

Proceed as follows:

1. Select “Automatic crossfading – fade-in constrained overlaps” on the 
Fade menu (or by clicking on the middle crossfade icon).

2. Create a fade-in curve in a clip on a track containing several clips.

3. Drag the clip to the left so that it overlaps another clip, past the right clip 
edge.
A crossfade is created in the overlap.

Dragging the right clip over the left clip edge will create a crossfade.

4. Continue dragging the clip, so that the dragged clip’s fade-in point over-
laps the left clip’s right edge.
The right edge of the left clip will be progressively adjusted as you drag the clip further to 
the left, making the clip shorter. The crossfade region remains the same length.

If you continue dragging to the left, the left clip will become shorter.

5. Drag the clip to the right again.
The resized clip is gradually uncovered. The original clip length is memorized, so you can al-
ways restore resized clips later.
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6. Separate the two clips again so that there is no overlap, and that they are 
in the same left/right position relative to each other as before.

7. Now drag the left clip to the right so that it overlaps the other clip, and 
continue dragging to the right.
Again, the right edge of the left clip will be progressively resized as you drag the clip further 
to the right.

8. Using “Automatic crossfading – fade-out constrained overlaps” works in 
the same way, but the defined fade-out length constrains the overlap in-
stead, and accordingly the left edge of the right clip is adjusted.

To use fade-in/out constrained overlaps, there must be a defined (i.e. not 
set to zero) fade-in/out in the overlap. Otherwise, “Automatic crossfading – 
free overlaps” is activated for that crossfade.

Fade constrained overlaps can also be used with the options “Allow multi-
ple automatic crossfades” and “Allow automatic crossfading with selected 
track” options on the Fade menu.

Additional crossfade options

There are three more options on the Edit view : Fade menu (with corre-
sponding icons on the Edit view icon bar) that affect crossfades:

• Snap to waveform when crossfading

If this option is activated, and you create a crossfade by moving the right clip towards the 
left, the moved clip will be time-adjusted slightly to match the waveform in the left clip. What 
actually happens when the mouse button is released, is that the “Waveform recognition” 
feature (on the Zoom page) is activated. See “The Zoom view” on page 433 for details re-
garding this feature.

• Create optimized crossfade when snapping to other clip

If this option is activated, and you move a clip so that its start snaps to the end of another 
clip, a short crossfade is automatically created, to optimally match the waveforms in the clip. 
See “Moving and snapping to another clip” on page 417.
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• Snap to fade-in/out when snapping to other clip

If this option is activated, and you move a clip so that its start snaps to the end of another 
clip, a crossfade is automatically created, like with the previous option. In this case how-
ever, the length of the crossfade will be the fade-in length of the right clip.
If this is zero, the fade-out length of the left clip is used as basis instead. If this too is zero, 
the function “Create optimized crossfade when snapping to other Clip” is performed (if ac-
tivated). In other words, “Snap to fade-in/out…” has higher priority than “Create optimized 
crossfade…”.

If the options “Snap to fade-in/out when snapping to other Clip” and “Snap 
to waveform when crossfading” are both activated, the right clip will first be 
pushed left to its fade-in point, and then pushed further to create an opti-
mized crossfade.

The pan envelope

The descriptions in this section refer to standard pan envelopes. For a de-
scription of surround panning, see “Surround panning” on page 512.

You can draw pan envelope curves to automate the pan setting for clips 
in the same way as with volume envelopes. For mono clips, pan governs 
the left/right position in the stereo spectrum. For stereo clips, pan sets the 
left/right balance. The operating procedure when creating and editing pan 
envelopes is the same as for volume envelopes, so please refer to that 
section for details. This section only deals with the options that affect pan 
specifically.

Showing pan envelopes 

To show the pan envelope, proceed as follows:

1. Right-click anywhere on a clip (except the envelope curve) to open the 
clip speed menu.

2. On the “Show Envelope” submenu select “Pan”. 
The pan envelope is shown. If the option “Map Waveforms to volume” is activated on the 
Edit view : Options menu, the waveforms are scaled according to the pan envelope (as with 
the volume envelope).

• For a description of the general procedure for showing/hiding envelope 
curves, see “Hiding/Showing volume envelope curves” on page 447.
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About pan modes

The four pan modes all relate to the fact that without power compensa-
tion, the power of the sum of the channels will drop by about 3 dB if a sig-
nal is panned hard left or right, compared to the same signal being 
panned center. You should experiment with the modes to see which fits 
best in a given situation. Proceed as follows:

1. Open the pan envelope speed menu by right-clicking the pan envelope 
curve.

2. Select “Pan mode” on the menu.
A submenu opens. Select one of the following four modes:

Transforming clips

On the clip speed menu, you will find a submenu called Transform. This 
contains two items: “Time-stretch to cursor…” and “Pitch Shift…”. When 
you use one of these functions, a clone of the original audio file is auto-
matically created, containing exactly the audio range used in the clip. The 
selected processing is applied to the clone, and the clip will reference to 
this file instead. The Transform functions can be viewed as “non-destruc-
tive”, since the original audio files are not affected.

Channel damp 
(0dB / mute)

This mode will not compensate for power loss at all. If a signal is 
panned hard left or right, the power of the sum of the channels will 
drop by 3dB.

Constant power
(+3dB / mute)

This is the default mode. Regardless of the pan position, the power of 
the sum of the channels will remain constant.

Channel boost 
(+4.5dB / mute)

If this mode is selected and a signal is panned hard left or right, the 
power of the sum of the channels will actually be higher than with a 
signal panned center.

Channel boost 
(+6dB / mute)

This is the same as the previous option, but with even greater power 
boost.
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• The cloned audio file will have the same name as the original, but with the suffix 
“_#X”, where X is a number.

• The cloned audio file will be stored in the folder specified in the “Implicit folder” 
dialog on the Edit view : Options menu (see “Cloning and substituting source 
files” on page 443).

Note that since the new cloned audio file contains exactly the audio range 
used by the clip, it is not possible to lengthen the clip by resizing it after the 
Transform operation.

Time-stretch to cursor

This function uses WaveLab’s (or DIRAC’s) time stretch algorithm to ad-
just the length of a clip:

1. Move the Montage cursor to the position where you want the clip to end.
Note that the time stretch algorithm will give best results when stretching/compressing by 
small or moderate amounts, i.e. when the Montage cursor is positioned not too far from the 
clip’s current end. Also, you should avoid time stretching already time stretched material – 
therefore, if you are not satisfied with the result, you should undo the operation before trying 
again.

In this example, the goal is to match the length of the lower clip to the upper clip. The 
magnetic bounds (see “Magnetic bounds” on page 409) make it easy to position the 
Montage cursor exactly at the end of the upper clip.

2. Right-click on the clip to bring up the clip speed menu.
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3. Select “Time-stretch to cursor” from the Transform submenu.
The Time Stretching dialog appears. This is the same dialog as when time stretching wave 
files, but the fields for stretch factor/time/tempo are greyed out (since these are determined 
by the cursor position).

4. Make settings for Quality, Audio Quantize and Preserve pitch, see “Time 
Stretch” on page 196.

5. Click OK.
The clip is stretched (or shortened) so that it ends exactly at the Montage cursor.
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Pitch shift

This function uses WaveLab’s (or DIRAC’s) pitch correction algorithm to 
change the pitch of the clip:

1. Right-click on the clip to bring up the clip speed menu.

2. Select “Pitch shift” from the Transform submenu.
The Pitch Correction dialog appears.

3. Specify the desired amount of pitch shift.
As with time stretch, small changes usually give better results.

4. Specify a Length Compensation value.
If you set this parameter to 100, the length of the clip will not be affected. Setting it to a 
smaller value will make the clip longer (negative pitch shift values) or shorter (positive pitch 
shift values).

5. Make settings for Quality, Audio Quantize, Preserve Formants and 
Rhythm Accuracy.
Click the question mark icon in the dialog for details.

6. Click OK.
The pitch of the clip is changed.
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Adding effects to tracks and clips
The Montage supports VST effect plug-ins, both for individual clips and 
for tracks. The main difference between clip and track effects is:

• Clip effects affect individual clips only.
• Track effects affect all clips on a track.

The standard WaveLab and DirectX plug-ins cannot be used as clip or 
track effects in the Montage, but VST versions of several standard Wave-
Lab effects are provided, as well as several of the standard Cubase VST 
effects. Each independent clip and/or audio track in the Montage can be 
independently processed by up to ten VST effect plug-ins. Effects are 
configured either as Inserts, when all sound is processed by the effect, or 
as Send effects (“Split mode”) where the balance between the unproc-
essed sound and the effect send level can be adjusted or controlled by 
effect envelope curves (clip effects only).

Only clip effects for clips that are active at the current playback position will 
consume any CPU power. This does not apply to track effects, which con-
sume CPU power regardless whether any clips on the track are playing back 
or not.

DirectX plug-ins from Waves Ltd. can be used as Montage effects by using 
the Waves VST shell.

The first time you play a Montage after opening or cloning it, the program 
has to load all effects into memory. If you have a lot of effects, this may re-
sult in a short silence before playback starts.
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Adding a clip effect slot 

To add an effect to a clip, proceed as follows:

1. Open the clip speed menu by right-clicking the clip.

2. Select “Add effect slot…” from the menu.
A slot is created and a dialog box opens where various settings relating to that slot can be 
made. Leave the dialog open for now.

Adding a track effect slot

To add an effect to a track, proceed as follows:

1. Click on the “Add effect slot” button in the Track Control area.
If no effects are currently loaded the button will display “no fx”.

2. Select “Add effect slot…” from the menu.
A slot is created and a dialog opens where various settings relating to that slot can be 
made. Leave the dialog open for now.

Selecting an effect for a slot

The following applies to both clip and track effects.

1. Click on the button marked “Effects”.
A pop-up menu opens containing all installed VST plug-ins.

2. Select one of the effects from the menu.
The chosen effect’s parameters appear to the left in the dialog. 

3. Change the parameter settings as desired.

4. When you are done, click “Close” to close the dialog or leave it open if 
you want to make more adjustments later.
You can continue working with the Effect dialog open. It is also possible to have several 
Effect dialogs open.
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If a clip effect has been added, the number [1] is displayed before the clip 
name. This is to indicate that one active effect slot is used for that clip. For 
track effects, the number of active effect slots currently used is shown in 
the “Add effect slot” button.

You can add effects during playback. However, if you add an effect with a 
latency larger than zero (displayed to the right in the Effect dialog, see “La-
tency” on page 479), you should stop and restart playback to avoid timing 
discrepancies.
Also, a small number of VST plug-ins may change latency depending on pa-
rameter settings. If that is the case, make sure to stop and restart playback 
after the latency is changed.

Removing an effect from a slot

You can’t actually manually remove created effect slots, only the slot’s ef-
fect. Here’s what you do:

1. To remove a clip effect from a slot, open the clip speed menu and select 
the effect you want to remove from a slot.
To remove a track effect from a slot, click the “Add effect slot” button (in 
the Track Control area) and select the effect you want to remove from a 
slot from the menu that appears.
The effect window opens.

2. Click on the “Effects” button, and select “Remove” from the pop-up menu 
that appears.
The effect is removed from the slot. You can now either select a new effect for the slot or 
leave the slot unused.

• You can also remove effects from slots in the Plug-ins view – see “Man-
aging effects in the Plug-ins view” on page 483.

Unused slots are automatically removed the next time WaveLab is launched, 
and do not consume any CPU power.
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Effect type: Insert or Split Mode?

Clip and track effects can be configured either as Insert or Send effects. 
This is done using the “Split mode” setting in the Effect dialog (see “The 
Effect dialog” on page 478). 

• When Split mode is deactivated for an effect, it is treated as an insert effect.
This means the whole clip signal is routed through the effect. Typical insert effects would 
be compressors, auto panners or distortion units, etc. 

• When Split mode is activated for an effect, it is treated more as a send effect.
In this mode, you can adjust the send level to the effect. Note that Split mode is different to 
conventional send effects in that the effect signal is mixed directly into the audio path and 
not to an effect return section. When Split mode is activated, the send level can be auto-
mated using effect envelope curves (this applies to clip effects only). Typical Split mode ef-
fects would be reverb, chorus or delay, etc.

Some effects are always in Insert mode or always in Split mode. For these 
effects, the Split mode setting is greyed out and cannot be changed.

The Reset Plug-ins options

On the Edit view : Options menu, you will find two options related to the 
plug-in effects:

• Reset plug-ins when starting playback.
When this is activated and you start playback, the program asks the plug-ins to first release 
any samples in plug-in memory. Activate this if you get a small click or noise when the play-
back position reaches the start of a clip with effects (typically reverb or delay effects). If not 
needed, you should leave this option off, since having it activated could result in a slightly de-
layed response when you start playback (especially in a Montage with many plug-ins used).

• Reset plug-ins before rendering.
Unfortunately, a small number of plug-ins do not respond properly to the VST “Reset” com-
mand sent by the option above. These plug-ins are only properly initialized when they are 
created (in effect, when the Montage is opened). If you have activated “Reset plug-ins 
when starting playback” and still get clicks on playback as described above, you can acti-
vate this option before rendering (see “Mixing down – The Render function” on page 527). 
This makes WaveLab reload all plug-ins before rendering the file(s).
Note that this requires twice the amount of memory (since the Montage is in effect opened 
twice).
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The Effect dialog

The Effect dialog

When an effect is selected, the left part of the Effect dialog contains the 
parameters for the effect. The right part of the dialog contains a number of 
options and functions that are common (although some settings may be 
disabled depending on the effect type, as explained above). 
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The dialog contains the following common elements:

Dialog item Description

Send level 
slider

This controls the send level for the chosen effect. Only available when Split 
mode is selected. 

Latency Certain effect plug-ins that have to analyze the sound before passing it on, will 
introduce a latency (delay) in the audio path. WaveLab automatically compen-
sates for this delay with regard to other tracks. However, real-time changes 
(like turning an effect knob) will be delayed according to the maximum latency 
found among all clips (the largest sum of latencies for a single clip). Plug-ins 
with latency cannot be used as Split mode effects (see below).

Tail Effects like reverb and delay produce audio “tails”, i.e. the effect sound contin-
ues after the clip sound ends. If for example you add echo to a clip without 
specifying a tail value, the echo effect is muted as soon as the clip ends, which 
is in most cases undesirable. Set the tail length so that the effect is allowed to 
decay naturally. If you add another plug-in to the clip that also produces a tail, 
a separate tail value does not have to be set for this plug-in unless the new ef-
fect has a longer natural decay tail than the first. The overall tail length for the 
clip is the sum of each plug-in’s tail. The maximum tail setting is 30 seconds.

Split mode If Split mode is activated for an effect, the send level for the effect can be ad-
justed, as described in the section “Effect type: Insert or Split Mode?” on page 
477. For some effects, this setting cannot be changed.

Bypass If this is activated, the effect is bypassed.

Effects 
button

This button opens the Effects menu where you can select to remove the slot’s 
current effect, or select a new one from the menu for the same slot. Changing 
the effect using this menu will erase any unsaved changes to the previously se-
lected effect.

Preset 
button

This button opens the preset menu where you can load or save effect banks or 
effects. There are also two items named Load and Save Default Bank. Saving 
as default bank will store the effect settings in the same folder as the plug-in’s 
.dll file, and each time you load the plug-in this bank will automatically be 
loaded. This is the way to customize the default presets of a plug-in. 

Functions 
button

This button opens the Functions menu which allows you to copy/paste effect 
settings between clips, rearrange the order of the effect slots and switch be-
tween the different effect dialogs currently active. See “Copying effect settings 
to another clip” and “Rearranging the order of the effect slots” below.
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Copying effect settings to another clip or track

You can copy both the effect type and its settings and paste them into an-
other clip/track. Proceed as follows:

1. Select the effect you want to copy the settings from.

2. Select “Copy” from the Functions menu in the Effect dialog.

3. Click the “Add effect slot” button for a track or right-click the clip which you 
want to paste the effects settings, and either select “Add effect slot…” or 
select an existing effect slot (if you want to replace the existing effect).

4. Select “Paste” from the Functions menu.
The copied effect type is added to a new slot along with the effect settings you copied.

• You can also copy/paste effects in the Plug-ins view.
See “Managing effects in the Plug-ins view” on page 483.

Stereo plug-in settings can’t be pasted onto mono clips (the same applies 
for mono plug-in settings and stereo clips).

Undoing effect changes

It is possible to undo changes to the effect settings. However, WaveLab 
will only “register” the changes (thus making them undoable), when the 
Effect dialog loses focus. Therefore, if you have made an effect setting 
change that you want to undo:

1. Click on another window, so that the Effect dialog loses focus.
The new effect setting is registered by WaveLab.

2. Select Undo as usual.

3. Go back to the Effect dialog to continue working (if you wish).
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Rearranging the order of the effect slots

The Function menu items “Move up” and “Move down” allow you to rear-
range the order of the effect slots. The effect order in a chain determines 
to a certain degree how the effects will affect each other. If you have se-
lected to use compression and reverb for example, the order decides 
whether compression affects the clip signal only (compressor used as Ef-
fect 1), or both the clip signal and the reverb signal (compressor used as 
Effect 2). The rule is that any effect that follows a previous effect slot will 
process the previous effect(s) (or a mix of input/effect in case Split mode 
is used). Proceed as follows:

1. Open the effect dialog for the first effect in a chain consisting of at least 
two active effect slots.

2. Select the Function menu item “Move down”.
The effect dialog remains open and unchanged except that the previous Effect 1 slot now 
becomes Effect slot 2 and vice versa.

3. Now selecting “Move up” would return both effect slots to their original 
positions.
Repeating step two again would swap Effect slot 2 with slot 3 (if available), etc. Only rele-
vant menu items are selectable, you can’t select “Move down” for the last effect slot or 
“Move up” for the first effect slot.

• You can also reorder effect slots in the Plug-ins view.
See “Managing effects in the Plug-ins view” on page 483.

Using effect envelopes (clip effects only)

It is possible to automate the effect send level for split mode clip effects 
by using effect envelope curves. Proceed as follows:

1. Open the clip speed menu for a clip that has a split mode effect active.

2. Select “Show envelope” from the clip speed menu.
The clip’s split mode effects are now selectable from the “Show envelope” submenu.

3. Select the effect to which you want to add an effect envelope.
The effect envelope appears in the clip.

4. Editing the effect envelope is done using the same methods as for volume 
envelopes.
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About the “Upper Track” output option

On the track pop-up menu you will find two items: “Route to Master Sec-
tion and upper track” and “Route to upper track only”. These items are re-
lated to the fact that WaveLab can host plug-ins that modulate audio with 
other audio (clip effects only). As an example of this, a plug-in called 
“Ducker” is included with the program. This is used for lowering the vol-
ume of one signal, whenever another signal is present. A typical applica-
tion for the Ducker would be a music track with a commentary voice-over 
on another track; whenever the commentary voice is heard, the volume of 
the music track is lowered by a certain amount.

To set up for this example, proceed as follows:

1. Make sure the “voice-over” clip is on the track just below the “music track”.

2. Pull down the track pop-up menu for the “voice-over” track and select the 
option “Route to Master Section and upper track”.
This will route the sound of the “voice-over” track both to the Master Section and to the 
track above. In other situations, you may not want to hear the sound of the modulating track 
at all, in which case you would select “Route to upper track only” instead.

3. Add a new clip effect slot to the “music” clip, and select the Ducker plug-
in.
You have to use a clip effect for the Ducker effect to work.

4. Start playback.
Whenever the “voice-over” signal exceeds a certain level (the Ducker effect’s Threshold 
value), the level of the “music” clip will be lowered (by an amount set with the Damping pa-
rameter).

5. Adjust the Ducker effect parameters until you get the desired effect.

• A similar effect can be obtained using the “Duck according to other track” 
function (see “Duck according to other track” on page 453). The difference 
is that with the Ducker, it is the actual signal level that governs the ducking, 
while with the “Duck according to other track” function, it is the presence of 
a clip.
Therefore, the Ducker is the best choice if the modulating track (the “voice-over”) consists 
of long clips including silence, while the “Duck according to other track” function is best 
used when the modulating track holds a lot of short clips (without silence).
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Managing effects in the Plug-ins view

The Plug-ins view allows you to overview and manage plug-in effects 
used in a Montage. The view is divided into two panes:

Right pane

• The right pane shows all plug-in slots currently used for either the focused 
track or the focused clip.
Which is shown is selected by clicking the “C” button (focused clip) or the “T” button 
(focused track) or by selecting the respective item on the Options menu.

• There are two columns; Plug-in chain and Preset.
The Plug-in chain column will show all plug-ins used by a clip or track as a chain according 
to the slots used. The Preset column will show the name of the preset used.

• Double-clicking an effect opens it for editing.

• You can also save and load plug-in chains – see “Saving and loading plug-in 
chains” on page 485.
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If you right-click on an effect in the Plug-in chain column, a pop-up opens 
with the following options:

Left pane

• The left pane shows all the available plug-ins in a tree list. 
Used plug-ins have a plus sign beside the name. Clicking the plus sign allows you to see 
exactly which clips or tracks are currently using the corresponding effect, and which slot 
each effect uses. For clip effects you can also see the clip start time in brackets.

Option Description

Find in plug-in 
tree

When you select this option, the lift pane displays the clip/track which uses 
this effect.

Edit… This opens the Effect dialog for the corresponding effect.

Copy This will copy the effect and its settings.

Paste This allows you to paste in the copied effect in another slot.

Remove This removes the current effect from the slot. The slot itself will then read 
“Unused slot”. You can now either select a new effect for the slot or leave 
the slot unused.

Move up/down This allows you to reorder the plug-in chain.
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If you right-click on the plugin name, a pop-up opens with the following 
options:

If you right-click on the the clip or track name in the tree, a pop-up opens 
with the following options:

• You can also drag and drop plug-ins from the left pane to a slot in the 
right pane.
You can either drag a plug-in, or a clip or track plug-in instance, i.e. the plug-in and its cur-
rent preset. You can replace a slot, or insert into an empty slot this way. To insert it in be-
tween two used slots press [Ctrl] and drag.

Saving and loading plug-in chains

You can save complete plug-in chains which can later be loaded:

• Select “Save plug-in chain…” from the Options menu in the right pane.
A file dialog opens where you can name the plug-in chain. Plug-in chains have the exten-
sion “.set”, and are by default stored in the Montage Plugin chains folder. 

Option Description

Remove from all clips 
and tracks that use it

This removes all instances of this plugin in the Audio Montage.

Replace with clipboard 
in all clips and tracks 
that use it

If a plug-in has previously been copied into the clipboard, it will be 
used to replace the selected plug-in (in all clips and tracks). This is 
useful if you want to replace a plug-in with another in the whole Mon-
tage, or if you want to update a plug-in to use different settings.

Add to selected clips This is an easy way to add a plug-in to all selected clips in one oper-
ation.

Option Description

Show plugin chain This will display the plug-in chain that uses this plug-in in the right pane.

Edit… This opens the Effect dialog for the corresponding effect.

Zoom on this clip/
Make this track visible

This will focus the Montage on the plugin host; either the clip or the 
track.

Copy This will copy the effect and its settings.

Paste This allows you to paste in the copied effect into another slot.

Remove This removes the current effect from the slot. The slot itself will then 
read “Unused slot”. You can now either select a new effect for the 
slot or leave the slot unused.

Add to selected clips This is an easy way to add a plug-in to all selected clips in one oper-
ation.
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To load a saved plug-in chain, proceed as follows:

1. Select the track or clip you wish to apply it to.
Plug-in chains can only be applied to the clip with selection focus (red name label).

2. If you wish to apply the chain to the focused clip, select “Show plugins of 
focused clip” (on the Options menu or click the “C” button). If you wish to 
apply the chain to the selected track, click the “Show plugins of focused 
track” (“T” button).
E.g. if a track is selected and a clip on this track (or any other track) has selection focus, this 
governs what the effect chain will be applied to, the track or the clip.

3. Select “Load plug-in chain…” from the Options menu.
The plug-in chain is loaded.

The Meta Normalizer
The Meta Normalizer, found on the Edit view : Special menu, is a special 
Montage version of the Batch plug-in processor with the same name that 
is also included with WaveLab. The basic functionality is similar but in-
stead of processing batched files, it processes clips. The processing is 
non destructive, i.e. it will not affect the source audio files. 

The Meta Normalizer operates in two or three passes. It first analyses the 
peak or RMS levels on all clips in the Montage. Then it processes the 
clips according to the highest possible level found amongst the clips, so 
that they will all play back at equal peak or RMS levels. This is achieved by 
automatically adjusting the clips “Gain” setting in the clip list. Note that 
the gain level of a clip can either be amplified or reduced. The two pur-
poses of the Meta Normalizer are to equalize the loudness between all 
clips (useful e.g. when producing a CD) and to ensure that the full mix-
down of the Montage will never clip. Depending on how much the levels 
differ between clips, there are a number of options available to ensure 
that the applied processing optimizes the levels without clipping.

The audio path in WaveLab uses 32 Bit floating point processing. You can 
therefore “overload” it, i.e. use levels above 0 dB, without running the risk of 
causing clipping in the signal path. The only section of the audio path that 
can introduce clipping is the output of the Master Section, and this can also 
be taken care of by the Meta Normalizer.
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The Meta Normalizer dialog

The Meta Normalizer settings dialog

Selecting the Meta Normalizer from the Edit view : Special menu opens a 
dialog where you can set up various options before applying the process-
ing. The dialog is divided into two pages; “Settings” and “Schedule”, which 
you can switch between by clicking on the appropriate tab at the top of the 
dialog. In the Settings dialog you specify how the clips will be processed, 
and in the Schedule dialog you set up options related to the performance of 
the processing (which always happens in the background).

The options on the Settings tab in the Meta Normalizer dialog are listed 
on the next page.

• The Meta Normalizer’s Schedule settings are similar to those in the Batch 
Processing dialog (see “Scheduling” on page 299).

• When you have set up the Meta Normalizer dialog, click the “Process” 
button to activate processing.
Processing happens in the background. You can go on working in WaveLab during the 
processing, although not in the Montage being processed.
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The following options are available in the Meta Normalizer dialog:

Option Description

Equalize Clip Volume Selecting this will process all clips in the Montage according to 
the highest possible level or loudness found amongst the clips, so 
that they will all play back at equal levels.

Equalize peak level Select this option if you want to use peak levels as a basis for de-
termining what is considered “equal level” when executing Equal-
ize Clip Volume.

Equalize loudness 
(RMS)

Select this option if you want to use RMS (Root Mean Square) 
levels as a basis for determining what is considered “equal level” 
when executing Equalize Clip Volume. RMS normally produces 
more natural results than using Peak levels, since this method is 
better at detecting the perceived “loudness” of a sound.

Global When this is activated, the RMS value is calculated over the 
whole clip. That is, the overall loudness of entire clips will be used 
as a basis for calculating the loudness.

Resolution 
(0 – 10 seconds)

This option is only relevant if “Equalize Loudness (RMS)” has been 
selected and “Global” is deactivated. It is used to set the size of the 
audio sections that are analysed when calculating the loudness. 
The loudest section found will be used. The smaller this value, the 
more sensitive the method will be to peaks in the material.

Normalize Mix 
(Master Section Input) 
(-24 to 0 dB)

If this is selected, the entire Montage mix will be normalized to a 
preset level at the Master Section input. The maximum level that 
can be used is 0 dB. Since there is no risk of clipping in the 32 bit 
internal audio path, you can usually turn off this feature.

Normalize Master Section 
Output 
(-24 to 0 dB)

If this is selected, the entire mix will be normalized to a preset level 
at the Master Section output. The maximum level that can be used 
is 0 dB. This function is useful before you mix down or create a CD. 
Note that this function affects the output of the Master Section, 
which is “outside” the actual Montage. Therefore, the effect of this 
function is not saved when you save the Montage.

Exclude effects If this is selected, effects will not be taken into account when pro-
cessing with the Meta Normalizer.

Only selected clips If this is selected, only selected clips will be processed with the 
Meta Normalizer.
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Groups
In many situations, it is useful to work with several clips as one entity. This 
is easily done by grouping them in the Groups view.

Grouping clips

1. Select the clips you want to group.

2. Click the Groups tab to select the Groups view.

3. Select “Group selected Clips…” from the Groups view : Grouping menu, 
or click the Group icon.

4. Enter a name for the group in the dialog that appears and click OK.
The new group appears in the group list. All clips included in the group will also have the 
name of the group prepended to the clip names in the Track View.

This clip belongs to the group “Introduction”.

A group selected in 
the Groups view.

The clips in the se-
lected group are au-
tomatically selected 
in the Track View.
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Adding clips to an existing group 

If you already have a group, and want to add one or several clips to that 
group, this is done in the following way:

1. Select the clips you want to add.

2. In the Groups view, select “Group selected Clips” from the Grouping 
menu, or click the corresponding icon.

3. In the dialog that appears, select the group to which you want to add the 
clips.

4. Click OK. 
The clips are added to the group.

• If you want to create a new empty group, to which you can add clips one at a time, 
start by selecting “Add empty Group” from the Groups view : Grouping menu.
This creates an empty group in the list, to which you can later add clips. 

• It is possible to create nested groups, by adding a group to another group.
This can be useful, since it allows you to deactivate the grouping for some subgroups only, 
as described below. For clips in nested groups, all group names are displayed before the 
clip name (separated by “:”)

• A clip cannot be part of more than one group.
If you add a clip to a group, it is automatically removed from any other group it is part of.

A nested group in the Groups view.

A clip belonging to the nested group.
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Group options

There are a couple of options in the Groups view that affect how groups 
are handled:

• You can temporarily “turn off” a group by deactivating the checkbox to the left of 
a group in the list.
When the group is deactivated this way, you can move individual clips in the group, as if 
they were not grouped.

• If the option “A mouse click selects a group” is activated on the Groups view : 
Options menu, selecting a clip in the Track View automatically selects all clips in 
the same group.
If the option is deactivated, selecting a whole group requires that you click on the group 
name in the Groups view list. This is useful if you want to be able to modify the relative po-
sitions of clips in the group, without having to remove them from the group.

You can also turn on or off “A mouse click selects a group” by clicking this icon.

Coloring groups

You can select a specific color for a group to make it easy to discern it in 
the Track View:

1. Select the group by clicking on its name in the Groups view list.

2. Pull down the Groups View : Grouping menu and select the desired color 
from the “Color selected group” submenu.
For more information about Audio Montage colors, see “Styling WaveLab – Audio Montage 
windows” on page 739.

Any individual color selections for the clips will override the group color.

Removing groups

1. Select the group by clicking on its name in the Groups view list.

2. Pull down the Grouping menu and select “Remove selected group”.
The group is removed (the clips are not affected).
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Using markers in the Montage
Separate markers are provided for use in the Montage. Markers are used 
in the Montage in much the same way as in the source Wave windows. 
See “Markers” on page 327 for details regarding marker types and the 
basic functionality of markers.

It is also possible to view the markers of a clip’s source audio file, by acti-
vating the option “Show source’s ruler and markers” on the clip speed 
menu.

Creating markers

The quickest way to create a marker is to right-click in the area above the 
ruler and select a marker type from the pop-up menu that appears. Right-
clicking this way automatically moves the cursor to the click position (pro-
vided that you don’t click on an existing marker) and inserts the marker at 
the cursor position – i.e. the position at which you click. 

Creating markers by right-clicking can be done regardless of what view is 
currently selected.

 
The Markers view

When the Markers view is selected, you can create markers at the Mon-
tage cursor position by using one of the following methods:

• By selecting a marker type from the Markers view : Functions menu.
• By clicking on one of the marker icons.
• By pressing the [Insert] key (this creates a Generic marker).

You can also use any of the above methods to create markers at the current 
cursor position while playing back.
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Importing markers

When you use the option “Create Audio Montage from Wave” on the Edit 
menu to create a new Montage from an open wave file, you can choose to 
import any existing markers in the file so that they will be present in the 
Montage as well.

This is done by activating the option “Translate markers” in the Wave to 
Audio Montage dialog.

This dialog lets you specify a number of options for how the wave file 
should be inserted into the new Montage. Click the question mark icon in 
the dialog for details.

Moving markers in the Track View

To move a marker in the Track View, you click and drag it. The Magnetic 
bounds setting on the Edit view : Options menu applies.

You can also move a selected marker with the Nudge function (see 
“Nudging” on page 430).

Deleting markers

There are three ways to delete markers in the Montage:

• By right-clicking the marker head and selecting “Delete marker” on the 
menu.

• By selecting the markers and then selecting “Delete selected markers” on 
the Markers view : Functions menu.

• By dragging the marker up and dropping it outside the ruler.

Selecting marker types to show/hide

By using the Markers view : Filter menu you can select to show or hide 
certain marker types in the marker list view. By default, all marker types 
are shown.
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Converting markers

You can convert any type of marker to another marker type. This is done in 
the “Convert marker type” dialog, which is opened from the Markers view : 
Functions menu. See “The Convert marker type dialog” on page 335.

Renaming markers

You can use the Batch Rename dialog to rename multiple markers. See 
“Markers” on page 311.

Editing in the markers list view

Clicking on the Marker tab opens the Markers view in the upper pane of the 
Montage. By default, this list contains all markers currently in the Montage. 
Below the Montage tabs there is a row of marker icons, and to the left of 
them are the Markers view : Functions and Filter menus. The markers list 
columns are used for editing and/or displaying the following marker data:

Option Description

Type This column displays the corresponding marker type icon. Clicking the 
icon opens a pop-up menu where you can select a new marker type for 
the current marker position.

Name Displays the marker name. Double click the name field to type in a new 
name. This can also be done by double clicking to the right of the marker 
head in the area above the ruler (the pointer changes shape when you 
move it into the “Marker name zone”).

Position This column displays the markers’ time positions. Double click to edit.

Lock If this is ticked, the marker cannot be moved by dragging the marker head.

Clip reference By selecting one of the Functions menu items “Make current marker rela-
tive to start of focused clip” or “Make current marker relative to end of fo-
cused clip” you can lock a marker position to the left or right edge of a 
clip. This column displays the name of the clip to which a marker is locked.

Offset Depending on which of the two Functions menu items described above is 
chosen, this column displays the time offset between the clip edge and 
the marker position.
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About locking marker positions to clips

As described in the table above, you can lock markers to clips by select-
ing one of the Functions menu items “Make current marker relative to start 
of focused clip”, “Make current marker relative to end of focused clip” or 
“Make current marker relative to audio of focused clip”. If selected, the 
marker will remain in the same position relative to the clip start (or end) 
even if the clip is moved in the Montage or is resized. 

Selecting the Functions menu item “Detach current marker from its rela-
tive clip” removes the marker’s clip reference and the marker position is 
no longer locked to the clip.

About attaching markers to clips

On the Functions menu there are two items that control if and how markers 
you insert should be automatically attached to existent clips. If a marker is 
attached to a clip, the marker will move with and maintain its relative posi-
tion to the clip if the clip is moved or resized.

Activating the option “Attach automatically new markers to the most suit-
able clip” results in the following:

• If a marker is created within the boundaries of a focused clip or a clip on a fo-
cused track, the marker is attached to the audio of that clip (as per the option 
“Make marker relative to audio of focused clip” described above).

• If a marker is created outside of any clips on the focused track (or if there is no 
clip on the focused track) but within the boundaries of a clip on any other track, 
the marker will be attached to the audio of that clip.

• Note that if the inserted marker is of the type CD or DVD track start or end, 
it can be inserted farther away from a clip edge than 2 seconds and still get 
attached. 
All other types of markers must be inserted within 2 seconds from a clip edge.

Activating the option “Full clip attachment” will cause attached markers to 
not only remain in position relatively to clips when you move them, but 
also to be attached during clip operations. That means; if you copy a clip, 
the attached markers will also be copied. If you delete a clip, the attached 
markers will also be deleted.

Export marker list as text

This item on the Markers view : Functions menu opens a dialog allowing 
you to save the marker list as a text file. The list will contain the markers’ 
names, positions and types. You can select to format the text in one of 
three ways; Pure text, Excel (tabs) or XML.
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Undo/Redo and History
The Audio Montage has a separate Undo/Redo list, independent from the 
Undo/Redo of Wave windows. If you have several Montages, each win-
dow has its own Undo history.

Undoing and redoing commands in the Audio Montage is done as in the 
Wave windows (by using the Edit menu, or by pressing [Ctrl]-[Z] or [F3] 
for Undo, and [Shift]-[Ctrl]-[Z] or [F4] for Redo). However, the Audio Mon-
tage has a special History view, which displays the Undo history as a list 
and makes it possible to undo several commands in one go.

The History view

In the History view, all operations you have made are listed. Furthermore, 
if you recently have undone any operations, these will be listed as well, al-
lowing you to redo them (as long as you don’t perform any other opera-
tion, in which case the undone operations will disappear from the list).

The list works in the following way:

In the figure above, selecting Undo would undo the operation “Group 
clips” at the green arrow. This operation would then be displayed in yel-
low, and the green arrow would move one step down in the list.

• You can hide columns in the History view, by using the Columns pop-up 
menu.
This is accessed by clicking the arrow button to the left of the column headings.

Yellow items indicate 
undone operations.

The green arrow 
indicates the last 
action performed.

The numbers indicate how many operations you can undo (nega-
tive numbers) or redo (positive numbers).

The type of performed/
undone operation.

The time when you performed 
or undid the operation.

A detailed description 
of the operation.
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History view Functions

On the History menu in the History view, the following functions and op-
tions are available:

The History view also contains the Montage Backup functions, see 
“Backing up Montages” on page 503.

Option Description

Undo last operation This is the same as the Undo command on the Edit menu. You can 
also undo the last operation by clicking the green arrow icon above the 
list (or in the main control bar).

 

Undo until selected 
operation

This is only available if you have selected an operation in the History list. 
Selecting this function undoes all operations up to and including the 
selected one. This is a quick way to undo several operations in one go.

Undo all operations 
since last saving

This is similar to “Revert to saved” on the File menu, with two differ-
ences: It does not undo any view, zoom or position changes, and it 
does not clear the History list.

Undo all operations Undoes all operations in the list, even those done before the last save.

Redo last undone 
operation

This is the same as the Redo command on the Edit menu. You can 
also redo the last undone operation by clicking the yellow arrow icon 
above the list (or in the main control bar).

Redo all undone 
operations

Redoes all undone operations in the list, i.e. all operations displayed in 
yellow.

Clear History now Removes all operations from the History list. If you use this function, 
you cannot undo any previous operations.

Clear History after
each saving

When this option is activated, the History list will be cleared each time 
you save the Montage.

Group similar 
operations

When this option is activated, and you perform several, similar opera-
tions one after another, these will later be “compressed” into one Undo 
operation.
Let’s say you move a clip in several steps until you find the perfect po-
sition. While you are doing this, it is still possible to undo each sepa-
rate movement as usual. However, as soon as you perform another 
operation, all the previous moves (the “similar” operations) will be con-
sidered as one single entry in the Undo History. This saves memory, 
and makes work quicker since you don’t have to undo every single 
step to revert to the clip’s original position.
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File handling in the Audio Montage

Saving the Montage

You save the Montage using the Save or Save As commands on the File 
menu. Audio Montage files have the extension “.mon”. 
A couple of things to note:

• The Montage files do not contain any audio data in themselves.
Rather, they contain references to audio files. This means that you must make sure not to 
delete, move or rename any audio files referenced by Montages.

• You can use the Rename dialog to rename (and/or move) audio files and 
automatically update all clip references.
See “Renaming files and documents (Rename)” on page 121.

• If the Audio Montage contains clips that refer to untitled audio files, you will 
be asked to save these audio files before you can save the Montage.

• WaveLab can save Montages automatically.
See “Backing up Montages” on page 503.

• You can store the current settings in the Master Section as part of the Mon-
tage, by selecting “Store current Master Section’s configuration” from the 
Edit view : Special menu.
To apply the settings stored in a Montage to the Master Section, select “Restore Master 
Section’s configuration”.

There are two alternative ways to store/recall a Master Section preset for 
a Montage: 

• [Ctrl]-click the “M” button in the title bar.
The button is now green to indicate that the current Master Section configuration is stored 
with the Montage. If you later load this Montage, click the green M button to restore the 
Master Section preset. 

• You can right-click the Master Section Presets button and select “Save in 
audio window” to store a preset.
To recall this preset later, simply right-click the Presets button again and select “Restore 
from audio window”.



WAVELAB
The Audio Montage 19 – 499

Saving a Montage template

Once you have set up the Audio Montage window the way you want it, 
you can save it as a template. The template file contains all settings and 
options in the Montage, but no clips. Next time you create a new Audio 
Montage (by selecting New Audio Montage on the File menu), the tem-
plate file is used as a basis for the new Montage. This allows you to create 
a custom track layout and other settings, once and for all.

To save a template, pull down the File menu and select “Save as tem-
plate…” from the Save special submenu.

• You can only have one Montage template – saving a template will overwrite 
the previous template.

• When a new Montage is created based on the template, the new Montage 
will automatically get the sample rate saved in the template.
To change this, select Audio Properties from the Edit menu and select another sample rate 
in the dialog that appears.

Opening Montage files

To open a saved Audio Montage (.mon) file, pull down the File menu and 
select “Audio Montage…” from the Open submenu.

If any of the audio files referenced in the Montage cannot be found, you 
will be asked to locate them manually. In the file dialog that appears, it’s 
also possible to replace the missing file with another – useful if you have 
renamed the original audio file.

Closing the Montage

Closing the Montage is done as with any document window, by clicking 
the window’s close button or by selecting Close from the File menu. If you 
have unsaved changes, you will be asked whether you want to save the 
Montage before closing it.

• If you have recorded audio files in the Montage, and close the Montage 
without saving it, the recorded files will automatically be erased.
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Cloning Montages

There are two ways to make a “clone” of an Audio Montage: “Quick clon-
ing”, in which the new clips will reference to the original audio files, and 
“Full cloning”, in which the actual audio files are cloned as well, creating a 
new “self-contained” Montage.

Quick cloning

This method is useful if you want to create several versions of the Montage, 
for example experimenting with variations. Note however that any process-
ing or editing you apply to the actual audio files will be reflected in both 
Montages, since they share all file references.

1. Select the Edit view by clicking the Edit tab.

2. Pull down the Edit view : Special menu and select “Quick cloning (reuse 
audio files)”.
A clone of the Audio Montage is created and appears in a new untitled window.

• You can also create a “quick clone” by clicking the document button of the Mon-
tage window and dragging to an empty area in the WaveLab window.

Full cloning

There are several uses for Full cloning. 

• Since the cloned Montage will have its own audio files, you can edit and process 
these files without affecting any other Montages. 

• It is also a good way to “pack” the Montage, removing all unused audio sections. 
• Even if you don’t need a copy of the Montage as such, you can use this feature to 

split audio files and give them specific names (using the “Create exactly one file 
per clip” option).

Note that Full cloning doesn’t render effects to files (as does the Render 
function). It merely “re-maps” file references.



WAVELAB
The Audio Montage 19 – 501

Proceed as follows:

1. Select “Full cloning (recreate audio files)…”, either from the Edit view : 
Special menu or from the Save special submenu on the File menu.
A dialog appears.

2. Specify a path and file name for the Audio Montage clone.
If you specify a folder that doesn’t exist, it will automatically be created. The cloned audio 
file(s) will be stored in the same folder as the Audio Montage clone.

3. Select one of the “How to recreate audio files” options:

Option Description

Recreate exact audio 
files

The cloned audio files will be exact copies of the original files. Un-
used ranges are not removed.

Combine optimally all 
audio files into a single 
audio file

All used ranges in the original audio files are copied and combined 
into a single audio file, to which the clips in the clone will reference. 
The file will get the same name as the Montage clone file.
Note: If the Montage contains both mono and stereo clips, there will 
be two “combined” audio files, one for the mono material and one 
for the stereo material. In this case, the file names will have the suffix 
S (stereo) and M (mono), respectively.
Also, this option is not recommended if clips on different tracks play 
back the same audio files at the same time.

Keep same number of 
files but remove unused 
ranges

The same number of audio files will be created, but any unused 
ranges in the files are removed.
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4. If you later want to be able to lengthen the clips in the cloned Montage, 
you need to specify a clip margins value greater than zero.
This feature allows you to add a specified number of seconds before and after the begin-
ning and end of the clip range in the created audio files. 

This is only relevant if you have selected any other option than the first one 
(“Recreate exact audio files”).

5. If you want the clips in the cloned Montage to have the names of their re-
spective audio file, activate the option “Reset clip names from file names”.

6. If you want the markers in the original audio files to be included in the 
cloned files, activate the option “Copy audio file markers”.

7. Click the Schedule tab to make settings for Priority, Completion, etc.
The options are the same as when using the Render function in the Master Section (see 
“Options on the Schedule tab” on page 242). Note that the process will happen in the 
background, allowing you to continue working in WaveLab (although not with the Montage 
being cloned).

8. Click Clone.
The audio files and the Montage are cloned. When finished, the cloned Montage will appear 
in a new Montage window.

Split files to remove 
unused ranges

Unused ranges in the files are removed, but instead of concatenat-
ing the used sections of a file (as with the previous option), the file is 
split when a range is removed.

Create exactly one file 
per clip

Every clip in the Montage clone will reference to a unique file, con-
taining only the audio used in the clip. The files will be named after 
the clips, with the addition of a number if several clips have the 
same name.

Create one file per clip, 
avoid duplicates

As the previous option, but if two clips use the exact same audio 
range, a common file is created for these clips.

Option Description
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Backing up Montages

The Audio Montage has a special backup mechanism, which allows you 
to maintain previous versions of saved Montages, and have the Audio 
Montage automatically saved. It works in the following way:

• Each time you save the Audio Montage, the previously saved version is copied to 
the subfolder “Backup.mon” (in the same folder as the Audio Montage file).
This backup folder is automatically created by WaveLab. The backup files are named 
“Montage_#X”, where “Montage” is the name of the Montage and “X” is a number.

• You can specify how many previous versions you want to keep.
The maximum number of stored backup versions is 1000 (this is possible since Montage 
files are small, containing no audio data). Once the specified number of backups has been 
created, the oldest file will be overwritten each time the Montage is backed up.

This means that the numbers in the backup file names are not related to the 
age of the backup files. Instead, you need to check the dates of the files to 
know which backup is the most recent.

• “Untitled” Montages (that are not yet saved) are also backed up.
The backup files for “Untitled” Montages are saved in the Windows temporary folder, and 
use a number as Montage name, so that the files are called “Y_#X”, where “Y” is a number 
identifying the Montage and “X” is the number of the backup file. Once the Montage is 
saved, these “temporary backup files” can be discarded.

Setting up

You make backup settings in the History view:

1. Select the History view by clicking the History tab.

2. Pull down the History view : Backup menu and select “Backup options…”.
The Backup options dialog appears.

3. Specify how many previous versions you want to keep (0 to 1000), in the 
“Number of backups” field.
Setting this to 0 is the same as turning off the backup for the Montage.
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4. Activate the Auto save checkbox if you want WaveLab to automatically 
save the Montage.
Use the value field to the right to specify how often the automatic save should be done (ev-
ery 5 to every 120 minutes).

5. Click OK to close the dialog.

Opening the previous version

The “Open previous version” function on the History view : Backup menu 
works as follows:

• If there are no unsaved changes in the Audio Montage, the most recent backup 
file is opened in a new window.
If you select the function from an open backup file, the previous backup version is opened, 
etc.

• If the Audio Montage has unsaved changes, the saved Montage file is opened in 
a new window.
This is not the same as “Revert to saved” on the File menu! The difference is that “Revert to 
saved” will close the current (unsaved) Montage and open the last saved version, effectively 
replacing the current Montage, while “Open previous version” will open the saved version in 
a new window, without closing the current, unsaved version.

Using video tracks

To be able to use video tracks, DirectX 9 must be installed.

You can edit audio in sync with video placed on a video track in the Mon-
tage. Video tracks are created from the track pop-up menu, just like audio 
tracks.

Adding video clips to the video track

There are several ways you can add video clips:

• By right-clicking somewhere on the empty video track and selecting “Insert 
file(s)”.
A file dialog opens where you can locate the video clip you wish to insert. The clip will be in-
serted at the cursor position.

• By dragging from the Files view (see “By dragging from the Files view” on 
page 384).

• By copying video clips from another Montage (see “By copying clips from 
another Montage” on page 386).
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Playing back a video clip 

Video clips are displayed as clips on the video track, with thumbnails rep-
resenting the frames in the film. If you start playback, the video is played 
back in the Track view for the video track.

Viewing video clips in the Video view

You can also view the film in the upper Montage pane if you select the 
Video view. Here you can set a number of view options:

• To view the video in full screen mode, press [Shift]+[A]. 
Use this same command to reset the view.

• If you make a selection range in an audio clip that is placed in the same 
time line as the video clip, there will be three visible images in the upper 
pane placed side by side.
The middle display shows the film, and the left and right displays will show still images in the 
video clip relating to the boundaries of your audio selection. You can use [Esc] to toggle 
between showing/hiding the audio selection boundaries.
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The Video view Options menu

There are two items on the Video view : Options menu:

• Play video in track (at cursor).
If this is ticked, the video frames will play back in the Track view at the cursor position. If this 
is off, the frames will be displayed as non-animated thumbnail images.

• No video playback in track when this tab is open.
If both options are ticked, the frames will be displayed as non-animated thumbnail images 
when the Video view is selected, but otherwise play back.

Editing video clips in the Montage

You can perform basic functions like moving the video clip by dragging it 
in the time line, lock the clip position, use Split at cursor, copy and paste, 
etc. All available functions are displayed on the clip speed menu for a 
video clip.

Multichannel operation in the Montage
WaveLab supports the use of up to 8 ASIO inputs and outputs. Using a 
multichannel audio interface with an ASIO driver you can route Montage 
audio tracks to up to 8 separate channel outputs and up to 6 surround out-
puts. You can also record up to 8 channels simultaneously, which automat-
ically creates new tracks in the Montage, one for each recorded channel or 
channel pair. 

Setting up for multichannel operation

To be able to use WaveLab for multichannel/surround projects, you need 
the following:

• An audio card/interface with multiple inputs and outputs (preferably 8).
• You have to select an ASIO driver in the Preferences–Audio device tab.
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The ASIO Audio Connections dialog

You also need to specify how WaveLab’s 8 internal input/output channels 
are connected to your audio card. This is done in the ASIO Audio connec-
tions dialog, which is opened by clicking the “Connections” button in the 
Preferences–Audio device tab.

• The 7 Surround channels are the available surround speaker channels.
Although you cannot use more than 6 surround channels in WaveLab, there are surround 
configurations available that include the mono Surround channel, which is not used in the 6 
channel mode. Hence the 7 available surround channels.

• You configure which Surround channel is connected to which ASIO out-
put by using the ASIO output pop-up menus for each channel.
How you should configure this naturally depends on your surround setup, the number of 
available channels, etc. See below for information regarding channel configurations.

• You can change the names of the WaveLab output channels in this dialog. 
However, these names are only reflected in the program when you have 
selected 8 channel (non-surround) mode.
For the surround modes, the channels are always named after the corresponding Surround 
channel.

• In the Input mapping section you select how the inputs on your audio card 
are mapped to the WaveLab input channels. These can also be renamed, 
and will be reflected in the Recording channels dialog.
See “Preparations” on page 521 for details about selecting recording channels in WaveLab.
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Selecting a channel configuration

You can configure the number of channels to use for each Montage. All 
multichannel (i.e. more than two channels) configurations except 8 chan-
nel mode are surround formats, and are internally assigned to surround 
channels in WaveLab as described previously.

The are two operational modes you can use for multichannel work in 
WaveLab:

• Using a surround configuration.
To access the surround configurations, you must first select DVD-Audio mode on the Edit 
view : Mode menu. In surround mode, tracks can be routed to one or several surround 
channels (Left/Right Front, Center, etc.). WaveLab supports configurations with up to 6 
surround channels (5.1).

• Using the 8 channel configuration.
To access the 8 channel configuration, you must select CD mode on the Edit view : Mode 
menu. In this mode, channels refer to the names of the 8 WaveLab output channels instead 
of the Surround channels. Tracks can be routed to one (mono tracks) or two (stereo tracks) 
of the 8 available output channels – see “About the 8 channel mode” on page 520.

• To select a channel configuration, open the Edit view : Mode menu. On 
this menu, all available channel configurations are shown, but if CD mode 
is selected at the top of the menu, only the stereo and 8 channel configu-
rations are available.

Here, a 6 channel (5.1) surround configuration is selected.
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Which configuration you should select depends on a number of factors:

• The number of outputs available on your audio card.
If you only have 4 outputs on your card, you can only use surround formats with 4 or less 
channels.

• Whether or not you intend to mix the Montage to a surround format.
If not, select normal stereo operation or 8 channel mode which is non-surround oriented, 
see “About the 8 channel mode” on page 520.

• The intended use of the final surround mix.
For example, if you want your mix to be compatible with the most commonly used 5.1 sur-
round set-up, select 6 channel mode.

About the surround channels

As mentioned before, there are 7 surround channels available (you use 
the ASIO Audio Connections dialog to specify how surround channels 
are connected to the outputs on your audio card – see “The ASIO Audio 
Connections dialog” on page 507), 6 of which can be used simulta-
neously. The surround channels are handled as either mono or stereo 
channels in WaveLab, depending on whether the corresponding sur-
round channel is stereo or mono. 

The following surround channels are available for the various multichannel 
configurations:

Surround channel Description

Left/Right front 
(Lf, Rf)

Used in all surround configurations. These correspond to standard left/
right stereo speaker positions in front of the listener. You should route 
a stereo track to these channels.

Center (C) This is placed in between the Lf/Rf surround speakers. You should 
route a mono track to this channel.

Low Frequency 
Effects (LFE)

The LFE channel is connected to a (often self powered) “subwoofer” 
and provides low frequency content (normally below 120Hz). It it nor-
mally used to provide special low frequency effects like deep rumbles, 
explosions, etc. For each channel routed to the LFE channel there is a 
low pass filter that allows you to extend or lower the low frequency 
range reproduced by the LFE channel. There are no strict rules for 
where to place the LFE subwoofer, but it is normally placed in an asym-
metrical position beside the Center speaker. You should route a mono 
track to this channel.

Surround (S) This is sometimes referred to as the “back” surround channel, and is 
normally placed in between the Left/Right surround channels. You 
should route a mono track to this channel.

Left/Right Surround These are placed behind the listening position, mirroring the Left/Right 
front speakers. You should route a stereo track to these channels.
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About the “Disable redundant modes” menu option

This is activated by default. On the Edit view : Mode menu you have proba-
bly noticed that some of the surround configurations are greyed out. You 
may also have noticed that in all surround configurations there is a slash “/” 
between some of the channels. If you look closer you can see that the 
greyed out channel configurations actually contain the same surround 
channel assignment as other (available) configurations, but that the slash 
there is placed between different channels. The reason for this is that the 
DVD-Audio specification allows for mixed sample resolutions within the 
same channel configuration, which therefore needs to be divided into two 
separate groups, e.g. the Lf/Rf channel group could have a higher sample 
rate resolution than the other surround channels in the same configuration. 
The slash indicates which channels belong to which group.

However, the use of mixed resolutions is not yet implemented in WaveLab 
so these modes are at the moment “redundant”.

Assigning tracks to output channels

When you select a multichannel configuration, new tracks are not auto-
matically created, you have to create and assign tracks to surround chan-
nels manually. However, when you import a multichannel interleaved 
audio file in the 5.1 format, tracks routed to the corresponding surround 
channels are automatically created, see below.

You select which output(s) a given audio track should be assigned to in 
the Audio dispatching dialog.



WAVELAB
The Audio Montage 19 – 511

1. To open the dialog, click in the area just below the track pop-up menu 
button for an audio track.

Click here… 

…to open the Audio dispatching dialog.

Which channels are available in the Audio dispatching dialog depends on 
the selected channel configuration, and whether the track is mono or ste-
reo. In the picture above a 6 channel (5.1) configuration has been se-
lected, and the Audio dispatching dialog was opened for a stereo track.

• The “Top” audio channels correspond to the left channel and “Bottom” 
audio channels to the right channel of a stereo track. For mono tracks the 
Top/Bottom channels are referred to as “Audio is sent to” and “Audio is 
also sent to”, respectively. This relates to how a mono channel is handled 
when using the surround panner (see “Surround panning” on page 512). 
The two channels are in fact the same (unless you use a stereo plug-in ef-
fect or clip panning in which case the output is stereo).

2. To route a track to an output channel (stereo or mono) you tick the corre-
sponding check box(es).
For stereo surround channels you select the left channel in the top area and the corre-
sponding right channel in the bottom area.

• If you have selected a surround format, you can route a track to several or 
all surround channels.
When you select more than two channels for a stereo track or more than one channel for a 
mono track, the Surround panner automatically appears in the Track Control area for the 
corresponding track (see below).
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Surround panning

As described above, you can route any Montage track directly to a sur-
round channel (or to a combination of surround channels) using the Audio 
dispatching dialog. However, you may also want to position a track freely 
in the surround image. This is done using the Surround Pan function. In 
this example, we assume that you have set up a Montage in 5.1 surround 
format and that you want to use the Surround Pan for a stereo track:

1. Locate the stereo track in the Montage and click the Audio dispatching la-
bel in the Track Control area (below the track number button).
The Audio dispatching dialog appears.

2. Activate the desired surround channels by ticking the corresponding 
checkboxes.
In this example, all surround channels are activated: Left front, Right front, Center, LFE, Left 
surround and Right surround.

• It’s possible to activate different surround channel combinations for the top 
(left) and bottom (right) audio if needed.
However, for now all surround channels for both stereo sides are activated to avoid confu-
sion.
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3. Click OK to close the dialog.
A surround pan indicator appears in the Track Control area. This is shown whenever a track 
is routed to a combination of surround channels.

4. Try clicking and dragging in the surround pan display.
As you see, dragging moves the blue dot – the position of the left (top) audio channel in the 
surround image. The red dot (the position of the right (bottom) audio channel) is automati-
cally mirrored horizontally. If you activate playback, you can hear the sound move between 
surround speakers.

The small surround pan display in the Track Control area can be used for 
coarse adjustments – but for more precise control of the imaging, you use 
the Surround Pan window:

5. Right-click the surround pan display in the Track Control area.
The Surround Pan window appears.

The Surround Pan window contains a larger version of the surround pan 
image and a number of settings. 
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• In the graphic display, the positions of the left/right audio channels are 
shown as small squares. The proportional signal levels from the individual 
speakers are indicated by colored lines from the speakers to the center of 
display.

• The graphic display shows the surround imaging of either the left/top 
(blue) channel or the right/bottom (red) channel – the color of the speaker 
lines shows which channel is selected for viewing and editing.
If you are viewing the left/top channel, you will see a blue square indicating the position of 
the audio. The other, grey square (which is mirrored horizontally) represents the other chan-
nel. Click this to view and edit this channel instead, it will be shown in red and red speaker 
lines will indicate the speaker levels.

• Each track can have its own Surround Pan window and you can have sev-
eral of these open at the same time if needed.

• You can resize the window as needed.

6. To pan the sound, click the blue square and move it to the desired position.
This pans the audio of the left/top channel – the other channel will automatically be mirrored 
horizontally.

• If you right-click in the graphical display, a pop-up menu appears allowing 
you to choose from a number of positioning “presets”.
This is a quick way to e.g. pan a signal fully left-front.
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7. If needed, adjust the settings to the left.
These are:

• You can use the Copy and Paste buttons to copy surround pan settings, 
e.g. from one track to another.

Setting Description

Center This determines how center source signals should be reproduced by 
the front speakers. With a value of 100%, the center speaker will pro-
vide the center source. With a value of 0%, the center source will be 
provided by the ghost image created by the left and right speakers. 
Other values will produce a mix between these two methods.
Note that this is only available if the Center channel is activated in the 
Audio dispatching dialog.

Divergence Determines the attenuation curve used when positioning sound 
sources. If this is set to 0%, positioning a sound source on a speaker 
will set all other speakers to zero level (-∞) (except for the center 
speaker which depends on the center level). With higher values, the 
other speakers will receive a percentage of the sound source – the 
sound will be less localized.

Front/Rear ratio This determines how much the front and rear levels are affected by the 
vertical positioning in the Surround Pan window. The higher the ratio, 
the less the difference between sounds panned front and rear. If this 
is set to 100%, the rear and front levels will always be the same.

Constant Power This determines whether the power (RMS) or the level of the summed 
signals should be preserved. If set to 100%, the total power (RMS) will 
be the same regardless of panning; if set to 0% the total level will be 
the same.

LFE Gain Sets the amount of signal sent to the LFE channel.
Note that this is only available if the LFE channel is activated in the 
Audio dispatching dialog.
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Using LFE

The LFE (Low Frequency Effects) channel should typically be used with 
great care – in many cases you don’t need to activate this at all for a track. 
If the LFE channel is activated in the Audio dispatching dialog, the follow-
ing settings are available:

• Low pass filtering.
When this checkbox is activated in the Audio dispatching dialog, a 12dB/octave low pass 
filter will be applied to the LFE signal, so that only the low frequency content is let through. 
You can adjust the cutoff frequency for the filter if needed.

• LFE Gain.
This setting in the Surround Pan window determines the amount of signal sent to the LFE 
channel. You can also automate this using the LFE envelope (see below).

Using Surround Pan envelopes

You can automate surround panning for individual clips using envelopes. 
This is slightly different from using regular volume and pan envelopes:

• Internally, there is a single surround pan envelope where each envelope 
point contains a complete surround state (left-right position, front-rear 
position and LFE amount).

• When you look at the envelope for a clip, you can choose to view either 
the Left-Right, Front-Rear or the LFE curve.
You select which envelope to view on the Show envelope submenu on the clip speed 
menu, as usual.

• If you add an envelope point to the Left-Right surround pan envelope for 
example, you will find that a point is automatically added to the Front-Rear 
and LFE envelopes, at the same position in the clip.
This is because there is actually only a single surround pan envelope – when you add an 
envelope point you really add it to this “full” surround pan envelope, and it is shown in all 
three views.
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Using the Surround Pan window

You can use the Surround Pan window to “program” each envelope point – 
this makes it easy to set up automated surround panning for a clip. Here’s 
an example. 

Let’s say that we want the signal to start at the front center position, then 
move to the left rear speaker and finally move to the right rear speaker. 
Proceed as follows:

1. Set up a track for surround panning by activating the desired surround 
channels in the Audio dispatching dialog.

2. Open the clip speed menu for a clip on the track and bring up the Show 
envelope submenu.

3. Select “Surround Pan (Left <-> Right)”.
Or, you could select the “Front-Rear” envelope – it doesn’t matter at this point.

4. The envelope currently has points at the very start and end of the clip – 
we want one more point, somewhere in between. Double click the enve-
lope to add a new envelope point in the middle of the clip.
This will be the position where the signal reaches the left rear speaker. Note that it’s only 
the position in the clip that is important when you create envelope points at this stage – not 
the vertical position of the point.

5. Right-click the surround pan display in the Track Control area to bring up 
the Surround Pan window.

6. Select the envelope point at the start of the clip.
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7. Use the Surround Pan window to position the sound as desired.
In our example, the panning should start in the front center position – drag the position 
square to the top middle of the display (or right-click in the display and select the “Front 
Center” preset).

8. Select the next envelope point in the clip and set the surround panning to 
the left rear speaker (move the position square to the lower left corner of 
the display).

9. Finally, select the last envelope point and set the surround panning to the 
right rear speaker (move the position square to the lower right corner of 
the display).
The Left-Right surround envelope curve now looks like this:
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10. Select “Surround Pan (Front <-> Rear)” from the Show envelope submenu 
for the clip.
The Front-Rear surround envelope curve looks like this:

11. Play back the clip.
You should hear the sound move from center front to left rear to right rear.

• To create more complex surround panning, add more envelope points 
and program these in the same way.

Editing the envelope curves directly

It is of course also possible to edit the envelope curves in a more conven-
tional way, by adjusting their points in the clip (see “The pan envelope” on 
page 469 for details on working with envelopes). This can be useful if you 
only want to change the LFE amount without affecting panning, or if you 
only want to change the left-right panning without affecting front-rear 
panning, or vice versa. However:

• Remember that if you move an envelope point, all surround pan envelopes 
are affected!
This is because you are in reality moving a single envelope point on the “total” surround pan 
envelope.
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About the “Import Surround audio file” option

This import option allows you to import multichannel interleaved files in 
the 5.1 format. This works as follows:

1. Open the Edit view : Mode menu and select the “6 channels” configuration.

2. Set the cursor where you want the imported files to be inserted and right-
click in an empty area for an audio track to open the Montage Insert 
speed menu.

3. Select “Import surround audio file” from the menu.
A file dialog opens, where you can select a single interleaved audio file, which must be in 
the 5.1 format.

4. Select the file and click Open.
The file is now automatically split into four separate files: two stereo (L/R front and L/R sur-
round) and two mono (center and LFE) files; and the Insert audio file dialog opens.

5. Here you can set various options for how the files should be inserted.
Click the question mark icon in the dialog for details. As you can see, each file is named af-
ter the original file but with the name of the surround channel it belongs to.

6. Each file is now placed on a different track, routed to the corresponding 
surround output.
Mono surround channels will be placed on mono tracks, and stereo surround channels on 
stereo tracks. 

About the 8 channel mode

To select this mode, you first need to select “Mode CD” on the Edit view : 
Mode menu. (This is merely a safety precaution, as this configuration is not 
supported in the DVD-Audio protocol – after selecting this configuration 
WaveLab will automatically switch to DVD-A Mode which is used for all 
multichannel configurations.) When 8 channel mode is selected, you can 
route tracks to one of the 8 output channels (mono tracks) or to a output 
channel pair (stereo tracks). 8 channel mode is non-surround oriented, 
and enables you to use the Montage as a straightforward 8 channel re-
cording/playback environment.

Channels are grouped as stereo pairs (1-2, 3-4, etc.), which is reflected 
in the Master Section and when rendering to multiple files, see “Render-
ing to multiple files or multichannel files” on page 530.
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Multichannel recording

• For a general description of Montage recording, see “Recording” on page 406.

You can record up to 8 channels simultaneously in the Montage. 

Preparations

To set up for multichannel recording, proceed as follows:

1. First you have to set up how the inputs on your audio card are connected 
to WaveLab’s internal channels.
This is done in the ASIO Audio connections dialog – see “The ASIO Audio Connections dia-
log” on page 507.

2. Open the Record dialog and click on the button to the far right in the Input 
section of the dialog.
The Recording channels dialog opens. Here you can activate the input channels you want 
to record from by activating the corresponding checkboxes.

• For each of the activated recording channels, a meter will be displayed in 
the Record dialog.

3. Open the Audio File Format dialog by clicking the Audio Format item in 
the top section of the Record dialog and select a format for the files to be 
recorded.
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4. On the “Channels” pop-up in the Audio File Format dialog either select 
the Multi Stereo/Mono or the Multi Mono option.
Multi Stereo/Mono will produce single stereo or mono files, depending on the activated chan-
nels in the Recording channels dialog. The channels are logically grouped as pairs (1-2, 3-4, 
etc.), and this governs the mono/stereo status of the recorded files and the tracks they will 
end up on. If you have activated channels 1, 2 and 3 for example, one stereo file (containing 
channels 1 and 2) and one mono file (channel 3) will be created.

5. Close the Audio File Format dialog and make sure that the “Add to selected 
track of montage” option is activated in the Record dialog.

Recording

1. Set the cursor where you want to start recording and activate Record, 
either from the track pop-up menu or the Record dialog.

2. When done, press Stop.
When you record multiple channels, new tracks will automatically be created in the Montage, 
one for each mono or stereo clip that is recorded. Each track will be routed to the same out-
put by default, but can be routed to any output used in the current configuration in the Audio 
dispatching dialog (see “Assigning tracks to output channels” on page 510).

• If you have activated more than 2 input channels in the Record channels 
dialog and select any Channel option except the Multi Mono or Multi Ste-
reo/Mono options, the activated recording inputs will be “mixed” and pro-
duce a single file (or two in case Dual Mono is selected).
If you have set things up this way and activate recording, an alert box will appear, asking you 
to confirm the operation.
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ASIO Instant playback switching

This tool (opened from the Tools menu) allows you to switch ASIO out-
puts. You can also use this tool to compare clips (routed to different out-
puts in the Montage) via one selected output pair.

You can for example use it to instantly switch between up to four different 
“takes” of a performance, or to switch between versions of the same clip 
(using different processing or effects) lined up on different tracks in the 
Montage for comparison purposes. 

Proceed as follows:

1. Select the 8 channel configuration from the Edit view : Mode menu.
For this configuration to be available, the Montage must be in CD mode.

2. Line up the clips you wish to compare (up to four) on separate tracks but 
on the same time line in the Montage, and route the tracks to different 
channel outputs. 
No other tracks should be routed to the these outputs. 

3. Select ASIO Instant playback switching from the Tools menu.
The dialog contains four large “buttons”, one for each output pair. Above the buttons you 
can select which ASIO outputs you wish to switch between.

4. Use the pop-up menus at the top of the dialog to select the output pairs 
you set up for each track in the Montage.

• You may want to set up a loop encompassing the clips you want to com-
pare in the Montage. 

5. Start playback.
You can now click on the buttons (or use the [1] to [4] buttons on the Numeric keypad) to 
mute/unmute the separate track outputs. 
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• If you activate “Solo mode” only one track/output will be heard at a time 
so you will switch instantly between the selected tracks/outputs.
Please note that the muting is not reflected in the Master Section.

• If you activate both “Solo mode” and “Redirect to the selected output 
pair” you will redirect all tracks/clips to the output pair selected with the 
Output radio buttons, regardless of the routing in the Montage.

Multichannel configurations in the Master Section

When you select a multichannel configuration (or switch from one config-
uration to another) on the Edit view : Mode menu, this is not reflected in 
the Master Section until you start playback. You can also refresh the Mas-
ter level pane by clicking the LED at the top of the pane.

The output channels for the selected channel configuration are then dis-
played in the Master Section, with one level fader and clip indicator for 
each output channel. The channels are color coded according to whether 
they are stereo or mono in the following way:

• Blue/orange faders indicate the left/right channels of a stereo pair, respectively.



WAVELAB
The Audio Montage 19 – 525

• Green faders indicate mono channels.

The Master Section with a 6 channel (5.1) configuration selected.

Stereo output channel faders are linked by default, but you can make inde-
pendent settings for the left/right channels if you click the Unlink button.

The Stereo button

If you have selected a multichannel/surround format, a “Stereo” button 
appears in the Master Level pane. When activated, you will monitor a ste-
reo mix of the Master Section outputs. This has two main uses:

• It allows you to listen to a stereo mixdown of a surround mix.

• It can be used to preview the Stereo Down Mixing settings for DVD-Audio 
projects.
See “Stereo Down Mixing” on page 537 for a description of this function.



WAVELAB
19 – 526 The Audio Montage

Master effects and multichannel Montages

Master effects for a multichannel Montage are handled in the same way 
as when working in stereo mode (see “The Effects pane” on page 225). 
However, there are a few things to note:

• Not all of WaveLab’s Master effects are compatible with multichannel 
operation.
Supported effects are: Peak Master, Puncher, Leveler Multi, Noise Gate, EQ-1 and Silence.

• When you apply Master effects to multichannel outputs, all output channels 
are processed with the same parameter settings.

• The included VST effects do not support multichannel inputs.

Dithering and multichannel Montages

For a complete description of the Dithering function, see “The Dithering 
pane” on page 231.

Basically you should use dithering when you are rendering a multichannel 
Montage to a lower bit resolution, especially when rendering to 16-bit 
resolution. 

• To apply dithering to a multichannel Montage, you must select the “Intern” 
dithering plug-in.
The plug-ins UV22 and UV22 HR are not compatible with multichannel operation.
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Mixing down – The Render function
The Render function in the Master Section allows you to “mix down” the 
whole Montage (or sections of it) to a single audio file, or to several files in 
case of a multichannel Montage (see “Rendering to multiple files or multi-
channel files” on page 530). 

The Render function can be used in many ways:

• It’s useful if you want to burn a CD from a CPU-intensive Montage, as it allows 
you to first render all track and clip effect processing and then burn the CD in a 
second pass (see “About the two CD write methods” on page 540).

• DVD-Audio projects are always rendered before burning, but the Render function 
is still useful for “printing” the effect processing for CPU-intensive Montages prior 
to the “final” rendering, allowing you to add more effects, etc.

• Surround channels can be rendered as multiple files, retaining the stereo/mono 
status of the individual surround channels (see “Rendering to multiple files or mul-
tichannel files” on page 530).

1. If you want to render the whole Montage from start to end, proceed to 
step 4.

2. If you want to render some of the clips only, select these.

3. If you want to render a certain section of the Montage only (on several 
tracks), make a selection range.
Note that although the selection range is only “horizontal”, all the audio on all tracks within 
the range will be included.

4. If necessary, mute or unmute tracks or clips.

Only unmuted audio will be included in the rendered file(s)!
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5. Click the Render button in the Master Section window.
The Rendering preferences dialog appears.

6. Use the radio buttons in the Source section to specify what you want to 
include in the created file.
The Time Selection and Selected Clips options will only be available if you made a selection 
range or selected clips, respectively (in step 2 and 3 above). 

• The Regions option will only be available if there are start/end region 
markers (Track/Loop/Region markers) in the Montage.
If Regions are selected, named files will be created.

If “Regions” is selected as the Source, the field normally used for the file 
name, is instead used to define the destination folder. Each region marker 
(or start marker) must have a unique name to create the files.

• Creating unique names for the regions can be done manually of course, 
but it is much quicker to have the program create these automatically. You 
can use the Batch Renaming tool for this. 
This allows you to define numerous options for renaming markers. See “Markers” on page 
311.

7. Activate the options as desired:

Option Description

No Tail When this is activated, any audio appended by the Master Section ef-
fects (such as echoes and reverb tails) will be cut off. Note that this 
doesn’t affect the Tail setting for clip effects (see “Tail” on page 479).

Copy markers When this is activated, any markers in the Montage are copied to the 
created file (only available when “Whole Montage” is selected).
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8. Select whether you want to create a named file or not.
If you activate “Create named file(s)”, you must specify a name and location for the file (or 
just a location in case Regions are used). If you don’t activate the option, a temporary file is 
created, with the bit resolution specified in the Preferences dialog–File tab. 

9. If “Create specific file” is selected you can click the item at the bottom of 
the dialog to open the Audio File Format dialog.
Here you can specify the various audio properties for the file(s) to be rendered. For certain 
compressed file formats (mp3/mp2/WMA/Ogg Vorbis), you can make encoding settings 
from the Encode pop-up menu. Click the question mark icon in the dialog for details.

Do fade-in/out at 
boundaries

“Do fade-in/out at boundaries” is selectable when “Regions” is acti-
vated. In this case, the generated files get a short fade-in at the start, and 
a short fade-out at the end.
The fade time and shape is set in the “Default fade/crossfade” section in 
the Preferences–Wave edit tab. The fade processor is located after the 
master fader, and before the post-master/dither slot. This allows the sig-
nal to benefit from dithering, if used.
If the fade time is longer than half the length of the processed file, it is not 
performed.

Create Basic 
Audio CD

This option (available when “Whole Montage” is selected and CD track 
markers have been added, see “Preparing the Audio Montage for CD/
DVD-Audio burning” on page 531) creates a temporary file of the whole 
Montage including clip and Master effects and opens it as a Basic Au-
dio CD window. This is a way to perform the processing and the CD 
burning separately (to conserve computing power). However, since not 
all Montage features are available in a Basic Audio CD, you may want to 
use the Create CD image method instead.

Create CD image 
and cue-sheet

This option (available when “Whole Montage” and “Create Specific file” 
are selected and CD track markers have been added) lets you export an 
Audio Montage as a CD image with an accompanying cue sheet (a text 
file identifying the CD tracks in the image file). The cue sheet and the 
image file it describes can then be imported into any CD recording ap-
plication that supports this function (including WaveLab), and written 
onto CD.

Open as new Audio 
Montage

If you have selected “Create CD image and cue-sheet”, you can select 
this option, in which case the created CD image will open as a new Au-
dio Montage on completion. This is the method to use when burning a 
CD from a CPU-intensive Montage, as it lets you render the processing 
and burn the CD in two separate passes, without losing any Montage 
functionality (see “About the two CD write methods” on page 540). If 
you have added DVD track markers in a Montage, this option is also 
available. Montages that are (or will become) part of a DVD-Audio 
project will always be rendered anyway before burning, but you could 
still use this option to “print” the Montage effects, allowing you to add 
more effects, etc. 

Option Description
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10. Close the Audio File Format dialog when you are done.

11. Click the Schedule tab to make settings for Priority, Start and Completion 
actions (see “Options on the Schedule tab” on page 242).

12. Click OK to create the file(s).

Rendering to multiple files or multichannel files

If you have selected the “Create specific file” option in the Render dialog, 
you can make numerous settings in the Audio File Format dialog before 
rendering. This dialog is opened by clicking the File Format item at the 
bottom of the dialog (where the current file format settings are shown). 
On the “Channels” pop-up menu in this dialog you can select the Multi 
Mono and Multi Stereo/Mono items (for rendering to multiple files). If you 
are rendering a surround mix to Multi Stereo/Mono files for example, the 
mono/stereo status of the rendered files will reflect the mono/stereo sta-
tus of the surround channels. In case the Montage to be rendered uses a 
6 channel (5.1) surround mode, two stereo files (Lf/Rf and Ls/Rs) and 
two mono files (C/Lfe) will be rendered. The names of the rendered files 
will also reflect the name of the surround channel they belong to.

If you render an 8 channel configuration using the Multi Stereo/Mono 
option, the channels are grouped as logical pairs (1-2, 3-4, etc.). Thus, for 
tracks routed to only one channel in a pair, a mono file will be created.

It is also possible to render single multichannel surround files in the WMA 
5.1 and 7.1 formats. To do this you must use the Windows Media Audio 9 
Professional encoder. Click the question mark icon in the dialog for details.
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Preparing the Audio Montage for CD/DVD-
Audio burning

See “Background information” on page 366 for a general description of the 
DVD-Audio format.

The descriptions in this section cover preparations for both CD and DVD-
Audio burning, as the basic procedures are almost identical. The term 
CD/DVD used there thus applies to options in both the CD and DVD-A 
view unless otherwise stated.

However, there are some important differences:

• A CD can be burned directly from within the Montage, which is not possi-
ble with DVD-Audio.
Montages are always rendered prior to the DVD burning process.

• While you make much the same preparations in the Montage for CD and 
DVD-Audio, e.g. using Markers to define tracks, etc., a DVD-Audio 
project can contain up to 9 Montages with up to 99 tracks in each Mon-
tage.
Thus, for DVD-Audio you will probably make preparations for several separate Montages 
that are to be included on the DVD first, then proceed to configure the DVD-Audio project 
where you add the separate Montages as groups. Lastly you render the files before the ac-
tual burning process takes place.

So for DVD-A the descriptions apply to making preparations for a single 
Montage, which can then later be added to a DVD-Audio project (see 
“DVD-Audio projects” on page 551) together with other Montages. Each 
Montage can have a different channel configuration, bit resolution and 
sample rate in the DVD-Audio project.

1. Make sure the Audio Montage contains exactly the material you want on 
the CD/DVD.

• Note that CD tracks must be at least 4 seconds long, and DVD tracks at 
least 1 second long. 

2. Select either CD or DVD mode from the Edit view : Mode menu, depend-
ing on what media you intend to use.

3. Click the CD/DVD tab to select the corresponding CD/DVD view.
This contains a CD/DVD track list, much like a Basic Audio CD. However, at this point, it 
will be empty (since there are no CD/DVD track markers inserted yet).
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4. Select “CD/DVD Wizard…” from the Functions menu (or click the “magic 
wand” icon).
The CD/DVD Wizard dialog appears. This contains a number of settings that help you auto-
mate the CD/DVD creation. 

5. Activate the option “Generate CD/DVD Track Markers” and activate the 
desired sub-options.
These options are:

• “Ensure minimum required size for CD tracks” is activated by default.
If a clip is shorter than 4 seconds, the CD end markers are moved to the right so as to make 
the track 4 seconds long (Red Book requirement).

Create markers at clip 
boundaries

This causes the CD/DVD Wizard to add CD or DVD track start and 
end markers at the beginning and end of all non-overlapping clips. 
Most likely, you want to have this activated.

Create markers at 
crossfade points

When this is activated, the CD/DVD Wizard will create CD or DVD 
boundary markers at all crossfade intersection points. Activate this 
if you have clips that overlap each other, but should become differ-
ent tracks on the CD.

Keep locked CD/DVD 
track markers

Normally, any previously created CD or DVD track markers in the 
Montage will be removed by the CD/DVD Wizard. However, if this 
option is activated, any locked CD or DVD track markers (see “Ed-
iting in the markers list view” on page 494) will be kept.
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6. If you like, activate the option “Adjust pause before tracks”.
This automatically adjusts the pause before each track, either to a fixed value (as specified 
in the Set time value box) or to the number of whole seconds closest to each current pause 
in the Montage. 
If you want to adjust the pauses between tracks but don’t want the start time of the first 
track in the Montage to change, be sure to activate “Don’t change first pause”. If you do, the 
original position of the first track will not change relative to the start of the Montage.

• The Red Book audio CD standard requires that the pause before the first 
track is at least 2 seconds (this does not apply to DVD-Audio).
If the option “Automatically set the standard duration for pause #1” is activated on the CD/
DVD-A view : Options menu, WaveLab will automatically adjust the first pause to 2 sec-
onds. This option is activated by default.

7. Adjust the other settings if you want.
Click the question mark icon in the dialog for details.

8. Click Apply.
The dialog closes. Now, CD or DVD track markers are generated and pauses are adjusted 
according to your settings. The CD/DVD view will now display a list of CD or DVD tracks, 
as defined by the corresponding track markers.

9. You can use the Play Next/Play Previous buttons on the toolbar (also 
available on the Functions menu) to audition tracks.

10. You can use the “Play all track starts” playback option on the toolbar (also 
available on the Functions menu) to check the beginning of – or the tran-
sition between – consecutive tracks, see “Checking transitions between 
tracks” on page 539.

11. If needed, you can adjust the CD or DVD track markers manually in the 
Track View or Markers view.
An example of a situation where you would need to add markers manually would be a con-
tinuous recording (one clip, e.g. a live recording), which you want to divide into separate 
CD/DVD tracks. Since this would contain neither clip boundaries nor crossfade points, the 
CD/DVD Wizard would not add any markers (apart from at the start and end of the whole 
clip). Then it would be necessary to add track splice markers at the desired positions. Other 
instances are track indexes (see “The different types of “events” on an audio CD” on page 
578 – this describes events on an audio CD but applies to events on a DVD-A as well). 
However, in most cases the CD/DVD Wizard will do a good job, and we recommend that 
you don’t edit the generated markers unless you really need to.

12. Select “Check” from the CD/DVD-A view : Functions menu or click the 
“glasses” icon.
WaveLab will check the CD/DVD list and inform you whether it’s OK or not (this check is 
also performed automatically before actually burning a CD from the Montage). For DVD-Au-
dio you can also use the check function for all Montages added to a DVD-Audio project be-
fore the final rendering process.



WAVELAB
19 – 534 The Audio Montage

13. If the Check gave a warning message, make manual adjustments and re-
peat the Check procedure until the list is OK.
You may get warning messages for several reasons, including:

• You have CD tracks that are shorter than 4 seconds, or DVD tracks shorter than 
1 second.

• The pause before the first CD track is shorter than 2 seconds.
• There are clips (or sections of clips) outside the CD or DVD tracks. 
• There are CD or DVD track start or end markers within clips (if you want a new 

CD or DVD track to begin within a clip, you should use CD/DVD track boundary 
markers).

• The CD or DVD is too long (the total length of the CD or DVD is displayed in the 
control bar at the top of the tab).

• The average bit rate for a DVD-A Montage exceeds the 9.6 Mbps limit (see “Au-
dio format considerations” on page 369).

If the “Audio in pauses” mode is activated on the CD/DVD-A view : Options 
menu, there will be no warnings if clips are placed outside the tracks, see 
below.

Audio in pauses 

Normally when creating a CD or DVD, only the section between the CD/
DVD markers are burned, and the pauses between tracks are replaced by 
silence. However, when Audio in pauses is activated, the exact image of 
the Audio Montage is burned to CD/DVD, including any audio between 
tracks.

Not all CD/DVD drives support this feature, and the only way to find out if 
this works with your drive is to test it.

Here are two possible uses for the Audio in pauses function:

Moving CD/DVD track markers to “hide” clip sections

Let’s say you have a live recording, with a section of applause between 
two songs. By moving the track markers so that the applause section is 
between the tracks and activating Audio in pauses, the applause will not 
be heard if you play any of the two tracks on their own – but it will be 
played normally when playing “through” the CD/DVD tracks.
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Proceed as follows:

1. Place the CD/DVD track end marker of the first track at the position 
where the music ends, but before the applause section.

2. If necessary, place the CD/DVD track start marker of the following track at 
the position where the music starts.

3. Activate the “Audio in pauses” mode from the CD/DVD-A view : Options 
menu, or by clicking the corresponding icon on the icon bar.

Placing a clip before track 1 

To create a “hidden” CD/DVD track before track 1, proceed as follows:

1. Place a clip without CD/DVD track markers prior to the first track start 
marker in the Audio Montage.

• It is recommended that you do not place the hidden track at the very start 
of the Montage, but leave a little room between the Montage start and the 
start of the hidden track.

2. Activate the “Audio in pauses” mode from the CD/DVD-A view : Options 
menu.
If you now run the CD/DVD-A “Check” function, there will be no warning and the CD or 
DVD-A track list should be “valid” (given that the rest of the Montage is ok).

3. Proceed with writing the CD or continue making the necessary DVD-A 
preparations before burning.
To hear the hidden track after burning the disc, rewind from the start of track 1.
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Editing the CD/DVD-A view list 

Once you have prepared a CD track list as described previously, you can 
go ahead and write the CD. For DVD-Audio you first need to make some 
settings in the DVD-Audio options dialog (see “The DVD-Audio options 
dialog” on page 537) before adding the Montage to a DVD-Audio project 
(see “Creating and opening a DVD-Audio project” on page 552). 

However, there are some additional settings you can adjust in the CD/
DVD-A view track list:

• You can hide or show CD/DVD-A track list columns by using the column pop-up 
menu (accessed by clicking the arrow button to the left of the column headings).
You can also drag and resize columns as usual.

• You can adjust all settings (except the “Length” value) numerically in the list.
However, changing track start and end positions may result in warning messages, as de-
scribed above.

• If the option “Allow reordering by drag-and-drop” is activated on the CD/DVD-A 
view : Options menu, you can change the order of CD/DVD-A tracks by dragging 
tracks in the CD/DVD-A view list.
There is one restriction: you can only drag tracks that are enclosed by CD/DVD track start 
and end markers – not by CD/DVD track splice markers. Tracks divided by a CD/DVD track 
boundary marker (a combined start and end marker) can only be moved as an entity.

About the “ATS” column in the DVD-A view list

ATS stands for “Audio Title Set” and defines a set of one or more tracks. 
An ATS start is automatically added for the first DVD track in the list. Nor-
mally, you just leave this as it is, without ticking the ATS column for any of 
the following tracks. There are only two instances where you should add a 
new ATS:

• To increase the number of pictures you can use for slide show presenta-
tions (i.e. pictures placed on the time line for DVD-Audio tracks).
A DVD-A player has a buffer limited to 2 MB for pictures. At each ATS start, the player 
scans all the pictures used in the Montage (i.e. up until the next ATS start) into this buffer, 
so that the audio streaming isn’t interrupted during playback. If you use just a few pictures 
(e.g. one per track), it’s usually best to use one ATS. But if you wish to use more pictures 
you can add a new ATS further down in the track list, to increase the number of pictures you 
can use in a given group on the DVD.

• To increase the number of available sub-indexes.
There are 255 sub-indexes available per ATS (up to 99 per track). 
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Setting a new ATS will mute the audio in the DVD-A player for up to two 
seconds. Therefore you should never set a new ATS at a gapless track tran-
sition or for Audio in Pause transitions!

About the “DM” column in the DVD-A view list

“DM” stands for Down Mixing. If you tick this column for a track using a sur-
round format, a “smart” stereo down mix will automatically be created ac-
cording to the settings made in the DVD-Audio options dialog, see below.

The DVD-Audio options dialog

The DVD-Audio options dialog is opened from the DVD-A view : Functions 
menu or by clicking the Tool icon. This dialog contains two vital settings for 
creating DVD-Audio:

Resolution on DVD

This determines whether the audio data should be stored in 16 or 24 bit 
resolution (word length) on the DVD.

Stereo Down Mixing

An important issue when creating DVD-Audio is stereo compatibility. Al-
though surround playback devices are becoming more and more common, 
there are still many occasions when playback is done in stereo – when us-
ing headphones, boomboxes or computer monitors, for example. To make 
a DVD-Audio playable in stereo, you could include two versions of each 
track, one in surround and one in stereo. The problem with this solution is 
that it requires more storage space on the disc – there will be room for 
less music.
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An alternative solution is to use Stereo Down Mixing tables. This means that 
you can specify how each surround channel should be represented in the 
stereo mix by supplying gain coefficients. When the DVD-Audio is played 
back on stereo equipment, the surround channels are combined to stereo – 
but they are “mixed” according to the coefficients you have specified. Look 
at this example:

The two columns show the gain coefficients for each surround channel, for the left and 
right signal in the down mixed stereo output:
- The left and right front signals are sent to the left and right channel respectively, with a 
slight attenuation.
- The center signal is sent in equal amounts to the left and right channel.
- The left and right surround (rear) signals are more heavily attenuated and sent to the left 
and right channel respectively.
- The LFE signal is not included at all in the mixed stereo output.

To set up a Down Mixing table, proceed as follows:

1. Select a table from the Table number pop-up menu.
You can set up 16 different Down Mixing tables. You select for each DVD track which table 
should be used. This is done in the DM column in the DVD-A view, see “About the “DM” 
column in the DVD-A view list” on page 537.

2. Specify the desired gain reduction for each surround channel in the Left 
and Right output columns.
The value fields are pop-up menus, allowing you to choose values from 0 dB to -61.8 dB or 
“Off”.

3. You can invert the phase of a signal by ticking its “inverse” checkbox.
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• You can also use the Preset pop-up menu to store and recall Down Mix-
ing table presets.

• You can check the results of your Down Mixing settings by selecting the 
desired table in the “DM” column in the DVD-A view (see “About the “DM” 
column in the DVD-A view list” on page 537), activating the Stereo button 
in the Master Section (see “The Stereo button” on page 525) and playing 
back.

Checking transitions between tracks 

On the CD/DVD-A view : Functions menu there is an item named “Edit 
playback times…”. This dialog allows you to set two things; a pre-roll time 
before a track is played back, and a test time, which is the time the begin-
ning of a track is played back when using the “Play all track starts” function 
on the toolbar (also located on the CD/DVD-A view : Functions menu). 

Say for example that you wish to hear a few seconds of each track end 
and following track start, to check the transitions between them:

1. Open the “Edit playback times” dialog on the CD/DVD-A view : Functions 
menu.

2. Enter suitable values for pre-roll and test times and click OK.
You can tick the option “Pre-roll starts with one second of silence” if you wish to make the 
transitions less abrupt.

3. Activate Pre-Roll mode on the CD/DVD-A view : Functions menu.
When this is activated all tracks will start with the set pre-roll if played back using the Func-
tions menu playback items. 

4. Select “Play all track starts” from the Functions menu, or by clicking the 
corresponding icon on the control bar.
Each track start and end (including the last track) are played back according to the values 
set in the dialog.

Edit CD-Text

This CD view : Functions menu item opens the CD Text editor, where you 
can input the track’s title, artist and other information. It will be burnt onto 
the CD as CD Text. Some CD Players support CD Text and display this 
information during track playback. For details, click the question mark icon 
in this dialog.

See “DVD-Audio text” on page 566 for a description of the Edit DVD-Audio 
text dialog.
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Render selected CD/DVD track

It is possible to render a selected CD/DVD track as an audio file. This fea-
ture is reserved for stereo audio montages. The rendered file can replace 
the existing clips that make the CD/DVD track, or can be placed on a free 
track or on a new track. 

For details, click the question mark icon in this dialog.

About the two CD write methods

The final phase of CD creation can be done in two ways:

• By burning directly from the CD view in the Montage.
This is an easy process, but puts some demand on your computer. Keep in mind that even 
if your Audio Montage plays back without problems, the CPU load will be four times as high 
if you burn in 4x speed (since the audio file has to be rendered four times as fast)! There is, 
however, an option in the CD Write dialog to “Render a temporary file before burning” that 
alleviates this problem – see “About the “Render to temporary file before burning” option 
(Audio Montage only)” on page 573.

• By using the Render function in the Master Section to first render the Montage to 
a CD image on disk, and then burn the CD in a second pass.
This method is recommended if your Audio Montage contains a lot of clip effects (or is other-
wise CPU intensive), since it separates the audio file rendering from the CD burning process. 
It is also recommended if you want to create multiple copies of the CD. For a description of the 
Rendering process and its options, see “Mixing down – The Render function” on page 527.

In both cases, all clip and track effects are used and the Montage is pro-
cessed through the Master Section, including any activated effects and 
the dithering/noise shaping stage.

Rendering a CD image and cue sheet

1. Open the Master Section and click the Render button.
The Rendering Preferences dialog appears.

2. Select the “Whole Montage” option in the Range section and activate the 
“Create specific file” option.

3. Specify a name and location for the file, and make sure the Wav 16 bit 
format is selected.

4. Select the “Create CD image and cue-sheet” option in the Options sec-
tion and activate the “then open as new Audio Montage” option.
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5. Click OK.
Now, the whole Montage is rendered to an CD image file, with a corresponding cue sheet. 
A new Audio Montage is created, which will play back as the original Montage and have all 
its features (but refer to the ready-processed CD image file instead). 
Now you can proceed with burning the CD as described in the next chapter.

• It is also possible to create a Basic Audio CD from the Render dialog.
This will also separate the processing and the CD burning and thus conserve processing 
power. However, not all Montage features (e.g. Audio in pauses and CD Text) are available 
in a Basic Audio CD. Therefore, use this for simple audio CDs only.

Creating an Audio CD report

Basic concept

An Audio CD report presents the contents of the current Audio Montage 
in text form, for printing.

Audio CD reports are based on a number of small documents in RTF for-
mat (Rich Text Format), one for each section in the report. These can be 
edited in any RTF-compatible application (e.g. WordPad), allowing you to 
change fonts and styles, set text justifications, add pictures, etc.

Furthermore, the RTF documents contain references to text variables, and 
these provide the actual information in the Audio CD report – track names, 
times, etc. When generating the report, the information provided by the 
variables will be presented according to the set style in the RTF documents. 

There are two types of variables, factory and user editable:

• Factory variables provide automatically generated information about a project 
such as number of tracks, track times, track names, etc. – based on the actual 
contents of the project. 

• User variables contain personal data such as company name and copyright infor-
mation, etc. – which is defined by the user.

Along with the variables, the Audio CD report can also include any CD 
Text you have specified in the Edit CD Text dialog (see “Edit CD-Text” on 
page 539). This is typically where you specify composers, performers, etc.
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Generating the Audio CD report

An Audio CD report should be generated when an Audio Montage is fully 
prepared and ready for CD burning (or after having already done so). Pro-
ceed as follows to generate a preview of the Audio CD report template:

1. Open the Audio Montage you wish to create a report for.

2. Click the CD tab and select “Generate/Print Audio CD report” from the 
Functions menu.
A dialog opens.

At this point, you can select one of three Audio CD report templates (or 
presets) from the pop-up menu; two of them will show “Absolute” times, 
where the timing is continuous from the beginning of the CD (i.e. from the 
start of the first pause), the third shows “Relative” times, where the timing 
is relative to the start of the first track, and the durations are given without 
pauses.

The first two represent the standard way of measuring track times in pro-
fessional use, such as for CD duplication plants, the third the way track 
times are normally listed on a CD cover.

3. Click OK to generate a preview image of the report.
This is the standard or template layout, which provides all of the relevant factory variable 
information.

4. You can now use the Print item on the Functions menu in the window to 
print the Audio CD report.
However, you probably want to edit the contents of the report first. Read on!
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Editing the Audio CD report

Editing user variables

To enter personal data for the user editable variables, or to add new vari-
ables, you use the “Edit text variables” dialog, located on the CD view : 
Functions menu, see “Defining user variables” on page 614.

Editing CD Text

CD Text is included on the actual CD, and can be displayed by some CD 
players. It can also be included in the Audio CD report, allowing you to 
specify titles, performers, composers and more for the whole CD and for 
each track. See “Edit CD-Text” on page 539 for details.

Editing the elements of the Audio CD report

You have complete control over what is shown in the Audio CD report. 
Proceed as follows:

1. Select “Generate/Print Audio CD report” from the CD view : Functions 
menu.

2. Click the “Edit…” button in the dialog.
This opens the Audio CD report edit dialog.

The main part of the dialog consists of “elements”; the RTF files that make 
up the CD report.
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• Each element entry consists of a path to a RTF file. 
One exception is the Logo, which should point to the location of an image file. The image 
will be embedded in the final RTF file.

• To use another RTF file for an element, click the folder icon and browse to 
the new RTF file.
You could for example have created different versions of the various RTF files, or a client 
could bring his own RTF files, etc.

• To remove an element from the Audio CD report, delete the path to its 
RTF file.

• At the bottom of the dialog you will find additional settings for the printout 
(page size and margins) as well as a Formats button (allowing you to edit 
the formats used for dates, times and numbering). 
You can also save the current Audio CD report as a preset, by selecting “Save as…” from 
the pop-up menu at the bottom of the dialog. 

Editing the RTF files

You can use the existing template RTF files as a starting point for creating 
custom CD reports, or create new RTF documents from scratch. Regard-
less of which, you may want to keep a copy of the original template RTF 
files, as a safety measure.

When you edit the RTF documents, it is recommended that you use WordPad 
(included with Windows) rather than Microsoft Word, as Word can sometimes 
automatically create “extra” information that cannot be translated correctly 
by WaveLab.

To open an RTF file for editing, proceed as follows:

1. In the Audio CD report edit dialog, click the arrow pop-up to the right of 
the element you want to edit.

2. On the pop-up menu that appears, select “Open containing folder”.
The folder containing the RTF file opens in a separate window.

3. Double click the RTF file (or drag it to the desired RTF editor program 
icon).
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In this example, we’ve opened the file “Header1.rtf”.

As you can see, this is the personal information that was shown under the 
logo in the preview CD report template. The entries are written exactly as 
in the “Edit Variables” dialog; a title followed by a variable name enclosed 
with “%” characters.

• All text in the RTF documents apart from the code inside the percentage 
marks will be shown in the report.

This lets you change headings, orders and similar; you may for example 
want to use another term than “Engineer”, exclude the address or phone 
number fields, etc. You can also change the fonts, styles and justification 
for the text. 
Also, if you have added a new user variable in the Edit Variables dialog, or 
defined a variable that is not called upon in the RTF file, this variable has 
to be written into the RTF file (enclosed by % signs).

However, while it is perfectly possible to enter the actual information (e.g. 
the name of the project) directly in the RTF file and remove the correspond-
ing variable, this would require that you edited the RTF files each time you 
created a new Audio CD report. It is much better to set up the styling of 
your Audio CD report and its RTF files once and for all, and then only edit 
the variables and CD Text when you work with a new project. In short:

The RTF documents should be used for adjusting the appearance of the 
report, not for writing in variable values. 
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Using DVD-A picture and text tracks
DVD-A picture and text tracks can be added to Montages that are to be 
burned to DVD.

These track types have no functionality in WaveLab itself, other than offer-
ing the ability to place text and pictures along the time line which will be 
shown together with the audio when the final DVD-A is played back in a 
compatible player connected to a video display.

• DVD-Audio text and picture tracks are created from the track pop-up 
menu, just like other track types.
They are set to “Half height” by default to save screen space.

Adding pictures to a DVD-A picture track

You can add pictures using one of the following methods:

• By right clicking in an empty area on a picture track and selecting “Insert file(s)”.
A file dialog opens where you can locate the picture you wish to insert. The picture will be 
inserted at the cursor position.

• By using copy/paste.

Still picture properties dialog

When you have added a picture to a DVD-A picture track you can dou-
ble-click it to open the “Still picture properties” dialog. In this dialog you 
can amongst other things set the time position for the picture relative to 
the start of the track, and add effect transitions. Effect transitions allow 
you to set a start and end transition for the picture (e.g. a fade-in at the 
start and a dissolve at the end) as well as transition durations. Click the 
question mark icon in the dialog for details.

• It is also possible to specify a default still picture as well as default effect 
transitions to use. This is done in the DVD-Audio project’s Main Settings 
dialog, see “Default still picture and picture effects” on page 558.
The default still picture will be displayed at the beginning of each Montage/group, unless 
the Montage contains a DVD-A picture track, in which case the picture(s) on the picture 
track will override the default picture. 

Note that there are certain limitations as to how many pictures can be used 
for a given group on a DVD-A. See “About the “ATS” column in the DVD-A 
view list” on page 536.
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Adding real time text to a DVD-A text track

1. Set the cursor at the position where you want the real time text to appear.

2. Right-click in an empty area on a text track and select “Insert text”.
This opens the Real time text dialog.

In this dialog you type in a text to be displayed at that time position. You can 
specify a time position for the text relative to the start of the track, and the 
duration the text is to be shown. Click the question mark icon in the dialog 
for details.

Note that real-time text is a recent DVD-Audio feature. Before using it exten-
sively, you should see if your player supports it, or at least if it does not dis-
turb the playback operation.

Exporting and importing AES-31 files
The AES-31 standard is an open file interchange format, developed by 
the Audio Engineering Society as a means of overcoming format incom-
patibility issues between different audio hardware and software. It can be 
used for transferring projects via disk or network from one workstation to 
another, retaining time positions of events, fades, etc.

AES-31 uses the widely used Microsoft FAT32 file system with Broad-
cast Wave as the default audio file format. This means that an AES-31 file 
can be transferred to and used with any digital audio workstation that 
supports AES-31, regardless of the type of hardware and software used, 
as long as the workstation can read the FAT32 file system and Broadcast 
Wave files (or regular wave files).
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Exporting AES-31 files

Proceed as follows to export an Audio Montage as an AES31 file:

1. Select “Export as AES-31 file…” from the Save Special submenu on the 
File menu.

2. Select a name and location for the new file and click Save.
At this point, the AES-31 Export options dialog appears. This dialog lets you specify a num-
ber of options for the AES-31 file to be exported. Click the question mark icon in the dialog 
for details.

3. When you’ve made the desired settings in the AES-31 Export options dia-
log, click OK.
The montage is exported to an AES-31 file. The exported file will contain all audio track 
data, including audio file references.

The saved file will be an xml file (but with the extension “.adl”, for audio 
decision list) – this means you can open it in any text editor to check file 
references, etc.

Importing AES-31 files

Proceed as follows to import an AES-31 file into WaveLab:

1. Select “Import AES-31 project…” from the Open submenu on the File 
menu.

2. Navigate to the location of the AES-31 file (extension “.adl”), select it and 
click Open.
The AES-31 Import options dialog appears, allowing you to specify some import options. 
Click the question mark icon in the dialog for details.

3. When you’ve made the desired settings in the AES-31 Import options 
dialog, click OK.
The imported AES-31 file opens as a new, untitled Audio Montage containing all the audio 
tracks stored in the AES-31 file.

About importing AES-31 files created in Nuendo

By importing an AES-31 file, you can for example import a project created 
in Steinberg’s Nuendo into WaveLab.

In this case, it is possible to add specific codes to the names of markers 
in Nuendo to facilitate their conversion into WaveLab specific markers – 
i.e. if an AES-31 file exported from Nuendo is imported into WaveLab, the 
markers it contains will be interpreted as WaveLab markers upon import.
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For the various CD track markers, for example, the codes to use are the 
following:

• You must use Nuendo 2.0 or later if you want to create specially named 
markers that will be interpreted as WaveLab markers.

• In Nuendo, a marker track has to be created for the specially named markers.

• When importing AES-31 projects containing specially named markers, the 
marker codes (e.g. [t-end]) will not be displayed in WaveLab.

XML Export/Import of Audio Montages
This is available on the Save special (Montage) submenu, and is solely 
intended for users familiar with XML. XML stands for “E Xtensible Markup 
Language” and is a markup language much like HTML. 

This feature can be useful, e.g. to change many file names used by the Au-
dio Montage (export then import). It could also be used to generate Audio 
Montages from scratch (or from a template), or to convert another DAW 
file format to WaveLab’s Audio Montage. Another application could be to 
compare two Audio Montages with a text file comparer.

There are many freeware XML editors available, but a simple text editor 
can also be used.

It is beyond the scope of this manual to provide details about how to edit 
XML files, however here’s some basic information:

• All strings are included in a CDATA section, in the UTF-8 format.
• All integer values are in simple textual form: 127 = “127”
• All float and double values are stored in Base64 format.
• Any binary data is stored in Base64 format.

Marker type Code Example marker name

CD track start [t-start] “So it begins [t-start]”

CD track end [t-end] “The end [t-end] of the road”

CD track splice [t-splice] Intermission [t-splice]

CD track index [t-index] [t-index] Hello



WAVELAB
19 – 550 The Audio Montage



20
DVD-Audio projects



WAVELAB
20 – 552 DVD-Audio projects

Creating and opening a DVD-Audio project

How to make preparations in the Montage for DVD-Audio is described in 
the Audio Montage chapter.

The DVD-Audio project is where you assemble the Montages you want to 
appear on the DVD before finally rendering the contents to the AUDIO_TS 
folder. It is also from here you can reach the “Main settings” dialog, where 
you make general settings for the final DVD.

• To create a new DVD-Audio project, pull down the File menu, select New, 
and from the submenu that appears, select “DVD-Audio project”.
You will get a blank window that you can fill with entries, see “Using Add Audio Montage” 
on page 553.

• To open an already existing DVD-Audio project, select Open from the File 
menu, and “DVD-Audio project” from the submenu that appears. Alterna-
tively, open it from the “Recent DVD-Audio projects” submenu at the bot-
tom of the File menu.
When you open an existing DVD-Audio project, the references to the Montages are auto-
matically updated. However, the Montages are not opened. To open a Montage, double-
click the name of the Montage in the File column. If some files that are part of a Montage 
can't be found, a warning message appears.

• You can also create a new DVD-Audio project from a Montage (DVD-A  tab : 
Functions menu).
This differs from creating a new project in that it will open the DVD-Audio Creation dialog at 
the same time as the DVD-Audio project – see “Rendering the DVD-Audio project” on 
page 569.
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Adding Montages to a DVD-Audio project
A DVD-Audio project consists of one or several (up to 9) Audio Montage(s). 
Each Montage corresponds to a group (which can be named) in the DVD-
Audio project.

Using Add Audio Montage

This item is used to add Audio Montages to the DVD-Audio project.

1. Select “Add Audio Montage” on the Functions menu, or click the green 
“+” icon.

2. In the File dialog that appears, select one or several Montage files.
A DVD-Audio project can contain up to 9 Montages (groups).

3. Click OK.
The Montages are now listed in the window.

By dragging between DVD-Audio projects

If you have several DVD-Audio projects open, you can drag and drop 
Montage/group items between them.

1. Point at a Montage in the list.

2. Press the mouse button and drag and drop the Montage into another 
DVD-Audio project.
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The DVD-Audio project window

Montages in the DVD-Audio project window

The DVD-Audio project window contains 8 columns that show information 
about Montages in the project. Apart from the entries in the Group Name 
column, you cannot edit any of the information shown in this window:

Column Description

Group Name  If you double-click on the name you can enter a new name for the group (by 
default the group name will be taken from the name of the Montage). The 
group name will be shown in the DVD menu display (see “Generating DVD 
menus” on page 558).

File The File column shows the name of the Montage.
If you double-click on the Montage name in the File column, the correspond-
ing Montage will open.

Tracks The Tracks column shows the number of tracks in the Montage.

Time This shows the total time of all tracks.

Bits The bit-depth of the samples in the Montage (as stored on the final DVD).

Rate The sample rate of the Montage.

Channels The number of audio channels used in the Montage.

Size The total size of the Montage.
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• If the tracks in a given Montage contain DVD start and end markers, these 
are used to define the number of tracks, the length and the size in the list.
If the tracks in a given Montage do not contain any markers, the Tracks, Time and Size col-
umns will display a zero value.

• In the top right corner of the window the total number of tracks and the 
length and size of all Montages in the DVD-Audio project are shown.

• You can have several DVD-Audio project windows open at the same time.

• The DVD-Audio project is merely a reference list of the Montage contents.
Any changes you make to a Montage will automatically be reflected in the DVD-Audio 
project as well. If you notice a “*” after the name of the DVD-Audio project (which indicates 
that unsaved changes have been made), this usually means that the reference list needs to 
be updated to reflect changes made in a Montage. When you render the project without 
saving it, it doesn’t matter as the list is for reference purposes only.

Setting the order of the Montages/groups

Once you have added all the Montages you need in the DVD-Audio 
project, you might want to set the order in which they will appear on the 
DVD (as groups). The order of the Montages is from the top down, i.e. the 
Montage at the top of the list corresponds to group item 1 and so on, just 
like tracks for an audio CD.

1. Position the mouse pointer over the Montage you want to move to another 
position.

2. Drag and drop it somewhere else in the list.

Deleting Montages from DVD-Audio projects

To remove a group/Montage from the list, select it and select “Remove 
selected Audio Montage” from the Functions menu. 
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The Main settings dialog

The Main settings dialog is opened either by clicking the Settings icon or 
by selecting “Settings…” from the Functions menu. In this dialog you can 
make various settings relating to what is to be included on the final DVD.

The dialog contains the following items:

Item Description

Volume ID/Number
of volumes

These items allow you to specify disk information. E.g., if you have a 
project that will end up on 3 DVD discs, you can specify 3 volumes, 
and ID each DVD as 1, 2 and 3, respectively.

Side A / B If you intend to include two albums using a double sided DVD, you 
can set on which side of the DVD the current album is to be.

Album name Here you can type in the name of the album, the top level in the visual 
menu/DVD structure.

Provider information Here you can type in information about the DVD-A provider.

Generate menus If this is activated, a menu displaying the basic album/group/track 
structure will be automatically generated. The look of the menu can 
be edited in the Menu generation dialog, see “Generating DVD 
menus” on page 558.
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There are several additional options in this dialog:

About the “Create bonus group” option

A bonus group is a “hidden” group on a DVD-A disc that is usually only ac-
cessible to users who know the specified code or “key number” with which 
to unlock it. If you activate this option, the last group on the DVD-A disc will 
become the bonus group, and you can also specify a four digit code.

Please note that it is not possible to create a bonus group if the DVD-A con-
tains only one group! Also note that the use of bonus groups may not be 
supported by all DVD-A players.

TV system

• If you intend to use still pictures you also need to specify whether the DVD-
A disc should conform to the NTSC or PAL/SECAM video standard, by 
clicking the corresponding radio button.
This is important since the NTSC (used in North America and Asia) and PAL/SECAM (used 
in Western Europe and Australia/France and Eastern Europe) video standards adopt differ-
ent resolutions.

Include still picture 
tracks

If this is activated, any pictures placed on a DVD-A picture track will 
be displayed in a compatible DVD player – see “Using DVD-A pic-
ture and text tracks” on page 546.

Include static text If this is checked, static text included on the DVD-A will be displayed 
in a compatible DVD player.

Include real time text If this is activated, any text placed on a DVD-A text track will be dis-
played in a compatible DVD player – see “Using DVD-A picture and 
text tracks” on page 546.

Auto play If this is activated the DVD will automatically play when inserted into a 
compatible DVD player.

Item Description
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Default still picture and picture effects

As described in the section “Using DVD-A picture and text tracks” on 
page 546, an Audio Montage can contain picture tracks. Still pictures 
placed on such a track will be burnt onto a DVD-A disc and displayed 
when the DVD-A is played back in a player that is able to read and show 
still pictures in a connected video display.

Here you can specify whether the DVD-A project should use a default still 
picture or not and also the default effect transitions between pictures. The 
picture you specify as default will be displayed from the beginning of the 
Montage.

Note however that each Montage in a DVD-A project can also have its 
own specific settings for which pictures should be displayed and which 
effect transitions between pictures should be used. In other words, you 
can make default settings in this dialog which will then be used unless 
you specify other settings in a Montage, which will then override the de-
fault settings (see “Still picture properties dialog” on page 546 for infor-
mation about making settings for pictures in a Montage picture track). 
This means that it’s not possible to use both a default still picture and pic-
tures in a Montage picture track.

• Note that a Montage in a DVD-Audio project does not need to contain a pic-
ture track if you want to use a default picture.
So even if a Montage doesn’t contain a picture track, you can still specify a default picture 
for it which will be displayed when the DVD-A is played back.

Generating DVD menus
DVD-A discs can optionally contain what is referred to as a “visual menu” 
of their contents. Many DVD-A players are able to make use of such a 
menu, either in an integrated display in the player itself, or in a connected 
external display.

WaveLab lets you create a visual menu that can contain information about 
the album title and the album tracks, allowing the user to navigate the 
contents of the disc and perform track selection for playback.
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You design and generate visual menus with the help of two dialogs avail-
able in the DVD-Audio project window: The “Main settings” dialog and 
the “Menu generation” dialog. These are accessed either from the Func-
tions menu, or by clicking the corresponding icon in the toolbar.

To create a DVD-A visual menu, proceed as follows:

1. Add one or more Montages to the DVD-Audio project, as described in the 
section “Adding Montages to a DVD-Audio project” on page 553.

2. Click the Settings icon in the toolbar, or select “Settings…” from the 
Functions menu.
The Main settings dialog opens.

3. In the Main settings dialog, make sure the option “Generate menus” to the 
top right is activated.
If this is not activated it won’t be possible to open the Menu generation dialog.

See “The Main settings dialog” on page 556 for descriptions of the re-
maining settings in this dialog, some of which are of relevance for the cre-
ation of visual menus.

Click here to open the 
“Main settings” dialog.

Click here to open the 
“Menu generation” dialog.
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4. Next, click the Edit menus icon in the toolbar, or select “Edit menus…” 
from the Functions menu.
This opens the Menu generation dialog.

This dialog lets you design every aspect of the visual menu and also test 
it, with or without audio playback. It is dominated by a display of what the 
menu will look like. It is possible to navigate in the display, just as you 
would with a remote control when the DVD-A disc is used in a DVD-A 
compatible player. Depending on the settings you make in the dialog, the 
display will show the album title, the group names and the track names.

The parameters, settings and controls in the dialog are as follows:

Menu type

This drop-down menu to the top left lets you select which menu to edit. 
The possible options are the group menu and the tracks menu of each 
group. Note that if you only have one group in the DVD-Audio project, 
there will be no group menu – just the track menu of the one group. Note 
also that you can choose whether to include a group menu or not with the 
option “Add menu for groups” (see below).
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Copy/Paste

These buttons let you apply the same settings quickly from one track 
menu to another. Just make all the desired settings for one track menu 
and click “Copy”. Then select another track menu and click “Paste”. All 
the settings in the first menu will then be applied to the second.

Add menu for groups

If this is activated, there will be group menus available for editing. If not, 
there will be only track menus.

Hide last group

This is available only if you have chosen to create a bonus group, as de-
scribed in the section “About the “Create bonus group” option” on page 
557. As previously mentioned, the last group can be specified as a bonus 
group. If you activate this option, the bonus group will be hidden and not 
appear in the menu.

Elements menu

This drop-down menu lets you select which elements in the menu to edit. 
Possible options are: Album title, Group names, Track names and Naviga-
tion buttons. Which options are available depends on the selection made 
on the Menu type drop-down menu, described above.

Show

This is available only when you have selected Album title or Group names 
from the Elements menu, and lets you determine whether the album title 
and the group names should be visible in the menu or not.
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Name/index/time menu

This drop-down menu is only available when you have selected Group 
names or Track names from the Elements menu. It lets you decide whether 
the groups and tracks should be displayed by name only, or using different 
combinations of name, index (group/track number) and time (group/track 
length).

Format

This button is only available when you have selected to display group 
names and track names by a combination of name, index and time. Click-
ing this button opens another dialog that lets you select the format for the 
time and index indicators.

In this dialog, you can choose for example to use roman numerals to indi-
cate the index numbers.

Font

Clicking this button opens a standard Windows dialog that lets you 
choose which font to use for the selected element (album title, group 
names or track names). This is not available for navigation buttons.
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Layout menu

The items on this menu allow you to specify the desired basic layout of the 
visual menu. For album title, group names and navigation buttons, you can 
choose the alignment for the text – left side, centered or right side. For 
track names, you can select the number of columns and their alignment.

Vertical spacing

This allows you to adjust the vertical spacing between the selected type 
of elements. For a track list, this is the space between each track name. 
For an album name, a group name or navigation buttons, this is the space 
between the element and the track list. The easiest and most convenient 
way to adjust the value is probably to double-click in the field and use the 
slider that pops up. Values you set are “stored” and can be recalled later 
and set by selecting them from the drop-down menu that appears when 
you click the arrow button to the right.

Left/Right margins

These allow you to adjust the margins between the left and right sides of 
the column(s) and the safety area borders (see below), thereby effectively 
changing the size of the column(s). Values you set are “stored” and can 
be recalled later and set by selecting them from the drop-down menu that 
appears when you click the arrow button to the right.

Top/Bottom margins

These are only available for track names and allow you to adjust the top 
and bottom margins of the column(s) and the album title/group name and 
navigation buttons, changing the size of the column(s). Values you set are 
“stored” and can be recalled later and set by selecting them from the drop-
down menu that appears when you click the arrow button to the right.
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Color settings (Normal, Selection, Action)

All elements except album titles and group names in a visual menu can 
have three states: Normal (unselected), selected (touched by the cursor) 
and active (when the command is carried out – e.g. starting playback of a 
selected track). The three colored squares allow you to select which color 
the selected element should have in each of these states. Click the col-
ored squares and select a color from the standard color picker dialog that 
appears. Preferably select contrasting colors to assure the visibility of the 
cursor in all states to facilitate easy navigation of the menu.

Highlight settings (text or background)

This menu lets you select whether the color settings you make as described 
above should be reflected in the actual text or in a cursor over the text.

Show edit areas

If you activate this option, an outline of the edit areas will be visible, which 
is helpful when designing the menu. The edit areas are the spaces allo-
cated to each of the different elements in the menu. A column for a track 
list, for example, is an edit area.
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Show safety area

If you activate this option, an outline of the safety area will be visible. The 
safety area is the part of the display area that is guaranteed to be visible 
when the menu is displayed on a regular TV set. Visual menus, pictures, 
etc. on DVD-A are usually set up on a computer monitor, and the display 
area, resolution and aspect ratio of computer monitors are different from 
those of TV sets.

The safety area therefore consists of about 80% of the pixels shown on a 
computer monitor. Items outside of this area will not show on a regular TV 
monitor, meaning that no items on a visual menu should be outside of the 
safety area.

Navigation buttons

These buttons in the bottom left corner work just like the buttons on a re-
mote control unit and let you navigate the visual menu to test it. If you acti-
vate the option “Simulate (with playback)”, you can also activate playback 
of the tracks.

• The four cursor buttons let you step between the elements of the menu.
• The enter button in the middle lets you perform different actions: Opening a group 

to view its contents, activating playback of a track and using the navigation but-
tons in the display.

• The Stop button lets you stop playback of a track.
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Background picture/color

The radio buttons “Picture” and “Color” directly below the display let you 
decide whether to use a picture as background for the menu, or whether 
the menu should be filled with a color of your choice.

• If you select “Picture” you get access to the folder button to the right. Use 
this to browse for the picture you want to use as background.
WaveLab supports the picture formats jpg/jpeg and bmp.

• Note that the picture should preferably match the resolution of the selected 
video format (NTSC or PAL/SECAM – see “TV system” on page 557). For 
NTSC this is 720x480 pixels, and for PAL/SECAM it is 720x576 pixels. If the 
picture doesn’t match the selected format resolution, it will be automatically 
resized by WaveLab, but resizing it manually before use may yield a better 
result.

• If you select “Color”, you can click the colored square to the right.
This opens a standard color picker dialog which lets you specify the color you want to use.

DVD-Audio text
The DVD-Audio text dialog can either be opened from the DVD-A view : 
Functions menu for a Montage, or from the Functions menu in a DVD-Au-
dio project. This dialog allows you to add and specify very detailed text in-
formation. DVD players that support DVD-Audio text can access this 
information.

Album, group and track names are automatically generated from the source 
Montage(s) and cannot be edited in this dialog. 

The functionality differs slightly depending on whether this dialog is 
opened from a Montage or from a DVD-Audio project:

• If it is opened from a Montage you can add text information at each level (group or 
track).

• If it is opened from a DVD-Audio project you can only add text information at the 
top level (album).
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When you first open this dialog it contains a main folder with a number of 
subfolders inside it. These items are all automatically generated and have 
to be edited outside of this dialog. Folders and subfolders are opened by 
double-clicking them. 

On the pop-up menu at the top of the dialog you will find a multitude of 
text options divided into various categories. You use the dialog in the fol-
lowing way:

1. First select an appropriate text option heading from the pop-up menu.
This is now displayed in the text field next to the pop-up.

2. Select which automatically generated item you want to add the text infor-
mation to, and click the green plus icon.
An item is added on a sub-level to the album, group or track item you selected, and a text 
field appears allowing you to type in the information.

• To remove an item, select it and click on the red cross icon.
• If you have added several sub-items for a generated album, group or track entry, 

you can use the up/down arrows to move it up or down in the list.
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Final preparations
When you have made all necessary preparations in the DVD-Audio 
project it is time to move on to the (next to) final process! 

Using the Check function

Before rendering the DVD-Audio project, you should use the Check func-
tion. This will automatically check all Montages in the project and display 
a detailed warning if the project does not comply with the DVD-Audio 
standard.

• Select “Check all” from the Functions menu or click the “glasses” icon.
All Montages added to the DVD-Audio project will now automatically open. If all is well, a 
message appears stating that the DVD-Audio is ready to be created. 

At this stage, you should make sure that the correct Master Section set-
tings are used. Before rendering, you have the option of rendering all 
Montages using the currently selected Master Section settings. If you 
wish to do so, make sure the Montage with the Master Section settings 
you wish to use is selected (click the LED at the top of the Master Level 
pane to make sure the “right” Master Section is shown) and continue.
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Rendering the DVD-Audio project

Before burning the DVD you have to render all the contents of the DVD-
Audio project to an AUDIO_TS folder. This folder is automatically added 
to a Data CD/DVD project, from where you can start the actual burning 
process. 

1. Select “Create…” from the Functions menu or click the red disc icon.
The DVD-Audio creation dialog appears.

In this dialog you can set the following options:

2. Click OK to render the DVD-Audio project.

Option Description

Test This will create a report about the contents of the DVD-
Audio project.

Render each Montage with
its own plug-in set

This option will render each Montage with its own set of 
master effects. Note that if you are applying dither for a 
multichannel Montage, the internal dithering plug-in must 
be used.

Use current Master Section 
settings for all Audio Montages

This will render all Montages according to the currently 
selected Master Section.

Ignore This will render the Montages without any Master Section 
effects or dithering.

Output folder Here you can select a destination for the rendered files 
(i.e. where the AUDIO_TS folder will be created).
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The contents of the DVD-Audio project are now rendered according to 
your settings. When the rendering process is finished, a Data DVD/CD 
project is automatically opened, containing a AUDIO_TS folder and an 
(empty) VIDEO_TS folder.

From here you can do one of the following:

• Burn the DVD without adding any additional data or a VIDEO_TS folder.
• Add data and/or a VIDEO_TS folder (authored in another application).

This is described in the section “Data CD/DVD Projects” on page 583.
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Introduction

For a description of how to create a DVD-Audio disc, see “Creating a DVD-
Audio compatible disc” on page 589.

This chapter describes the basic CD burning process, as well as some 
general reference information about the CD format. 
It does not, however, describe the necessary preparations for creating a 
CD from a basic audio CD or an Audio Montage. In other words, this 
chapter assumes that the respective preparations have been completed, 
and that you are ready to execute the actual CD burning.

Please refer to the chapters “Preparing a Basic Audio CD” and “The Audio 
Montage” for a description of the respective preparations before following 
the instructions in this chapter.

Note that some procedures and menu items differ according to what 
method has been used to prepare audio tracks for burning.

Selecting a CD-R unit
Before you start writing, you must specify which CD-R unit WaveLab 
should use (for example, you can have more than one unit connected at a 
time, and switch between them from within WaveLab).

1. If you are starting from a basic audio CD, pull down the “CD” menu and 
select “Write CD”. For Montages, click the CD tab and select “Write CD” 
from the Functions pop-up menu.

2. Use the Device pop-up menu to select your recorder.

3. Click the “i” (info) button next to the Device name.
This will show you details about, and settings for, your specific CD-R unit. Click the ques-
tion mark icon in the dialog for details.
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Testing a basic audio CD before burning
There are two ways to check a CD before burning:

Check

The “Check” command on the CD menu scans through the basic audio 
CD and checks that the settings conform to the CD standard. For Mon-
tages this command is on the Functions menu (CD tab selected). This 
command does not access the CD-R recorder in any way, it only checks 
the setting in the list against a set of rules. These rules are described in 
the help for the Check menu item. 

This check is automatically performed when you try to actually burn a CD.

“Test writing of first track” and “Test writing of the whole CD”

These two options in the Write CD dialog (also reached from the CD 
menu for a basic audio CD and on the Functions menu for Montages) ac-
tually simulate writing of one or all tracks to the CD. This takes all settings 
into account, including the writing speed (1x, 2x, etc.), or whether a disk 
image should be rendered first (see below), etc.

• If the test fails, try writing at a lower speed.
• If the testing of all tracks is successful, you can be sure there will be no problems 

with writing the actual CD.

About the “Render to temporary file before burning” option 
(Audio Montage only)

This is an additional option in the Write CD dialog that can be used in 
case you have a slow computer and/or a lot of CPU-load intensive ef-
fects, etc. in the Montage. If this item is ticked, a disk image is created be-
fore burning, which eliminates the risk of buffer underruns.

• This option is included in the test writing if it is ticked beforehand.
Therefore if it was on when testing, it should be on when writing.

• If this option was off, and the whole CD was test written successfully, 
there is no need to activate it when burning.
It will only make the write time longer, without providing any “extra” safety.
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Writing a CD
Once you have set up the basic audio CD or Montage, we suggest the 
following work order for burning the CD. These steps are not mandatory 
though, just a recommendation.

Please observe the precautions indicated in the Troubleshooting chapter in 
the online documentation before writing your first CD!

1. Listen through the CD once more, from the basic audio CD window or 
from the Montage, to check that all starts, ends and transitions are OK.

2. Select Check from the CD menu (basic audio CD) or CD tab – Functions 
menu (Montages), to check that all settings conform to the Red Book 
standard.
This is done automatically before burning, but you might want to do this anyway at this 
point.

3. Insert a fresh CD-R disc into your drive.

4. Select Write CD.

5. Select the speed at which you expect to be able to burn from the small 
pop-up menu.

6. Use the test options in the dialog to check that you will actually be able to 
write the CD at that speed.

7. If you want to create a CD in the CD-Extra format, activate the CD-Extra 
Support option in the dialog.
See below.

8. Once the basic audio CD (or the Montage) has passed the test, switch to 
“WRITE” and press OK in the dialog.
If you run into problems, check the Troubleshooting chapter in the online documentation.

• In the progress dialog that appears while the CD is recorded, you will find 
an option called “Eject CD on success”. If you activate this option, the CD 
recorder will automatically eject the CD once it’s finished.
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CD-Extra support

When writing an audio CD as described above, it is possible to prepare it 
for CD-Extra support. CD-Extra is comparable to Mixed Mode CDs in that 
both of these formats allow for the writing of both audio and data on a sin-
gle CD. However, unlike Mixed Mode CDs, the audio on CD-Extra CDs is 
placed on the first track(s) of the CD and the data follows subsequently. 
This means that the audio will start to play immediately when the CD is 
used in a regular audio CD player, without having to skip to track 2. Also, 
when creating a CD-Extra CD, you can make use of all the functions avail-
able in the Montage.

Please be aware that some computer CD drives may not recognize CDs in 
the CD-Extra format. Plextor drives are recommended.

If you are writing an audio CD and want to prepare it for CD-Extra, do the 
following:

1. Put a checkmark in the “CD-Extra compatible” box in the Write CD dialog.
This will prepare the CD for further writing of data later. Much like a multi-session CD.

2. Write the audio CD as described above.

3. The next step is to create a CD/DVD Project containing the data you want 
to incorporate on the CD.
How to create a CD/DVD Project is described in the section “Creating a new Data CD/
DVD Project” on page 585.

4. In the Write dialog for the Data CD//DVD (described in the section “The 
Write dialog for the Data CD/DVD” on page 590), select the options 
“Track At Once” for Write Method and “Close CD” for Closing Method.

5. Click on “Write”.
The data will now be added to the CD after the audio you added previously, and the CD-Extra 
is created and finalized (no further writing is possible).
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Validating an audio CD after burning
With a few easy steps, you can verify that an audio CD created from an 
Audio Montage was burnt correctly on CD – i.e. you can check what was 
burnt and compare it to what should have been burnt to see if there are 
any discrepancies. Of course, you can also do this as a test before the fi-
nal burning process.

This is done with the help of CD images and cue sheets and WaveLab’s 
ability to extract full CD images complete with all tracks, all index (and 
sub-index) markers and pauses, as well as CD-Text, ISRC and UPC 
codes.

Proceed as follows:

1. Make sure that the montage is set up as it should and click the Render 
button in the Master Section.
This opens the Rendering Preferences dialog.

2. Activate the option “Create CD image and cue-sheet”.
This is only available if the options “Whole Montage” and “Create Specific file” are activated, 
and if there are CD track markers in the montage. See “Mixing down – The Render function” 
on page 527 for detailed information about rendering a montage.

3. Select a name and location for the saved file, then click OK to render the 
CD image and cue sheet.

4. Next, open the CD image you rendered by selecting “Import cue-sheet/
CD image as Audio Montage” from the Open submenu on the File menu.
The CD image opens as a new montage.

5. Initiate burning from the Audio Montage Write CD dialog, as described in 
the section “Writing a CD” on page 574.

6. When the CD is recorded, open the “Import Audio CD Tracks” dialog 
from the Tools menu.

7. Select the drive containing the CD you just recorded, select the option 
“Convert to CD-Image/Cue-sheet” and import the CD.
This will extract a complete disc image of the CD. Please see “Importing audio CD tracks into 
WaveLab” on page 594 for detailed information about importing audio CDs into WaveLab.
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8. Select “Compare Audio CD images…” from the Tools menu.
The “Compare CD-images / cue-sheets” dialog opens.

9. Click the folder buttons to the right of the two text fields to open the cue 
sheets you created in step 3 and step 7 above, respectively.
The cue sheet you created in step 3 describes the contents of the CD as it should have 
been burnt, and the cue sheet created in step 7 describes the CD as it was burnt.

10. Click “Compare”.
The two cue sheets are now analysed, and a comparison of the two cue sheets/CD images 
is shown in the “Result” area at the bottom of the dialog.

The audio CD format – Background information
This text aims to provide you with some background information on the 
CD format, to help you better understand how to create your own CDs. 
This is a big subject, and we will only be able to touch upon it here. For 
more information, try a text-book on the subject, or search the Internet for 
more information.

The basic CD formats

There are a number of different formats for the contents of a CD disc. You 
are probably familiar with audio CDs, CD-ROMS, and CD-I. These are all 
slightly different, although they use the same media – CD discs. The au-
dio CD specification is called Red Book. It is this standard to which 
WaveLab conforms.
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Red Book CD is not a real file format

Those of you who are computer literate might know about file formats. 
Please note that Red Book CD is not a real file format. All the audio on the 
CD is stored in one big chunk, one file if you will. This is different from 
hard disks, for example, where each file is stored separately. Understand-
ing the fact that all the audio is in fact one long stream of digital data is 
something that will probably help you better understand the limitations of 
the format.

The different types of “events” on an audio CD

There are three types of events that can be used to specify various sec-
tions of audio on the CD. These are:

About frames, positions, small frames and bits 

The data on an audio CD is divided into frames. A frame consists of 588 
stereo samples. 75 frames make up one second of audio. Why? Well, 75 
x 588 = 44100, and since the sampling frequency of the CD format is 
44100kHz (samples per second), this equals one second of audio. When 
you specify positions on the CD, in WaveLab, you do it in the format 
mm:ss:ff, where mm is minutes, ss is seconds and ff is frames. The frame 
values go from 0 to 74, since there are 75 frames to a second.

Technically, there is no way to specify something smaller than a frame on 
a CD. One effect of this is that if the length of a track on the CD does not 
equal a perfect number of frames, some blank audio must be added at the 
end. Another effect of this is that when you play the CD, you can never lo-
cate (position) to anything closer than a frame. If you need some data in 
the middle of a frame, you still have to read the whole frame. Again, this is 
unlike a hard disk, where you can retrieve any byte on the disk, without 
reading the surrounding data.

Event Description

Track Start There can be up to 99 tracks on one CD. Each is identified by its start 
point only.

Track Sub-Indexes On advanced CD players, you might have noted that a track can be di-
vided into sub-indexes (sometimes called only indexes). These are used 
to identify “important” positions within a track. There can be 98 sub-in-
dexes in each track. However, since it is difficult and time-consuming to 
search for and locate to a sub-index, many CD players ignore this infor-
mation.

Pause A pause appears before each track. Pauses can be of variable lengths. 
Some CD players indicate the pauses between tracks on their displays.
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But frames aren’t the smallest block of data on a CD. There is also some-
thing called “small frames”. A small frame is a container of 588 bits. 98 
small frames together make up one regular frame. In each small frame 
there is actually only room for six stereo samples, which means that a lot 
of space is left for data other than the actual audio. There is information 
for encoding, laser synchronization, error correction and the PQ data (so 
called because it is stored in the “P” and “Q” bits). This PQ data is of ma-
jor importance to anyone who wants to create their own CD, so please let 
us explain it in further detail.

PQ codes and WaveLab's solution to handling them

The PQ codes convey information about track start, sub-indexes and 
pauses, as described above. They also contain the timing information 
(minutes, seconds, frames). To fit all this information in, a block of PQ in-
formation is spread out over 98 small frames.

Specifying PQ codes is not complex. However, when creating a CD there 
are a number of rules you must take into account. For example, there 
should be some silent frames before each track, sub-indexes should be 
slightly early, there should be pauses at the beginning and end of the en-
tire CD, etc.

When creating CDs from an Audio Montage, these rules and settings are 
handled by the CD Wizard. In a basic audio CD, they are collected in the 
“Advanced Settings” dialog on the CD menu. If you don't change these 
settings, you will get default values that ensure your CD will work prop-
erly. On the other hand, when the situation so requires, you can adjust 
them. We recommend you leave these settings as they are, unless you 
are completely sure of what you are doing.

ISRC codes

In addition to the basic PQ codes, there is something called “International 
Standard Recording Code”, identification that is only used on CDs in-
tended for commercial distribution. WaveLab allows you to specify an 
ISRC code for each audio track.

The ISRC code is structured as follows:

• Country Code (2 ASCII characters).
• Owner Code (3 ASCII characters or digits).
• Recording Year (2 digits or ASCII characters).
• Serial Number (5 digits or ASCII characters). 
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UPC/EAN codes

UPC stands for “Universal Product Code”. Some CD/DVD-R units allow 
you to specify this code, which is a thirteen-digit catalog number for the 
disc. Also known as EAN.

Pre-emphasis 

Pre-emphasis works by boosting (or pre-emphasizing) high frequencies 
before burning the CD, and cutting (de-emphasizing) them when playing 
back. The theoretical result of this is that the desired audio is returned to 
normal sound, but any other high frequency content (noise) in the record-
ing is reduced.

Disc-At-Once – Writing CD-Rs for duplication into “real” CDs

WaveLab only writes audio CDs in Disc-at-Once mode. There are three 
good reasons for this:

• If you want to create a CD-R to use as a master for a real CD production, 
you must write the CD-R in Disc-At-Once mode. In this mode, the entire 
disc is written in one pass, without ever turning off the recording laser. 
There are other ways of writing a CD, namely Track-At-Once and Multi-
Session. If you use these writing formats, the “link blocks” created to link 
the various recording passes together will be recognized as “uncorrect-
able errors” when you try to master from the CD-R. These links can also 
result in clicks when playing back the CD.

• Disc-At-Once mode provides more flexibility when specifying pause 
lengths between tracks.

• Disc-At-Once is the only mode that supports sub-indexes.

Writing on the fly vs. CD images

WaveLab always writes a CD on the fly, that is, it does not create a CD 
image before burning. This method makes writing CDs faster and requires 
much less disk space. However, if for some reason you need to, WaveLab 
lets you join all audio tracks in a basic audio CD into one large file that can 
be used as an “image” of the entire CD.

Using Exabyte tape drives – Creating DDP files

Those who work professionally creating CDs may prefer not to burn di-
rectly to CD-R, but instead create a file in DDP format (according to the 
DCA standard), for example on Exabyte tape.
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Cube-Tec International GmbH, in conjunction with Steinberg, provide 
such a solution as an addition to WaveLab. The product is called DDP-
Solution.

DDP-Solution includes the following features:

• Saves CD images directly to Exabyte tape or hard disk, in DDP format
• Automatic Verify
• Audio play
• DDP report printout
• Compatible with Sonic Solutions, SADiE and DCA systems
• Automatically creates basic audio CDs from DDP files
• Allows for DDP Data Burst before or after the audio data
• Allows you to monitor the data transfer rate to and from the drive
• Reads DDP image files in the “Import Audio CD Tracks” dialog

For further information, see the driver documentation.

For further information, contact Cube-Tec International on the web: 
http://www.ddp-solution.com
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Introduction
A Data CD/DVD project is an environment that can be used to compile 
and write a data only CD-ROM/DVD-ROM, Mixed Mode CDs and mixed 
data/DVD-Audio discs (although this is only possible when a Data CD/
DVD project has been automatically created from a DVD-Audio project, 
see “Creating a DVD-Audio compatible disc” on page 589).

• Data discs exclusively contain computer data. This can be files of any type. How-
ever, the files are stored on the CD/DVD in such a way that an audio CD player or 
a DVD-Audio player cannot recognize them.

• The difference between a Mixed Mode CD and a normal audio CD or a mixed 
data DVD-Audio disc and a normal DVD-Audio disc respectively is that the Mixed 
Mode CDs/mixed data/DVD-Audio discs contain both computer data and audio 
data that can be played back by a CD/DVD-A player.

• On a Mixed Mode CD, the computer data occupies track 1, and the music occu-
pies the subsequent tracks. Computer data on a DVD is stored in a separate di-
rectory, and is not shown in the visual menu of a DVD-A player.

An alternative to a Mixed Mode CD is the “CD-Extra” format, which also allows 
audio and data to be combined on the same CD. To create a CD-Extra, you 
first create and write an Audio Montage and then add the data. See “CD-Extra 
support” on page 575.
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Creating a new Data CD/DVD Project

For DVD, creating a new Data CD/DVD project as described below will en-
able you to create a data only DVD-ROM disc. To create any type of DVD-
Audio compatible disc, you have to first render a DVD-Audio project, see 
“Creating a DVD-Audio compatible disc” on page 589.

Creating a new Data CD/DVD project for data discs or Mixed Mode CDs

To create a new Data CD/DVD project, select “Data CD/DVD” from the 
New submenu on the File menu. A new Data CD/DVD window appears.

The principle is simple: The Data CD/DVD window has two main window 
panes; the source window on top and the destination window below.

The source window shows the contents of your hard disks (or other stor-
age media) in a way much like the Windows Explorer: with a folder hierar-
chy “tree” to the left and the contents of the selected folder shown to the 
right. The destination window shows the contents of the CD/DVD to be 
recorded, again with two panes in the same manner.

• To compile a data only CD-ROM/DVD-ROM or a Mixed Mode CD (but 
not a mixed data/DVD-Audio disc – see “Creating a DVD-Audio compat-
ible disc” on page 589), drag files and/or folders from the upper into the 
lower window pane.
You can record the CD/DVD as soon as you have placed all files in the lower pane.

• In the destination window, you can rename, remove or open files.

• You can save and open Data CD/DVD files from the File menu, as with 
other document types.
Data CD/DVD files have the extension “.cdp”.

Source window

Destination window
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Source window settings
You can decide how files and folders are displayed in the source window 
(as icons, as a list, etc.) by selecting one of the items on the Source menu 
(or by clicking the corresponding icon) on the source window toolbar.

To help navigating, you can use the functions “Up one level” and “Recent 
paths”. The latter (only available as an icon on the toolbar) displays a menu 
listing all recently used paths, allowing you to quickly go back to any of the 
listed folders.

The Source window Source menu contains the following view options:

Function Icon Description

Refresh Click on this icon to update the contents of the window. This 
is useful if, for instance, storage media has been added or re-
moved.

Show Audio Files If this function is active, the right part of the window pane only 
shows audio files, if available.

Show All Files If this function is active, the right part of the window pane 
shows all file types.
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Destination window settings

View settings

Use the Destination menu to adjust how files and folders are displayed in 
the destination window, just like in the source window.

Getting size information

At the bottom of the Data CD/DVD window, a ruler shows you the current 
and the maximum size of the project. On the CD/DVD menu you can set 
the ruler to display either a CD scale or a DVD scale, as well as define the 
actual available space of the destination media you intend to use (see 
“Define media size…” on page 588). Holding the mouse pointer over the 
ruler brings up a pop-up tip, showing you the exact size of the project, and 
a dotted, vertical red line in the ruler shows you the maximum available 
space on the destination media. This allows you to quickly assess the 
used and remaining space for the project.

You can also select “Properties” from the Destination window Edit menu, 
to get information about the number of files on the CD/DVD and their total 
size.

Editing the CD/DVD contents

You can move items between folders on the CD/DVD by using drag and 
drop, just like you drag them from the source window to add them. There 
are also various options on the Edit menu for adjusting the contents of the 
CD/DVD to be created:

• To add a new folder (within the selected folder), select “New Folder”.
See “Creating a Mixed Mode CD” on page 589 for a description of the “Add Audio Track 
Folder” function.

• To rename the selected folder, select “Rename” from the menu and type 
in a new name.

• To remove the selected file or folder from the Data CD/DVD, select “Re-
move”.
If a folder was selected, this and all its contents will be removed. Note that this only re-
moves files from the Data CD/DVD, not from the hard disk.

• To open the selected file or folder, select “Open”.
There is also an “Open in WaveLab” item, for opening audio files and other documents in 
WaveLab.
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The CD/DVD menu

The CD/DVD menu contains items for preparing and writing the disc:

Function Description

Disk Label… Opens a dialog where you can name the CD/DVD to be recorded.

CD/DVD Info… Displays the total number of files as well as the total file size on the CD/
DVD to be recorded.

Add photo viewer
to CD/DVD…

This opens a dialog where you can select to add a simple photo viewing 
application to CDs/DVDs that contain photo images. The viewer appli-
cation is called ImageViewer.exe and is added to the root of the CD/
DVD. It can only be used to visualize the photos on the CD/DVD. Note 
that the CD/DVD does not need to exclusively contain photos.

Write CD/DVD… Opens a dialog from where you can start recording the data or Mixed 
Mode CD (see below).

Save as ISO 
Image…

An ISO image is a file that holds the entire contents of a data CD or 
DVD (files and folders). You can create an ISO image of a CD/DVD and 
burn it later in WaveLab.

Create Label set… This allows you to create labels for your CDs. See “Selecting a tem-
plate” on page 604 for more information.

Edit text variables… Opens a dialog where you can edit and create text variables as used for 
CD labels (see “Defining user variables” on page 614).

Export text variables 
in ASCII…

This saves the current text variables as an ASCII text document in a tabu-
lated format, suitable for editing in a spreadsheet application such as 
Microsoft Excel.

CD Scale/DVD 
Scale

These items allow you to select whether the ruler at the bottom of the 
Data CD/DVD window should display a CD scale or a DVD scale, 
showing the available amount of storage space. Since a DVD can hold 
considerably more data than a CD, you should for proper reference se-
lect the appropriate option depending on which kind of media the mate-
rial you are compiling is intended to end up.

Define media size… Opens a dialog in which you can specify the available storage space of 
the destination media. If you for instance are using a DVD disc that can 
hold more data than the “standard” 4 700 MB, you can specify how 
much it can hold, to get a correct visual reference of the available space 
when preparing the DVD.
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Creating a Mixed Mode CD

To create a Mixed Mode CD (i.e. a CD with both audio and data), proceed 
as follows:

1. Select the “root” of the CD in the left destination window pane.

2. Select “Add Audio Track Folder” from the Destination window Edit menu.
An Audio Track Folder item appears in the destination window. This cannot be moved or 
removed.

3. Drag any audio files you want included as audio tracks from the source 
window to the audio track folder.

Creating a DVD-Audio compatible disc

There is only one method you can use to create a DVD-Audio compatible 
disc, regardless of whether you intend to add data or not.

1. You first have to create a DVD-Audio project and then render the Mon-
tage(s) that it contains (see “Creating and opening a DVD-Audio project” 
on page 552).

2. After the rendering process, a new Data CD/DVD window opens auto-
matically, containing an AUDIO_TS folder and an (empty) VIDEO_TS 
folder.
The AUDIO_TS folder contains all the rendered audio and visual menu content as well as 
optional value-added content (still pictures, text) stored as data files in various formats.

3. From here you can optionally add data and VIDEO_TS folder content cre-
ated in a DVD-V authoring application. 
Like WaveLab (or any other DVD-Audio authoring application) always 
creates an AUDIO_TS folder, a DVD-V authoring application will always 
create a VIDEO_TS folder.

• To add VIDEO_TS folder content drag it into the destination window.
This content can be accessed from a DVD Universal player (see “Types of DVD players” on 
page 370) or a standard video DVD player. See “Data structure of a DVD-Audio disc” on 
page 368 for general information about the VIDEO_TS folder.
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The Write dialog for the Data CD/DVD
When you select “Write CD/DVD…” on the Destination window’s CD/
DVD menu, you will first be asked for a name for the CD or DVD to be cre-
ated. After entering a name and clicking OK, the “Write virtual Disc” dia-
log appears. Here you can make all the necessary settings for the CD or 
DVD to be recorded. 

• If you burn a DVD-Audio to a DVD-RW that already contains data, you will be 
asked if you want to create a new session. In that case you will have to click 
“No” and erase all the data on disk.

Item Description

Write The CD/DVD writing process is started.

Close The dialog is closed.

Settings This opens a dialog where you can make settings for your CD/DVD 
recorder. The content of this dialog depends on the recorder used.

Disc Info If a writable disc is in the CD/DVD recorder, you can use this option to 
get information about its size and available space. 

Write speed Here you can select a write speed supported by your recorder.

Write method Here you can select a Write method supported by your CD recorder. 
If you are adding the data portion to a CD-Extra CD, you must select 
“Track At Once” (see “CD-Extra support” on page 575). For DVD, 
there are no write method options.
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Note that at the end of the DVD burning process it can take up to 15 minutes 
to close the DVD. Please be patient.

Closing method Here you can select a closing method. If you are adding the data por-
tion to a CD-Extra CD, you must select “Close CD” (see “CD-Extra 
support” on page 575).

Simulation Here you define if and how a simulation should be performed before the 
actual writing process. Simulating the writing process lets you find out 
whether the writing process will be successful, or if problems might oc-
cur. 

Write to hard
disk first

If this function is active (ticked), the writing program first writes an image 
file onto your hard disk (which must have enough free space to hold the 
file). An image file has the advantage that the data to be recorded doesn’t 
have to be converted into CD format during burning, as this is done when 
the image file is created. The actual burning (recording) procedure will 
therefore be faster and performed with greater reliability and less risk of 
malfunction.

Default Click on this button to save the current dialog settings as default. The 
next time you open the dialog, they will automatically be set.

Advanced If you click the “Advanced” button, the dialog is extended downwards 
and you get access to five tabs. These let you make a number of addi-
tional settings for the writing process. 

Item Description
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Importing audio CD tracks into WaveLab
WaveLab provides the ability to read audio tracks from regular CDs. This 
makes a digital copy of the audio from the CD directly into an audio file 
on your hard disk.

Although WaveLab supports a large number of CD drives, there are some 
restrictions you should be aware of:

• There are a number of different, not very well standardized protocols for re-
trieving audio from a CD-ROM/CD-R drive.
WaveLab tries to support as many of these methods as possible, but there are no guaran-
tees it will work with any particular drive. Some brands that reportedly use the same method 
still have slightly different implementations which might cause problems.

• Please observe and respect any copyright notices on the CDs from which 
you are reading tracks!

To import CD tracks, proceed as follows:

1. Insert the CD into the CD-ROM/CD-R unit.

2. Pull down the Tools menu and select “Import Audio CD tracks”.

3. Select the drive from which you want to read from the pop-up menu at the 
top of the dialog.

4. Select a read speed from the pop-up menu just beside this.
For information about which speed to use, click the question mark icon.

5. If necessary, click Refresh so that the list of tracks is updated.
The window now lists the tracks on the CD, plus some information about each track. Please 
note that the Copy Protection and Pre-emphasis columns are for information only, you can-
not change these settings.
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• By default, the tracks will be named “Track XX”, where XX is a number 
starting at 01. You can adjust the auto numbering scheme by right-click-
ing in the list and selecting an option from the pop-up menu that appears.
This pop-up menu also contains some additional functions for saving individual tracks di-
rectly as files, appending a track to the current Montage, etc.

The “Import Audio CD Tracks” dialog

6. Click on the Folder button at the bottom of the dialog to select a destina-
tion folder for the file(s).
The files will be saved with the name that is shown in the track list. To rename a file, double 
click on it in the track list and type the desired name.

The tracks must have unique names if you want to import them all. If two or 
more files have the same name, a warning dialog will appear when the sec-
ond one is imported, allowing you to either cancel the operation or to re-
place the first file saved with that name.

7. If you want to import to a format other than Wave, click on the file format 
button at the bottom of the dialog and select the desired format from the 
Audio File Format dialog that appears.
See “Supported file formats” on page 113 for information about the available file formats.
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8. If required, you can select one file and click Play.
This will play the beginning of the track so that you can check it out.

• If you notice that playback starts too late into the track – i.e. a small part of 
the beginning of the track is “cut out”, you can specify a pre-roll value to en-
sure that the entire beginning of the track is read.
This is done by selecting the option “Define reading of audio before and after CD track…” 
on the Options menu, and entering the desired pre-roll value in the dialog that appears. You 
can also specify a post-roll value to ensure that the entire end of the track is read. The tech-
nical reason behind this is that it’s not possible to locate, or position, to anything closer than 
a frame – a block of data on a CD. Thus, if there is data in the middle of a frame, you might 
have to specify a pre-roll or post-roll so that the whole frame is read. See “About frames, 
positions, small frames and bits” on page 578 for more information.

9. Select as many tracks as you wish from the list.
You can use [Ctrl] and [Shift] to make multiple selections, or use the Select All button.

• You can also “drag and drop” one or more CD tracks onto WaveLab’s 
desktop or into an Audio Montage to save them.
In the latter case, you can drop them in the clip list or directly into the track pane. For this to 
work, the item “Enable Drag and Drop to Audio Montages” must be activated on the Op-
tions pop-up menu.

10. If you have only selected one file, you can import just a part of the track by 
adjusting the start and end/length values.
The bar graph shows the part of the track that will be imported.

11. Click the Save button.
The track(s) are retrieved. Optionally, each is opened in its own window. This is specified in 
the progress indication menu that appears during importing.

About the Freedb function

You need to be connected to the Internet to use the Freedb function.

Clicking the Freedb button opens a pop-up menu where you can use 
some functions provided by Freedb to get information about your CDs. 
Freedb maintains a worldwide database of CD information.

• When an audio CD is inserted, you can query the database to get the track 
names of this CD, and more.

• If the CD is not yet recorded in the database, you have the option to become a 
participant by describing the CD and submitting your description to the database. 
Find more information on this at www.freedb.org.
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File format – Converting CD track(s) to other formats

The extracted audio files are saved in WAV (Wave) format by default. You 
can, however, directly save files in other audio formats by clicking the but-
ton at the bottom of the dialog to open the Audio File Format dialog, and 
select the desired file format from the Type menu.

Among the formats available are the following compressed audio formats: 
MP3, MP2, WMA and Ogg Vorbis.

When any of these formats is selected, you can click the Encoding field 
and select “Edit…” from the pop-up to open the corresponding Encoding 
dialog, where you can specify the bit rate and other attributes of the file to 
be created.

CD reading method

In rare cases, the default method of extracting audio samples from a drive 
does not work. In such cases you can change the extraction method used 
by selecting the “CD reading method” item on the Options pop-up menu. 
This opens a dialog with several optional audio extraction methods. Click 
the question mark icon in the respective dialog for details.

• Do not change the settings if you are not having problems!

About Ultra-Safe mode

Sometimes a small bit of a CD track is not properly retrieved (this de-
pends on the quality of your CD drive). This can result in unpleasant clicks 
and pops. To solve this issue, you can activate the ultra-safe mode on the 
Options pop-up menu. When activated, each CD track is read several 
times until the exact same result is found (check sums are used).

Convert to Montage

The “Convert to Montage” function can convert a CD to an Audio Montage. 
There are two basic methods you can use; Standard mode or Exact mode. 
The Standard mode analyses digital silence between tracks to recreate 
pauses between tracks. Certain CDs don’t have pure digital silence be-
tween tracks in which case the tracks will not be separated by pauses.

The “Exact” mode method is different (and can take a while to complete). 
Here, all tracks, all index (and sub-index) markers and pauses are re-
trieved (including audio-in-pauses), as well as CD-Text, ISRC and UPC 
codes. A single file is created. A third mode “Exact (no audio)” is also 
available. It is like “Exact” but without retrieving the audio tracks.
Once you have converted to a montage, you can reorder tracks, remove 
some tracks or add new tracks. You can use this function to create mixed 
compilations of CDs.
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Convert to Basic Audio CD

The “Convert to Basic Audio CD” function is similar to Convert to Mon-
tage (Standard mode), but a Basic Audio CD is created instead.

Convert to CD-Image / cue-sheet

This will convert all tracks, all index (and sub-index) markers and pauses 
exactly, as well as CD-Text, ISRC and UPC codes. A CD-Image file 
with a corresponding cue sheet is created. 

Notes

• Note that importing audio CD tracks is technically more complicated than reading 
files from a CD-ROM or hard disk, because audio sectors can be hard to detect. 
Some CDs which do not conform completely to the CD standard may cause 
problems.

• There are several other functions on the Options pop-up menu. Click the question 
mark icon in the dialog for details.

• If you import a CD track with Emphasis, and later want to use this on a CD of your 
own, remember to activate Emphasis for that track in the Audio Montage or Basic 
Audio CD window.
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Importing DVD-Audio tracks into WaveLab
WaveLab provides the ability to read audio tracks from DVD-A discs. This 
creates a digital copy of the audio from the DVD-A directly into an audio 
file on your hard disk.

The main uses for this function are:

• Recovering audio tracks from DVD-A discs you have generated and burnt 
onto DVD via WaveLab’s DVD-Audio project window (see “Creating and 
opening a DVD-Audio project” on page 552).
This function makes it possible to use DVD-A projects as “playable archives” from which 
you can retrieve and play back audio tracks.

• Similarly, you can use it to verify that DVD-A projects you generate in 
WaveLab are rendered correctly, and that tracks play back as they 
should.
This can be done before or after the DVD-A project is burnt onto DVD – i.e. either from hard 
disk or DVD-A disc.

• Please note that it is not possible to import audio tracks from commercially 
distributed, copy protected DVD-A discs!

• There are also several other factors that determine whether WaveLab will 
be able to read tracks from DVD-A discs or not, for instance if they use 
compressed audio formats such as MLP, AC3, etc.
The only way of finding out if the tracks on a certain DVD-A disc can be read or not is to try. 
If it isn’t possible via this dialog, the DVD-A is either copy protected or uses an audio format 
not supported by WaveLab.

To import DVD-A tracks, proceed as follows:

1. Insert the DVD-A into the DVD unit.
As previously mentioned, you can also import DVD-Audio tracks from a DVD-Audio project 
that has been generated to hard disk, but not yet burnt onto a DVD.

2. Pull down the Tools menu and select “Import DVD-Audio tracks”.
The “Import DVD-Audio tracks” dialog appears.

3. Use the Source DVD-Audio menu at the bottom left of the dialog to select 
the DVD drive or hard disk folder from which you want to import audio 
tracks.
Primarily, this is used for selecting a DVD drive containing the source material DVD-A. You 
can also select a directory on your hard disk in which you have saved a DVD-Audio 
project rendered from WaveLab.
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4. Use the Destination folder menu below to select a destination folder for 
the file(s) to be imported. You can either type in the folder name and path 
directly or click the folder button to browse for a folder.
The files will be saved with the name that appears in the visual menu. Note that you can re-
name a file later – after clicking “Save” (see below).

5. Next, click the Analyse button.
The DVD-A (on DVD or hard disk) is now analysed and the dialog is updated to display the 
contents of the DVD-A.

The dialog is dominated by a display showing the DVD-A disc’s visual 
menu (see “Generating DVD menus” on page 558 for information about 
visual menus). The album title, the group names and the track names are 
displayed. You can navigate the menu and select groups and tracks by 
clicking on them.

• Click on a group name to select it and show the tracks the group contains.
• Click on a track name to select it. You can select multiple tracks by pressing 

[Shift] or [Ctrl] when you click.
• To go back in the menu structure when displaying the tracks in a group, click the 

navigator button at the bottom of the visual menu.

The Navigator button.

• If the DVD-A does not contain a visual menu, the display will not show any-
thing. It is still possible to import audio tracks from a DVD-A that doesn’t 
contain a visual menu though, by selecting the option “Retrieve all groups” 
in the dialog (see step 8 below).

6. If you want to import to a format other than Wave, click on the file format 
button at the bottom left of the dialog and select the desired format from 
the Audio File Format dialog that appears.
See “Supported file formats” on page 113 for information about the available file formats.

7. If you wish, you can select a track and click Play.
This will play the beginning of the track so that you can check it out.

• If you notice that playback starts too late into the track – i.e. a small part of 
the beginning of the track is “cut out”, this could be because the pause be-
tween the track and the previous one (i.e. the area between a track end 
marker and a track start marker) actually contains audio.
In this case, you can activate the option “Get audio in pause”. All pauses between tracks on 
the DVD-A will then be checked to find if they contain audio, and any audio in pauses will be 
retrieved. See “Audio in pauses” on page 534 for more information about audio in pauses.
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8. The next step is to decide which audio tracks you want to import.
This can be done in one of three ways:

• Select the option “Retrieve selected tracks” to the top right, and then select as 
many tracks as you wish from the visual menu.
You can use [Ctrl] or [Shift] to make multiple selections, or use the Select All button. It’s 
possible to select tracks from several groups this way, as long as you keep pressing [Ctrl] 
or [Shift] when selecting groups and tracks.

• Click on a group to select it and select the option “Retrieve whole group”.
This way, all the tracks the group contains will be imported.

• Select the option “Retrieve all groups”.
This way, all tracks in all groups will be imported. 

• Note that “Retrieve all groups” is the only option possible if the DVD-A from 
which you’re importing does not contain a visual menu!

9. Click the Save button.
At this point, the File list dialog opens.

The File list dialog lists all selected tracks, their channel configuration, 
sample rate and resolution.

10. If you wish, you can rename tracks in the File list dialog by double clicking 
on them and typing the desired names.

• You can decide the syntax for the track names with the option “Use group 
name as prefix for file names”.
If this is activated, the saved file(s) will contain both the track name and the corresponding 
group name, in the syntax “Group Name – Track Name”.

The tracks must have unique names if you want to import them all. If two or 
more files have the same name, an error message will appear when the 
second one is imported, and the retrieval will be aborted.
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11. Optionally, activate “Create peak file”.
When this is activated, a peak file is created for each track as they are saved to disk. A peak 
file is a small file with the extension “.gpk” automatically created by WaveLab each time a 
file is modified or opened in WaveLab (if it hasn’t been previously). The peak file contains 
information about the waveform, and determines how it is drawn in the wave window.

With this option activated, the importing of the tracks will take slightly longer. On the other 
hand, no peak files will need to be generated later when opening the files which may also 
take some time.

12. The track(s) are retrieved. Optionally, each is opened in its own window. 
This is specified in the progress indication menu that appears during im-
port.

File format – Converting DVD track(s) to other formats

The extracted audio files are saved in WAV (Wave) format by default. You 
can, however, directly save files in other audio formats by clicking the 
large button at the bottom left of the dialog to open the Audio File Format 
dialog, and select the desired file format from the Type menu.

Among the formats available are the following compressed audio formats: 
MP3, MP2, WMA and Ogg Vorbis.

When any of these formats is selected, you can click the Encoding field 
and select “Edit…” from the pop-up to open the corresponding Encoding 
dialog, where you can specify the bit rate and other attributes of the file to 
be created.

Convert to Audio Montage

The “Convert to Audio Montage” option can convert an entire DVD-A or 
single tracks to an Audio Montage.

All tracks, all index markers and pauses are retrieved (including audio-in-
pauses if the option “Get audio in pause” is activated), as well as DVD-
Text and ISRC codes. A single file is created.

If the DVD-A contains several groups, each group will be converted to a 
separate montage.

Once you have converted to a montage, you can reorder tracks, remove 
some tracks or add new tracks. You can use this function to create mixed 
compilations of DVD-Audio discs.

Show DVD Text

This lets you view – but not edit – any DVD Text accompanying the DVD-
A. See “DVD-Audio text” on page 566 for information about DVD Text.
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Introduction
The Label Editor allows you to design and print custom labels for your CD 
and DVD-Audio projects. You can design separate layouts for front, inside, 
back and disk labels. Both text information and a wide range of image file 
formats can be imported and edited in various ways.

For DVD-Audio projects, you can create labels from within the Audio Mon-
tage, or you need to start the Label Editor and create them from scratch.

About variables and templates

Every CD Project/Audio Montage/Backup Plan/Import Audio CD Tracks 
session has a default set of “variables”, text that consists of a short code 
string plus a value. Variables provide information about a project, such as 
track titles, personal data, etc. There are two types of variables: factory 
and user editable.

Factory variables automatically provide information based on the contents 
of a project, and user editable variables can be customized to suit the 
current project. Variables are also used for the Audio CD Report func-
tion (see “Creating an Audio CD report” on page 541).

Templates are ready-made layouts that will use the information provided 
by the variables.

You can freely customize the properties of a template layout by using the 
Label Editor. Add new images or other objects, delete or edit existing ob-
jects, etc.

Selecting a template

The first thing you do before the Label Editor is opened is to select a tem-
plate. As mentioned previously, templates provide some information based 
on the current project, and have ready-made layouts:

1. Open the project you wish to create labels for.
This can be a CD Project, an Audio Montage, an Import Audio CD Tracks session or a 
Backup Plan.

2. Select the “Create Label set…” menu item.
Where this menu item is located depends on the type of project; for Audio Montages and 
Backup Plans it is on the Functions menu, for Data CD/DVD it is on the CD menu, and for 
Import Audio CD Tracks it is on the Options menu.
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3. A dialog appears, allowing you to select a template for your project.

To the right in the dialog there is a list of available templates, divided into three groups “Audio”, 
“Data” and “Audio + Data”. By clicking on the corresponding tab the available templates for 
the selected project type are shown in the list. To the left in the dialog, preview images of the 
front, back and the disk labels are shown.

4. Select a template, and click OK.
The Label Editor window opens, displaying the CD case front label.

• If you do not wish to use a template at all you can select “Void” in this 
dialog.
This will open the Label Editor with totally empty labels, allowing you to build your own 
labels from scratch by adding objects, specifying backgrounds, etc.

• You can also save user templates.
See “Saving a label set as a user template” on page 613.
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Using the Label Editor

Overview

The Label Editor always displays one of the three available views or 
pages: the front, back or disk case label. You switch between these 
pages by selecting the corresponding tabs below the toolbar. The layout 
is completely independent for each page.

• Please note that the front label can be either single- or double-sided. 
This option is set in the Page Layout dialog on the Printing menu.

The Label Editor window displays a frame with the currently selected label 
(front, back or disk) layout. Layouts are made up of editable objects – im-
ages, text boxes, lines or circles. You can also select either an image or 
color as background for the layout as a whole.

ToolbarFront/back/disk layout buttonsHorizontal and vertical rulers

Text box object

Circle object



WAVELAB
Creating labels 24 – 607

Basic object handling in the Label Editor

The Label Editor tools

Tools can be selected in three ways:

• From the Tools menu
• By clicking the corresponding icon on the toolbar
• By right-clicking in the background area (not an object), and selecting from the 

speed menu that appears

The following tools are available:

Tool Description

Selection tool Used to select, resize or move objects.

Zoom Object & 
Zoom In/Out

This is used to zoom in on a selected object, keeping it in view. 
The Zoom In/Out zooms the layout as a whole in or out. You can 
go back to normal magnification (1:1) by selecting “Zoom 
100%” from the Options menu.

Insert track list This will produce an automatically generated track list, based on 
the tracks belonging to the current project.

Insert box with text Creates a text box object.

Insert Circle This will insert a circle or ellipse object.

Insert Line This will insert line objects.

Insert Image This will insert an image.

Set background color…
(menu only)

Allows you to define a color for the background of the layout.

Set background image… 
(menu only)

Allows you to define an image for the background of the layout.

Selection tool

Zoom object

Insert track list

Insert box with text

Insert circle Insert line

Insert image

Print label

Zoom in/out
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Selecting objects

Click an object with the Selection tool to select it. 

• Selected objects are indicated by a dotted outline, and square “handles”, which 
can be used to scale the size of the object. 

• To select several objects, hold down [Shift] or [Ctrl] and click. Selected objects 
can be de-selected by [Shift]-clicking.

• When several objects are selected, one of the objects will always have “focus”. The 
focus is indicated by red handles on this particular object. You can move the fo-
cus to any of the selected objects by [Ctrl]-clicking.

Two objects selected, with the upper having the focus.

Resizing objects

If you click on a handle of a selected object, the pointer changes to a dou-
ble arrow, indicating that you can resize the object by dragging. Images or 
circle objects will be scaled, whereas dragging the handles of text box 
objects will resize the size of the box, not the text itself.

• You can also right-click an object and select “Edit Position and Size…” from 
the speed menu.
A dialog appears, allowing you to edit size (width and height) numerically, in cm/mm.
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Inserting new objects

Inserting new objects is done by selecting the corresponding tool, and 
clicking and dragging in the layout. When you release the mouse button, 
a dialog appears, allowing you to define basic properties for the inserted 
object. Note that this does not apply to image objects, where instead a 
standard file dialog appears.

• The Edit Properties dialog is also selectable from the Objects menu and by 
right-clicking objects and selecting from the speed menu.
See “About the Edit Properties dialog” on page 610 for a description of the items available 
in the Edit Properties dialogs.

Inserting a text box object

Deleting objects

To delete objects, select them and use the [Delete] key.

Copy/move object

If you manually move an object with the right mouse button pressed, a 
small pop-up menu appears when you release the button allowing you to 
either select to copy the object to the new position or to move it there.

Positioning objects

There are several methods you can use to position objects:

• Manually – by dragging objects using the Selection tool. 
• Automatically in relation to the layout frame. You can have an object centered 

(horizontally or vertically) by right-clicking it and selecting the corresponding item 
from the speed menu.

• Automatically in relation to other selected objects (see “The Objects menu” on 
page 611).
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• By selecting “Edit Position and Size…” from the Objects (or context) menu and 
adjusting the position numerically in the dialog that appears. Note that this adjusts 
the position of the object with focus.

You specify the position from the left side and the top of the layout frame, in cm/mm. 
Click “Apply” to apply the position change without closing the dialog.

About the grid, rulers and magnetize options

On the Options menu, you will find two items, “Show Grid” and “Show 
Rulers”. If these are ticked, the background of the layout will show a dot-
ted grid, and also vertical and horizontal rulers that show the current posi-
tion of the mouse pointer. Both these items help you to position objects 
with fine precision in the layout. The grid spacing can be specified in the 
Preferences dialog on the Options menu.

You can also use magnetize so that objects will snap either to grid posi-
tions, to other objects or to the frames limits (or all three), by selecting the 
corresponding Options menu item.

About the Edit Properties dialog

The Edit Properties dialog can be opened in three ways:

• By selecting an object and selecting “Edit Properties” from the Objects menu
• By right-clicking an object and selecting the same item from the speed menu 
• By double-clicking an object 

The contents of the dialog varies depending on the object type. Click the 
question mark icon in the respective dialog for details.
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The Objects menu

The Objects menu can be selected from the toolbar, or opened by right-
clicking an object (speed menu). The items on the Objects menu are 
greyed out if no object is selected. 

If one object is selected, the following Object menu items are available:

Item Description

Edit properties… See “About the Edit Properties dialog” on page 610.

Edit position and size… See “Positioning objects” on page 609.

Edit display condition This allows you to decide whether an object will be displayed or 
not, depending on whether a given variable is empty or not.

Bring to front This brings any object that is partially obscured by another over-
lapping object to the front.

Send to back This sends any object that partially or completely overlaps another 
object to the back.

Center horizontally Centers a selected object horizontally in the layout.

Center vertically Centers a selected object vertically in the layout.

Lock movement This locks the position of the selected object.

Select all Selects all objects.

Select all with the 
same size

Selects all objects with identical dimensions to the selected 
object.
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If several objects are selected when opening the Objects menu, the fol-
lowing additional items are available:

About label sets

You can save as many label sets as you like for a project. However, when-
ever you open the Label Editor by selecting the “Create Label” menu item, 
a new label set opens which is untitled and only contains the auto-gener-
ated data.

Whenever you have edited layouts in the Label Editor, you will be asked 
to save it as a label set if you close the Label Editor or exit the program 
without first having saved your changes. If you don’t save, any changes 
are lost.

• It is important to note that any work performed in the Label Editor is not 
saved with the project – it has to be saved separately as a label set.

Item Description

Apply same properties 
as focused object

This item allows you to apply properties from the focused object 
to all of the selected objects of the same type.

Space evenly horizontally This distributes the selected objects horizontally, using the top 
center handle as a guide. This means that the top center han-
dles in each selected object will be exactly the same distance 
from each other horizontally. 

Space evenly vertically This distributes the selected objects vertically, using the side 
center handle as a guide. This means that the side center han-
dles in each selected object will be exactly the same distance 
from each other vertically. 

Place under each other This will place all selected objects directly under each other.

Align with focused object 
(several items)

These menu items will align selected objects to the position of 
the focused object. You can select to align to any side (left/
right/top/bottom), or to the horizontal or vertical center of the 
object with the focus.

Resize as focused object 
(several items)

These menu items will resize all selected objects to either the 
same size as the focused object or to the same width or height 
as the focused object.

Group/Ungroup This will group all selected objects so that they will act as one 
object when selected or moved (keeping the relative positions 
to each other). Ungroup deselects the grouping.
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• Saved label sets (with the extension *.lab) contain all the layout work per-
formed in the Label Editor.
It is, however, not dynamic. This means that if you have added to or changed the CD 
Project, Audio Montage, etc. in any way after saving a label set, these changes will not be 
reflected in the saved label set, unless you save it as a user template (see below).

Saving a label set

To save a label set, select “Save” or “Save As…” from the File menu with 
the Label Editor open and as the active window (on top).

Opening a label set

To open a saved label set, select “Open” from the File menu and “Label 
Set…” from the submenu that appears.

Saving a label set as a user template

If you have saved a label set, you can make this appear on the list of avail-
able templates in the “Select a Label Template” dialog. Label templates 
are label sets that reside in designated subfolders inside the WaveLab 
program folder. The path to the Label template folders (starting from the 
main WaveLab program folder) is “Presets\Label\Templates\”. Here you 
will find four folders: “Audio/AudioData/Data/Images”. Place (or save di-
rectly) a label set in the appropriate folder. It will now appear as a new 
template next time you open the “Select a Label Template” dialog.
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Defining user variables

If you have reached this section via a cross-reference from the CD report 
section in the Audio Montage chapter, please note that the information ap-
plies equally to CD reports, although the text is written specifically for labels.

Apart from the auto-generated data such as media information, date and 
time, etc., you can define a number of user editable variables that are local 
to the project you are working on. Once you have defined a set of user 
variables, this is automatically saved with the current project. To define 
user variables, proceed as follows:

1. Open the project you wish to set user variables for.
This can be a CD Project, an Audio Montage, an Import Audio CD Tracks session or a 
Backup Plan.

2. Select the “Edit text variables…” menu item.
Where this menu item is located depends on the type of project; for Audio Montages and 
Backup Plans it is on the Functions menu and for Data CD/DVD Projects it is on the CD 
menu. Selecting this item opens a dialog containing a list of folders similar to the structure 
in the Windows Explorer.

• Only the variables in open folders (and “Editable” written in the Type col-
umn) can be edited.
The editable variables vary according to the type of project.
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3. To define a value for a default variable, for example copyright or personal 
information, double-click in the Current Value column for the relevant de-
scription.
A text box opens where you can type in the relevant information.

4. Click OK when done.

Creating new variables

You can create new variables and define values for them. The new vari-
able will automatically be put in the currently selected folder (or in the 
folder with a currently selected variable). Proceed as follows:

1. Either create a new folder by clicking the “New Folder” button, or select a 
folder that you want to add a new variable to.
If you chose the former option, select the new folder.

2. Click the “New Variable” button.
A new editable variable appears in the selected folder.

3. Double-click in the Description column beside the new variable to open a 
text box where an appropriate description can be typed in.
For example “Producer”.

4. Double-click in the Current Value column to enter the relevant information 
for the new variable, i.e. the name of the producer.

5. To create a code that can be used to refer to the variable in the Label Ed-
itor, type in an appropriate name beginning and ending with “%” in the 
Code column.
To use the earlier example, this would be written “%Producer%”.

6. Click OK when done.

Once you have entered your personal data you can save the text variables 
file as a preset, see below.

On the Options menu there is a default set of text variables that is al-
ways available. Use this as a clean slate for creating new variables.

Saving variable sets as presets

Clicking the name field pop-up at the bottom of the window opens a 
menu which allows you to save sets of variables as presets. After having 
saved one or more variable sets as presets, you can switch between dif-
ferent presets of already “filled in” variables by selecting one from the 
name field pop-up. A preset could typically represent the information be-
longing to a client you work with regularly, for example. Naturally, the auto-
generated variables will still adapt to the current project as usual.
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Exporting text variables in ASCII

This option opens the current text variables as an ASCII text document in 
a tabulated format, suitable for editing in a spreadsheet application such 
as Excel.

Where this menu item is located depends on the type of project; for Au-
dio Montages and Backup Plans it is on the Functions menu, and for CD 
Projects it is on the CD menu.

Printing labels
You print your labels directly from the Label Editor, either on standard pa-
per or on special media label paper (usually available in computer periph-
eral stores, etc.).

Calibrating the printer

If you are printing on special label paper, it is very important that the printer 
is “calibrated”, that is, the measurements in the program (for margins, po-
sitioning, etc.) must be exactly the same as the actual results you get when 
printing. This is not as important when you print on standard paper (since 
the printouts then don’t have to fit exactly in specific positions on paper).

To calibrate the printer, select “Calibrate printer” from the Printing menu 
in the Label Editor and follow the steps in the dialog that appears.

You only need to do this once (unless you switch to another printer).

Setting up page layouts

The Page Layout dialog contains various settings relating to how the page 
layout will be printed. It’s important to note that you make page layout set-
tings individually for each one of the three label types (case front, case 
back and disc label). These are also printed individually.

If you are using special label paper, these will typically come with a mea-
surement sheet, showing the exact size and positioning of the labels. 

To set up the page layout, select the desired label type (by clicking the 
corresponding tab) and select “Page layout…” from the Printing menu in 
the Label Editor. For details about the settings, click the question mark 
icon in the dialog. Note that there are different settings for the three differ-
ent label types.
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Printing

Printing is done independently for the three label types. However, there 
are two settings that are global for all three label types:

1. Pull down the Options pop-up menu and select “Preferences”.
The “Label editor preferences” dialog appears.

2. Use the “Printing” checkboxes to determine whether the frames around 
the labels should be printed, and whether cut markers should be printed 
(making it easier to cut out the labels from the printed paper).

Now, you are ready to print:

3. Select one of the label types by clicking its tab.

4. Select “Print” from the Printing menu in the Label Editor window.
The “Print label” dialog appears, allowing you to make printer settings, preview the result 
and specify a number of copies.

5. Click Print.

6. Select the next label type by clicking on its tab, and proceed from step 3 
above.
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Global analysis

Introduction

What does the “Global analysis” dialog do?

This dialog allows you to perform advanced analysis on your audio to find 
certain areas with specified properties. It can be used to find problem 
areas (glitches, distortion), etc., or to check general information such as 
the pitch of a sound.

How does it work?

When you analyse a section of an audio file, the program scans it and 
extracts overall information which it displays in the dialog.

However, during analysis, it also “pin-points” sections in the file that meet 
specific characteristics, for example, sections being very loud or very silent. 
You can then browse between these points, set markers at these places or 
zoom in on them.

About the tabs

• The Peaks tab is used for finding individual samples with very high values.
• The Loudness tab is for finding sections with high amplitude.
• The Pitch tab is for finding out the exact pitch of a sound or section.
• The Extra tab tells you about DC offsets and the significant bit resolution.
• The Errors tab helps you find glitches and sections where the audio has been 

clipped (recorded or processed at too high a level).
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General operations

Opening the “Global analysis” dialog

1. Make a selection in the wave file that you want to process.
This selection can be of any length and in one or both channels. If you want to analyse the 
entire file, hit [Ctrl]-[A]. If “Process whole file if no selection exists” is activated in the Pref-
erences - Wave edit tab, the whole file will be processed automatically if no selection has 
been made in 

2. Select “Global analysis…” from the Analysis menu.

Deciding what types of analysis to perform

As described above, there are several types of analysis that can be per-
formed. Each of them takes some time, so you may want to make sure that 
only the types your are actually interested in are included in the analysis.

It doesn’t hurt to have more options activated than you need, but it will 
slow down the process. The pitch analysis in particular uses up a lot of 
processing time, because by its very nature it is complicated.

If the section you are analyzing is very short, it doesn’t matter much 
whether all options are activated.

• Click on the Peaks tab and decide whether you want peak analysis by activating 
the “Peaks” option.

• Click on the Loudness tab and decide whether you want “RMS Power” analysis 
performed.

• Click on the Pitch tab for the program to find the “Average Pitch”.
• On the Errors tab, decide whether you want the program to search for “Glitches” 

and/or “Clipping”.
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Setting parameters and performing the analysis

1. Set up the parameters.

On most of the tabs, you will find settings determining exactly how the 
analysis should be performed. For example, on the Peaks tab there are 
two parameters:

• “Maximum number…” allows you to set an upper limit for the number of peaks re-
ported. For example, if you set this to “10”, the program will only report the ten 
highest peaks in the file.

• “Minimum time…” allows you to specify the minimum interval between two peaks 
found. For example, if this is set to “5 s”, there will always be at least five seconds 
between the reported peaks.

These two settings allow you to make sure that the reported peaks are not 
all in the same area. Click the question mark icon in the dialog for details.

2. If desired, move the wave cursor to a new position.
The Peak and Loudness tabs report values specifically for the position of the wave cursor, 
so if this is of interest, you should make sure the wave cursor is at the position for which you 
want a readout.

3. Click Analyse.

Checking and browsing the results

Checking the results on the Pitch and Extra tabs is simple, since there is 
only one value returned for the whole section of analysed audio. Just click 
on the tab and read off the values in the dialog (for details about the val-
ues, see later in this chapter).

For the other tabs, slightly more advanced options are available. This is 
since all these analysis methods provide their results as a number of posi-
tions in the file, positions that indicate peaks, glitches, etc. We call these 
“hot points”.

You can browse (jump) between these points in a very practical way. Pro-
ceed as follows:

1. Click on the tab that represents the values you are interested in.
For example, let’s say you click the Loudness tab.

2. Check the display for maximum/minimum values in the entire section anal-
ysed.
For the Loudness tab, these values represent the maximum and minimum amplitudes in the 
left and right channels respectively (for a stereo file).

3. Decide which of these values you want to browse.
For example, say you want to browse the minimum amplitudes in the right channel.
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4. Click on the button that currently displays this value.
The value displayed is for the “hot point” with the highest/lowest value. In our example, you 
would click the button in the lower right corner.

5. Check the “Number of hot points” value at the bottom of the dialog. It dis-
plays how many positions in the file the analysis found.
In our example it shows how many positions with low amplitude in the right channel meet 
the criteria specified by the parameters in the dialog.

6. Use the scroll bar below the “Number of hot points” value to browse be-
tween the positions found.
The wave cursor jumps between the points found by the analysis, and the display scrolls if 
needed.

7. When you want to browse another property, click on the corresponding 
tab (if required) and then on the value button that represents it.
For example, to check the amplitude of the left channel instead, click that button. To check 
peak values, click on the Peaks tab and then on one of the value buttons on that tab.

The result of the analysis is saved until you close the dialog or click 
Analyse again.

Click here to browse the minimum 
levels for the right channel.

Here you can see the number 
of “hot points” found.
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Creating markers

If you like you can add markers at the “hot points”:

1. Select a property and channel for which you want to add markers.
You will add markers for the same property as you are currently browsing, so this selection 
is done with the value buttons, as described above.

Since you are always browsing one channel at a time in a stereo file, mark-
ers can be added for only one channel at a time.

2. Click the “Create markers…” button.
Temporary markers (see “The various marker types” on page 329) are added at all “hot 
points”.

The markers are named using the following principle: “Hot point number” 
(“Channel”). For example, a marker at the third “hot point” in the left chan-
nel would be labelled “3 (L)”.

Focusing

You can also focus the display on a certain “hot point”:

1. Use the “Number of hot points” scroll bar to move the position indicator to 
the position you are interested in.

2. Click the Focus button.
Now two things happen:

• The wave display zooms in on the selected point.
• The “Global analysis” dialog is “folded in” so that only its title bar is visible.
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The Peaks tab

This is used to find peak values in the audio, that is, single samples with 
very high values.

Parameters

There are two report parameters:

• “Maximum number…” allows you to put restrictions on how many points will be 
reported. For example, setting this to “1” will make the program report only the 
highest peak (or one of the peaks with the highest value – if there are several with 
the same value).

• “Minimum time…” lets you set things up so that the points don’t occur too close. 
Settings this to “1 s” will ensure there is always at least a second between reported 
points.

Result

The Result fields show you the following values:

Option Description

Maximum The highest peak in the analysed section.

At Cursor The level of the sample at the wave cursor position, at the time of the analysis.
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The Loudness tab

This finds loud and weak sections in a more “intelligent” manner than the 
Peaks tab. The theory behind this is that there might be a single sample 
with a high or low value somewhere, but this may not necessarily mean 
that this section is perceived as loud/weak.

To find sections that the ear perceives as significant in volume, you must 
look at a longer section of audio. To do this you measure a consecutive 
section of samples and then average their value. WaveLab does just this, 
using a mathematical method called RMS (Root Mean Square) which is 
well known for its accuracy.

Parameters

The parameters on the Loudness tab are slightly more complicated than 
those for Peak analysis:

• “Resolution” is the length of audio measured and averaged. If this value is lowered, 
very short passages of loud/low audio will be detected. When it is raised, the 
sound will have to be loud/low for a longer period to result in a hot point.

• “Threshold…” is used for recordings where there are pauses, to make sure the 
average value is calculated correctly. A pause could “fool” the algorithm. There-
fore you can set up a value, and all audio below that value will be considered si-
lence and will not be taken into account for the average value.

• “Maximum number…” and “Minimum time…” are the same as on the Peaks tab, 
see above.
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Result

The Result fields show you the following values:

The Pitch tab

The Pitch tab shows the values from WaveLab’s extremely accurate pitch 
detection algorithm. This can be used for pitch shifting, for example, to 
get one sound in tune with another.

There are no parameters to set. The display shows the pitch for each 
channel, both in Hertz (Hz) and as semitones and cents (hundredths of a 
semitone).

Since the display shows an overall value for the entire analysed section, 
the “hot point” controls in the lower section of the dialog are not used on 
this tab.

Option Description

Maximum and 
Minimum

The level of the highest and lowest points in the analysed section.

Average The overall loudness of the whole analysed section.

Around Cursor The loudness at the wave cursor position at the time of the analysis.
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Usage guidelines

• The result is an average value for the whole selection.
• The method only works on monophonic material (not on chords or harmonies).
• The algorithm assumes the analysed section has a reasonably stable pitch.
• The material must be relatively well isolated from other sounds.
• It is preferable to analyse the sustain portion of a sound, rather than the attack. 

The pitch is usually not “stable” during the attack.
• Some synthetic sounds may have a weak fundamental (first harmonic) which can 

fool the algorithm.

The Extra tab

This tab shows you two things:

• The average DC Offset in the analysed section.
See “Eliminate DC Offset” on page 195 for details.

• The Apparent Bit Resolution.
This attempts to detect the actual resolution in the audio, i.e. how many bits are really used. 
This is useful e.g. if you want to check whether a 16 bit file really uses 16 bits (or if it was 
actually recorded with only 8 bit resolution and then expanded up to 16 bits).

You may want to use the Bit Meter for this instead (preferably in “Analyse Se-
lection” mode), as this is even more accurate (see “Bit Meter” on page 170.
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The Errors tab

This tab actually reports two totally separate things:

• Glitches
These are disruptions in the audio. Glitches may occur after problematic digital transfers, 
after careless editing, etc. They manifest themselves as “clicks” or “pops” in the audio.

• Clipping
A digital system has a finite number of levels that it can represent properly. When a sound 
has been recorded at too high a level or when digital processing has raised the level past 
what the system can handle, hard clipping occurs. This will be heard as a very harsh type of 
distortion.

A sine waveform before clipping……and after.

Report parameters

“Maximum number…” and “Minimum time…” are the same as for the 
Peaks tab, see above.
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Glitch parameters

• “Threshold” is a value for setting how drastic a change in level has to be reported 
as a glitch. The higher this value, the less sensitive the detection.

• “Sensitivity” is a length value. It represents the length of time that the waveform 
must exceed the threshold to be reported as a glitch. The higher this value, the 
less sensitive the detection.

It is not 100% certain that the points found by the algorithm are real glitches. 
Please zoom in and play back to check whether the found points really indi-
cate a problem.

Clipping parameters

The program checks for a number of consecutive samples at full value, to 
determine whether clipping has occurred. “Threshold” is a setting to de-
termine the exact number of these consecutive samples which must oc-
cur for the program to report clipping.

Results

This reports the number of glitches and clipping instances that have been 
found.

Working with presets

As with effect processors you can create presets for all the settings in the 
dialog for quick recall. See “Presets” on page 65 for details.
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Audio error detection and correction
This function can be used to detect and remove all sorts of click noise, in-
cluding digital clicks. You can also restore damaged portions of an audio 
file by using waveform replacement.

Several detection and restoration methods are available. You can detect, 
mark and name, jump to, play back and remove individual audio errors.

Selecting a detection method

Proceed as follows:

1. In WaveLab, open the file you wish to process.

2. Open the “Audio error detection and correction” dialog by selecting “Au-
dio error detection and correction” from the Analysis menu.

3. Select one of the detection methods available on the Detection method 
pop-up menu.
The methods Click Detection 1 and 2 will search for clicks in certain frequency ranges and 
the method Digital Click Detection looks for clicks that are caused by a single sample.
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Depending on which method you have selected, different detection para-
meters are available:

The Detection method pop-up menu.

When you have selected a Detection method there are two ways to con-
tinue: selecting to detect all errors (see below) or selecting to detect indi-
vidual errors (see “Correcting individual errors” on page 634).

Automatic detection and correction

You can let WaveLab automatically remove all click noise errors that it 
can detect.

Parameter Description

Threshold The lower the value you set for this detection threshold, the smaller or 
softer clicks are detected.

Detection This parameter lets you set the lower limit of the analysed frequency 
range. Available for the Click Detection 1 and 2 methods.

Detection width This is used to set the width of the analysed frequency range. Only 
available when using the Click Detection 2 method.
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1. Click on the “Detect all errors” button to start the search for all detectable 
errors.
WaveLab will now search the complete file and insert a pair of markers for each found error.

Here, WaveLab has detected an error in the waveform.

2. In the Restoration method pop-up menu, select one of the available op-
tions.
A description of what the selected method does is displayed below the pop-up.

The Restoration method pop-up menu.

3. Click on the “Correct all errors” button.
WaveLab will now automatically correct all errors it has detected.
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Correcting individual errors

You can of course also detect and correct individual errors, using differ-
ent detection methods and parameter settings for each error, if necessary. 
This is especially useful in cases that can’t be solved easily.

1. Open a file and select “Audio error detection and correction…” from the 
Analysis menu.
The “Audio error detection and correction” dialog opens.

2. Select a Detection method as described earlier.

3. Click the “Detect next error” button.
WaveLab will now analyse the audio file from the beginning, and stop at the first found error.

4. From here there are several options for how to proceed (some of the op-
tions are only available after first selecting another option): 

Option Description

Detect next error Starts the search for the next error, starting at the cursor position.

Correct current error Restores the currently selected error using the selected restoration 
method.

Undo Reverses the currently selected and corrected error to its previous 
uncorrected state.

Mark for later restoration Assigns a pair of markers to the selected error.

Unmark Deletes the markers of the currently selected error.

Previous mark Jumps to the position of the previous marker pair.

Next mark Jumps to the position of the next marker pair.

Play region Starts audio playback of the currently selected error region.
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Options

In this section of the dialog you can activate the “Auto-play” function, 
which automatically plays back each error that is found. With the “Pre-roll 
time” and “Post-roll time” options you can define how much of the audio 
file before and after the error is to be played back.

You also have the option to automatically set green markers encompass-
ing the corrected errors.

Reset search position

When you click on this button located at the top right of the “Audio error 
detection and correction” dialog you set the search start position back to 
the start of the audio file.

Zoom in wave window

If you click on this button located at the bottom of the dialog, the Wave 
window will display the detected error in high resolution (one sample 
equals one pixel on your screen). The “Audio error detection and cor-
rection” dialog will be “folded in” (i.e. only the dialog title bar will be visi-
ble) so as not to obstruct the view. To display the entire dialog window 
again, double-click its title bar.

Saving and loading Presets

The current “Audio error detection and correction” dialog settings can be 
saved temporarily (in the computer’s RAM) or permanently as a Preset.
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Find the corresponding functions in the presets pop-up menu at the bot-
tom right of the dialog.

The presets pop-up menu

• To store the settings temporarily (in the computer’s RAM), select one of 
the options on the Store temporarily submenu.

• To save the settings as a preset, select “Save as…” on the presets pop-
up menu and specify a file name and location for the preset.

The Audio Range dialog

Click on the “Range” button at the top right of the dialog to open the Au-
dio Range dialog. Here you can define playback and selection ranges in 
great detail. The Audio Range dialog is described in the section “Using 
the Audio Range dialog” on page 141.
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Audio file comparer

This utility allows you to compare two files and create a file that contains 
the difference between the two, a “delta file”. This is useful for example to:

• See the effect of using an equalizer by comparing the file before and after. The 
delta file will show what was added.

• Check the noise added by a processor, again by comparing.
• Compare two digitally recorded files to check for dropouts.

Proceed as follows:

1. Make sure that the two documents you want to compare are open.

2. Select “Audio file comparer…” from the Analysis menu.

3. Fill out the dialog box and click OK.
Click the question mark icon in the dialog for details. Here’s a run down of the major possi-
bilities:

• The program can create a delta file, that is, a file that only contains the differences 
between the two files. This allows you to hear the difference between two files, for 
example to check what got lost when you applied data compression to a file.

• The program can add markers at positions where differences are found. For this 
to make sense, the differences between the files must be small.
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3D Frequency Analysis
This function allows you to view a wave file in the frequency domain rather 
than in the time domain. Although a wave display (time domain) tells you a 
lot about where one sound starts or ends in a file, for example, it doesn’t 
say anything about the timbral contents of the file. A frequency graph (fre-
quency domain) does.

The graph used in WaveLab is actually something often referred to as an 
FFT (Fast Fourier Transform) plot.

Creating the graph

1. Select the part of the file you want to analyse.
If you select a stereo recording, a mix of the two channels will be analysed.

The length of the selection affects the accuracy of the analysis. For short se-
lections the result will be very detailed. For longer selections (over a minute 
or so) it will not give equally detailed results, since the harmonic content 
might vary “between the measure points”, which is then not shown in the 
display. You might for example make a separate analysis of the attack (be-
ginning) of a sound, since the most drastic variations usu ally occur there.

2. Select “3D Frequency analysis options” from the Analysis menu and click 
on the Frequency tab. Adjust the settings if needed.
These are the only settings that cannot be redone when the graph is already open.

3. If you only want to see a plot for a part of the frequency range, adjust the 
“From” and “To” values.
The range must always span at least three octaves.

4. Decide if you want the frequency axis in the graph to be linear or logarith-
mic.
Logarithmic is often the most natural choice since each octave (doubling of the frequency) 
is then represented by an equal distance on the frequency axis.
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5. Click OK to close the dialog.

6. Select 3D Frequency analysis from the Analysis menu.
The wave is analysed and the graph opens in a new window.

The frequency graph shows you how the different frequency components 
vary over time. A high “mountain” means that this frequency is very promi-
nent at that particular time.

Adjusting the view

There are a number of settings you can make that affect the way the 
graph is displayed.

1. Either select “3D Frequency analysis options…” from the Analysis menu, 
or double click directly on the graph. Click on the Style tab.

2. Decide whether you want the graph to be in color, grey scale or black and 
white.

3. Decide whether you want to use a change in color to represent the ampli-
tude (the height of each mountain determines its color) or if you want it to 
represent frequency (the frequency spectrum is drawn in colors ranging 
from red to purple).

4. Decide on a background color (black or white).

5. To view the effect of your changes, click Redraw.
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6. Click the Perspective tab.

7. Decide from which point of view you want to examine the graph (use the 
“freq/time” figure as a directional guide).

8. Decide whether you want a linear or exponential amplitude display.
The Wave window’s level rulers use a linear display, so this is a natural choice to start with.

9. Again, if you so desire, click Redraw.

Working with multiple views

If you wish you can view the same graph in several windows, but with dif-
ferent style and perspective settings. This allows you to get a better view 
of an otherwise crowded graph.

• To open a second view of the graph, drag-create a window, see “Working with 
multiple windows” on page 54.

• To make settings for one of the windows, select it, open the “3D Frequency anal-
ysis…” options dialog from the Analysis menu and proceed as described above.

Examples of how the graph can be used

The graph can be used for example for the following purposes:

• To see how the frequency spectrum is distributed in a mix.
• As a basis for EQ-ing, so that you know which frequencies to reduce or boost.
• To see which parts of the audio spectrum a certain background noise occupies (for 

removing by filtering).
• For educational purposes – these graphs tell you a lot about how different sounds 

are “built”.



WAVELAB
Analysis 25 – 641

Loudness distribution tool

This analysis tool measures the most frequent loudness found in an audio 
file (this is different from average loudness). The graphic peaks found by 
the analysis represent these values.

The following parameters can be set:

Parameter Description

Resolution Loudness is the average audio volume computed over a given period. 
This parameter represents this period. Smaller time values are more 
suited for sections with abrupt changes in level, like drum hits.

Left/Right Allows you to display the loudness in both channels or either the left 
or right channel in a stereo file.

Mono/Mix For a stereo file, this option displays a single graph (average left/right).

Display range This adjusts the vertical ruler range, so you can zoom-in the graph 
(Auto mode has to be off).

Auto When this is activated, the vertical ruler is automatically adjusted to 
optimize the display.

Analysis 1-3 You can store 3 different graphs, which is useful for comparison pur-
poses. When comparing similar curves, you should switch off Auto 
mode, to keep the same scale for each analysis.
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Audio Signal Generator

This utility allows you to synthesize audio documents from scratch. The 
resulting documents can then be used for a number of purposes:

• For testing the specifications of audio equipment.
• For measurements of various kinds, including calibrating tape recorders.
• For testing signal processing methods.
• For educational purposes.

The Audio Signal Generator is not intended for synthesizing musical 
sounds.

The Signal Generator is based on a waveform generator which can gen-
erate a large number of basic waveforms such as sine, saw, pulse and 
various types of noise.

The Signal Generator has a multitude of settings for character (Source 
tab), frequency (Frequency tab) and amplitude (Level tab).

As if that wasn’t enough, you can combine up to 64 such signal generators 
into “layers” and even make separate settings for the left and right channel 
for each.

Once all settings have been made, the program calculates an audio file 
according to the specifications.
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Proceed as follows:

1. Select the Audio Signal Generator option on the Tools menu.

2. Decide on a number of layers, by setting the “Number of layers” para-
meter at the bottom of the dialog.
You can always change this value at a later stage if required.

3. Select one of the layers, using the “Edit layer” parameter.

4. Decide if you want to make changes for both or just one of the channels in 
this layer, by using the “Edit channel(s)” pop-up.

5. Make the required settings on the Source, Frequency and Level tabs.
Click the question mark icon in the dialog for details. Please note that the length of the file 
is determined by settings on the Level tab.

6. Repeat steps 3 to 5 as required.

7. When everything is done, set up a file format and Global level in the mid-
dle section of the lower half of the dialog.

8. Click Generate.
The file is generated and opens up in a new window.

The algorithms that the Audio Signal Generator is based on were optimized 
for accuracy, not for speed. Creating long and/or complex files might take a 
while, especially on slower computers.
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DTMF Generator

DTMF (Dual Tone Multi Frequency – or Touch Tone) is a way of generat-
ing signals by combining two sine waves with variable frequencies, used 
in telephone systems. The numbers you press generate sine waves of dif-
ferent frequencies, and these signals are then decoded at the central 
telephone office to actually identify which numbers you press.

The DTMF Generator does just this – it allows you to generate an audio 
file with the sounds you hear when pressing the different keys on a tele-
phone.

To use the DTMF Generator, proceed as follows:

1. Pull down the Tools menu and select DTMF Generator.
The DTMF Generator dialog opens.

2. Enter a dial string in the text box in the top of the dialog.
The characters you can use are the same as those you can use on a telephone and are 
listed in the dialog. Any other characters will not generate any tone.

3. Select the desired standard; DTMF or MF.
The difference between the options is described in the table below.

4. Make the desired settings for Durations and Amplitude.
Click the question mark icon in the dialog for details.
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5. Select a bit resolution and a sample rate for the file to be created.
When you click the button, the Audio Properties dialog (see “Editing audio properties” on 
page 127) opens to let you make settings for the audio file.

6. If you wish, you can save the settings you make as a preset.
You can create presets for settings in the dialog, for quick recall.

7. When the settings are to your satisfaction, click Generate.
The file is generated and opens up in a new window.
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Introduction
It is possible to synchronize the audio playback in WaveLab to incoming 
MIDI Time Code (MTC), or via the ASIO Positioning Protocol (for sample 
accurate sync). 

• For MTC sync to be possible, you need to have a MIDI Interface installed 
and working!

• For sync to ASIO Positioning Protocol, you need compatible audio hardware 
with a built-in time code reader.
See “Sync to ASIO Positioning Protocol (APP)” on page 656.

MTC sync
MIDI Time Code provides timing information, so that each time position 
coincides in the master (the other recorder, MIDI sequencer, etc.) and the 
slave (WaveLab). However, there is still one problem: Even though Wave-
Lab starts playback of an audio file at the exact correct position, it cannot 
affect the timing of the audio file once playback is started. At that point, 
the playback of the audio file is only dependent on the clock on the com-
puter’s audio card.

Let’s say you are syncing WaveLab to a tape recorder providing MTC. As 
the clock on the computer’s audio card and the internal clock of the mas-
ter (in this case the tape recorder) are not synchronized, the audio file(s) 
played back by WaveLab and the tape tracks will inevitably be drifting out 
of sync after a period of time.

The solution is to not only synchronize WaveLab, but also the audio card! 
This means that you need:

• A synchronization device that can send both MTC and word clock.
• An audio card that can read and synchronize to incoming word clock.

With this setup, the master device sends MTC into WaveLab (ensuring 
that audio playback starts at the correct time position) and word clock to 
the audio card (ensuring that audio playback continuously follows the 
master device.
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It is worth noting that without using a word clock based system, it is possi-
ble to synchronize WaveLab with another device for a shorter period of time. 
Exactly how long depends on a number of factors, such as the overall sta-
bility of the system (using an ADAT as master will provide higher stability 
than using an analog tape machine for example) and the length of the audio 
files played by WaveLab, etc. 
Also note that if a project involves using several different types of machines 
as the master, the result (the length of time synchronization is upheld) is 
likely to vary in an unpredictable way. For best results when using synchro-
nization without word clock, it is recommended that you use a fixed (and 
relatively stable) setup during the course of the project.

Setting up

1. Make sure the desired Montage or Wave window is active.
This is important, since each Montage or Wave can have separate Sync settings.

2. Pull down the Options menu and select Preferences.
The Preferences dialog appears.

3. Click the Sync tab.

4. Pull down the MIDI Input pop-up menu and select the MIDI Input port to 
which your synchronization device is connected.
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If the time code in the master device is offset (so that playback starts at a 
time position other than zero), you need to compensate for this in Wave-
Lab by setting the SMPTE Offset parameter to the same value:

5. If the SMPTE Offset is positive, click the [+] button next to the SMPTE 
Offset parameter. If it is negative, click the [–] button.

6. Set the SMPTE Offset parameter to the time position when you want 
playback to start.
This should be set according to any offset values in the master device, so that both devices 
have the same start position. The offset value is subtracted from (+ button activated) or 
added to (– button activated) the incoming time code. Usually, positive offset values are 
used. If you edit this value during playback you have to stop and restart for the change to 
take effect.

Each Audio Montage can save its own SMPTE offset. When you edit the off-
set in the Preferences dialog, you actually edit the offset of the currently ac-
tive audio document.

7. Leave the Time Correction parameter at 0 for now.
You may need to adjust this later on, as described below.

8. Click OK to close the dialog.

Activating MTC sync

To activate MTC sync in WaveLab, proceed as follows:

1. Click the playback start position icon to the left on the Transport bar.
A pop-up menu appears.
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2. Select “Sync from MIDI Time Code” from the pop-up menu.
The button changes shape to a MIDI symbol, indicating that WaveLab is in MTC Sync mode.

• You can also activate Sync mode by pressing [Shift]+[F9] on the com-
puter keyboard.

WaveLab is now expecting MIDI Time Code, and will start playback when 
the master device is started. If the MIDI Time Code stops, WaveLab will 
stop playback but remain in Sync mode. You can also do the reverse: 
start the master (generating MTC), then press [Shift]+[F9] to start Wave-
Lab in sync.

• If you find that there is a slight, constant offset between the master and 
slave, you need to adjust the time correction parameter until you get it right, 
either by stopping playback and going back to the Preferences dialog, or by 
nudging the sync offset (if you are playing back a Montage; see below).
Although rare, such an offset could occur due to audio card latency, “slow” MIDI equip-
ment, the coarseness of the MTC signal, etc. 

3. To exit Sync mode, select another playback start position option from the 
pop-up menu, press [Shift]+[F9] or stop playback manually.

Sync mode 
selected
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Nudging sync offset

This is only possible when playing back an Audio Montage. For general in-
formation about nudging, see “Nudging” on page 430.

For various reasons, you may find that there is a slight constant offset be-
tween the master and the slave during synchronized playback. This is ad-
justed with the time correction parameter in the Preferences–Sync tab. 
However, trying to guess the correct time correction value in Stop mode 
can be a time consuming process. Instead you can nudge the time correc-
tion value during playback and use your ears to find the optimum setting:

1. Pull down the Edit view Options menu and select “Synchro Offset 
(SMPTE)” from the Nudge submenu.
You may also want to deactivate the “Auto Select” option on the Nudge submenu, to avoid 
accidentally changing nudge target.

2. Activate synchronized playback as described above.

3. If WaveLab’s playback is “behind” the master, click the right Nudge icon 
or press [F12].
This will skip samples, effectively “speeding up” WaveLab’s playback. This may cause 
some clicks just after you nudge. 
The timing adjustment will be audible after the playback latency time (displayed in the Pref-
erences–Audio device tab).

4. If WaveLab’s playback is “ahead of” the master, click the left Nudge icon 
or press [F11].
This will add blank samples, effectively “slowing down” WaveLab’s playback. This may 
cause some clicks just after you nudge. Furthermore, these blank samples will have to be 
played back, resulting in a short silence, during which the Montage cursor will stay flickering 
in one place.

• As when nudging other Montage elements, you can use modifier keys to 
determine the nudge “impulse”:

Modifier Impulse

No modifier (standard impulse) One frame

[Shift] (large impulse) One second

[Ctrl] (small impulse) 1/10 frame

[Ctrl]+[Shift] (micro impulse) 1/100 frame
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These values are fixed, and are not affected by the current setting in the 
Nudge Impulse Value dialog.

5. Repeat the nudging procedure until you find the optimum setting (no au-
dible offset between master and slave).

6. Stop playback.
Now, your adjustments are added to the current SMPTE Offset and/or time correction set-
tings in the Preferences dialog, so that next time you start playback, the two devices will be 
in sync.

Again, the purpose of this function is to adjust for any constant offset be-
tween master and slave. It is not meaningful to use this for compensating for 
drifting sync (in a setup without word clock).
Also note that this is a function for fine adjustments, ± a few seconds at most.

Checking incoming time code

You can inspect the incoming MIDI Time Code in the following way:

1. Enable Sync Mode as described above.
The Time Code display will only be updated in Sync mode.

2. Open the Monitor window from the Specialized Windows submenu on 
the View menu.

3. Click the Timecode tab at the bottom of the Monitor window.
Now, the Monitor window serves as a time code display, indicating incoming time code in 
the format hours:minutes:seconds,frames:
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Sync to ASIO Positioning Protocol (APP)
In order to take advantage of the ASIO Positioning Protocol, your audio 
hardware must be suitably equipped and the functionality must be in-
cluded in the ASIO driver for the hardware.

Hardware and software requirements for APP

• Your computer audio hardware must support all the functionality required 
for the ASIO Positioning Protocol. 
That is, it must be able to read the digital audio and the corresponding positional informa-
tion from the external device.

• There must be an ASIO 2.0 driver for the audio hardware.

• For resolving to external timecode, the audio hardware must have a time-
code reader built-in.

For information about which audio hardware models currently support 
APP, see the Steinberg web site (www.steinberg.net).

Activating

When using the ASIO Positioning Protocol there is no setting up required 
in WaveLab, since the timecode comes in directly via your audio hardware. 

To activate APP sync in WaveLab, proceed as follows:

1. Click the playback start position icon to the left on the Transport bar.
A pop-up menu appears.

2. Select “Sync from ASIO Time Code” from the pop-up menu.
You can also activate ASIO sync mode by pressing [F9] on the computer keyboard.

• When APP sync is activated, WaveLab starts playing the wave file or the Audio 
Montage as soon as time code comes in via ASIO. 
It will be locked to exact positioning (with sample accuracy) from then on.

• If you need to stop and restart in sync, press [F9] twice, to deactivate and 
reactivate the synchronization. 
If the time code has a discontinuity, then WaveLab stops and restarts automatically at the 
new position.
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Introduction
This chapter describes various operations related to samplers. WaveLab 
has the ability to communicate with most audio samplers on the market, 
making it possible to receive and transmit audio.

Connected to this functionality is the possibility to create good loops. 
Looping is a common technique used in samplers to simulate the infinite (or 
at least very long) sustain of many instrumental sounds. WaveLab has tools 
for creating smooth loops, even for the most complex types of sounds.

What we normally refer to as audio files in WaveLab are probably called 
“samples” in your sampler. In this chapter we will adhere to this terminol-
ogy and call audio recordings “samples”.

Background information

About the various communication methods

Samplers from various manufacturers are very different when it comes to 
communication possibilities. The following section tries to categorize the 
various means of communication that are available:

Generic SDS (Sample Dump Standard)

SDS is the most basic and widely spread way of communicating with a 
sampler. It is part of the MIDI standard. SDS allows you to send and re-
ceive samples, but does not support any type of name handling. Specify-
ing which sample to send/retrieve is done using numbers.

Recommendation: Use SDS only if no other means of communication is 
available. It works well, but it is slow and not very practical.

The WaveLab implementation of SDS requires two way MIDI communica-
tion between the sampler and computer (MIDI In to MIDI Out and vice 
versa). “Open loop” (one way) transfers are not supported.
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Generic SMDI 

SMDI is the SCSI version of SDS. Since it uses SCSI as a carrier, it is 
much faster. However, it doesn’t have very much additional functionality; 
again samples are identified via numbers rather than names.

Recommendation: Use SMDI if you want fast communication, have the 
necessary computer equipment and a sampler that supports it. However, 
if your sampler supports some proprietary type of SCSI communication, 
this is preferred to SMDI.

Proprietary MIDI only communication

Many samplers use proprietary MIDI communication protocols to ex-
change sample data. Normally this will provide better functionality than 
SDS, for example the possibility to specify samples by name.

Recommendation: Use a proprietary MIDI protocol rather than SDS if 
your sampler supports it.

Proprietary SCSI only communication

Same as above but via SCSI.

Recommendation: Use a proprietary SCSI protocol rather than SMDI if 
your sampler supports it and you have the necessary equipment.

Proprietary MIDI + SCSI communication

A common means of communication is to combine MIDI and SCSI. Nor-
mally “administration”, such as providing lists of sample names, etc., hap-
pens via MIDI and the actual audio transfer is done via SCSI. This type of 
communication normally provides very high functionality and reliability.

Recommendation: Use this type of communication if your sampler sup-
ports it and you have the necessary equipment.
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Which communication methods does my sampler support?

• To find out whether a sampler supports generic SDS or SMDI, check its docu-
mentation or contact the manufacturer.

• To find out whether it has a specific communication protocol that is also imple-
mented in WaveLab, select “Sampler configurations…” from the Sampling menu, 
click on the Settings tab, pull down the top pop-up and check whether your par-
ticular model is on the list.

• For further details about some supported samplers, check the Sampler Details 
chapter in the online documentation.

About sample rates and bit resolutions

WaveLab doesn’t put any restrictions on the sample format:

• Samples can always be received, regardless of format.
• When you transmit, samples with sample rates not directly supported by the sam-

pler may be accepted or rejected. Exactly how a sample with an unusual sample 
rate is handled depends on the sampler.

• Transmitted samples are always converted to 16 bit during the transfer.

About loops

WaveLab supports transmission of up to two loops in a sample. The fol-
lowing rules apply:

• If you transmit a sample with more than two loop points defined, only the first two 
will be transferred.

• Your sampler, or the transmission protocol you use, may not support more than 
one loop. For example, SDS and SMDI only support one loop point. In this case, 
only the first loop will be used. 
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Setting up your sampler(s)
The following text assumes you have made all connections as described 
in the installation chapter. Proceed as follows:

Making the basic settings

1. Make sure the sampler is turned on.
If you use SCSI it must have been turned on when you booted the computer.

2. Select “Sampler configurations…” from the Sampling menu.

The “Sampler configurations” dialog

3. Click on the Settings tab.

4. Select the desired communications protocol from the menu.
If possible, select your sampler protocol by sampler model name, this will provide the high-
est level of functionality. If your sampler can’t be found on this menu, you will have to select 
SDS or SMDI, depending on the type of connection and the instrument’s capabilities.

Only select an item that corresponds to the type of connection you actually 
have. For example, selecting anything that involves SCSI is pointless unless 
you actually have connected the sampler via SCSI, as described in the sec-
tion “Connecting the sampler” on page 31.
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5. If the sampler is connected via SCSI, pull down the SCSI Unit pop-up 
and select the instrument you want to communicate with.
If the instrument can’t be found on this menu, there is something wrong with your SCSI con-
nection. Go back and check the instructions in the section “SCSI connections” on page 31.

The SCSI Unit pop-up

If you ever change the SCSI ID for the sampler, you need to update the pre-
set. Otherwise, sampler communication won’t work.

6. If the sampler is connected via MIDI, use the MIDI input and output that 
the instrument is connected to from the MIDI pop-ups and set the SysEx 
ID (System Exclusive ID number) to the same number as that of the instru-
ment.
This setting is very important. If the two numbers don’t correspond, transfers won’t work. To 
find out how to check what SysEx ID your sampler is set to, consult its operation manual.

A few samplers that communicate via SCSI will use the SysEx ID for SCSI 
purposes as well. See your sampler documentation for details.

Creating a preset

Once all settings are done, you must convert them to a preset before you 
can continue:

1. Click on the Presets tab.

2. Type in a name in the field to the right.
Use a name that can be used to identify this particular sampler (if you have several).

3. Click the Add button to add the preset to the list.

If you have more samplers, you can now go back to the Settings tab, 
make settings for the next instrument, and create a preset for that.
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Transmitting samples
1. If needed, open the sample in a Wave window and trim it to the desired 

length.
Since samplers are RAM based, this may limit the amount of data you can transmit.

2. Add one or two loops as desired (see “Basic looping” on page 669).

3. Pull down the Sampling menu and select “Transmit…”.

4. Select the target sampler from the Target menu.
This menu lists all samplers for which you have created presets. The sampler will be on the 
list regardless of whether it is turned on or connected properly or not, so this list is not a 
verification that things have been set up properly.

5. If the protocol used for this sampler identifies samples by number, use the 
“Sample number” setting to specify a “memory location” in the sampler 
where you want to store the sample.
If another sample is already stored at that location, it will most likely be overwritten when 
you transmit, so it might be a good idea to use the sampler's front panel controls to make 
sure you have specified the number of an empty location.

6. If the sampler uses names and/or banks, click the Refresh button instead 
to get a list of the current memory contents in the sampler. Then select a 
bank and a sample location from the pop-up and list.
This is not always required. In many instruments, if nothing is specified, the sample will be 
stored in a new memory location and no existing samples will be overwritten.

7. Click Transmit.
The sample is transmitted to the sampler. You can monitor the progress of the transmission 
on the status bar at the bottom of the screen.
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Receiving samples
1. Pull down the Sampling menu and select “Receive…”.

2. Select the desired sampler from the Target menu.
As with Transmit, this menu lists the samplers for which you have created presets.

3. If the protocol used for this sampler identifies samples by number, use the 
“Sample number” setting to specify which sample to retrieve.

4. If the sampler uses names and/or banks, click the Refresh button to get a 
list of the current memory contents in the sampler. Then select a bank and 
a sample location from the pop-up and list.

5. Click Receive.
The sample is received and opened in a new window. You can monitor the progress of the 
reception on the status bar at the bottom of the screen. 

About loops

If the sample contains loops they will be converted to loop markers in 
WaveLab. However, see “About loops” on page 660.

Deleting and getting information about samples
In the Transmit and Receive dialogs, you will find Info and Delete buttons. 
These buttons will only be available for samplers where a specific proto-
col that supports this functionality is implemented. They are not available 
with the generic protocols SDS and SMDI (see “Generic SDS (Sample 
Dump Standard)” on page 658).

1. If required, click Refresh to update the list of samples in the sampler.

2. Select a bank and sample in the list.

3. Click Delete to remove the sample from memory, or click Info to get infor-
mation about the properties of a sample.
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The Transmit Back feature
A common working procedure would be to receive a sample from the 
sampler, process it in WaveLab and then transmit it back to the sampler. 
The “Transmit Back” feature facilitates this. It is a variation on the Transmit 
function. The difference is that it automatically sends the sample to the 
same memory location from which it originally came, without presenting 
any dialog.

Proceed as follows:

1. Receive a sample from the sampler (see “Receiving samples” on page 
664).

2. Work on it in WaveLab as desired.

3. Select “Transmit back” from the Sampling menu.
The sample is transmitted back to the same memory location in the sampler from which it 
originally came.

In case of problems
If you run into problems during transmission, check the Troubleshooting 
chapter in the online documentation.
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Using WaveLab with Steinberg HALion
If you are the lucky owner of Steinberg’s HALion software sampler, you 
can use WaveLab as your sample editor. You can add samples by drag-
ging audio file selections from WaveLab onto the HALion Key Zone Editor 
or by using copy and paste. It is also possible to transfer multiple samples 
from WaveLab to HALion in one go, using the following procedure:

1. Open and set up the audio files in WaveLab.
You may for example need to adjust the root key settings in the “Sample attributes” dialog 
(see “Editing sample attributes” on page 667), so that they correspond to the proper 
pitches of the files.

2. If you have edited the files in any way, make sure they are saved.
This is very important, since HALion will load the actual file from disk.

• If you haven’t edited the actual audio, but only the loop markers or sample 
attributes (e.g. root key settings), you should save the file(s) with the “Save 
as” command. 
This is because those settings are stored in the file headers, which are only rebuilt when the 
audio is re-saved. If the audio portion of a file hasn’t been changed, WaveLab will not re-
save the audio on a regular “Save” – hence you should use “Save as”.

3. Make a selection range in one of the files, covering the section you want 
to use as a sample.

4. Press [Ctrl]-[Shift]-[C].
With this function, no audio is copied, only the audio file reference and the position of the 
selected region.

5. Make a new selection in another file and press [Ctrl]-[Shift]-[C] again.
The file and region information for the new selection is added to the clipboard, without re-
moving any previous information there.

6. Copy the regions of as many audio files as you like in the same way.

7. When you have copied the desired regions, go to the Keyzone Page view 
in HALion and press [Ctrl]-[V].
The copied regions appear as separate samples in HALion, assigned to keys correspond-
ing to their original root key settings.

• If you are using HALion with Cubase SX/SL, and have selected WaveLab as 
your external Wave Editor, you can open HALion samples for editing in 
WaveLab directly from the sampler, by selecting “Edit in Cubase SX/SL”.
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Editing sample attributes

The “Sample attributes” dialog.

This menu item on the Sampling menu allows you to make settings for a 
sample. They do not process the sample in any way, they just give it prop-
erties that the receiving sampler may or may not take advantage of. 

See “About the various communication methods” on page 658.

Setting Description

Name The name the sample will have in the sampler. If the sample is an already 
named file, the name is displayed here, but you can change it if you wish. 
Note that not all samplers support all characters. Furthermore, if the 
name is too long, it will be truncated.

Parse name into 
key

If a sample is named so as to denote its root key (e.g. “Bass C0” – a 
sample of a bass in the key C0), clicking this button will automatically fill 
in the key field (see below) with the root key information taken from the 
file name. Note that you can also use this method for samples that are 
named so as to denote their MIDI note numbers (see below).

Parse last 
group of digits

This is available when you select MIDI note number notation (see below), 
and can be useful when you want to use the Parse name into key option 
(described above). In cases where samples are named with multiple 
groups of numbers – e.g. “Piano_01_112” – you need to activate this 
option to let WaveLab know that the last group of digits is the one de-
noting the MIDI note number.

Key This specifies which key will play back the sound at its original pitch.

Detune This specifies whether the sample should be played back at a slightly dif-
ferent pitch. The range is ±50% of a semitone, which translates into a 
quarter tone in each direction.
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Depending on your sampler and the protocol you use for communicating, 
the above features may or may not be supported. For example, SDS and 
SMDI do not support names. SMDI supports Key and Detune whereas 
SDS does not.

Detect from 
audio selection

If you click this button, WaveLab will analyse the sample and determine 
its pitch and amount of detune. For this to work properly, the sample 
must be of such a nature that it is possible to clearly detect a pitch (it 
won’t work properly with chords and drum loops for example). 

Musical notation/
MIDI note number

These radio buttons let you choose whether to display the different key 
values in the dialog with the key’s pitch or the key’s MIDI note number. In 
musical notation, keys are denoted according to their pitch (e.g. C3 – 
meaning the note C in the third octave). Each key corresponds to a MIDI 
note number, from 0 – 127. The key C3 for example, corresponds to the 
MIDI note number 48. MIDI note numbers make it possible for samplers 
to automatically map samples to the correct keys.

Key range If a sample is part of a multi-sample key map, you can specify the key 
range for the sample, i.e. which keys should be able to play it.

Velocity range If a sample is part of a multi-sample key map with velocity switchable 
samples, you can here specify the velocity range for the sample – the 
minimum and maximum velocity values that should trigger the sample.

Setting Description
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Basic looping
Instrumental sounds in samplers rely heavily on looping. Looping a sound 
allows you to repeat a section of the sample indefinitely, to create a sus-
tain of unlimited length. An example of this would be an organ sound. 
Without looping you will only be able to play notes as long as the original 
recording. With looping, notes can be of any length.

Finding a good loop point takes a bit of practice. Here is some advice:

• There are only two types of loops: very long and very short. Loops of intermediate 
lengths usually don’t work very well.

• A long loop will sound the most natural, and should be used whenever possible. 
However, if the sound does not have a stable section in the middle (an even sus-
tain part), it might be hard to find a good long loop. For example, a piano note – 
which decays continuously – will be hard to loop since the start point of the loop 
will be louder than the end. A flute will be much simpler, because the sound in the 
sustain section is very stable.

• Very short loops (covering only a few cycles or periods) can almost always be 
found, but may sound “static” and unnatural.

• A loop should normally start a short time after the “attack” portion, that is, when 
the sound has “stabilized” to a sustaining note.

• If you try to set up a long loop, it should end as late as possible, but before the 
sound starts decaying to silence (if it does).

• If you go for a short loop, it is harder to say exactly where in the sound to put it, 
but it should definitely be towards the end.

More information about looping in general, and the exact capabilities of 
your sampler in particular, can be found in the sampler’s manual. Below 
follows a description of WaveLab’s set of tools for setting up loops.

Adding, moving and playing loop markers

Loop markers are added, moved and otherwise edited just as any other 
type of marker. This is described in the section “Introduction” on page 328 
and onwards.

Please note the points about marker pairs (see “About marker pairs” on 
page 329).
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Here is a brief description on how to create a basic loop:

1. Make a selection that corresponds to the area you want looped.
If you like, you can play back with “Loop selection” activated on the Transport bar and ad-
just the selection during playback.

2. Bring up the Marker toolbar.

3. Click on the loop marker icons (the green ones).
The selection is now enclosed by loop markers.

4. Make sure that “Loop as marked” is activated on the Transport bar.
Click the Playback end position/Loop mode button to open the corresponding pop-up.

5. Play back and adjust the position of the markers to change the loop.

A basic loop setup using markers.

Note that it takes a while for changes in the loop to take effect on playback. 
Exactly how long depends on your buffer settings, see “About loop updating 
and short loops” on page 137.

Getting a good loop by just dragging the markers around might be hard. 
Most often you will hear a click or an abrupt change in timbre at the turn-
ing point, which is hard to get rid of by dragging the markers.

We suggest you only use this method for setting up the basic length of 
the loop (leaving clicks, etc. as they are) and then use the Crossfade 
Looper and Loop Tone Equalizer (described below) to perfect it.



WAVELAB
Using samplers and creating loops 28 – 671

Using the Crossfade Looper

What is the Crossfade Looper?

The Crossfade Looper is a special tool for creating “seamless” loops. It 
allows you to “nudge” the loop points while at the same time providing vi-
sual feedback of the “join” between the start and end point.

The Crossfade Looper can also automatically find loop points for you, by 
scanning the area of the waveform that is in the current loop points’ vicin-
ity. You can specify parameters for how “finicky” the program should be 
when suggesting loop points.

Finally, if you can’t find a good enough loop point using the methods de-
scribed above, the Crossfade Looper allows you to process the waveform 
to allow for smoother loops. It does this by crossfading areas of the wave-
form close to the loop start and end points.

Opening the Crossfade Looper

Before you open the Crossfade Looper we suggest you set up a basic 
loop as described on the previous pages. Then proceed as follows:

1. If you have several loops, place the wave cursor somewhere inside the 
one you want to work on.
This can be done by clicking somewhere between the loop markers.

2. Select Crossfade Looper… from the Sampling menu.

3. Click on the “Loop points” tab.
This tab should be your starting point, since this is where you adjust the loop points.

• The following sections describe the common procedures for using the 
Crossfade Looper – for details about the dialog itself, click the question 
mark icon in the dialog.

About the Crossfade Looper dialogs

The Crossfade Looper dialogs are non-modal. While they are open, you 
can still access other windows (e.g. the Transport bar). However, all edit-
ing of the Wave window on which you are working is blocked out (except 
moving the current pair of loop markers, of course).

Furthermore, each time you click Apply, the process starts out from the 
wave data as it was when you opened the Crossfade Looper (since you 
want to be able to try out various types of crossfading without re-process-
ing the wave each time). This affects the undo function: there is only one 
step of undo and no redo in the Crossfade Looper.
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Moving the loop points “manually”

Let’s assume you have set up a basic loop that you are happy with, except 
for glitches or “bumps” at the turning point. You can then use the Cross-
fade Looper to move the points manually, in small steps, to eliminate the 
glitch.

This is actually technically no different from moving the loop points in the 
wave display, but the features of this dialog makes it much easier to find 
good loop points, since the display gives you visual feedback as you go 
along. We also recommend that you have playback going on in “Loop as 
marked” mode since you will then also hear what you are doing!

The two ways of moving loop points

There are two ways of moving the loop points: dragging in the actual 
waveform (position the mouse pointer in the display and drag sideways) 
and using the “nudge” buttons.

• Dragging in the waveform allows you to perform larger moves more quickly.
• The nudge buttons are more useful for fine-tuning since they move the points by 

one screen pixel. This means that in 1:1 zoom mode, each press on a nudge but-
ton moves the loop point a single sample.

The various moving options

• By moving the left part of the display, you are moving the end point to a later (left) 
or earlier (right) position.

• By moving the right part of the display, you are moving the start point to a later 
(left) or earlier (right) position.

• If you activate Linking, both the start and end points will move simultaneously. 
That is, the loop length will be exactly the same, but the entire loop will move.

• You can switch to the Wave window and adjust the markers there, if needed.

You can drag either side of the waveform directly…

…or use the nudge buttons.
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Using the auto-find feature

If desired, you can have the program search for good loop points auto-
matically. This is technically no different from adjusting the loop points 
yourself, only that the program uses pattern matching algorithms to sug-
gest loop points for you.

Let’s say that you want to let the program find a better start point for the 
loop. You first set up a start and end loop marker, to get a basic loop, as 
described above. You then invoke the automatic searching, and the pro-
gram searches the waveform from the current start point, trying to find a 
section that is as similar as possible to the area just after the current end 
point. When it finds a match it stops.

You decide how similar the section must be to be considered a match.

Setting up the parameters

The auto-find parameters.

There are two parameters for the auto-find feature, desired correspon-
dence and search accuracy.

• Search accuracy is a parameter for determining how many samples should be in-
cluded in the analysis. Higher values result in greater accuracy, but also longer 
processing times.

• Desired correspondence is a value for how well the found section must resemble 
the section to which it is compared, to be considered a match. WaveLab uses 
two methods for comparison, “phase match” and “join match” (which provide 
much better matching than the simple zero crossing detection used by most other 
programs. Phase matching also ensures that no harmonic cancellation will occur 
when you crossfade, see later in this chapter). First phase matching is performed 
and then, to “fine tune”, a join match is employed. A value of 1000 will most likely 
fail completely, since it requires a 100% perfect match.
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Searching

1. Set up the search parameters.

2. Click on one of the buttons in between the “nudge” buttons.
Each time you click, the program scans from the current point (forwards or backwards, de-
pending on which button you clicked) until it finds a point that matches. It then stops. If you 
wish you can stop at any time by clicking the right mouse button, by using the Stop button 
on the status bar or by hitting [Esc]. The program will then jump back to the best match 
found so far.

3. Check the loop by playing back.

4. If you think there might be a better point, at some later or earlier position, 
just click the button again, and scanning continues from this point on-
wards.

Remember that you can always go back to the main Wave window and 
adjust the markers manually.

Working with candidates

Often you will want to try various alternatives before committing to a loop. 
To be able to compare several alternatives, WaveLab offers looping can-
didates. These allow you to store sets of loop points in memory locations 
for later recall.

When you have set up the loop points as desired, you store them by se-
lecting “Save candidate” from the options pop-up menu in the dialog, and 
then selecting one of the five memory locations.
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To recall a stored candidate, select “Restore candidate” from the pop-up 
menu, and then select the desired memory location from the submenu. 
The points are now recalled and the loop points in the wave are moved to 
the positions stored in the memory location.

• To compare several candidates, you can for example have playback going, 
select them one after the other, and listen to the difference.
Once you have found your candidate, you can select OK to exit this window or proceed to 
crossfading.

Things to note about candidates

• There is only one set of candidates per Wave window, not one per set of loop 
points. This means that if you have several sets of loops in your file, you must be 
careful so that you don’t recall the wrong set.

• Crossfading is not part of the candidate, only loop positions are. You should de-
cide on a candidate to use before you apply crossfading.

Creating a crossfade

What is a crossfade and when do I need it?

Sometimes it is impossible to find a loop that doesn’t cause any glitches. 
This is especially true for stereo material, where you might be able to find 
a perfect candidate for either channel, but not for both at the same time.

One solution to this problem is to use crossfading. This technique 
“smears” the material around the end loop point so that it loops perfectly. 
It does this by mixing material before the loop start with material just be-
fore the loop end.

The only problem with this technique is that it alters the waveform and 
hence changes the sound. However, normally you can find settings that 
minimize this problem.
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Setting up

1. While still at the “Loop points” tab (in the Crossfade Looper dialog), try to 
create as good a loop as you can.

2. Click on the Crossfade tab.

3. Make sure the Crossfade check box is activated.
There is a corresponding check box on the Post-Crossfade tab. This lets you choose if reg-
ular crossfading and/or post-crossfading will be performed when you click Apply later.

The Crossfade tab with crossfading activated.

4. Decide on a length for the crossfade either by dragging the length handle 
or by adjusting the Length value below the graph.
The length is used to adjust the amount of the audio file that will be processed. This area is 
always located just before the end of the loop, but the Length value adjusts how far towards 
the start of the loop it stretches. As you can see, an equally large area before the loop start 
is used as basis for the processing. However, this area is not processed, just analysed.

Generally you will want the crossfade to be as short as it can be, with an 
acceptable result:

• Using a long crossfade will be a better guarantee that the loop will be smooth. How-
ever, more of the waveform will be processed and hence changed in character.

• Using a short crossfade will ensure the sound is affected as little as possible. 
However, the loop might then not be as smooth as otherwise.

5. Decide on a crossfade shape, by dragging the shape handle or by adjust-
ing the shape value.
The considerations for this are the same as when creating other crossfades, see “Cross-
fade” on page 192. 0% means that the sound level will be equal in the middle of the cross-
fade, whereas 100% means that the energy will be equal in the middle of the crossfade. 
Use low values for “simple” sounds and high values for “complex” sounds.
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Applying and checking the crossfade

When you click Apply, the sound is processed. If you have playback go-
ing, repeating the loop you will hear the change take effect after a short 
while.

• You can check the crossfade visually by opening the “Loop points” tab and 
activating “Display processed signal” on the options pop-up menu.
When this is activated, the display will show the waveform as it looks when crossfaded. 
When the option is deactivated, the display will show the waveform as it originally was. 
Switching back and forth allows you to compare the two.

• You can undo the crossfade by selecting Undo from the Edit menu.

• If you click OK, the dialog closes and crossfading is made permanent.
If you click Cancel instead, the dialog closes and the waveform is reverted back to the way 
it was before crossfading.

Do not move the loop points after performing a crossfade! The waveform 
has been processed specifically for the current loop settings!

Creating a post-crossfade

The post-crossfade is accessed from its own tab.

This is identical to the regular crossfade, but it is applied to the area after 
the loop. This means that it is used to fade the material so that there will 
be no glitch when playback continues out of the loop.
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If you intend to use the sound in your sampler in such a way that the area 
after the loop is never played, you don’t need to worry about this feature at 
all! Some samplers don’t even allow you to play the area after the loop. 
However, if you do intend to use the area after the loop it is very important 
to have post-crossfade activated!

The post-crossfade looks at the part of the waveform that occurs just af-
ter the loop start and processes a certain area beginning at the end of the 
loop. The Length parameter adjusts the size of this area.

Everything else is identical to regular crossfading, see above.

Working with presets

As with effect processors, you can create presets for settings in the dia-
log for quick recall. See “Presets” on page 65 for details. This comes in 
extremely handy for example when processing a number of similar files, 
for example for creating a multisample (several instrumental samples 
mapped across the keyboard).
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Using the Loop Tone Equalizer

The Loop Tone Equalizer is a function for looping those un-loopable 
sounds, for example sounds that constantly decay in level or continuously 
change in timbre. The Loop Tone Equalizer applies drastic processing to 
the sound that evens out changes in level and timbral characteristics, be-
fore and during the loop.

It does this by using one of the following two methods:

• Slice mixing
A number of slices is specified for the looped section. If for example you specify eight slices, 
the loop is cut up into eight sections of equal length. These sections are then mixed together 
as one sound which is repeated eight times. This new piece of audio replaces all audio in-
side the loop in a smart way so that no harmonic cancellation (due to phase offsets) occurs.

• Chorus smoothing
This has nothing to do with a conventional chorus effect, but uses a method known as 
“Phase Vocoding” to filter the harmonics. This method is recommended for looping ensem-
ble and choir sounds.

You can use both slice mixing and chorus smoothing in conjunction, but it 
is highly unlikely that you will ever need to. Note also that the original 
length of the loop will not be changed by the processing.

In addition to the above, the Loop Tone Equalizer includes a crossfade fa-
cility so that the original sound fades into the processed sections as play-
back approaches the loop start.
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To use the Loop Tone Equalizer, proceed as follows:

1. Set up a basic loop of the length you desire.
This will probably not be a very good loop. If it was you wouldn’t need to use the Loop Tone 
Equalizer.

2. Select Loop Tone Equalizer from the Sampling menu and click on the 
Loop Tone Equalizer tab.

3. Make sure that either slice mixing or chorus smoothing is activated and 
make the desired settings.
For slice mixing, you need to determine the number of slices. Only experimentation can tell 
how many slices are needed, but generally, the more slices, the more natural the sound (to 
a certain extent). However, the program puts a restriction on the number of slices, so that 
each one is never shorter than 20 milliseconds.

For chorus smoothing, you can make the following settings:

4. Switch to the Pre-Crossfade tab and set up a crossfade.
You will need to use this feature since the Loop Tone Equalizer itself changes the timbre in-
side the loop and only there. This will mean that the transition into the loop will not be as 
smooth as expected, unless you apply crossfading. Generally, this is the same as the cross-
fade in the Crossfade Looper window. However, the difference is that this crossfade is 
made before and up to the loop start. The processed material created by the Loop Tone 
Equalizer is added to the original material before the loop.

5. Click Apply, and the sound gets processed.
If you have playback going, repeating the loop, you will hear the change take effect after a 
short while.

• You can undo the crossfade by selecting Undo from the Edit menu.

• If you click OK, the dialog closes and processing is made permanent.
If you click Cancel instead, the dialog closes and the waveform is reverted back to the way 
it was before processing.

Option Description

Timbre This governs the amount by which the timbral characteristics of the sample 
should be evened out. The higher the value, the more pronounced the ef-
fect.

Chorusing The delay time of the chorus effect varies with the modulation, which 
causes a sweeping effect. What this parameter does is determine the 
width and speed of the chorus sweep.

Enhance Warmth Creates a smoother, warmer sounding effect.

Stereo Expansion This increases the width of the sample in the stereo sound image.
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Do not move the loop points after performing the processing! The wave-
form has been processed specifically for the current loop settings!

About the end of the loop – Post-crossfading

After using the Loop Tone Equalizer, the transition from the end of the 
loop to the end of the file in many cases won’t be very natural. This can be 
fixed as follows:

1. Close the Loop Tone Equalizer and open the Crossfade Looper.

2. Click on the Crossfade tab and deactivate the Crossfade option (the 
check box).

3. Click on the Post-Crossfade tab and make sure Crossfade is activated.

4. Set up the post-crossfade parameters and click Apply.

Working with presets

As with the Crossfade Looper, you can create presets for settings in the 
dialog for quick recall. See “Presets” on page 65 for details.
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What is an Audio Database and why do I need it?
Audio Databases are collections of audio files. However, an Audio 
Database doesn’t really contain the actual files, rather it contains instruc-
tions on where the files are, what they are called, etc.

The files in an Audio Database can be located on any of the media con-
nected to your computer, e.g. hard disks, removable disks, CD-ROM disks 
and even floppies. For example, if you use an Audio Database to call up a 
wave file that is on a CD-ROM disk not currently in the CD-ROM drive, the 
program will inform you as to which CD-ROM you need to be able to load 
the wave.

Furthermore, the Audio Database allows you to organize your audio file 
library into categories (sound fx, instrumental sounds, etc.) and you can 
specify categories yourself, if you like. This allows you for example to dis-
play all your bass drums on all your disks and CD-ROMs with a single 
mouse click!

Finally, an Audio Database can search your media for files, based on cer-
tain criteria, for example allowing you to find all files with the word “train” 
as part of the name.
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Creating and opening Audio Databases

Creating an empty Audio Database

There are two ways to create a new empty Audio Database:

• Pull down the File menu, select New, and from the menu that appears, se-
lect Audio Database, or…

• Click on the New icon on the control bar, and select Audio Database from 
the menu that appears.
Either way, a dialog appears, allowing you to specify a name and location for the new Audio 
Database.

Opening an existing Audio Database

Audio Database files are opened like any other file in Windows (see 
“Opening Waves” on page 71 for information on opening Wave files. 
Many of the same methods apply). There is one shortcut, though:

• Click on the Open icon on the control bar, and select Audio Database 
from the menu that appears.

Audio Database files have the extension “dba”.

You can have many Audio Databases open at the same time. This does 
not consume a lot of your system resources.

How Audio Databases are saved
There is no special save command for Audio Databases. Instead, any 
changes you make are automatically saved to disk as you go along. If you 
close an Audio Database and then open it you will find it exactly as you 
left it (to open an Audio Database with a standard layout instead, hold 
down [Ctrl] when opening).

You might work a lot on your Audio Databases, organizing files into catego-
ries, etc. Please back the Audio Database files up, in case you experience 
data loss. Audio Database files are small compared to audio files.
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Window overview and adjustments

About the panes

The Audio Database window is divided into the Location Pane, the Cate-
gory Pane and the File List. Their sizes can be adjusted, see “Panes” on 
page 51.

• The Location pane shows volumes, folders and subfolders as on your hard disks. 
To be precise, it shows all folders containing files that are in the Audio Database.

• The Category pane lists all the categories which are used to “classify” and orga-
nize the sounds in the Audio Database. There are categories and subcategories, 
displayed just like folders on a hard disk. For example, there is an “Instruments” 
category and this contains the categories “Keyboards”, “String” and “Wind”, 
which in turn contain other categories.

• The File list shows a selection of all the files in the Audio Database. Various oper-
ations allow you to display all files in a certain category, all files in a certain folder 
or a combination of both these criteria. You can also perform more advanced find 
operations to display only files that meet certain criteria.

• From the File list you can play, open and perform other operations on files .

Location Pane

Folders that contain 
audio files

Category Pane Categories

File List

File attribute columns

Volumes (drives) that 
contain audio files
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Adding files to the Audio Database
There are several ways to add files to a Database:

Using Add

1. Select Add from the Audio Database menu.
You can also press the right mouse button in the Location pane and select Add from the 
menu that appears.

2. Select all files you want to open (for example using [Shift] and [Ctrl]) and 
click Open.
The files appear in the List. Also, folders are added to the Location pane. These correspond 
to the real folders that the files are in, on the disk.

By dragging a document

You can drag an entire Wave document into the Audio Database by using 
the drag icon on the title bar of the Wave window.

Using Scan folder

This feature allows you to automatically search for and add files matching 
certain criteria.

1. Select “Scan folder” from the Audio Database menu.
You can also press the right mouse button in the Location pane and select “Scan folder” 
from the menu that appears.

2. Select a drive and a folder from which to start searching, and click OK.
This folder and all its subfolders will be searched.

3. In the dialog that appears, set up the desired criteria (see the following 
pages for details).

Note that the search criteria dialog has three tabs for deciding which files to 
add to the Audio Database – one for text criteria, one for file format criteria 
and one for date and size criteria. For a file to be added, it must fulfill the 
criteria set up in all three tabs. 

The drag icon



WAVELAB
29 – 688 Audio Databases

For example it might have to…

• have a name containing the text “piano”
• be in stereo
• be smaller than one megabyte.

You can of course set up any of the tabs so that all files meet the criteria 
in this particular tab. For example you can add files based only on their 
naming or only on their format.

4. If at some point you need to reset the settings in all three tabs to default 
values, click Reset.

5. Once all the criteria are set up, click Scan to actually search the disk for 
files.
The files that meet all the criteria appear in the list. Also, folders are added to the Loca-
tion Pane as needed, corresponding to the files’ real folders on disk.

The Text tab

This is used to specify which files to add to the Audio Database, based on 
text criteria:

• WaveLab will search in file names, keywords or comments (depending on 
the “Topic to Search” setting) for the text specified on the Query line.
It doesn’t matter whether you use upper case or lower case letters. When searching among 
keywords, you can use the menu button to the right to automatically add keywords to the 
query text. Keywords and comments are described in the section “Keywords” on page 696.
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• To search for multiple text strings, separate words with spaces on the 
Query line.
The result depends on the “Search mode” options:

For example, if you type “piano grand” and specify an “OR” search in file 
names, the following files will be “found”:

• piano
• PIANO
• pianola
• The best piano you have ever heard
• grand funk
• grand piano
• GRANDMA

But you will not “find” the files:

• pianissimo
• pia no way!

If instead you performed an AND search with the same words you would 
for example find:

• Grand Piano
• Piano Grandissimo

but not:

• Piano
• Grand

Option Description

Normal The entire text on the line is used as one “string”. Files that contain this text will 
be “found”.

AND If there are several words, separated by spaces, only files that contain all the 
words will be “found”.

OR If there are several words separated by spaces, files that contain any of these 
words will be “found”.
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The Format tab

This allows you to add files based on the file format. You may activate 
multiple options in each section in order to add files of different catego-
ries (e.g. both mono and stereo files). Background information on the dif-
ferent attributes in this dialog can be found in the section “Editing 
attributes and getting information” on page 127.

The Date & Size tab
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This tab allows you to specify two things:

• Whether the “Modified” date of the file should be included in the search criteria. 
• Whether the size of the file should be included in the search criteria .

Using presets

You can create presets for this dialog, just as with processing. See “Pre-
sets” on page 65.

Adding more files

You can keep on using the Add and Scan folder options as many times as 
you wish. The new files will be added to the existing ones in the list, and 
WaveLab makes sure that no file is added twice.

Adding a “Dual Mono” file

To add two files as one stereo pair (see “Opening dual mono files” on 
page 72), proceed as follows:

1. Add one of the files.

2. Right-click on the file name and select Properties from the pop-up menu 
that appears.

3. Activate the “Other channel file name” option and type in the name of the 
other file in the field below.
The two files will now be treated as a stereo pair when editing, playing, etc.
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Limitations

• Windows puts a limitation on how many files can actually be shown in the File List 
at one time (roughly 1500).

• Normally you don’t want too many files in the list anyway, since it only makes it 
harder to organize them and some Audio Database operations will take longer to 
finish. Use the “Maximum size of result list” setting in the Preferences–Audio Da-
tabase tab to set a limit on how many files will be added in one go.

• If you have specified a limit, as described above, it might happen that the list can’t 
show all the files you expect. If this is the case, the status bar will indicate this by 
displaying the number of files in red.

• If too many files are added at the same time, this is probably an indication that you 
should narrow your search criteria.

Using a temporary Database

If you are worried that your “Scan folder” operation will add more files to 
the Audio Database than you actually desire (which means you will have 
to spend time removing them), you can use a temporary Audio Database 
instead.

1. Create an empty Audio Database.

2. Use Scan folder to add files to this Database.

3. Drag files from this temporary Database to the other.
See “Drag & Drop between Audio Databases and Workspaces” on page 697 for details 
about dragging.

Volume name

If you try to add files from a volume (hard disk or similar) that hasn’t been 
given any name, the program will prompt you for such a name. This is re-
quired for WaveLab so that it can keep track of which files are on which 
disk (for example with removable hard disks).

The volume name you specify will appear in all programs that display de-
tailed disk information (like for example the Explorer).

When this is shown in red, 
not all files are displayed.
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Displaying all the files in the Audio Database

Later you will learn more about how to decide which files get displayed in 
the File List, but for now if you just want to display all files in the Audio Da-
tabase, proceed as follows:

1. Select Global Find from the Audio Database menu, and click the Preset 
tab.

2. Select the “All audio files” preset and click Load.

3. Click Search.

Customizing the File List
As with other similar lists in the program, you can customize the File List 
display in the following ways:

• Select a list format (details, icons, etc.) from the Audio Database menu (or 
right-click in the File List and select from the pop-up menu).

• If you have selected Show Details, you can click on the column headings 
to sort the list according to that column’s criteria.

• If you have selected Show Details, you can click between two column 
headings and drag to adjust the width of the columns.
This setting is saved with the Audio Database.

Selecting in the File List
You select files in the list by clicking on their names or by using the arrow 
keys. Use [Shift] or [Ctrl] to select several files, just as in other Windows 
programs.

• You can also select a range of files by clicking and dragging a selection 
rectangle (provided that you start to the right of the file names).

• To select all files, right-click in the File List and select “Select All” from the 
pop-up menu.
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Finding out where files are located
If you want to find out in which folder a certain file is located, right-click it 
in the list and select “Show folders” from the menu that appears (or press 
[Alt] and click on the file name or wave icon in the list). Either way, the 
folder is highlighted in the Location pane (as is the file’s category – see 
“Checking to which category a file belongs” on page 701).

Opening a file for editing
To open one or more files in a wave editing window, use one of the follow-
ing methods:

• Double click on one file.
• Select the file(s), right-click anywhere in the list except on a file name and select 

Open from the menu that appears.
• Drag the file(s) out of the Audio Database window into an “empty” area within the 

WaveLab application window.

If the file is not on any of the disks currently “in the computer”, you will be 
prompted for the required disk.

Playing a file
To play a file, select it and right-click on a file in the file list and select Play 
from the speed menu (or press [Enter] on the computer keyboard). If the 
file is not on any of the disks currently “in the computer”, the required disk 
will be requested.

• If the file is already open and has unsaved changes, the version in the win-
dow will be played rather than the one on disk.

The selected file is 
located in this folder
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Other file operations

Setting properties

To set the properties of one or more files, select the file(s), right-click any-
where in the list except on a file name, and select “Properties…” from the 
menu that appears.

The Properties dialog

• Please note that you can assign the same keyword(s) and comments to 
several files in one go, by selecting them and then selecting Properties.

Name

This is the file’s regular name including the file type extension. Changing 
this is the same as changing the file name in the Explorer or another file 
managing utility.

This cannot be edited if you have selected several files or if a file is on CD-
ROM.

Other channel file name

This is used for dual mono files as described in the section “Adding a 
“Dual Mono” file” on page 691.

This cannot be edited if you have selected several files.
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Keywords

This allows you to specify characteristics for the file that you can use later 
in a search operation. This feature works in addition to the category fea-
ture. It can be thought of as a more advanced extension to the category 
function. If you find that using categories serves all your needs for classi-
fication of the files, you do not need to use this feature.

To add keywords to the file(s), type in each keyword, separated by semi-
colons (“;”) or commas (“,”).

• You can also click the “<<” button and select from the pop-up menus.
You can enter as many keywords as you like this way. 

The Keyword pop-ups

• You can also add keywords of your own to the menus by typing the de-
sired name preceded by a backslash character (“\”). You can create hier-
archic items as on the standard menu. For example, if you type 
“\Quality\Texture\Chrystal”, Chrystal will appear on the Texture menu 
which in turn is on the Quality menu.
The new menus are automatically saved when you close the dialog. You can also modify 
which keywords are available on the menu in new Audio Databases, see “Changing the de-
fault categories and keywords” on page 705.

Comment

In this field you can type in any comment you like to add to the file. This in-
formation can also be used when you want to find files that meet certain 
criteria.

Update

If you have worked on the files since the Audio Database was last 
opened, the file attributes (size, date, etc.) might be “out of sync” with the 
real values. To update those settings, select the file(s) and use this menu 
command.
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Rename

If you want to rename the file, proceed as follows.

1. Right-click on the file and select “Rename…” from the pop-up menu.
If the file is not on any of the disks currently “in the computer”, you will be prompted for the 
required disk.

2. Type in the new name and press [Return]. Do not specify an extension, 
only the actual file name.
If you need to modify the extension, use the Properties dialog, see “Setting properties” on 
page 695.

This operation permanently changes the actual file name!

Remove

To remove one or more files from the Audio Database, without actually 
deleting it from disk, select the file(s), right-click anywhere in the list ex-
cept on a file name, and select “Remove…” from the pop-up menu.

Drag & Drop between Audio Databases and Workspaces

You can drag and drop files to the following locations:

• The File List in another Audio Database. This copies the file into that Audio Data-
base. If you hold down [Alt] or [Shift], the file is moved rather than copied.

• A category in another Audio Database. Categories are described in detail below. 
If you drag a file onto a category in another Audio Database, the file is copied to 
that Database and added to the category on which you dropped it. Use [Alt] or 
[Shift] to move the file rather than copy it.

• A Workspace window. This copies the file to the Workspace. You can 
aim at a certain group to add the files to it.

• Note that it is also possible to drag and drop files from a WaveLab Audio 
Database into a project in Steinberg’s Nuendo application!
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Import file attributes

This function, available on the Database main menu, allows you to import 
keywords and comments from a text file. 

Let’s say you have a CD full of audio files and a text file describing these 
files. You would first scan the CD to reference all the audio files. You can 
then use this function to import the related attributes. This function can 
also be used if you need to migrate a database with a different format to 
WaveLab.

When you first select this function the Find dialog appears. Set up the cri-
teria on all three tabs as desired, to select which files the operation 
should affect.

After selecting “Import”, a standard file dialog opens, where you can se-
lect a text file. Then the dialog displayed below appears.

The text file has to use a format where each item is separated by a tabula-
tion character. If a text file does not correspond to this format, you need to 
reformat the file.

Each line of the text file must contain the following:

• The File name: 
Specify at which tabulation position it can be found (first tabulation is #1). You should also 
specify the path to the volume or drive.

• The Keywords: 
All keywords must be at the same tabulation position, each preferably separated by one of 
these characters: “comma/colon/semicolon/straight slash/punctuation mark”. If you have 
no keyword to specify, enter “0” as tabulation.

• The Comments:
If you have none to specify, enter “0” as tabulation.
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Working with categories
Categories allow you to organize your files according to type or context 
rather than names or location on the hard disk.

For example, this allows you to display all bass drums on all your hard 
disks, removables and CD-ROMs with one simple click!

About the category folder list

The Category pane contains a number of folder symbols. These all repre-
sent categories and subcategories. For example, there is an “Instrument” 
category, which contains a “Strings” category, which in turn contains a 
“Bowed” category and so on.

• Folders are opened and closed as in the standard Windows Explorer, including 
using the [+] and [–] keys.

• You can create and remove category folders, as described in the section “Creat-
ing, renaming and removing categories” on page 701.

The “Instruments” category and its subcategories

Moving files into categories

1. Make sure the desired category is visible in the list.
If it isn’t, open the desired folders and scroll the list to make it visible.

2. Select the desired files and drag them to the desired category folder.
The files disappear from the list. Note:

• You can add a file to any level in the category “hierarchy”. For example, you 
can make a file part of the “Instrument” category, without having to put it 
into any of the subcategories (“Keyboards”, “String”, etc.).

• A file can only be in one category at a time.
Dragging a file to a category will remove it from any category it previously belonged to.
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Displaying all files that belong to a certain category

To display the files that belong to a certain category, click on the category 
name (note that you should click on the folder name, not on the folder 
symbol).

• To display all files not in any category, right-click in the Category pane and 
select “Find unregistered items” from the pop-up menu.

Displaying files regardless of category

If you want to display all files in the Audio Database, regardless of their 
category, proceed as follows:

1. In the Location pane, select the top folder (Folders).

2. Select “Global Find…” from the Audio Database menu.

3. Click on the Presets tab.

4. Select the preset “All audio files” in the list, click Load and then click the 
Search button.

Click on a category name to have the File 
List show the files in that category.



WAVELAB
Audio Databases 29 – 701

Checking to which category a file belongs

If you want to find out to which category a certain file belongs, right-click 
it in the list and select “Show folders” from the menu that appears (or 
press [Alt] and click on the file name or wave icon in the list). Either way, 
the category is highlighted in the Category pane (if no category folder is 
highlighted, the file doesn’t belong to any category).

• This operation also tells you in which folder the file is (check the Location 
pane).

Creating, renaming and removing categories

• To create a new category, select the folder in which you want this new cate-
gory to be. Then press the right mouse button and select “New category…”. 
Type in the name and click OK.

• To rename a category, select “Rename…” from the menu described above. 
Type in the new name and click OK.

• To delete a category folder, select it and select Remove from the same 
menu as above.
This deletes the selected category and all its subcategories.

The files that belonged to these categories are not deleted. Rather they be-
come “unregistered items”, see “Displaying all files that belong to a certain 
category” on page 700.

The default categories

As described in the section “Changing the default categories and key-
words” on page 705 you can modify the default list of categories that ap-
pears in new Audio Databases.

The selected file 
belongs to this 
category.
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Location operations
The folders in the Location Pane mirror the way the files are organized on 
your disk(s). However, what you see is not really the folders on your disks. 
For one thing, only the folders that actually contain files that are in this Au-
dio Database are displayed. Furthermore you can rename the folders in 
this list without actually renaming the folders on your disk(s).

Displaying all files in a certain folder

To display all the files that reside in a certain folder (regardless of their 
categories), click on the folder.

Renaming

You can rename a folder in the Database (not the real folder on disk) by 
right-clicking it and selecting “Rename…” from the pop-up menu. This 
opens the folder name for editing – change the name and press [Return].

Note that if the folder names in the Audio Database and on the disk do not 
match, you cannot open the files in that folder from the Database.

Removing

To remove a folder and all the files in it from the Audio Database, right-
click the folder and select “Remove…” from the pop-up menu.

This does not delete the actual files from disk. It only removes them from 
the Audio Database.

…and the files in it are 
displayed in the list.

Click on a folder…
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Syncing to folder

The Sync to folder feature lets you make sure that the content of a volume 
folder in the Audio Database matches the corresponding hard disk volume.

The operation affects the specified volume folder and all its subfolders.

1. In the folder list, right-click the volume folder you want to update, and se-
lect “Sync to folder…” from the pop-up menu.
The Find dialog appears, see “Using Scan folder” on page 687.

2. Fill out the dialog or select a preset to narrow the operation to files that 
only meet certain criteria.
If you want to affect all files in the folder(s) select the “All audio files” preset.

3. Click the Scan button.

The following operations are performed:

• Files that are not yet in the Audio Database are added.
• Files that don’t exist any longer are removed from the Audio Database.
• The attributes (size, etc.) of all files in the Audio Database are updated.

Filtering the list
The filter function allows you to specify which files should be visible in the 
Audio Database, by setting up certain criteria. You might for example 
want the list to only display stereo files, files of a certain date, etc.

The filtering is common to all open Audio Databases.

To set up a filter, proceed as follows:

1. Select “Global Filter…” from the Audio Database menu.
The dialog that appears is identical to the one used for Scan folder.

2. Fill out the dialog or select a preset, as described in the section “Using 
Scan folder” on page 687.

3. Click OK.
Now when you click on folders or categories, only files that meet the specified criteria will 
be displayed.

When a filter is active, “Global Filter” is shown on the status bar.
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• To completely turn off the filtering, open the Global Filter dialog, click the 
Reset button and click OK.

Finding files
WaveLab’s Find feature allows you to find all files in the Audio Database 
that match certain criteria.

Please note that the Find function only searches among files already added to 
the Database (which is different from how Scan folder works, see “Using 
Scan folder” on page 687).

There are four ways to invoke the Find function:

• If you want to search among all files in the Audio Database, select “Global 
Find…” from the Audio Database menu.

• If you want to search in a folder and its subfolders, right-click on that folder and 
select “Find…”.

• If you want to search among files in one category and its subcategories, right-
click on that category and select “Find…”.

• If you only want to search among the files currently in the list, click on the right 
mouse button in the list and select “Find…”.

Regardless of which method you use, a Search dialog will appear. This is 
similar to the one used for filtering and for Scan folder (see “Using Scan 
folder” on page 687). Use the tabs to specify different types of criteria for 
the search (or select a preset) and click Search. The files found appear in 
the Audio Database.

• If you have selected Global Find, you can activate “Keep open”. This al-
lows you to redo the search without closing the dialog.

• Note that the filter setting applies.
For example, you might have set up a filter which ensures that only stereo files are shown in 
the list. When you perform a Find operation, you will still only get stereo files in the list. 
Please note that this might result in no files at all being shown. An example of this would be 
that you try to find only mono files and have a filter that only displays stereo files.
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Changing the default categories and keywords
To change the category hierarchy and keyword lists that appear in new 
Audio Databases, proceed as follows:

1. Make copies of the files “categ.txt” and “keywords.txt”.
These are located in the WaveLab program folder, in the Presets–Misc subfolder. You 
might for example name the copies “categ.bak” and “keywords.bak”.

2. Launch a regular text editor.
One of those included with Windows will work fine.

3. To Edit the categories, open the file “categ.txt”. To edit the keywords, 
open “keywords.txt”.

Note how the files are structured:

• Each level in the hierarchy begins with the name. After this, the sub items within 
this level are listed inside curly brackets (“{” and “}”). For example, in the “categ” 
file you will note a section that begins with the word “Keyboards” followed by a 
left bracket on the next line. This category (“Keyboards”) does not end until after 
the word “Harpsichord”, since on the line below that, a corresponding right 
bracket appears.

• Within each level you will in many cases find sublevels, also enclosed in curly brack-
ets. (In programmer speak, this is referred to as nested structure). In the “Keyboard” 
example, the sublevels are “Organ”, “Piano”, “Synth”, “Celesta”, “Clavinet” and 
“Harpsichord”. The first three of these contain their own subcategories.

4. Change the structure, rename, add and remove items as desired.

Make sure that each left bracket is “balanced” by a right bracket ending the 
“level”!

5. Save the file under the same name in the same location.

If something goes wrong, delete the files you have created and rename 
the backup files to the original names. This will give you back the initial 
settings.
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What are Workspaces?
Workspaces allow you to collect files that somehow belong together, for 
example all files used in a song, all files used for one commercial, etc.

Furthermore, Workspaces allow you to organize those files into “folders” 
(here called groups) in any structure you like. For example you might put 
all narration files in one group regardless of whether the files are in differ-
ent folders on your hard disk, or even if they are on totally different drives!

The group handling in this window is very similar to the folder handling in 
the Windows Explorer.

Workspaces remember window settings!

When you open a Workspace, all its files are restored to the state they 
were in when you closed the Workspace. This means that all Wave files 
are opened with their windows sized, zoomed and styled as they were 
when you last worked on the Workspace (to open a Workspace with a 
standard layout instead, hold down [Ctrl] when opening).

Workspace files have the extension “.prj”.
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Creating and opening Workspaces

When you open a Workspace or create a new one, all open files are closed.

Creating an empty Workspace

There are two ways to create a new empty Workspace:

• Pull down the File menu, select New, and from the menu that appears, se-
lect Workspace, or…

• Click on the New icon on the control bar, and select Workspace from the 
menu that appears.
Either way a file dialog opens, where you can select a location for naming and saving the 
new Workspace.

Opening an existing Workspace

Workspace files are opened like any other file under Windows. However, 
there is one shortcut:

• Click on the Open icon on the control bar. Select Workspace from the 
menu that appears.

You can only have one Workspace open at a time.

How Workspaces are saved
There is no special save command for Workspaces. Instead, any changes 
you make are automatically saved to disk as you go along. If you close a 
Workspace and then open it you will find it exactly as you left it.
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Creating, renaming and deleting groups
Creating

You can create new groups as you see fit: Right-click on the group in 
which you want to create a new group, and select “New group” from the 
pop-up menu that appears. Enter a name for the group and click OK.

Renaming

To rename an existing group, right-click it and select Rename from the 
pop-up menu.

Removing

To delete a group and remove all files within it from the Workspace, right-
click it and select Remove, and click OK in the dialog that appears.

This only removes the items from the Workspace. It does not delete any-
thing from your disks!

File operations
Adding files using a dialog

To add one or more files to a group, proceed as follows:

1. Right-click on the group to which you want to add the file(s), and select 
Add from the pop-up menu that appears.

2. In the file dialog, select all the files you want to open.
You can select as many files as you wish from the same folder, using [Ctrl] and [Shift].

3. Click Open.

A file can only be added to one group at a time.

Adding files by dragging a document

You can drag an entire Wave document into the Workspace, by using the 
drag icon on the title bar of the Wave window.

Adding files from a Database 

You can drag and drop files from a Database to a Workspace, as de-
scribed in the section “Drag & Drop between Audio Databases and 
Workspaces” on page 697.
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Renaming files 

To rename a file, right-click it and select Rename from the pop-up menu.

This means the file on disk is actually renamed, just as if you had changed 
the name in the Windows Explorer.

Removing files

To delete a file from a group, right-click it and select Remove.

This removes the file from the Workspace but does not delete anything 
from your disks!

Moving files between groups

To move a file from one group to another, first remove it from one group 
and then add it to another, as described above.

Playing and opening files

• To play a file, select it and press [Enter] or click Play on the Transport bar.

• To open a file for editing, double click on it (or right-click and select Open 
from the pop-up menu).
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Background
WaveLab features very versatile and powerful functions for backing up all 
kinds of files and folders. Here’s a brief rundown of the features:

• You can back up directly to CD or to standard media. When backing up to CD, 
you can create archives that span several CDs, if necessary.

• The archives created by the backup function are ZIP files, compatible with other 
ZIP extraction applications. They can of course also be opened by WaveLab (as 
can any ZIP file)!

• When backing up WAV audio files, these can be converted to the OSQ (Original 
Sound Quality) lossless compression format automatically, for great savings in file 
size.

• You have the option to specify exactly which folders and files should be included 
in the backup, to exclude or include files of a certain type only (individually for dif-
ferent folders if you like), to exclude files based on their date, etc.

• Preview and Simulate functions allow you to check the contents and size of the 
archive before actually performing the backup.

• You can create a Data CD/DVD Project containing the files and folders you want 
to back up, thus allowing you to back up data to CD or DVD. This also gives you 
the possibility of, for example, rearranging the data and write multiple copies of 
the backup CD/DVD.

…and much more!
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Creating a Backup Plan
The Backup Plan is where you specify which folders and files should be 
backup, and make additional settings for how the backup should be per-
formed.

• To create a new Backup Plan, open the File menu and select Backup Plan 
from the New submenu.
An untitled Backup Plan window appears.

Defining which files should be backed up

The contents of the Backup Plan are defined by filters. Each filter is de-
fined for a certain folder, but you can also specify that a filter for a folder 
should affect all its subfolders as well.

On the most basic level, a filter defines which files should be backed up – 
one or several specific files, or all files in the folder. But it’s also possible 
to include or exclude files based on their file types.

The filters are defined in the right half of the Backup Plan window. 
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Below is a step-by-step procedure showing how to set up filters – please 
read the filtering rules as well (see “Filtering rules” on page 717).

1. Make sure the “Definition” tab is selected at the top of the window.
The other tab, “Preview”, is described in the section “Using the Preview function” on page 
721.

2. In the directory view to the left, select a folder containing elements you 
want to back up.
The files in the selected folder are listed in the two panes to the right.

3. To mark individual files for backup, tick their checkboxes in the “Include” 
list.
The number after the text “Specific files” (just above the list) shows how many individual 
files are currently marked for backup.

4. If you want to back up all files in the folder, tick the “All files” checkbox at 
the top of the “Include” list.
To also include all files in all subfolders, tick the “Also applies to subfolders” checkbox. This 
makes the subfolders “inherit” the same filter as their parent folder (not including the “Spe-
cific files” settings, see “Filtering rules” on page 717). However, you can override this for a 
subfolder by defining a separate filter for that folder.

5. To exclude individual files in the folder from backup, tick their checkboxes 
in the “Exclude” list.
If none of the files in the folder should be backed up, you can tick the “All files” checkbox in 
the “Exclude” list. 
For example, you may have a folder with several subfolders, and want to back up all these 
except one: Activate the “Include: All files” and “Also applies to subfolders” options for the 
parent folder, and tick the “Exclude: All files” checkbox for the one subfolder you don’t want 
to back up.

The files in the “Video” folder will 
be excluded from the backup.

This is the “parent folder” 
in our example.

The green arrows indi-
cate that these folders use 
the filter settings of their 
parent folder (see “The 
symbols in the directory 
view” on page 718).

The “Video” folder is selected, and its contents are there-
fore shown in the Include/Exclude lists to the right.
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This far, filtering has only been applied to specific folders and files, but 
you can also specify that certain file types should be excluded (or in-
cluded) in the backup:

6. To exclude a certain file type from backup, specify its file name extension 
by typing into the Patterns field above the “Exclude” list.
This function is available when the “Include: All files” option is activated.
Note that you should use the wildcard character * to indicate that all files with a certain ex-
tension should be excluded. For example, typing *.bmp will exclude all bitmap files in the 
folder from backup. If you specify several file types, you should separate them with commas.

• If the “Also applies to subfolders” checkbox is activated, the specified file 
type will be excluded for the subfolders as well.
It’s also possible to exclude files and file types globally, for all folders (see “General settings” 
on page 722).

• If the “Include: All files” checkbox is not activated, it’s possible to have a 
certain file type included in the backup, by typing its extension in the Pat-
tern field above the “Include” list.
This allows you to quickly set up a Backup Plan where only files of a certain type are backed 
up.

Filtering rules

• The “Include: All files” setting is “dynamic” (or “abstract”) in the sense 
that it will include all files that are present in the folder at the time when 
the backup is executed (regardless of what was in the folder when the 
Backup Plan was created).
In fact, activating “Include: All files” is the same as writing “*.*” in the “Include: Patterns” field.

• Activating the “Also applies to subfolders” option makes the filter settings 
apply to all subfolders for which no separate filters are defined.
This applies to the filter settings “Include: All files”, “Include: Patterns” and “Exclude: Pat-
terns”. Settings for including or excluding specific files are never inherited by subfolders.
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• If you use the “Exclude: All files” option, this automatically applies to all 
subfolders (for which no separate filters are defined).
In other words, when “Exclude: All files” is used, the “Also applies to subfolders” option is 
automatically activated.

• If you define a filter for a folder, any “inherited” filter from a parent folder is 
automatically overridden (both for that folder and for its subfolders). 

The symbols in the directory view

When you specify the backup filters in the lists to the right, you will notice 
that the folders will be labeled with different symbols in the directory view 
to the left. The symbols have the following meaning:

If you position the pointer over a folder name in the directory view to the 
left, a pop-up tip will appear, telling you the status of the folder (e.g. “All files 
in this folder are included in the backup”).

Symbol Description

 (green circle) A filter has been defined specifically for this folder. All files in this 
folder will be backed up. If a plus sign is shown in the circle, this 
indicates that this filter is inherited by subfolders (i.e. the “Also 
applies to subfolders” option is activated).

 (light blue circle) A filter has been defined specifically for this folder. Some (but 
not all) files in this folder will be backed up. If a plus sign is 
shown in the circle, this indicates that this filter is inherited by 
subfolders (i.e. the “Also applies to subfolders” option is acti-
vated).

 (red circle) A filter has been defined specifically for this folder. No files in this 
folder will be backed up (although files in subfolders may be in-
cluded in the backup, if separate filters have been defined for 
these subfolders).

 (green arrow up) No filter has been defined specifically for this folder, but all files 
in this folder will be backed up, since this folder inherits the filters 
from a parent folder (one or several steps up).

 (light blue arrow up) No filter has been defined specifically for this folder, but some 
(not all) files in this folder will be backed up, since this folder in-
herits the filters from a parent folder.

 (purple arrow down) No filter has been defined specifically for this folder. However, fil-
ters have been defined for one or more subfolders.
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Editing the filters in textual form

Sometimes it can be preferable to view and edit the filter definitions as 
text. This is done by selecting “Edit filters in text form” from the Functions 
pop-up menu (or by clicking the “T” icon).

In the dialog that appears, you can view each defined filter separately, and 
edit the settings:

• Use the scrollbar in the upper right corner to step between the available filters. 
The path of the folder for the currently displayed filter is shown to the left.

• The checkboxes and “Patterns” fields work as in the main Backup Plan window.
• You can remove specific files from the filters by selecting them in the lists and 

pressing [Delete].
• It’s also possible to delete the selected filter completely, by clicking the “Delete 

displayed filter” button.

The “Edit filters” dialog also offers some functions that are not available 
from the main Backup Plan window:

• The Display options in the lower left corner allow you to scan for filters which are 
attached to non-existing folders, or filters listing non-existent files, and remove 
these if desired.
This may be necessary if you have removed files or folders since you first created the 
Backup Plan.
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• If you have renamed or reordered folders on your hard disk since creating the 
Backup Plan, you can click the “Find and replace in all paths” button to update 
the Backup Plan.
In the Search and Replace dialog that appears, enter the previous (no longer valid) path 
name in the Find field and the new, correct path in the Replace field and click OK. The pro-
gram will search all displayed filters (taking the Display options into account) and perform 
the replacements, after which an alert tells you how many replacements were made.

After editing the filters, click OK to close the dialog and keep the 
changes. To discard all changes made in the dialog, click Cancel.

Saving and importing filter pattern files

If you have set up a filter that you want to use for many different folders or 
in different Backup Plans, you can save it as a text file. This is done by se-
lecting “Save current pattern as…” from one of the Patterns pop-up 
menus (above the Include and Exclude lists). The file will be saved in the 
Presets/BackupFilters subfolder in the program folder.

To add the filter patterns from a file to the current filter, use one of the 
“Add Patterns” functions on the Patterns pop-up menus.

• Add pattern (contents) extracts the contents of the specified file and adds these 
to the current filter.

• Add pattern (by reference) adds a file reference to the current filter.
The contents of the file is read and incorporated into the filter when the backup is pre-
viewed, simulated or executed. This means that if you edit the referred file directly (e.g. in a 
text editor), all Backup Plans referring to this file will be affected. Note also that the file must 
be located in the Presets/BackupFilters subfolder in the program folder.



WAVELAB
Using WaveLab for backup 31 – 721

Using filter presets

Included with the program are some presets with common filtering options. 
To use one of these, select “Explore presets” from the Patterns pop-up 
menu, and open one of the preset files from the window that appears.

Importing filters from another Backup Plan

If you have saved other Backup Plans (see “Saving your Backup Plan” on 
page 724), you can incorporate their filters into the current Backup Plan. 
This is done by selecting “Import and merge filters from another Backup 
Plan” from the Functions pop-up menu, and selecting the desired Backup 
Plan file in the file dialog that appears.

• The imported filters will be merged with the current filters.
If there are filters for the same folder in both Plans, the settings of the current (open) 
Backup Plan will be used.

Erasing all filters

To remove all filters from the current Backup Plan, select “Erase all filters” 
from the Functions pop-up menu.

Using the Preview function

Once you have set up the desired filters, you can click the Preview tab to 
view exactly which files will be backed up with the current settings.
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The items on the Preview pop-up menu (and the corresponding icons to 
the right) have the following functionality:

General settings

Before you can actually run the backup, you need to make some general 
settings. Actually, the dialog for this will automatically appear when you 
simulate or execute a backup, but you may want to adjust these settings 
before this, since some of them affect the backup contents (and thus 
what is shown in Preview mode).

To make general settings for the Backup Plan, select “Settings” from the 
Functions menu (when the Definition tab is selected) or click the corre-
sponding icon to the right.

The Backup Plan Options dialog appears. For information about the avail-
able options and settings, click the question mark icon in the dialog.

Click OK or Cancel to close the dialog and keep/discard the changes, as 
usual. An additional checkbox allows you to save the settings as default.

Option Description

Generate file list Generates a list of files to be backed up, in text format. The list is opened in 
the default text editor (e.g. Notepad), allowing you to save it or print it.

Display source 
paths

When this is selected, the Preview window shows the files according to 
their original hierarchy on your hard disk (from the drive root down).

Display saved 
paths

When this is selected, the Preview window shows the files according to 
how they will be archived. In this case, the folder hierarchy depends on the 
settings in the Options dialog (see “General settings” on page 722).

Up one level Used for navigating to the nearest higher hierarchical level.

Refresh Refreshes the preview display.

Show options Determines how the backup contents should be shown in the Preview.
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Performing the backup

Simulating

Before you actually execute the backup, you may want to run a simulation. 
This allows you to check the exact size of the archive (useful if you’re un-
certain whether it will fit on a single CD). It’s also useful to see that all 
backup files can be properly accessed by the program.

Simulation is the same as the actual backup, but without saving. This 
means the process will take virtually the same time.

Proceed as follows:

1. Select “Simulate” from the Functions menu, or click the yellow arrow.
The Backup Plan Options dialog opens, allowing you to check your settings.

2. In the dialog, click “Simulate”.
The simulation starts. A dialog will show you the progress, and inform you of how much 
each file and the complete archive are compressed.

3. When the simulation is finished, an alert appears to inform you of the final 
archive size (and how much was saved by the compression).

Executing

To execute the backup, proceed as follows:

1. If you are backing up to CD, make sure the CD writer is correctly con-
nected and set up, with an empty CD inserted.

2. Select “Execute” from the Functions menu, or click the red arrow icon.
The Backup Plan Options dialog opens, allowing you to check your settings.

3. In the dialog, click “Backup”.
The backup starts. A dialog will show you the progress, and inform you of how much each 
file and the complete archive are compressed.

• If you back up to CD, and the archive is larger than what fits on one CD, 
you will be asked to insert new CDs during the backup progress.

4. If you have activated the “Open archive at the end” checkbox in the 
Backup Plan Options dialog, the archive will automatically open when the 
backup is finished.
For more information on viewing archives and extracting files, see “Opening an archive” on 
page 725.
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Saving your Backup Plan

If you intend to execute the same backup more than once, you should 
save your Backup Plan. This is done by selecting “Save as” or “Save” 
from the File menu as usual. Backup Plan files have the file extension 
“.bkp”. To open a saved Backup Plan, use the “Open Backup Plan” item 
on the File menu.

The Externalize and Internalize functions

A saved Backup Plan contains a list of all folders for which a filter is de-
fined, and the specifics for each filter. However, if you rearrange the folder 
structure on your hard disk, some folders listed in the Backup Plan may no 
longer exist in their original locations. This would normally mean you’d 
have to adjust your Backup Plan manually, but luckily there’s an easier 
way:

1. Open the Backup Plan and select “Externalize” from the Functions pop-
up menu.
The program writes each filter description into a small text file, and stores each such text file 
in the folder to which the filter is attached. In other words, each folder (for which there is a 
filter defined) will now contain a small text file describing the filter settings.

2. Reorganize your hard disk as desired.
Make sure you don’t remove the filter description text files (these are called “@backup.txt”).

3. To update the Backup Plan after the folder structure on the hard disk has 
been changed, select “Internalize” from the Functions pop-up menu.
This function makes the program scan the hard disk for filter description text files and add 
them to the Backup Plan.
In the dialog that appears, you can specify drive, folder and name of the Backup Plan to 
search for. You also get the option to have the found filter descriptions merge with the ex-
isting descriptions in the Backup Plan, or to replace them.

• Note that a filter description file (@backup.txt) can contain the descriptions 
of different Backup Plans.
You can also easily edit these files manually, and use the Add Pattern functions on the Pat-
terns pop-up menu to import these into a Backup Plan.
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Performing the backup from a command line

It’s possible to launch WaveLab, have it execute a given Backup Plan and 
(optionally) quit afterwards, by entering a command line. The syntax for 
this is:

“program path” “backup plan path” -a [-q]

For example:

“WaveLab.exe” “c:\my backup plan.bkp” -a [-q]

Note:

• The optional -q switch tells the program to quit after successfully executing the 
backup.

• WaveLab in itself does not have a feature for scheduling automatic backups 
(since the backup function is primarily aimed at backing up to CD, which requires 
user assistance). However, the possibility to run a backup from a command line 
allows you to use any scheduling application for this, should you so desire.

Opening an archive
To open a backup archive file, select “Open Archive” from the File menu. In 
the file dialog that appears, locate, select and open the desired zip file.

Note that WaveLab can open any zip file – not only files created by the pro-
gram’s own backup function!

The archive opens in a new archive window:

• As usual, you can reorder the columns, hide or show columns and sort the 
items by different columns.
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Making file extraction settings

1. Select “Settings” from the Functions pop-up menu (or click the corre-
sponding icon to the right).
The File Extraction Settings dialog appears.

2. Use the radio buttons in the “Extract what” section to determine whether 
only the selected files, all files or some specific files should be extracted.
The “Specific files” option allows you to e.g. extract files of a certain type only (by typing 
“*.xxx”, where “xxx” is the file name extension of the file type).

3. Specify the destination of the extracted files to the right in the dialog.
Normally, this is done by specifying a specific folder. If the “Restore original folder tree” 
checkbox is activated, the stored path of each file will be kept (i.e. underlying folders will be 
added if needed). If the checkbox isn’t activated, the files will be extracted directly into 
the specified folder.

• If the archive contains files from several different partitions or drives, you 
can select the “Original or remapped partitions” option.
This allows you to extract the files back to their original partitions/drives (default), or re-direct 
all files from a certain partition to another (by typing a new path in the column to the right). 
This is useful if you e.g. have reconfigured your system with new partition schemes, removed 
or added drives, etc.

4. Set the options in the section to the left in the dialog.
Click the question mark icon in the dialog for details.
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Previewing

Selecting Preview from the Functions menu (or clicking the eye icon) ac-
tivates the Preview mode. In this mode, some additional information is 
shown in the Archive window: 

• The Preview column shows the path of the files (the locations in which they will be 
extracted, taking the file extraction settings into account).

• The Destination column shows whether there are files of the same name in the 
destination folders, and whether these are older, newer or have the same date as 
the archived files. “Not existing” means that there is no file of the same name in 
the destination folder.

Testing the archive

To check that the archive is OK, proceed as follows:

1. Select “Test archive’s integrity” from the Functions pop-up menu (or click 
the yellow arrow icon).
The File Extraction Settings dialog appears, allowing you to check the settings.

2. In the dialog, click the “Test” button.
A message will tell you whether the archive is OK.

Extracting

To extract archived files, proceed as follows:

1. If you want to extract some files only, select these.
Use [Ctrl]-clicking to select several files, or [Shift]-clicking to select a range of files.

2. Select “Extract” from the Functions pop-up menu (or click the green arrow 
icon).
The File Extraction Settings dialog appears, allowing you to check the settings. If you want 
to extract the selected files only, make sure this option is selected in the dialog.

3. In the dialog, click the “Extract” button.
The files are extracted. If you activated the “Open containing folder(s) at the end” option in 
the dialog, the destination folders will automatically be opened.

• When you extract archived OSQ files with the “Convert OSQ files to WAV” 
option activated, the files are restored to WAV format, with their original au-
dio data intact.
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Other functions
Render as data CD/DVD

By selecting this item from the Functions menu, you create a new data 
CD/DVD Project with the contents of the current Backup Plan. This allows 
you to rearrange the contents of the CD/DVD, write multiple CD/DVD 
copies, etc.

Create Labels and Edit Text Variables

These items on the Functions menu allow you to create CD labels for your 
backup CDs. Read more about creating labels in the chapter “Creating 
labels” on page 603.
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What is customizing?
When we talk about customizing, we mean making settings so that the 
program behaves and looks the way you want it to!

Preferences

In the Preferences dialog on the Options menu you will find a number of 
settings for tailoring the look and behavior of the program.

The settings are collected on tabs. To get a description of the Preferences 
settings of a particular tab, click the question mark icon.

Saving the preferences

To make sure the preference settings “stick”, select the General tab and 
make sure “Save preferences on exit” is activated. When this is activated, 
all your preferences settings (as well as all menu options, etc.) are auto-
matically saved when you Quit the program.
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Creating startup preferences

To make sure the program starts with the same preference settings each 
time you launch it, proceed as follows:

1. Set up all preferences as desired and make sure “Save preferences on 
exit” is activated.

2. Quit the program.

3. Launch the program again, and deactivate “Save preferences on exit”.
Now you can change the preferences for this session, but the settings you had when you 
last quit will be the ones you get next time you launch the program.

Folder editing

Navigating to the right folder via file dialogs can sometimes be time con-
suming, but WaveLab gives you the option to optimize these operations.

If you select “Edit folders” from the Options menu, a dialog opens where 
you set for the saving and opening of preferences for WaveLab’s various 
folders. 

To the left in the dialog is a tree list with two root folders; “Work folders” 
and “Document folders”. Work folders are the folders associated with 
temporary files, and Document folders are all folders associated with 
WaveLab specific files and documents (Wave, Audio Montage, etc.). 
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Work folders

The Work folders are usually set up after installing WaveLab, as the fold-
ers specified for temporary files have an important bearing on WaveLab’s 
overall performance. See “Temporary files” on page 28 for a description 
of how to set up these folders.

Document folders

For each WaveLab document type, you can specify paths to open and 
save folders (given that the document can be saved). This is done in the 
following way:

1. Click on the plus sign for a document type in the tree list.
All document types will have Open and Save sub-items. Archive, Audio Database and 
Workspace items only have Open entries as these documents do not have a special save 
command.

2. Select either Open or Save.
Now you can specify a path to a folder which will be automatically selected when opening 
or saving a document of this type.

For each folder, you can specify the following:

Item Description

Current folder Here you can specify a path to a folder to use for Saving or Opening 
documents of the selected type.

Keep last used The last folder used for saving or opening documents of the selected 
type will be selected the next time you open or save from the file dialog.

Change when save/
open folder changes

Use this if you want the folder to be redefined if the opposite operation 
is performed (open vs save). If you set this option both for the Open 
and Save folders, then these folders will always be the same.

When opening Wave-
Lab set this folder

If you want to reset the folder to a specific folder each time you open 
WaveLab you can specify a path here.
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Saving the window layout
If “Open last window layout on startup”, on the Preferences–General tab 
is activated, the program will open in exactly the same state as it was 
when you last quit (with the option activated). The snapshots, and even 
the document windows you had open (and their “layout”) will automati-
cally be reopened.

You can use this to create a startup “layout” that will always appear when 
you launch WaveLab:

1. Set up all windows as desired.

2. Make sure “Open last window layout on startup” is activated and quit the 
program.

3. Launch the program again, and deactivate “Open last window layout on 
startup”.
The next time you launch the program, it will open with the windows set up as in step 1 
above, regardless of whether you have changed the window layout since.

• If you hold down [Ctrl] when quitting the program, the effect of the “Open 
last window layout on startup” setting is reversed. If it was activated, it will 
be deactivated and vice versa.

• If you hold down [Ctrl] when launching the program, no window layout is 
loaded.
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Styling WaveLab – Wave windows
It’s possible to “style” the Wave windows to your liking, by adjusting col-
ors (of waveforms, background, cursor lines, etc.) and changing the look 
of the ruler and other window details. This can be done in two ways:

• By changing the default style.
This is the style that is normally used when you open or record an audio file in a Wave win-
dow.

• By having the program assign different styles to different Waves, according to 
specific conditions.
You could for example have all files of a certain file type or with a certain name be shown 
with their own style.

On the following pages, we will first describe the general procedure for 
how to change the default style or set up style conditions, then describe 
the elements you can change.

Changing the default style

1. Set up a Wave window to look the way you want it.
Note that this also includes the ruler formats – see “Units of time and level” on page 61.

2. Select “Audio window styles…” from the View menu.

3. In the dialog that appears, make sure “Default style” is selected and click 
“Save”.

4. Close the dialog.
Now, all Wave windows (which do not match any style condition you may have set up) will 
be shown in the style you specified.
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Setting up style conditions

In the Audio Window Styles dialog, there are 15 additional style “slots” 
(apart from the default style), some of which already hold pre-defined 
styles to use or overwrite, as you see fit. For each of these styles, you can 
specify that it should be applied to all Wave windows with audio files that 
meet certain criteria, called conditions:

1. Open the Audio Window Styles dialog from the View menu.

2. Select one of the style slots.
This could hold a pre-defined style or one that you have saved yourself (see below).

• To make sure you select the correct style, you can click the “Apply to cur-
rent window “button to temporarily apply the style to the active Wave win-
dow.
This is just a way to check what style settings are stored in the style slot.

3. Click the Condition button to open the “Style condition” dialog.

4. Activate the desired conditions by ticking their radio buttons, and fill in the 
settings as required.
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The following settings are available:

5. Click OK to close the “Style condition” dialog, and close the Audio Win-
dow Styles dialog.

Now, if you open or record a new file that meets all conditions specified 
for a style slot, it will automatically be shown in that style.

Note that the conditions are set for the style slots – not for the actual style 
settings stored in the slot. This means you can set up your conditions first if 
you like, and then change the style settings for the slots (see below), with-
out having to redefine the conditions.

Saving your own styles for use with conditions

To save your own settings in the style slots, you proceed just as when 
changing the default style: set up the Wave window as desired, select the 
style slot in the Audio Window Styles dialog and click Save. It’s also pos-
sible to rename a style slot by clicking and typing.

The elements of a style

• Again: When you change any of these style settings (apart from ruler for-
mats), you need to save them in a style (either the default style or one of the 
conditional styles – see “Changing the default style” on page 734). 
If you don't do so, the window will automatically be reset to the default style (or a condi-
tional style) as soon as you perform any editing (because the style to apply is evaluated af-
ter each edit)!

Setting Description

File extension Here you can specify files of certain types, by entering their file exten-
sions (e.g. mp3 or wav). Separate several extensions with a blank 
space or comma.

Name Allows you to specify keywords in the file names. For example, by en-
tering the keyword “bass”, all files with “bass” in the name can be 
shown with a separate style.
Separate keywords with a blank space or comma.

Sample Rate If this is activated, only files with a sample rate in the range specified 
will be shown with this style.

Bit Resolution If this is activated, only files with a bit resolution in the range specified 
will be shown with this style.

Number of channels Lets you specify that only mono (1 channel) or stereo (2 channels) 
files should be shown with this style.
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Waveform elements

To change the waveform elements, right-click on a waveform (in the over-
view or in the main display), select Elements and then select the desired 
item from the submenu that appears.

Note that you make separate settings for the main waveform display, the 
overview and for the two channels in a stereo file! Which section you make 
settings for depends on where you click.

Colors

To set the color of a certain element in the display, right-click in the Wave 
window, select Colors and then select an element from the submenu that 
appears. In the standard Windows color dialog that appears, select or de-
fine a color and click OK.

• For the display background colors, there are separate “top” and “bottom” 
settings – the resulting display background will be a gradient “fade” from 
the top color to the bottom color.

Item Description

Time Ruler Specifies whether or not the display should have a time ruler.

Level Ruler This only applies to the Main view display. It is used to set whether or 
not there should be a ruler showing levels.

Solid/Dotted
Markers

These two (mutually exclusive) items are used to set the style of the 
marker lines extending across the waveform. If neither is activated, the 
marker lines are hidden.

Range Indicator 
at top/bottom

The range indicator is a small “barber shop striped” bar that indicates 
which part of the waveform is shown in the main display. These two 
items are used to set whether it should appear at the top or bottom of 
the overview.

Thin/Medium/
Fat Cursor

These three items are used to set the thickness of the cursor line.

Solid/Dotted 
zero level axis

These two (mutually exclusive) items are used to set the style of the 
line crossing the waveform at zero level (in the middle). If neither is ac-
tivated, the zero level axis is hidden.

Solid/Dotted 
half level axis

As above, but for the two lines crossing the waveform at ±50% level.

End of file indicator Allows you to show/hide the line that indicates the end of the file.



WAVELAB
32 – 738 Customizing

If you prefer a single background color (or if you need to speed up display 
redraws, typically with slower graphic cards), you can turn this feature off 
by activating “Do not use gradient backgrounds” in the Preferences–En-
vironment tab. The background color will then be a 50/50 mix of the top 
and bottom color.

Again, when changing colors for the waveform images, you make separate 
settings for the main waveform display, the overview and for the two chan-
nels in a stereo file, depending on where you click.

Ruler style

To change the look of the rulers (done separately for the Overview and 
Main view), right-click on the ruler, select style and then select one of the 
options from the submenu that appears:

Option Description

3D/Mingled These two (mutually exclusive) items allow you to select whether the 
ruler should have its own looks (3D) or whether it should “inherit” the 
color of the waveform background.

Font Opens up a dialog box that allows you to set a font for the text/num-
bers on the ruler. Select a font, style, size, effect and color and click 
OK.

Tick Color This allows you to set the color for the tick marks on the ruler. A stan-
dard Windows color dialog is used.
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Styling WaveLab – Audio Montage windows

Using custom colors

You can create and assign different color schemes to different clips, 
tracks or groups to make it easier to find your way through the Montage:

• To assign a color scheme to a track, open the Track menu and select a 
color scheme from the Color submenu.
The selected color scheme is used for all current clips on the track, as well as for clips you 
add later on. However, note that this color selection is overridden by the group and clip colors.

• To assign a color scheme to a group, use the “Color selected group” op-
tions in the Grouping menu on the Groups tab (see “Coloring groups” on 
page 491).
The group color (if other than default) supersedes the track colors, but is overridden by in-
dividual clip color scheme selections.

• To assign a color scheme to an individual clip, right click on the clip to 
bring up the clip speed menu, and select a color scheme from the Color 
submenu.
Clip color selections (if other than default) override track and group color selections.

• The Lock and Mute colors override all color settings above.
If a clip is both locked and muted, the Mute color is used.

It’s also possible to have different color schemes automatically applied to 
different clips, according to their names or properties of their audio files. 
This is described in the section “Automatic coloring – Setting up condi-
tions” on page 742.
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Defining custom colors

You can redefine all colors on the Color pop-up menus, as well as the 
colors for various other elements in the Audio Montage. This is done in 
the Audio Montage Colors dialog, using the following procedure:

There are many items of different color displayed in a Montage. If you rede-
fine colors, be careful not to choose colors which cause some elements to 
“disappear” (e.g. black marker lines on a black background).

1. Pull down the View menu and select “Audio Montage colors…”.
The Audio Montage Colors dialog appears. For the menu item to be available, the active 
window must be a Montage window.

2. In the Items list, select the element for which you want to edit the colors.
By clicking the plus sign next to a heading, you display the sub elements for that item. The 
available elements are described in the section “The color elements” on page 742.

3. Use the three sliders (red, green and blue) to adjust the color of the se-
lected element.
The current color is displayed in the field to the right. You can also see the changes in the 
Audio Montage window while you are editing.
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• If you are editing a clip color element, you can make separate color set-
tings for the left and right sides of stereo clips.
If you want the same color for the left and right sides, you must make sure that the checkbox 
Edit Left/Right is activated (it is by default).

When this is activated, settings for the left side of a clip are automatically “mirrored” on 
the right side, and vice versa.

• If you activate the Link sliders checkbox, you can adjust all three sliders at 
once, by moving one of them.
This is useful if you want to adjust the brightness of the color, without affecting the hue.

• Some elements can be hidden totally by activating the Hide option.
When this is activated, it is not possible to make any color adjustments (since the element 
won’t be visible in the Audio Montage anyway).

• It is also possible to select colors from a standard Windows color dialog, 
opened by clicking the Select button.

4. If you make a mistake, you can undo your latest adjustment by clicking the 
Undo button.
To undo all changes you made since you opened the dialog, click Undo All.

5. If you want to apply the same color to several elements, you can use the 
Copy and Paste buttons.
Set up the color, click Copy, select the next element and click Paste to apply the same 
color settings.

• You can also copy an entire color scheme (for example, copy all settings 
for one of the custom schemes to the default scheme) by dragging and 
dropping in the Items list.

6. If you are editing one of the color definitions (the items that appear on the 
track, group and clip color menus), you can rename the color by clicking 
on the name in the Item list and typing a new name.
In the Items list, the color definitions that can be renamed are displayed in blue.

7. When you’re finished, click Close to close the window.
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Automatic coloring – Setting up conditions 

When you have defined a custom color scheme, you have the option of 
automatically applying this to any files you add to the Montage that match 
certain conditions.

Select a custom color scheme in the Audio Montage Colors dialog and 
click the Conditions button to bring up the “Style condition” dialog. Here 
you can set up which conditions must be matched for a clip to automatically 
get the selected custom color scheme. The procedures and options are the 
same as when setting up style conditions for Wave windows (see “Setting 
up style conditions” on page 735), with one exception: here, the “Name” 
condition refers to the clip name, not the name of the actual audio file.

When you close the dialog, the selected color scheme will be applied to 
all clips that match the set conditions.

The color elements

Clip colors

Under the heading Clip Colors you can select colors for various elements 
in the following clip types:

For each item, you can select colors for a number of different clip ele-
ments. You can make separate adjustments for the left and right sides of 
a stereo clip, though by default, editing a color for the left side will auto-
matically change the same setting for the right side and vice versa (see 
“Defining custom colors” on page 740). For mono clips, the “Left (mono)” 
setting is used.

Option Description

Crossfade Region Allows you to set the background color for overlapping clip sections.

Default The default colors, used for clips for which you haven’t selected any spe-
cific color.

Locked The colors used for all locked clips.

Muted The colors used for all muted clips.

Custom These options correspond to the items on the Color submenus (on the 
Track menu, clip speed menu and Groups view : Grouping menu). These 
can be renamed, and you can also set up conditions for when these 
should be automatically applied, as described above. 
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The following color elements are available:

For the Crossfade Region item, you can only select colors for “Background” 
and “Background (sel. range)”.

Option Description

Background top/bot-
tom (normal/selected/
selected range)

The background colors of the clip (unselected, selected and selec-
tion range, respectively). The resulting display backgrounds will be 
gradient “fades” from the top colors to the bottom colors (this can be 
turned off in the Preferences–Environment tab, as described in the 
section “Colors” on page 737.

Waveform (normal/
selected/sel.range)

The waveform color for unselected/selected clips or selection 
ranges, respectively.

Waveform outline (nor-
mal/selected/sel.range)

The color of the waveform outline (unselected/selected clips and se-
lection range, respectively).

Edge The left and right edge of the clip.

Edge (selected) The left and right edge, if the clip is selected.

Edge (sel. range) The left and right edge, if within a selection range.

Axis (level zero) The color of the horizontal dotted line in the middle of a clip, indicat-
ing zero level.

Axis (half level) The color of the horizontal dotted lines halfway up and down from the 
middle of a clip, indicating 50% level.

Channel separator 
(stereo clip)

The line dividing the two sides in a stereo clip.

Clip name The name label of the clip.

Focused Clip name The name label of the focused clip (see “About selected and focused 
clips” on page 413).

Focused Clip name 
background

The name label background of the focused clip.
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Miscellaneous colors

This section of the Items list in the dialog contains color settings for other 
elements in the Track View:

Working with window layouts
Window layouts are used for creating various “work displays” for differ-
ent situations. The following items are stored in window layouts:

• The size, position and minimize/maximize properties of document windows. This 
does not include the contents of the window, just the properties of the window 
“frame” itself. For example, if some Database window was included in the window 
layout, the Database you currently have open when you load the preset will be 
sized and moved accordingly.

• Positions of non-modal dialog boxes, such as the off-line processors. This in-
cludes opening any such windows.

• Positions of plug-in processor panels.

Windows that are already open will never be closed as a result of recal ling 
a window layout.

Option Description

Background 
top/bottom

The background colors of the Track View.

Background (selected 
range) top/bottom

The background colors in selected ranges.

Cursor The color of the Montage cursor. Note that because of the blinking 
Cursor, the selected colors will appear in inverse video in the Mon-
tage.

Marker The color of the marker lines in the Montage.

Cue-Point The color of the vertical dotted cue point lines.

Marker (source) The color of marker lines from the source Wave windows (shown in 
clips if the option “Show source’s ruler and markers” is activated on 
the clip speed menu).

Time Ruler (source) The color of the source ruler (shown in clips if the option “Show 
source’s ruler and markers” is activated on the clip speed menu).

Time Grid The color of the time grid (see “The time grid” on page 377).
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Window layouts are managed in the Window Layouts dialog on the View 
menu. The procedures are the same as when handling regular presets (for 
detailed descriptions, see “Presets” on page 65):

• To create a new window layout, set up the display as you want it (see the 
list above) and use the Window Layout dialog to name and add the new 
layout.

• To modify an existing window layout, set up the display as you want it, se-
lect the window layout in the dialog and click the Update button.

• To load an existing window layout, select it in the dialog and click Load.

Using key sequences

You can use key sequences for recalling window layouts, just as with many 
other items (see “Customizable key/MIDI commands” on page 746). This 
can be used for quick and easy window control. For example, open a sin-
gle document window, maximize it, save a window layout and assign it to a 
key sequence. Later, this key sequence can be used to maximize the active 
window only.

Setting default size and position for windows
As mentioned above, while window layouts can be used for storing the 
size and position of windows, it also stores settings for various dialog 
boxes. If you only wish to determine a default size and position for different 
types of windows (Waves, Audio Montages, Basic Audio CDs, etc.), you 
can instead use the option “Remember active window’s layout as opening 
setting” on the View menu. This is a quick and effective way of organiz-
ing your working environment the way you want it.

To set a default size and position for a certain type of window, proceed as 
follows:

1. Open or create the desired type of window.

2. Size and position it the way you like.

3. Pull down the View menu and select “Remember active window’s layout 
as opening setting”.
A dialog appears asking you to confirm the option.

4. Click “Yes” to continue.
All windows of that type will now open in this same size and position.

• Loading a window layout as described above will override this setting.
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Creating a Favorites menu
The Favorites item on the File menu allows you to assemble a list of files 
that you want to be able to open quickly – a library if you will.

• To add a file to the list, make sure its window is active and select “Add current 
document” from the Favorites-Functions submenu.

• To open a file from the list, select it.
• To clear the whole list, select Clear List from the Favorites–Functions submenu.
• To update the list so that it only lists files that actually still exist in the specified lo-

cations on your hard disk(s), select Validate List from the Favorites–Functions 
submenu.
Files that can’t be found are removed.

Customizable key/MIDI commands
In addition to the fixed key commands for selecting from menus, etc., there 
are a number of operations for which you can set up your own commands. 
You can do this in two ways:

• By specifying a key sequence – a sequence of between one to three keys 
that must be pressed in a certain order to invoke the operation.

• By specifying a MIDI command. 
You need a MIDI controller device (e.g. a MIDI keyboard or a dedicated controller device) 
connected to your PC via a MIDI interface for this to work.
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Key sequences and MIDI commands are listed and managed in the “Key-
board/MIDI Commands” dialog, opened from the Options menu.
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About the list of operations

The main part of this dialog is occupied by the list of available operations 
that can be called up via key sequences and/or MIDI commands. You can 
choose to view this list in one of two ways, with the “Sort” buttons in the 
upper right corner of the dialog:

• “Sort by Command” organizes the operations in folders, in groupings that relate 
to various sections in the program.

• “Sort by Key” lists all commands in a “flat” fashion (no folders), and sorts the list 
alphabetically via the defined key commands, which allows you to easily find a 
command assigned to a certain key.

Regardless of which mode you select, the actual available operations are 
the same, it’s just the view that changes.

The “dynamic” items in the list

Please note that the number of items in the list varies with other settings 
in the program. For example, if you have assigned key shortcuts to plug-
ins, in the Plug-in manager, they will appear in this list too. Otherwise they 
will not.

The columns

• The Description column lists the operations available.
• The next column allows you to choose between three modes that determine when 

a key sequence is available and when it is not, see “Setting enable options” on 
page 751.

• The Key column shows the Key sequence defined for the operation.
• The MIDI Event column shows any assigned MIDI commands.
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Defining key sequences

1. Select the operation for which you want to create a key sequence.

2. Click the “Key Sequence…” button.

3. If you want to clear the current key sequence, click Clear.

4. Make sure “Catch mode” is active.

5. Press the first combination of keys that you want to use.
You can include modifiers ([Shift], [Ctrl], [Alt], etc.) if you like. There is also a setting that 
makes the program distinguish between two modifiers with the same label, on each side of 
the space bar.

6. Proceed with the following key(s).

7. Disable “Catch mode”.
This is just an optional safety measure so that you don’t accidentally erase or add to your 
current key sequence, when pressing more keys.

8. Close the dialog.

It is possible to define the same key sequence for two operations. If you do, 
one of them will be invoked. To see which, select “Sort by key” and locate 
the items in the list. The top one is the one that will be used.
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Defining MIDI Commands

Before you can use MIDI commands you have to select the MIDI interface 
for incoming messages from the “Input for MIDI commands” pop-up.

1. Select the operation for which you want to define a MIDI command.

2. Click the “MIDI Event…” button.

3. If you want to clear the current MIDI command, click Clear.

4. Send the MIDI event from your controller.
Press the key or button you wish to use on your MIDI controller and the MIDI command will 
be set for the operation. Which MIDI channel you are sending over is also taken into account.

5. You have the option of specifying a “Context” for the command.
If you click “Context”, a second MIDI Command dialog is opened.

A context can be a Program change or a Note ON message. E.g. if you 
choose a Program change as context, the command will only be triggered 
if the last program change received is the one specified as the context. 
This is a way of introducing “modifier” options via MIDI messages.

6. Click OK to exit the MIDI command dialog(s) and then the Key Commands 
dialog.

7. Make sure “Enable MIDI Commands” is activated on the Options menu.
Now the MIDI function you have set up is active.

• All MIDI controllable WaveLab functions are of the “on/off” type except the 
separate Shuttle/Pitch bend function (see “Using a MIDI pitch bend wheel 
to control Shuttle” on page 144).
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Setting enable options

Once the key sequence has been defined, you may want to set the Enable 
Options for the operation. This is done by selecting from the pop-up in the 
middle column:

Excluding windows (Key commands)

This is mainly for plug-in windows. Since some plug-ins, especially from 
third-party manufacturers, have their own set of key commands, you may 
want to disable WaveLab key commands for these windows. 

Let’s say you assign a key command to “apply” in the Master Section, and 
a certain plug-in already uses the same key combination for an internal op-
eration. Then, pressing this key command might lead to the wrong opera-
tion being invoked when this plug-in has the focus.

“Exclude windows” allows you to prevent this situation:

1. Click the “Exclude windows” button.

2. Type in the name of the window in the Window exclusion list.
You can include DOS “wildcard” characters. For example to exclude all products from the 
manufacturer Waves, you can type “Waves*”.

3. Close the window.

Option Description

Enabled all the time This key sequence is always active.

Enabled if active 
window…

This key sequence can be used for all windows, except the ones 
added to the “Exclude Windows” lists, described below.

Enabled if involved
window…

This key sequence is only available if the window it is applied to has 
the focus (is active or displayed on top of all other windows).
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Using key sequences/MIDI commands

To use a key sequence or MIDI command, press the keys/buttons speci-
fied in the dialog, and the corresponding operation is performed.

Key sequences/MIDI commands can only be executed after you have 
closed the Key Commands dialog.

About some special key commands

There are some key commands that might require an explanation:

Command Description

Set focus on this 
key command group

This allows you to re-use key commands for certain groups.
For example, let’s say you set up things so that [Ctrl]+[F10] is 
the key command for setting the focus to the Master Section. 
You then assign simple key commands to the Master Section 
items, for example [A] for “Apply” and [R] for “Remove all plug-
ins”, even though these keys may be used for other sections of 
the program.
You can then Press [Ctrl]-[F10] followed by any of the single 
commands to control most aspects of the Master Section.

Bypass all defined 
key commands/
Enable all key commands

This can be used when an installed plug-in, from a third party 
manufacturer, has its own set of key commands. You can then 
temporarily disable all WaveLab key commands to be able to 
use the plug-in’s own.

Bypass all defined 
key commands but those
set to “Enabled all time”

Same as above but disables all key commands except those 
where you have set the Enable Option to “Enabled all time”.

Plug-in Slot commands To assign a certain processor to a certain slot, in the Master 
Section, you need two key sequences. Selecting a slot is done 
by a key sequence in the “Slot selection” section, and select-
ing a plug-in is done in the “Slot Commands” section.
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Organizing plug-in processors

Introduction

You may find that you need to organize your processors into sensible 
groups. Why? Well, a host of plug-ins are included with the program, and 
additional ones can be added. If you have Cubase installed on the com-
puter, even more appear in WaveLab. Also, sometimes when you install a 
package of DirectX plug-ins you get effects that are of no relevance to 
WaveLab (or even to audio) and therefore just clutter menus.

To organize how your plug-ins appear on menus in the program, open the 
“Organize Master Section plug-ins” dialog on the Options menu.

This organizes plug-ins accessed from the Master Section or Batch Processor, 
not the VST plug-ins in the Montage. Note however, that you can exclude some 
VST plug-ins completely, see “Handling VST plug-ins” on page 756.

About the plug-in list

The “Organize Master Section plug-ins” dialog

These are plug-ins that can be used in the program. They are processors, 
or effects, that can be added to the Master Section slots (see “The Effects 
pane” on page 225) or utilized from the Batch Processor (see “Setting up the 
processing tasks to be performed” on page 285).
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Groups

In the Master Section folder in the list, you will find subfolders, represent-
ing groups of plug-ins.

By organizing your plug-ins into folders, you arrange the way they ap-
pear on menus in the program. How you organize your effects is of course 
up to you, but initially, they are categorized according to their technical 
“type”, regular WaveLab plug-ins in one folder, VST plug-ins in another, 
DirectX plug-ins in yet another, etc. (see “The Effects pane” on page 225 
for more details on these types of plug-ins).

VST and DirectX plug-ins need to be in a group, whereas WaveLab plug-ins 
can be outside all groups.

The columns

• The Plug-in column displays the names of all the available plug-ins.
• The FX column determines whether a plug-in is active or not, see below.
• If the checkbox in the PM (Post Master) column is activated for a plug-in, it will be 

available for selection in the Dithering pane in the Master Section (after the mas-
ter faders in the signal path). This allows you to use separately purchased dither-
ing plug-ins and similar. See “Adding other plug-ins to the Dithering pane” on 
page 235 for more information.

• The Key column displays the key sequence defined for a plug-in.
• The Module column tells you the name of the plug-in (dll) file.

Activating and deactivating plug-ins and groups

By clicking in the FX column, you can activate/deactivate individual plug-ins 
or an entire group of plug-ins (see below for more information on groups). If 
you have plug-ins installed on your computer that you don’t want to use in 
WaveLab, this lets you disable them completely, thus reducing “menu clut-
ter”. The disabled plug-ins will still be applicable in other programs that can 
use them.

An example of this would be DirectX plug-ins. Many of these do not apply 
to audio at all and are of no relevance to WaveLab whatsoever. By dis-
abling these, you will make it easier to find the plug-ins that you really 
want to use in WaveLab.

VST plug-ins can also be excluded, see “Handling VST plug-ins” on page 756.
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Working with groups

The Master Section plug-ins can be organized into groups. This is done 
by adding subfolders to the Master Section folder and then dragging 
Plug-in icons into these folders.

When you then select from plug-in menus or display lists of plug-ins, the 
organization you have created will be reflected in the menu/list.

• To create a group, click the New Group button, enter a name and press 
[Return].
The group will initially appear at the end of the list, but when you start using it, the list will be 
resorted so that the groups are displayed in alphabetical order.

• To delete a group, select it and click Delete Group.
If the group contains any plug-ins, they will not be deleted. Instead, they will appear in the 
Master Section section, outside all other groups.

• Moving plug-ins between groups is done by dragging and dropping, just 
as when dragging files in the Windows Explorer.

• If you lose track of your changes and wish to return to the state that the 
list was in when you first opened the dialog, click Undo Changes.

• If you want to restore everything to the default “factory settings”, click 
“Set default”.

These settings are stored in the files “WaveLab/Presets/Plug-ins/PlugIn-
PrefAE.set” and “WaveLab/System/plugIns.set”. If you ever encounter prob-
lems with “lost” plug-ins, delete these files and the program will re-scan 
and build a new list of plug-ins the next time you launch it. This can also be 
achieved by clicking the “Force plugin dectection at next launch” button in 
the Preferences–VST dialog (see below).

Here, a “Dynamics” group has 
been created, which then 
appears in the Master Section.
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Handling VST plug-ins

If you have VST plug-ins installed on your computer that you don’t need in 
WaveLab, you can tell the program to ignore these on launch. This is 
done in the Preferences–VST dialog. It is possible to exclude single VST 
plug-ins, entire folders and subfolders containing VST plug-ins, and the 
“Shared VST Plug-ins” folder (if present on your system). The methods for 
doing this are all described below.

Note that unlike deactivating a plug-in in the Plug-in Manager (as described 
in the section “Activating and deactivating plug-ins and groups” on page 
754) which will only remove it from the plug-in menu in the Master Section, 
“ignoring” a VST plug-in as described below will remove it from the whole 
program, including the Montage.

Proceed as follows to set up which VST plug-ins to use in WaveLab:

• Open the Preferences dialog from the Options menu, and select the VST 
tab.

This contains the following items:

Item Description

Use VST plugin 
shared folder

If you have Cubase installed on your computer, the effects that 
were included with Cubase can also be available in WaveLab, pro-
vided that they are installed in the “Shared VST Plug-ins” folder and 
this checkbox is activated. Next time WaveLab is launched the plug-
ins in this folder will be available.

Optional extra VST 
plugin folder 
(WaveLab specific)

Here you can set a path to an “extra” VST plugin folder. As many Cu-
base plug-ins are not usable in WaveLab, you can set up a specific 
folder containing all the VST plug-ins you wish to use in WaveLab.

Ignore plugins located 
in the following folders

In this text field, you can type in the name of a folder or subfolder con-
taining VST plug-ins that you want to exclude.
If you want to exclude several folders, type in all their names, but sepa-
rate each name with a semicolon.

Do not load the 
following plugins

In this list you can exclude individual plug-ins from being loaded by 
adding them to the list. Common VST instrument plug-ins (which 
cannot be used in WaveLab) are already added to the list.

Faster graphics refresh-
ing (consumes more 
computer power)

This can be useful for plug-ins that display e.g. meters. If changed, 
this option takes effect after closing and reopening the VST plug-in 
window(s).

Force plugin detection 
at next launch

Clicking this button lets WaveLab re-scan and build a new list of all 
plug-ins next time it is launched.
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Note the following:

• If VST plug-ins you want to exclude reside in one or several subfolders inside a 
main folder, you don’t have to list all the subfolders. Excluding the main folder will 
also automatically exclude its subfolders.

• It’s not necessary to type in the entire path to a folder you want to exclude (e.g. 
C:\plug-ins\reverb). Typing just reverb will suffice, since WaveLab will look through 
the folders and subfolders on your C disk or partition upon startup, searching for the 
folder named reverb, and exclude it.

• On the other hand, if you have a main folder containing two or more subfolders 
and you only want to exclude the plug-ins in one of the folders and you also have 
another folder or subfolder with the same name as the one you want to exclude, 
you will need to type the path to the subfolder you want to exclude (e.g. C:\plug-
ins\delay).

In this case, the subfolder “Delay” in the folder “Old effects” will be excluded, but the 
subfolder “Delay” in the folder “New effects” will be included.

• Quit WaveLab and then launch the program again.
If you check the effect menus, you will find that the plug-ins in the specified folders are 
removed.

• If you change your mind and want to use the ignored plug-ins again, 
repeat the steps above but remove the folder names from the text field.
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Excluding all plug-ins

If you wish, you can temporarily exclude all plug-ins so that none will be 
available in WaveLab:

• Press and hold [Ctrl]+[Shift] when launching WaveLab.
This will disable the Master Section and prevent all plug-ins from being loaded. This can be 
useful for troubleshooting purposes – i.e. to determine whether the loading of one or more 
plug-ins is causing problems.

• If you wish to have access to the plug-ins again, activate the Master Sec-
tion.



33
Plug-in Processor Reference
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About WaveLab plug-ins
These plug-ins use WaveLab’s own plug-in format, and cannot be used 
with other applications. Note:

• As a rule, WaveLab specific plug-ins can only be used in the Master Section 
(not as track or clip effects in the Audio Montage).
However, some WaveLab effects are also included as VST plug-ins, available as track or 
clip effects in Audio Montages. This is indicated for each effect below.

• WaveLab specific plug-ins can also be used in the batch processor.

• You can specify which plug-ins should be available in the Master Section by 
using the Organize Master Section Plug-ins function on the Options menu.
This also allows you to specify which plug-ins should be available in the Dithering Pane 
(post-master fader).

• Only certain WaveLab specific plug-ins can be used as master effects when 
a multichannel configuration is used in the Montage.
Effects that can be used with multiple output channels are indicated for each effect below. 
Note that all channels in the Master Section will be affected equally.

• Presets for WaveLab plug-ins are handled like other presets in WaveLab 
(processing functions, etc.).

Auto Panner

The Auto Panner (only available in the Master Section) pans the signals 
continuously between the left and right channel in the stereo image. It has 
the following parameters:

Parameter Description

LFO Freq 
(0.1Hz~50Hz)

This parameter sets the speed of the panning. The higher the value, the 
faster the signal moves around in the stereo image. 

Width (0~100%) Use this parameter to specify the “width” of the pan movements. The 
value 100% causes the signal to move from the extreme left to the ex-
treme right, while 0% disables the panning effect.

Waveform
(Sine, Pulse)

Allows you to specify the way in which the signal moves from left to 
right. Select Sine if you prefer fluid movements, or Pulse to create 
abrupt panning “jumps”.

Out Left, Out Right 
(-96dB~6dB)

These two parameters allow you to adjust the level of the left or right 
channel, useful e.g. for correcting the stereo image or adjusting the 
overall gain. The setting 0dB means no change of level, while -96dB 
means turning the channel off completely.
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Chorus

The Chorus plug-in (only available in the Master Section) is a classic ste-
reo chorus based on a sweeping delay, with the following parameters:

Parameter Description

Delay (0.1~60ms) Use this parameter to specify the basic time delay for the chorused sig-
nal with respect to the “dry” signal. The higher the value, the more pro-
minent the effect. Low settings (up to 7ms) create flanger-like effects. 
Settings up to 25ms are for classic chorus while settings above this 
value are mainly for special effects.

Width (0~100%) Use this parameter to specify how much the delay time is allowed to 
vary with the modulation. It is this variation in delay time that causes the 
sweeping effect. Note that the value 0% should probably be avoided 
since it might create the impression that you are experiencing phase 
problems.

Frequency 
(0.01~25Hz)

The Frequency parameter sets the speed of the sweep (the modula-
tion). The higher the value, the faster the modulation. You will probably 
not use values above 7Hz except for special effects.

Feedback 
(0~100%)

This parameter specifies how much of the output from the effect is fed 
back to the input (the feedback signal is also phase inverted). The 
higher the value, the more prominent the effect. At short delay times, this 
creates a flanger-like effect. At larger settings it creates more of a slap-
back repetition type of sound.

Fb Balance 
(0~100%)

Use this parameter to set the volume of the Feedback signal (see 
above) in the mix. If this is set to 100%, and combined with a Feedback 
setting between 65% and 100%, the effect goes into self-oscillation.

Glimmer 1, 
Glimmer 2 
(0~100%)

The two Glimmer parameters allow you to specify to what extent the 
Chorus signal should move around in the stereo image. They work in 
more or less the same way as the Auto Panner but only apply to the 
Chorus signals. Glimmer 1 processes the right channel signal, while 
Glimmer 2 processes a combination of the left and right channels (the 
actual left channel always remains at 0).

Stereo Spread 
(0~100%)

This parameter specifies the width the Chorus effect will occupy in the 
stereo sound image. The value 0% creates a mono impression, and 
since left and right channel signals are then mixed together, the Chorus 
becomes louder.

Mix (0~100%) Use this parameter to specify the balance in level between the dry and 
the delayed signal. The value 0% means that only the dry signal will be 
heard, while 100% actually means a 50/50 mix between dry and effect 
signal.

Output Lev
(-48dB~0dB)

This is an attenuator that allows you to reduce the output level of the 
Chorus effect, avoiding clipping and hence distortion. If the Clip indica-
tor lights up continuously, lower this value.
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Crystal Resampler

The Crystal Resampler plug-in (only available in the Master Section) is a 
professional sample rate converter providing exceptional transparency 
and preservation of the frequency content:

Echo

The Echo plug-in (only available in the Master Section) is a stereo echo 
effect with two separate delay lines. It has the following parameters:

Parameter Description

Sample Rate (6 - 
384 kHz)

This defines the output sample rate while the input sample rate is deter-
mined by the sample rate of the active audio file or Audio Montage.

Quality (Preview 
(fast), Standard, 
High, Ultra (slow))

This defines the quality of the algorithm which is used. In Preview mode 
the CPU load is much lower than in Ultra mode but as ta trade off the 
sonic quality of the resulting audio is also lower.

Parameter Description

Delay 1 
(0.5~1000ms)

This sets the delay time of Delay 1, with respect to the incoming signal. 
Please note that the minimum value (0.5ms) creates an out-of-phase 
impression.

Feedback 1 
(0~100%)

This sets the amount of delayed signal fed back into the Delay 1 block, 
to create repetitions. The value 100% means that the echo signal is re-
peated indefinitely, while 0% means there is only one repetition.

Link 1-2 
(Off, Linked)

Select Off if you wish to use Delay 1 and Delay 2 as two independent 
blocks. Select Linked if the output of Delay 1 is to be connected to the 
Input of Delay 2.

Delay 2, Feedback 2 See Delay 1 (0.5~1000ms) and Feedback 1 (0~100%) above. These 
parameters are identical to these but apply to the second Delay block.

Del. Balance 
(0~100%)

This sets the stereo width of Delay 1 and Delay 2. When set to 100%, 
Delay 1 is assigned to the left channel, while Delay 2 is assigned to the 
right channel. The value 0% means that both Delay blocks are spread 
across the stereo field.

Vol Left, Vol Right 
(-96dB~0dB)

Use these parameters to correct volume imbalances brought about by 
the Delay effects. These parameters only apply to the Echo effect, the 
dry signal is not affected by these settings.
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EQ-1

EQ-1 is available both as a VST and a WaveLab plug-in. It can be used as 
a clip or track effect in the Audio Montage, or as a global effect in the 
Master Section (including multichannel configurations). 

This is a three-band equalizer with high and low shelving filters and a full 
parametric mid-frequency band. You can turn off each band separately by 
clicking the corresponding button, making it easy to compare the signal 
with and without EQ. The following parameters are available:

• WaveLab also includes the “Q” equalizer plug-in, which offers two full-para-
metric EQ bands and additional features. 
As always, which equalizer to choose depends on your needs in the given situation.

Parameter Description

High Gain Determines the boost or cut (in dB) of the high shelving filter.

High Frequency Sets the frequency of the high shelving filter. Frequencies above this 
value will gradually be increased or reduced in level, according to the 
High Gain setting.

Mid Gain Determines the boost or cut (in dB) of the mid band EQ.

Mid Frequency Sets the center frequency of the mid band eq. Frequencies around this 
value will be affected by the Mid Gain.

Mid Q Use this parameter to set the width of the Mid band, e.g. how wide a fre-
quency range around the Mid Frequency should be affected by the mid 
band EQ. The higher this value, the “narrower” the mid band.

Low Gain Determines the boost or cut (in dB) of the low shelving filter.

Low Frequency Sets the frequency of the low shelving filter. Frequencies below this 
value will gradually be increased or reduced in level, according to the 
Low Gain setting.
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Leveler & Leveler Multi

This plug-in is available both as a VST and a WaveLab plug-in. It can be 
used as a clip or track effect in the Audio Montage, or as a global effect in 
the Master Section. 

Leveler Multi is adapted to handle multichannel configurations and can be 
used to change the level of all channels in the Master Section.

This “effect” simply reduces or boosts the signal level. This is useful for 
matching levels between effects. You may want to patch in the Leveler af-
ter an equalizer plug-in, for example. The parameters consist of volume 
settings for the left and right channels, and a Stereo Link setting (when 
activated, the Volume Left parameters control the level of both channels). 
Finally, a Mix to mono setting allows you to mix an incoming stereo signal 
to mono (much like the Mono button in the Master Section).

Noise Gate

This plug-in is available both as a VST and a WaveLab plug-in. It can be 
used as a clip or track effect in the Audio Montage, or as a global effect in 
the Master Section (including multichannel configurations).

The Noise Gate plug-in mutes any signal that falls below a specified 
threshold level. This can be useful for removing unwanted residual noise 
from audio material without having to manually clean up or mute sound-
files. Other applications include gating reverb “tails” and tightening per-
cussion tracks.

Parameter Description

Threshold
(-144~-12dB)

This setting determines at what level the Noise Gate is activated. Any 
signal or portion of a signal that falls below the chosen threshold will be 
muted.

Rel Time 
(1~5000ms)

Determines how long the gate stays open after a signal below the 
Threshold level has been detected.

Rel Sens (1~100) This setting is used to prevent the gate from being triggered on/off inad-
vertently when the signal is close to the threshold level.

Attack Sens 
(1~100)

Determines the time it takes for the gate to open. A low setting provides 
a fast transient response but a high setting will soften or mute the early 
portion of the sound which is triggering the gate.
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Peak Master
This plug-in is available both as a VST and a WaveLab plug-in. It can be 
used as a clip effect in the Audio Montage, or as a global effect in the 
Master Section (including multichannel configurations). This plug-in pro-
vides a safe and transparent way of boosting the perceived loudness of 
audio material. By limiting transients and simultaneously raising the ge-
neral level by compression, the Peak Master will increase the subjective 
loudness of the signal without risk of distortion inducing peaks.

Puncher
This plug-in is available both as a VST and a WaveLab plug-in. It can be 
used as a clip or track effect in the Audio Montage, or as a global effect in 
the Master Section (including multichannel configurations).

The Puncher plug-in generates additional harmonics which are added to 
the audio material. The result is a more dynamic, and “punchier” sound, 
particularly when applied to drums and percussive material. Compared to 
the Peak Master the Puncher plug-in could be described as operating in 
almost the opposite way. Puncher leaves quieter parts untouched but will 
add power to the louder portions without causing clipping. The plug-in is 
optimized for peak signal levels between 10 and 0dB, the closer to 0dB, 
the better.

Parameter Description

Input Gain
(-12~+24dB)

This allows you to adjust the input level to Peak Master. Use this to 
(typically) raise the loudness of the signal. Use extreme boost settings 
with caution as they can induce distortion.

Out Ceiling
(-18~0dB)

This setting determines the maximum level at the Peak Master outputs.

Softness (-5~5) This parameter affects the way the Peak Master operates. A high setting 
will maximize the perceived loudness effect but can in some cases re-
sult in a slight harshness of the sound. Adjust this parameter to optimize 
the balance between sound quality and the desired effect.

Parameter Description

Density (Soft, Me-
dium, Hard)

The difference between these 3 settings lies in the number of added 
harmonics. The setting you use depends on the audio material.

Effect (0~100%) This adjusts the balance between the processed and the dry signal.

Input Gain
(-12~24dB)

This sets the input level. Boosting the signal may cause clipping, so use 
this with caution. With no boost, Puncher will never cause clipping.
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ReSampler

The Resampler (only available in the Master Section) plays back the file at 
another sample rate. This is similar to the Convert Sample Rate function. 
However, since the ReSampler processor operates in real time, it lets you 
play back files at a certain sample rate, regardless of which rate they were 
recorded at. Please note that if your files already match the card’s sample 
rate, you do not need to use this processor at all.

One situation where this processor is extremely useful is when you are 
mastering digitally to a certain sample rate.

Resizer

The Resizer plug-in (only available in the Batch Processor) is a simple but 
useful plug-in allowing you to specify a set length for all files in the batch.

Simply set a desired Duration time using the slider.

If “Add silence” is on, silence will be added to all files shorter than the set 
Duration time to make them the exact length specified.

StereoExpander
The StereoExpander plug-in (only available in the Master Section) nar-
rows or enlarges the stereo width of an existing stereo signal. This is set 
by the single “Width” parameter. 

A value of 0% produces two equal output channels (the original stereo 
image is lost). Values between 1 and 49% correspond to a narrower ste-
reo image. A value of 50% corresponds to the original signal. Values be-
tween 51 and 100% enlarge the stereo image.

Parameter Description

Freq 11~192 kHz This is used to set the desired sample rate.

Quality (Low, 
Medium, High)

The higher the quality, the more computer processing power is required. 
The option you select here depends largely on the processing capabili-
ties of your computer and the other effects you are using.

Fine The Fine control allows you to set any sample rate between the fixed 
settings of the Freq parameter. The current setting is indicated by the 
“kHz Output” display to the right.
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Silence
The Silence plug-in (only available in the Master Section) lets you add si-
lent portions at the start and/or end of a file. This can be useful for exam-
ple in conjunction with effects such as reverb and delay which produce 
audio “tails” – i.e. the sound of the effect lingers after the end of the file – 
since the sound of the effect would otherwise be muted at the end of the 
file. To remedy this, just place the Silence plug-in before the other plug-in 
in the Master Section and specify the length of the silent portion as nec-
essary, so that the sound of the effect is allowed to decay naturally.

The Silence plug-in only has two parameters which let you define the 
length of the silent portions at the start and end of the file. Silence can be 
used for multichannel configurations.
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VST Plug-ins

About VST Plug-ins

These plug-ins use Steinberg’s widely adapted VST plug-in format. As a 
rule, VST plug-ins can be used by any VST-compatible application, al-
though some plug-ins may still be limited to use with certain programs. 
Note:

• VST Plug-ins can be used in the Master Section (but not for multichannel 
configurations) or as track or clip effects in the Audio Montage.
The only exception to this is the “Ducker” effect, which can only be used as a clip effect.

• As with WaveLab plug-ins, you can specify which VST plug-ins should be 
available in the Master Section by using the Organize Master Section Plug-
ins function on the Options menu.
This also allows you to specify which plug-ins should be available in the Dithering Pane 
(post-master fader).

• It’s also possible to exclude VST plug-ins completely from WaveLab, 
thereby removing them from the clip and track effects lists as well.

• VST plug-ins have their own preset handling. 
When you click the Preset button for this type of effect, a pop-up menu appears, allowing 
you to save or load effect programs (presets) or complete banks containing several pro-
grams.

Autopan

The AutoPan plug-in pans the signals continuously between the left and 
right channel in the stereo image. It has the following parameters:

Parameter Description

LFO Freq 
(0.1Hz~10Hz)

This parameter sets the speed of the pan movements. The higher the 
value, the faster the processed signal moves around in the stereo 
image. 

Width (0~100%) Use this parameter to specify the “width” of the pan movements. Setting 
this to its maximum value causes the signal to move from the extreme 
left to the extreme right, while lowering it completely disables the pan-
ning effect.

Waveform Determines the shape of the panning curve. Available curve shapes are 
Sine, Triangle, Sawtooth, and Pulse.

Out Levl The stereo output level of the effect.
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Choirus2

Choirus2 is a chorus effect, used for making the sound “warmer”, etc. It 
has the following parameters:

Parameter Description

Time Use this parameter to specify the basic time delay for the chorused sig-
nal with respect to the “dry” signal. The higher the value, the more pro-
minent the effect. Low settings create flanger-like effects, medium 
settings provides classic chorus while higher settings are mainly for 
special effects.

Width Use this parameter to specify how much the delay time is allowed to 
vary with the modulation. It is this variation in delay time that causes the 
sweeping effect. Note that the value 0% should probably be avoided 
since it might create the impression that you are experiencing phase 
problems.

Lfo Freq The Frequency parameter sets the speed of the sweep (the modula-
tion). The higher the value, the faster the modulation. You will probably 
not use higher values (above 7Hz) except for special effects.

Feedback This parameter specifies how much of the output from the effect is fed 
back to the input (the feedback signal is also phase inverted). The 
higher the value, the more prominent the effect. At short delay times, this 
creates a flanger-like effect. At larger settings it creates more of a slap-
back repetition type of sound.

Feed Bal Use this parameter to set the volume of the Feedback signal (see 
above) in the mix. If this is set to 100%, and combined with a Feedback 
setting between 65% and 100%, the effect goes into self-oscillation.

Glimmer 1, 
Glimmer 2 

The two Glimmer parameters allow you to specify to what extent the 
Chorus signal should move around in the stereo image. They work in 
more or less the same way as the Auto Panner but only apply to the 
Chorus signals. Glimmer 1 processes the right channel signal, while 
Glimmer 2 processes a combination of the left and right channels (the 
actual left channel always remains at 0).

Out Levl The stereo output level of the effect.
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CleanComp

CleanComp is a simple compressor that allows you to limit loud sounds, 
while at the same time boosting the overall loudness of the audio material.

DeClicker

The DeClicker plug-in is specifically designed to eliminate single “clicks” 
or “pops” in a recording. One typical application is to clean up recordings 
made from vinyl records, but you may also find it useful for removing pops 
from microphone switches, oxidized connector noises, clicks from sync 
problems when transferring material digitally, etc.

• Note that the DeClicker module is not optimized for crackles (a series of 
short clicks).
However, as it is often hard to distinguish between clicks and crackles, you might also be 
able to use it to improve your recording in this respect.

• If the recording also contains background noise (hiss), you may want to 
combine DeClicker with the DeNoiser plug-in.

How DeClicker works

The Declicker process is divided into two steps:

• Analysis – when the audio signal passes through DeClicker, the selected analysis 
algorithm finds the clicks in the recording. You provide input to the analysis pa-
rameters by selecting a Mode and the Threshold and DePlop parameters.

• Removal – a de-click algorithm is applied to the audio, removing the clicks.
In many cases, the original audio material “hidden” underneath a click cannot be restored. 
This means there will be a gap once the click has been removed. DeClicker has the ability 
to automatically “redraw” the hence missing parts of the waveform. This feature can also be 
used to remove tape dropouts with a length of up to 60 samples (just above one millise-
cond at 44.1kHz).

Parameter Description

Ceiling (0dB~-24) This setting determines the maximum level at the CleanComp outputs.

Softness (-5~5) This parameter affects the way CleanComp operates. A high setting will 
maximize the perceived loudness effect but can in some cases result in 
a slight harshness of the sound. Adjust this parameter to optimize the 
balance between sound quality and the desired effect.

Out Gain 
(0~+24dB)

This allows you to adjust the output level from CleanComp. Use this to 
(typically) raise the loudness of the signal. Use extreme boost settings 
with caution as they can induce distortion.



WAVELAB
Plug-in Processor Reference 33 – 771

The whole Declicking process can be visually monitored in the Input and 
Output displays of the DeClicker window (showing the incoming audio 
and the processed - DeClicked - audio, respectively). This helps you to 
adjust the parameters. Furthermore, if you activate the Audition button, 
only the removed material will be heard (and shown in the Output display).

Make sure that no low-pass filter has been applied to your audio material 
before you edit it with DeClicker. This may affect the detection of clicks.

Parameters

Parameter Description

Audition button When this is activated, only the removed material will be heard. The 
Output display will also show the waveform image of the removed mate-
rial in this mode.

Classic When this is activated, the DeClicker attempts to remove both audible 
clicks and crackle noise. When it’s deactivated, only single clicks will be 
removed while crackles (rapidly repeated clicks) are ignored. Which 
mode to choose depends on the source material. Note also that Classic 
mode requires less CPU power.

Threshold This setting determines the amplitude (level) required for a click to be 
detected. In many cases, DeClicker’s sensitive algorithms identify a lot 
more clicks than you can actually hear. To avoid wasting processing 
power to remove inaudible clicks, raise this parameter to a high value, 
and then lower it until all the artefacts that you actually want removed 
are detected. The lower the setting, the more clicks will be detected but 
also the higher the risk of audible artefacts. If in doubt, activate Audition 
mode and check that the removed material doesn’t contain any actual 
musical or rhythmical information, etc.

DePlop This setting controls a special highpass filter which works on signals 
below 150 Hz. It cuts away the “plop noise” which sometimes appears 
after eliminating a click. The slider adjusts the filter frequency (off - 150 
Hz).
Note: This function is best applied to older recordings, which often use 
a narrow frequency range. Be careful when applying this function to 
modern recordings, as you may risk removing parts of the useful signal! 

Quality This determines the quality of the click removal and audio restoration, 
with “4” being the best quality setting. Please note that selecting higher 
quality settings also means that more processing power is consumed.
Also, note that in some situations it might be more productive to use a 
lower Quality value. One example of this is when two clicks follow each 
other in quick succession or when you tackle a click in a low level part 
that is followed by a loud part.
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Tips and Tricks

• By combining Vintage Mode and extreme Threshold and DePlop settings, you 
can create an interesting effect which “softens” material with particularly sharp at-
tacks, e.g. percussion or brass.

• If you have material with digital distortion (clipping), try applying DeClicker. While 
it can’t do miracles, it can at least make some improvement to the overall “hard-
ness” introduced by the distortion.

DeNoiser

The DeNoiser plug-in lets you suppress noise without affecting the ge-
neral sound quality. Or, in tech talk, the DeNoiser removes broad band 
noise from arbitrary audio material without leaving any “spectral finger 
print”. The algorithm that this plug-in is based on has the ability to track 
and adjust itself to variations in background noise. This means the noise 
can be diminished without side effects, preserving the spatial impression, 
and without letting the result become “colorless”. Many years of research 
were invested in developing the methods used.

Typical applications for the DeNoiser include cleaning or remastering re-
cordings from old tape or vinyl, or noisy live recordings.

How DeNoiser works

DeNoiser is based on spectral subtraction. Each section of the frequency 
spectrum that has an amplitude below the estimated noise floor, is re-
duced in intensity by use of a spectral expander. The result is a noise re-
duction that does not affect the phase of the signal. 

Mode Which Mode to select depends on the source material. Standard mode 
is suitable for a wide variety of source material - try this option first. Vin-
tage mode is suitable for restoring “antique” recordings (with limited 
high frequency content), while Modern mode is best suited for contem-
porary recordings with a wide frequency range (putting greater empha-
sis on distinguishing clicks from other strong impulses in the audio 
material).

Bypass This will bypass the effect, allowing you to compare the DeClicked and 
unprocessed material.

Parameter Description
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The figure below shows the signal flow:

The solid line represents the actual audio signal, while the dotted lines represent control 
signals

The signal is continuously analyzed by the first module in the chain, to es-
timate the noise floor at any given time. This is sufficient when the noise 
level is constant or modulates slowly. When the noise level varies rapidly, 
the Ambience and Transient analyses help adjust the response of the 
noise reduction unit, allowing transient-rich material to maintain its liveli-
ness and natural ambience.

• When you process audio in DeNoiser, the plug-in will need a short time 
(less than a second) to analyze the material and set its internal parameters.
Since you would not want to include this short “startup sequence” in the final result, you 
should make it a habit to first play back a short section of the audio, thereby letting De-
Noiser “learn” the noisefloor, and then stop and start over again from the beginning. The 
plug-in then remembers the settings internally.

The Noisefloor Display

The display to the left in the DeNoiser window is crucial when making set-
tings. It contains the following three elements:

• The dark green spectral graph.
This shows the spectrum of the audio currently being played back. The horizontal axis 
shows the frequency (linear scale). The low frequencies are visible on the left side, the high 
ones on the right side. The vertical axis shows the signal amplitudes, thus the level (dis-
played as a logarithmic dB scale).

• The yellow line.
This is a spectral estimation of the noise floor. The average of this value is shown numeri-
cally below the display.

Noise 
Reduction

Noise Floor Ambient 
Analysis

Transient 
Analysis

Input Output

Level

Noise Reduction

Ambience
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• The light green line.
This is simply a graphic representation of the Offset parameter.

The light green Offset line should be adjusted so that it appears as close 
above the yellow noise floor graph as possible. The dark green spectrum 
plot is there to help you fine-tune the Offset setting, so that only the noise 
is removed, not parts of the signal (ideally, the light green line should be 
between the yellow line and the spectrum plot).

Parameters

Parameter Description

Freeze If you activate this button, you “freeze” the noise floor detection pro-
cess. The yellow noise floor graph in the display will hold its current 
value (as will the numeric noise floor value display below) until you de-
activate Freeze. This allows you to take a closer look at the readings.

Reduction Governs the amount of noise reduction. The display below this fader 
shows the amount of dB by which the noise level is being reduced. The 
final result also depends on the Ambience parameter, and on the auto-
matic Ambience and Transient analysis of the original material, as de-
scribed above.

Ambience This parameter is used to specify a balance between the noise suppres-
sion and the amount of natural ambience, which is essential for a natural 
result. With a low Ambience setting, the sound can become somewhat 
lifeless and sterile. A high setting, on the other hand, preserves more of 
the ambient character of the sound, but the noise suppression is less 
effective.

Offset This parameter serves as a threshold, governing the overall level at 
which the noise reduction is performed. For optimal noise reduction 
with a minimum of sound coloration, this parameter should be set to a 
value slightly above the noise floor level. To help you do this, the offset 
value is shown as a light green line in the noisefloor display, while the 
noise floor is shown as a yellow line.

A/B/Store These are described below this table. 

Classic When this is activated, a less CPU-intensive version of the DeNoiser al-
gorithm is used. Use Classic mode if you are short on processing 
power. However, for optimum noise suppression, we recommend that 
you deactivate Classic mode.

Bypass When this is activated, the signal passes through the plug-in but you 
don’t hear the results of the processing. Use this to compare the sound 
with and without processing. Note: the analysis is always performed, re-
gardless of the Bypass switch. This allows you to monitor the noise 
floor, spectrum and level in the spectrum display.
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Using the A/B setups

With the A/B buttons you can make instantaneous switches between two 
different DeNoiser setups, allowing you to quickly try out and compare 
different configurations. You can also use this feature for separate set-
tings for two different sections of an audio recording. Proceed as follows:

1. Make the settings you want for setup A.

2. Click on [Store] and then on the [A] button.

3. Make the settings you want for setup B.

4. Click on [Store] and then on the [B] button.
Now the two setups are stored, and you can switch between them simply by clicking [A] or 
[B].

Ducker

This is a special VST plug-in that can only be used as a Montage clip ef-
fect. 

It uses the “Route to Upper Track” feature which can be found on the 
Track menu. The Ducker is a plug-in that can control (modulate) the vol-
ume of clips placed on a track with the signal of one or more clips placed 
on the next adjacent track below it. Let's say you have a clip containing 
music, and you want to add a voice-over to that clip. First place the music 
clip on track 1 and assign the ducker plug-in to this clip. Then place the 
voice-over clip(s) on track 2. On the Track menu (for track 2), select the 
“Route to Master Section and Upper Track” item. Now the signal of track 
2 will be sent to the Master Section as usual, but also to the Ducker plug-
in on track 1. The clip volume on track 1 will now be automatically lowered 
by the Ducker whenever there is a signal (in this example the voice-overs) 
on track 2, and raised again when the signal stops. Note that it is possible 
to use mono or stereo tracks for both the modulating and the upper track.

Parameter Description

Threshold This sets the loudness threshold that will trigger the Ducker. Clips on 
the modulator track with levels above the threshold will cause the level 
of a clip on the upper track to be lowered. 

Damping This sets the amount of level reduction that is applied to the clip on the 
upper track.

Fall Time This sets the time it takes for the level to change from 0dB to the set 
damping level.
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Externalizer

The Externalizer is a plug-in designed for headphone monitoring. It im-
proves the sound and stereo localization by simulating the effect of two vir-
tual speakers in an ideal listening position. A common problem when 
listening to music through headphones is the phenomenon known as “in-
head localization”. This means that each sound source appears to be lo-
cated inside your head, on an imaginary line between the ears. Naturally, 
this is no place where a sound source would ever be situated, and the re-
sult is therefore perceived as unnatural. However - headphone monitoring 
doesn’t have to be this way! Anyone who has listened to binaural record-
ings, those made with a “dummy head” and two microphones, will confirm 
this, and will probably remember the transparent and natural sound impres-
sion for a very long time. Steinberg Externalizer provides this experience 
with any audio material, by recreating the effect of two virtual speakers in 
an ideal listening position. This will transform any recording into something 
that is a pleasure, rather than a pain, to listen to on headphones. 

Since the Externalizer window only has one control, it is very simple to 
use:

Listen to a stereo recording in your headphones and use the fader to ad-
just the sound to your liking. When you raise the fader, you will gradually 
move the virtual speakers apart and away from your head, as indicated in 
the display.

Hold Time When the modulating signal falls below the set threshold, this setting 
determines how long the level will stay reduced before it starts rising to 
normal level again.

Rise Time Controls how long it takes for the reduced level to rise to normal level 
when the modulating signal falls below the set threshold (after the Hold 
time). 

Mix Mode If this is activated, the Ducker will output a mix of the two tracks. This is 
only useful if the “Route to Upper Track only” mode has been selected 
for the modulating track. Then this feature can be used for processing 
several clips through the same plug-in chain, if more plug-ins have been 
assigned after the Ducker on the upper track. Note that the mixed out-
put is controlled by the upper track. If this is not playing a clip, both of 
the tracks will be silent.

Parameter Description
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MultiBand Compressor

This is a high-quality multi-band compressor, especially suited for profes-
sional mastering. It will split the signal into up to five frequency bands, and 
process each band with its own freely adjustable compressor character-
istic. 

The MultiBand Compressor window is divided into two main sections: the 
Frequency Band editor and the Characteristic display. You can specify 
the level, bandwidth and compressor characteristics for each band by us-
ing the various controls.

The Frequency Band editor

The Frequency Band editor is where you set the width of the frequency 
bands as well as their level before compression. The horizontal value scale 
below the Frequency band display indicates the frequency with the maxi-
mum value corresponding to half the current sample rate. The vertical 
value scale indicates the level setting (in dB) of each frequency band.

• You can drag the diamond-shaped handles at the bottom to adjust the 
frequency range occupied by each band.
To add a new band (up to the maximum of five bands), drag the leftmost or rightmost fre-
quency handle towards the middle of the display. Similarly, to remove the lowest or highest 
frequency band, drag its upper or lower frequency handle, respectively, to the very edge of 
the display.

If you hold down the [Shift] key and click on a frequency handle, all bands will be set to the 
same bandwidth (in octaves). The exact bandwidth depends on the number of bands cur-
rently used.

• By dragging the diamond-shaped handles on top of each frequency band 
you can cut or boost the input gain by +/- 12dB before compression.
To reset a Level handle to 0 dB, hold down the [Shift] key on your computer keyboard and 
click on the handle.

For both types of handles, you can hold down [Ctrl] and drag to change 
the values in smaller steps.
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The Characteristic display

By adding breakpoints and drawing curves you set the compressor cha-
racteristic. Before you start using the Characteristic display, you have to 
select the frequency band you want to process. This is done in the Fre-
quency Band editor by clicking in the area inside the frequency band. 

A selected band is highlighted for editing both in the Frequency Band edi-
tor and the Characteristic display. If you select another frequency band, the 
previously edited characteristic is still shown in the Characteristic display, 
but it is no longer highlighted, and is editable only when you select it again.

To edit the compression curve for the selected frequency band, you add 
and adjust breakpoints in the Characteristic display.

• Clicking anywhere on the line will add a breakpoint.
• To remove a breakpoint, hold down [Shift] and click on it.
• The first breakpoint at which the line deviates from the straight diagonal will be 

the threshold point. 
• Creating a curve in the area below the diagonal input/output line will cause com-

pression. Compression decreases the output level in relation to the input level.
• Creating a curve in the area above the diagonal input/output line will cause ex-

pansion. Expansion increases the output level in relation to the input level.

Additional parameters

Parameter Description

Solo switch This switch is located above the Frequency bands editor window. You 
can use it to separately monitor each of the frequency bands. This func-
tion is useful both when editing bandwidth settings and compressor 
characteristics. To select another band while solo is active, click some-
where in the (dark) area of the frequency band that you wish to monitor.

Compressor Type Classic mode works like a standard compressor with fixed attack and 
release parameters. Complex mode features a new compression ap-
proach with a program adaptive circuit. The program adaptive compres-
sion automatically optimizes parameters according to the audio material.

Output The Output dial controls the total output level that the MultiCompressor 
passes on to WaveLab. The range available is +/- 12 dB. If the Soft 
Clip function (see below) is active, the Output dial instead controls the 
amount of soft clipping. 

Soft Clip The Soft Clip function is positioned at the very last stage of the internal 
signal path, right after the Output dial. When active, it will ensure that 
the total output to WaveLab never exceeds 0 dB. It works by clipping 
the signal gently, generating harmonics which add a warm, tube-like 
characteristic to the signal.
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NaturalVerb

NaturalVerb is a high-quality reverb that adds ambience, or room-quality, 
to the sound. In addition to the standard size and decay parameters, Na-
turalVerb also features low- and high-pass filters, plus a gate for gated re-
verb effects.

To change the parameters, either drag the sliders up and down, or click in 
a slider area to set the slider. If you hold down [Shift], you can change the 
parameters with a higher degree of precision. If you hold down [Ctrl] and 
click in a slider area, the slider is reset to its default value.

If you click on the logo a diagram of the signal-chain is shown. The follow-
ing parameters are available:

Parameter Description

Pre-Delay This governs the start time of the first “early reflection”, i.e. how the 
sound is “bounced” off the walls in the simulated room environment. The 
value range is 0-100 milliseconds. The lower the value, the sooner the 
early reflection is heard. 

HPF This is a high-pass filter that only affects the reverb signal into the Natu-
ralVerb, not the original audio signal. A high-pass filter lets high-fre-
quency signals through while cutting off low-frequency signals. The 
slider allows you to set the frequency for the filter, and only sounds 
above the set frequency will be heard.

LPF This is a low-pass filter that only affects the reverb signal into the Natu-
ralVerb, not the original audio signal. A low-pass filter lets low-fre-
quency signals through while cutting off high-frequency signals. The 
slider allows you to set the frequency for the filter, and only sounds be-
low the set frequency will be heard.

Room Size This regulates the size of the simulated room, and thereby the spacious-
ness of the reverb. The value range is 1-30, and the higher the value you 
specify, the bigger the room. 

Decay This lets you specify the length of the reverberation. The value range 
goes from 26 milliseconds to 11.63 seconds.

Damping Damping can be used for attenuating the high frequencies of the reverb, 
thereby creating a softer, warmer sound. The higher the value, the more 
the high frequencies will be attenuated.
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Stereo Mix This parameter is used for balancing the reverb signal between the left 
and right channel inputs to the NaturalVerb. The value range is 0-100%. 
A setting of 0 means that the reverb signals for both channels are com-
pletely independent of each other (default), while a setting of 100 
means that the reverb signals for both channels are equally mixed with 
each other (50/50). In between these, settings from 1-99% mean that 
each channel signal will contain that percentage of the other channel’s 
signal. 

Wet/Dry This regulates the balance between the effect sound (wet) and the orig-
inal, unprocessed audio signal (dry). If the slider is in the middle position 
(default), the output will be balanced equally. With higher values, the 
original signal will be more pronounced, and with lower values, the ef-
fect sound will be more dominant.

Gate button Clicking this button turns the Gate section on and off. Gating cuts off 
signals below a certain set threshold level. That is, the Gate only opens 
to let signals above the set threshold through. Note that the three sliders 
directly above this button (Sensitivity, Threshold and Fade-Out) control 
the Gate effect, and therefore have no functionality when this button is 
in the Off position. Also note that the Gate only affects the reverb, not 
the original audio signal.

Sensitivity This parameter determines how fast the Gate will open to let a trigger 
signal pass. The value range is 1-100 milliseconds. In order for this to 
have any effect, the Gate button must be in the On position.

Threshold This is used for setting the reference signal level (in dB) for the Gate. 
Signal levels above the set threshold open the Gate and pass through, 
but signal levels below the set threshold close the Gate and are cut off. 
In order for this to have any effect, the Gate button must be in the On 
position.

Fade-Out This parameter determines how long it should take for the Gate to close 
again after being triggered to let a signal through. The value range is 0-
200 milliseconds. With higher values, more signal “residue” will be al-
lowed to pass through the Gate before it closes, thereby producing a 
smoother cut-off. In order for this to have any effect, the Gate button 
must be in the On position.

Parameter Description
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Q

Q is a high-quality 4-band parametric stereo equalizer with two fully para-
metric midrange bands. The low and high bands can act as either stan-
dard shelving filters or fixed-gain high/low-cut filters.

Making settings

1. Click the corresponding On button below the EQ curve display to acti-
vate any or all of the Low, Mid 1, Mid 2 or High equalizer bands.
When a band is activated, a corresponding EQ point appears in the EQ curve display.

2. Set the parameters for an activated EQ band.
This can be done in several ways:

• By using the knobs.
• By clicking a value field and entering values numerically.
• By using the mouse to drag points in the EQ curve display window.

By using this method, you control both the Gain and Frequency parameters simultaneously. 
The knobs turn accordingly when you drag points. In addition, if the Mid 1 and Mid 2 bands 
(M1 and M2) are activated there will be two points on each side of the Gain/Frequency 
point that control the width (Q) parameter.

If you press [Shift] while dragging, values can be set in finer increments.

Parameters

Parameter Description

Low Freq
(20-2000Hz)

This sets the frequency of the Low band.

Low Gain (+/-20dB) This sets the amount of cut/boost for the Low band.

Low Cut If this button is activated for the Low band, it will act as a Low Cut fil-
ter. The Gain parameter will be fixed.

Mid 1 Freq 
(20-20000Hz)

This sets the center frequency of the Mid 1 band. 

Mid 1 Gain 
(+/- 20dB)

This sets the amount of cut/boost for the Mid 1 band.

Mid 1 Width 
(0.05-5.00 Octaves)

This sets the width of the Mid 1 band, in octaves. The lower this value, 
the “narrower” the bandwidth.

Mid 2 Freq
(20-20000Hz)

This sets the center frequency of the Mid 2 band. 

Mid 2 Gain
(+/- 20dB)

This sets the amount of cut/boost for the Mid 2 band.
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Spectralizer

The Spectralizer is a type of audio “enhancer” or “exciter”. It can be put to 
many uses:

• To restore lost harmonics in a recording.
• To improve the clarity and transparency of a recording.
• To make a recording sound “warmer”.

How Spectralizer works

Most audio equipment introduces a slight low-pass filtering to the audio 
signal. This means you lose “high end” or “clarity”. The lost high frequency 
components often have a level close to the noise floor. This means that 
simply using EQ to boost the high frequencies does not create the de-
sired effect – the noise is amplified as much as the signal.

Spectralizer can actually re-synthesize lost harmonics based on existing 
lower frequencies in the material. This can create an acoustically more 
pleasing result than EQ-ing.

Spectralizer basically works by generating 2nd and 3rd harmonics or 
overtones. 

Mid 2 Width 
(0.05-5.00 Octaves)

This sets the width of the Mid 2 band, in octaves. The lower this value, 
the “narrower” the bandwidth.

High Freq 
(200-20000Hz)

This sets the frequency of the High band.

High Gain (+/-20dB) This sets the amount of cut/boost for the High band.

High Cut If this button is activated for the High band, it will act as a High Cut fil-
ter. The Gain parameter will be fixed.

Output (+/- 20dB) This parameter allows you to adjust the overall output level.

Left/Stereo/Right/
Mono Modes

For stereo signals you can set independent curves for the left and 
right channels by clicking the corresponding button. If the Stereo 
mode is activated, the curve will be applied to both channels. 
When channel independent curves have been set, the left/right chan-
nel curves will be colored green and red, respectively. The currently 
non-selected channel is shown with a dotted curve. If you activate 
Stereo mode after independent curves have been set, the currently 
active curve will be applied to both channels.
Mono mode is automatically activated for mono signals and is other-
wise unavailable.

Parameter Description
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• The second harmonic is a signal at twice the frequency (one octave) above the 
basic frequency (the fundamental). 

• The 3rd harmonic is three times the fundamental (one octave and a fifth above it).

The reasons for limiting the processor to these two frequencies are; 
firstly, higher harmonics are most often perceived as “too high”, and se-
condly, their amplitude normally doesn’t follow that of the fundamental in a 
natural way.

• Please note the relation between the Frequency parameter and the har-
monics generated. 
If the Frequency parameter for example is set to 4000, the 2nd harmonic generator will only 
create frequencies from 8000Hz upwards and the 3rd harmonic generator will add fre-
quencies starting at 12000Hz.

Another part of this process is giving the added harmonics appropriate 
amplitude curves. The amplitude of the harmonics is based on the ampli-
tude of the existing material, but you can control it to some extent using 
the Density and Kick parameters, see “Parameters” below.

The amplitude of the added harmonics is usually very low. The difference 
Spectralizer makes is sometimes only apparent on a psycho-acoustical 
level. To hear what is actually added to the signal, use the Solo button.

Parameters

The parameters are as follows:

Parameter Description

Solo When this is activated, the output will only contain the added Harmon-
ics. The original unprocessed signal will not be heard on the output.
This mode is used as a diagnostic tool to monitor what the current set-
tings actually add to the signal.

Kick When this is activated, even more Harmonics will be added when a 
transient (attack) occurs in the signal.

Frequency This adjusts the frequency of the high-pass filter that appears just after 
the input. Signals with a frequency lower than this setting will not be af-
fected by the processing. In other words, there will be no harmonics 
added to the frequencies that are too low to pass through the filter.

Density This controls the amplitude “envelope” of the added harmonics. The 
higher the value, the more prominent the effect.

Input This adjusts the overall input to the processor. Use this to both maximize 
the signal level and to make sure that internal clipping does not occur. 
Use the Meter and “Int. Clip” indicator to check the levels.
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Stereo Echo

The Stereo Echo is a delay with separate settings for the left and right 
channel. It can also be used as a single mono delay, in which case the 
maximum delay time will be doubled.

The Stereo Echo has the following parameters:

Gain This adjusts the level of the signal just before it reaches the harmonic 
generators.
As you increase this, you will most probably have to lower the Input set-
ting to avoid clipping.

2nd This sets the level of the 2nd harmonics in the mix.

3rd This sets the level of the 3rd harmonics in the mix. 

Mix The Mix parameter adjusts the balance between the unprocessed signal 
and the added harmonics.

Int. clip When this lights up, the signal has exceeded the maximum level that 
Spectralizer can handle. This will lead to unpleasant distortion and 
should definitely be avoided. If this happens, please lower the Input level 
and/or Gain.

Meter This allows you to check your adjustments of the Input and Gain con-
trols, so that the signal does not change drastically in level when pass-
ing through the Spectralizer.

Parameter Description

Delay 1 The delay time for the left channel. The maximum delay time is 1486 ms, 
unless you link both channels for mono operation, in which case the 
maximum delay time is 2972 ms - see below (1000ms = 1 second).

Feedback 1 This sets the amount of delayed signal fed back into the Delay 1 block, 
to create repetitions. Higher values result in a higher number of echo re-
peats.

Link 1-2
(Off, Linked)

Select Off if you wish to use Delay 1 and Delay 2 as two independent 
blocks. Select Linked if the output of Delay 1 is to be connected to the 
Input of Delay 2.

Delay 2,
Feedback 2

These parameters are identical to these but apply to the second Delay 
block.

Del2 Bal This parameter determines how much of the left channel output is sent 
to the right channel input. When set to 0.0 (fully left), then none of the 
left channel output is added to the right channel input; when it is set to 
1.0 (fully right), the right input receives both its normal source and the 
complete output of the left channel.

Parameter Description
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StereoExpander

The StereoExpander plug-in narrows or enlarges the stereo width of an 
existing stereo signal. There is only one parameter, the horizontal stereo 
effect slider. Setting this to a value of -100% produces two equal output 
channels (the original stereo image is lost). Values between -99 and -1 
correspond to a narrower stereo image. A value of 0 corresponds to the 
original signal, while values between 1 and 100 enlarge the stereo image.

Tools One

Tools One is an extremely useful “effect” for various applications. 

The level faders allow you to adjust the level of the left and right channel 
respectively. You can [Shift]-drag to make detailed settings. [Ctrl]-clicking 
a fader resets it to 0 dB (no level adjustment). Normally, adjusting one 
fader automatically moves the other as well, but you can make separate 
adjustments for the channels by pressing [Alt] and dragging.

The two Phase switches let you invert the phase of the left or right chan-
nel (or both).

The Algorithm buttons let you adjust the stereo sound image. When none 
of the buttons are activated, the stereo image will be preserved as is. MS 
process mode can be used in one of two ways:

• To transform an incoming “regular” stereo signal so that it resembles a signal re-
corded according to the M-S (middle/side) principle. This technique is often used 
in broadcasting to record the direct signal source (usually a voice) using one micro-
phone, and the ambience using a second microphone positioned at a 90° angle. 

• To transform an incoming MS signal into a “regular” stereo signal (to simulate an 
“XY” recording technique, where neither microphone is placed directly in front of 
the signal source).

Channel Swap, finally, means that the left channel is assigned to the right 
side and the right channel to the left side.

Volume L The output level of the left channel delay.

Volume R The output level of the right channel delay.

Parameter Description
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Voice Attenuator

This plug-in can be used to remove lead vocals from a recording, to pro-
duce a “karaoke” effect. The principle concept is based on the fact that 
vocals are usually mixed to center position in the stereo field, and that the 
human voice occupies a limited area of the frequency spectrum. 

Note, however, that it is nearly impossible to remove a vocal completely, 
without using very complex processing beyond the scope of this plug-in. 

• If the Remove Mono button is activated, the plug-in will sum the right and the left 
channels (with one of the channels out of phase), in the frequency range set by 
the Low and High Frequency parameters. This method will only work with stereo 
material.

• If the Notch Filter button is activated, the plug-in will filter out the signals within 
the frequency range set with the Low and High Frequency parameters, by apply-
ing a notch (band reject) filter. This method can be used with both stereo and 
mono material.

• The Gain parameter allows you to adjust the output level of the plug-in.

VSTDynamics

General Information

The VST Dynamics plug-in combines five separate processors; Auto-
Gate, Compress, AutoLevel, Limit and SoftClip, covering a variety of Dy-
namic Processing functions. The VST Dynamics window is divided into 
five sections, containing controls and meters for each processor. You ac-
tivate the VST Dynamics panel by clicking the “On” button in the lower 
right corner. Once VST Dynamics is activated, you can turn the individual 
processors on and off by clicking on their labels. Activated processors 
have highlighted labels.

You can activate as many processors as you want, but remember that not 
all processors are designed to work together. For example, “Limit” and 
“SoftClip” are both designed to ensure that the output never exceeds 
0dB, but achieve this in different ways. To have both of them activated 
would be unnecessary. The internal signal flow is printed in the lower right 
part of the Dynamics panel.
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The following processors are available on the VST Dynamics panel (click 
an item in the list for more information about the corresponding processor):

• “AutoGate” on page 787
• “AutoLevel” on page 789
• “Compress” on page 789
• “SoftClip” on page 790
• “Limit” on page 790

AutoGate

Gating, or noise gating, is a method of dynamic processing that silences 
audio signals below a certain set threshold level. As soon as the signal 
level exceeds the set threshold, the gate opens to let the signal through. 
AutoGate offers all the features of a standard noise gate, plus some very 
useful additional features, such as auto calibration of the threshold set-
ting, a look-ahead predict function, and frequency selective triggering. 
Available parameters are as follows:

Parameter Explanation

Threshold This setting determines the level where AutoGate is activated. Signal 
levels above the set threshold trigger the gate to open, but signal levels 
below the set threshold will close the gate.

Attack This parameter sets the time it takes for the gate to open after being 
triggered. If the Predict button is activated, it will ensure that the gate 
will already be open when a signal above the threshold level is played 
back. AutoGate manages this by “looking ahead” in the audio material, 
checking for signals loud enough to pass the gate.

Hold This determines how long the gate stays open after the signal drops be-
low the threshold level.

Release This parameter sets the amount of time it takes for the gate to close (af-
ter the set hold time). If the “Auto” button is activated, AutoGate will find 
an optimum release setting, depending on the audio program material.
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Trigger Frequency Range 

AutoGate has a feature that allows the gate to be triggered only by sig-
nals within a specified frequency range. This is a most useful feature be-
cause it lets you filter out parts of the signal that might otherwise trigger 
the gate in places you don’t want it to, thus allowing more control over the 
gate function. The Trigger Frequency Range function is controlled using 
the control in the upper part of the AutoGate panel, and the slider located 
below it. The basic operation of the Trigger Frequency Range function is 
as follows:

1. While playing back audio, drag the slider to the “Listen” position.
You will now monitor the audio signal, and the gate will be bypassed.

2. While listening, drag the two handles in the Trigger Frequency window to 
set the frequency range you wish to use to trigger the gate.
You will hear the audio being filtered as you move the handles.

• Dragging the left handle to the right will progressively cut frequencies starting 
from the low end of the frequency spectrum.

• Dragging the right handle to the left will progressively cut frequencies starting 
from the high end of the frequency spectrum.

3. After setting the frequency range, drag the slider to the “On” position.
AutoGate will now use the selected frequency range as the trigger input.

4. To disable the Trigger Frequency Range function, drag the slider to “Off”.
AutoGate will now use the unfiltered audio signal as the trigger input.

Calibrate Function

This function, activated by using the Calibrate button located below the 
Threshold knob, is used to automatically set the threshold level. It is espe-
cially useful for material with consistent inherent background noise in the 
audio material, like tape hiss for example. This may be masked by the au-
dio content for most of the time, but becomes noticeable during silent 
passages. Use as follows:

1. Find a part of the audio material, preferably not too short, where only the 
background noise is heard. 
If you can find only a short section with background noise, try looping it.

2. Play it back, and click on the Calibrate button.
The button will blink for a few seconds, and then automatically set the threshold so that the 
noise will be silenced (gated) during passages where there is no other signal present.
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AutoLevel

AutoLevel reduces signal level differences in audio material. It can be 
used to process recordings where the level unintentionally varies. It will 
boost low levels and attenuate high level audio signals. Only levels above 
the set threshold will be processed, so low level noise or rumble will not 
be boosted. If the input level is greater than 0dB, AutoLevel will react very 
fast, because it looks ahead in the audio material for strong signal levels 
and can attenuate levels before they occur, thus reducing the risk of sig-
nal clipping.

Compress

Compress reduces the dynamic range of the audio, so that softer sounds 
get louder or louder sounds get softer, or both. Compress functions like a 
standard compressor with separate controls for threshold, ratio, attack, 
release and make-up gain parameters. 

There is also a separate display that graphically illustrates the compressor 
curve shaped according to the Threshold, Ratio and MakeUp Gain pa-
rameter settings. Compress also features a Gain Reduction meter that 
shows the amount of gain reduction in dB, and a program dependent 
Auto feature for the Release parameter.

Parameter Description

Threshold Only levels stronger than the set threshold will be processed.

Reaction Time 
Switch

This parameter sets the amount of time it takes for AutoLevel to adjust 
the gain. Set this according to whether the program level changes sud-
denly or over a length of time.

Parameter Description

Threshold This setting determines the level where Compress “kicks in”. Signal lev-
els above the set threshold are affected, but signal levels below are not 
processed.

Ratio Ratio determines the amount of gain reduction applied to signals over 
the set threshold. A ratio of 3:1 means that for every three dB the input 
level increases, the output level will increase by only one dB.

Attack This determines how fast Compress will respond to signals above the 
set threshold. If the attack time is long, more of the early part of the sig-
nal (attack) will pass through unprocessed.
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SoftClip

SoftClip is designed to ensure that the output level never exceeds 0dB, 
like a limiter. SoftClip, however, acts differently compared to a conven-
tional limiter. When the signal level exceeds -6dB, SoftClip starts limiting 
(or clipping) the signal “softly”, at the same time generating harmonics 
which add a warm, tubelike characteristic to the audio material. SoftClip 
is simplicity itself to use as it has no control parameters. The meter indi-
cates the input signal level, and thus the amount of “softclipping”. Levels 
in the green area (weaker than -6dB) are unaffected, while levels in the 
yellow-orange-red area indicate the degree of “softclipping”. The deep 
red meter area to the right indicates input levels higher than 0dB. 

• Avoid feeding SoftClip with excessively high signal levels as audible distor-
tion may occur, although the output level will never exceed 0dB.

Limit

Limit is designed to ensure that the output level never exceeds a certain 
set output level, to avoid clipping in following devices. Conventional limi-
ters usually require very accurate setting up of the attack and release pa-
rameters, to totally avoid the possibility of the output level going beyond 
the set threshold level. Limit adjusts and optimizes these parameters au-
tomatically, according to the audio material. However, should you want to, 
you can adjust the Release parameter manually.

Release Sets the amount of time it takes for the gain to return to its original level 
when the signal drops below the Threshold level. If the “Auto” button is 
activated, Compress will automatically find an optimum release setting, 
that varies depending on the audio program material.

MakeUp Gain This parameter is used to compensate for output gain loss, caused by 
compression.

Parameter Description

Threshold This setting determines the maximum output level. Signal levels above 
the set threshold are affected, but signal levels below are left unaffected

Release This parameter sets the amount of time it takes for the gain to return to 
its original level when the signal drops below the threshold level. If the 
“Auto” button is activated, Limit will automatically find an optimum re-
lease setting that varies depending on the audio program material.

Parameter Description
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SDS - Generic Sample Dump Standard
Sampler Operating system required:

Latest available.

MIDI:

Required.

SCSI:

N/A.

Loops:

One.

SMDI (Standard SCSI transfer)
Sampler Operating system required:

Latest available.

MIDI:

N/A.

SCSI:

Required.

Loops:

One.
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Akai S1000/1100 including PB models
Sampler Operating system required:

4.30 or later.

MIDI:

Required. Also supports SDS.

SCSI:

Not supported.

Loops:

One.

Akai S2000/S2800/S3000/S3200, including all 
“i”, CD, and “XL” derivatives etc.

Sampler Operating system required:

1.50 or later.

MIDI:

Required. Also supports SDS.

SCSI:

Not supported.

Loops:

One.
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Ensoniq, EPS, EPS16+, ASR-10, ASR-88
Sampler Operating system required:

EPS: 2.40

ASR-10: 2.53

Other: the latest

MIDI:

Required. Also supports SDS.

SCSI:

Not supported.

Loops:

One.

E-mu Esi-32
Sampler Operating system required:

2.10 or later

MIDI:

Not supported, unless you use SDS.

SCSI:

Required for sampler specific protocol, also supports SMDI.

Loops:

One.
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E-mu EIV, e64 and other samplers running the 
EOS operating system

Sampler Operating system required:

2.50 or later

MIDI:

Not supported, unless you use SDS.

SCSI:

Required for sampler specific protocol, also supports SMDI.

Loops:

One.

Kurzweil K2000 and K2500
Sampler Operating system required:

K2000, 3.01 or later, K2500, 2.13 or later

MIDI:

Required, unless you use SMDI. Also supports SDS.

SCSI:

Optional, also supports SMDI.

Loops:

One.
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Roland S-760
Sampler Operating system required:

2.17 or later

MIDI:

Required. Also supports SDS.

SCSI:

Not supported.

Loops:

Two.
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General problems
Can't create a temporary file

• Please check which drive is specified for your temporary files (in the Edit Folders 
dialog). You cannot use a CD-ROM disk or a write protected drive for your tem-
porary files.

• Is the drive full? Please select a drive with as much free space as possible.

A drive/partition can't be found

• Is this volume a removable drive, or a CD-ROM? In that case, is the correct disk 
really in the drive?

• Have you renamed the Volume since you last used the program?

A file can't be deleted or renamed

• Is the volume write protected on which the file is residing? In that case, turn the 
write protection off.

• Is the file on a CD-ROM? Files can’t be deleted from CD-ROMs.

The program opens/doesn't open with the same files each time

• This is not a bug, it's a feature! You can decide to have the program boot up as 
you last left it. This is done by activating/deactivating “Open last window layout on 
startup” in the Preferences dialog. See Preferences Topics.

My snapshots are gone!

There are two main ways to make sure your snapshots “stay” from ses-
sion to session:

• Make sure “Save view settings in companion file” is activated in the Preferences - 
Wave edit tab. This will automatically save any snapshots associated with an au-
dio file.

• Use Open last window layout on startup (described above) to make all settings 
remain just as you left them.

The wave isn't styled as when I opened it last

There are three ways to save your window styling, etc.:

• Make sure “Save view settings in companion file” is activated in the Preferences–
Wave edit tab. This will automatically save any window settings associated with 
an audio file.

• Use “Open last window layout on startup” in the Preferences dialog to make all 
settings remain just as you left them.

• Make the file part of a workspace and open it from there. Layouts are saved with 
the opened windows of a project.
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Problems with opening files
The file doesn't appear in the Open dialog.

• Does the file have the right extension? Select “All files (*.*)” from the pop-up in 
the Open dialog and check again.

• Is the drive on which the file resides currently accessible? If you use removable 
hard disks or CD-ROMs, make sure the right disk is in the drive.

Can't open a file

• Is the file really a supported file type?
• Is it possible to open it in other programs that support files of the same format? If 

not, it is probably damaged.
• Try opening the file in the Media Player application, included with Windows. If that 

doesn't work, the file is probably damaged. Note that WaveLab carefully checks 
the file headers: if any mistake in the format is found, WaveLab does not open the 
file for safety reasons. This could happen (rarely) with some files created by non-
professional software.

• Is the drive on which the file resides currently accessible? If you use removable 
hard disks or CD-ROMs, make sure the right disk is in the drive.

Can't open dual mono files

• Open the Preferences dialog, click on the File tab and activate “Allow opening of 
dual mono files”.



WAVELAB
35 – 800 Troubleshooting

Problems with saving files
Can't save

• Is the volume on which you are trying to save write protected? For example, you 
cannot save anything on a CD-ROM.

• Is there enough space on the drive?
• Is the drive to which the file was last saved currently accessible? If you use re-

movable hard disks or CD-ROMs, make sure the right disk is in the drive.
• Are you trying to overwrite another file with the same name? If so, is that file write 

protected? If it is, it can't be overwritten. Save under another name, or remove the 
write protection.

• Are you trying to overwrite another file with the same name? Is that file open? If it 
is, close it and try again.

• To get around all of the problems listed above, try saving to another disk/folder.

Recording problems
I can't record

• Are you trying to record at a sample rate/bit resolution that your card doesn't sup-
port? Check the documentation for the card to find out which formats it supports.

• Is the card really installed correctly? Try using some application included with the 
card to see if that works. Also try the “Sound recorder” included with Windows.

• Do you have the latest drivers for your card? Contact your dealer for the latest 
drivers.

• Is your temporary files location set up correctly and do you have enough free 
space on that drive?

I can’t hear what i just recorded

• Do the meters move when you record? Do you get a waveform in the window? If 
you do, the recording is not the problem, it is the playback.

• Check the Mixer. Do you have the correct recording inputs activated, and are the 
levels set properly?

• If you can't seem to activate the correct inputs and levels from WaveLab, try the 
mixer application that was included with your audio card. Some card drivers do 
not react correctly to the standard Windows commands transmitted by WaveLab.

• Please check your cables and the devices you have connected. Is there really a 
proper audio signal coming in to the card?

• Have you selected the appropriate recording mode for the recording source? If 
you want to record an external audio signal through the active inputs on your au-
dio hardware, you must select the “Audio card input” mode in the Record dialog. 
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There is too much noise in my recordings

• Have you adjusted your recording levels properly?
• Is the source connected to the proper input?
• Have you specified 8 bits as the bit resolution for the recording? Try 16 bits in-

stead.
• Keep in mind that microphones provided with sound cards are very low quality.

The mixer can't be “created”

• Have you specified your audio card in the Preferences dialog? A mixer can't be 
created if “Microsoft Sound Mapper” is selected.

• Do you have the latest and correct drivers for your card? We have noted that 
some card drivers contain “bugs” that prevent a mixer from being created.

Playback problems
No playback at all

• Is the card really installed correctly? Try using some application included with the 
card to see if that works. Also try the “Media Player” included with Windows. If 
that doesn't work, there's something wrong with the card or the installation.

Playback is choppy

• Are you using a compressed hard drive? You should not use WaveLab on such 
drives because they eat up too much processor power!

• To play a quality wave (e.g. 16 bit Stereo 44,1 kHz file) from a CD-ROM, your 
CD-ROM reader must be at least of a “Double Speed” type.

A file can't be played

• Is the file really in a format (sample rate, bit resolution mono/stereo) supported by 
your audio card? The format of the file is indicated on the status bar.

Playback can’t be heard

• Do you have an application for the audio card that allows you to adjust playback 
volumes? Are these settings correct?

• Check the cables and the other audio equipment you use.
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Editing problems
After editing I get clicks and pops

• Are you making “splices” in the middle of an audio section? If you do, we recom-
mend that you make all cuts at zero crossings, to avoid clicks and pops.

After crossfading, I get distortion

• If both sections play at full level during the crossfade, it is possible that clipping 
will occur (although it is unlikely). If this happens, undo the crossfade, lower the 
gain of both sections (by 3 or 6 dB for example) and try again. The problem can-
not occur if you check the “Inverse of Fade In” or “Inverse of Fade Out” options.

Audio database and workspace problems
Where are my files in the database?

• See topics related to databases.
• Do you have the Global Filter activated? Turn it off.

A new Audio Database/Workspace can't be created

• Is the volume where you try to store the file write protected? For example, you 
cannot create databases and workspaces on CD-ROMs.

• Is the disk full?

A file can't be found, opened or played

• Has the name or the extension of the file been changed since you last used the 
workspace/database? Please try to open the file from the Open dialog.

• Have you moved the file to another folder?
• Have you renamed the folder (in the database)?
• Is the drive on which the file was residing currently accessible? If you use remov-

able hard disks or CD-ROMs, make sure the right disk is in the drive.

Not all files are added to the database as expected

• When performing a “Scan folder” operation, the list will not display all files just reg-
istered, but only those from the last scanned folder. Also check the setting for “Max-
imum size of result list” in the Audio Database part of the Preferences dialog.

A file can't be renamed or deleted

• Is the volume on which the file is residing write protected? 
• Is the file on a CD-ROM? Files on CD-ROMs cannot be deleted or renamed.
• Is the drive to which the file was last saved currently accessible? If you use re-

movable hard disks or CD-ROMs, make sure the right disk is in the drive.
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Troubleshooting and precautions
The following sections provide information concerning Sampler communi-
cation problems, problems relating to CD/DVD burning, hardware devices, 
precautions for trouble-free CD writing as well as hardware and setup is-
sues.

Please note that Steinberg cannot make any guarantees about the validity 
of your recorded audio CDs.

Sampler communication problems
General precautions

• Not all samplers require or even support MIDI transfers. However, in some cases, 
where SCSI is supported, MIDI is required anyway! See the chapter Sampler De-
tails in the on-line documentation for details!

• If you use MIDI, remember that two way communication is always required!
• Some MIDI cards and drivers have problems with the heavy MIDI SysEx commu-

nication required when transferring audio data. Serial port interfaces are not re-
commended for sampler communication.

Sampler Transfer doesn't work at all, or not reliably

• Does the sampler have the required OS?
• Does it require MIDI? In some cases, where SCSI is supported, MIDI is required 

anyway!
• Does it require SCSI? Some samplers are not supported via MIDI at all.
• If the sampler supports MIDI, try only MIDI first. When this works correctly, switch 

to, or add SCSI and try again. 
• If MIDI is required, is two way communication really established? Check patcher, 

MIDI interfaces etc. Try with a simpler connection and/or MIDI interface.
• If MIDI is required, is the interface connected and set up correctly?
• Is the MIDI driver installed correctly? Do other programs work?
• If MIDI is required, is some other program blocking MIDI? Is Cubase running with 

Play in Background active?
• Recheck your MIDI SysEx ID settings. If these are not in accordance with the set-

tings in WaveLab, transfers won't work.
• If SCSI is used (or required), are IDs, terminators and everything else set up as 

they should be? Does the sampler appear on the SCSI bus at all? See the instal-
lation chapter in the printed documentation.

• Is some other program using MIDI at the same time? Make sure WaveLab has the 
MIDI connectors to itself during transfers.
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• For SCSI, check termination, SCSI card driver versions and everything else re-
lated to the SCSI setup.

Problems and solutions
General instructions

The following text is written for problems relating to CD burning, but ap-
plies to DVD as well.

• If you run into problems, the first thing to check is your hardware and software 
setup. To isolate the problem, you could try using other CD burning software (for 
example a program supplied with the CD-R unit). If this doesn't work either, the 
problem isn't with WaveLab, but with some other component in the system.

• When you insert a disk into the recorder, make sure you wait long enough before 
you start using it. You might have to wait several seconds. Watch any possible 
LEDs on the front panel. They will indicate when the unit is ready for use (see the 
operation manual for the unit for details).

• If your CD recorder doesn't respond, the first thing to do is to eject the disc and 
insert it again. This will reinitialize the recorder.

• If this doesn't work, you might try switching off the recorder (even if the computer 
is still on), wait three seconds and then turn it back on again. Often, only reboot-
ing the computer is not enough.



WAVELAB
Troubleshooting 35 – 805

Questions and Answers
• I have problems with a Phillips CDD-2000 unit.

If you have a real Phillips drive or a drive that contains this Phillips mech-
anism, you must make sure that the firmware version is 1.25 or later. A 
firmware update can be found at http://www.philips.com/sv/pcaddon.

• I have other problems writing a CD and/or importing CD audio tracks.

Well of course there could be many reasons for this. Check the “Day to 
day precautions for trouble free CD writing” section below. But, here are 
two more things to try:

Open the Control Panel, and double click on System. Select the Device 
Manager tab, select CD-R in the list (if this entry exists, which is not man-
datory) and click on the Properties button and then select Settings. Dis-
able the “Insert auto notification” to prevent Windows from reading from 
the CD-R during the writing process.

If you have problems at higher speeds, try lowering it. Even if your system 
writes correctly at 8x most of the time, it's safer to write at lower speeds.

• I have problems writing CDs when I specify ISRC and EAN/UPS codes, but oth-
erwise things work fine.

If you try to write a ISRC code or EAN/UPC code, WaveLab might return 
an error if: a) the CD recorder does not support this (not all do, or not all 
firmware versions do). b) the codes are not properly formatted: UPC/
EAN: 13 numeric characters. ISRC: 5 alphanumeric followed by 7 nu-
meric characters.

• A CD disc that I have created doesn't play correctly on my CD player.

The reflections of a “normal” CD and a CD-R are different (a CD-R re-
flects less light). A dirty lens on the CD player might disturb playback. 
This is more common on old CD players because their lasers do not prop-
erly calibrate for recordable CDs. Sometimes, the combination of disc 
brand and CD recorder brand can make a difference.

• I can't write track Sub-Indexes.

Some CD recorders are simply not capable of this. Some others can only 
write 50 Sub-Indexes per track for example, and some others only 100 
Sub-Indexes per CD. This depends on the CD-R firmware.
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Day to day precautions for trouble free CD 
writing

The most important thing to remember is that CD writing is a real-time op-
eration where a laser burns depressions into the surface of the CD. This 
is done at a speed which cannot be slowed down or interrupted. Any in-
terruption will most likely be fatal, rendering the CD-R disk useless. For 
these reasons you should make sure your system does not interrupt the 
CD-R writing once it's under way. Read the following points:

• Keep the CD-recorder on a vibration-free surface. Sudden “shocks” could cause 
writing interruptions.

• Do not read files directly from a CD, copy them to a fast hard disk first.
• Do not read files over a network. Networks usually are far too slow for CD-R writing.
• Turn off networking, at least for the hard disk drive from which you are reading, 

since the CD writing may be interrupted by anyone trying to access this drive.
• It is best to store the files on a hard disk partition that is 1 gigabyte in size, or 

smaller (since this means the sectors will be 16kByte rather than 32kByte).
• Do not read files from a hard disk with compression enabled!
• It is highly recommended that you keep your hard disk(s) defragmented at all 

times. Windows includes an application for this. 
• If you have multiple hard drives in your system, put the audio files on your fastest 

drive! Also use a fast drive for WaveLab's “temp” files.
• Turn off any screen savers, anti-virus, schedulers, animated icons and alarm or re-

minder programs that might interrupt the CD burning operation.
• Make sure any fax reception or background e-mail software is disabled.
• If you use the System Agent, make sure no activities are scheduled for the time 

you write to the CD. Do no use the “When Idle” option in the System Agent.
• Disable any System Monitoring programs.
• If you use the CD-R unit as a CD-ROM reader, make sure you quit the Explorer 

and close any “My Computer” windows before writing.
• Stop audio playback in WaveLab before writing.
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Hardware and setup issues
CD-R Drivers

• If you have previously installed another CD-R software product, you may run into 
driver conflicts. Normally this should not happen since WaveLab has built-in driv-
ers that are loaded as needed, and which usually override any other installed dri-
vers. However, if you do have problems writing to CD-R, this is a point to check.

• If it isn't absolutely required, don't install any other driver for your CD-R unit (for 
example a driver that allows you to use the CD-R as a CD-ROM drive). The dri-
vers might make Windows try to access the drive during writing, which can cause 
system interruptions.

• In the advanced BIOS settings of your SCSI host adapter, the following should 
normally be disabled:
- Plug and Play SCAM Support
- Support Removable Disks Under BIOS as Fixed Disks
- BIOS Support for Bootable CD-ROM
- BIOS Support for Int 13 Extensions 

Networking Cards

Network cards can produce hardware interrupts which momentarily halt 
operation of all software. This can cause various problems. For CD writ-
ing, a non-networked machine is more stable than a networked one.

• If you need to keep your machine connected to a network try to not load the net-
work card drivers when you plan to write CDs.

About Hard disks

• Many hard disks automatically perform something called thermal calibration at 
regular (but unpredictable) intervals. For this reason, drives sold as “A/V drives” 
are recommended, since they have built-in “intelligence” which delays any recali-
bration to times when the disk is not being used. Some drives not marketed as 
“A/V Drives” also have this capability, check with the vendor if in doubt.

CD-R disks

• There are many brands of CD-R disks. Always use one that has been tested and 
recommended by your CD-R drive manufacturer.

• CD-R discs are not as solid as real CDs. Handle them with care! Do not expose 
discs to sunlight for long periods, and avoid heat and humidity.

• The top (label) side of a CD-R disc is also vulnerable. Don't use alcohol-based 
pens to write on discs and don't put labels on unless they are specifically de-
signed for CD-Rs (otherwise the glue on the label might eat through the surface).
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Links and sources for more information

• A general CD-R site that might be of interest: http://www.osta.org/technology/
cdqa.htm
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File handling

Wave display mode
The following keys on the alphanumeric part of the keyboard (not on the 
numeric keypad) are used for these commands:

Key Command Function

[Ctrl]-[O] Open wave file

[Alt]-[Enter] Open wave file information window

[Shift]+[O] Open Recently used Wave Files selection box

[Ctrl]-[F2] Open Audio Montage

[Ctrl]+[Shift]+[O] Open Recently used Wave Files selection box

[Ctrl]-[S] Save current document

[Shift]-[S] Save current document under new name and/or in a new location

[Ctrl]-[Shift]-[S] Save all currently open documents

[Ctrl]-[N] Create new wave

[Ctrl]-[W] Close current document (and all its related windows)

[Ctrl]-[E] Convert Wave to MP3 (Save special – Encode (MP3))

[Ctrl]-[Shift]-[E] Convert Wave to MP2 (Save special – Encode (MP2))

[Shift]-[E] Save current wave selection as a new wave file

Key Command Function

[1] Wave display

[3] Spectrum display

[4] Open spectrum options dialog

[5] Loudness envelope display

[6] Open envelope options dialog

[0] Sync top and bottom views
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Zooming
Main View

Overview

View
The following commands scroll the window without moving the cursor:

Key Command Function

[G] Zoom in horizontally

[Arrow up] Zoom in horizontally (or Zoom out if Cubase compatibility is enabled)

[H] Zoom out horizontally

[Arrow down] Zoom out horizontally (or Zoom in if Cubase compatibility is enabled)

[Ctrl]-[Arrow up] Zoom in horizontally to maximum zoom factor

[Ctrl]-[Arrow down] 
or [J]

Zoom out horizontally to display the entire wave or montage

[Shift]-[G] or
[Shift]-[Arrow up]

Zoom in vertically (or Zoom out if Cubase compatibility is enabled)

[Shift]-[H] or 
[Shift]-[Arrow down]

Zoom out vertically (or Zoom in if Cubase compatibility is enabled)

[Shift]-[J] Zoom in or out to get an optimized level display (best fit)

[K] Zoom selection

[Ctrl]-[L] Zoom in vertically to decrease the number of visible tracks (Montage)

[Ctrl]-[Shift]-[L] Zoom out vertically to increase the number of visible tracks (Montage)

Key Command Function

[Ctrl]-[J] Zoom out to display the entire wave/Montage horizontally

Key Command Function

[Ctrl]-[Home] Start of Wave or Montage

[Ctrl]-[End] End of Wave or Montage

[.] (Numeric keypad) Cursor position
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Playback and cursor position
Numeric keypad

Function keys

Key Command Function

[Enter] Play (from current position)

[0] Stop / Move to selection start / Move to beginning

[1] Move cursor to selection start

[2] Move cursor to selection end

[4] Move cursor to previous marker

[5] Move cursor to next marker

[.] (full stop) Scroll to cursor

[/] Loop on/off (current wave only)

[F] Scroll during playback on/off

Key Command Function

[Space Bar] Toggle Play / Stop

[F8] Play (from current position)

[F7] Stop / Move to selection end/ Move to selection start / Move to begin-
ning

[F6] Play selection

[Shift]+F9] Activate/deactivate MTC synchronization mode

[F9] Activate/deactivate ASIO synchronization mode

[F10] Activate/deactivate Jog and Shuttle mode
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Cursor keys

Selecting

Extending or making selections

The following commands create a new selection or extend the current one.

Key Command Function

[Arrow left] Move cursor one pixel to the left

[Arrow right] Move cursor one pixel to the right

[Ctrl]-[Arrow right] Move cursor 1/10 of the window width to the right (or left if Cubase 
compatibility is enabled)

[Ctrl]-[Arrow left] Move cursor 1/10 of the window width to the left (or right if Cubase 
compatibility is enabled)

[Ctrl]-[Page Up] Move cursor one window width to the left (or right if Cubase compatibil-
ity is enabled)

[Ctrl]-[Page Down] Move cursor one window width to the right (or left if Cubase compatibil-
ity is enabled)

[Home] Move cursor to beginning

[End] Move cursor to end

[Tab] Toggle Cursor between left/right/both channels (stereo waves only)

Key Command Function

[Esc] Toggle selection on/off

[Tab] Toggle selection between left/right/both channels (stereo waves only)

Key Command Function

[Shift]-[Arrow left] One pixel to the left

[Shift]-[Arrow right] One pixel to the right

[Ctrl]+[Shift]-
[Arrow left]

20 pixels to the left

[Ctrl]+[Shift]-
[Arrow right]

20 pixels to the right

[Shift]-[Page Up] 20 pixels to the left (or right if Cubase compatibility is enabled)



WAVELAB
36 – 814 Key commands

Making selections

The following commands always create a new selection:

“One the fly” numeric keypad commands

The following commands are for selecting during playback. Please note 
that the keys on the numeric keypad must be used.

[Shift]-[Page Down] 20 pixels to the right (or left if Cubase compatibility is enabled)

[Ctrl]+[Shift]-
[Page Up]

One window width to the left (or right if Cubase compatibility is enabled)

[Ctrl]+[Shift]-
[Page Down]

One window width to the right (or left if Cubase compatibility is enabled)

Key Command Function

[Shift]-[Home] From cursor to start

[Shift]-[End] From cursor to end

[Ctrl]-[A] Select all

Key Command Function

[Shift]-[1] Set start of selection

[Shift]-[2] Set end of selection

[+] Press and hold to set start of selection, release to set end of selection.

Key Command Function
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Editing and Recording
General

Cut and Paste

Delete and Silence

Recording

Key Command Function

[Shift]-[A] Open Wave Attributes dialog

[Ctrl]-[U] Open Audio Properties dialog

Key Command Function

[Ctrl]-[X] Cut

[Ctrl]-[C] Copy

[Ctrl]-[V] Paste

[Ctrl]+[Shift]-[V] Paste Append

Key Command Function

[Backspace] or [Del] Delete current selection

[Ctrl]-[Space bar] Silence current selection (Fast mute)

[Ctrl]+[Shift]-
[Space]

Insert silence

[Ctrl]-[Backspace] Trim (to selection)

[Ctrl]+[Del] Smooth delete

Key Command Function

[*] (Multiply on the 
numeric keypad)

Open Record dialog
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When Record dialog is open

Undo and Redo

Key Command Function

[Ctrl]-[M] Drop generic marker

[Ctrl]-[L] Drop generic region start marker

[Ctrl]-[R] Drop generic region end marker

[Ctrl]-[P] Pause

[Ctrl]-[Enter] Record

[Ctrl]-[0] 
(Numeric keypad)

Stop record

[Ctrl]-[Y] Reset meters

Key Command Function

[Ctrl]-[Z] Undo

[F3] Undo

[Ctrl]+[Shift]-[Z] Redo

[F4] Redo
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Processing

Markers

Key Command Function

[N] Level Normalizer

[Shift]+[M] Loudness Normalizer

[Shift]+[P] Pan Normalizer

[Ctrl]-[G] Change gain

[D] Dynamics

[V] Level envelope

[Ctrl]-[D] Easy Fade

[Ctrl]-[F] Fade in/out

[X] Crossfade

[Ctrl]-[R] Reverse

[R] Waveform Restorer

[T] Time stretch

[P] Pitch Correction

[Ctrl]-[Q] EQ

[B] Pitch Bend

Key Command Function

[Ctrl]-[M] Open marker list

[Insert] Drop new marker at cursor position (for example during playback)

[Ctrl]-[Insert] Create Marker
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Database

Miscellaneous

Key Command Function

[Insert] Add file to database

[Ctrl]-[D] Scan folder

[Ctrl]-[F] Global Search

[Ctrl]-[G] Global Filter

Key Command Function

[F2] Open Rename dialog

[Alt]-[Ctrl]-[M] Maximize Wave or Montage window width

[W] View Window layouts

[Ctrl]-[F9] Show/hide Master Section

[Ctrl]-[F10] Show/hide Monitor window

[Ctrl]-[P] Open Preferences dialog

[M] Magnetize Bounds on/off

[Z] Zero crossing on/off

[7] (Numeric keypad) Undo zoom/view/position change in Montage

[Shift]+[F5] Open a dialog where you can save a picture of the active window.
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A
Accelerators 68
ACM 126
Adding files to Databases 687
AES-31 files

Import and export 547
Analyse selection 157
Append 105
Archives 725
ASIO driver 25
ASIO Instant playback switching

About 523
ASIO Positioning Protocol 

(APP) 656
ATS column (Montage)

About 536
Audio card

Checking 22
Settings 25

Audio CD format 577
Audio CD report 541
Audio CD track import 594
Audio file comparer 637
Audio files See “Wave files”
Audio formats

DVD-Audio project 368
Audio in pauses 534
Audio Input plug-in 251
Audio Montage

About 372
Backing up 503
Cloning 500
Creating new 378
Opening 499
Panes 373
Recording 406
Saving 498

Audio Properties 127
Audio Range dialog 141
Audio Signal Generator 644
Auto Panner 760
Auto Split 342
Auto zoom for overview 85
Autopan 768

B
Backup archives 725
Backup Plan

Creating 715
Editing as text 719
Executing 723
Running from command line 725
Saving 724

Backups
Audio files 117
Montage 503

Basic Audio CD
Adding tracks 350
Copy protection 360
Creating 348
Creating from Montage 541
Deleting tracks 353
Exporting single tracks 363
Naming tracks 360
Pauses 360
Playing tracks 361
Sorting 353
Testing 573
Track info 355
Writing 574

Batch file encoding 304
Batch file renaming 307
Batch processing

Adding files 279
Creating zip archives 296
File list 278
File settings 292
File status icon 283
Introduction 274
Off-line processors 287
Plug-ins 286
Presets 301
Processor list 285
Scheduling 299
Ultra-pass processors 288

Bit Meter 170
Blur peaks 264
Bypass (Master Section effects) 228
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C
Calibrating printer 616
Categories (Database) 699
CD format specification 577
CD images

Comparing 576
Creating with cue sheet 540
From Basic Audio CD 362
Importing as Montage 378
Writing to Exabyte tape 580

CD recorders
Disc-At-Once 580
Installing 30
Selecting 572

CD track markers
Audio Montage 329
Basic Audio CD 358

CD track sub-index markers 329
CD view (Montage) 531
CD/DVD Project

About 584
From Backup Plan 728

CD/DVD Wizard dialog 532
CD-Extra 575
Change Gain 178
Channel configuration (Montage)

Selecting 508
Choirus2 769
Chorus 208
Chorus (Plug-in) 761
CleanComp 770
Clear Undo 48
Clip auto-grouping

All tracks 416
Same track 416

Clip effects
Adding 475
Latency 479
Tail 479

Clipping
About 179

Clips
About 372
Adding 382
Deleting 427
Duplicating 419

Editing in the clip list 439
Grouping 489
Locking 427
Mouse zones 408
Moving 415
Overlapping 418
Pitch shifting 473
Renaming 310
Reordering in the clip list 438
Repeating 420
Resizing 422
Saving and loading 386
Selecting 411
Selecting ranges in 413
Sliding audio source in 424
Source files 441
Splitting 425
Time stretching 471

Clips view
About 436
Customizing 436
Editing 439
Pregap column options 440
Reordering clips 438

Clone and substitute source 443
Colors

Conditions (Montage) 742
Customizing (Montage) 739
Customizing

(Wave window) 737
Colors (System) 22
Comment 696
Compare audio CD images 576
Comparing files 637
Compression 184

Audio file formats 125
Control bars 56

Appearance 57
Button functions 57
Descriptions 58
Docking 56
Moving 57
Show tips 57
Showing/hiding 57
Un-docking 57

Convert format
Batch encoding 304
Using Save as 117
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Convert sample rate 210
Converting marker type 345
Copy 101
Copy to new window 109
Copying wave selections 99
Create optimized crossfade when 

snapping to other clip 468
Crossfade 192
Crossfade Looper 671
Crossfades (Montage)

About 462
Constrained overlaps 467
Editing 464
Options 463
Power/Amplitude 

compensation 464
Crystal Resampler (Plug-in) 762
Cue Points 428
Cursor

Appearance 737
Moving to marker 338
Scroll to 86
Setting position 89
Status bar 79

Cut 103

D
Damp 264
Data CD/DVD

Creating 585
Writing 590

Databases
Adding dual mono files 691
Adding files 687
Categories 699
Creating 685
Displaying files in folders 702
File list 693
Filtering 703
Find operations 704
Locating files 694
Opening 685
Playing files in 694
Removing files 697
Removing folders 702
Renaming files 697

Renaming folders 702
Saving 685
Update 696
Window overview 686

dB (Level unit) 61
DC Offset 195
DDP files 580
Decimal (Level unit) 61
DeClicker 770
Deleting clips 427
Deleting files and documents 123
Deleting wave selections 105
DeNoiser 772
Dialogs (Non-modal) 67
DIRAC processor

Pitch Shift 203
Time Stretch 200

DirectX plug-ins 225
Disable redundant modes

About 510
Disc image See “CD images”
Disc-At-Once 580
Disk space 152
Dispersion 264
Dithering

About 231
Internal 233
UV22 234
UV22HR 234

DM column (Montage)
About 537

Dockable control bars 
See “Control bars”

Drag and drop 73, 697
Drop marker 331
Dropout 224
DTMF Generator 646
Dual mono files 72
Duck according to other track 453
Ducker (Plug-in) 775
Ducker plug-in 482
DVD view (Montage) 531
DVD-A Picture and Text tracks

Using 546
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DVD-Audio
Bit resolution on DVD 537

DVD-Audio options dialog
About 537

DVD-Audio project
Adding Montages 553
Audio formats 368
Creating 552
Deleting Montages 555
Groups 366
Rendering 569
Setting group order 555

DVD-Audio track import 599
Dynamics 184

E
Easy Fade 191
Echo (Plug-in) 762
Edit Folders dialog 731
Edit Overview (Montage) 394
Edit playback times 539
Effect Morphing 211
Effects

About 225
Installing 230
Mute 228
Presets 229
Removing 226
Reordering 226
Selecting 226

Effects (Montage)
Copying settings 480
Effect dialog 478
Envelopes 481
Removing 476
Split mode 477

Eight channel mode 520
Eliminate DC Offset 195
Emphasis 360
Enable Snapping 410
Encode (ACM) 126
Encoded formats

About 125
Batch encoding to 304
Exporting to 126

Envelopes
About 445
Copying 451
Displaying 447
Editing 448
Locking 453
Presets 452
Resetting 450
Smoothing 452

EQ (Processing) 209
EQ-1 763
Erase Peak files 116
Export

AES-31 547
Extend to peaks 98
External Gear plug-in 252
Externalize (Backup) 724
Externalizer 776

F
Fade-In/Out 191
Faders (Master Section)

About 222
Offset 223
Unlink mode 223

Fades (Montage)
Copying 460
Creating 457
Default 458
Editing 457
Presets 458
ROM presets 460, 464

Fast mute 109
Favorites 75, 746
FFT

3D Frequency Analysis 638
Spectrum Analyser 167

File formats 113
File list 693
File size (Unit) 61
Files

Renaming 308
Files (Audio) See “Wave files”
Files view 441
Filters (Backup) 715
Finding files 704
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Folder editing 731
Frames (CD) 578
Freedb 596
Freeze all meters 156
Frequency Analysis, 3D 638
Full cloning 500

G
Gating 184
Generic markers 329
Global Analysis

Errors 629
Extra 628
Introduction 620
Loudness 626
Operations 621
Peaks 625
Pitch 627

Global auto-grouping 391
Global envelope lock 453
Global filter 703
Groups

DVD-Audio project 366
Montage 489
Plug-ins 755
Workspaces 710

H
Hard disk requirements 17
Harmonization 207
Help 46
Hidden CD tracks

Creating 534
Hi-fi Chorus 208
History 496

I
Implicit folder 443
Import

AES-31 547
Audio CD track 594
Audio files 71
CD image as Audio 

Montage 378

Cue sheet 378
DVD-Audio track 599
Markers 330

Import Surround audio file
About 520

Index markers 329
Info line (Montage) 375
Insert audio file 72
Insert silence 106
Installation 23
Internalize (Backup) 724
Invert Phase 195
ISRC codes

About 579
Editing 360

J
Jog

Montage window 404
Wave window 143

K
Key commands

About 68
Key sequences 746
Key/MIDI commands

Customizing 746
Keywords

Adding to file 696
Adding to menu 696
Default 705

K-System VU meter modes 163

L
Label Editor

Edit Properties dialog 610
Editing objects 608
Grid 610
Objects menu 611
Tools 607
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Label sets
About 612
Opening 613
Printing 616
Saving 613
Saving as user template 613
Templates 604

Layouts
Saving 733
Window layouts 744

Level envelope 189
Level Processing (Dynamics) 184
Level selections 98
Level/Pan Meter 159
Leveler 764
Leveler Multi 764
Limiting 184
List of open files dialog 50
Locating files 694
Locking

Clips 427
Envelopes 453

Loop markers 329, 340, 669
Loop Tone Equalizer 679
Looping 137, 340, 669
Loudness distribution 641
Loudness Envelope display mode

Using 129
Loudness Normalizer 180

M
Magnetic bounds (Montage) 409
Magnetize bounds

Cursor 90
Cursor to marker 338
Dropping audio on markers 339
Snap to 100
Wave selections 97

Magnification See “Zooming”
Magnifying Glass 81
Marker list 332
Marker toolbar 330

Markers
Appearance 737
Converting type 345
Creating 331
Deleting 337
Displaying/hiding 333
Dropping 331
Dropping audio on 339
Dropping while recording 153
Editing 334
Importing and Saving 330
Introduction 328
Montage 492
Moving 336
Moving cursor to 338
Selecting between 338
Types 329

Master Section
About 218
Deactivating 218
Dithering Pane 231
Effects Pane 225
Master Level Pane 222
Render 239
Storing settings with 

Montage 498
Using dither for multichannel 

Montages 526
Using Master effects for multi-

channel Montages 526
Window handling 220

Master Section preset groups 238
Maximize width 79
Memory requirements 17
Meta Normalizer (Montage) 486
Meter format 61, 89
Metering

Bits 170
Introduction 156
Level 159
Pan 160
Phase 165
Selecting what to monitor 156
Spectrum 166

Meters
Master Section 223
Meter Windows 159
Record dialog 151
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MIDI
Connecting samplers with 31
Installation (Windows) 31

MIDI Time Code 650
Mix (Option) 105
Mixed Mode CD

Creating 589
Mixed Mode CD/DVD

About 584
MME/WDM Driver 26
Monitor audio input 156
Monitor edit-cursor position 157
Monitor file rendering 157
Monitor playback 156
Monitor window

Performance display 249
Progress display 247
Timecode display 655

Mono
Master Section button 224

Mono to Stereo 109
Montage See “Audio Montage”
Mouse zones 408
Mouse zooming 83
Move cursor to 89
Moving wave selections 103
MP3 files

Batch encoding 304
MRK files 330
MTC 650
MultiBand Compressor 777
Multichannel recording

About 521
Multiple copies 104
Multitasking 300
Mute

Clips and tracks 400
Effects 228
Selection in wave 329
Selection range in clip 451

Mute markers 329

N
NaturalVerb 779
Navigating

By clicking 86
Scroll menu 86
Using status bar 87

New documents, Creating 70
Noise Gate (Plug-in) 764
Noise gating 184
Non-modal dialogs 67, 177
Normalize 178, 289
Nudge (Kicker) tools

Audio Montage 430
Wave window 104

Nudging
Auto-Select 433
Montage 430
Setting impulse 431
Synchro offset 654
Wave window 104

O
Online documentation 46
Only if clipping (Normalize) 289
Open last window layout on 

startup 733
Oscilloscope 173
OSQ files

Batch conversion to 304
Saving and opening 119

Overwrite 105

P
Page layout (Labels) 616
Pan envelopes

Displaying 469
Pan modes 470

Pan Meter 160
Pan Normalizer 183
Panes 51
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Paste
Append 105
Copying wave selections 101
Mix 105
Moving wave selections 103
Overwrite 105
Prepend 105

Peak Master 765
Pencil tool 112
Percent (Level unit) 61
Phase Invert 195
Phase Scope 165
Photo viewer 588
Pitch Bend 205
Pitch Correction 201
Pitch Shift (Montage) 473
Play (Transport bar) 135
Play selection 141
Play tool 140
Playback Browser 140
Playback position display 250
Playback speed 138
Playback starter marker 329
Playing

Clips 402
Database 694
Montage 399
One channel in stereo file 140
Play tool 140
Selection 141
Setting playback speed 138
Setting start point 89
Skipping sections 137

Plug-ins
About 225
Installing 230
Organizing 753
Presets 229

Pop-up menus
In displays 60
Values 62

Position display 250
Position See “Cursor”
PQ codes 579
Pre-Emphasis 580

Preferences
Introduction 730
Saving 730
Startup 731

Prepend 105
Pre-roll 539
Preset groups 238
Presets

Batch processing 301
Creating 66
Databases 691
Deleting 66
Introduction 65
Loading 65
Master Section 236
Modifying 66

Preview (Backup) 721
Printing CD Labels 616
Priorities

Batch processing 300
Master Section 243
Monitor window 248

Properties 695
Puncher 765

Q
Q (Plug-in) 781
Quick Cloning 500

R
RAM 17
Range indicator 85, 737
Receive sample 664
Recent audio files 75
Recording

Disk capacity 152
Dropping markers 153
File format 148
In the Montage 406
Introduction 146
Levels 151
Mixer settings 150

Recording multiple channels
(Montage)
Setting up 521

Redo 47, 176
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Redo (Montage) 496
Refresh selection analysis 157
Region markers

About 329
Marking takes during 

recording 153
Release audio hardware 134
Remember active window’s 

layout 745
Rename dialog

Range parameters 314
Renaming Clips 310
Renaming files 308
Renaming files and documents 121
Render selected CD/DVD track 540
Rendering

Audio Montage 527
Wave windows 239

Rendering (Montage)
WMA 5.1 and 7.1 formats 530

Repeating wave selections 104
ReSampler 766
Resize clips 422
Resizer 766
Resolution on DVD 537
Restore Master Section’s 

configuration 498
Resume 248
Reverse 195
Revert to saved 121
Route to upper track 482
Rulers

Appearance 738
Hiding/showing 737
Meter format 89
Montage 377
Selecting units 61
Start position 88
Wave window 76

S
Sample rate

Conflicts 101
Conversion 210
Montage 378

Samplers
Communicating with 

WaveLab 658
Connecting 31
Editing sample attributes 667
Installing 31
Receiving samples from 664
Requirements 18
Setting up 661
Transmitting waves to 663
Verifying SCSI 

communication 32
Samples (Unit) 61
Save All 120
Save and Save as 117
Save Copy 120
Save left/right channel as 120
Save markers 330
Save selection as Clip 119
Scan folder 687
Scroll during playback 145
Scroll menu 86
SCSI

Connecting samplers with 31
Verifying communication 32

Select menu 94
Selecting

At zero crossings 95
By dragging 89
Clips 411
Effects 226
Level selections 98
Select menu 94
Shortcuts 92
Stereo files 91
Switching between channels 92

Selection
Selection ranges 413
Turning into new document 109

Set origin at cursor 88
Show tips 57
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Shuttle
Montage window 404
Via MIDI Pitch bend 144
Wave window 143

ShuttlePro 145
Signal Generator 644
Silence 109
Silence (Plug-in) 767
Size ruler (CD/DVD Project) 587
Skip 137
Skip muted regions 340
Sliders 62
Smart bypass 244
Smooth Delete 106
Snap (Montage) 410
Snap to fade-in/out when snapping 

to other clip 469
Snap to time units 97
Snap to waveform when 

crossfading 468
Snap to zero crossing 95, 96
Snapshots

Montage 396
Wave window 87

Solo (Montage) 400
Source audio files (Montage) 441
Speaker tool 140
Spectralizer 782
Spectrum Analyser

FFT Meter 167
Spectrum editor

Blur peaks 264
Copy operations 265
Damp 264
Defining a region 260
Dispersion 264
Filtering operations 263
Playback pre-roll/post-roll 265
Surgical processing 262

Spectrum Meter 166
Spectrum options

About 259
Speed Menus 60
Spin controls 62
Split mode

Effects (Montage) 477

Splitting audio files (Auto Split) 342
Splitting clips 425
Status bar

Introduction 59
Navigating from 87
Wave windows 79

Steinberg on the internet 14
Stereo

Master Section button 525
Stereo Echo 784
Stereo to Mono 109
StereoExpander 766, 785
Stop button 135
Store current Master Section’s 

configuration 498
Style conditions

Audio Montages 742
Wave windows 735

Styles 734
Substitute with existing wave 444
Surround channels

About 509
Suspend 248
Swap channels 111
Sync tab (Preferences) 651
Synchronizing WaveLab 650
System information 19

T
Templates (Label Editor) 604
Tempo 89
Temporary files 28
Temporary markers 329
The track activity indicator

About 401
Time code 61
Time format 61
Time stretch 196
Timecode display 250
Time-stretch to cursor 471
Toolbox

Introduction 58
Magnifying Glass 81
Play tool 140

Tools One 785
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Tracer application 33
Track auto-grouping 391
Track effects

Adding 475
Track gain faders

About 401
Tracks (Montage)

About 372
Handling 380
Output routing 482

Transform clips 470
Transmit back (sample) 665
Transmit samples 663
Transport bar 135
Trim 106

U
Undo

Clearing 48
Introduction 47
Limiting 47
Processing 176

Undo (Montage)
History view 496
View changes 398

UPC/EAN codes 580
Use Master Section 218
UV22 234
UV22HR 234

V
Values (Setting) 62
Variables

About 604
Editing 614

Video track (Montage)
About 504

View settings
Saving 124

Voice Attenuator 786
Volume envelopes

About 445
Displaying 447
Editing 448
Mono/Stereo 448

VST plug-ins
About 225
Excluding 756
Presets 229

VSTDynamics 786

W
Wave cursor See “Cursor”
Wave files

Basic editing commands 99
Drag and drop 73
Exporting from Basic Audio 

CD 363
Importing from audio CD 594
Importing from DVD-Audio 599
Opening 71
Processing 175
Recording 146
Selecting in 89
Zooming 80

Wave selections
Copying 99
Deleting 105
Moving 103
Repeating 104

Waveform elements 737
Waveform Restorer 196
Waveform Scope 174
Web links 14
Wheel mouse 63
Window layouts 744
Windows

Closing 49
Duplicate view 54
Maximizing width 79
Minimizing 49
Multiple views 54
Panes 51
Saving layout 733
Switching between 49

WMA files
Batch encoding 304

Word Clock 650
Workspaces 708
Write CD 574
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Z
Zero crossings 95
Zero level axis 737
Zip archives

Backup 725
Batch processing 296

Zoom controls 81
Zoom menu 84
Zoom view 433
Zooming

About 80
Auto zoom for overview 85
Magnifying Glass 81
Montage 392
Mouse zooming 83
Using the keyboard 84
Using the menu 84
Zoom selection 84
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